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Frequently asked questions

GENERAL

INTERNET

On what computers can Kaspersky Endpoint
Security operate?

Does Kaspersky Endpoint Security scan encrypted
connections (HTTPS)?

What has changed since the last version?

How do I allow users to connect only to trusted Wi-Fi
networks?

With which other Kaspersky applications can
Kaspersky Endpoint Security operate?

How do I block social networks?

How can I conserve computer resources during
operation of Kaspersky Endpoint Security?
APPLICATIONS
DEPLOYMENT

How do I install Kaspersky Endpoint Security to
all computers of an organization?
Which installation settings can be con gured in
the command line?

How do I nd out which applications are installed on a
user's computer (inventory)?
How do I prevent computer games from running?
How do I verify that Application Control has been
correctly con gured?
How do I add an application to the trusted list?

How do I remotely uninstall Kaspersky Endpoint
Security?
DEVICES
UPDATE

What methods are available to update the
databases?

How do I block the use of ash drives?
How do I add a device to the trusted list?
Is it possible to obtain access to a blocked device?

What should I do if problems arise after an
update?
How do I update databases outside of the
corporate network?
Is it possible to use a proxy server for updates?

SECURITY

ENCRYPTION

Under which conditions is encryption impossible?
How do I use a password to restrict access to an
archive?
Is it possible to use smart cards and tokens with
encryption?

How does Kaspersky Endpoint Security scan
email?

Is it possible to gain access to encrypted data if there is
no connection with Kaspersky Security Center?

How do I exclude a trusted le from scans?

What should I do if the computer operating system fails
but data remains encrypted?

How do I protect a computer against viruses
from ash drives?
How can I run a virus scan that is hidden from the
user?
How do I temporarily pause the protection of
Kaspersky Endpoint Security?
How do I restore a le that Kaspersky Endpoint
Security erroneously deleted?

SUPPORT

Where is the report le stored?
How do I create a trace le?
How do I enable dump writing?

How do I protect Kaspersky Endpoint Security
from being uninstalled by a user?
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What's new
Update 11.7.0
Kaspersky Endpoint Security for Windows 11.7.0 o ers the following new features and improvements:
1. The interface of Kaspersky Endpoint Security for Windows is updated.
2. Support of Windows 11, Windows 10 21H2 and Windows Server 2022.
3. Added new components:
A built-in agent for integration with Kaspersky Sandbox was added. The Kaspersky Sandbox solution
detects and automatically blocks advanced threats on computers. Kaspersky Sandbox analyzes object
behavior to detect malicious activity and activity characteristic of targeted attacks on the IT infrastructure
of the organization. Kaspersky Sandbox analyzes and scans objects on special servers with deployed virtual
images of Microsoft Windows operating systems (Kaspersky Sandbox servers). For details about the
solution, refer to the Kaspersky Sandbox Help.
You no longer need Kaspersky Endpoint Agent in order to use Kaspersky Sandbox. Kaspersky Endpoint
Security can perform all Kaspersky Endpoint Agent functions. To migrate Kaspersky Endpoint Agent
policies, use the Migration Wizard. You need Kaspersky Security Center 13.2 for all of the functions of
Kaspersky Sandbox to work. For details about the migrating from Kaspersky Endpoint Agent to Kaspersky
Endpoint Security for Windows, please refer to the application help.
Added the built-in agent to support the operation of the Kaspersky Endpoint Detection and Response
Optimum solution. Kaspersky Endpoint Detection and Response Optimum is a solution for protecting the
organization's IT infrastructure from advanced cyber threats. The functionality of the solution combines
automatic detection of threats with the ability to react to these threats to counteract advanced attacks
including new exploits, ransomware, leless attacks, as well as methods using legitimate system tools. For
more information about the solution, refer to the Kaspersky Endpoint Detection and Response Optimum
Help.
You no longer need Kaspersky Endpoint Agent in order to use Kaspersky Endpoint Detection and Response.
Kaspersky Endpoint Security can perform all Kaspersky Endpoint Agent functions. To migrate Kaspersky
Endpoint Agent policies and tasks, use the Migration Wizard. To use all the functions, Kaspersky Endpoint
Detection and Response Optimum require Kaspersky Security Center 13.2. For details about the migrating
from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows, please refer to the
application help.
4. The Migration Wizard for Kaspersky Endpoint Agent policies and tasks was added. The Migration Wizard
creates new merged policies and tasks for Kaspersky Endpoint Security for Windows. The wizard allows
switching Detection and Response solutions from Kaspersky Endpoint Agent to Kaspersky Endpoint Security.
Detection and Response solutions include Kaspersky Sandbox, Kaspersky Endpoint Detection and Response
Optimum (EDR Optimum), and Kaspersky Managed Detection and Response (MDR).
5. Kaspersky Endpoint Agent, which is included in the distribution kit, is updated to version 3.11.
When upgrading Kaspersky Endpoint Security, the application detects the version and designated purpose of
Kaspersky Endpoint Agent. If Kaspersky Endpoint Agent is designated for the operation of Kaspersky Sandbox,
Kaspersky Managed Detection and Response (MDR) and Kaspersky Endpoint Detection and Response
Optimum (EDR Optimum), Kaspersky Endpoint Security switches the operation of these solutions to the
application’s built-in agent. For Kaspersky Sandbox and EDR Optimum, the application automatically uninstalls
Kaspersky Endpoint Agent. For MDR, you can uninstall Kaspersky Endpoint Agent manually. If the application is
designated for the operation of Kaspersky Endpoint Detection and Response Expert (EDR Expert), Kaspersky
Endpoint Security upgrades the version of Kaspersky Endpoint Agent. For more details about the application,
please refer to the documentation of Kaspersky solutions that support Kaspersky Endpoint Agent.
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6. BitLocker encryption functionality improved:
Enhanced PIN can now be used with BitLocker Drive Encryption. Enhanced PIN allows using other characters
in addition to numerical characters: uppercase and lowercase Latin letters, special characters, and spaces.
A feature to disable BitLocker authentication for upgrading the operating system or installing update
packages was added. Installing updates may require restarting the computer multiple times. To install
updates correctly, you can temporarily turn o BitLocker authentication and re-enable the authentication
after installing updates.
Now you can set an expiration time for BitLocker encryption password or PIN. When the password or PIN
expires, Kaspersky Endpoint Security prompts the user for a new password.
7. Now you can con gure the maximum number of keyboard authorization attempts for BadUSB Attack
Prevention. When the con gured number of failed attempts to enter the authorization code is reached, the
USB device is temporarily locked.
8. Firewall functionality is improved:
Now you can con gure a range of IP addresses for Firewall packet rules. You can enter a range of addresses
in IPv4 or IPv6 format. For example, 192.168.1.1-192.168.1.100 or 12:34::2-12:34::99.
Now you can enter DNS names for Firewall packet rules instead of IP addresses. You should use DNS names
only for LAN computers or internal services. Interaction with cloud services (such as Microsoft Azure) and
other Internet resources should be handled by the Web Control component.
9. Web Control rule search improved. To search a web resource access rule, in addition to the name of the rule,
you can use the URL of the website, a username, a content category, or a data type.
10. The Virus Scan task was improved:
The Virus Scan task in idle mode was improved. If you have rebooted the computer during the scan,
Kaspersky Endpoint Security automatically runs the task, continuing from the point where the scan was
interrupted.
The Virus Scan task was optimized. By default, Kaspersky Endpoint Security runs the scan only when the
computer is idle. You can con gure when the computer scan is run in task properties.
11. Now you can restrict user access to data provided by the Application Activity Monitor. Application Activity
Monitor is a tool designed for viewing information about the activity of applications on a user's computer in real
time. The administrator can hide the Application Activity Monitor from the user in application policy properties.
12. Improved the security of managing the application through the REST API. Now Kaspersky Endpoint Security
validates the signature of requests sent via the REST API. To manage the program, you need to install a request
identi cation certi cate.

Update 11.6.0
Kaspersky Endpoint Security 11.6.0 for Windows o ers the following features and improvements:
1. Support for Windows 10 21H1. For details about support for the Microsoft Windows 10 operating system, please
refer to the Technical Support Knowledge Base .
2. The Managed Detection and Response component was added. This component facilitates interaction with the
solution known as Kaspersky Managed Detection and Response. Kaspersky Managed Detection and Response
(MDR) provides round-the-clock protection from a growing number of threats capable of bypassing automated
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protection mechanisms for organizations that have a di icult time nding highly quali ed experts or have
limited internal resources. For detailed information about how the solution works, please refer to the Kaspersky
Managed Detection and Response Help.
3. Kaspersky Endpoint Agent, which is included in the distribution kit, has been updated to version 3.10. Kaspersky
Endpoint Agent 3.10 provides new features, resolves some previous issues, and has improved stability. For more
details about the application, please refer to the documentation of Kaspersky solutions that support Kaspersky
Endpoint Agent.
4. It now provides the capability to manage protection against attacks such as Network Flooding and Port
Scanning in Network Threat Protection settings.
5. Added new method of creating network rules for Firewall. You can add packet rules and application rules for
connections that are displayed in the Network Monitor window. However, network rule connection settings will
be con gured automatically.
6. Network Monitor interface is now improved. Added the information about network activity: process ID, that
initiate network activity; network type (local network or the Internet); local ports. By default, the information
about network type is hidden.
7. There is now the capability to automatically create Authentication Agent accounts for new Windows users. The
Agent allows a user to complete authentication for access to drives that were encrypted using Kaspersky Disk
Encryption technology, and to load the operating system. The application checks information about Windows
user accounts on the computer. If Kaspersky Endpoint Security detects a Windows user account that has no
Authentication Agent account, the application will create a new account for accessing encrypted drives. This
means that you do not need to manually add Authentication Agent accounts for computers with already
encrypted drives.
8. There is now the capability to monitor the disk encryption process in the application interface on users'
computers (Kaspersky Disk Encryption and BitLocker). You can run the Encryption Monitor tool from the main
application window.

Update 11.5.0
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Kaspersky Endpoint Security 11.5.0 for Windows o ers the following features and improvements:
1. Support for Windows 10 20H2. For details about support for the Microsoft Windows 10 operating system,
please refer to the Technical Support Knowledge Base .
2. Updated application interface. Also updated the application icon in the noti cation area, application
noti cations, and dialog boxes.
3. Improved interface of the Kaspersky Endpoint Security web plug-in for the Application Control, Device
Control, and Adaptive Anomaly Control components.
4. Added functionality for importing and exporting lists of rules and exclusions in XML format. The XML
format allows you to edit lists after they are exported. You can manage lists only in the Kaspersky Security
Center Console. The following lists are available for export/import:
Behavior Detection (list of exclusions).
Web Threat Protection (list of trusted web addresses).
Mail Threat Protection (list of attachment lter extensions).
Network Threat Protection (list of exclusions).
Firewall (list of network packet rules).
Application Control (list of rules).
Web Control (list of rules).
Network port monitoring (lists of ports and applications monitored by Kaspersky Endpoint Security).
Kaspersky Disk Encryption (list of exclusions).
Encryption of removable drives (list of rules).
5. Object MD5 information was added to the threat detection report. In previous versions of the application,
Kaspersky Endpoint Security showed only the SHA256 of an object.
6. Added capability to assign the priority for device access rules in Device Control settings. Priority
assignment enables more exible con guration of user access to devices. If a user has been added to
multiple groups, Kaspersky Endpoint Security regulates device access based on the rule with the highest
priority. For example, you can grant read-only permissions to the Everyone group and grant read/write
permissions to the administrators group. To do so, assign a priority of 0 for the administrators group and
assign a priority of 1 for the Everyone group. You can con gure the priority only for devices that have a le
system. This includes hard drives, removable drives, oppy disks, CD/DVD drives, and portable devices
(MTP).
7. Added new functionality:
Manage audio noti cations.
Cost-Aware Networking Kaspersky Endpoint Security limits its own network tra ic if the Internet
connection is limited (for example, through a mobile connection).
Manage Kaspersky Endpoint Security settings via trusted remote administration applications (such as
TeamViewer, LogMeIn Pro and Remotely Anywhere). You can use remote administration applications to
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start Kaspersky Endpoint Security and manage settings in the application interface.
Manage the settings for scanning secure tra ic in Firefox and Thunderbird. You can select the
certi cate storage that will be used by Mozilla: the Windows certi cate storage or the Mozilla
certi cate storage. This functionality is available only for computers that do not have an applied policy.
If a policy is being applied to a computer, Kaspersky Endpoint Security automatically enables use of the
Windows certi cate storage in Firefox and Thunderbird.
8. Added capability to con gure the secure tra ic scan mode: always scan tra ic even if protection
components are disabled, or scan tra ic when requested by protection components.
9. Revised procedure for deleting information from reports. A user can only delete all reports. In previous
versions of the application, a user could select speci c application components whose information would
be deleted from reports.
10. Revised procedure for importing a con guration le containing Kaspersky Endpoint Security settings, and
revised procedure for restoring application settings. Prior to importing or restoring, Kaspersky Endpoint
Security shows only a warning. In previous versions of the application, you could view the values of the new
settings before they were applied.
11. Simpli ed procedure for restoring access to a drive that was encrypted by BitLocker. After completing the
access recovery procedure, Kaspersky Endpoint Security prompts the user to set a new password or PIN
code. After setting a new password, BitLocker will encrypt the drive. In the previous version of the
application, the user had to manually reset the password in the BitLocker settings.
12. Users now have the capability to create their own local trusted zone for a speci c computer. This way,
users can create their own local lists of exclusions and trusted applications in addition to the general
trusted zone in a policy. An administrator can allow or block the use of local exclusions or local trusted
applications. An administrator can use Kaspersky Security Center to view, add, edit, or delete list items in
the computer properties.
13. Added capability to enter comments in the properties of trusted applications. Comments help simplify
searches and sorting of trusted applications.
14. Managing the application through the REST API:
There is now the capability to con gure the settings of the Mail Threat Protection extension for
Outlook.
It is prohibited to disable detection of viruses, worms, and Trojans.

Update 11.4.0
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Kaspersky Endpoint Security 11.4.0 for Windows o ers the following features and improvements:
1. New design of the application icon in the taskbar noti cation area. The new is now displayed instead of
the old icon. If the user is required to perform an action (for example, restart the computer after
updating the application), the icon will change to . If the protection components of the application are
disabled or have malfunctioned, the icon will change to or . If you hover over the icon, Kaspersky
Endpoint Security will display a description of the problem in computer protection.
2. Kaspersky Endpoint Agent, which is included in the distribution kit, has been updated to version 3.9.
Kaspersky Endpoint Agent 3.9 supports integration with new Kaspersky solutions. For more details about
the application, please refer to the documentation of Kaspersky solutions that support Kaspersky
Endpoint Agent.
3. Added the Not supported by license status for Kaspersky Endpoint Security components. You can view
the status of components by clicking the Protection components button in the main application window.
4. New events from Exploit Prevention have been added to reports.
5. Drivers for Kaspersky Disk Encryption technology are now automatically added to the Windows Recovery
Environment (WinRE) when drive encryption is started. The previous version of Kaspersky Endpoint
Security added drivers when installing the application. Adding drivers to WinRE can improve the stability of
the application when restoring the operating system on computers protected by Kaspersky Disk
Encryption technology.
The Endpoint Sensor component has been removed from Kaspersky Endpoint Security. You can still
con gure Endpoint Sensor settings in a policy provided that Kaspersky Endpoint Security version 11.0.0 to
11.3.0 is installed on the computer.
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Kaspersky Endpoint Security for Windows
Kaspersky Endpoint Security for Windows (hereinafter also referred to as Kaspersky Endpoint Security) provides
comprehensive computer protection against various types of threats, network and phishing attacks.

Threat detection technologies

Machine learning
Kaspersky Endpoint Security uses a model
based on machine learning. The model is
developed by Kaspersky experts. Subsequently,
the model is continuously fed with threat data
from KSN (model training).

Cloud analysis
Kaspersky Endpoint Security receives threat
data from the Kaspersky Security Network.
Kaspersky Security Network (KSN) is an
infrastructure of cloud services providing
access to the online Kaspersky Knowledge Base
that contains information about the reputation
of les, web resources, and software.

Expert analysis
Kaspersky Endpoint Security uses threat data
added by Kaspersky virus analysts. Virus
analysts evaluate objects if the reputation of an
object cannot be determined automatically.

Behavior analysis
Kaspersky Endpoint Security analyzes the activity of an
object in real time.

Automatic analysis
Kaspersky Endpoint Security receives data from the
automatic object analysis system. The system processes
all objects that are sent to Kaspersky. The system then
determines the reputation of the object and adds the
data to anti-virus databases. If the system cannot
determine the reputation of the object, the system
queries Kaspersky virus analysts.

Kaspersky Sandbox
Kaspersky Endpoint Security processes the object in a
virtual machine. Kaspersky Sandbox analyzes the
behavior of the object and decides on its reputation. This
technology is available only if you are using the
Kaspersky Sandbox solution.

Selection tree
Each type of threat is handled by a dedicated component. Components can be enabled or disabled independently,
and their settings can be con gured.
Selection tree

Section

Essential
Threat
Protection

Component

File Threat Protection
The File Threat Protection component lets you prevent infection of the le system of the
computer. By default, the File Threat Protection component permanently resides in the
computer's RAM. The component scans les on all drives of the computer, as well as on
connected drives. The component provides computer protection with the help of anti-virus
databases, the Kaspersky Security Network cloud service, and heuristic analysis.
Web Threat Protection
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The Web Threat Protection component prevents downloads of malicious les from the
Internet, and also blocks malicious and phishing websites. The component provides computer
protection with the help of anti-virus databases, the Kaspersky Security Network cloud
service, and heuristic analysis.
Mail Threat Protection
The Mail Threat Protection component scans the attachments of incoming and outgoing
email messages for viruses and other threats. The component also scans messages for
malicious and phishing links. By default, the Mail Threat Protection component permanently
resides in the computer's RAM and scans all messages received or sent using the POP3, SMTP,
IMAP, or NNTP protocols, or the Microsoft O ice Outlook mail client (MAPI). The component
provides computer protection with the help of anti-virus databases, the Kaspersky Security
Network cloud service, and heuristic analysis.
Network Threat Protection
The Network Threat Protection component scans inbound network tra ic for activity that is
typical of network attacks. When Kaspersky Endpoint Security detects an attempted network
attack on the user's computer, it blocks the network connection with the attacking computer.
Descriptions of currently known types of network attacks and ways to counteract them are
provided in Kaspersky Endpoint Security databases. The list of network attacks that the
Network Threat Protection component detects is updated during database and application
module updates.
Firewall
The Firewall blocks unauthorized connections to the computer while working on the Internet
or local network. The Firewall also controls the network activity of applications on the
computer. This allows you to protect your corporate LAN from identity theft and other
attacks. The component provides computer protection with the help of anti-virus databases,
the Kaspersky Security Network cloud service, and prede ned network rules.
BadUSB Attack Prevention
The BadUSB Attack Prevention component prevents infected USB devices emulating a
keyboard from connecting to the computer.
AMSI Protection
AMSI Protection component is intended to support Antimalware Scan Interface from
Microsoft. The Antimalware Scan Interface (AMSI) allows third-party applications with AMSI
support to send objects (for example, PowerShell scripts) to Kaspersky Endpoint Security for
an additional scan and then receive the results from scanning these objects.
Advanced
Threat
Protection

Kaspersky Security Network

Kaspersky Security Network (KSN) is an infrastructure of cloud services providing access to
the online Kaspersky Knowledge Base that contains information about the reputation of les,
web resources, and software. The use of data from Kaspersky Security Network ensures
faster responses by Kaspersky Endpoint Security to new threats, improves the performance
of some protection components, and reduces the likelihood of false positives. If you are
participating in Kaspersky Security Network, KSN services provide Kaspersky Endpoint
Security with information about the category and reputation of scanned les, as well as
information about the reputation of scanned web addresses.
Behavior Detection
The Behavior Detection component receives data on the actions of applications on your
computer and provides this information to other protection components to improve their
performance. The Behavior Detection component utilizes Behavior Stream Signatures (BSS)
for applications. If application activity matches a behavior stream signature, Kaspersky
Endpoint Security performs the selected responsive action. Kaspersky Endpoint Security
functionality based on behavior stream signatures provides proactive defense for the
computer.
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Exploit Prevention
The Exploit Prevention component detects program code that takes advantage of
vulnerabilities on the computer to exploit administrator privileges or to perform malicious
activities. For example, exploits can utilize a bu er over ow attack. To do so, the exploit sends
a large amount of data to a vulnerable application. When processing this data, the vulnerable
application executes malicious code. As a result of this attack, the exploit can start an
unauthorized installation of malware. When there is an attempt to run an executable le from a
vulnerable application that was not performed by the user, Kaspersky Endpoint Security
blocks this le from running or noti es the user.
Host Intrusion Prevention
The Host Intrusion Prevention component prevents applications from performing actions that
may be dangerous for the operating system, and ensures control over access to operating
system resources and personal data. The component provides computer protection with the
help of anti-virus databases and the Kaspersky Security Network cloud service.
Remediation Engine
The Remediation Engine lets Kaspersky Endpoint Security roll back actions that have been
performed by malware in the operating system.
Security
Controls

Application Control
Application Control manages the startup of applications on users' computers. This allows you
to implement a corporate security policy when using applications. Application Control also
reduces the risk of computer infection by restricting access to applications.
Device Control
Device Control manages user access to devices that are installed on or connected to the
computer (for example, hard drives, cameras, or Wi-Fi modules). This lets you protect the
computer from infection when such devices are connected, and prevent loss or leaks of data.
Web Control
Web Control manages users' access to web resources. This helps reduce tra ic and
inappropriate use of work time. When a user tries to open a website that is restricted by Web
Control, Kaspersky Endpoint Security blocks access or shows a warning.
Adaptive Anomaly Control
The Adaptive Anomaly Control component monitors and blocks actions that are not typical of
the computers in a company's network. Adaptive Anomaly Control uses a set of rules to track
uncharacteristic behavior (for example, the Start of Microsoft PowerShell from o ice
application rule). Rules are created by Kaspersky specialists based on typical scenarios of
malicious activity. You can con gure how Adaptive Anomaly Control handles each rule and, for
example, allow the execution of PowerShell scripts that automate certain work ow tasks.
Kaspersky Endpoint Security updates the set of rules along with the application databases.

Encryption

File Level Encryption
The component allows creating le encryption rules. You can select prede ned folders for
encryption, select a folder manually, or select individual les by extension.
Full Disk Encryption
The component allows encrypting the hard disk using Kaspersky Disk Encryption or BitLocker
Drive Encryption.
Encryption of removable drives
The component allows protecting data on removable drives. You can use Full Disk Encryption
(FDE) or File Level Encryption (FLE).

Detection
and
Response

Endpoint Detection and Response
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Built-in agent for the Kaspersky Endpoint Detection and Response Optimum solution
(hereinafter also "EDR Optimum"). Kaspersky Endpoint Detection and Response Optimum is a
solution for protecting the organization's IT infrastructure from advanced cyber threats. The
functionality of the solution combines automatic detection of threats with the ability to react
to these threats to counteract advanced attacks including new exploits, ransomware, leless
attacks, as well as methods using legitimate system tools. For more information about the
solution, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
Kaspersky Sandbox
The component enables interoperability with the Kaspersky Sandbox solution. The Kaspersky
Sandbox solution detects and automatically blocks advanced threats on computers.
Kaspersky Sandbox analyzes object behavior to detect malicious activity and activity
characteristic of targeted attacks on the IT infrastructure of the organization. Kaspersky
Sandbox analyzes and scans objects on special servers with deployed virtual images of
Microsoft Windows operating systems (Kaspersky Sandbox servers). For details about the
solution, refer to the Kaspersky Sandbox Help.
Managed Detection and Response
Built-in agent to support the operation of the Kaspersky Managed Detection and Response
solution. The Kaspersky Managed Detection and Response (MDR) solution automatically
detects and analyzes security incidents in your infrastructure. To do so, MDR uses telemetry
data received from endpoints and machine learning. MDR sends incident data to Kaspersky
experts. The experts can then process the incident and, for example, add a new entry to AntiVirus databases. Alternatively, the experts can issue recommendations on processing the
incident and, for example, suggest isolating computer from the network. For detailed
information about how the solution works, please refer to the Kaspersky Managed Detection
and Response Help .
In addition to the real-time protection that the application components provide, we recommend that you regularly
scan the computer for viruses and other threats. This helps to rule out the possibility of spreading malware that
was not detected by protection components, for example, due to a low security level.
To keep computer protection up to date, you must update the databases and modules that the application uses.
The application is updated automatically by default, but if necessary, you can update the databases and
application modules manually.
The following tasks are provided in Kaspersky Endpoint Security:
Integrity Check. Kaspersky Endpoint Security checks the application modules in the application installation
folder for corruption or modi cations. If an application module has an incorrect digital signature, the module is
considered corrupt.
Full Scan. Kaspersky Endpoint Security scans the operating system, including kernel memory, objects that are
loaded at operation system startup, disk boot sectors, backup storage of the operating system, and all hard
drives and removable drives.
Custom Scan. Kaspersky Endpoint Security scans the objects that are selected by the user.
Critical Areas Scan. Kaspersky Endpoint Security scans the kernel memory, objects that are loaded at
operation system startup and disk boot sectors.
Update. Kaspersky Endpoint Security downloads updated databases and application modules. Updating keeps
the computer protected against the latest viruses and other threats.
Last update rollback. Kaspersky Endpoint Security rolls back the last update of databases and modules. This
lets you roll back the databases and application modules to their previous versions when necessary, for
example, when the new database version contains an invalid signature that causes Kaspersky Endpoint Security
to block a safe application.
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Service functions of the application
Kaspersky Endpoint Security includes a number of service functions. Service functions are provided for keeping
the application up to date, expand its functionality, and assist the user with operating the application.
Reports. In the course of its operation, the application keeps a report on each application component. You can
also use reports to track the results of completed tasks. The reports contain lists of events that occurred
during Kaspersky Endpoint Security operation and all the operations that the application performs. In case of
an incident, you can send reports to Kaspersky, where Technical Support specialists can look into the issue in
more detail.
Backup. If the application detects infected les while scanning the computer for viruses and other threats, it
blocks those les. Kaspersky Endpoint Security stores copies of disinfected and deleted les in Backup.
Kaspersky Endpoint Security moves les that are not processed for any reason to the list of active threats. You
can scan les, restore les to their original folders, and empty the data storage.
Noti cations. The noti cation service helps the user to track the events that in uence the computer
protection status and Kaspersky Endpoint Security operation. Noti cations can be displayed on the screen or
sent by email.
Kaspersky Security Network. User participation in Kaspersky Security Network enhances e iciency of
computer protection through real-time use of information on the reputation of les, web resources, and
software received from users worldwide.
License. Purchasing a license unlocks full application functionality, provides access to application database and
module updates, and support by phone or via email on issues related to installation, con guration, and use of
the application.
Support. All registered users of Kaspersky Endpoint Security can contact Technical Support specialists for
assistance. You can send a request to Kaspersky Technical Support through the Kaspersky CompanyAccount
portal or call Technical Support by phone.
If the application returns errors or hangs up during operation, it may be restarted automatically.
If the application encounters recurring errors that cause the application to crash, the application performs the
following operations:
1. Disables control and protection functions (encryption functionality remains enabled).
2. Noti es the user that the functions have been disabled.
3. Attempts to restore the application to a functional state after updating anti-virus databases or applying
application module updates.

Distribution kit
The distribution kit includes the following distribution packages:
Strong encryption (AES256)
This distribution package contains cryptographic tools that implement the AES
(Advanced Encryption Standard) encryption algorithm with an e ective key length of 256 bits.
Lite encryption (AES56)
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This distribution package contains cryptographic tools that implement the AES encryption algorithm with an
e ective key length of 56 bits.
Each distribution package contains the following les:
kes_win.msi

Kaspersky Endpoint Security installation package.

setup_kes.exe

Files that are required for installing the application using any of the available
methods.

kes_win.kud

File for creating installation packages for Kaspersky Endpoint Security.

klcfginst.msi

Kaspersky Endpoint Security Management Plug-in installation package for
Kaspersky Security Center.

bases.cab

Update package les that are used during installation.

cleaner.cab

Files for removing incompatible software.

incompatible.txt

File that contains a list of incompatible software.

ksn_<language_ID>.txt

File where you can read through the terms of participation in Kaspersky
Security Network.

license.txt

File where you can read through the End User License Agreement and the
Privacy Policy.

dpa.txt

File where you can read additional Data processing statements for Kaspersky
Endpoint Security for Windows.

installer.ini

File that contains the internal settings of the distribution kit.

endpointagent.msi

Installation package for Kaspersky Endpoint Agent, which is required for
integration with other Kaspersky solutions (for example, Kaspersky Sandbox).

NDP<version>-<package
properties>

Microsoft .NET Framework installation package.

keswin_web_plugin.zip

Archive containing the les required for installing the Kaspersky Endpoint
Security web plug-in.

It is not recommended to change the values of these settings. If you want to change installation options, use
the setup.ini le.

Hardware and software requirements
To ensure proper operation of Kaspersky Endpoint Security, your computer must meet the following requirements:
Minimum general requirements:
2 GB of free disk space on the hard drive
CPU:
Workstation: 1 GHz
Server: 1.4 GHz
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Support for the SSE2 instruction set
RAM:
Workstation (x86): 1 GB
Workstation (x64): 2 GB
Server: 2 GB
Microsoft .NET Framework 4.0 or later
Supported operating systems for workstations:
Windows 7 Home / Professional / Ultimate / Enterprise Service Pack 1 or later;
Windows 8 Professional / Enterprise;
Windows 8.1 Professional / Enterprise;
Windows 10 Home / Pro / Pro for Workstations / Education / Enterprise;
Windows 11.
The SHA-1 module signature algorithm is deprecated by Microsoft. Update KB4474419 is required for
successful installation of Kaspersky Endpoint Security on a computer running the Microsoft Windows 7
operating system. For more details about this update, visit the Microsoft technical support website .

For details about support for the Microsoft Windows 10 operating system, please refer to the Technical
Support Knowledge Base .

For details about support for the Microsoft Windows 11 operating system, please refer to the Technical
Support Knowledge Base .
Supported operating systems for servers:
Windows Small Business Server 2011 Essentials / Standard (64-bit);
Microsoft Small Business Server 2011 Standard (64-bit) is supported only if Service Pack 1 for Microsoft
Windows Server 2008 R2 is installed.
Windows MultiPoint Server 2011 (64-bit);
Windows Server 2008 R2 Foundation / Standard / Enterprise / Datacenter Service Pack 1 or later;
Windows Server 2012 Foundation / Essentials / Standard / Datacenter;
Windows Server 2012 R2 Foundation / Essentials / Standard / Datacenter;
Windows Server 2016 Essentials / Standard / Datacenter;
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Windows Server 2019 Essentials / Standard / Datacenter;
Windows Server 2022.
The SHA-1 module signature algorithm is deprecated by Microsoft. Update KB4474419 is required for
successful installation of Kaspersky Endpoint Security on a computer running the Microsoft Windows Server
2008 R2 operating system. For more details about this update, visit the Microsoft technical support website .

For details about support for the Microsoft Windows Server 2016 and Microsoft Windows Server 2019
operating systems, please refer to the Technical Support Knowledge Base .

For details about support for the Microsoft Windows Server 2022 operating system, please refer to the
Technical Support Knowledge Base .
Supported terminal server types:
Microsoft Remote Desktop Services based on Windows Server 2008 R2 SP1;
Microsoft Remote Desktop Services based on Windows Server 2012;
Microsoft Remote Desktop Services based on Windows Server 2012 R2;
Microsoft Remote Desktop Services based on Windows Server 2016;
Microsoft Remote Desktop Services based on Windows Server 2019.
Supported virtual platforms:
VMware Workstation 16.1.1 Pro;
VMware ESXi 7.0 Update 2a;
Microsoft Hyper-V Server 2019;
Citrix Virtual Apps and Desktops 7 2103;
Citrix Provisioning 2012;
Citrix Hypervisor 8.2 LTSR.
Kaspersky Endpoint Security supports operation with the following versions of Kaspersky Security Center:
Kaspersky Security Center 11;
Kaspersky Security Center 12;
Kaspersky Security Center 12 Patch A;
Kaspersky Security Center 12 Patch B;
Kaspersky Security Center 13;
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Kaspersky Security Center 13.1;
Kaspersky Security Center 13.2.

Comparison of available application features depending on the type of
operating system
The set of available Kaspersky Endpoint Security features depends on the type of operating system: workstation
or server (see the table below).
Comparison of Kaspersky Endpoint Security features

Feature

Workstation

Server

Advanced Threat Protection
Kaspersky Security Network
Behavior Detection
Exploit Prevention
Host Intrusion Prevention

–

Remediation Engine
Essential Threat Protection
File Threat Protection
Web Threat Protection

–

Mail Threat Protection

–

Firewall
Network Threat Protection
BadUSB Attack Prevention
AMSI Protection
Security Controls
Application Control
Device Control

–

Web Control

–

Adaptive Anomaly Control

–

Data Encryption
Kaspersky Disk Encryption

–

BitLocker Drive Encryption
File Level Encryption

–

Encryption of removable drives

–

Detection and Response
Kaspersky Endpoint Agent
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Endpoint Detection and Response Optimum
Kaspersky Sandbox
Managed Detection and Response

Comparison of application functions depending on the management tools
The set of functions available in Kaspersky Endpoint Security depends on the management tools (see the table
below).
You can manage the application using the following consoles of Kaspersky Security Center:
Administration Console. Microsoft Management Console (MMC) snap-in installed on the administrator's
workstation.
Web Console. Component of Kaspersky Security Center that is installed on the Administration Server. You can
work in the Web Console through a browser on any computer that has access to the Administration Server.
You can also manage the application by using the Kaspersky Security Center Cloud Console. The Kaspersky
Security Center Cloud Console is the cloud version of Kaspersky Security Center. This means that the
Administration Server and other components of Kaspersky Security Center are installed in the cloud infrastructure
of Kaspersky. For details on managing the application using the Kaspersky Security Center Cloud Console, refer to
the Kaspersky Security Center Cloud Console Help .
Comparison of Kaspersky Endpoint Security features

Feature

Kaspersky Security Center
Administration
Console

Web
Console

Kaspersky Security
Center
Cloud Console

Advanced Threat Protection
Kaspersky Security Network
Kaspersky Private Security Network

–

Behavior Detection
Exploit Prevention
Host Intrusion Prevention
Remediation Engine
Essential Threat Protection
File Threat Protection
Web Threat Protection
Mail Threat Protection
Firewall
Network Threat Protection
BadUSB Attack Prevention
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Managed Detection and Response
AMSI Protection
Security Controls
Application Control
Device Control
Web Control
Adaptive Anomaly Control
Data Encryption
Kaspersky Disk Encryption

–

BitLocker Drive Encryption
File Level Encryption

–

Encryption of removable drives

–

Detection and Response
Kaspersky Endpoint Agent
Endpoint Detection and Response Optimum (EDR)

–

Kaspersky Sandbox

–

Managed Detection and Response
Tasks
Add key
Change application components
Inventory
Update
Update rollback
Virus scan
Integrity check

–

Wipe Data
Manage Authentication Agent accounts (Kaspersky
Disk Encryption)

–

IOC Scan (EDR)

–

Move le to Quarantine (EDR)

–

Get le (EDR)

–

Delete le (EDR)

–

Process start (EDR)

–

Terminate process (EDR)

–

Compatibility with other applications
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Prior to the installation, Kaspersky Endpoint Security checks the computer for the presence of Kaspersky
applications. The application also checks the computer for incompatible software. The list of incompatible
software is available in the incompatible.txt le that is included in the distribution kit.
DOWNLOAD THE INCOMPATIBLE.TXT FILE
Kaspersky Endpoint Security is incompatible with the following Kaspersky applications:
Kaspersky Small O ice Security.
Kaspersky Internet Security.
Kaspersky Anti-Virus.
Kaspersky Total Security.
Kaspersky Safe Kids.
Kaspersky Free.
Kaspersky Anti-Ransomware Tool.
Kaspersky Anti Targeted Attack Platform (including the Endpoint Sensor component).
Kaspersky Sandbox (including Kaspersky Endpoint Agent).
Kaspersky Endpoint Detection and Response (including the Endpoint Sensor component).
If the Endpoint Agent component was installed on a computer using the deployment tools of other
Kaspersky applications, the component will be automatically removed during installation of Kaspersky
Endpoint Security. Kaspersky Endpoint Security may also include the Endpoint Sensor / Kaspersky
Endpoint Agent component if you selected Endpoint Agent in the list of application components.
Kaspersky Security for Virtualization Light Agent.
Kaspersky Fraud Prevention for Endpoint.
Kaspersky Security for Windows Server.
Kaspersky Embedded Systems Security.
If Kaspersky applications from this list are installed on the computer, Kaspersky Endpoint Security removes these
applications. Please wait for this process to nish before continuing installation of Kaspersky Endpoint Security.
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Installing and removing the application
Kaspersky Endpoint Security can be installed on a computer in the following ways:
locally, by using the Setup Wizard.
locally from the command line.
remotely using Kaspersky Security Center.
remotely through the Microsoft Windows Group Policy Management Editor (for more details, visit the Microsoft
Technical Support website ).
remotely, by using the System Center Con guration Manager.
You can con gure the application installation settings in several ways. If you simultaneously use multiple methods
for con guring the settings, Kaspersky Endpoint Security applies the settings with the highest priority. Kaspersky
Endpoint Security uses the following order of priorities:
1. Settings received from the setup.ini le.
2. Settings received from the installer.ini le.
3. Settings received from the command line.
We recommend closing all running applications before starting the installation of Kaspersky Endpoint Security
(including remote installation).

Deployment through Kaspersky Security Center
Kaspersky Endpoint Security can be deployed on computers within a corporate network in several ways. You can
choose the most suitable deployment scenario for your organization or combine several deployment scenarios at
the same time. Kaspersky Security Center supports the following main deployment methods:
Installing the application using the Protection Deployment Wizard.
Standard installation method is convenient if you are satis ed with the default settings of Kaspersky Endpoint
Security and your organization has a simple infrastructure that does not require special con gurations.
Installing the application using the remote installation task.
Universal installation method, which allows to con gure Kaspersky Endpoint Security settings and exibly
manage remote installation tasks. Installation of Kaspersky Endpoint Security consists of the following steps:
1. Creating an installation package.
2. Creating a remote installation task.
Kaspersky Security Center also supports other methods of installing Kaspersky Endpoint Security, such as
deployment within an operating system image. For details about other deployment methods, refer to Kaspersky
Security Center Help .
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Standard installation of the application
Kaspersky Security Center provides a Protection Deployment Wizard for installing the application on corporate
computers. The Protection Deployment Wizard includes the following main actions:
1. Selecting a Kaspersky Endpoint Security installation package.
An installation package is a set of les created for remote installation of a Kaspersky application via Kaspersky
Security Center. The installation package contains a range of settings needed to install the application and get
it running immediately after installation. The installation package is created using les with the .kpd and .kud
extensions included in the application distribution kit. Kaspersky Endpoint Security installation package is
common for all supported Windows versions and processor architecture types.
2. Creating the Install application remotely task of the Kaspersky Security Center Administration Server.

Kaspersky Endpoint Security deployment

How to run the Protection Deployment Wizard in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Additional → Remote
installation.
2. Click the Deploy installation package on managed devices (workstations) link.
This will start the Protection Deployment Wizard. Follow the instructions of the Wizard.

TCP ports 139 and 445, and UDP ports 137 and 138 must be opened on a client computer.

Step 1. Selecting an installation package
Select Kaspersky Endpoint Security installation package from the list. If the list does not contain the
installation package for Kaspersky Endpoint Security, you can create the package in the Wizard.
You can con gure the installation package settings in Kaspersky Security Center. For example, you can select
the application components that will be installed to a computer.
Network Agent will also be installed together with Kaspersky Endpoint Security. Network Agent facilitates
interaction between the Administration Server and a client computer. If Network Agent is already installed on
the computer, it is not installed again.

Step 2. Selecting devices for installation
Select the computers for installing Kaspersky Endpoint Security. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. Network
Agent is not installed on unassigned devices. In this case, the task is assigned to speci c devices. The
speci c devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 3. De ning remote installation task settings
Con gure the following additional application settings:
Force installation package download. Select the method of application installation:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Then Kaspersky Endpoint Security is installed
by the tools of Network Agent.
Using operating system resources through distribution points. The installation package is delivered
to client computers using operating system resources via distribution points. You can select this option
if there is at least one distribution point in the network. For more details about distribution points, refer
to the Kaspersky Security Center Help .
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Using operating system resources through Administration Server. Files will be delivered to client
computers by using operating system resources through the Administration Server. You can select this
option if Network Agent is not installed on the client computer, but the client computer is in the same
network as the Administration Server.
Behavior for devices managed through other Administration Servers. Select the Kaspersky Endpoint
Security installation method. If the network has more than one Administration Server installed, these
Administration Servers may see the same client computers. This may cause, for example, an application to
be installed remotely on the same client computer several times through di erent Administration Servers,
or other con icts.
Do not re-install application if it is already installed. Clear this check box if you want to install an earlier
version of the application, for example.
Assign Network Agent installation in Active Directory group policies. Manually installing Network Agent
using Active Directory resources. To install Network Agent, the remote installation task must be run with
domain administrator privileges.

Step 4. Selecting a license key
Add a key to the installation package for activating the application. This step is optional. If the Administration
Server contains a license key with automatic distribution functionality, the key will be automatically added
later. You can also activate the application later by using the Add key task.

Step 5. Selecting the operating system restart setting
Select the action to be performed if a computer restart is required. Restart is not required when installing
Kaspersky Endpoint Security. Restart is required only if you have to remove incompatible applications prior to
installation. Restart may also be required when updating the application version.

Step 6. Removing incompatible applications before installing the application
Carefully read the list of incompatible applications and allow removal of these applications. If incompatible
applications are installed on the computer, installation of Kaspersky Endpoint Security ends with an error.

Step 7. Selecting an account for accessing devices
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you install Kaspersky Endpoint Security
using Network Agent tools, you do not have to select an account.

Step 8. Starting the installation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.
How to start the Protection Deployment Wizard in the Web Console and Cloud Console
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In Web Console main window, select Discovery & Deployment → Deployment & Assignment → Protection
Deployment Wizard.
This will start the Protection Deployment Wizard. Follow the instructions of the Wizard.
TCP ports 139 and 445, and UDP ports 137 and 138 must be opened on a client computer.

Step 1. Selecting an installation package
Select Kaspersky Endpoint Security installation package from the list. If the list does not contain the
installation package for Kaspersky Endpoint Security, you can create the package in the Wizard. To create the
installation package, you do not need to search for the distribution package and save it to computer memory.
In Kaspersky Security Center, you can view the list of distribution packages residing on Kaspersky servers, and
the installation package is created automatically. Kaspersky updates the list after the release of new versions
of applications.
You can con gure the installation package settings in Kaspersky Security Center. For example, you can select
the application components that will be installed to a computer.

Step 2. Selecting a license key
Add a key to the installation package for activating the application. This step is optional. If the Administration
Server contains a license key with automatic distribution functionality, the key will be automatically added
later. You can also activate the application later by using the Add key task.

Step 3. Selecting a Network Agent
Select the version of Network Agent that will be installed together with Kaspersky Endpoint Security. Network
Agent facilitates interaction between the Administration Server and a client computer. If Network Agent is
already installed on the computer, it is not installed again.

Step 4. Selecting devices for installation
Select the computers for installing Kaspersky Endpoint Security. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. Network
Agent is not installed on unassigned devices. In this case, the task is assigned to speci c devices. The
speci c devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 5. Con guring advanced settings
Con gure the following additional application settings:
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Force installation package download. Selecting the method of application installation:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Then Kaspersky Endpoint Security is installed
by the tools of Network Agent.
Using operating system resources through distribution points. The installation package is delivered
to client computers using operating system resources via distribution points. You can select this option
if there is at least one distribution point in the network. For more details about distribution points, refer
to the Kaspersky Security Center Help .
Using operating system resources through Administration Server. Files will be delivered to client
computers by using operating system resources through the Administration Server. You can select this
option if Network Agent is not installed on the client computer, but the client computer is in the same
network as the Administration Server.
Do not re-install application if it is already installed. Clear this check box if you want to install an earlier
version of the application, for example.
Assign package installation in Active Directory group policies. Kaspersky Endpoint Security is installed
by means of Network Agent or manually by means of Active Directory. To install Network Agent, the remote
installation task must be run with domain administrator privileges.

Step 6. Selecting the operating system restart setting
Select the action to be performed if a computer restart is required. Restart is not required when installing
Kaspersky Endpoint Security. Restart is required only if you have to remove incompatible applications prior to
installation. Restart may also be required when updating the application version.

Step 7. Removing incompatible applications before installing the application
Carefully read the list of incompatible applications and allow removal of these applications. If incompatible
applications are installed on the computer, installation of Kaspersky Endpoint Security ends with an error.

Step 8. Assigning to an administration group
Select the administration group to which the computers will be moved after Network Agent is installed.
Computers need to be moved to an administration group so that policies and group tasks can be applied. If a
computer is already in any administration group, the computer will not be moved. If you do not select an
administration group, computers will be added to the Unassigned devices group.

Step 9. Selecting an account for accessing devices
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you install Kaspersky Endpoint Security
using Network Agent tools, you do not have to select an account.

Step 10. Starting installation
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Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.

Creating an installation package
An installation package is a set of les created for remote installation of a Kaspersky application via Kaspersky
Security Center. The installation package contains a range of settings needed to install the application and get it
running immediately after installation. The installation package is created using les with the .kpd and .kud
extensions included in the application distribution kit. Kaspersky Endpoint Security installation package is common
for all supported Windows versions and processor architecture types.
How to create an installation package in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Additional → Remote
installation → Installation packages.
This opens a list of installation packages that have been downloaded to Kaspersky Security Center.
2. Click the Create installation package button.
The New Package Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting the installation package type
Select the Create an installation package for a Kaspersky application option.

Step 2. De ning the installation package name
Enter the name of the installation package, for example, Kaspersky Endpoint Security for Windows
11.7.0.

Step 3. Selecting the distribution package for installation
Click Browse and select the kes_win.kud le that is included in the distribution kit.
If required, update the anti-virus databases in the installation package by using the Copy updates from
repository to installation package check box.

Step 4. End User License Agreement and Privacy Policy
Read and accept the terms of the End User License Agreement and Privacy Policy.
The installation package will be created and added to Kaspersky Security Center. Using the installation
package, you can install Kaspersky Endpoint Security on corporate network computers or update the
application version. In the installation package settings, you can also select the application components and
con gure the application installation settings (see the table below). The installation package contains antivirus databases from the Administration Server repository. You can update the databases in the installation
package to reduce tra ic consumption when updating the databases after installing Kaspersky Endpoint
Security.
How to create an installation package in the Web Console and Cloud Console
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1. In Web Console main window, select Discovery & Deployment → Deployment & Assignment →
Installation packages.
This opens a list of installation packages that have been downloaded to Kaspersky Security Center.
2. Click the Add button.
The New Package Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting the installation package type
Select the Create an installation package for a Kaspersky application option.
The Wizard will create an installation package from the distribution package residing on Kaspersky servers. The
list is updated automatically as new versions of applications are released. It is recommended to select this
option for installation of Kaspersky Endpoint Security.
You can also create an installation package from a le.

Step 2. Installation packages
Select the Kaspersky Endpoint Security for Windows installation package. The installation package creation
process starts. During creation of the installation package, you must accept the terms of the End User
License Agreement and Privacy Policy.
The installation package will be created and added to Kaspersky Security Center. Using the installation
package, you can install Kaspersky Endpoint Security on corporate network computers or update the
application version. In the installation package settings, you can also select the application components and
con gure the application installation settings (see the table below). The installation package contains antivirus databases from the Administration Server repository. You can update the databases in the installation
package to reduce tra ic consumption when updating the databases after installing Kaspersky Endpoint
Security.
Installation package settings

Section

Description

Protection
components

In this section, you can select the application components that will be available. You can
change the set of application components at a later time by using the Change application
components task. The BadUSB Attack Prevention component, Endpoint Agent component,
and data encryption components are not installed by default. These components can be
added in the installation package settings.

Installation
settings

Add application location to environment variable %PATH%. You can add the installation
path to the %PATH% variable for convenient use of the command line interface.
Do not protect the installation process. Installation protection includes protection against
replacement of the distribution package with malicious applications, blocking access to the
installation folder of Kaspersky Endpoint Security, and blocking access to the system
registry section containing application keys. However, if the application cannot be installed
(for example, when performing remote installation with the help of Windows Remote
Desktop), you are advised to disable protection of the installation process.
Ensure compatibility with Citrix PVS. You can enable support of Citrix Provisioning
Services to install Kaspersky Endpoint Security to a virtual machine.
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Path to application installation folder. You can change the installation path of Kaspersky
Endpoint Security on a client computer. By default, the application is installed in the
%ProgramFiles%\Kaspersky Lab\Kaspersky Endpoint Security for Windows
folder.
Con guration le. You can upload a le that de nes the settings of Kaspersky Endpoint
Security. You can create a con guration le in the local interface of the application.

Updating databases in the installation package
The installation package contains anti-virus databases from the Administration Server repository that are up to
date when the installation package is created. After creating the installation package, you can update the antivirus databases in the installation package. This lets you reduce tra ic consumption when updating anti-virus
databases after installing Kaspersky Endpoint Security.
To update the anti-virus databases in the Administration Server repository, use the Download updates to the
Administration Server repository task of the Administration Server. For more information about updating the antivirus databases in the Administration Server repository, please refer to the Kaspersky Security Center Help .
You can update the databases in the installation package only in the Administration Console and Kaspersky
Security Center Web Console. It is not possible to update the databases in the installation package in the
Kaspersky Security Center Cloud Console.
How to update the anti-virus databases in the installation package through the Administration Console (MMC)

1. In the Administration Console, go to the folder Administration Server → Additional → Remote
installation → Installation packages.
This opens a list of installation packages that have been downloaded to Kaspersky Security Center.
2. Open the properties of the installation package.
3. In the General section, click the Update databases button.
As a result, the anti-virus databases in the installation package will be updated from the Administration
Server repository. The bases.cab le that is included in the distribution kit will be replaced by the bases
folder. The update package les will be inside the folder.
How to update anti-virus databases in an installation package through the Web Console
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1. In Web Console main window, select Discovery & Deployment → Deployment & Assignment →
Installation packages.
This opens a list of installation packages downloaded to Web Console.
2. Click on the name of the Kaspersky Endpoint Security installation package in which you want to update the
anti-virus databases.
The installation package properties window opens.
3. On the General information tab, click the Update databases link.
As a result, the anti-virus databases in the installation package will be updated from the Administration
Server repository. The bases.cab le that is included in the distribution kit will be replaced by the bases
folder. The update package les will be inside the folder.

Creating a remote installation task
The Install application remotely task is designed for remote installation of Kaspersky Endpoint Security. The Install
application remotely task allows you to deploy the installation package of the application to all computers in the
organization. Before deploying the installation package, you can update the anti-virus databases inside the
package and select the available application components in the properties of the installation package.
How to create a remote installation task in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Security Center Administration Server → Install application remotely.

Step 2. Selecting an installation package
Select Kaspersky Endpoint Security installation package from the list. If the list does not contain the
installation package for Kaspersky Endpoint Security, you can create the package in the Wizard.
You can con gure the installation package settings in Kaspersky Security Center. For example, you can select
the application components that will be installed to a computer.
Network Agent will also be installed together with Kaspersky Endpoint Security. Network Agent facilitates
interaction between the Administration Server and a client computer. If Network Agent is already installed on
the computer, it is not installed again.

Step 3. Additional
Select the Network Agent installation package. The selected version of Network Agent will be installed
together with Kaspersky Endpoint Security.

Step 4. Settings
Con gure the following additional application settings:
Force installation package download. Select the method of application installation:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Then Kaspersky Endpoint Security is installed
by the tools of Network Agent.
Using operating system resources through distribution points. The installation package is delivered
to client computers using operating system resources via distribution points. You can select this option
if there is at least one distribution point in the network. For more details about distribution points, refer
to the Kaspersky Security Center Help .
Using operating system resources through Administration Server. Files will be delivered to client
computers by using operating system resources through the Administration Server. You can select this
option if Network Agent is not installed on the client computer, but the client computer is in the same
network as the Administration Server.
Behavior for devices managed through other Administration Servers. Select the Kaspersky Endpoint
Security installation method. If the network has more than one Administration Server installed, these
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Administration Servers may see the same client computers. This may cause, for example, an application to
be installed remotely on the same client computer several times through di erent Administration Servers,
or other con icts.
Do not re-install application if it is already installed. Clear this check box if you want to install an earlier
version of the application, for example.

Step 5. Selecting the operating system restart setting
Select the action to be performed if a computer restart is required. Restart is not required when installing
Kaspersky Endpoint Security. Restart is required only if you have to remove incompatible applications prior to
installation. Restart may also be required when updating the application version.

Step 6. Selecting the devices to which the task will be assigned
Select the computers for installing Kaspersky Endpoint Security. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. Network
Agent is not installed on unassigned devices. In this case, the task is assigned to speci c devices. The
speci c devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 7. Selecting the account to run the task
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you install Kaspersky Endpoint Security
using Network Agent tools, you do not have to select an account.

Step 8. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or when the computer is idle.

Step 9. De ning the task name
Enter a name for the task, for example, Install Kaspersky Endpoint Security for Windows 11.7.0.

Step 10. Finishing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties. The application will be installed in silent mode. After installation,
the icon will be added to the noti cation area of the user's computer. If the icon looks like this , make sure
that you activated the application.
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How to create a remote installation task in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Security Center.
2. In the Task type drop-down list, select Install application remotely.
3. In the Task name eld, enter a brief description, such as Installation of Kaspersky Endpoint
Security for Managers.
4. In the Select devices to which the task will be assigned section, select the task scope.

Step 2. Selecting computers for installation
At this step, select the computers on which Kaspersky Endpoint Security will be installed according to the
selected task scope option.

Step 3. Con guring an installation package
At this step, con gure the installation package:
1. Select the Kaspersky Endpoint Security for Windows (11.7.0) installation package.
2. Select the Network Agent installation package.
The selected version of Network Agent will be installed together with Kaspersky Endpoint Security.
Network Agent facilitates interaction between the Administration Server and a client computer. If Network
Agent is already installed on the computer, it is not installed again.
3. In the Force installation package download section, select the application installation method:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Then Kaspersky Endpoint Security is installed
by the tools of Network Agent.
Using operating system resources through distribution points. The installation package is delivered
to client computers using operating system resources via distribution points. You can select this option
if there is at least one distribution point in the network. For more details about distribution points, refer
to the Kaspersky Security Center Help .
Using operating system resources through Administration Server. Files will be delivered to client
computers by using operating system resources through the Administration Server. You can select this
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option if Network Agent is not installed on the client computer, but the client computer is in the same
network as the Administration Server.
4. In the Maximum number of concurrent downloads eld, set a limit on the number of installation package
download requests sent to the Administration Server. A limit on the number of requests will help prevent
the network from being overload.
5. In the Maximum number of installation attempts eld, set a limit on the number of attempts to install the
application. If installation of Kaspersky Endpoint Security ends with an error, the task will automatically
start the installation again.
6. If necessary, clear the Do not re-install application if it is already installed check box. It allows, for
example, to install one of the previous versions of the application.
7. If necessary, clear the Verify operating system type before downloading check box. This lets you avoid
downloading an application distribution package if the operating system of the computer does not meet
the software requirements. If you are sure that the operating system of the computer meets the software
requirements, you can skip this veri cation.
8. If necessary, select the Assign package installation in Active Directory group policies check box.
Kaspersky Endpoint Security is installed by means of Network Agent or manually by means of Active
Directory. To install Network Agent, the remote installation task must be run with domain administrator
privileges.
9. If necessary, select the Prompt users to close running applications check box. Installation of Kaspersky
Endpoint Security takes up computer resources. For the convenience of the user, the Application
Installation Wizard prompts you to close running applications before starting the installation. This helps
prevent disruptions in the operation of other applications and prevents possible malfunctions of the
computer.
10. In the Behavior for devices managed through other Administration Servers section, select the
Kaspersky Endpoint Security installation method. If the network has more than one Administration Server
installed, these Administration Servers may see the same client computers. This may cause, for example, an
application to be installed remotely on the same client computer several times through di erent
Administration Servers, or other con icts.

Step 4. Selecting the account to run the task
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you install Kaspersky Endpoint Security
using Network Agent tools, you do not have to select an account.

Step 5. Completing task creation
Finish the wizard by clicking the Finish button. A new task will be displayed in the list of tasks. To run a task,
select the check box opposite the task and click the Start button. The application will be installed in silent
mode. After installation, the icon will be added to the noti cation area of the user's computer. If the icon
looks like this , make sure that you activated the application.

Installing the application locally using the Wizard
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The interface of the application Setup Wizard consists of a sequence of windows corresponding to the application
installation steps.

To install the application or upgrade the application from a previous version using the Setup Wizard:
1. Copy the distribution kit folder to the user's computer.
2. Run setup_kes.exe.
The Setup Wizard starts.

Preparing for installation
Before installing Kaspersky Endpoint Security on a computer or upgrading it from a previous version, the following
conditions are checked:
Presence of installed incompatible software (the list of incompatible software is available in the incompatible.txt
le that is included in the distribution kit).
Whether or not the hardware and software requirements are met.
Whether or not the user has the rights to install the software product.
If any one of the previous requirements is not met, a relevant noti cation is displayed on the screen.
If the computer meets the listed requirements, the Setup Wizard searches for Kaspersky applications that could
lead to con icts when running at the same time as the application being installed. If such applications are found,
you are prompted to remove them manually.
If the detected applications include previous versions of Kaspersky Endpoint Security, all data that can be
migrated (such as activation data and application settings) is retained and used during installation of Kaspersky
Endpoint Security 11.7.0 for Windows, and the previous version of the application is automatically removed. This
applies to the following application versions:
Kaspersky Endpoint Security 10 Service Pack 2 Maintenance Release 3 for Windows (build 10.3.3.275).
Kaspersky Endpoint Security 10 Service Pack 2 Maintenance Release 4 for Windows (build 10.3.3.304).
Kaspersky Endpoint Security 11.0.0 for Windows (build 11.0.0.6499).
Kaspersky Endpoint Security 11.0.1 for Windows (build 11.0.1.90).
Kaspersky Endpoint Security 11.0.1 for Windows SF1 (build 11.0.1.90).
Kaspersky Endpoint Security 11.1.0 for Windows (build 11.1.0.15919).
Kaspersky Endpoint Security 11.1.1 for Windows (build 11.1.1.126).
Kaspersky Endpoint Security 11.2.0 for Windows (build 11.2.0.2254).
Kaspersky Endpoint Security 11.2.0 for Windows CF1 (build 11.2.0.2254).
Kaspersky Endpoint Security 11.3.0 for Windows (build 11.3.0.773).
Kaspersky Endpoint Security 11.4.0 for Windows (build 11.4.0.233).
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Kaspersky Endpoint Security 11.5.0 for Windows (build 11.5.0.590).
Kaspersky Endpoint Security 11.6.0 for Windows (build 11.6.0.394).

Kaspersky Endpoint Security components
During the installation process, you can select the components of Kaspersky Endpoint Security that you want to
install. The File Threat Protection component is a mandatory component that must be installed. You cannot cancel
its installation.
By default, all application components are selected for installation except the following components:
BadUSB Attack Prevention.
Data Encryption components.
Detection and Response components.
You can change the available application components after the application is installed. To do so, you need to run
the Setup Wizard again and choose to change the available components.

Advanced settings
Protect the application installation process. Installation protection includes protection against replacement of
the distribution package with malicious applications, blocking access to the installation folder of Kaspersky
Endpoint Security, and blocking access to the system registry section containing application keys. However, if the
application cannot be installed (for example, when performing remote installation with the help of Windows Remote
Desktop), you are advised to disable protection of the installation process.
Ensure compatibility with Citrix PVS. You can enable support of Citrix Provisioning Services to install Kaspersky
Endpoint Security to a virtual machine.
Add application location to environment variable %PATH%. You can add the installation path to the %PATH%
variable for convenient use of the command line interface.

Remotely installing the application using System Center Con guration
Manager
These instructions apply to System Center Con guration Manager 2012 R2.

To remotely install an application using System Center Con guration Manager:
1. Open the Con guration Manager console.
2. In the right part of the console, in the App management section, select Packages.
3. In the upper part of the console in the control panel, click the Create package button.
This starts the New Package and Application Wizard.
4. In the New Package and Application Wizard:
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a. In the Package section:
In the Name eld, enter the name of the installation package.
In the Source folder eld, specify the path to the folder containing the distribution package of
Kaspersky Endpoint Security.
b. In the Application type section, select the Standard program option.
c. In the Standard program section:
In the Name eld, enter the unique name for the installation package (for example, the application name
including the version).
In the Command line eld, specify the Kaspersky Endpoint Security installation options from the
command line.
Click the Browse button to specify the path to the executable le of the application.
Make sure that the Run mode list has the Run with administrative rights item selected.
d. In the Requirements section:
Select the Run another program rst check box if you want a di erent application to be started before
installing Kaspersky Endpoint Security.
Select the application from the Application drop-down list or specify the path to the executable le of
this application by clicking the Browse button.
Select the This program can run only on speci ed platforms option in the Platform requirements
section if you want the application to be installed only in the speci ed operating systems.
In the list below, select the check boxes opposite the operating systems in which Kaspersky Endpoint
Security will be installed.
This step is optional.
e. In the Summary section, check all entered values of the settings and click Next.
The created installation package will appear in the Packages section in the list of available installation packages.
5. In the context menu of the installation package, select Deploy.
This starts the Deployment Wizard.
6. In the Deployment Wizard:
a. In the General section:
In the Software eld, enter the unique name of the installation package or select the installation package
from the list by clicking the Browse button.
In the Collection eld, enter the name of the collection of computers on which the application will be
installed, or select the collection by clicking the Browse button.
b. In the Contains section, add distribution points (for more detailed information, please refer to the help
documentation for System Center Con guration Manager).
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c. If required, specify the values of other settings in the Deployment Wizard. These settings are optional for
remote installation of Kaspersky Endpoint Security.
d. In the Summary section, check all entered values of the settings and click Next.
After the Deployment Wizard nishes, a task will be created for remote installation of Kaspersky Endpoint
Security.

Description of setup.ini le installation settings
The setup.ini le is used when installing the application from the command line or when using the Group Policy
Editor of Microsoft Windows. To apply settings from the setup.ini le, place this le into the folder containing the
Kaspersky Endpoint Security distribution package.
DOWNLOAD THE SETUP.INI FILE
The setup.ini le consists of the following sections:
[Setup] – general settings of application installation.
[Components] – selection of application components to be installed. If none of the components are speci ed,
all components that are available for the operating system are installed. File Threat Protection is a mandatory
component and is installed on the computer regardless of which settings are indicated in this section. The
Managed Detection and Response component is also absent from this section. To install this component, you
must activate Managed Detection and Response in the Kaspersky Security Center Console.
[Tasks] – selection of tasks to be included in the list of Kaspersky Endpoint Security tasks. If no task is
speci ed, all tasks are included in the task list of Kaspersky Endpoint Security.
The alternatives to the value 1 are the values yes, on, enable, and enabled.

The alternatives to the value 0 are the values no, off, disable, and disabled.
Settings of the setup.ini le

Section

[Setup]

Parameter

Description

InstallDir

Path to the application installation folder.

ActivationCode

Kaspersky Endpoint Security activation code.

EULA=1

Acceptance of the terms of the End User License
Agreement. The text of the License Agreement is
included in the distribution kit of Kaspersky Endpoint
Security.
Accepting the terms of the End User License
Agreement is necessary for installing the
application or upgrading the application version.
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PrivacyPolicy=1

Acceptance of the Privacy Policy. The text of the
Privacy Policy is included in the Kaspersky Endpoint
Security distribution kit.
To install the application or upgrade the application
version, you must accept the Privacy Policy.

KSN

Agreement or refusal to participate in Kaspersky
Security Network (KSN). If no value is set for this
parameter, Kaspersky Endpoint Security will prompt to
con rm your consent or refusal to participate in KSN
when Kaspersky Endpoint Security is rst started.
Available values:
1 – agreement to participate in KSN.
0 – refusal to participate in KSN (default value).
The Kaspersky Endpoint Security distribution
package is optimized for use with Kaspersky
Security Network. If you opted not to participate in
Kaspersky Security Network, you should update
Kaspersky Endpoint Security immediately after the
installation is complete.

Login

Set the user name for accessing the features and
settings of Kaspersky Endpoint Security (the Password
protection component). The user name is set together
with the Password and PasswordArea parameters.
The user name KLAdmin is used by default.

Password

Specify a password for accessing Kaspersky Endpoint
Security features and settings (the password is
speci ed together with the Login and PasswordArea
parameters).
If you speci ed a password but did not specify a user
name with the Login parameter, the KLAdmin user
name is used by default.

PasswordArea

Specify the scope of the password for accessing
Kaspersky Endpoint Security. When a user attempts to
perform an action that is included in this scope,
Kaspersky Endpoint Security prompts for the user's
account credentials (Login and Password
parameters). Use the ";" character to specify multiple
values.
Available values:
SET – modifying application settings.
EXIT – exiting the application.
DISPROTECT – disabling protection components
and stopping scan tasks.
DISPOLICY – disabling the Kaspersky Security
Center policy.
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UNINST – removing the application from the
computer.
DISCTRL – disabling control components.
REMOVELIC – removing the key.
REPORTS – viewing reports.
SelfProtection

Enabling or disabling the application installation
protection mechanism. Available values:
1 – the application installation protection
mechanism is enabled (default value).
0 – the application installation protection
mechanism is disabled.
Installation protection includes protection against
replacement of the distribution package with
malicious applications, blocking access to the
installation folder of Kaspersky Endpoint Security,
and blocking access to the system registry section
containing application keys. However, if the
application cannot be installed (for example, when
performing remote installation with the help of
Windows Remote Desktop), you are advised to
disable protection of the installation process.

Reboot=1

Automatic restart of the computer, if required after
installation or upgrade of the application. If no value is
set for this parameter, automatic computer restart is
blocked.
Restart is not required when installing Kaspersky
Endpoint Security. Restart is required only if you have to
remove incompatible applications prior to installation.
Restart may also be required when updating the
application version.

AddEnvironment

In the %PATH% system variable, add the path to
executable les located in the Kaspersky Endpoint
Security setup folder. Available values:
1 – the %PATH% system variable is supplemented
with the path to executable les that are located in
the Kaspersky Endpoint Security setup folder.
0 – the %PATH% system variable is not
supplemented with the path to executable les that
are located in the Kaspersky Endpoint Security
setup folder.

AMPPL

Enables or disables protection of the Kaspersky
Endpoint Security processes using AM-PPL technology
(Antimalware Protected Process Light). For more details
about AM-PPL technology, please visit the Microsoft
website .
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AM-PPL technology is available for Windows 10 version
1703 (RS2) or later, and Windows Server 2019 operating
systems.
Available values:
1 – protection of the Kaspersky Endpoint Security
processes using AM-PPL technology is enabled.
0 – protection of the Kaspersky Endpoint Security
processes using AM-PPL technology is disabled.
SetupReg

Enable writing of registry keys from the setup.reg le to
the registry. SetupReg: setup.reg parameter value.

EnableTraces

Enabling or disabling application tracing. After
Kaspersky Endpoint Security starts, it saves trace les
in the folder %ProgramData%\Kaspersky
Lab\KES\Traces. Available values:
1 – tracing is enabled.
0 – tracing is disabled (default value).

TracesLevel

Level of detail of traces. Available values:
100 (critical). Only messages about fatal errors.
200 (high). Messages about all errors, including fatal
errors.
300 (diagnostic). Messages about all errors, as well
as warnings.
400 (important). All error messages, warnings, and
additional information.
500 (normal). Messages about all errors and
warnings, as well as detailed information about the
operation of the application in normal mode
(default).
600 (low). All messages.

RESTAPI

Managing the application through the REST API. To
manage the application through the REST API, you must
specify the user name (RESTAPI_User parameter).
Available values:
1 – management via REST API is allowed.
0 – management via REST API is blocked (default
value).
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To manage the application through the REST API,
management using administrative systems must be
allowed. To do so, set the AdminKitConnector=1
parameter. If you manage the application through
the REST API, it is impossible to manage the
application using the administration systems of
Kaspersky.
RESTAPI_User

User name of the Windows domain account used for
managing the application through the REST API.
Management of the application through the REST API is
available only to this user. Enter the user name in the
format <DOMAIN>\<UserName> (for example,
RESTAPI_User=COMPANY\Administrator). You can
select only one user to work with the REST API.
Adding a user name is a prerequisite for managing the
application through the REST API.

[Components]

RESTAPI_Port

Port used for managing the application through the
REST API. Port 6782 is used by default.

RESTAPI_Certificate

Certi cate for identifying requests (for example,
RESTAPI_Certificate=C:\cert.pem). Secure
interaction of Kaspersky Endpoint Security with the
REST client requires con guring request identi cation.
To do so, you must install a certi cate and subsequently
sign the payload of each request.

ALL

Installation of all components. If the parameter value 1
is speci ed, all components will be installed regardless
of the installation settings of individual components.
Because of the way Detection and Response
solutions are supported, Endpoint Detection and
Response Optimum as well as Kaspersky Sandbox
components are installed on the computer. The
Endpoint Agent component is not con gured with
this con guration of the application.

MailThreatProtection

Mail Threat Protection.

WebThreatProtection

Web Threat Protection.

AMSI

AMSI Protection.

HostIntrusionPrevention

Host Intrusion Prevention.

BehaviorDetection

Behavior Detection.

ExploitPrevention

Exploit Prevention.

RemediationEngine

Remediation Engine.

Firewall

Firewall.

NetworkThreatProtection

Network Threat Protection.

WebControl

Web Control.

DeviceControl

Device Control.
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ApplicationControl

Application Control.

AdaptiveAnomaliesControl

Adaptive Anomaly Control.

FileEncryption

File Level Encryption libraries.

DiskEncryption

Full Disk Encryption libraries.

BadUSBAttackPrevention

BadUSB Attack Prevention.

AntiAPT

Endpoint Agent. Endpoint Agent installs Kaspersky
Endpoint Agent to facilitate the interaction of the
application and Kaspersky solutions for advanced threat
detection (for example, Kaspersky Sandbox).
The component is incompatible with Endpoint
Detection and Response Optimum (EDR) and
Kaspersky Sandbox (SB) components.

EDR

Endpoint Detection and Response Optimum (EDR
Optimum).
The component is incompatible with the Endpoint
Agent component (AntiAPT).

SB

Kaspersky Sandbox.
The component is incompatible with the Endpoint
Agent component (AntiAPT).

AdminKitConnector

Application management using administration systems.
Administration systems include, for example, Kaspersky
Security Center. In addition to Kaspersky administration
systems, you can use third-party solutions. Kaspersky
Endpoint Security provides an API for this purpose.
Available values:
1 – application management with the help of
administration systems is allowed (default value).
0 – application management is allowed only through
the local interface.

[Tasks]

ScanMyComputer

Full Scan task. Available values:
1 – the task is included in the list of Kaspersky
Endpoint Security tasks.
0 – the task is not included in the list of Kaspersky
Endpoint Security tasks.

ScanCritical

Critical Areas Scan task. Available values:
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1 – the task is included in the list of Kaspersky
Endpoint Security tasks.
0 – the task is not included in the list of Kaspersky
Endpoint Security tasks.
Updater

Update task. Available values:
1 – the task is included in the list of Kaspersky
Endpoint Security tasks.
0 – the task is not included in the list of Kaspersky
Endpoint Security tasks.

Change application components
During installation of the application, you can select the components that will be available. You can change the
available application components in the following ways:
Locally, by using the Setup Wizard.
Application components are changed by using the normal method for a Windows operating system, which is
through the Control Panel. Run the Application Setup Wizard and select the option to change the application
components that are available. Follow the instructions on the screen.
Remotely using Kaspersky Security Center.
The Change application components task allows you to change the components of Kaspersky Endpoint
Security after the application is installed.
Please take into account the following special considerations when changing the application components:
On computers running Windows Server, you cannot install all components of Kaspersky Endpoint Security (for
example, the Adaptive Anomaly Control component is not available).
If the hard drives on your computer are protected by Full Disk Encryption (FDE), you cannot remove the Full
Disk Encryption component. To remove the Full Disk Encryption component, decrypt all the hard drives of the
computer.
If the computer has encrypted les (FLE) or the user uses encrypted removable drives (FDE or FLE), it will be
impossible to access the les and removable drives after the Data Encryption components are removed. You
can access the les and removable drives by reinstalling the Data Encryption components.
How to add or remove application components in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → Change application components.

Step 2. Task settings for changing application components
Select the application components that will be available on the user's computer.
Select the Remove incompatible third-party applications check box. The list of incompatible applications
can be viewed in incompatible.txt, which is included in the distribution kit. If incompatible applications are
installed on the computer, installation of Kaspersky Endpoint Security ends with an error.
If necessary, enable password protection for task performance:
1. Click the Additional button.
2. Select the Use password for modifying the set of application components check box.
3. Enter the KLAdmin user account credentials.

Step 3. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 4. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or when the computer is idle.

Step 5. De ning the task name
Enter a name for the task, for example, Add the Application Control component.
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Step 6. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.
As a result, the set of Kaspersky Endpoint Security components on users' computers will be changed in silent
mode. The settings of available components will be displayed in the local interface of the application. The
components that were not included in the application are disabled, and the settings of these components are
not available.
How to add or remove application components in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
2. In the Task type drop-down list, select Change application components.
3. In the Task name eld, enter a brief description, for example, Add the Application Control
component.
4. In the Select devices to which the task will be assigned section, select the task scope.

Step 2. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. For example, select a separate administration
group or build a selection.

Step 3. Completing task creation
Select the Open task details when creation is complete check box and nish the Wizard. In the task
properties, select the Application Settings tab and select the application components that will be available.
If necessary, enable password protection for task performance:
1. In the Advanced Settings section, select the Use password for modifying the set of application
components check box.
2. Enter the KLAdmin user account credentials.
Save the changes and run the task.
As a result, the set of Kaspersky Endpoint Security components on users' computers will be changed in silent
mode. The settings of available components will be displayed in the local interface of the application. The
components that were not included in the application are disabled, and the settings of these components are
not available.

Upgrading from a previous version of the application
When you update a previous version of the application to a newer version, consider the following:
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We recommend quitting all active applications before starting the update.
If the computer has hard drives that are encrypted using Full Disk Encryption (FDE), then you need to decrypt
all encrypted hard drives to upgrade Kaspersky Endpoint Security from version 10 to version 11.0.0 or later.
Before updating, Kaspersky Endpoint Security blocks the Full Disk Encryption functionality. If Full Disk
Encryption could not be locked, the upgrade installation will not start. After updating the application, the
Full Disk Encryption functionality will be restored.
Kaspersky Endpoint Security supports updates for the following versions of the application:
Kaspersky Endpoint Security 10 Service Pack 2 Maintenance Release 3 for Windows (build 10.3.3.275).
Kaspersky Endpoint Security 10 Service Pack 2 Maintenance Release 4 for Windows (build 10.3.3.304).
Kaspersky Endpoint Security 11.0.0 for Windows (build 11.0.0.6499).
Kaspersky Endpoint Security 11.0.1 for Windows (build 11.0.1.90).
Kaspersky Endpoint Security 11.0.1 for Windows SF1 (build 11.0.1.90).
Kaspersky Endpoint Security 11.1.0 for Windows (build 11.1.0.15919).
Kaspersky Endpoint Security 11.1.1 for Windows (build 11.1.1.126).
Kaspersky Endpoint Security 11.2.0 for Windows (build 11.2.0.2254).
Kaspersky Endpoint Security 11.2.0 for Windows CF1 (build 11.2.0.2254).
Kaspersky Endpoint Security 11.3.0 for Windows (build 11.3.0.773).
Kaspersky Endpoint Security 11.4.0 for Windows (build 11.4.0.233).
Kaspersky Endpoint Security 11.5.0 for Windows (build 11.5.0.590).
Kaspersky Endpoint Security 11.6.0 for Windows (build 11.6.0.394).
When upgrading Kaspersky Endpoint Security 10 Service Pack 2 for Windows to Kaspersky Endpoint Security
11.7.0 for Windows, the les that were placed in either Backup or Quarantine in the previous version of the
application are transferred to Backup in the new version of the application. For versions earlier than Kaspersky
Endpoint Security 10 Service Pack 2 for Windows, les that were placed in Backup and Quarantine in a
previous version of the application are not migrated to the newer version.
Kaspersky Endpoint Security can be updated on the computer in the following ways:
locally, by using the Setup Wizard.
locally from the command line.
remotely using Kaspersky Security Center.
remotely through the Microsoft Windows Group Policy Management Editor (for more details, visit the Microsoft
Technical Support website ).
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remotely, by using the System Center Con guration Manager.
If the application that is deployed in the corporate network features a set of components other than the default
set, updating the application through the Administration Console (MMC) is di erent from updating the application
through the Web Console and Cloud Console. When you update Kaspersky Endpoint Security, consider the
following:
Kaspersky Security Center Web Console or Kaspersky Security Center Cloud Console.
If you created an installation package for the new version of the application with the default set of
components, then the set of components on a user's computer will not be changed. To use Kaspersky Endpoint
Security with the default set of components, you need to open the installation package properties, change the
set of components, then revert to the original set of components and save the changes.
Kaspersky Security Center Administration Console.
The set of application components after the update will match the set of components in the installation
package. That is, if the new version of the application has the default set of components, then, for example,
BadUSB Attack Prevention will be removed from the computer, since this component is excluded from the
default set. To continue using the application with the same set of components as before the update, select
the required components in the installation package settings.

Remove the application
Removing Kaspersky Endpoint Security leaves the computer and user data unprotected against threats.
Kaspersky Endpoint Security can be uninstalled from the computer in the following ways:
locally, by using the Setup Wizard;
locally from the command line;
remotely, by using Kaspersky Security Center (refer to the Kaspersky Security Center Help
information);

for more

remotely through the Microsoft Windows Group Policy Management Editor (for more details, visit the Microsoft
Technical Support website ).
If you selected the Endpoint Agent component during installation of the application, the following two
applications will be installed on the computer: Kaspersky Endpoint Security and Kaspersky Endpoint Agent.
After uninstalling Kaspersky Endpoint Security, Kaspersky Endpoint Agent will also be uninstalled
automatically.

Uninstalling through Kaspersky Security Center
You can remotely uninstall the application by using the Uninstall application remotely task. When performing the
task, Kaspersky Endpoint Security downloads the application uninstall utility to the user's computer. After
completing uninstallation of the application, the utility will be automatically removed.
How to remove the application through the Administration Console (MMC)
61

1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Security Center Administration Server → Additional → Uninstall application remotely.

Step 2. Selecting the application to be removed
Select Uninstall application supported by Kaspersky Security Center.

Step 3. Task settings for application uninstallation
Select Kaspersky Endpoint Security for Windows (11.7.0).

Step 4. Uninstall utility settings
Con gure the following additional application settings:
Force download of the uninstallation utility. Select the utility delivery method:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Kaspersky Endpoint Security is then uninstalled
by the tools of Network Agent.
Using operating system resources through Administration Server. The utility will be delivered to
client computers by using operating system resources through the Administration Server. You can
select this option if Network Agent is not installed on the client computer, but the client computer is in
the same network as the Administration Server.
Using operating system resources through distribution points. The utility is delivered to client
computers using operating system resources via distribution points. You can select this option if there
is at least one distribution point in the network. For more details about distribution points, refer to the
Kaspersky Security Center Help .
Verify operating system type before downloading. If necessary, clear this check box. This lets you avoid
downloading the uninstall utility if the operating system of the computer does not meet the software
requirements. If you are sure that the operating system of the computer meets the software requirements,
you can skip this veri cation.
If the application uninstallation operation is password protected, do the following:
1. Select the Use uninstallation password check box.
2. Click the Edit button.
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3. Enter the KLAdmin account password.

Step 5. Selecting the operating system restart setting
After uninstalling the application, a restart is required. Select the action that will be performed to restart the
computer.

Step 6. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 7. Selecting the account to run the task
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you uninstall Kaspersky Endpoint
Security using Network Agent tools, you do not have to select an account.

Step 8. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or when the computer is idle.

Step 9. De ning the task name
Enter a name for the task, such as Remove Kaspersky Endpoint Security 11.7.0.

Step 10. Finishing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.
The application will be uninstalled in silent mode.
How to remove the application through the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Security Center.
2. In the Task type drop-down list, select Uninstall application remotely.
3. In the Task name eld, enter a brief description, for example, Uninstall Kaspersky Endpoint
Security from Technical Support computers.
4. In the Select devices to which the task will be assigned section, select the task scope.

Step 2. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. For example, select a separate administration
group or build a selection.

Step 3. Con guring application uninstallation settings
At this step, con gure the application uninstallation settings:
1. Select Uninstall managed application.
2. Select Kaspersky Endpoint Security for Windows (11.7.0).
3. Force download of the uninstallation utility. Select the utility delivery method:
Using Network Agent. If Network Agent has not been installed on the computer, rst Network Agent
will be installed using the tools of the operating system. Kaspersky Endpoint Security is then uninstalled
by the tools of Network Agent.
Using operating system resources through Administration Server. The utility will be delivered to
client computers by using operating system resources through the Administration Server. You can
select this option if Network Agent is not installed on the client computer, but the client computer is in
the same network as the Administration Server.
Using operating system resources through distribution points. The utility is delivered to client
computers using operating system resources via distribution points. You can select this option if there
is at least one distribution point in the network. For more details about distribution points, refer to the
Kaspersky Security Center Help .
4. In the Maximum number of concurrent downloads eld, set a limit on the number of requests sent to the
Administration Server to download the application uninstall utility. A limit on the number of requests will
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help prevent the network from being overload.
5. In the Maximum number of uninstallation attempts eld, set a limit on the number of attempts to uninstall
the application. If uninstallation of Kaspersky Endpoint Security ends with an error, the task will
automatically start the uninstallation again.
6. If necessary, clear the Verify operating system type before downloading check box. This lets you avoid
downloading the uninstall utility if the operating system of the computer does not meet the software
requirements. If you are sure that the operating system of the computer meets the software requirements,
you can skip this veri cation.

Step 4. Selecting the account to run the task
Select the account for installing Network Agent using the tools of the operating system. In this case,
administrator rights are required for computer access. You can add multiple accounts. If an account does not
have su icient rights, the Installation Wizard uses the next account. If you uninstall Kaspersky Endpoint
Security using Network Agent tools, you do not have to select an account.

Step 5. Completing task creation
Finish the wizard by clicking the Finish button. A new task will be displayed in the list of tasks.
To run a task, select the check box opposite the task and click the Start button. The application will be
uninstalled in silent mode. After uninstallation is complete, Kaspersky Endpoint Security shows a prompt to
restart the computer.
If the application uninstallation operation is password protected, enter the KLAdmin account password in
the properties of the Uninstall application remotely task. Without the password, the task will not be
performed.

To use the KLAdmin account password in the Uninstall application remotely task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Kaspersky Security Center task Uninstall application remotely.
The task properties window opens.
3. Select the Application settings tab.
4. Select the Use uninstallation password check box.
5. Enter the KLAdmin account password.
6. Click the Save button.

Uninstalling the application using the Wizard
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Kaspersky Endpoint Security is removed using the normal method for a Windows operating system, which is
through the Control Panel. The Setup Wizard starts. Follow the instructions on the screen.
You can specify which of the data that is used by the application you want to save for future use, during the next
installation of the application (such as when upgrading to a newer version of the application). If you do not specify
any data, the application will be completely removed.
You can save the following data:
Activation data, which lets you avoid having to activate the application again. Kaspersky Endpoint Security
automatically adds a license key if the license term has not expired prior to installation.
Backup les – les that are scanned by the application and placed in Backup.
Backup les that are saved after removal of the application can be accessed only from the same version
of the application that was used to save those les.

If you plan to use Backup objects after removal of the application, you must restore those objects before
removing the application. However, Kaspersky experts do not recommend restoring objects from Backup
because this may harm the computer.
Operational settings of the application – values of application settings that are selected during application
con guration.
Local storage of encryption keys – data that provides access to les and drives that were encrypted before
removal of the application. To ensure access to encrypted les and drives, make sure that you selected data
encryption functionality when reinstalling Kaspersky Endpoint Security. No further action is required for access
to previously encrypted les and drives.
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Application licensing
This section provides information about general concepts related to application licensing.

About the End User License Agreement
The End User License Agreement is a binding agreement between you and AO Kaspersky Lab stipulating the terms
on which you may use the application.
We recommend carefully reading the terms of the License Agreement before using the application.
You can view the terms of the License Agreement in the following ways:
When installing Kaspersky Endpoint Security in interactive mode.
By reading the license.txt le. This document is included in the application distribution kit and is also located in
the application installation folder %ProgramFiles(x86)%\Kaspersky Lab\Kaspersky Endpoint
Security for Windows\Doc\<locale>\KES.
By con rming that you agree with the End User License Agreement when installing the application, you signify your
acceptance of the terms of the End User License Agreement. If you do not accept the terms of the End User
License Agreement, you must abort the installation.

About the license
A license is a time-limited right to use the application, granted under the End User License Agreement.
A valid license entitles you to the following kinds of services:
Use of the application in accordance with the terms of the End User License Agreement
Technical Support
The scope of services and application usage term depend on the type of license under which the application was
activated.
The following license types are provided:

Trial – a free license intended for trying out the application.
A trial license usually has a short term. When the trial license expires, all Kaspersky Endpoint Security features
become disabled. To continue using the application, you must purchase a commercial license.
You can activate the application under a trial license only once.

Commercial – a paid license that is provided when you purchase Kaspersky Endpoint Security.
Application functionality available under the commercial license depends on the choice of product. The
selected product is indicated in the License Certi cate. Information on available products may be found on the
Kaspersky website .
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When the commercial license expires, the application continues to work in limited functionality mode. You can
use protection and control components and run a scan using the application databases that were installed
before the license expired. The application also continues to encrypt les that had been modi ed and
encrypted before license expiration, but does not encrypt new les. Use of Kaspersky Security Network is not
available.
To continue using Kaspersky Endpoint Security in fully functional mode, you must renew your commercial
license.
We recommend renewing the license before its expiration to ensure that your computer stays fully protected
against threats.

About the license certi cate
A license certi cate is a document transferred to the user together with a key le or activation code.
The license certi cate contains the following license information:
License key or order number.
Details of the user to whom the license is granted.
Details of the application that can be activated using the license.
Limitation on the number of licensed units (for example, the number of devices on which the application can be
used under the license).
License term start date.
License expiration date or license term.
License type.

About subscription
A subscription for Kaspersky Endpoint Security is a purchase order for the application with speci c parameters
(such as the subscription expiry date and number of devices protected). You can order a subscription for
Kaspersky Endpoint Security from your service provider (such as your ISP). A subscription can be renewed
manually or automatically, or you may cancel your subscription. You can manage your subscription on the website
of the service provider.
Subscription can be limited (for one year, for example) or unlimited (without an expiry date). To keep Kaspersky
Endpoint Security working after the limited subscription term expires, you need to renew your subscription.
Unlimited subscription is renewed automatically if the vendor's services have been prepaid on time.
When a limited subscription expires, you may be provided a subscription renewal grace period during which the
application continues to function. The availability and duration of such a grace period is decided by the service
provider.
To use Kaspersky Endpoint Security under a subscription, you need to apply the activation code received from the
service provider. After the activation code is applied, the active key is added. The active key determines the license
for using the application under the subscription. It is not possible to add a reserve key under a subscription.
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Activation codes purchased under subscription may not be used to activate previous versions of Kaspersky
Endpoint Security.

About license key
A license key is a sequence of bits that you can use to activate and then use the application in accordance with
the terms of the End User License Agreement.
A license certi cate is not provided for a key that is added under a subscription.
You can add a license key to the application by either applying a key le or entering an activation code.
The key can be blocked by Kaspersky if the terms of the End User License Agreement are violated. If the key has
been blocked, you need to add a di erent key to continue using the application.
There are two types of keys: active and reserve.
An active key is a key that is currently used by the application. A trial or commercial license key can be added as
the active key. The application cannot have more than one active key.
A reserve key is a key that entitles the user to use the application, but is not currently in use. At the expiry of the
active key, a reserve key automatically becomes active. A reserve key can be added only if the active key is
available.
A key for a trial license can be added only as an active key. It cannot be added as the reserve key. A trial license
key cannot replace the active key to a commercial license.
If a key is added to the list of prohibited keys, the application functionality de ned by the license used to activate
the application remains available for eight days. The application noti es the user that the key has been added to
the list of prohibited keys. After eight days, application functionality becomes limited to the functionality level that
is available after license expiry. You can use protection and control components and run a scan using the
application databases that were installed before the license expired. The application also continues to encrypt les
that had been modi ed and encrypted before license expiration, but does not encrypt new les. Use of Kaspersky
Security Network is not available.

About activation code
An activation code is a unique sequence of 20 alphanumeric characters. You enter an activation code to add a
license key that activates Kaspersky Endpoint Security. You receive an activation code at the email address you
speci ed after purchasing Kaspersky Endpoint Security.
To activate the application with an activation code, Internet access is required to connect to Kaspersky activation
servers.
When the application is activated using an activation code, the active key is added. A reserve key can be added
only by using an activation code and cannot be added using a key le.
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If an activation code is lost after activating the application, you can restore the activation code. You may need an
activation code, for example, to register a Kaspersky CompanyAccount . If the activation code was lost after the
application activation, contact Kaspersky partner from whom you purchased the license.

About the key le
A key le is a le with the .key extension that you receive from Kaspersky. The purpose of a key le is to add a
license key that activates the application.
You receive a key le at the email address that you provided when you purchased Kaspersky Endpoint Security or
ordered the trial version of Kaspersky Endpoint Security.
You do not need to connect to Kaspersky activation servers in order to activate the application with a key le.
You can recover a key le if it has been accidentally deleted. You may need a key le to register a Kaspersky
CompanyAccount, for example.
To recover a key le, do one of the following:
Contact the license seller.
Obtain a key le on the Kaspersky website

based on your existing activation code.

When the application is activated using a key le, an active key is added. A reserve key can be added only by using
a key le and cannot be added using an activation code.

Activating the application
Activation is the process of activating a license that allows you to use a fully functional version of the application
until the license expires. The application activation involves adding a license key.
You can activate the application in one of the following ways:
Locally from the application interface, by using the Activation Wizard You can add both the active key and the
reserve key in this way.
Remotely with the Kaspersky Security Center software suite by creating and then starting an add license key
task. You can add both the active key and the reserve key in this way.
Remotely by distributing key les and activation codes stored in the Kaspersky Security Center Administration
Server key storage to client computers. For more details on distributing keys, please refer to the Kaspersky
Security Center Help . You can add both the active key and the reserve key in this way.
The activation code purchased under subscription is distributed in the rst place.
Using the command line.
It may take some time for the application to be activated with an activation code (during either remote or
non-interactive installation) due to load distribution across activation servers of Kaspersky. If you need to
activate the application right away, you may interrupt the ongoing activation process and start activation
using the Activation Wizard.
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Activating the application through Kaspersky Security Center
You can activate the application remotely through Kaspersky Security Center in the following ways:
Using the Add key task.
This method lets you add a key to a speci c computer or to computers that are part of an administration group.
By distributing a key stored on the Kaspersky Security Center Administration Server to the computers.
This method lets you automatically add a key to computers that are already connected to Kaspersky Security
Center, and to new computers. To use this method, you need to rst add the key to the Kaspersky Security
Center Administration Server. For more details about adding keys to the Kaspersky Security Center
Administration Server, please refer to Kaspersky Security Center Help .
A trial version is provided for Kaspersky Security Center Cloud Console. The trial version is a special version of
Kaspersky Security Center Cloud Console designed to familiarize a user with the features of the application. In this
version, you can perform actions in a workspace for a period of 30 days. All managed applications are automatically
run under a trial license for Kaspersky Security Center Cloud Console, including Kaspersky Endpoint Security.
However, you cannot activate Kaspersky Endpoint Security using its own trial license when the trial license for
Kaspersky Security Center Cloud Console expires. For detailed information about Kaspersky Security Center
licensing, please refer to the Kaspersky Security Center Cloud Console Help .
The trial version of Kaspersky Security Center Cloud Console does not allow you to subsequently switch to a
commercial version. Any trial workspace will be automatically deleted with all its contents after the 30-day
period expires.
You can monitor the use of licenses in the following ways:
View the Key usage report for the organization's infrastructure (Monitoring and reporting → Reports).
View the statuses of computers on the Devices → Managed devices tab. If the application is not activated,
the computer will have the status and the Application is not activated status description.
View license information in the computer properties.
View the key properties (Operations → Licensing).
How to activate the application in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → Add key.

Step 2. Adding a key
Enter an activation code or select a key le.
For more details about adding keys to the Kaspersky Security Center repository, please refer to the Kaspersky
Security Center Help .

Step 3. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 4. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or when the computer is idle.

Step 5. De ning the task name
Enter a name for the task, such as Activate Kaspersky Endpoint Security for Windows.

Step 6. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties. As a result, Kaspersky Endpoint Security will be activated on
users' computers in silent mode.
How to activate the application in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
2. In the Task type drop-down list, select Add key.
3. In the Task name eld, enter a brief description, such as Activation of Kaspersky Endpoint
Security for Windows.
4. In the Select devices to which the task will be assigned section, select the task scope. Click the Next
button.

Step 2. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 3. Selecting a license
Select the license that you want to use to activate the application. Click the Next button.
You can add keys to the Web Console (Operations → Licensing).

Step 4. Completing task creation
Finish the wizard by clicking the Finish button. A new task will be displayed in the list of tasks. To run a task,
select the check box opposite the task and click the Start button. As a result, Kaspersky Endpoint Security
will be activated on users' computers in silent mode.
In the properties of the Add key task, you can add a reserve key to the computer. A reserve key becomes active
when the active key expires or is deleted. The availability of a reserve key lets you avoid application functionality
limitations when a license expires.
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How to automatically add a license key to computers through the Administration Console (MMC)

1. In the Administration Console, go to the folder Administration Server → Kaspersky licenses.
A list of license keys opens.
2. Open the license key properties.
3. In the General section, select the Automatically distributed license key check box.
4. Save your changes.
As a result, the key will be automatically distributed to the appropriate computers. During automatic
distribution of a key as an active or a reserve key, the licensing limit on the number of computers (set in the
key properties) is taken into account. If the licensing limit is reached, distribution of this key to computers
ceases automatically. You can view the number of computers to which the key has been added and other
data in the key properties in the Devices section.
How to automatically add a license key to computers through the Web Console and Cloud Console

1. In Web Console main window, select the Operations → Licensing → Kaspersky Licenses.
A list of license keys opens.
2. Open the license key properties.
3. On the General tab, switch on the Deploy license key automatically toggle button.
4. Save your changes.
As a result, the key will be automatically distributed to the appropriate computers. During automatic
distribution of a key as an active or a reserve key, the licensing limit on the number of computers (set in the
key properties) is taken into account. If the licensing limit is reached, distribution of this key to computers
ceases automatically. You can view the number of computers to which the key has been added and other
data in the key properties on the Devices tab.

Using the Activation Wizard to activate the application
To activate Kaspersky Endpoint Security by using the Activation Wizard:
1. In the main application window, go to the License section.
2. Click Activate the application using a new license.
The Application Activation Wizard starts. Follow the instructions of the Activation Wizard.

Viewing license information
To view information about a license:
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In the main application window, go to the License section (see the gure below).

Licensing window

The section displays the following details:
Key status. Several keys can be stored on a computer. There are two types of keys: active and reserve. The
application cannot have more than one active key. A reserve key can become active only after the active key
expires or after the active key is deleted by clicking Delete.
Application name. Full name of the purchased Kaspersky application.
License. The following types of licenses are available: trial and commercial.
Functionality. Application features that are available under your license. Features may include Protection,
Security Controls, Data Encryption, and others. The list of available features is also provided in the License
Certi cate.
Additional information about the license. Start date and end date of the license term (only for the active key),
remaining duration of the license term.
License expiration time is displayed according to the time zone con gured in the operating system.
Key. A key is a unique alphanumeric sequence that is generated from an activation code or a key le.
In the Licensing window, you can also do one of the following:
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Purchase license / Renew license. Opens the Kaspersky online store website, where you can purchase or
renew a license. To do so, please enter your company information and pay for the order.
Activate the application using a new license. Starts the Application Activation Wizard. In this Wizard you can
add a key using an activation code or a key le. The Application Activation Wizard allows you to add an active
key and only one reserve key.

Purchasing a license
You may purchase a license after installing the application. On purchasing a license, you receive an activation code
or a key le for activating the application.

To purchase a license:
1. In the main application window, go to the License section.
2. Do one of the following:
If no keys have been added or a key for trial license has been added, click the Purchase license button.
If the key for a commercial license is added, click the Renew license button.
A window will open with the website of the Kaspersky online store, where you can purchase a license.

Renewing subscription
When you use the application under subscription, Kaspersky Endpoint Security automatically contacts the
activation server at speci c intervals until your subscription expires.
If you use the application under unlimited subscription, Kaspersky Endpoint Security automatically checks the
activation server for renewed keys in background mode. If a key is available on the activation server, the application
adds it by replacing the previous key. In this way, unlimited subscription for Kaspersky Endpoint Security is renewed
without user involvement.
If you are using the application under a limited subscription, on the expiration date of the subscription (or on the
expiration date of the subscription renewal grace period), Kaspersky Endpoint Security noti es you about this and
stops attempting to renew the subscription automatically. In this case, Kaspersky Endpoint Security behaves in the
same way as it does when a commercial license for the application expires: the application operates without
updates and the Kaspersky Security Network is unavailable.
You can renew subscription on the website of the service provider.

To visit the website of the service provider from the application interface:
1. In the main application window, go to the License section.
2. Click Contact your subscription provider.
You can update subscription status manually. This may be required if the subscription has been renewed after
the grace period and the application has not updated the subscription status automatically.
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Data provision

Data provision under the End User License Agreement
If an activation code is applied to activate Kaspersky Endpoint Security, you agree to periodically send Kaspersky
the following information automatically for the purposes of verifying correct use of the application:
type, version, and localization of Kaspersky Endpoint Security;
versions of installed updates for Kaspersky Endpoint Security;
ID of the computer and ID of the speci c Kaspersky Endpoint Security installation on the computer;
serial number and active key identi er;
type, version and bit rate of the operating system, and name of the virtual environment (if Kaspersky Endpoint
Security is installed in a virtual environment);
IDs of Kaspersky Endpoint Security components that are active when the information is transmitted.
Kaspersky may also use this information to generate statistics on the dissemination and use of Kaspersky
software.
By using an activation code, you agree to automatically transmit the data listed above. If you do not agree to
transmit this information to Kaspersky, you should use a key le to activate Kaspersky Endpoint Security.
By accepting the terms of the End User License Agreement, you agree to automatically transmit the following
information:
When upgrading Kaspersky Endpoint Security:
version of Kaspersky Endpoint Security;
ID of Kaspersky Endpoint Security;
active key;
unique ID of the upgrade task start;
unique ID of the Kaspersky Endpoint Security installation.
When following links from the Kaspersky Endpoint Security interface:
version of Kaspersky Endpoint Security;
version of the operating system;
Kaspersky Endpoint Security activation date;
license expiration date;
key creation date;
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Kaspersky Endpoint Security installation date;
ID of Kaspersky Endpoint Security;
ID of the detected vulnerability in the operating system;
ID of the last update installed for Kaspersky Endpoint Security;
hash of the detected le with a threat, and the name of this threat according to the Kaspersky
classi cation;
Kaspersky Endpoint Security activation error category;
Kaspersky Endpoint Security activation error code;
number of days until key expiration;
number of days that have elapsed since the key was added;
number of days that have elapsed since the license expired;
number of computers on which the active license is applied;
active key;
Kaspersky Endpoint Security license term;
current status of the license;
type of active license;
application type;
unique ID of the upgrade task start;
unique ID of the Kaspersky Endpoint Security installation on the computer;
Kaspersky Endpoint Security interface language.
Received information is protected by Kaspersky in accordance with the law and the requirements and applicable
regulations of Kaspersky. Data is transmitted over encrypted communication channels.
Read the End User License Agreement and visit the Kaspersky website to learn more about how we receive,
process, store, and destroy information about application usage after you accept the End User License
Agreement and consent to the Kaspersky Security Network Statement. The license.txt and ksn_<language ID>.txt
les contain the text of the End User License Agreement and Kaspersky Security Network Statement and are
included in the application distribution kit.

Data provision when using Kaspersky Security Network
The set of data that Kaspersky Endpoint Security sends to Kaspersky depends on the type of license and the
Kaspersky Security Network usage settings.

Use of KSN under license on no more than 4 computers
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By accepting the Kaspersky Security Network Statement, you agree to automatically transmit the following
information:
information about KSN con guration updates: identi er of the active con guration, identi er of the
con guration received, error code of the con guration update;
information about les and URL addresses to be scanned: checksums of the scanned le (MD5, SHA2-256,
SHA1) and le patterns (MD5), the size of the pattern, type of the detected threat and its name according to
Rightholder's classi cation, identi er for the anti-virus databases, URL address for which the reputation is
being requested, as well as the referrer URL address, the connection's protocol identi er and the number of the
port being used;
ID of the scan task that detected the threat;
information about digital certi cates being used needed to verify their authenticity: the checksums (SHA256)
of the certi cate used to sign the scanned object and the certi cate's public key;
identi er of the Software component performing the scan;
IDs of the anti-virus databases and of the records in these anti-virus databases;
Information about activation of the Software on the Computer: signed header of the ticket from the activation
service (identi er of the regional activation center, checksum of the activation code, checksum of the ticket,
ticket creation date, unique identi er of the ticket, ticket version, license status, start/end date and time of
ticket validity, unique identi er of the license, license version), identi er of the certi cate used to sign the ticket
header, checksum (MD5) of the key le;
Information about the Rightholder's Software: full version, type, version of the protocol used to connect to
Kaspersky services.

Use of KSN under license on 5 or more computers
By accepting the Kaspersky Security Network Statement, you agree to automatically transmit the following
information:
If the Kaspersky Security Network check box is selected and the Enable extended KSN mode check box is
cleared, the application sends the following information:
information about KSN con guration updates: identi er of the active con guration, identi er of the
con guration received, error code of the con guration update;
information about les and URL addresses to be scanned: checksums of the scanned le (MD5, SHA2-256,
SHA1) and le patterns (MD5), the size of the pattern, type of the detected threat and its name according to
Rightholder's classi cation, identi er for the anti-virus databases, URL address for which the reputation is
being requested, as well as the referrer URL address, the connection's protocol identi er and the number of the
port being used;
ID of the scan task that detected the threat;
information about digital certi cates being used needed to verify their authenticity: the checksums (SHA256)
of the certi cate used to sign the scanned object and the certi cate's public key;
identi er of the Software component performing the scan;
IDs of the anti-virus databases and of the records in these anti-virus databases;
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Information about activation of the Software on the Computer: signed header of the ticket from the activation
service (identi er of the regional activation center, checksum of the activation code, checksum of the ticket,
ticket creation date, unique identi er of the ticket, ticket version, license status, start/end date and time of
ticket validity, unique identi er of the license, license version), identi er of the certi cate used to sign the ticket
header, checksum (MD5) of the key le;
Information about the Rightholder's Software: full version, type, version of the protocol used to connect to
Kaspersky services.
If the Enable extended KSN mode check box is selected in addition to the Kaspersky Security Network check
box, the application sends the following information in addition to the information listed above:
information about the results of categorization of the requested web-resources, which contains the processed
URL and IP address of the host, the version of the Software's component that performed the categorization,
the method of categorization and set of the categories de ned for the web-resource;
information about the software installed on the Computer: names of the software applications and software
vendors, registry keys and their values, information about les of the installed software components
(checksums (MD5, SHA2-256, SHA1), name, path to the le on the Computer, size, version and the digital
signature);
information about the state of anti-virus protection of the Computer: the versions and the release timestamps
of the anti-virus databases being used, the ID of the task and the ID of Software that performs scanning;
information about les being downloaded by the End User: the URL and IP addresses of the download and the
download pages, download protocol identi er and connection port number, the status of the URLs as malicious
or not, le's attributes, size and checksums (MD5, SHA2-256, SHA1), information about the process that
downloaded the le (checksums (MD5, SHA2-256, SHA1), creation/build date and time, autoplay status,
attributes, names of packers, information about signatures, executable le ag, format identi er, and entropy),
le name and its path on the Computer, the le's digital signature and timestamp of its generation, the URL
address where detection occurred, the script's number on the page that appears to be suspicious or harmful,
information about HTTP requests generated and the response to them;
information about the running applications and their modules: data about processes running on the system
(process ID (PID), process name, information about the account the process was started from, the application
and command that started the process, the sign of trusted program or process, the full path to the process's
les and their checksums (MD5, SHA2-256, SHA1), and the starting command line, level of the process's
integrity, a description of the product that the process belongs to (the name of the product and information
about the publisher), as well as digital certi cates being used and information needed to verify their
authenticity or information about the absence of a le's digital signature), and information about the modules
loaded into the processes (their names, sizes, types, creation dates, attributes, checksums (MD5, SHA2-256,
SHA1), the paths to them on the Computer), PE- le header information, names of packers (if the le was
packed);
information about all potentially malicious objects and activities: name of the detected object and full path to
the object on the computer, checksums of processed les (MD5, SHA2-256, SHA1), detection date and time,
names and sizes of infected les and paths to them, path template code, executable le ag, indicator of
whether the object is a container, names of the packer (if the le was packed), le type code, le format ID, list
of actions performed by malware and the decision made by the software and user in response to them, IDs of
the anti-virus databases and of the records in these anti-virus databases that were used to make the decision,
indicator of a potentially malicious object, the name of the detected threat according to the Rightholder’s
classi cation, the level of danger, the detection status and detection method, reason for inclusion into the
analyzed context and sequence number of the le in the context, checksums (MD5, SHA2-256, SHA1), the name
and attributes of the executable le of the application through which the infected message or link was
transmitted, depersonalized IP addresses (IPv4 and IPv6) of the host of the blocked object, le entropy, le
autorun indicator, time when the le was rst detected in the system, the number of times the le has been run
since the last statistics were sent, information about the name, checksums (MD5, SHA2-256, SHA1) and size of
the mail client through which the malicious object was received, ID of the software task that performed the
scan, indicator of whether the le reputation or signature was checked, le processing result, checksum (MD5)
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of the pattern collected for the object, the size of the pattern in bytes, and the technical speci cations of the
applied detection technologies;
information about scanned objects: the assigned trust group to which and/or from which the le has been
placed, the reason the le was placed in that category, category identi er, information about the source of the
categories and the version of the category database, the le's trusted certi cate ag, name of the le's vendor,
le version, name and version of the software application which includes the le;
information about vulnerabilities detected: the vulnerability ID in the database of vulnerabilities, the vulnerability
danger class;
information about emulation of the executable le: le size and its checksums (MD5, SHA2-256, SHA1), the
version of the emulation component, emulation depth, an array of properties of logical blocks and functions
within logical blocks obtained during the emulation, data from the executable le's PE headers;
the IP addresses of the attacking computer (IPv4 and IPv6), the number of the port on the Computer that the
network attack is directed at, identi er of the protocol of the IP packet containing the attack, the attack's
target (organization name, website), ag for the reaction to the attack, the attack's weight, trust level;
information about attacks associated with spoofed network resources, the DNS and IP addresses (IPv4 and
IPv6) of visited websites;
DNS and IP addresses (IPv4 or IPv6) of the requested web resource, information about the le and web client
accessing the web resource, the name, size and checksums (MD5, SHA2-256, SHA1) of the le, full path to the
le and path template code, the result of checking its digital signature, and its status in KSN;
information about rollback of malware actions: data on the le whose activity was rolled back (name of the le,
full path to the le, its size and checksums (MD5, SHA2-256, SHA1)), data on successful and unsuccessful
actions to delete, rename and copy les and restore the values in the registry (names of registry keys and their
values), and information about system les modi ed by malware, before and after rollback;
Information about the exclusions set for the Adaptive Anomaly Control component: the ID and status of the
rule that was triggered, the action performed by the Software when the rule was triggered, the type of user
account under which the process or the thread performs suspicious activity, information about the process
that performed or was subject to the suspicious activity (script ID or process le name, full path to the process
le, path template code, checksums (MD5, SHA2-256, SHA1) of the process le); information about the object
that performed the suspicious actions and about the object that was subject to the suspicious actions
(registry key name or le name, full path to the le, path template code, and checksums (MD5, SHA2-256, SHA1)
of the le).
information about loaded software modules: name, size and checksums (MD5, SHA2-256, SHA1) of the module
le, full path to it and the path template code, digital signature settings of the module le, data and time of
signature creation, name of the subject and organization that signed the module le, ID of the process in which
the module was loaded, name of the module supplier, and the sequence number of the module in the loading
queue;
information about the quality of Software interaction with the KSN services: start and end date and time of the
period when the statistics were generated, information about the quality of requests and connection to each
of the KSN services used (KSN service ID, number of successful requests, number of requests with responses
from cache, number of unsuccessful requests (network problems, KSN being disabled in the Software settings,
incorrect routing), time spread of the successful requests, time spread of the cancelled requests, time spread
of the requests with exceeded time limit, number of connections to KSN taken from cache, number of
successful connections to KSN, number of unsuccessful connections to KSN, number of successful
transactions, number of unsuccessful transactions, time spread of the successful connections to KSN, time
spread of the unsuccessful connections to KSN, time spread of the successful transactions, time spread of the
unsuccessful transactions);
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if a potentially malicious object is detected, information is provided about data in the processes' memory:
elements of the system object hierarchy (ObjectManager), data in UEFI BIOS memory, names of registry keys
and their values;
information about events in the systems logs: the event's timestamp, the name of the log in which the event
was found, type and category of the event, name of the event's source and the event's description;
information about network connections: version and checksums (MD5, SHA2-256, SHA1) of the le from which
process was started that opened the port, the path to the process's le and its digital signature, local and
remote IP addresses, numbers of local and remote connection ports, connection state, timestamp of the port's
opening;
information about the date of Software installation and activation on the Computer: the ID of the partner that
sold the license, the serial number of the license, the signed header of the ticket from the activation service
(the ID of a regional activation center, the checksum of the activation code, the checksum of the ticket, the
ticket creation date, the unique ID of the ticket, the ticket version, the license status, the ticket start/end date
and time, the unique ID of the license, the license version), the ID of the certi cate used to sign the ticket
header, the checksum (MD5) of the key le, the unique ID of Software installation on the Computer, the type
and ID of the application that gets updated, the ID of the update task;
information about the set of all installed updates, and the set of most recently installed/removed updates, the
type of event that caused the update information to be sent, duration since the installation of last update,
information about any currently installed anti-virus databases;
information about software operation on the computer: data on CPU usage, data on memory usage (Private
Bytes, Non-Paged Pool, Paged Pool), number of active threads in the software process and pending threads,
and the duration of software operation prior to the error;
number of software dumps and system dumps (BSOD) since the Software was installed and since the time of
the last update, the identi er and version of the Software module that crashed, the memory stack in the
Software's process, and information about the anti-virus databases at the time of the crash;
data on the system dump (BSOD): a ag indicating the occurrence of the BSOD on the Computer, the name of
the driver that caused the BSOD, the address and memory stack in the driver, a ag indicating the duration of
the OS session before the BSOD occurred, memory stack of driver that crashed, type of stored memory dump,
ag for the OS session before BSOD lasted more than 10 minutes, unique identi er of the dump, timestamp of
the BSOD;
information about errors or performance problems that occurred during operation of the Software
components: the status ID of the Software, error type, code and cause as well of the time when the error
occurred, the IDs of the component, module and process of the product in which the error occurred, the ID of
the task or update category during which the error occurred, logs of drivers used by the Software (error code,
module name, name of the source le and the line where the error occurred);
information about updates of anti-virus databases and Software components: the name, date and time of
index les downloaded during the last update and being downloaded during the current update;
information about abnormal termination of the Software operation: the creation timestamp of the dump, its
type, the type of event that caused the abnormal termination of the Software operation (unexpected powero , third-party application crash), date and time of the unexpected power-o ;
information about the compatibility of Software drivers with hardware and Software: information about OS
properties that restrict the functionality of Software components (Secure Boot, KPTI, WHQL Enforce,
BitLocker, Case Sensitivity), type of download Software installed (UEFI, BIOS), Trusted Platform Module (TPM)
identi er, TPM speci cation version, information about the CPU installed on the Computer, operating mode
and parameters of Code Integrity and Device Guard, operating mode of drivers and reason for use of the
current mode, version of Software drivers, software and hardware virtualization support status of the
Computer;
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information about third-party applications that caused the error: their name, version and localization, the error
code and information about the error from the system log of applications, the address of the error and memory
stack of the third-party application, a ag indicating the occurrence of the error in the Software component,
the length of time the third-party application was in operation before the error occurred, checksums (MD5,
SHA2-256, SHA1) of the application process image, in which the error occurred, path to the application process
image and template code of the path, information from the system log with a description of the error
associated with the application, information about the application module, in which an error occurred
(exception identi er, crash memory address as an o set in the application module, name and version of the
module, identi er of the application crash in the Rightholder's plug-in and memory stack of the crash, duration
of the application session before crash);
version of the Software updater component, number of crashes of the updater component while running
update tasks over the lifetime of the component, ID of the update task type, number of failed attempts of the
updater component to complete update tasks;
information about the operation of the Software system monitoring components: full versions of the
components, date and time when the components were started, code of the event that over owed the event
queue and number of such events, the total number of queue over ow events, information about the le of the
process of the initiator of the event ( le name and its path on the Computer, template code of the le path,
checksums (MD5, SHA2-256, SHA1) of the process associated with the le, le version), identi er of the event
interception that occurred, the full version of the interception lter, identi er of the type of the intercepted
event, size of the event queue and the number of events between the rst event in the queue and the current
event, number of overdue events in the queue, information about the le of the process of the initiator of the
current event ( le name and its path on the Computer, template code of the le path, checksums (MD5, SHA2256, SHA1) of the process associated with the le), duration of the event processing, maximum duration of the
event processing, probability of sending statistics, information about OS events for which the processing time
limit was exceeded (date and time of the event, number of repeated initializations of anti-virus databases, date
and time of the last repeated initialization of anti-virus databases after their update, event processing delay
time for each system monitoring component, number of queued events, number of processed events, number
of delayed events of the current type, total delay time for the events of the current type, total delay time for all
events);
information from the Windows event tracing tool (Event Tracing for Windows, ETW) in the event of Software
performance problems, suppliers of SysCon g / SysCon gEx / WinSATAssessment events from Microsoft:
information about the Computer (model, manufacturer, form factor of the housing, version), information about
Windows performance metrics (WinSAT assessments, Windows performance index), domain name, information
about physical and logical processors (number of physical and logical processors, manufacturer, model,
stepping level, number of cores, clock frequency, CPUID, cache characteristics, logic processor characteristics,
indicators of supported modes and instructions), information about RAM modules (type, form factor,
manufacturer, model, capacity, granularity of memory allocation), information about network interfaces (IP and
MAC addresses, name, description, con guration of network interfaces, breakdown of number and size of
network packages by type, speed of network exchange, breakdown of number of network errors by type),
con guration of IDE controller, IP addresses of DNS servers, information about the video card (model,
description, manufacturer, compatibility, video memory capacity, screen permission, number of bits per pixel,
BIOS version), information about plug-and-play devices (name, description, device identi er [PnP, ACPI],
information about disks and storage devices (number of disks or ash drives, manufacturer, model, disk
capacity, number of cylinders, number of tracks per cylinder, number of sectors per track, sector capacity,
cache characteristics, sequential number, number of partitions, con guration of SCSI controller), information
about logical disks (sequential number, partition capacity, volume capacity, volume letter, partition type, le
system type, number of clusters, cluster size, number of sectors per cluster, number of empty and occupied
clusters, letter of bootable volume, o set address of partition in relation to the start of the disk), information
about BIOS motherboard (manufacturer, release date, version), information about motherboard (manufacturer,
model, type), information about physical memory (shared and free capacity), information about operating
system services (name, description, status, tag, information about processes [name and PID]), energy
consumption parameters for the Computer, con guration of interrupt controller, path to Windows system
folders (Windows and System32), information about the OS (version, build, release date, name, type, installation
date), size of page le, information about monitors (number, manufacturer, screen permission, resolution
capacity, type), information about video card driver (manufacturer, release date, version);

83

information from ETW, suppliers of EventTrace / EventMetadata events from Microsoft: information on the
sequence of system events (type, time, date, time zone), metadata about the le with tracing results (name,
structure, tracing parameters, breakdown of number of trace operations by type), information about the ОS
(name, type, version, build, release date, start time);
information from ETW, suppliers of Process / Microsoft Windows Kernel Process / Microsoft Windows Kernel
Processor Power events from Microsoft: information about started and completed processes (name, PID, start
parameters, command line, return code, power management parameters, start and completion time, access
token type, SID, SessionID, number of descriptors installed), information about changes in thread priorities (TID,
priority, time), information about disk operations of the process (type, time, capacity, number), history of
changes to the structure and capacity of usable memory processes;
information from ETW, suppliers of StackWalk / Per nfo events from Microsoft: information about
performance counters (performance of individual code sections, sequence of function calls, PID, TID, addresses
and attributes of ISRs and DPCs);
information from ETW, supplier of KernelTraceControl-ImageID events from Microsoft: information on
executable les and dynamic libraries (name, image size, full path), information on PDB les (name, identi er),
VERSIONINFO resource data for executable les (name, description, creator, localization, application version
and identi er, le version and identi er);
information from ETW, suppliers of FileIo / DiskIo / Image / Windows Kernel Disk events from Microsoft:
information on le and disk operations (type, capacity, start time, completion time, duration, completion status,
PID, TID, driver function call addresses, I/O Request Packet (IRP), Windows le object attributes), information
about les involved in le and disk operations (name, version, size, full path, attributes, o set, image checksum,
open and access options);
information from ETW, supplier of PageFault events from Microsoft: information on memory page access errors
(address, time, capacity, PID, TID, attributes of Windows le object, memory allocation parameters);
information from ETW, supplier of Thread events from Microsoft: information on thread creation/completion,
information on threads started (PID, TID, size of stack, priorities and allocation of CPU resources, I/O resources,
memory pages between threads, stack address, address of init function, address of Thread Environment Block
(TEB), Windows service tag);
information from ETW, supplier of Microsoft Windows Kernel Memory events from Microsoft: information about
memory management operations (completion status, time, quantity, PID), memory allocation structure (type,
capacity, SessionID, PID);
information about Software operation in the event of performance problems: Software installation identi er,
type and value of drop in performance, information about the sequence of events within the Software (time,
time zone, type, completion status, Software component identi er, Software operating scenario identi er, TID,
PID, function call addresses), information about network connections to be checked (URL, direction of the
connection, size of network package), information about PDB les (name, identi er, image size of executable
le), information about les to be checked (name, full path, checksum), Software performance monitoring
parameters;
information about the last unsuccessful OS restart: the number of unsuccessful restarts since OS installation,
data on the system dump (code and parameters of an error, name, version and checksum (CRC32) of the
module that caused an error in the OS operation, error address as an o set in the module, checksums (MD5,
SHA2-256, SHA1) of the system dump);
information to verify authenticity of digital certi cates being used to sign les: the certi cate's ngerprint, the
checksum algorithm, the certi cate's public key and serial number, the name of the issuer of the certi cate, the
result of certi cate validation and the certi cate's database identi er;
information about the process executing the attack on the Software's self-defense: the name and size of the
process le, its checksums (MD5, SHA2-256, SHA1), the full path to the process le and the template code of
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the le path, the creation/build timestamps, executable le ag, attributes of the process le, information
about the certi cate used to sign the process le, code of the account used to launch the process, ID of
operations performed to access the process, type of resource with which the operation is performed (process,
le, registry object, FindWindow search function), name of resource with which the operation is performed, ag
indicating success of the operation, the status of the le of the process and its signature according to the KSN;
information about the Rightholder's Software: full version, type, localization and operation state of Software
used, versions of the installed Software components and their operation state, information about the installed
Software updates, the value of the TARGET lter, the version of the protocol used to connect to the
Rightholder's services;
information about hardware installed on the Computer: type, name, model name, rmware version, parameters
of built-in and connected devices, the unique identi er of the Computer with the installed Software;
information about the versions of the operating system and installed updates, the word size, edition and
parameters of the OS run mode, version and checksums (MD5, SHA2-256, SHA1) of the OS kernel le, and OS
startup date and time;
executable and non-executable les, either entirely or partly;
portions of the Computer's RAM;
sectors involved in the process of booting the OS;
network tra ic data packets;
web pages and emails containing suspicious and malicious objects;
description of the classes and instances of classes of the WMI repository;
application activity reports:
the name, size and version of the le being sent, its description and checksums (MD5, SHA2-256, SHA1), le
format identi er, the name of the le's vendor, the name of the product to which the le belongs, full path to
the le on the Computer, template code of the path, the creation and modi cation timestamps of the le;
start and end date/time of the validity period of the certi cate (if the le has a digital signature), the date
and the time of the signature, the name of the issuer of the certi cate, information about the certi cate
holder, the ngerprint, the certi cate's public key and appropriate algorithms, and the certi cate's serial
number;
the name of the account from which the process is running;
checksums (MD5, SHA2-256, SHA1) of the name of the Computer on which the process is running;
titles of the process windows;
Identi er for the anti-virus databases, name of the detected threat according to the Rightholder's
classi cation;
data about the installed license, its identi er, type and expiration date;
local time of the Computer at the moment of the provision of information;
names and paths of the les that were accessed by the process;
names of registry keys and their values that were accessed by the process;
85

URL and IP addresses that were accessed by the process;
URL and IP addresses from which the running le was downloaded.

Compliance with European Union legislation (GDPR)
Kaspersky Endpoint Security may transmit data to Kaspersky under the following scenarios:
Using Kaspersky Security Network.
Activating the application with an activation code.
Updating application modules and anti-virus databases.
Following links in the application interface.
Dump writing.
Irrespective of the data classi cation and territory from which the data is received, Kaspersky adheres to high
standards for data security and employs various legal, organizational and technical measures to protect the data
of users, to guarantee data security and con dentiality, and also to ensure the ful llment of users' rights as
guaranteed by applicable legislation. The text of the Privacy Policy is included in the application distribution kit and
is available on the Kaspersky website .
Prior to using Kaspersky Endpoint Security, please carefully read the description of transmitted data in the End
User License Agreement and Kaspersky Security Network Statement. If speci c data transmitted from Kaspersky
Endpoint Security under any of the described scenarios may be classi ed as personal data according to your local
legislation or standard, you must ensure that such data is processed legally and obtain the consent of end users
for the collection and transmission of such data.
Read the End User License Agreement and visit the Kaspersky website to learn more about how we receive,
process, store, and destroy information about application usage after you accept the End User License
Agreement and consent to the Kaspersky Security Network Statement. The license.txt and ksn_<language ID>.txt
les contain the text of the End User License Agreement and Kaspersky Security Network Statement and are
included in the application distribution kit.
If you do not want to transmit data to Kaspersky, you can disable data provision.

Using Kaspersky Security Network
By using Kaspersky Security Network, you agree to automatically provide the data listed in the Kaspersky Security
Network Statement. If you do not agree to provide this data to Kaspersky, use Private KSN or disable use of KSN.
For more details about Private KSN, please refer to the documentation on Kaspersky Private Security Network.

Activating the application with an activation code
By using an activation code, you agree to automatically provide the data listed in the End User License Agreement.
If you do not agree to provide this data to Kaspersky, use a key le to activate Kaspersky Endpoint Security .

Updating application modules and anti-virus databases
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By using Kaspersky servers, you agree to automatically provide the data listed in the End User License Agreement.
Kaspersky requires this information to verify that Kaspersky Endpoint Security is being legitimately used. If you do
not agree to provide this information to Kaspersky, use Kaspersky Security Center for database updates or
Kaspersky Update Utility.

Following links in the application interface
By using links in the application interface, you agree to automatically provide the data listed in the End User
License Agreement. The precise list of data transmitted in each speci c link depends on where the link is located in
the application interface and which problem it aims to resolve. If you do not agree to provide this data to
Kaspersky, use the simpli ed application interface or hide the application interface.

Dump writing
If you have enabled dump writing, Kaspersky Endpoint Security will create a dump le that will contain all memory
data from application processes at the moment when this dump le was created.
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Getting started
After installing Kaspersky Endpoint Security, you can manage the application using the following interfaces:
Local application interface.
Kaspersky Security Center Administration Console.
Kaspersky Security Center Web Console.
Kaspersky Security Center Cloud Console.

Kaspersky Security Center Administration Console
Kaspersky Security Center lets you remotely install and uninstall, start and stop Kaspersky Endpoint Security,
con gure application settings, change the set of available application components, add keys, and start and stop
update and scan tasks.
The application can be managed via Kaspersky Security Center using the Kaspersky Endpoint Security
Management Plug-in.
For more details on managing the application through Kaspersky Security Center, refer to the Kaspersky Security
Center Help .

Kaspersky Security Center Web Console and Kaspersky Security Center Cloud Console
Kaspersky Security Center Web Console (hereinafter also referred to as Web Console) is a web application
intended for centrally performing the main tasks to manage and maintain the security system of an organization's
network. Web Console is a Kaspersky Security Center component that provides a user interface. For detailed
information about Kaspersky Security Center Web Console, please refer to the Kaspersky Security Center Help .
Kaspersky Security Center Cloud Console (hereinafter also referred to as the "Cloud Console") is a cloud-based
solution for protecting and managing an organization's network. For detailed information about Kaspersky Security
Center Cloud Console, please refer to the Kaspersky Security Center Cloud Console Help .
Web Console and Cloud Console let you do the following:
Monitor the status of your organization's security system.
Install Kaspersky applications on devices within your network.
Manage installed applications.
View reports on the security system status.
Management of Kaspersky Endpoint Security through the Web Console, Cloud Console, and Kaspersky Security
Center Administration Console all provide di erent management capabilities. The available components and tasks
also vary for the di erent Consoles.

About the Kaspersky Endpoint Security for Windows Management Plug-in
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The Kaspersky Endpoint Security for Windows Management Plug-in enables interaction between Kaspersky
Endpoint Security and Kaspersky Security Center. The Management Plug-in lets you manage Kaspersky Endpoint
Security by using policies, tasks, and local application settings. Interaction with Kaspersky Security Center Web
Console is provided by the web plug-in.
The version of the Management Plug-in may di er from the version of Kaspersky Endpoint Security
application installed on the client computer. If the installed version of the Management Plug-in has less
functionality than the installed version of Kaspersky Endpoint Security, the settings of the missing functions
are not regulated by the Management Plug-in. These settings can be modi ed by the user in the local
interface of Kaspersky Endpoint Security.
The web plug-in is not installed by default in Kaspersky Security Center Web Console. In contrast to the
Management Plug-in for the Kaspersky Security Center Administration Console, which is installed on the
administrator workstation, the web plug-in must be installed on a computer that has Kaspersky Security Center
Web Console installed. The functionality of the web plug-in is available to all administrators that have access to
Web Console in a browser. You can view the list of installed web plug-ins in Web Console interface: Console
settings → Plug-ins. For more details about the compatibility of web plug-in versions and Web Console, refer to
the Kaspersky Security Center Help .

Installing the web plug-in
You can install the web plug-in as follows:
Install web plug-in using Quick Start Wizard of Kaspersky Security Center Web Console.
Web Console automatically prompts you to run the Quick Start Wizard when connecting Web Console to the
Administration Server for the rst time. You can also run the Quick Start Wizard in the Web Console interface
(Discovery & Deployment → Deployment & Assignment → Quick Start Wizard). The Quick Start Wizard can
also check if the installed web plug-ins are up to date and download the necessary updates. For more details on
the Quick Start Wizard for Kaspersky Security Center Web Console, please refer to the Kaspersky Security
Center Help .
Install web plug-in from the list of available distribution packages in Web Console.
To install the web plug-in, select the distribution package of the Kaspersky Endpoint Security web plug-in in the
Web Console interface: Console settings → Plug-ins. The list of available distribution packages is updated
automatically after new versions of Kaspersky applications are released.
Download the distribution package to the Web Console from an external source.
To install the web plug-in, add the ZIP-archive of the distribution package for the Kaspersky Endpoint Security
web plug-in in the Web Console interface: Console settings → Plug-ins. The distribution package of the web
plug-in can be downloaded on the Kaspersky website, for example.

Updating the Management Plug-in
To update the Kaspersky Endpoint Security for Windows Management Plug-in, download the latest version of the
plug-in (included in distribution kit) and run the plug-in installation wizard.
If a new version of the web plug-in becomes available, Web Console will display the noti cation Updates are
available for utilized plug-ins. You can proceed to update the web plug-in version from this Web Console
noti cation. You can also manually check for new web plug-in updates in the Web Console interface (Console
settings → Plug-ins). The previous version of the web plug-in will be automatically removed during the update.
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When the web plug-in is updated, already existing items (for example, policies or tasks) are saved. The new
settings of items implementing new functions of Kaspersky Endpoint Security will appear in existing items and
will have the default values.
You can update the web plug-in as follows:
Update the web plug-in in the list of web plug-ins in online mode.
To update the web plug-in, you must select the distribution package of the Kaspersky Endpoint Security web
plug-in in the Web Console interface (Console settings → Plug-ins). Web Console checks for available
updates on Kaspersky servers and downloads the relevant updates.
Update the web plug-in from a le.
To update the web plug-in, you must select the ZIP-archive of the distribution package for the Kaspersky
Endpoint Security web plug-in in the Web Console interface: Console settings → Plug-ins. The distribution
package of the web plug-in can be downloaded on the Kaspersky website, for example. You can update the
Kaspersky Endpoint Security web plug-in only to a more recent version. The web plug-in cannot be updated to
an older version.
If any item is opened (such as a policy or task), the web plug-in checks its compatibility information. If the version
of the web plug-in is equal to or later than the version speci ed in the compatibility information, you can change
the settings of this item. Otherwise, you cannot use the web plug-in to change the settings of the selected item. It
is recommended to update the web plug-in.

Special considerations when working with di erent versions of management
plug-ins
You can manage Kaspersky Endpoint Security via Kaspersky Security Center only if you have a Management Plugin whose version is equal to or later than the version speci ed in the information regarding the compatibility of
Kaspersky Endpoint Security with the Management Plug-in. You can view the minimum required version of the
Management Plug-in in the installer.ini le included in the distribution kit.
If any item is opened (such as a policy or task), the Management Plug-in checks its compatibility information. If
the version of the Management Plug-in is equal to or later than the version speci ed in the compatibility
information, you can change the settings of this item. Otherwise, you cannot use the Management Plug-in to
change the settings of the selected item. It is recommended to upgrade the Management Plug-in.

Upgrading the Kaspersky Endpoint Security 10 for Windows Management Plug-in
If the Kaspersky Endpoint Security 10 for Windows Management Plug-in is installed in the Administration Console,
please consider the following when installing the Kaspersky Endpoint Security 11 for Windows Management Plug-in:
The Kaspersky Endpoint Security 10 for Windows Management Plug-in will not be removed, and will remain
available for operation. Therefore, you will have access to two Management Plug-ins for working with
application versions 10 and 11.
The Kaspersky Endpoint Security 11 for Windows Management Plug-in does not support management of
Kaspersky Endpoint Security 10 for Windows on users' computers.
The Kaspersky Endpoint Security 11 for Windows Management Plug-in does not support items (for example,
policies or tasks) that were created using the Kaspersky Endpoint Security 10 for Windows Management Plug90

in.
You can use the Policies and Tasks Batch Conversion Wizard to convert policies and tasks from version 10
to version 11. For more details about converting policies and tasks, please refer to the Kaspersky Security
Center Help .

Upgrading the Kaspersky Endpoint Security 11 for Windows Management Plug-in
If the Kaspersky Endpoint Security 11 for Windows Management Plug-in is installed in the Administration Console,
please consider the following when installing a new version of the Kaspersky Endpoint Security 11 for Windows
Management Plug-in:
The previous version of the Kaspersky Endpoint Security 11 for Windows Management Plug-in will be removed.
The new version of the Kaspersky Endpoint Security 11 for Windows Management Plug-in supports
management of the previous version of Kaspersky Endpoint Security 11 for Windows on users' computers.
You can use the new version of the Management Plug-in to change the settings in policies, tasks, and other
items created by the previous version of the Management Plug-in.
For new settings, the new version of the Management Plug-in assigns the default values when a policy, policy
pro le, or task are saved for the rst time.
After the Management Plug-in is upgraded, it is recommended to check and save the values of the new
settings in policies and policy pro les. If you do not do this, the new groups of Kaspersky Endpoint Security
settings on the user's computer will take the default values and can be edited (the attribute). It is
recommended to check the settings starting with policies and policy pro les at the top level of the
hierarchy. It is also recommended to use the user account that has access rights to all functional areas of
Kaspersky Security Center.

To learn about the new capabilities of the application, please refer to the Release Notes or the application
help.
If a new parameter has been added to a group of settings in the new version of the Management Plug-in, the
previously de ned status of the / attribute for this group of settings is not changed.
When upgrading the Management Plug-in to version 11.2.0, you need to open a policy to automatically convert it.
When doing so, Kaspersky Endpoint Security will prompt you for con rmation to participate in KSN. If you
already upgraded the application to version 11.20 on the computers of your organization, participation in KSN will
be disabled until you accept the terms of participation in KSN.

Special considerations when using encrypted protocols for interacting with
external services
Kaspersky Endpoint Security and Kaspersky Security Center uses an encrypted communication channel with TLS
(Transport Layer Security) to work with external services of Kaspersky. Kaspersky Endpoint Security uses external
services for the following functions:
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updating databases and application software modules;
activating the application with an activation code (activation 2.0);
using Kaspersky Security Network.
Use of TLS secures the application by providing the following features:
Encryption. The contents of messages are con dential and are not disclosed to third-party users.
Integrity. The message recipient is certain that the message contents have not been modi ed since the
message was forwarded by the sender.
Authentication. The recipient is certain that communication is established only with a trusted Kaspersky server.
Kaspersky Endpoint Security uses public key certi cates for server authentication. A public key infrastructure (PKI)
is required for working with certi cates. A Certi cate Authority is part of a PKI. Kaspersky uses its own Certi cate
Authority because Kaspersky services are highly technical and not public. In this case, when root certi cates of
Thawte, VeriSign, GlobalTrust and others are revoked, the Kaspersky PKI remains operational without disruptions.
Environments that have MITM (software and hardware tools that support parsing of the HTTPS protocol) are
considered to be unsafe by Kaspersky Endpoint Security. Errors may be encountered when working with Kaspersky
services. For example, there may be errors regarding the use of self-signed certi cates. These errors may occur
because an HTTPS Inspection tool from your environment does not recognize the Kaspersky PKI. To rectify these
problems, you must con gure exclusions for interacting with external services.

Application interface

Main application window
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Monitoring

Reports. View events that occurred during operation of the application, individual
components and tasks.
Backup. View a list of saved copies of infected les that the application has deleted.
Threat detection technologies. View information about threat detection technologies
and the number of threats detected by these technologies.
Kaspersky Security Network. Status of the connection between Kaspersky Endpoint
Security and Kaspersky Security Network, and global KSN statistics. Kaspersky Security
Network (KSN) is an infrastructure of cloud services providing access to the online
Kaspersky Knowledge Base that contains information about the reputation of les, web
resources, and software. The use of data from Kaspersky Security Network ensures faster
responses by Kaspersky Endpoint Security to new threats, improves the performance of
some protection components, and reduces the likelihood of false positives. If you are
participating in Kaspersky Security Network, KSN services provide Kaspersky Endpoint
Security with information about the category and reputation of scanned les, as well as
information about the reputation of scanned web addresses.
Application Activity Monitor. View information about the operation of installed
applications. System Watcher keeps track of the le, registry, and operating system events
associated with an application.
Network Monitor. View information about network activity of the computer in real time.
Encryption Monitor. Monitors the disk encryption or decryption process in real time.
Encryption Monitor is available if the Kaspersky Disk Encryption component or BitLocker
Drive Encryption component is installed.

Security

Operating status of installed components. You can also proceed to con guring components
or viewing reports.

Update

Manage Kaspersky Endpoint Security update tasks. You can update anti-virus databases and
application modules and roll back the last update. An administrator can hide the section from
the user or restrict task management.

Tasks

Manage Kaspersky Endpoint Security scan tasks. You can run a virus scan and application
integrity check. An administrator can hide tasks from a user or restrict management of tasks.

License

Application licensing. You can purchase a license, activate the application or renew a
subscription. You can also view information about the current license.
Con gure application settings. An administrator can prohibit changes to settings in Kaspersky
Security Center.
Information about the application: current version of Kaspersky Endpoint Security, database
release date, key, and other information. You can also proceed to Kaspersky information
resources that provide useful information, recommendations, and answers to frequently asked
questions on how to purchase, install, and use the application.

/

Messages containing information about available updates and requests for access to
encrypted les and devices.

Application icon in the taskbar noti cation area
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Immediately after installation of Kaspersky Endpoint Security, the application icon appears in the Microsoft
Windows taskbar noti cation area.
The icon serves the following purposes:
It indicates application activity.
It acts as a shortcut to the context menu and main window of the application.
The following application icon statuses are provided for displaying application operating information:
The icon signi es that critically important protection components of the application are enabled. Kaspersky
Endpoint Security will display a warning if the user is required to perform an action, for example, restart the
computer after updating the application.
The icon signi es that critically important protection components of the application are disabled or have
malfunctioned. Protection components may malfunction, for example, if the license has expired or as a result of
an application error. Kaspersky Endpoint Security will display a warning with a description of the problem in
computer protection.
The context menu of the application icon contains the following items:
Kaspersky Endpoint Security for Windows. Opens the main application window. In this window, you can adjust
the operation of application components and tasks, and view the statistics of processed les and detected
threats.
Pause protection / Resume protection. Pause the operation of all protection and control components that are
not marked by a lock ( ) in the policy. Prior to performing this operation, it is recommended to disable the
Kaspersky Security Center policy.
Prior to pausing the operation of protection and control components, the application requests the password
for accessing Kaspersky Endpoint Security (account password or temporary password). You can then select
the pause period: for a speci c amount of time, until a restart, or upon user request.
This context menu item is available if Password Protection is enabled. To resume the operation of protection
and control components, click Resume Protection in the context menu of the application.
Pausing the operation of protection and control components does not a ect the performance of update
and scan tasks. The application also continues using Kaspersky Security Network.
Disable policy / Enable policy. Disables a Kaspersky Security Center policy on the computer. All Kaspersky
Endpoint Security settings are available for con guration, including settings that have a closed lock in the policy
( ). If the policy is disabled, the application requests the password for accessing Kaspersky Endpoint Security
(account password or temporary password). This context menu item is available if Password Protection is
enabled. To enable the policy, select Enable policy in the context menu of the application.
Settings. Opens the application settings window.
Support. This opens a window containing the information necessary for contacting Kaspersky Technical
Support.
About. This item opens an information window with application details.
Exit. This item quits Kaspersky Endpoint Security. Clicking this context menu item causes the application to be
unloaded from the computer RAM.
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Application icon context menu

Simpli ed application interface
If a Kaspersky Security Center policy con gured to display the simpli ed application interface is applied to a client
computer on which Kaspersky Endpoint Security is installed, the main application window is not available on this
client computer. Right-click to open the context menu of the Kaspersky Endpoint Security icon (see the gure
below) containing the following items:
Disable policy / Enable policy. Disables a Kaspersky Security Center policy on the computer. All Kaspersky
Endpoint Security settings are available for con guration, including settings that have a closed lock in the policy
( ). If the policy is disabled, the application requests the password for accessing Kaspersky Endpoint Security
(account password or temporary password). This context menu item is available if Password Protection is
enabled. To enable the policy, select Enable policy in the context menu of the application.
Tasks. Drop-down list containing the following items:
Integrity Check.
Rollback of databases to their previous version.
Full Scan.
Custom Scan.
Critical Areas Scan.
Update.
Support. This opens a window containing the information necessary for contacting Kaspersky Technical
Support.
Exit. This item quits Kaspersky Endpoint Security. Clicking this context menu item causes the application to be
unloaded from the computer RAM.

Context menu of the application icon when displaying the simpli ed interface

Con guring the display of the application interface
You can con gure the application interface display mode for a user. The user can interact with the application in
the following ways:
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With simpli ed interface. On a client computer, the main application window is inaccessible, and only the icon
in the Windows noti cation area is available. In the context menu of the icon, the user can perform a limited
number of operations with Kaspersky Endpoint Security. Kaspersky Endpoint Security also displays
noti cations above the application icon.
With full interface. On a client computer, the main window of Kaspersky Endpoint Security and the icon in the
Windows noti cation area are available. In the context menu of the icon, the user can perform operations with
Kaspersky Endpoint Security. Kaspersky Endpoint Security also displays noti cations above the application
icon.
No interface. On a client computer, no signs of Kaspersky Endpoint Security operation are displayed. The icon
in the Windows noti cation area and noti cations are not available.
How to con gure the application interface display mode in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General settings → Interface.
6. In the Interaction with user section, do one of the following:
Select the Display application interface check box if you want the following interface elements to be
displayed on the client computer:
Folder containing the application name in the Start menu
Kaspersky Endpoint Security icon in the Microsoft Windows taskbar noti cation area
Pop-up noti cations
If this check box is selected, the user can view and, depending on the available rights, change
application settings from the application interface.
Clear the Display application interface check box if you want to hide all signs of Kaspersky Endpoint
Security on the client computer.
7. In the Interaction with user section, select the Simpli ed application interface check box if you want the
simpli ed application interface to be displayed on a client computer that has Kaspersky Endpoint Security
installed.
How to con gure the application interface display mode in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to enable
support for portable mode.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Interface.
5. In the Interaction with user section, con gure how the application interface will be displayed:
With simpli ed interface. On a client computer, the main application window is inaccessible, and only
the icon in the Windows noti cation area is available. In the context menu of the icon, the user can
perform a limited number of operations with Kaspersky Endpoint Security. Kaspersky Endpoint Security
also displays noti cations above the application icon.
With full interface. On a client computer, the main window of Kaspersky Endpoint Security and the icon
in the Windows noti cation area are available. In the context menu of the icon, the user can perform
operations with Kaspersky Endpoint Security. Kaspersky Endpoint Security also displays noti cations
above the application icon.
No interface. On a client computer, no signs of Kaspersky Endpoint Security operation are displayed.
The icon in the Windows noti cation area and noti cations are not available.
6. Save your changes.

Getting started
After deploying the application on client computers, to work with Kaspersky Endpoint Security from Kaspersky
Security Center Web Console you need to perform the following actions:
Create and con gure a policy.
You can use policies to apply identical Kaspersky Endpoint Security settings to all client computers within an
administration group. The Quick Start Wizard of Kaspersky Security Center automatically creates a policy for
Kaspersky Endpoint Security.
Create the Update and Virus Scan tasks.
The Update task is required for keeping computer security up to date. When the task is performed, Kaspersky
Endpoint Security updates the anti-virus databases and application modules. The Update task is created
automatically by the Quick Start Wizard of Kaspersky Security Center. To create the Update task, install the
Kaspersky Endpoint Security for Windows web plug-in while running the Wizard.
The Virus Scan task is required for the timely detection of viruses and other malware. You need to manually
create the Virus Scan task.
How to create a Virus Scan task in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → Virus scan.

Step 2. Scan scope
Create the list of objects that Kaspersky Endpoint Security will scan while performing a scan task.

Step 3. Kaspersky Endpoint Security action
Choose the action on threat detection:
Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection fails, Kaspersky Endpoint Security
deletes the les.
Disinfect; inform if disinfection fails. If this option is selected, Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection is not possible, Kaspersky Endpoint
Security adds the information about the infected les that are detected to the list of active threats.
Inform. If this option is selected, Kaspersky Endpoint Security adds the information about infected les to
the list of active threats on detection of these les.
Run Advanced Disinfection immediately. If the check box is selected, Kaspersky Endpoint Security uses
the Advanced Disinfection technology to treat active threats during the scan.

Advanced disinfection technology is aimed at purging the operating system of malicious applications that
have already started their processes in RAM and that prevent Kaspersky Endpoint Security from removing
them by using other methods. The threat is neutralized as a result. While Advanced Disinfection is in
progress, you are advised to refrain from starting new processes or editing the operating system registry.
The advanced disinfection technology uses considerable operating system resources, which may slow
down other applications. After the advanced disinfection is complete, Kaspersky Endpoint Security will
restart the computer without asking the user for con rmation.
Con gure the task run mode using the Run only when the computer is idle check box. This check box
enables / disables the function that suspends the Virus scan task when computer resources are limited.
Kaspersky Endpoint Security pauses the Virus scan task if the screensaver is o and the computer is
unlocked.

Step 4. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
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Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 5. Selecting the account to run the task
Select an account to run the Virus Scan task. By default, Kaspersky Endpoint Security starts the task with the
rights of a local user account. If the scan scope includes network drives or other objects with restricted
access, select a user account with the su icient access rights.

Step 6. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or after anti-virus databases are downloaded
to the repository.

Step 7. De ning the task name
Enter a name for the task, for example, Daily full scan.

Step 8. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties. As a result, the Virus Scan task will be executed on the user
computers in accordance to the speci ed schedule.
How to create a Virus Scan task in the Web Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Virus Scan.
c. In the Task name eld, enter a brief description, for example, Weekly scan.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
6. To con gure the task schedule, go to the task properties.
It is recommended to schedule the task to run at least once a week.
7. Select the check box next to the task.
8. Click the Run button.
You can monitor the status of the task, and the number of devices on which the task was completed
successfully or completed with an error.
As a result, the Virus Scan task will be executed on the user computers in accordance to the speci ed
schedule.

Managing policies
A policy is a collection of application settings that are de ned for an administration group. You can con gure
multiple policies with di erent values for one application. An application can run under di erent settings for
di erent administration groups. Each administration group can have its own policy for an application.
Policy settings are sent to client computers by Network Agent during synchronization. By default, the
Administration Server performs synchronization immediately after policy settings are changed. UDP port 15000 on
the client computer is used for synchronization. The Administration Server performs synchronization every 15
minutes by default. If synchronization fails after policy settings were changed, the next synchronization attempt
will be performed according to the con gured schedule.

Active and inactive policy

100

A policy is intended for a group of managed computers and can be active or inactive. The settings of an active
policy are saved on client computers during synchronization. You cannot simultaneously apply multiple policies to
one computer, therefore only one policy may be active in each group.
You can create an unlimited number of inactive policies. An inactive policy does not a ect application settings on
computers in the network. Inactive policies are intended as preparations for emergency situations, such as a virus
attack. If there is an attack via ash drives, you can activate a policy that blocks access to ash drives. In this case,
the active policy automatically becomes inactive.

Out-of-o ice policy
An out-of-o ice policy is activated when a computer leaves the organization network perimeter.

Settings inheritance
Policies, like administration groups, are arranged in a hierarchy. By default, a child policy inherits settings from the
parent policy. Child policy is a policy for nested hierarchy levels, that is a policy for nested administration groups
and secondary Administration Servers. You can disable the inheritance of settings from the parent policy.
Each policy setting has the attribute, which indicates if the settings can be modi ed in the child policies or in the
local application settings. The attribute is applicable only if inheritance of parent policy settings is enabled for
the child policy. Out-of-o ice policies do not a ect other policies through the hierarchy of administration groups.

Settings inheritance

The rights to access policy settings (read, write, execute) are speci ed for each user who has access to the
Kaspersky Security Center Administration Server and separately for each functional scope of Kaspersky Endpoint
Security. To con gure the rights to access policy settings, go to the Security section of the properties window of
the Kaspersky Security Center Administration Server.

Creating a policy
How to create a policy in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, select the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Click the New policy button.
The Policy Wizard starts.
5. Follow the instructions of the Policy Wizard.
How to create a policy in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the Add button.
The Policy Wizard starts.
3. Select Kaspersky Endpoint Security and click Next.
4. Please read and accept the terms of the Kaspersky Security Network (KSN) Statement and click Next.
5. On the General tab, you can perform the following actions:
Change the policy name.
Select the policy status:
Active. After the next synchronization, the policy will be used as the active policy on the computer.
Inactive. Backup policy. If necessary, an inactive policy can be switched to active status.
Out-of-o ice. The policy is activated when a computer leaves the organization network perimeter.
Con gure the inheritance of settings:
Inherit settings from parent policy. If this toggle button is switched on, the policy setting values are
inherited from the top-level policy. Policy settings cannot be edited if is set for the parent policy.
Force inheritance of settings in child policies. If the toggle button is on, the values of the policy
settings are propagated to the child policies. In the properties of the child policy, the Inherit
settings from parent policy toggle button will be automatically switched on and cannot be
switched o . Child policy settings are inherited from the parent policy, except for the settings
marked with . Child policy settings cannot be edited if is set for the parent policy.
6. On the Application settings tab, you can con gure the Kaspersky Endpoint Security policy settings.
7. Save your changes.
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As a result, Kaspersky Endpoint Security settings will be con gured on client computers during the next
synchronization. You can view information about the policy that is being applied to the computer in the Kaspersky
Endpoint Security interface by clicking the Support button on the main screen (for example, the policy name). To
do so, in the settings of the Network Agent policy, you need to enable the receipt of extended policy data. For
more details about a Network Agent policy, please refer to the Kaspersky Security Center Help .

Security level indicator
The security level indicator is displayed in the upper part of the Properties: <Policy name> window. The indicator
can take one of the following values:
High protection level. The indicator takes this value and turns green if all components from the following
categories are enabled:
Critical. This category includes the following components:
File Threat Protection.
Behavior Detection.
Exploit Prevention.
Remediation Engine.
Important. This category includes the following components:
Kaspersky Security Network.
Web Threat Protection.
Mail Threat Protection.
Host Intrusion Prevention.
Medium protection level. The indicator takes this value and turns yellow if one of the important components is
disabled.
Low protection level. The indicator takes this value and turns red in one of the following cases:
One or multiple critical components are disabled.
Two ore more important components are disabled.
If the indicator has the Medium protection level or Low protection level value, a link that opens the
Recommended protection components window appears to the right of the indicator. In this window, you can
enable any of the recommended protection components.

Task management
You can create the following types of tasks to administer Kaspersky Endpoint Security through Kaspersky Security
Center:
Local tasks that are con gured for an individual client computer.
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Group tasks that are con gured for client computers within administration groups.
Tasks for a selection of computers.
You can create any number of group tasks, tasks for a selection of computers, or local tasks. For more details
about working with administration groups and selections of computers, refer to the Kaspersky Security Center
Help .
Kaspersky Endpoint Security supports the following tasks:
Virus scan. Kaspersky Endpoint Security scans the computer areas speci ed in the task settings for viruses
and other threats. The Virus Scan task is required for the operation of Kaspersky Endpoint Security and is
created during the Quick Start Wizard. It is recommended to schedule the task to run at least once a week.
Add key. Kaspersky Endpoint Security adds a key for activating applications, including an additional key. Before
running the task, make sure that the number of computers, on which the task is to be executed, does not
exceed the number of computers allowed by the license.
Change application components. Kaspersky Endpoint Security installs or removes components on client
computers according to the list of components speci ed in the task settings. The File Threat Protection
component cannot be removed. The optimal set of Kaspersky Endpoint Security components helps to
conserve computer resources.
Inventory. Kaspersky Endpoint Security receives information about all application executable les that are
stored on computers. The Inventory task is performed by the Application Control component. If the
Application Control component is not installed, the task will end with an error.
Update. Kaspersky Endpoint Security updates databases and application modules. The Update task is required
for the operation of Kaspersky Endpoint Security and is created during the Quick Start Wizard. It is
recommended to con gure a schedule that runs the task at least once per day.
Wipe data. Kaspersky Endpoint Security deletes les and folders from users' computers immediately or if there
is no connection with Kaspersky Security Center for a long time.
Update rollback. Kaspersky Endpoint Security rolls back the last update of databases and application modules.
This may be necessary if, for example, new databases contain incorrect data that could cause Kaspersky
Endpoint Security to block a safe application.
Integrity check. Kaspersky Endpoint Security analyzes application les, checks les for corruption or
modi cations, and veri es the digital signatures of application les.
Manage Authentication Agent accounts. Kaspersky Endpoint Security con gures the Authentication Agent
account settings. An Authentication Agent is needed for working with encrypted drives. Before the operating
system is loaded, the user needs to complete authentication with the Agent.
Tasks are run on a computer only if Kaspersky Endpoint Security is running.

Add a new task
How to create a task in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. Select the Tasks folder in the Administration Console tree.
3. Click the New task button.
The Task Wizard starts.
4. Follow the instructions of the Task Wizard.
How to create a task in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select the task that you want to run on user computers.
c. In the Task name eld, enter a brief description, for example, Update the application for
accounting.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks. The task will have the default settings. To con gure the task
settings, you need to go to the task properties. To run a task, you need to select the check box opposite the task
and click the Start button. After the task has started, you can pause the task and resume it later.
In the list of tasks, you can monitor the task results, which include the task status and the statistics for task
performance on computers. You can also create a selection of events to monitor the completion of tasks
(Monitoring and reporting → Event selections). For more details on event selection, please refer to the
Kaspersky Security Center Help . Task execution results are also saved locally in Windows event log and in
Kaspersky Endpoint Security reports.

Task access control
The rights to access Kaspersky Endpoint Security tasks (read, write, execute) are de ned for each user who has
access to Kaspersky Security Center Administration Server, through the settings of access to functional areas of
Kaspersky Endpoint Security. To con gure access to the functional areas of Kaspersky Endpoint Security, go to
the Security section of the properties window of Kaspersky Security Center Administration Server. For more
details on task management through Kaspersky Security Center, please refer to the Kaspersky Security Center
Help .
105

You can con gure users' rights to access tasks using a policy (task management mode). For example, you can hide
group tasks in the Kaspersky Endpoint Security interface.
How to con gure the task management mode in the Kaspersky Endpoint Security interface through the
Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Local Tasks → Task management.
6. Con gure the task management mode (see the table below).
7. Save your changes.
How to con gure the task management mode in the Kaspersky Endpoint Security interface through the Web
Console

1. In the main window of Web Console, select the Devices → Policies & pro les tab.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to enable
support for portable mode.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Local tasks → Task management.
5. Con gure the task management mode (see the table below).
6. Save your changes.
Task management settings

Parameter

Allow use of
local tasks

Description

If the check box is selected, local tasks are displayed in the Kaspersky Endpoint Security
local interface. When there are no additional policy restrictions, the user can con gure and
run tasks. However, con guring task run schedule remains unavailable for the user. The user
can run tasks only manually.
If the check box is cleared, use of local tasks is stopped. In this mode, local tasks do not run
according to schedule. Tasks cannot be started or con gured in the local interface of
Kaspersky Endpoint Security, or when working with the command line.
A user can still start a virus scan of a le or folder by selecting the Scan for viruses option
in the context menu of the le or folder. The scan task is started with the default values of
settings for the custom scan task.
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Allow group
tasks to be
displayed

If the check box is selected, group tasks are displayed in the Kaspersky Endpoint Security
local interface. The user can view the list of all tasks in the application interface.
If the check box is cleared, Kaspersky Endpoint Security displays an empty task list.

Allow
management
of group
tasks

If the check box is selected, users can start and stop group tasks speci ed in Kaspersky
Security Center. Users can start and stop tasks in the application interface or in the
simpli ed application interface.
If the check box is cleared, Kaspersky Endpoint Security starts scheduled tasks
automatically, or the administrator starts tasks manually in Kaspersky Security Center.

Con guring local application settings
In Kaspersky Security Center, you can con gure Kaspersky Endpoint Security settings on a particular computer.
They are the local application settings. Some settings may be unaccessible for editing. These settings are locked
by the attribute in the policy properties.
How to con gure the local application settings in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder of the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computer belongs.
3. In the workspace, select the Devices tab.
4. Select the computer for which you want to con gure Kaspersky Endpoint Security settings.
5. In the context menu of the client computer, select Properties.
A client computer properties window opens.
6. In the client computer properties window, select the Applications section.
A list of Kaspersky applications that are installed on the client computer appears in the right part of the
client computer properties window.
7. Select Kaspersky Endpoint Security.
8. Click the Properties button under the list of Kaspersky applications.
This opens the Kaspersky Endpoint Security for Windows application settings window.
9. In the General Settings section, con gure Kaspersky Endpoint Security as well as Reports and Storage.
The other sections of the Kaspersky Endpoint Security for Windows application settings window are
the same as in the standard sections of Kaspersky Security Center. A description of these sections is
provided in the Kaspersky Security Center Help.
If an application is subject to a policy that prohibits changes to speci c settings, you will not be able to
edit them while con guring application settings in the General Settings section.
10. To save your changes, in the Kaspersky Endpoint Security for Windows application settings window,
click OK.
How to con gure the local application settings in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Managed devices.
2. Select the computer for which you want to con gure local application settings.
This opens the computer properties.
3. Select the Applications tab.
4. Click Kaspersky Endpoint Security for Windows.
This opens the local application settings.
5. Select the Application settings tab.
6. Con gure the local application settings.
7. Local application settings are the same as policy settings, except for encryption settings.

Starting and stopping Kaspersky Endpoint Security
After installing Kaspersky Endpoint Security to a user's computer, the application is started automatically. By
default, Kaspersky Endpoint Security is started after operating system startup. It is not possible to con gure
automatic startup of the application in the operating system settings.
Downloading Kaspersky Endpoint Security anti-virus databases after the operating system starts can take up
to two minutes depending on the capabilities of the computer. During this time, the level of computer
protection is reduced. The downloading of anti-virus databases when Kaspersky Endpoint Security is started
on an already started operating system does not cause a reduction in the level of computer protection.
How to con gure the startup of Kaspersky Endpoint Security in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General Settings → Task management.
6. Use the Start Kaspersky Endpoint Security for Windows on computer startup check box to con gure
the application startup.
7. Save your changes.
How to con gure the startup of Kaspersky Endpoint Security in the Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of Kaspersky Endpoint Security policy for the computers for which you want to con gure
the startup of the application.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings.
5. Click the Application settings link.
6. Use the Start Kaspersky Endpoint Security for Windows on computer startup check box to con gure
the application startup.
7. Save your changes.
How to con gure the startup of Kaspersky Endpoint Security in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Application Settings.
3. Use the Start Kaspersky Endpoint Security for Windows on computer startup check box to con gure
the application startup.
4. Save your changes.

Kaspersky experts recommend against manually stopping Kaspersky Endpoint Security because doing so
exposes the computer and your personal data to threats. If necessary, you can pause computer protection for
as long as you need to, without stopping the application.
You can monitor the application status by using the Protection Status widget.
How to start or stop Kaspersky Endpoint Security in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder of the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computer belongs.
3. In the workspace, select the Devices tab.
4. Select the computer on which you want to start or stop the application.
5. Right-click to display the context menu of the client computer and select Properties.
6. In the client computer properties window, select the Applications section.
A list of Kaspersky applications that are installed on the client computer appears in the right part of the
client computer properties window.
7. Select Kaspersky Endpoint Security.
8. Do the following:
To start the application, click the

button to the right of the list of Kaspersky applications.

To stop the application, click the

button to the right of the list of Kaspersky applications.

How to start or stop Kaspersky Endpoint Security in the Web Console

1. In the main window of Web Console, select Devices → Managed devices.
2. Click the name of the computer on which you want to start or stop Kaspersky Endpoint Security.
The computer properties window opens.
3. Select the Applications tab.
4. Select the check box opposite Kaspersky Endpoint Security for Windows.
5. Click the Start or Stop button.
How to start or stop Kaspersky Endpoint Security from the command line
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To stop the application from the command line, enable external management of system services.
The le klpsm.exe, which is included in the Kaspersky Endpoint Security distribution kit, is used to start or stop
the application from the command line.
1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security executable le is located.
3. To start the application from the command line, enter klpsm.exe start_avp_service.
4. To stop the application from the command line, enter klpsm.exe stop_avp_service.

Pausing and resuming computer protection and control
Pausing computer protection and control means disabling all protection and control components of Kaspersky
Endpoint Security for some time.
The application status is displayed using the application icon in the taskbar noti cation area.
The

icon signi es that computer protection and control are paused.

The

icon signi es that computer protection and control are enabled.

Pausing or resuming computer protection and control does not a ect scan or update tasks.
If any network connections are already established when you pause or resume computer protection and control, a
noti cation about the termination of these network connections is displayed.

To pause computer protection and control:
1. Right-click to bring up the context menu of the application icon that is in the taskbar noti cation area.
2. In the context menu, select Pause protection (see the gure below).
This context menu item is available if Password Protection is enabled.
3. Select one of the following options:
Pause for <time period> – computer protection and control will resume after the amount of time that is
speci ed in the drop-down list below.
Pause until application restart – computer protection and control will resume after you restart the
application or restart the operating system. Automatic startup of the application must be enabled to use
this option.
Pause – computer protection and control will resume when you decide to re-enable them.
4. Click the Pause protection button.
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Kaspersky Endpoint Security will pause the operation of all protection and control components that are not
marked by a lock ( ) in the policy. Prior to performing this operation, it is recommended to disable the Kaspersky
Security Center policy.

Application icon context menu

To resume computer protection and control:
1. Right-click to bring up the context menu of the application icon that is in the taskbar noti cation area.
2. In the context menu, select Resume protection.
You can resume computer protection and control at any time, regardless of the computer protection and
control pause option that you selected previously.
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Virus Scan of the computer
A virus scan is vital to computer security. Regularly run virus scans to rule out the possibility of spreading malware
that is undetected by protection components due to a low security level setting or for other reasons.
Kaspersky Endpoint Security does not scan les whose contents are located in OneDrive cloud storage, and
creates log entries stating that these les have not been scanned.

Full Scan
A thorough scan of the entire computer. Kaspersky Endpoint Security scans the following objects:
Kernel memory
Objects that are loaded at startup of the operating system
Boot sectors
Operating system backup
All hard and removable drives
Kaspersky experts recommend that you do not change the scan scope of the Full Scan task.

To conserve computer resources, it is recommended to use a background scan task instead of a full scan task.
This will not a ect the security level of the computer.

Critical Areas Scan
By default, Kaspersky Endpoint Security scans the kernel memory, running processes, and disk boot sectors.
Kaspersky experts recommend that you do not change the scan scope of the Critical Areas Scan task.

Custom Scan
Kaspersky Endpoint Security scans the objects that are selected by the user. You can scan any object from the
following list:
System memory
Objects that are loaded at startup of the operating system
Operating system backup
Microsoft Outlook mailbox
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Hard, removable, and network drives
Any selected le

Background scan
Background scan is a scan mode of Kaspersky Endpoint Security that does not display noti cations for the user.
Background scan requires less computer resources than other types of scans (such as a full scan). In this mode,
Kaspersky Endpoint Security scans startup objects, the boot sector, system memory, and the system partition.

Integrity check
Kaspersky Endpoint Security checks the application modules for corruption or modi cations.

Scanning the computer
A virus scan is vital to computer security. Regularly run virus scans to rule out the possibility of spreading malware
that is undetected by protection components due to a low security level setting or for other reasons. The
component provides computer protection with the help of anti-virus databases, the Kaspersky Security Network
cloud service, and heuristic analysis.
Kaspersky Endpoint Security has standard tasks Full Scan, Critical Areas Scan, Custom Scan prede ned. If your
organization has the Kaspersky Security Center administration system deployed, you can create a Virus Scan task
and con gure the scan. The Background scan task is also available in Kaspersky Security Center. The background
scan cannot be con gured.
How to run a Virus Scan in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Tasks tab.
4. Select the scan task and double-click to open the task properties.
If necessary, create a Virus scan task.
5. In the task properties window, select the Settings section.
6. Con gure the scan task (see the table below).
If necessary, con gure the scan task schedule.
7. Save your changes.
8. Run the scan task.
Kaspersky Endpoint Security will start scanning the computer. If the user has interrupted the execution of
the task (for example by powering o the computer), Kaspersky Endpoint Security automatically runs the
task, continuing from the point where the scan was interrupted.
How to run a Virus Scan in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the scan task.
The task properties window opens.
3. Select the Application settings tab.
4. Con gure the scan task (see the table below).
If necessary, con gure the scan task schedule.
5. Save your changes.
6. Run the scan task.
Kaspersky Endpoint Security will start scanning the computer. If the user has interrupted the execution of
the task (for example by powering o the computer), Kaspersky Endpoint Security automatically runs the
task, continuing from the point where the scan was interrupted.
How to run a Virus Scan in the application interface
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1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Con gure the scan task (see the table below).
If necessary, con gure the scan task schedule.
4. Save your changes.
5. Run the scan task.
Kaspersky Endpoint Security will start scanning the computer. The application will show the scan progress,
the number of scanned les, and the scan time remaining. You can stop the task at any time by clicking the
Stop button. If the scan task is not displayed, it means the administrator has prohibited the use of local
tasks in the policy.
Scan settings

Parameter

Description

Security level

Kaspersky Endpoint Security can use di erent groups of settings for running a scan. These
groups of settings that are stored in the application are called security levels:
High. Kaspersky Endpoint Security scans all types of les. When scanning compound
les, Kaspersky Endpoint Security also scans mail-format les.
Recommended. Kaspersky Endpoint Security scans only the speci ed le formats on
all hard drives, network drives, and removable storage media of the computer, and also
embedded OLE objects. Kaspersky Endpoint Security does not scan archives or
installation packages.
Low. Kaspersky Endpoint Security scans only new or modi ed les with the speci ed
extensions on all hard drives, removable drives, and network drives of the computer.
Kaspersky Endpoint Security does not scan compound les.
You can select one of the preset security levels or manually con gure security level
settings. If you change the security level settings, you can always revert back to the
recommended security level settings.

Action on
threat
detection

Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint
Security automatically attempts to disinfect all infected les that are detected. If
disinfection fails, Kaspersky Endpoint Security deletes the les.
Disinfect; inform if disinfection fails. If this option is selected, Kaspersky Endpoint
Security automatically attempts to disinfect all infected les that are detected. If
disinfection is not possible, Kaspersky Endpoint Security adds the information about the
infected les that are detected to the list of active threats.
Inform. If this option is selected, Kaspersky Endpoint Security adds the information about
infected les to the list of active threats on detection of these les.
Before attempting to disinfect or delete an infected le, Kaspersky Endpoint Security
creates a backup copy of the le in case you need to restore the le or if it can be
disinfected in the future.
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On detection of infected les that are part of the Windows Store application,
Kaspersky Endpoint Security attempts to delete the le.

Run
Advanced
Disinfection
immediately

(available only
in the
Kaspersky
Security
Center
Console)

Advanced Disinfection during a virus scan task on a computer is performed only if the
Advanced Disinfection feature is enabled in the properties of the policy applied to this
computer.
If the check box is selected, Kaspersky Endpoint Security disinfects the active infection
immediately after it is detected during the execution of the virus scan task. After the
active infection is disinfected, Kaspersky Endpoint Security reboots the computer without
prompting the user.
If the check box is cleared, Kaspersky Endpoint Security does not disinfect the active
infection immediately after it is detected during the execution of the virus scan task.
Kaspersky Endpoint Security generates active infection events in local application reports
and on the Kaspersky Security Center side. The active infection can be disinfected when
the virus scan task is run again with the Advanced Disinfection feature turned on. In this
way, the system administrator can choose the appropriate time to do Advanced
Disinfection and subsequently reboot the computers automatically.

Scan scope

List of objects that Kaspersky Endpoint Security scans while performing a scan task.
Objects within the scan scope can include the kernel memory, running processes, boot
sectors, system backup storage, mail databases, hard drive, removable drive or network
drive, folder or le.

Scan
schedule

Manually. Run mode in which you can start scan manually at a time when it is convenient
for you.
By schedule. In this scan task run mode, Kaspersky Endpoint Security starts the scan task
in accordance with the schedule that you create. If this scan task run mode is selected, you
can also start the scan task manually.

Start in N
minutes after
application
startup

Postponed start of the scan task after application startup. At operating system startup,
many processes are running, therefore it is advantageous to postpone running the scan
task instead of running it immediately after Kaspersky Endpoint Security startup.

Run missed
tasks

If the check box is selected, Kaspersky Endpoint Security starts the skipped scan task as
soon as it becomes possible. The scan task may be skipped, for example, if the computer
was o at the scheduled scan task start time. If the check box is cleared, Kaspersky
Endpoint Security does not run skipped scan tasks. Instead, it carries out the next scan
task in accordance with the current schedule.

Run only
when the
computer is
idle

Postponed start of the scan task when computer resources are busy. Kaspersky Endpoint
Security starts the scan task if the computer is locked or if the screen saver is on. If you
have interrupted the execution of the task, for example by unlocking the computer,
Kaspersky Endpoint Security automatically runs the task, continuing from the point where
it was interrupted.

Run scan as

By default the scan task is run in the name of the user with whose rights you are registered
in the operating system. The protection scope may include network drives or other objects
that require special rights to access. You can specify a user that has the required rights in
the Kaspersky Endpoint Security settings and run the scan task under this user's account.

File types
Kaspersky Endpoint Security considers les without an extension as executable ones.
Kaspersky Endpoint Security always scans executable les regardless of the le types
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that you select for scanning.
All les. If this setting is enabled, Kaspersky Endpoint Security checks all les without
exception (all formats and extensions).
Files scanned by format. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . Before scanning a le for malicious code, the internal header of the
le is analyzed to determine the format of the le (for example, .txt, .doc, or .exe). The scan
also looks for les with particular le extensions.
Files scanned by extension. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . The le format is then determined based on the le's extension.
By default, Kaspersky Endpoint Security scans les by their format. Scanning les by
extension is less safe because a malicious le can have an extension that is not on the list
of potentially infectable (for example, .123).
Scan only
new and
changed les

Scans only new les and those les that have been modi ed since the last time they were
scanned. This helps reduce the duration of a scan. This mode applies both to simple and to
compound les.

Skip les that
are scanned
for longer
than N sec

Limits the duration for scanning a single object. After the speci ed amount of time,
Kaspersky Endpoint Security stops scanning a le. This helps reduce the duration of a scan.

Scan archives

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE.

Scan
distribution
packages

This check box enables/disables scanning of third-party distribution packages.

Scan les in
Microsoft
O ice
formats

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft extensions).
O ice format les include OLE objects as well.

Scan email
formats

This check box enables / disables the option for Kaspersky Endpoint Security to scan les
in email formats and mail databases.
The application only fully scans MS Outlook, Windows Mail/Outlook Express and EML mail
le formats and only if the computer has the MS Outlook x86 mail client.
If the check box is selected, Kaspersky Endpoint Security splits the mail-format le into its
components (header, body, attachments) and scans them for threats.
If this check box is cleared, Kaspersky Endpoint Security scans the mail-format le as a
single le.

Scan
passwordprotected
archives

If the check box is selected, Kaspersky Endpoint Security scans password-protected
archives. Before les in an archive can be scanned, you are prompted to enter the
password.
If the check box is cleared, Kaspersky Endpoint Security skips scanning of passwordprotected archives.

Do not
unpack large
compound
les

If this check box is selected, Kaspersky Endpoint Security does not scan compound les if
their size exceeds the speci ed value.
If this check box is cleared, Kaspersky Endpoint Security scans compound les of all sizes.
Kaspersky Endpoint Security scans large les that are extracted from archives regardless
of whether the check box is ticked or not.

Machine
learning and

The machine learning and signature analysis method uses the Kaspersky Endpoint Security
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signature
analysis

databases that contain descriptions of known threats and ways to neutralize them.
Protection that uses this method provides the minimum acceptable security level.
Based on the recommendations of Kaspersky experts, machine learning and signature
analysis is always enabled.

Heuristic
Analysis

The technology was developed for detecting threats that cannot be detected by using the
current version of Kaspersky application databases. It detects les that may be infected
with an unknown virus or a new variety of a known virus.
When scanning les for malicious code, the heuristic analyzer executes instructions in the
executable les. The number of instructions that are executed by the heuristic analyzer
depends on the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.

iSwift
Technology

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)
iChecker
Technology

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scanning by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date that the le was last scanned on,
and any modi cations to the scanning settings. The iSwift technology is an advancement
of the iChecker technology for the NTFS le system.

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scans by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date when the le was last scanned,
and any modi cations to the scan settings. There are limitations to iChecker Technology: it
does not work with large les and applies only to les with a structure that the application
recognizes (for example, EXE, DLL, LNK, TTF, INF, SYS, COM, CHM, ZIP, and RAR).

Scanning removable drives when they are connected to the computer
Kaspersky Endpoint Security scans all les that you run or copy, even if the le is located on a removable drive (File
Threat Protection component). To prevent the spread of viruses and other malware, you can con gure automatic
scans of removable drives when they are connected to the computer. Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection fails, Kaspersky Endpoint Security deletes
the les. The component keeps a computer secure by running scans that implement machine learning, heuristic
analysis (high level) and signature analysis. Kaspersky Endpoint Security also uses iSwift and iChecker scan
optimization technologies. The technologies are always on and cannot be disabled.
How to con gure running the Removable drives scan in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Local Tasks → Removable drives scan.
6. In the Action when a removable drive is connected drop-down list, select Detailed Scan or Quick Scan.
7. Con gure advanced options for Removable drives scan (see table below).
8. Save your changes.
How to con gure running the Removable drives scan in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Local Tasks → Removable drives scan.
5. In the Action when a removable drive is connected drop-down list, select Detailed Scan or Quick Scan.
6. Con gure advanced options for Removable drives scan (see table below).
7. Save your changes.
How to con gure running the Removable drives scan in the application interface
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1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Use the Removable drives scan toggle to enable or disable scans of removable drives upon connection to
the computer.
4. Con gure advanced options for Removable drives scan (see table below).
5. Save your changes.
As a result, Kaspersky Endpoint Security runs a Removable drives scan for removable drives that are not
larger than the speci ed maximum size. If the Removable drives scan task is not displayed, it means the
administrator has prohibited using local tasks in the policy.
Removable drives scan task settings

Parameter

Action
when a
removable
drive is
connected

Maximum
removable
drive size

Description

Detailed Scan If this item is selected, when a removable drive is connected, Kaspersky
Endpoint Security scans all les on the removable drive, including les nested in compound
objects, archives, distribution packages, and les in o ice formats. Kaspersky Endpoint
Security does not scan les in mail formats or password-protected archives.
Quick Scan If this option is selected, after a removable drive is connected Kaspersky Endpoint
Security scans only les of speci c formats that are most vulnerable to infection, and does
not unpack compound objects.
If this check box is selected, Kaspersky Endpoint Security performs the action that is selected
in the Action when a removable drive is connected drop-down list on removable drives with a
size not more than the speci ed maximum drive size.
If the check box is cleared, Kaspersky Endpoint Security performs the action that is selected
in the Action when a removable drive is connected drop-down list on removable drives of
any size.

Show scan
progress

If the check box is selected, Kaspersky Endpoint Security displays the progress of removable
drives scan in a separate window and in the Tasks window.
If the check box is cleared, Kaspersky Endpoint Security performs removable drives scan in
the background.

Block the
stopping
of the
scan task

If the check box is selected, the Stop button in the Tasks window and the Stop button in the
Virus Scan window are not available in the local interface of Kaspersky Endpoint Security.

Background scan
Background scan is a scan mode of Kaspersky Endpoint Security that does not display noti cations for the user.
Background scan requires less computer resources than other types of scans (such as a full scan). In this mode,
Kaspersky Endpoint Security scans startup objects, the boot sector, system memory, and the system partition. A
background scan is started in the following cases:
After an anti-virus database update.
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30 minutes after Kaspersky Endpoint Security is started.
Every six hours.
When the computer is idling for ve minutes or more (the computer is locked or the screensaver is on).
Background scan when the computer is idling is interrupted when any of the following conditions are true:
The computer went into active mode.
If the background scan has not been run for more than ten days, the scan is not interrupted.
The computer (laptop) has switched to battery mode.
When performing a background scan, Kaspersky Endpoint Security does not scan les whose contents are
located in OneDrive cloud storage.
How to enable background scanning in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Local Tasks → Background scan.
6. Use the Background scan check box to enable or disable background scanning.
7. Save your changes.
How to enable background scanning in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Local tasks → Background scan.
5. Use the Background scan check box to enable or disable background scanning.
6. Save your changes.
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How to enable background scanning in the application interface

1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Use the Background scan toggle to enable or disable background scans.
4. Save your changes.
If the Background scan is not displayed, it means the administrator has prohibited using local tasks in the
policy.

Scan from context menu
Kaspersky Endpoint Security lets you run a scan of individual les for viruses and other malware from the context
menu (see the gure below).
When performing a scan from the context menu, Kaspersky Endpoint Security does not scan les whose
contents are located in OneDrive cloud storage.

Scan from context menu

How to con gure Scan from Context Menu in Administration Console (MMC)

124

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Local Tasks → Scan from Context Menu.
6. Con gure Scan from Context Menu (see the table below).
7. Save your changes.
How to con gure Scan from Context Menu in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Local Tasks → Scan from Context Menu.
5. Con gure Scan from Context Menu (see the table below).
6. Save your changes.
How to con gure Scan from Context Menu in the application interface

1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Con gure Scan from Context Menu (see the table below).
4. Save your changes.
If the Scan from Context Menu task is not displayed, it means the administrator has prohibited using local
tasks in the policy.
Scan from Context Menu task settings

Parameter

Security
level

Description

Kaspersky Endpoint Security can use di erent groups of settings for running a scan. These
groups of settings that are stored in the application are called security levels:
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High. Kaspersky Endpoint Security scans all types of les. When scanning compound les,
Kaspersky Endpoint Security also scans mail-format les.
Recommended. Kaspersky Endpoint Security scans only the speci ed le formats on all
hard drives, network drives, and removable storage media of the computer, and also
embedded OLE objects. Kaspersky Endpoint Security does not scan archives or
installation packages.
Low. Kaspersky Endpoint Security scans only new or modi ed les with the speci ed
extensions on all hard drives, removable drives, and network drives of the computer.
Kaspersky Endpoint Security does not scan compound les.
Action on
threat
detection

Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection fails,
Kaspersky Endpoint Security deletes the les.
Disinfect; block if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection is not
possible, Kaspersky Endpoint Security adds the information about the infected les that are
detected to the list of active threats.
Inform. If this option is selected, Kaspersky Endpoint Security adds the information about
infected les to the list of active threats on detection of these les.

File types
Kaspersky Endpoint Security considers les without an extension as executable ones.
Kaspersky Endpoint Security always scans executable les regardless of the le types
that you select for scanning.
All les. If this setting is enabled, Kaspersky Endpoint Security checks all les without
exception (all formats and extensions).
Files scanned by format. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . Before scanning a le for malicious code, the internal header of the le
is analyzed to determine the format of the le (for example, .txt, .doc, or .exe). The scan also
looks for les with particular le extensions.
Files scanned by extension. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . The le format is then determined based on the le's extension.
By default, Kaspersky Endpoint Security scans les by their format. Scanning les by
extension is less safe because a malicious le can have an extension that is not on the list of
potentially infectable (for example, .123).
Scan only
new and
changed
les

Scans only new les and those les that have been modi ed since the last time they were
scanned. This helps reduce the duration of a scan. This mode applies both to simple and to
compound les.

Skip les
that are
scanned
for longer
than N sec

Limits the duration for scanning a single object. After the speci ed amount of time,
Kaspersky Endpoint Security stops scanning a le. This helps reduce the duration of a scan.

Scan
archives

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE.

Scan
distribution
packages

The check box enables or disables scanning of distribution packages.
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Scan les
in
Microsoft
O ice
formats
Scan email
formats

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft extensions). O ice
format les include OLE objects as well.

This check box enables / disables the option for Kaspersky Endpoint Security to scan les in
email formats and mail databases.
The application only fully scans MS Outlook, Windows Mail/Outlook Express and EML mail le
formats and only if the computer has the MS Outlook x86 mail client.
If the check box is selected, Kaspersky Endpoint Security splits the mail-format le into its
components (header, body, attachments) and scans them for threats.
If this check box is cleared, Kaspersky Endpoint Security scans the mail-format le as a single
le.

Scan
passwordprotected
archives
Do not
unpack
large
compound
les
Machine
learning
and
signature
analysis
Heuristic
Analysis

If the check box is selected, Kaspersky Endpoint Security scans password-protected
archives. Before les in an archive can be scanned, you are prompted to enter the password.
If the check box is cleared, Kaspersky Endpoint Security skips scanning of passwordprotected archives.
If this check box is selected, Kaspersky Endpoint Security does not scan compound les if
their size exceeds the speci ed value.
If this check box is cleared, Kaspersky Endpoint Security scans compound les of all sizes.
Kaspersky Endpoint Security scans large les that are extracted from archives regardless of
whether the check box is ticked or not.
The machine learning and signature analysis method uses the Kaspersky Endpoint Security
databases that contain descriptions of known threats and ways to neutralize them.
Protection that uses this method provides the minimum acceptable security level.
Based on the recommendations of Kaspersky experts, machine learning and signature
analysis is always enabled.
The technology was developed for detecting threats that cannot be detected by using the
current version of Kaspersky application databases. It detects les that may be infected with
an unknown virus or a new variety of a known virus.
When scanning les for malicious code, the heuristic analyzer executes instructions in the
executable les. The number of instructions that are executed by the heuristic analyzer
depends on the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.

iSwift
Technology

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scanning by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date that the le was last scanned on,
and any modi cations to the scanning settings. The iSwift technology is an advancement of
the iChecker technology for the NTFS le system.

iChecker
Technology

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scans by using a special algorithm that takes into account the release date
of Kaspersky Endpoint Security databases, the date when the le was last scanned, and any
modi cations to the scan settings. There are limitations to iChecker Technology: it does not
work with large les and applies only to les with a structure that the application recognizes
(for example, EXE, DLL, LNK, TTF, INF, SYS, COM, CHM, ZIP, and RAR).
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Checking the integrity of application
Kaspersky Endpoint Security checks the application modules for corruption or modi cations. For example, if an
application library has an incorrect digital signature, the library is considered corrupt. The Integrity check task is
intended for scanning application les. Run the Integrity check task if Kaspersky Endpoint Security detected a
malicious object but did not neutralize it.
You can create the Integrity Check task both in the Kaspersky Security Center Web Console and in the
Administration Console. It is not possible to create a task in the Kaspersky Security Center Cloud Console.
Application integrity breaches may occur in the following cases:
A malicious object modi ed les of Kaspersky Endpoint Security. In this case, perform the procedure for
restoring Kaspersky Endpoint Security using the tools of the operating system. After restoration, run a full scan
of the computer and repeat the integrity check.
The digital signature expired. In this case, update Kaspersky Endpoint Security.
How to run an application integrity check through the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → Integrity check.

Step 2. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 3. Con guring a task start schedule
Con gure a schedule for starting a task, for example, manually or when a virus outbreak is detected.

Step 4. De ning the task name
Enter a name for the task, for example, Integrity check after the computer was infected.

Step 5. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties. As a result, Kaspersky Endpoint Security will check the
integrity of the application. You can also con gure an application integrity check schedule in the task
properties (see the table below).
How to run an application integrity check through the Web Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Integrity check.
c. In the Task name eld, enter a brief description, for example, Check the integrity of the
application after a computer infection.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
6. Select the check box next to the task.
As a result, Kaspersky Endpoint Security will check the integrity of the application. You can also con gure an
application integrity check schedule in the task properties (see the table below).
How to run an integrity check in the application interface

1. In the main application window, go to the Tasks section.
2. This opens the task list; select the Integrity check task and click Run scan.
As a result, Kaspersky Endpoint Security will check the integrity of the application. You can also con gure an
application integrity check schedule in the task properties (see the table below). If the Integrity check is not
displayed, it means the administrator has prohibited using local tasks in the policy.
Integrity check task settings

Parameter

Scan
schedule

Description

Manually. Run mode in which you can start scan manually at a time when it is convenient for
you.
By schedule. In this scan task run mode, Kaspersky Endpoint Security starts the scan task in
accordance with the schedule that you create. If this scan task run mode is selected, you can
also start the scan task manually.

Run
missed
tasks

If the check box is selected, Kaspersky Endpoint Security starts the skipped scan task as soon
as it becomes possible. The scan task may be skipped, for example, if the computer was o at
the scheduled scan task start time. If the check box is cleared, Kaspersky Endpoint Security
does not run skipped scan tasks. Instead, it carries out the next scan task in accordance with
the current schedule.
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Run only
when the
computer
is idle

Postponed start of the scan task when computer resources are busy. Kaspersky Endpoint
Security starts the scan task if the computer is locked or if the screen saver is on. If you have
interrupted the execution of the task, for example by unlocking the computer, Kaspersky
Endpoint Security automatically runs the task, continuing from the point where it was
interrupted.

Run scan
as

By default the scan task is run in the name of the user with whose rights you are registered in
the operating system. Special permissions may be required for accessing the application
installation folder. You can specify a user that has the required rights in the Kaspersky Endpoint
Security settings and run the scan task under this user's account.

(available
only in the
Kaspersky
Security
Center
Console)

Editing the scan scope
The Scan scope is a list of paths to folders and paths that Kaspersky Endpoint Security scans when executing the
task. Kaspersky Endpoint Security supports environment variables and the * and ? characters when entering a
mask.
To edit the scan scope, we recommend using the Custom Scan task. Kaspersky experts recommend that you
do not change the scan scope of the Full Scan and Critical Areas Scan tasks.
Kaspersky Endpoint Security has the following prede ned objects as part of the scan scope:
My email.
Files relevant to the Outlook mail client: data les (PST), o line data les (OST).
Kernel Memory.
Running processes and Startup Objects.
Memory occupied by processes and application executable les that are run at system startup.
Disk boot sectors.
Hard disk and removable disk boot sectors.
System Backup.
Contents of the System Volume Information folder.
All removable drives.
All hard drives.
All network drives.
To exclude folders or les from the scan scope, add the folder or le to the trusted zone.
How to edit a scan scope in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Tasks tab.
4. Select the scan task and double-click to open the task properties.
If necessary, create a Virus scan task.
5. In the task properties window, select the Settings section.
6. In the Scan scope section, click Settings.
7. In the opened window, select the objects that you want to add to the scan scope or exclude from it.
8. If you want to add a new object to the scan scope:
a. Click the Add button.
b. In the Object eld, enter the path to the folder or le and click Add.
Use masks:
The * (asterisk) character, which takes the place of any set of characters, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\*\*.txt will include all paths to les with the TXT extension located in folders on the
C: drive, but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the
le or folder name, including the \ and / characters (delimiters of the names of les and folders in
paths to les and folders). For example, the mask C:\Folder\**\*.txt will include all paths to les
with the TXT extension located in the folder named Folder and its subfolders. The mask must
include at least one nesting level. The mask C:\**\*.txt is not a valid mask.
The ? (question mark) character, which takes the place of any single character, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\Folder\???.txt will include paths to all les residing in the folder named Folder that
have the TXT extension and a name consisting of three characters.
You can exclude an object from scans without deleting it from the list of objects in the scan scope. To do
so, clear the check box next to the object.
9. Save your changes.
How to edit a scan scope in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the scan task.
The task properties window opens. If necessary, create a Virus Scan task.
3. Select the Application settings tab.
4. In the Scan scope section, select the objects that you want to add to the scan scope or exclude from it.
5. If you want to add a new object to the scan scope:
a. Click the Add button.
b. In the Path eld, enter the path to the folder or le and click OK.
Use masks:
The * (asterisk) character, which takes the place of any set of characters, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\*\*.txt will include all paths to les with the TXT extension located in folders on the
C: drive, but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the
le or folder name, including the \ and / characters (delimiters of the names of les and folders in
paths to les and folders). For example, the mask C:\Folder\**\*.txt will include all paths to les
with the TXT extension located in the folder named Folder and its subfolders. The mask must
include at least one nesting level. The mask C:\**\*.txt is not a valid mask.
The ? (question mark) character, which takes the place of any single character, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\Folder\???.txt will include paths to all les residing in the folder named Folder that
have the TXT extension and a name consisting of three characters.
You can exclude an object from scans without deleting it from the list of objects in the scan scope. To do
so, set the toggle switch next to it to the o position.
6. Save your changes.
How to edit a scan scope in the application interface
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1. In the main application window, go to the Tasks section.
2. In the task list, select the Custom Scan task and click Select.
You can also edit the scan scope for other tasks. Kaspersky experts recommend that you do not change
the scan scope of the Full Scan and Critical Areas Scan tasks.
3. In the opened window, select the objects that you want to add to the scan scope.
4. Save your changes.
If the scan task is not displayed, it means the administrator has prohibited the use of local tasks in the policy.

Running a scheduled scan
Fully scanning the computer takes some time and resources of the computer. You should choose the optimum
time to run a computer scan to avoid adversely impacting the performance of other software. Kaspersky Endpoint
Security lets you con gure a normal schedule for scanning the computer. This is convenient if your organization
has a work schedule. You can con gure a computer scan to run at night or on weekends. If it is impossible to run
the scan task for any reason (for example, the computer is o at that time), you can con gure the skipped task to
be run automatically as soon as this becomes possible.
If con guring an optimum scan schedule proves impossible, Kaspersky Endpoint Security lets you run a computer
scan when the following special conditions are met:
After a database update.
Kaspersky Endpoint Security runs the computer scan with the updated signature databases.
After application startup.
Kaspersky Endpoint Security runs a computer scan when a speci ed amount of time elapses after application
startup. At operating system startup, many processes are running, therefore it is advantageous to postpone
running the scan task instead of running it immediately after Kaspersky Endpoint Security startup.
Wake-on-LAN.
Kaspersky Endpoint Security runs a computer scan on schedule even if the computer is powered o . To do so,
the application uses the Wake-on-LAN feature of the operating system. The Wake-on-LAN feature allows
remotely powering on the computer by sending a special signal over the local network. To use this feature, you
must enable Wake-on-LAN in BIOS settings.
You can con gure running the scan using Wake-on-LAN only for the Virus Scan task in Kaspersky Security
Center. You cannot enable Wake-on-LAN for scanning the computer in the application interface.
When the computer is idling.
Kaspersky Endpoint Security runs a computer scan on schedule when the screensaver is active or the screen is
locked. If the user unlocks the computer, Kaspersky Endpoint Security pauses the scan. This means that it may
take several days for the application to complete a full computer scan.
How to con gure the scan schedule in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Tasks tab.
4. Select the scan task and double-click to open the task properties.
If necessary, create a Virus scan task.
5. In the task properties window, select the Schedule section.
6. Con gure the scan task schedule.
7. Depending on the selected frequency, con gure advanced settings that specify the task run schedule (see
the table below).
8. Save your changes.
How to con gure the scan schedule in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the scan task.
The task properties window opens.
3. Select the Schedule tab.
4. Con gure the scan task schedule.
5. Depending on the selected frequency, con gure advanced settings that specify the task run schedule (see
the table below).
6. Save your changes.
How to con gure the scan schedule in the application interface
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You can con gure the scan schedule only if a policy is not applied to the computer. For computers under
policy, you can con gure the Virus Scan task schedule in Kaspersky Security Center.
1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

You can con gure a schedule for running a Full Scan, a Critical Areas Scan, or an Integrity Check. You can
only run a Custom Scan manually.
3. Click the Scan schedule button.
4. In the opened window, con gure the scan task run schedule.
5. Depending on the selected frequency, con gure advanced settings that specify the task run schedule (see
the table below).
6. Save your changes.
Scan schedule settings

Parameter

Scan
schedule

Description

Manually. Run mode in which you can start scan manually at a time when it is convenient
for you.
By schedule. In this scan task run mode, Kaspersky Endpoint Security starts the scan task
in accordance with the schedule that you create. If this scan task run mode is selected,
you can also start the scan task manually.

Start in N
minutes after
application
startup

Postponed start of the scan task after application startup. At operating system startup,
many processes are running, therefore it is advantageous to postpone running the scan
task instead of running it immediately after Kaspersky Endpoint Security startup.

Run missed
tasks

If the check box is selected, Kaspersky Endpoint Security starts the skipped scan task as
soon as it becomes possible. The scan task may be skipped, for example, if the computer
was o at the scheduled scan task start time. If the check box is cleared, Kaspersky
Endpoint Security does not run skipped scan tasks. Instead, it carries out the next scan
task in accordance with the current schedule.

Run only when
the computer
is idle

Postponed start of the scan task when computer resources are busy. Kaspersky Endpoint
Security starts the scan task if the computer is locked or if the screen saver is on. If you
have interrupted the execution of the task, for example by unlocking the computer,
Kaspersky Endpoint Security automatically runs the task, continuing from the point where
it was interrupted.

Use
automatically
randomized
delay for task
starts

If the check box is selected, the task is not run strictly on schedule, but randomly within a
certain interval, that is, the start times of the task are spread out. Randomized start times
help avoid a great number of computers simultaneously accessing the Administration
Server when the task is run on schedule.

(available only
in the
Kaspersky
Security
Center
Console)

The range of randomized start times is automatically calculated when the task is created,
depending on the number of computers that have the task assigned. Subsequently, the
task is always run at its calculated start time. However, whenever task settings are
modi ed or the task is run manually, the calculated start time changes.
If the check box is cleared, the task is run exactly at scheduled time.
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Activate the
device before
the task is
started
through
Wake-on-LAN
(min)

If the check box is selected, the operating system of the computer is given a speci ed lead
time to complete startup before the task is run. The default lead time is 5 minutes.
Select the check box if you want to run the task on all computers including powered o
computers.

(available only
in the
Kaspersky
Security
Center
Console)

Running a scan as a di erent user
By default the scan task is run in the name of the user with whose rights you are registered in the operating
system. The protection scope may include network drives or other objects that require special rights to access.
You can specify a user that has the required rights in the Kaspersky Endpoint Security settings and run the scan
task under this user's account.
You can run the following scans as a di erent user:
Critical Areas Scan.
Full Scan.
Custom Scan.
Scan from Context Menu.
You cannot con gure user rights to run a Removable drives scan, a Background scan, or an Integrity check.
How to run a scan as a di erent user in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Tasks tab.
4. Select the scan task and double-click to open the task properties.
5. In the task properties window, select the Account section.
6. Enter the account credentials of the user whose rights you want to use to run a scan task.
7. Save your changes.
How to run a scan as a di erent user in Web Console or Cloud Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the scan task.
The task properties window opens.
3. Select the Settings tab.
4. Under Account, click Settings.
5. Enter the account credentials of the user whose rights you want to use to run a scan task.
6. Save your changes.
How to run a scan as a di erent user in the application interface

1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Click Advanced settings → Run scan as.
4. In the opened window, enter the account credentials of the user whose rights you want to use to run a
scan task.
5. Save your changes.
If the scan task is not displayed, it means the administrator has prohibited the use of local tasks in the policy.

Scan optimization
You can optimize le scanning: reduce scan time and increase the operating speed of Kaspersky Endpoint Security.
This can be achieved by scanning only new les and those les that have been modi ed since the previous scan.
This mode applies both to simple and to compound les. You can also set a limit for scanning a single le. When the
speci ed time interval expires, Kaspersky Endpoint Security excludes the le from the current scan (except
archives and objects that include several les).
A common technique of concealing viruses and other malware is to implant them in compound les, such as
archives or databases. To detect viruses and other malware that are hidden in this way, the compound le must be
unpacked, which may slow down scanning. You can limit the types of compound les to be scanned and thereby
speed up scanning.
You can also enable the iChecker and iSwift technologies. The iChecker and iSwift technologies optimize the
speed of scanning les, by excluding les that have not been modi ed since the most recent scan.
How to optimize scanning in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Tasks tab.
4. Select the scan task and double-click to open the task properties.
If necessary, create a Virus scan task.
5. In the task properties window, select the Settings section.
6. In the Security level section, click the Settings button.
This opens the scan task settings window.
7. In the Scan optimization block, con gure the scan settings:
Scan only new and changed les. Scans only new les and those les that have been modi ed since
the last time they were scanned. This helps reduce the duration of a scan. This mode applies both to
simple and to compound les.
You can also con gure scanning new les by type. For example, you can scan all distribution packages
and scan only new archives and o ice format les.
Skip les that are scanned for longer than N sec. This sets a time limit for scanning a single object.
After the speci ed amount of time, Kaspersky Endpoint Security stops scanning a le. This helps
reduce the duration of a scan.
8. Click the Additional button.
This opens the compound les scanning settings window.
9. Under Size limit, select the Do not unpack large compound les check box. Limits the duration for
scanning a single object. After the speci ed amount of time, Kaspersky Endpoint Security stops scanning a
le. This helps reduce the duration of a scan.
Kaspersky Endpoint Security scans large les that are extracted from archives, regardless of whether
the Do not unpack large compound les check box is selected.
10. Click OK.
11. Select the Additional tab.
12. In the Scan technologies block, select the check boxes next to the names of technologies that you want
to use during a scan:
iSwift technology. This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scanning by using a special algorithm that takes into account the
release date of Kaspersky Endpoint Security databases, the date that the le was last scanned on, and
any modi cations to the scanning settings. The iSwift technology is an advancement of the iChecker
technology for the NTFS le system.
iChecker technology. This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scans by using a special algorithm that takes into account the release
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date of Kaspersky Endpoint Security databases, the date when the le was last scanned, and any
modi cations to the scan settings. There are limitations to iChecker Technology: it does not work with
large les and applies only to les with a structure that the application recognizes (for example, EXE,
DLL, LNK, TTF, INF, SYS, COM, CHM, ZIP, and RAR).
13. Save your changes.
How to optimize scanning in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the scan task.
The task properties window opens. If necessary, create a Virus Scan task.
3. Select the Application settings tab.
4. Under Action on threat detection, select the Scan only new and changed les check box. Scans only new
les and those les that have been modi ed since the last time they were scanned. This helps reduce the
duration of a scan. This mode applies both to simple and to compound les.
You can also con gure scanning new les by type. For example, you can scan all distribution packages and
scan only new archives and o ice format les.
5. Select the Do not unpack large compound les check box. Limits the duration for scanning a single
object. After the speci ed amount of time, Kaspersky Endpoint Security stops scanning a le. This helps
reduce the duration of a scan.
Kaspersky Endpoint Security scans large les that are extracted from archives, regardless of whether
the Do not unpack large compound les check box is selected.
6. Under Advanced Settings, select the Skip les that are scanned for longer than N sec check box. This
sets a time limit for scanning a single object. After the speci ed amount of time, Kaspersky Endpoint
Security stops scanning a le. This helps reduce the duration of a scan.
7. Save your changes.
How to optimize scanning in the application interface
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1. In the main application window, go to the Tasks section.
2. In the task list, select the scan task and click

.

3. Click the Advanced settings button.
4. In the Scan optimization block, con gure the scan settings:
Scan only new and changed les. Scans only new les and those les that have been modi ed since
the last time they were scanned. This helps reduce the duration of a scan. This mode applies both to
simple and to compound les.
You can also con gure scanning new les by type. For example, you can scan all distribution packages
and scan only new archives and o ice format les.
Skip les that are scanned for longer than N sec. This sets a time limit for scanning a single object.
After the speci ed amount of time, Kaspersky Endpoint Security stops scanning a le. This helps
reduce the duration of a scan.
5. Under Size limit, select the Do not unpack large compound les check box. Limits the duration for
scanning a single object. After the speci ed amount of time, Kaspersky Endpoint Security stops scanning a
le. This helps reduce the duration of a scan.
Kaspersky Endpoint Security scans large les that are extracted from archives, regardless of whether
the Do not unpack large compound les check box is selected.
6. In the Scan technologies block, select the check boxes next to the names of technologies that you want
to use during a scan:
iSwift technology. This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scanning by using a special algorithm that takes into account the
release date of Kaspersky Endpoint Security databases, the date that the le was last scanned on, and
any modi cations to the scanning settings. The iSwift technology is an advancement of the iChecker
technology for the NTFS le system.
iChecker technology. This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scans by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date when the le was last scanned, and any
modi cations to the scan settings. There are limitations to iChecker Technology: it does not work with
large les and applies only to les with a structure that the application recognizes (for example, EXE,
DLL, LNK, TTF, INF, SYS, COM, CHM, ZIP, and RAR).
7. Save your changes.
If the scan task is not displayed, it means the administrator has prohibited the use of local tasks in the policy.
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Updating databases and application software modules
Updating the databases and application modules of Kaspersky Endpoint Security ensures up-to-date protection
on your computer. New viruses and other types of malware appear worldwide on a daily basis. Kaspersky Endpoint
Security databases contain information about threats and ways of neutralizing them. To detect threats quickly, you
are urged to regularly update the databases and application modules.
Regular updates require a license in e ect. If there is no current license, you will be able to perform an update
only once.
The main update source for Kaspersky Endpoint Security is Kaspersky update servers.
Your computer must be connected to the Internet to successfully download the update package from Kaspersky
update servers. By default, the Internet connection settings are determined automatically. If you are using a proxy
server, you need to con gure the proxy server settings.
Updates are downloaded over the HTTPS protocol. They may also be downloaded over the HTTP protocol
when it is impossible to download updates over the HTTPS protocol.
While performing an update, the following objects are downloaded and installed on your computer:
Kaspersky Endpoint Security databases. Computer protection is provided using databases that contain
signatures of viruses and other threats and information on ways to neutralize them. Protection components
use this information when searching for and neutralizing infected les on your computer. The databases are
constantly updated with records of new threats and methods for counteracting them. Therefore, we
recommend that you update the databases regularly.
In addition to the Kaspersky Endpoint Security databases, the network drivers that enable the application's
components to intercept network tra ic are updated.
Application modules. In addition to the databases of Kaspersky Endpoint Security, you can also update the
application modules. Updating the application modules xes vulnerabilities in Kaspersky Endpoint Security, adds
new functions, or enhances existing functions.
While updating, the application modules and databases on your computer are compared against the up-to-date
version at the update source. If your current databases and application modules di er from their respective upto-date versions, the missing portion of the updates is installed on your computer.
Context help les can be updated together with application module updates.
If the databases are obsolete, the update package may be large, which may cause additional Internet tra ic
(up to several dozen MB).
Information about the current state of the Kaspersky Endpoint Security databases is displayed in the main
application window or the tooltip that you see when you hover the cursor over the icon of the application in the
noti cation area.
Information on update results and on all events that occur during the performance of the update task is logged in
the Kaspersky Endpoint Security report.
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Database and application module update scenarios
Updating the databases and application modules of Kaspersky Endpoint Security ensures up-to-date protection
on your computer. New viruses and other types of malware appear worldwide on a daily basis. Kaspersky Endpoint
Security databases contain information about threats and ways of neutralizing them. To detect threats quickly, you
are urged to regularly update the databases and application modules.
The following objects are updated on users' computers:
Anti-virus databases. Anti-virus databases include databases of malware signatures, description of network
attacks, databases of malicious and phishing web addresses, databases of banners, spam databases, and other
data.
Application modules. Module updates are intended for eliminating vulnerabilities in the application and to
improve computer protection methods. Module updates may change the behavior of application components
and add new capabilities.
Kaspersky Endpoint Security supports the following scenarios for updating databases and application modules:
Update from Kaspersky servers.
Kaspersky update servers are located in various countries throughout the world. This ensures high reliability of
updates. If an update cannot be performed from one server, Kaspersky Endpoint Security switches over to the
next server.

Update from Kaspersky servers

Centralized update.
Centralized update reduces external Internet tra ic, and provides for convenient monitoring of the update.
Centralized update consists of the following steps:
1. Download the update package to a repository within the organization's network.
The update package is downloaded to the repository by the Administration Server task named Download
updates to Administration Server repository.
2. Download the update package to a shared folder (optional).
You can download the update package to a shared folder by using the following methods:
Using Kaspersky Endpoint Security Update task. The task is intended for one of the computers in the
local company network.
Using the Kaspersky Update Utility. For detailed information about using Kaspersky Update Utility, refer to
the Kaspersky Knowledge Base .
3. Distribute the update package to client computers.
The update package is distributed to client computers by the Kaspersky Endpoint Security Update task. You
can create an unlimited number of update tasks for each administration group.
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Updating from a server repository

Updating from a shared folder

Updating using Kaspersky Update Utility

For the Web Console, the default list of update sources contains the Kaspersky Security Center Administration
Server and Kaspersky update servers. For the Kaspersky Security Center Cloud Console, the default list of update
sources contains distribution points and Kaspersky update servers. For more details about distribution points,
refer to the Kaspersky Security Center Cloud Console Help. You can add other update sources to the list. You can
specify HTTP/FTP servers and shared folders as update sources. If an update cannot be performed from an
update source, Kaspersky Endpoint Security switches over to the next one.
Updates are downloaded from Kaspersky update servers or from other FTP- or HTTP servers over standard
network protocols. If connection to a proxy server is required for accessing the update source, specify the proxy
server settings in Kaspersky Endpoint Security policy settings.

Updating from a server repository
To conserve Internet tra ic, you can con gure updates of databases and application modules on computers of
the organization's LAN from a server repository. For this purpose, Kaspersky Security Center must download an
update package to the repository (FTP- or HTTP server, network or local folder) from Kaspersky update servers.
Other computers on the organization's LAN will be able to receive the update package from the server repository.
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Con guring database and application module updates from a server repository consists of the following steps:
1. Con gure download of an update package to the Administration Server repository (Download updates to
Administration Server repository task).
2. Con gure database and application module updates from the speci ed server repository to the remaining
computers on the organization's LAN (Update task).

Updating from a server repository

To con gure download of an update package to the server repository:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Select the Download updates to the Administration Server repository Administration Server task.
The task properties window opens.
The Download updates to the Administration Server repository Administration Server task is created
automatically by the Quick Start Wizard of Kaspersky Security Center Web Console, and this task may only
have one single instance.
3. Select the Application settings tab.
4. In the Other settings section, click Con gure.
5. In the Folder for storing updates eld, specify the address of FTP- or HTTP server, network folder or local
folder where Kaspersky Security Center copies the update package received from Kaspersky update servers.
The following path format is used for update source:
For an FTP or HTTP server, enter its web address or IP address.
For example, http://dnl-01.geo.kaspersky.com/ or 93.191.13.103.
For an FTP server, you can specify the authentication settings within the address in the following format:
ftp://<user name>:<password>@<node>:<port>.
For a network folder, enter the UNC path.
For example, \\ Server\Share\Update distribution.
For a local folder, enter the full path to that folder.
For example, C:\Documents and Settings\All Users\Application Data\Kaspersky
Lab\AVP11\Update distribution\.
6. Save your changes.

To con gure Kaspersky Endpoint Security update from the speci ed server storage:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
145

2. Click the Update task for Kaspersky Endpoint Security.
The task properties window opens.
The Update task is created automatically by the Quick Start Wizard of Kaspersky Security Center. To create
the Update task, install the Kaspersky Endpoint Security for Windows web plug-in while running the Wizard.
3. Select the Application settings tab → Local mode.
4. In the list of update sources, click the Add button.
5. In the Source eld, specify the address of the FTP- or HTTP server, network folder or local folder where
Kaspersky Security Center will copy the update package received from Kaspersky servers.
The address of the update source must match the address you speci ed in the Folder for storing
updates eld when you con gured download of updates to the server storage (see the instruction above).
6. In the Status section select Enabled.
7. Click OK.
8. Con gure the priorities of update sources by using the Up and Down buttons.
9. Save your changes.
If an update cannot be performed from the rst update source, Kaspersky Endpoint Security automatically
switches over to the next source.

Updating from a shared folder
To conserve Internet tra ic, you can con gure updates of databases and application modules on computers of
the organization's LAN from a shared folder. For this purpose, one of the computers on the organization's LAN
must receive update packages from the Kaspersky Security Center Administration Server or from Kaspersky
update servers and then copy the received update package to the shared folder. Other computers on the
organization's LAN will be able to receive the update package from this shared folder.
Con guring database and application module updates from a shared folder consists of the following steps:
1. Con guring database and application module updates from a server repository.
2. Enable copying of an update package to a shared folder on one of the computers on the enterprise LAN (see
the instructions below).
3. Con gure database and application module updates from the speci ed shared folder to the remaining
computers on the enterprise LAN (see the instructions below).
The version and localization of the Kaspersky Endpoint Security application that copies the update
package to a shared folder must match the version and localization of the application that updates
databases from the shared folder. If versions or localizations of the applications do not match, the
database update may end with an error.
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Updating from a shared folder

To enable copying of the update package to the shared folder:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Update task for Kaspersky Endpoint Security.
The task properties window opens.
The Update task is created automatically by the Quick Start Wizard of Kaspersky Security Center. To create
the Update task, install the Kaspersky Endpoint Security for Windows web plug-in while running the Wizard.
3. Select the Application settings tab → Local mode.
4. Con gure the sources of updates.
The sources of updates can be Kaspersky update servers, Kaspersky Security Center Administration Server,
other FTP- or HTTP servers, local folders, or network folders.
5. Select the Copy updates to folder check box.
6. In the Path eld, enter the UNC path to the shared folder (for example, \\Server\Share\Update
distribution).
If the eld is left blank, Kaspersky Endpoint Security copies the update package to the C:\Documents and
Settings\All Users\Application Data\Kaspersky Lab\AVP11\Update distribution\ folder.
7. Save your changes.
The Update task must be assigned for one computer that will serve as the source of updates.

To con gure updates from a shared folder:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
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b. In the Task type drop-down list, select Update.
c. In the Task name eld, enter a brief description, for example, Updating from a shared folder.
d. In the Select devices to which the task will be assigned section, select the task scope.
The Update task must be assigned to the computers of the organization's LAN, except the computer
that serves as the update source.
4. Select devices according to the selected task scope option and click Next.
5. Finish the wizard by clicking the Create button.
A new task will be displayed in the table of tasks.
6. Click the newly created Update. task.
The task properties window opens.
7. Go to the Application settings section.
8. Select the Local mode tab.
9. In the Update source section, click the Add button.
10. In the Source eld, enter the path to the shared folder.
The source address must match the address that you previously speci ed in the Path eld when you
con gured copying of the update package to the shared folder (see the instructions above).
11. Click OK.
12. Con gure the priorities of update sources by using the Up and Down buttons.
13. Save your changes.

Updating using Kaspersky Update Utility
To conserve Internet tra ic, you can con gure updates of databases and application modules on computers of
the organization's LAN from a shared folder using the Kaspersky Update Utility. For this purpose, one of the
computers on the organization's LAN must receive update packages from the Kaspersky Security Center
Administration Server or from Kaspersky update servers and then copy the received update packages to the
shared folder using the utility. Other computers on the organization's LAN will be able to receive the update
package from this shared folder.
Con guring database and application module updates from a shared folder consists of the following steps:
1. Con guring database and application module updates from a server repository.
2. Install the Kaspersky Update Utility on one of the computers of the organization's LAN.
3. Con gure copying of the update package to the shared folder in the Kaspersky Update Utility settings.
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4. Con gure database and application module updates from the speci ed shared folder to the remaining
computers on the organization's LAN.
The version and localization of the Kaspersky Endpoint Security application that copies the update
package to a shared folder must match the version and localization of the application that updates
databases from the shared folder. If versions or localizations of the applications do not match, the
database update may end with an error.

Updating using Kaspersky Update Utility

You can download the Kaspersky Update Utility distribution package from the Kaspersky Technical Support
website . After installing the utility, select the update source (for example, the Administration Server repository)
and the shared folder to which the Kaspersky Update Utility will copy update packages. For detailed information
about using Kaspersky Update Utility, refer to the Kaspersky Knowledge Base .

To con gure updates from a shared folder:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Update task for Kaspersky Endpoint Security.
The task properties window opens.
The Update task is created automatically by the Quick Start Wizard of Kaspersky Security Center. To create
the Update task, install the Kaspersky Endpoint Security for Windows web plug-in while running the Wizard.
3. Select the Application settings tab → Local mode.
4. In the list of update sources, click the Add button.
5. In the Source eld, enter the UNC path to the shared folder (for example, \\Server\Share\Update
distribution).
The source address must match the address indicated in the Kaspersky Update Utility settings.
6. Click OK.
7. Con gure the priorities of update sources by using the Up and Down buttons.
8. Save your changes.
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Updating in mobile mode
Mobile mode is the mode of Kaspersky Endpoint Security operation, when a computer leaves the organization
network perimeter (o line computer). For more details about working with o line computers and out-of-o ice
users, refer to the Kaspersky Security Center Help .
An o line computer outside of the organization's network cannot connect to the Administration Server to update
databases and application modules. By default, only Kaspersky update servers are used as update source for
updating databases and application modules in mobile mode. The use of a proxy server to connect to the Internet
is determined by a special out-of-o ice policy. The out-of-o ice policy must be created separately. When
Kaspersky Endpoint Security is switched to mobile mode, the update task is started every two hours.

To con gure the update settings for mobile mode:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Update task for Kaspersky Endpoint Security.
The task properties window opens.
The Update task is created automatically by the Quick Start Wizard of Kaspersky Security Center. To create
the Update task, install the Kaspersky Endpoint Security for Windows web plug-in while running the Wizard.
Select the Application settings tab → Mobile mode.
3. Con gure the sources of updates. The sources of updates can be Kaspersky update servers, other FTP- and
HTTP servers, local folders, or network folders.
4. Save your changes.
As a result, the databases and application modules will be updated on user computers when they switch to
mobile mode.

Starting and stopping an update task
Regardless of the selected update task run mode, you can start or stop a Kaspersky Endpoint Security update
task at any time.

To start or stop an update task:
1. In the main application window, go to the Update section.
2. In the Update of databases and application modules block, click the Update button if you want to start the
update task.
Kaspersky Endpoint Security will start updating the application modules and databases. The application will
display the task progress, the size of the downloaded les, and the update source. You can stop the task at any
time by clicking Stop update.

To start or stop the update task when the simpli ed application interface is displayed:
1. Right-click to bring up the context menu of the application icon that is in the taskbar noti cation area.
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2. In the Tasks drop-down list in the context menu, do one of the following:
select a non-running update task to start it
select a running update task to stop it
select a paused update task to resume or restart it

Starting an update task under the rights of a di erent user account
By default, the Kaspersky Endpoint Security update task is started on behalf of the user whose account you have
used to log in to the operating system. However, Kaspersky Endpoint Security may be updated from an update
source that the user cannot access due to a lack of required rights (for example, from a shared folder that
contains an update package) or an update source for which proxy server authentication is not con gured. In the
Kaspersky Endpoint Security settings, you can specify a user that has such rights and start the Kaspersky
Endpoint Security update task under that user account.

To start an update task under a di erent user account:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click

.

3. Click Run database updates as.
4. This opens a window; in this window, select Other user.
5. Enter the account credentials of a user with the necessary permissions to access the update source.
6. Save your changes.

Selecting the update task run mode
If it is not possible to run the update task for any reason (for example, the computer is not on at that time), you can
con gure the skipped task to be start automatically as soon as this becomes possible.
You can postpone starting the update task after the application starts if you select the By schedule update task
run mode, and if the start time of Kaspersky Endpoint Security matches the update task start schedule. The
update task can only be run after the speci ed time interval elapses after the startup of Kaspersky Endpoint
Security.

To select the update task run mode:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click
3. Click Databases update schedule.
4. In the opened window, select the update task run mode:
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If you want Kaspersky Endpoint Security to run the update task depending on whether or not an update
package is available from the update source, select Automatically. The frequency of checks by Kaspersky
Endpoint Security for update packages increases during virus outbreaks and is less at other times.
If you want to start an update task manually, select Manually.
If you want to con gure a schedule for running the update task, select other options. Con gure the
advanced settings for starting the update task:
In the Postpone running after application startup for N minutes eld, enter the time interval by which
you want to postpone the start of the update task after the startup of Kaspersky Endpoint Security.
Select the Run scheduled scan on the next day if computer is turned o if you want Kaspersky
Endpoint Security to run missed update tasks at the rst opportunity.
5. Save your changes.

Adding an update source
An update source is a resource that contains updates for databases and application modules of Kaspersky
Endpoint Security.
Update sources include the Kaspersky Security Center server, Kaspersky update servers, and network or local
folders.
The default list of update sources includes Kaspersky Security Center and Kaspersky update servers. You can add
other update sources to the list. You can specify HTTP/FTP servers and shared folders as update sources.
Kaspersky Endpoint Security does not support updates from HTTPS servers unless they are Kaspersky's
update servers.
If several resources are selected as update sources, Kaspersky Endpoint Security tries to connect to them one
after another, starting from the top of the list, and performs the update task by retrieving the update package
from the rst available source.

To add an update source:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click

.

3. Click the Select update sources button.
4. In the window, click the Add button.
5. In the window that opens, specify the address of the FTP or HTTP server, network folder or local folder that
contains the update package.
The following path format is used for update source:
For an FTP or HTTP server, enter its web address or IP address.
For example, http://dnl-01.geo.kaspersky.com/ or 93.191.13.103.
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For an FTP server, you can specify the authentication settings within the address in the following format:
ftp://<user name>:<password>@<node>:<port>.
For a network folder, enter the UNC path.
For example, \\ Server\Share\Update distribution.
For a local folder, enter the full path to that folder.
For example, C:\Documents and Settings\All Users\Application Data\Kaspersky
Lab\AVP11\Update distribution\.
6. Click the Select button.
7. Con gure the priorities of update sources by using the Up and Down buttons.
8. Save your changes.

Con guring updates from a shared folder
To conserve Internet tra ic, you can con gure updates of databases and application modules on computers of
the organization's LAN from a shared folder. For this purpose, one of the computers on the organization's LAN
must receive update packages from the Kaspersky Security Center Administration Server or from Kaspersky
update servers and then copy the received update package to the shared folder. Other computers on the
organization's LAN will be able to receive the update package from this shared folder.
Con guring database and application module updates from a shared folder consists of the following steps:
1. Enabling the copying of an update package to a shared folder on one of the computers on the local area
network.
2. Con gure database and application module updates from the speci ed shared folder to the remaining
computers on the organization's LAN.

To enable copying of the update package to the shared folder:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click

.

3. In the Distributing updates block, select the Copy updates to folder check box.
4. Enter the UNC path to the shared folder (for example, \\Server\Share\Update distribution).
5. Save your changes.

To con gure updates from a shared folder:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click
3. Click the Select update sources button.
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4. In the window, click the Add button.
5. In the window that opens, enter the path to the shared folder.
The source address must match the address that you previously speci ed when you con gured copying of
the update package to the shared folder (see the instructions above).
6. Click the Select button.
7. Con gure the priorities of update sources by using the Up and Down buttons.
8. Save your changes.

Updating application modules
Application module updates x errors, improve performance, and add new features. When a new application
module update becomes available, you need to con rm installation of the update. You can con rm installation of an
application module update either in the application interface or in Kaspersky Security Center. When an update
becomes available, the application will show one of the following noti cations in the main window of Kaspersky
Endpoint Security: important update ( ), or critical update ( ). If application module updates require reviewing and
accepting the terms of the End User License Agreement, the application installs updates after the terms of the
End User License Agreement have been accepted. For details about keeping track of application module updates
and con rming an update in Kaspersky Security Center, please refer to the Kaspersky Security Center Help .
After installing an application update, you may be required to restart your computer.

To con gure application module updates:
1. In the main application window, go to the Update section.
2. This opens the task list; select the update task and click

.

3. In the Downloading and installing updates of application modules block, select the Download updates of
application modules check box.
4. Select the application module updates that you want to install.
Install critical and approved updates. If this option is selected, when application module updates are
available Kaspersky Endpoint Security installs critical updates automatically and all other application module
updates only after their installation is approved locally via the application interface or on the side of
Kaspersky Security Center.
Install only approved updates. If this option is selected, when application module updates are available
Kaspersky Endpoint Security installs them only after their installation is approved locally via the application
interface or on the side of Kaspersky Security Center. This option is selected by default.
5. Save your changes.
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Using a proxy server for updates
You may be required to specify proxy server settings to download database and application module updates from
the update source. If there are multiple update sources, proxy server settings are applied for all sources. If a proxy
server is not needed for some update sources, you can disable use of a proxy server in the policy properties.
Kaspersky Endpoint Security will also use a proxy server to access Kaspersky Security Network and activation
servers.

To con gure a connection to update sources through a proxy server:
1. In the main window of Web Console, click

.

The Administration Server properties window opens.
2. Go to the Con guring Internet access section.
3. Select the Use proxy server check box.
4. Con gure the proxy server connection settings: proxy server address, port, and authentication settings (user
name and password).
5. Save your changes.

To disable use of a proxy server for a speci c administration group:
1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to disable use of a
proxy server.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to the General settings → Network settings section.
5. Under Proxy Server Settings, select Bypass proxy server for local addresses.
6. Save your changes.

To con gure the proxy server settings in the application interface:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. Under Proxy server, click Proxy Server Settings.
4. In the opened window, select one of the following options for determining the proxy server address:
Automatically detect proxy server settings.
This option is selected by default. Kaspersky Endpoint Security uses the proxy server settings that are
de ned in the operating system settings.
Use speci ed proxy server settings.
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If you selected this option, con gure the settings for connecting to the proxy server: proxy server address
and port.
5. If you want to enable authentication on the proxy server, select the Use proxy server authentication check
box and provide your user account credentials.
6. If you want to disable proxy server use when updating databases and application modules from a shared folder,
select the Bypass proxy server for local addresses check box.
7. Save your changes.
As a result, Kaspersky Endpoint Security will use the proxy server to download application module and database
updates. Kaspersky Endpoint Security will also use the proxy server to access KSN servers and Kaspersky
activation servers. If authentication is required on the proxy server but the user account credentials were not
provided or are incorrect, Kaspersky Endpoint Security will prompt you for the user name and password.

Last update rollback
After the databases and application modules are updated for the rst time, the function of rolling back the
databases and application modules to their previous versions becomes available.
Each time that a user starts the update process, Kaspersky Endpoint Security creates a backup copy of the
current databases and application modules. This lets you roll back the databases and application modules to their
previous versions when necessary. Rolling back the last update is useful, for example, when the new database
version contains an invalid signature that causes Kaspersky Endpoint Security to block a safe application.

To roll back the last update:
1. In the main application window, go to the Update section.
2. In the Rollback of databases to their previous version block, click the Roll back button.
Kaspersky Endpoint Security will start rolling back the last database update. The application will display the
rollback progress, the size of the downloaded les, and the update source. You can stop the task at any time by
clicking Stop update.

To start or stop a rollback task when the simpli ed application interface is displayed:
1. Right-click to bring up the context menu of the application icon that is in the taskbar noti cation area.
2. In the Tasks drop-down list in the context menu, do one of the following:
Select a non-running rollback task to start it.
Select a running rollback task to stop it.
Select a paused rollback task to resume or restart it.
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Working with active threats
Kaspersky Endpoint Security logs information about les that it has not processed for some reason. This
information is recorded in the form of events in the list of active threats. To work with active threats, Kaspersky
Endpoint Security uses the Advanced Disinfection technology. Advanced Disinfection works di erently for
workstations and servers. You can con gure advanced disinfection technology in Virus Scan task settings and in
application settings.

Disinfection of active threats on workstations
To work with active threats on workstations, enable the Advanced Disinfection technology in the application
settings. Next, con gure the user experience in the Virus scan task properties. There is a Run Advanced
Disinfection immediately check box in the task properties. If the ag is set, Kaspersky Endpoint Security will
perform disinfection without notifying the user. When the disinfection is complete, the computer will be rebooted.
If the ag is unset, Kaspersky Endpoint Security will display a noti cation about active threats (see the gure
below). You cannot close this noti cation without processing the le.
Advanced Disinfection during a virus scan task on a computer is performed only if the Advanced Disinfection
feature is enabled in the properties of the policy applied to this computer.

Noti cation about active threat

Disinfection of active threats on servers
To work with active threats on servers, you need to do the following:
enable the Advanced Disinfection technology in the application settings;
enable immediate Advanced Disinfection in the Virus scan task properties.
If Kaspersky Endpoint Security is installed on a computer running Windows for Servers, Kaspersky Endpoint
Security does not show the noti cation. Therefore, the user cannot select an action to disinfect an active
threat. To disinfect a threat, you need to enable Advanced Disinfection technology in application settings and
enable immediate Advanced Disinfection in Virus scan task settings. Then you need to start Virus Scan task.
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Processing of active threats
An infected le is considered processed if Kaspersky Endpoint Security performs one of the following actions on
this le according to the speci ed application settings while scanning the computer for viruses and other threats:
Disinfect.
Remove.
Delete if disinfection fails.
Kaspersky Endpoint Security moves the le to the list of active threats if, for any reason, Kaspersky Endpoint
Security failed to perform an action on this le according to the speci ed application settings while scanning the
computer for viruses and other threats.
This situation is possible in the following cases:
The scanned le is unavailable (for example, it is located on a network drive or on a removable drive without
write privileges).
The action that is selected in the Action on threat detection section for scan tasks is Inform, and the user
selects the Skip action when a noti cation about the infected le is displayed.

Main application window when a threat is detected

To process active threats:
1. In the main application window, click the Details button.
The list of active threats opens.
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2. Select the object that you want to process.
3. Choose how you want to handle the threat:
Resolve. If this option is selected, Kaspersky Endpoint Security automatically attempts to disinfect all
infected les that are detected. If disinfection fails, Kaspersky Endpoint Security deletes the les.
Ignore. If this option is selected, Kaspersky Endpoint Security deletes the entry from the list of active
threats. If there are no active threats remaining on the list, the computer status will be changed to OK. If the
object is detected again, Kaspersky Endpoint Security will add a new entry to the list of active threats.
Open containing folder. If this option is selected, Kaspersky Endpoint Security opens the folder containing
the object in the le manager. You can then manually delete the object or move the object to a folder that is
not within the protection scope.
Learn more. If this option is selected, Kaspersky Endpoint Security opens the Kaspersky Virus Encyclopedia
website .
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Computer protection

File Threat Protection
The File Threat Protection component lets you prevent infection of the le system of the computer. By default,
the File Threat Protection component permanently resides in the computer's RAM. The component scans les on
all drives of the computer, as well as on connected drives. The component provides computer protection with the
help of anti-virus databases, the Kaspersky Security Network cloud service, and heuristic analysis.
The component scans the les accessed by the user or application. If a malicious le is detected, Kaspersky
Endpoint Security blocks the le operation. The application then disinfects or deletes the malicious le, depending
on the settings of the File Threat Protection component.
When attempting to access a le whose contents are stored in the OneDrive cloud, Kaspersky Endpoint
Security downloads and scans the le contents.

Enabling and disabling File Threat Protection
By default, the File Threat Protection component is enabled and runs in the mode recommended by Kaspersky
experts. For File Threat Protection, Kaspersky Endpoint Security can apply di erent groups of settings. These
groups of settings saved in the application are called security levels: High, Recommended, Low. The
Recommended security level settings are considered to be the optimal settings recommended by Kaspersky
experts (see the table below). You can select one of the preset security levels or manually con gure security level
settings. If you change the security level settings, you can always revert back to the recommended security level
settings.

To enable or disable the File Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Use the File Threat Protection toggle to enable or disable the component.
4. If you enabled the component, do one of the following in the Security level section:
If you want to apply one of the preset security levels, select it with the slider:
High. When this le security level is selected, the File Threat Protection component takes the strictest
control of all les that are opened, saved, and started. The File Threat Protection component scans all
le types on all hard drives, removable drives, and network drives of the computer. It also scans archives,
installation packages, and embedded OLE objects.
Recommended. This le security level is recommended by Kaspersky Lab experts. The File Threat
Protection component scans only the speci ed le formats on all hard drives, removable drives, and
network drives of the computer, and embedded OLE objects. The File Threat Protection component
does not scan archives or installation packages. The values of settings for the recommended security
level are provided in the table below.
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Low. The settings of this le security level ensure maximum scanning speed. The File Threat Protection
component scans only les with speci ed extensions on all hard drives, removable drives, and network
drives of the computer. The File Threat Protection component does not scan compound les.
If you want to con gure a custom security level, click the Advanced settings button and de ne your own
component settings.
You can restore the values of preset security levels by clicking the Restore recommended security level
button in the upper part of the window.
5. Save your changes.
File Threat Protection settings recommended by Kaspersky experts (recommended security level)

Parameter

Value

Description

File types

Files
scanned by
format

If this setting is enabled, Kaspersky Endpoint Security scans infectable les
only . Before scanning a le for malicious code, the internal header of the
le is analyzed to determine the format of the le (for example, .txt, .doc, or
.exe). The scan also looks for les with particular le extensions.

Heuristic
Analysis

Light scan

The technology was developed for detecting threats that cannot be
detected by using the current version of Kaspersky application databases.
It detects les that may be infected with an unknown virus or a new variety
of a known virus.
When scanning les for malicious code, the heuristic analyzer executes
instructions in the executable les. The number of instructions that are
executed by the heuristic analyzer depends on the level that is speci ed for
the heuristic analyzer. The heuristic analysis level ensures a balance
between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.

Scan only
new and
changed
les

Enabled

Scans only new les and those les that have been modi ed since the last
time they were scanned. This helps reduce the duration of a scan. This
mode applies both to simple and to compound les.

iSwift
Technology

Enabled

This technology allows increasing scan speed by excluding certain les
from scanning. Files are excluded from scanning by using a special algorithm
that takes into account the release date of Kaspersky Endpoint Security
databases, the date that the le was last scanned on, and any
modi cations to the scanning settings. The iSwift technology is an
advancement of the iChecker technology for the NTFS le system.

iChecker
Technology

Enabled

This technology allows increasing scan speed by excluding certain les
from scanning. Files are excluded from scans by using a special algorithm
that takes into account the release date of Kaspersky Endpoint Security
databases, the date when the le was last scanned, and any modi cations
to the scan settings. There are limitations to iChecker Technology: it does
not work with large les and applies only to les with a structure that the
application recognizes (for example, EXE, DLL, LNK, TTF, INF, SYS, COM,
CHM, ZIP, and RAR).

Scan les
in
Microsoft
O ice
formats

Enabled

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft
extensions). O ice format les include OLE objects as well.

Scan mode

Smart
mode

In this mode, File Threat Protection scans an object based on an analysis of
actions taken on the object. For example, when working with a Microsoft
O ice document, Kaspersky Endpoint Security scans the le when it is rst
161

opened and last closed. Intermediate operations that overwrite the le do
not cause it to be scanned.
Action on
threat
detection

Disinfect;
delete if
disinfection
fails

If this option is selected, Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection
fails, Kaspersky Endpoint Security deletes the les.

Automatic pausing of File Threat Protection
You can con gure File Threat Protection to automatically pause at a speci ed time or when working with speci c
applications.
File Threat Protection should be paused only as a last resort when it con icts with some applications. If any
con icts arise while a component is running, you are advised to contact Kaspersky Technical Support . The
support experts will help you set up the File Threat Protection component to run simultaneously with other
applications on your computer.

To con gure automatic pausing of File Threat Protection:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the Pause File Threat Protection block, click the Pause File Threat Protection link.
5. In the opened window, con gure the settings for pausing File Threat Protection:
a. Con gure a schedule for automatically pausing File Threat Protection.
b. Create a list of applications whose operation should cause File Threat Protection to pause its activities.
6. Save your changes.

Changing the action taken on infected les by the File Threat Protection
component
By default, the File Threat Protection component automatically tries to disinfect all infected les that are
detected. If disinfection fails, the File Threat Protection component deletes these les.

To change the action taken on infected les by the File Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
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3. In the Action on threat detection section, select the required option:
Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection fails, Kaspersky Endpoint Security
deletes the les.
Disinfect; block if disinfection fails. If this option is selected, Kaspersky Endpoint Security automatically
attempts to disinfect all infected les that are detected. If disinfection is not possible, Kaspersky Endpoint
Security adds the information about the infected les that are detected to the list of active threats.
Block. If this option is selected, the File Threat Protection component automatically blocks all infected les
without attempting to disinfect them.
Before attempting to disinfect or delete an infected le, Kaspersky Endpoint Security creates a backup
copy of the le in case you need to restore the le or if it can be disinfected in the future.
4. Save your changes.

Forming the protection scope of the File Threat Protection component
The protection scope refers to the objects that the component scans when enabled. The protection scopes of
di erent components have di erent properties. The location and type of les to be scanned are properties of the
protection scope of the File Threat Protection component. By default, the File Threat Protection component
scans only potentially infectable les that are run from hard drives, removable drives and network drives.
When selecting the type of les to scan, consider the following:
1. There is a low probability of introducing malicious code into les of certain formats and its subsequent
activation (for example, TXT format). At the same time, there are le formats that contain executable code
(such as .exe, .dll). The executable code may also be contained in les of formats that are not intended for this
purpose (for example, the DOC format). The risk of intrusion and activation of malicious code in such les is
high.
2. An intruder may send a virus or another malicious application to your computer in an executable le that has
been renamed with the .txt extension. If you select scanning of les by extension, the application skips this le
during scanning. If scanning of les by format is selected, Kaspersky Endpoint Security analyzes the le header
regardless of its extension. If this analysis reveals that the le has the format of an executable le (for example,
EXE), the application scans it.

To create the protection scope:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the File types section, specify the type of les that you want the File Threat Protection component to scan:
All les. If this setting is enabled, Kaspersky Endpoint Security checks all les without exception (all formats
and extensions).
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Files scanned by format. If this setting is enabled, Kaspersky Endpoint Security scans infectable les only .
Before scanning a le for malicious code, the internal header of the le is analyzed to determine the format
of the le (for example, .txt, .doc, or .exe). The scan also looks for les with particular le extensions.
Files scanned by extension. If this setting is enabled, Kaspersky Endpoint Security scans infectable les
only . The le format is then determined based on the le's extension.
5. Click the Edit protection scope link.
6. In the opened window, select the objects that you want to add to the protection scope or exclude from it.
You cannot remove or edit objects that are included in the default protection scope.
7. If you want to add a new object to the protection scope:
a. Click the Add button.
The folder tree opens.
b. Select the object and click Select.
You can exclude an object from scans without deleting it from the list of objects in the scan scope. To do so,
clear the check box next to the object.
8. Save your changes.

Using scan methods
Kaspersky Endpoint Security uses a scanning technique called Machine learning and signature analysis. During
signature analysis, Kaspersky Endpoint Security matches the detected object with records in its database. Based
on the recommendations of Kaspersky experts, machine learning and signature analysis is always enabled.
To increase the e ectiveness of protection, you can use heuristic analysis. When scanning les for malicious code,
the heuristic analyzer executes instructions in the executable les. The number of instructions that are executed
by the heuristic analyzer depends on the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats, the load on the resources of the
operating system, and the duration of heuristic analysis.

To con gure the use of heuristic analysis in the operation of the File Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. If you want the application to use heuristic analysis for protection against le threats, select the Heuristic
analysis check box in the Scan methods block. Then use the slider to set the heuristic analysis level: Light
scan, Medium scan, or Deep scan.
5. Save your changes.
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Using scan technologies in the operation of the File Threat Protection
component
To con gure the use of scan technologies in the operation of the File Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the Scan technologies block, select the check boxes next to the names of technologies that you want to use
for le threat protection:
iSwift technology. This technology allows increasing scan speed by excluding certain les from scanning.
Files are excluded from scanning by using a special algorithm that takes into account the release date of
Kaspersky Endpoint Security databases, the date that the le was last scanned on, and any modi cations to
the scanning settings. The iSwift technology is an advancement of the iChecker technology for the NTFS
le system.
iChecker technology. This technology allows increasing scan speed by excluding certain les from scanning.
Files are excluded from scans by using a special algorithm that takes into account the release date of
Kaspersky Endpoint Security databases, the date when the le was last scanned, and any modi cations to
the scan settings. There are limitations to iChecker Technology: it does not work with large les and applies
only to les with a structure that the application recognizes (for example, EXE, DLL, LNK, TTF, INF, SYS,
COM, CHM, ZIP, and RAR).
5. Save your changes.

Optimizing le scanning
You can optimize the le scanning that is performed by the File Threat Protection component by reducing the scan
time and increasing the operating speed of Kaspersky Endpoint Security. This can be achieved by scanning only
new les and those les that have been modi ed since the previous scan. This mode applies both to simple and to
compound les.
You can also enable the use of the iChecker and iSwift technologies that optimize the speed of le scanning by
excluding les that have not been modi ed since the most recent scan.

To optimize le scanning:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the Scan optimization section, select the Scan only new and changed les check box.
5. Save your changes.
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Scanning compound les
A common technique of concealing viruses and other malware is to implant them in compound les, such as
archives or databases. To detect viruses and other malware that are hidden in this way, the compound le must be
unpacked, which may slow down scanning. You can limit the types of compound les to be scanned and thereby
speed up scanning.
The method used to process an infected compound le (disinfection or deletion) depends on the type of le.

The File Threat Protection component disinfects compound les in the RAR, ARJ, ZIP, CAB, and LHA formats
and deletes les in all other formats (except mail databases).

To con gure scanning of compound les:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the Scan of compound les section, specify the types of compound les that you want to scan: archives,
installation packages, or les in o ice formats.
5. If scanning only new and modi ed les is disabled, con gure the settings for scanning each type of compound
le: scan all les of this type or only new les.
If scanning only new and modi ed les is enabled, Kaspersky Endpoint Security scans only new and modi ed
les of all types of compound les.
6. Con gure the advanced settings for scanning compound les.
Do not unpack large compound les.
If this check box is selected, Kaspersky Endpoint Security does not scan compound les if their size
exceeds the speci ed value.
If this check box is cleared, Kaspersky Endpoint Security scans compound les of all sizes.
Kaspersky Endpoint Security scans large les that are extracted from archives, regardless of whether
the Do not unpack large compound les check box is selected.
Unpack compound les in the background.
If the check box is selected, Kaspersky Endpoint Security provides access to compound les that are larger
than the speci ed value before these les are scanned. In this case, Kaspersky Endpoint Security unpacks
and scans compound les in the background.
Kaspersky Endpoint Security provides access to compound les that are smaller than this value only after
unpacking and scanning these les.
If the check box is not selected, Kaspersky Endpoint Security provides access to compound les only after
unpacking and scanning les of any size.
7. Save your changes.
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Changing the scan mode
Scan mode refers to the condition that triggers le scanning by the File Threat Protection component. By default,
Kaspersky Endpoint Security scans les in smart mode. In this le scan mode, the File Threat Protection
component decides whether or not to scan les after analyzing operations that are performed with the le by the
user, by an application on behalf of the user (under the account that was used to log in or a di erent user
account), or by the operating system. For example, when working with a Microsoft O ice Word document,
Kaspersky Endpoint Security scans the le when it is rst opened and last closed. Intermediate operations that
overwrite the le do not cause it to be scanned.
To change the le scan mode:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → File Threat Protection.
3. Click the Advanced settings button.
4. In the Scan mode section, select the required mode:
Smart mode. In this mode, File Threat Protection scans an object based on an analysis of actions taken on
the object. For example, when working with a Microsoft O ice document, Kaspersky Endpoint Security
scans the le when it is rst opened and last closed. Intermediate operations that overwrite the le do not
cause it to be scanned.
On access and modi cation. In this mode, File Threat Protection scans objects whenever there is an
attempt to open or modify them.
On access. In this mode, File Threat Protection scans objects only upon an attempt to open them.
On execution. In this mode, File Threat Protection only scans objects upon an attempt to run them.
5. Save your changes.

Web Threat Protection
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
The Web Threat Protection component prevents downloads of malicious les from the Internet, and also blocks
malicious and phishing websites. The component provides computer protection with the help of anti-virus
databases, the Kaspersky Security Network cloud service, and heuristic analysis.
Kaspersky Endpoint Security scans HTTP-, HTTPS- and FTP-tra ic. Kaspersky Endpoint Security scans URLs and
IP addresses. You can specify the ports that Kaspersky Endpoint Security will monitor, or select all ports.
For HTTPS tra ic monitoring, you need to enable encrypted connections scan.
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When a user tries to open a malicious or phishing website, Kaspersky Endpoint Security will block access and show
a warning (see the gure below).

Website access denied message

Enabling and disabling Web Threat Protection
By default, the Web Threat Protection component is enabled and runs in the mode recommended by Kaspersky
experts. For Web Threat Protection, Kaspersky Endpoint Security can apply di erent groups of settings. These
groups of settings saved in the application are called security levels: High, Recommended, Low. The
Recommended web tra ic security level settings are considered to be the optimal settings recommended by
Kaspersky experts (see the table below). You can select one of the pre-installed security levels for web tra ic that
is received or transmitted via the HTTP and FTP protocols, or con gure a custom web tra ic security level. If you
change the web tra ic security level settings, you can always revert to the recommended web tra ic security level
settings.

To enable or disable the Web Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Web Threat Protection.
3. Use the Web Threat Protection toggle to enable or disable the component.
4. If you enabled the component, do one of the following in the Security level section:
If you want to apply one of the preset security levels, select it with the slider:
High. The security level under which the Web Threat Protection component performs maximum scanning
of web tra ic that the computer receives over the HTTP and FTP protocols. Web Threat Protection
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performs detailed scanning of all web tra ic objects by using the full set of application databases,
and performs the deepest possible heuristic analysis .
Recommended. The security level that provides the optimal balance between the performance of
Kaspersky Endpoint Security and the security of web tra ic. The Web Threat Protection
component performs heuristic analysis at the medium scan level. This web tra ic security level is
recommended by Kaspersky specialists. The values of settings for the recommended security level are
provided in the table below.
Low. The settings of this web tra ic security level ensure the maximum web tra ic scanning speed. The
Web Threat Protection component performs heuristic analysis at the light scan level.
If you want to con gure a custom security level, click the Advanced settings button and de ne your own
component settings.
You can restore the values of preset security levels by clicking the Restore recommended security level
button in the upper part of the window.
5. Save your changes.
Web Threat Protection settings recommended by Kaspersky experts (recommended security level)

Parameter

Value

Description

Check the
web
address
against
the
database
of
malicious
web
addresses

Enabled

Scanning the links to determine whether they are included in the database of
malicious web addresses allows you to track websites that have been added
to denylist. The database of malicious web addresses is maintained by
Kaspersky, included in the application installation package, and updated during
Kaspersky Endpoint Security database updates.

Check the
web
address
against
the
database
of
phishing
web
addresses

Enabled

The database of phishing web addresses includes the web addresses of
currently known websites that are used to launch phishing attacks. Kaspersky
supplements this database of phishing links with addresses obtained from the
international organization known as the Anti-Phishing Working Group.
The database of phishing addresses is included in the application installation
package and supplemented with Kaspersky Endpoint Security database
updates.

Use
heuristic
analysis
(Web
Threat
Protection)

Medium
scan

The technology was developed for detecting threats that cannot be detected
by using the current version of Kaspersky application databases. It detects
les that may be infected with an unknown virus or a new variety of a known
virus.

Use
heuristic
analysis

Enabled

When web tra ic is scanned for viruses and other applications that present a
threat, the heuristic analyzer performs instructions in the executable les. The
number of instructions that are executed by the heuristic analyzer depends on
the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats,
the load on the resources of the operating system, and the duration of
heuristic analysis.
The technology was developed for detecting threats that cannot be detected
by using the current version of Kaspersky application databases. It detects
les that may be infected with an unknown virus or a new variety of a known
virus.
169

(AntiPhishing)
Action on
threat
detection

Block
download

If this option is selected and an infected object is detected in web tra ic, the
Web Threat Protection component blocks access to the object and displays a
message in the browser.

Changing the action to take on malicious web tra ic objects
By default, on detection of an infected object in web tra ic, the Web Threat Protection component blocks access
to the object and displays a noti cation about the action.

To change the action to take on malicious web tra ic objects:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Web Threat Protection.
3. In the Action on threat detection section, select the action that Kaspersky Endpoint Security performs on
malicious web tra ic objects:
Block download. If this option is selected and an infected object is detected in web tra ic, the Web Threat
Protection component blocks access to the object and displays a message in the browser.
Inform. If this option is selected and an infected object is detected in web tra ic, Kaspersky Endpoint
Security allows this object to be downloaded to the computer but adds information about the infected
object to the list of active threats.
4. Save your changes.

Scanning URLs against databases of phishing and malicious web addresses
Scanning links to see if they are included in the list of phishing web addresses allows avoiding phishing attacks. A
phishing attack can be disguised, for example, as an email message supposedly from your bank with a link to the
o icial website of the bank. By clicking the link, you go to an exact copy of the bank's website and can even see its
real web address in the browser, even though you are on a counterfeit site. From this point forward, all of your
actions on the site are tracked and can be used to steal your money.
Because links to phishing websites may be received not only in an email message but also from other sources such
as ICQ messages, the Web Threat Protection component monitors attempts to access a phishing website at the
web tra ic scan level and blocks access to such websites. Lists of phishing URLs are included with the Kaspersky
Endpoint Security distribution kit.

To con gure the Web Threat Protection component to check links against the databases of phishing and malicious
web addresses:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Web Threat Protection.
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3. Click the Advanced settings button.
4. Do the following:
If you want the Web Threat Protection component to check links against the databases of malicious web
addresses, in the Scan methods section, select the Check the web address against the database of
malicious web addresses check box. Scanning the links to determine whether they are included in the
database of malicious web addresses allows you to track websites that have been added to denylist. The
database of malicious web addresses is maintained by Kaspersky, included in the application installation
package, and updated during Kaspersky Endpoint Security database updates.
Kaspersky Endpoint scans all links to determine if they are listed in databases of malicious web
addresses. The application's secure connection scan settings do not a ect the link scanning
functionality. In other words, if encrypted connections scan is disabled, Kaspersky Endpoint Security
checks links against databases of malicious web addresses even if network tra ic is transmitted over
an encrypted connection.
If you want the Web Threat Protection component to check links against the databases of phishing web
addresses, select the Check the web address against the database of phishing web addresses check box
in the Anti-Phishing block. The database of phishing web addresses includes the web addresses of
currently known websites that are used to launch phishing attacks. Kaspersky supplements this database of
phishing links with addresses obtained from the international organization known as the Anti-Phishing
Working Group. The database of phishing addresses is included in the application installation package
and supplemented with Kaspersky Endpoint Security database updates.
You can also check links against the reputation databases of Kaspersky Security Network.
5. Save your changes.

Using heuristic analysis in the operation of the Web Threat Protection
component
To increase the e ectiveness of protection, you can use heuristic analysis. During heuristic analysis, Kaspersky
Endpoint Security analyzes the activity of applications in the operating system. Heuristic analysis can detect
threats for which there are currently no records in the Kaspersky Endpoint Security databases.

To con gure the use of heuristic analysis:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Web Threat Protection.
3. Click the Advanced settings button.
4. In the Scan methods block, select the Use heuristic analysis check box if you want the application to use
heuristic analysis when scanning web tra ic for viruses and other malware. Then use the slider to set the
heuristic analysis level: Light scan, Medium scan, or Deep scan.
5. In the Anti-Phishing block, select the Use heuristic analysis check box if you want the application to use
heuristic analysis when scanning web pages for phishing links.
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6. Save your changes.

Creating the list of trusted web addresses
You can create a list of URLs whose content you trust. The Web Threat Protection component does not analyze
information from trusted web addresses to check them for viruses or other threats. This option may be useful, for
example, if the Web Threat Protection component interferes with the downloading of a le from a known website.
A URL may be the address of a speci c web page or the address of a website.

To create a list of trusted web addresses:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Web Threat Protection.
3. Click the Advanced settings button.
4. Select the Do not scan web tra ic from trusted web addresses check box.
If the check box is selected, the Web Threat Protection component does not scan the content of web pages or
websites whose addresses are included in the list of trusted web addresses. You can add both the speci c
address and the address mask of a web page/website to the list of trusted web addresses.
5. Create a list of URLs / web pages whose content you trust.
6. Save your changes.

Exporting and importing the list of trusted web addresses
You can export the list of trusted web addresses to an XML le. Then you can modify the le to, for example, add a
large number of web addresses of the same type. You can also use the export/import function to back up the list
of trusted web addresses or to migrate the list to a di erent server.
How to export and import a list of trusted web addresses in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Web Threat Protection.
6. Click the Settings button.
7. In the opened window, select the Trusted web addresses tab.
8. To export the list of trusted web addresses:
a. Select the trusted web addresses that you want to export. To select multiple ports, use the CTRL or
SHIFT keys.
If you did not select any trusted web address, Kaspersky Endpoint Security will export all web
addresses.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
trusted web addresses, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of trusted web addresses to the XML le.
9. To import the list of trusted addresses:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of trusted
addresses.
b. Click the Open button.
If the computer already has a list of trusted addresses, Kaspersky Endpoint Security will prompt you to
delete the existing list or add new entries to it from the XML le.
10. Save your changes.
How to export and import a list of trusted web addresses in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of trusted web addresses.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Web Threat Protection.
5. To export the list of exclusions in the Trusted web addresses block:
a. Select the trusted web addresses that you want to export.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
trusted web addresses, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of trusted web addresses to the XML le.
6. To import a list of exclusions in the Trusted web addresses block:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of trusted
addresses.
b. Click the Open button.
If the computer already has a list of trusted addresses, Kaspersky Endpoint Security will prompt you to
delete the existing list or add new entries to it from the XML le.
7. Save your changes.

Mail Threat Protection
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
The Mail Threat Protection component scans the attachments of incoming and outgoing email messages for
viruses and other threats. The component also scans messages for malicious and phishing links. By default, the Mail
Threat Protection component permanently resides in the computer's RAM and scans all messages received or
sent using the POP3, SMTP, IMAP, or NNTP protocols, or the Microsoft O ice Outlook mail client (MAPI). The
component provides computer protection with the help of anti-virus databases, the Kaspersky Security Network
cloud service, and heuristic analysis.
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The Mail Threat Protection component does not scan messages if the mail client is open in a browser.
When a malicious le is detected in an attachment, Kaspersky Endpoint Security renames the message subject as
follows: [Message is infected] <message subject> or [Infected object deleted] <message
subject>.
This component interacts with mail clients installed on the computer. For the Microsoft O ice Outlook mail client,
an extension with additional parameters is provided. The Mail Threat Protection extension is embedded in the
Microsoft O ice Outlook mail client during installation of Kaspersky Endpoint Security.

Enabling and disabling Mail Threat Protection
By default, the Mail Threat Protection component is enabled and runs in the mode recommended by Kaspersky
experts. For Mail Threat Protection, Kaspersky Endpoint Security applies di erent groups of settings. These
groups of settings saved in the application are called security levels: High, Recommended, Low. The
Recommended mail security level settings are considered to be the optimal settings recommended by Kaspersky
experts (see the table below). You can select one of the pre-installed email security levels or con gure a custom
email security level. If you have changed the email security level settings, you can always revert to the
recommended email security level settings.

To enable or disable the Mail Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Mail Threat Protection.
3. Use the Mail Threat Protection toggle to enable or disable the component.
4. If you enabled the component, do one of the following in the Security level section:
If you want to apply one of the preset security levels, select it with the slider:
High. When this email security level is selected, the Mail Threat Protection component scans email
messages most thoroughly. The Mail Threat Protection component scans incoming and outgoing email
messages, and performs deep heuristic analysis. The High mail security level is recommended for highrisk environments. An example of such an environment is a connection to a free email service from a
home network that is not guarded by centralized email protection.
Recommended. The email security level that provides the optimal balance between the performance of
Kaspersky Endpoint Security and email security. The Mail Threat Protection component scans incoming
and outgoing email messages, and performs medium-level heuristic analysis. This mail tra ic security
level is recommended by Kaspersky specialists. The values of settings for the recommended security
level are provided in the table below.
Low. When this email security level is selected, the Mail Threat Protection component only scans
incoming email messages, performs light heuristic analysis, and does not scan archives that are attached
to email messages. At this mail security level, the Mail Threat Protection component scans email
messages at maximum speed and uses a minimum of operating system resources. The Low mail security
level is recommended for use in a well-protected environment. An example of such an environment might
be an enterprise LAN with centralized email security.
If you want to con gure a custom security level, click the Advanced settings button and de ne your own
component settings.
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You can restore the values of preset security levels by clicking the Restore recommended security level
button in the upper part of the window.
5. Save your changes.
Mail Threat Protection settings recommended by Kaspersky experts (recommended security level)

Parameter

Value

Description

Incoming
and
outgoing
messages

The Protection scope includes objects that the component checks when
it is run: Incoming and outgoing messages or Incoming messages only.

Connect
Microsoft
Outlook
extension

Enabled

If the check box is selected, scanning of email messages transmitted via
the POP3, SMTP, NNTP, IMAP protocols is enabled on the side of the
extension integrated into Microsoft Outlook.

Scan
attached
archives

Enabled

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and
ICE.

Scan
attached
les of
O ice
formats

Enabled

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft
extensions). O ice format les include OLE objects as well.

Attachment
lter

Rename
attachments
of selected
types

If this option is selected, the Mail Threat Protection component will
replace the last extension character found in the attached les of the
speci ed types with the underscore character (for example,
attachment.doc_). Thus, in order to open the le, the user must rename
the le.

Heuristic
Analysis

Medium
scan

The technology was developed for detecting threats that cannot be
detected by using the current version of Kaspersky application
databases. It detects les that may be infected with an unknown virus or
a new variety of a known virus.

Protection
scope

In order to protect your computers, you need only scan incoming
messages. You can turn on scanning for outgoing messages to prevent
infected les from being sent in archives. You can also turn on the
scanning of outgoing messages if you want to prevent les in particular
formats from being sent, such as audio and video les, for example.

If mail is scanned using the extension for Microsoft Outlook, it is
recommended to use Cached Exchange Mode. For more detailed
information about Cached Exchange Mode and recommendations on its
use, refer to the Microsoft Knowledge Base.

When scanning les for malicious code, the heuristic analyzer executes
instructions in the executable les. The number of instructions that are
executed by the heuristic analyzer depends on the level that is speci ed
for the heuristic analyzer. The heuristic analysis level ensures a balance
between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.
Action on
threat
detection

Disinfect;
delete if
disinfection
fails

When an infected object is detected in an inbound or outbound message,
Kaspersky Endpoint Security attempts to disinfect the detected object.
The user will be able to access the message with a safe attachment. If
the object cannot be disinfected, Kaspersky Endpoint Security deletes
the infected object. Kaspersky Endpoint Security adds information about
the performed action to the message subject: [Infected object was
deleted] <message subject>.
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Changing the action to take on infected email messages
By default, the Mail Threat Protection component automatically attempts to disinfect all infected email messages
that are detected. If disinfection fails, the Mail Threat Protection component deletes the infected email messages.

To change the action to take on infected email messages:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Mail Threat Protection.
3. In the Action on threat detection section, select the action for Kaspersky Endpoint Security to perform when
an infected message is detected:
Disinfect; delete if disinfection fails. When an infected object is detected in an inbound or outbound
message, Kaspersky Endpoint Security attempts to disinfect the detected object. The user will be able to
access the message with a safe attachment. If the object cannot be disinfected, Kaspersky Endpoint
Security deletes the infected object. Kaspersky Endpoint Security adds information about the performed
action to the message subject: [Infected object was deleted] <message subject>.
Disinfect; block if disinfection fails. When an infected object is detected in an inbound message,
Kaspersky Endpoint Security attempts to disinfect the detected object. The user will be able to access the
message with a safe attachment. If the object cannot be disinfected, Kaspersky Endpoint Security adds a
warning to the message subject: [Message infected] <message subject>. The user will be able to
access the message with the original attachment. When an infected object is detected in an outbound
message, Kaspersky Endpoint Security attempts to disinfect the detected object. If the object cannot be
disinfected, Kaspersky Endpoint Security blocks transmission of the message, and the mail client shows an
error.
Block. If an infected object is detected in an inbound message, Kaspersky Endpoint Security adds a warning
to the message subject: [Message infected] <message subject>. The user will be able to access the
message with the original attachment. If an infected object is detected in an outbound message, Kaspersky
Endpoint Security blocks transmission of the message, and the mail client shows an error.
4. Save your changes.

Forming the protection scope of the Mail Threat Protection component
Protection scope refers to the objects that are scanned by the component when it is active. The protection
scopes of di erent components have di erent properties. The properties of the protection scope of the Mail
Threat Protection component include the settings for integrating the Mail Threat Protection component into mail
clients, and the type of email messages and email protocols whose tra ic is scanned by the Mail Threat Protection
component. By default, Kaspersky Endpoint Security scans both incoming and outgoing email messages and
tra ic of the POP3, SMTP, NNTP, and IMAP protocols, and is integrated into the Microsoft O ice Outlook mail
client.
To form the protection scope of the Mail Threat Protection component:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Mail Threat Protection.
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3. Click the Advanced settings button.
4. In the Protection scope block, select the messages to scan:
Incoming and outgoing messages.
Incoming only.
In order to protect your computers, you need only scan incoming messages. You can turn on scanning for
outgoing messages to prevent infected les from being sent in archives. You can also turn on the scanning of
outgoing messages if you want to prevent les in particular formats from being sent, such as audio and video
les, for example.
If you choose to scan only incoming messages, it is recommended that you perform a one-time scan of all
outgoing messages because there is a chance that your computer has email worms that are being spread
over email. This helps to avoid problems resulting from unmonitored mass emailing of infected messages
from your computer.
5. In the Connectivity section, do the following:
If you want the Mail Threat Protection component to scan messages that are transmitted via the POP3,
SMTP, NNTP, and IMAP protocols before they are received on the user's computer, select the Scan POP3,
SMTP, NNTP, and IMAP tra ic check box.
If you do not want the Mail Threat Protection component to scan messages that are transmitted via the
POP3, SMTP, NNTP, and IMAP protocols before they arrive on the user's computer, clear the Scan POP3,
SMTP, NNTP, and IMAP tra ic check box. In this case, messages are scanned by the Mail Threat Protection
extension embedded in the Microsoft O ice Outlook mail client after they are received on the user
computer if the Connect Microsoft Outlook extension check box is selected.
If you use a mail client other than Microsoft O ice Outlook, the Mail Threat Protection component
does not scan messages that are transmitted via the POP3, SMTP, NNTP, and IMAP protocols, when the
Scan POP3, SMTP, NNTP, and IMAP tra ic check box is cleared.
If you want to allow access to Mail Threat Protection component settings from Microsoft O ice Outlook
and enable scanning of messages that are transmitted via the POP3, SMTP, NNTP, IMAP, and MAPI protocols
after they arrive on the computer using the extension that is embedded into Microsoft O ice Outlook,
select the Connect Microsoft Outlook extension check box.
If you want to block access to Mail Threat Protection component settings from Microsoft O ice Outlook
and disable scanning of messages that are transmitted via the POP3, SMTP, NNTP, IMAP, and MAPI
protocols after they arrive on the computer using the extension that is embedded into Microsoft O ice
Outlook, clear the Connect Microsoft Outlook extension check box.
The Mail Threat Protection extension is embedded in the Microsoft O ice Outlook mail client during
installation of Kaspersky Endpoint Security.
6. Save your changes.

Scanning compound les attached to email messages
178

You can enable or disable scanning of message attachments, limit the maximum size of message attachments to
be scanned, and limit the maximum message attachment scan duration.

To con gure scanning of compound les attached to email messages:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Mail Threat Protection.
3. Click the Advanced settings button.
4. In the Scan of compound les section, con gure the scan settings:
Scan attached les of O ice formats. Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other
Microsoft extensions). O ice format les include OLE objects as well.
Scan attached archives. Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE.
If during the scan, Kaspersky Endpoint Security detects a password for an archive in the text of the
message, this password will be used to scan the content of the archive for malicious applications. In this
case, the password is not saved. An archive is unpacked during scan. If an application error occurs
during the unpacking process, you can manually delete the unpacked les that are saved to the
following path: %systemroot%\temp. The les have the PR pre x.
Do not scan archives larger than N MB. If this check box is selected, the Mail Threat Protection component
excludes archives attached to email messages from scanning if their size exceeds the speci ed value. If the
check box is cleared, the Mail Threat Protection component scans email attachment archives of any size.
Limit the time for checking archives to N sec. If the check box is selected, the time that is allocated for
scanning archives attached to email messages is limited to the speci ed period.
5. Save your changes.

Email messages attachment ltering
The attachment ltering functionality is not applied to outgoing email messages.
Malicious applications can be distributed in the form of attachments in email messages. You can con gure ltering
based on the type of message attachments so that les of the speci ed types are automatically renamed or
deleted. By renaming an attachment of a certain type, Kaspersky Endpoint Security can protect your computer
against automatic execution of a malicious application.

To con gure ltering of attachments:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Mail Threat Protection.
3. Click the Advanced settings button.
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4. In the Attachment lter section, do one of the following:
Disable ltering. If this option is selected, the Mail Threat Protection component does not lter les that
are attached to email messages.
Rename attachments of selected types. If this option is selected, the Mail Threat Protection component
will replace the last extension character found in the attached les of the speci ed types with the
underscore character (for example, attachment.doc_). Thus, in order to open the le, the user must rename
the le.
Delete attachments of selected types. If this option is selected, the Mail Threat Protection component
deletes attached les of the speci ed types from email messages.
5. If you selected the Rename attachments of selected types option or the Delete attachments of selected
types option during the previous step, select the check boxes opposite the relevant types of les.
6. Save your changes.

Exporting and importing extensions for attachment ltering
You can export the list of attachment lter extensions to an XML le. You can use the export/import function to
back up the list of extensions or to migrate the list to a di erent server.
How to export and import a list of attachment lter extensions in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Mail Threat Protection.
6. In the Security level section, click the Settings button.
7. In the opened window, select the Attachment lter tab.
8. To export the list of extensions:
a. Select the extensions that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
extensions, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of extensions to the XML le.
9. To import the list of extensions:
a. Click the Import link.
b. In the window that opens, select the XML le from which you want to import the list of extensions.
c. Click the Open button.
If the computer already has a list of extensions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
10. Save your changes.
How to export and import a list of attachment lter extensions in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of exclusions.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Mail Threat Protection.
5. To export the list of extensions in the Attachment lter block:
a. Select the extensions that you want to export.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
extensions, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of extensions to the XML le.
6. To import a list of extensions in the Attachment lter block:
a. Click the Import link.
b. In the window that opens, select the XML le from which you want to import the list of extensions.
c. Click the Open button.
If the computer already has a list of extensions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
7. Save your changes.

Scanning emails in Microsoft O ice Outlook
During installation of Kaspersky Endpoint Security, the Mail Threat Protection extension is embedded into
Microsoft O ice Outlook (hereinafter also referred to as Outlook). It allows you to open the Mail Threat Protection
component settings from within Outlook, and to specify when email messages are to be scanned for viruses and
other threats. The Mail Threat Protection extension for Outlook can scan incoming and outgoing messages that
are transmitted via the POP3, SMTP, NNTP, IMAP, and MAPI protocols. Kaspersky Endpoint Security also supports
working with other email clients (including Microsoft Outlook Express®, Windows Mail, and Mozilla™ Thunderbird™).
The Mail Threat Protection extension supports operations with Outlook 2010, 2013, 2016, and 2019.
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When working with the Mozilla Thunderbird mail client, the Mail Threat Protection component does not scan
messages that are transmitted via the IMAP protocol for viruses and other threats if lters are used to move
messages from the Inbox folder.
In Outlook, incoming messages are rst scanned by the Mail Threat Protection component (if the Scan POP3,
SMTP, NNTP, and IMAP tra ic check box is selected in the interface of Kaspersky Endpoint Security) and then by
the Mail Threat Protection extension for Outlook. If the Mail Threat Protection component detects a malicious
object in a message, it noti es you about this event.
The Mail Threat Protection component settings can be con gured directly in Outlook if the Microsoft Outlook
extension is connected in the Kaspersky Endpoint Security interface.
Outgoing messages are rst scanned by the Mail Threat Protection extension for Outlook, and are then scanned
by the Mail Threat Protection component.
If mail is scanned using the Mail Threat Protection extension for Outlook, it is recommended to use Cached
Exchange Mode. For more detailed information about Cached Exchange Mode and recommendations on its
use, refer to the Microsoft Knowledge Base .

To con gure the operating mode of the Mail Threat Protection extension for Outlook using Kaspersky Security
Center:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Mail Threat Protection.
6. In the Security level section, click the Settings button.
7. In the Connectivity section, click Settings.
8. In the Email protection window:
Select the Scan when receiving check box if you want the Mail Threat Protection extension for Outlook to
scan incoming messages as they arrive to the mailbox.
Select the Scan when reading check box if you want the Mail Threat Protection extension for Outlook to
scan incoming messages when the user opens them.
Select the Scan when sending check box if you want the Mail Threat Protection extension for Outlook to
scan outgoing messages as they are sent.
9. Save your changes.

Network Threat Protection
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The Network Threat Protection component scans inbound network tra ic for activity that is typical of network
attacks. When Kaspersky Endpoint Security detects an attempted network attack on the user's computer, it
blocks the network connection with the attacking computer. Descriptions of currently known types of network
attacks and ways to counteract them are provided in Kaspersky Endpoint Security databases. The list of network
attacks that the Network Threat Protection component detects is updated during database and application
module updates.

Enabling and disabling Network Threat Protection
By default, Network Threat Protection is enabled and running in the optimal mode. You can disable Network Threat
Protection if necessary.

To enable or disable Network Threat Protection:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Network Threat Protection.
3. Use the Network Threat Protection toggle to enable or disable the component.
4. Save your changes.
As a result, if Network Threat Protection is enabled, Kaspersky Endpoint Security scans inbound network tra ic
for activity that is typical of network attacks. When Kaspersky Endpoint Security detects an attempted network
attack on the user's computer, it blocks the network connection with the attacking computer.

Blocking an attacking computer
To block an attacking computer:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Network Threat Protection.
3. Select the Add an attacking computer to the list of blocked computers for N min check box.
If the check box is selected, the Network Threat Protection component adds the attacking computer to the
blocked list. This means that the Network Threat Protection component blocks the network connection with
the attacking computer after the rst network attack attempt for the speci ed amount of time. This block
automatically protects the user's computer against possible future network attacks from the same address.
You can view the block list in the Network Monitor tool window.
Kaspersky Endpoint Security clears the block list when the application is restarted and when the Network
Threat Protection settings are changed.
4. Set a di erent blocking duration for an attacking computer in the eld to the right of the Add an attacking
computer to the list of blocked computers for N min check box.
5. Save your changes.
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As a result, when Kaspersky Endpoint Security detects an attempted network attack launched against the user's
computer, it will block all connections with the attacking computer.

Con guring addresses of exclusions from blocking
Kaspersky Endpoint Security can recognize a network attack and block an unsecured network connection that is
transmitting a large number of packets (for example, from surveillance cameras). To work with trusted devices, you
can add the IP addresses of these devices to the list of exclusions.

To con gure addresses of exclusions from blocking:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Network Threat Protection.
3. Click the Manage exclusions link.
4. In the window, click the Add button.
5. Enter the IP address of the computer from which network attacks must not be blocked.
6. Save your changes.
As a result, Kaspersky Endpoint Security does not track the activity from devices on the list of exclusions.

Exporting and importing the list of exclusions from blocking
You can export the list of exclusions to an XML le. Then you can modify the le to, for example, add a large number
of addresses of the same type. You can also use the export/import function to back up the list of exclusions or to
migrate the list to a di erent server.
How to export and import a list of exclusions in the Administration Console (MMC)

185

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Network Threat Protection.
6. In the Network Threat Protection settings block, click the Exclusions button.
7. To export the list of rules:
a. Select the exclusions that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any exclusion, Kaspersky Endpoint Security will export all exclusions.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
8. To import the list of exclusions:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
9. Save your changes.
How to export and import a list of exclusions in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of exclusions.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Network Threat Protection.
5. In the Network Threat Protection settings block, click the Exclusions link.
The list of exclusions opens.
6. To export the list of rules:
a. Select the exclusions that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected exclusions, or export the entire list of exclusions.
d. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
e. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
7. To import the list of exclusions:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
8. Save your changes.

Con guring protection against network attacks by type
Kaspersky Endpoint Security lets you manage protection against the following types of network attacks:

Network Flooding is an attack on network resources of an organization (such as web servers). This attack
consists of sending a large number of requests to overload the bandwidth of network resources. When this
happens, users are unable to access the network resources of the organization.
A Port Scanning attack consists of scanning UDP ports, TCP ports, and network services on the computer. This
attack allows the attacker to identify the degree of vulnerability of the computer before conducting more
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dangerous types of network attacks. Port Scanning also enables the attacker to identify the operating system
on the computer and select the appropriate network attacks for this operating system.
A MAC spoo ng attack consists of changing the MAC address of a network device (network card). As a result,
an attacker can redirect data sent to a device to another device and gain access to this data. Kaspersky
Endpoint Security lets you block MAC Spoo ng attacks and receive noti cations about the attacks.
You can disable detection of these types of attacks in case some of your allowed applications perform operations
that are typical for these types of attacks. This will help avoid false alarms.
By default, Kaspersky Endpoint Security does not monitor Network Flooding, Port Scanning, and MAC spoo ng
attacks.

To con gure protection against network attacks by type:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Network Threat Protection.
3. Use the toggle Treat port scanning and network ooding as attacks to enable or disable detection of these
attacks.
4. Use the MAC Spoo ng Protection toggle.
5. In the On detecting a MAC spoo ng attack block, select one of the following options:
Notify only.
Notify and block.
6. Save your changes.

Firewall
The Firewall blocks unauthorized connections to the computer while working on the Internet or local network. The
Firewall also controls the network activity of applications on the computer. This allows you to protect your
corporate LAN from identity theft and other attacks. The component provides computer protection with the help
of anti-virus databases, the Kaspersky Security Network cloud service, and prede ned network rules.
Network Agent is used for interaction with Kaspersky Security Center. Firewall automatically creates network
rules required for the application and the Network Agent to work. As a result, the Firewall opens several ports
on the computer. Which ports are opened depends on computer's role (for example, distribution point). To
learn more about the ports that will be opened on the computer, refer to the Kaspersky Security Center
Help .

Network rules
You can con gure network rules at the following levels:

Network packet rules. Network packet rules impose restrictions on network packets, regardless of the
application. Such rules restrict inbound and outbound network tra ic through speci c ports of the selected
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data protocol. Kaspersky Endpoint Security has prede ned network packet rules with permissions
recommended by Kaspersky experts.

Application network rules. Application network rules impose restrictions on the network activity of a speci c
application. They factor in not only the characteristics of the network packet, but also the speci c application
to which this network packet is addressed or which issued this network packet.
Controlled access of applications to operating system resources, processes and personal data is provided by
the Host Intrusion Prevention component by using application rights.
During the rst startup of the application, the Firewall performs the following actions:
1. Checks the security of the application using downloaded anti-virus databases.
2. Checks the security of the application in Kaspersky Security Network.
You are advised to participate in Kaspersky Security Network to help the Firewall work more e ectively.
3. Puts the application in one of the trust groups: Trusted, Low Restricted, High Restricted, Untrusted.
A trust group de nes the rights that Kaspersky Endpoint Security refers to when controlling application
activity. Kaspersky Endpoint Security places an application in a trust group depending on the level of danger
that this application may pose to the computer.
Kaspersky Endpoint Security places an application in a trust group for the Firewall and Host Intrusion
Prevention components. You cannot change the trust group only for the Firewall or Host Intrusion
Prevention.

If you refused to participate in KSN or there is no network, Kaspersky Endpoint Security places the
application in a trust group depending on the settings of the Host Intrusion Prevention component. After
receiving the reputation of the application from KSN, the trust group can be changed automatically.
4. It blocks network activity of the application depending on the trust group. For example, applications in the High
Restricted trust group are not allowed to use any network connections.
The next time the application is started, Kaspersky Endpoint Security checks the integrity of the application. If the
application is unchanged, the component uses the current network rules for it. If the application has been
modi ed, Kaspersky Endpoint Security analyzes the application as if it were being started for the rst time.

Network Rule Priorities
Each rule has a priority. The higher a rule is on the list, the higher its priority. If network activity is added to several
rules, the Firewall regulates network activity according to the rule with the highest priority.
Network packet rules have a higher priority than network rules for applications. If both network packet rules and
network rules for applications are speci ed for the same type of network activity, the network activity is handled
according to the network packet rules.
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Network rules for applications work as follows: a network rule for applications includes access rules based on the
network status: public, local, or trusted. For example, applications in the High Restricted trust group are not allowed
any network activity in networks of all statuses by default. If a network rule is speci ed for an individual application
(parent application), then the child processes of other applications will run according to the network rule of the
parent application. If there is no network rule for the application, the child processes will run according to network
access rule of the application's trust group.
For example, you have prohibited any network activity in networks of all statuses for all applications, except
browser X. If you start browser Y installation (child process) from browser X (parent application), then browser Y
installer will access the network and download the necessary les. After installation, browser Y will be denied any
network connections according to the Firewall settings. To prohibit network activity of browser Y installer as a child
process, you must add a network rule for the installer of browser Y.

Network connection statuses
The Firewall allows you to control network activity depending on the status of the network connection. Kaspersky
Endpoint Security receives the network connection status from the computer's operating system. The status of
the network connection in the operating system is set by the user when setting up the connection. You can change
the status of the network connection in the Kaspersky Endpoint Security settings. The Firewall will monitor
network activity depending on the network status in the Kaspersky Endpoint Security settings, and not in the
operating system.
The network connection can have one of the following status types:
Public network. The network is not protected by antivirus applications, rewalls, or lters (such as Wi-Fi in a
cafe). When the user operates a computer that is connected to such a network, Firewall blocks access to les
and printers of this computer. External users are also unable to access data through shared folders and remote
access to the desktop of this computer. Firewall lters the network activity of each application according to
the network rules that are set for it.
Firewall assigns Public network status to the Internet by default. You cannot change the status of the Internet.
Local network. Network for users with restricted access to les and printers on this computer (such as for a
corporate LAN or home network).
Trusted network. Safe network in which the computer is not exposed to attacks or unauthorized data access
attempts. Firewall permits any network activity within networks with this status.

Enabling or disabling Firewall
By default, Firewall is enabled and functions in the optimal mode.

To enable or disable Firewall:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Use the Firewall toggle to enable or disable the component.
4. Save your changes.
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Changing the network connection status
Firewall assigns Public network status to the Internet by default. You cannot change the status of the Internet.

To change the network connection status:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Available networks button.
4. Select the network connection whose status you want to change.
5. In the Network type column, select the status of the network connection:
Public network. The network is not protected by antivirus applications, rewalls, or lters (such as Wi-Fi in a
cafe). When the user operates a computer that is connected to such a network, Firewall blocks access to
les and printers of this computer. External users are also unable to access data through shared folders and
remote access to the desktop of this computer. Firewall lters the network activity of each application
according to the network rules that are set for it.
Local network. Network for users with restricted access to les and printers on this computer (such as for a
corporate LAN or home network).
Trusted network. Safe network in which the computer is not exposed to attacks or unauthorized data
access attempts. Firewall permits any network activity within networks with this status.
6. Save your changes.

Managing network packet rules
You can perform the following actions while managing network packet rules:
Create a new network packet rule.
You can create a new network packet rule by creating a set of conditions and actions that is applied to network
packets and data streams.
Enable or disable a network packet rule.
All network packet rules that are created by Firewall by default have Enabled status. When a network packet
rule is enabled, Firewall applies this rule.
You can disable any network packet rule that is selected in the list of network packet rules. When a network
packet rule is disabled, Firewall temporarily does not apply this rule.
A new custom network packet rule is added to the list of network packet rules by default with Enabled
status.
Edit the settings of an existing network packet rule.
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After you create a new network packet rule, you can always return to editing its settings and modify them as
needed.
Change the Firewall action for a network packet rule.
In the list of network packet rules, you can edit the action that is taken by Firewall on detecting network activity
that matches a speci c network packet rule.
Change the priority of a network packet rule.
You can raise or lower the priority of a network packet rule that is selected in the list.
Remove a network packet rule.
You can remove a network packet rule to stop Firewall from applying this rule on detecting network activity
and to stop this rule from showing in the list of network packet rules with Disabled status.

Creating a network packet rule
You can create a network packet rule in the following ways:
Use the Network Monitor tool.

Network Monitor is a tool designed for viewing information about the network activity of a user's computer in
real time. This is convenient because you do not need to con gure all the rule settings. Some Firewall settings
will be inserted automatically from Network Monitor data. Network Monitor is available only in the application
interface.
Con gure the Firewall settings.
This lets you ne-tune the Firewall settings. You can create rules for any network activity, even if there is no
network activity at the current time.
When creating network packet rules, remember that they have priority over network rules for applications.
How to use the Network Monitor tool to create a network packet rule in the application interface
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1. In the main application window, in the Monitoring section, click the Network Monitor tile.
2. Select the Network activity tab.
The Network activity tab shows all currently active network connections with the computer. Both
outbound and inbound network connections are displayed.
3. In the context menu of a network connection, select Create network packet rule.
This opens the network rule properties.
4. Set the Active status for the packet rule.
5. Manually enter the name of the network service in the Name eld.
6. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Network rule template link. Rule templates
describe the most frequently used network connections.
All network rule settings will be lled in automatically.
7. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
8. Click the Save button.
The new network rule will be added to the list.
9. Use the Up / Down buttons to set the priority of the network rule.
10. Save your changes.
How to use Firewall settings to create a network packet rule in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Packet rules button.
This opens the list of default network rules that are set by the Firewall.
4. Click the Add button.
This opens the network rule properties.
5. Set the Active status for the packet rule.
6. Manually enter the name of the network service in the Name eld.
7. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Network rule template link. Rule templates
describe the most frequently used network connections.
All network rule settings will be lled in automatically.
8. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
9. Click the Save button.
The new network rule will be added to the list.
10. Use the Up / Down buttons to set the priority of the network rule.
11. Save your changes.
How to create a network packet rule in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Firewall.
6. In the Firewall settings block, click the Settings button.
This opens the list of network packet rules and the list of application network rules.
7. Select the Network packet rules tab.
This opens the list of default network rules that are set by the Firewall.
8. Click the Add button.
This opens the packet rule properties.
9. Manually enter the name of the network service in the Name eld.
10. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the
frequently used network connections.

button. Rule templates describe the most

All network rule settings will be lled in automatically.
11. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
12. Click the Save button.
The new network rule will be added to the list.
13. Use the Up / Down buttons to set the priority of the network rule.
14. Save your changes.
The Firewall will control network packets according to the rule. You can disable a packet rule from Firewall
operation without deleting it from the list. To do so, clear the check box next to the object.
How to create a network packet rule in the Web Console and Cloud Console

195

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Firewall.
5. In the Firewall settings block, click the Network packet rules link.
This opens the list of default network rules that are set by the Firewall.
6. Click the Add button.
This opens the packet rule properties.
7. Manually enter the name of the network service in the Name eld.
8. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Select template link. Rule templates describe the
most frequently used network connections.
All network rule settings will be lled in automatically.
9. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
10. Click the Save button.
The new network rule will be added to the list.
11. Use the Up / Down buttons to set the priority of the network rule.
12. Save your changes.
The Firewall will control network packets according to the rule. You can disable a packet rule from Firewall
operation without deleting it from the list. Use the toggle in the Status column to enable or disable the
packet rule.
Network packet rule settings

Parameter

Action

Description

Allow.
Block.
By application rules. If this option is selected, Firewall applies the application network rules to
the network connection.

Protocol

Control network activity over the selected protocol: TCP, UDP, ICMP, ICMPv6, IGMP and GRE.
If ICMP or ICMPv6 is selected as the protocol, you can de ne the ICMP packet type and code.
If TCP or UDP is selected as the protocol type, you can specify the comma-delimited port
numbers of the local and remote computers between which the connection is to be monitored.

Direction

Inbound (packet). Firewall applies the network rule to all inbound network packets.
Inbound. Firewall applies the network rule to all network packets sent via a connection that was
initiated by a remote computer.
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Inbound / Outbound. Firewall applies the network rule to both inbound and outbound network
packets, regardless of whether the user's computer or a remote computer initiated the
network connection.
Outbound (packet). Firewall applies the network rule to all outbound network packets.
Outbound. Firewall applies the network rule to all network packets sent via a connection that
was initiated by the user's computer.
The TCP protocol establishes a connection. For TCP, use the Inbound, Outbound, and
Inbound / Outbound directions. All other protocols do not establish connections, but
they send packets. For all other protocols, use the Inbound (packet), Outbound (packet),
or Inbound/Outbound directions.

Network
adapters

Network adapters that can send and/or receive network packets. Specifying the settings of
network adapters makes it possible to di erentiate between network packets sent or received
by network adapters with identical IP addresses.

Time to
live (TTL)

Restrict control of network packets based on their time to live (TTL).

Remote
addresses

Network addresses of remote computers that can send and receive network packets. Firewall
applies the network rule to the speci ed range of remote network addresses. You can include
all IP addresses in a network rule, create a separate list of IP addresses, specify a range of IP
addresses, or select a subnet (Trusted networks, Local networks, Public networks). You can
also specify a DNS name of a computer instead of its IP address. You should use DNS names
only for LAN computers or internal services. Interaction with cloud services (such as Microsoft
Azure) and other Internet resources should be handled by the Web Control component.

Local
addresses

Network addresses of computers that can send and receive network packets. Firewall applies
a network rule to the speci ed range of local network addresses. You can include all IP
addresses in a network rule, create a separate list of IP addresses, or specify a range of IP
addresses. You can also specify a DNS name of a computer instead of its IP address. You
should use DNS names only for LAN computers or internal services. Interaction with cloud
services (such as Microsoft Azure) and other Internet resources should be handled by the Web
Control component.
Sometimes the local address cannot be obtained for applications. If this is the case, this
parameter is ignored.

Enabling or disabling a network packet rule
To enable or disable a network packet rule:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Packet rules button.
This opens a list of default network packet rules that are set by Firewall.
4. Select the necessary network packet rule in the list.
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5. Use the toggle in the Status column to enable or disable the rule.
6. Save your changes.

Changing the Firewall action for a network packet rule
To change the Firewall action that is applied to a network packet rule:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Packet rules button.
This opens a list of default network packet rules that are set by Firewall.
4. Select it in the list of network packet rules and click the Edit button.
5. In the Action drop-down list, select the action to be performed by Firewall on detecting this kind of network
activity:
Allow.
Block.
By application rules.
6. Save your changes.

Changing the priority of a network packet rule
The priority of a network packet rule is determined by its position in the list of network packet rules. The topmost
network packet rule in the list of network packet rules has the highest priority.
Every manually created network packet rule is added to the end of the list of network packet rules and is of the
lowest priority.
Firewall executes rules in the order in which they appear in the list of network packet rules, from top to bottom.
According to each processed network packet rule that applies to a particular network connection, Firewall either
allows or blocks network access to the address and port that are speci ed in the settings of this network
connection.

To change the network packet rule priority:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Packet rules button.
This opens a list of default network packet rules that are set by Firewall.
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4. In the list, select the network packet rule whose priority you want to change.
5. Use the Up / Down buttons to set the priority of the network rule.
6. Save your changes.

Exporting and importing network packet rules
You can export the list of network packet rules to an XML le. Then you can modify the le to, for example, add a
large number of rules of the same type. You can use the export/import function to back up the list of network
packet rules or to migrate the list to a di erent server.
How to export and import a list of network packet rules in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Firewall.
6. To export the list of network packet rules:
a. Select the rules that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any rule, Kaspersky Endpoint Security will export all rules.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of rules,
and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the list of rules to the XML le.
7. To import a list of network packet rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.
How to export and import a list of network packet rules in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import the list of rules.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Firewall.
5. Click the Network packet rules link.
6. To export the list of network packet rules:
a. Select the rules that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected rules, or export the entire list.
d. Click the Export button.
Kaspersky Endpoint Security exports the list of rules to an XML le in the default downloads folder.
7. To import a list of network packet rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.

Managing application network rules
By default, Kaspersky Endpoint Security groups all applications that are installed on the computer by the name of
the vendor of the software whose le or network activity it monitors. Application groups are in turn categorized
into trust groups. All applications and application groups inherit properties from their parent group: application
control rules, application network rules, and their execution priority.
Like the Host Intrusion Prevention component, by default the Firewall component applies the network rules for an
application group when ltering the network activity of all applications within the group. The application group
network rules de ne the rights of applications within the group to access di erent network connections.
By default, Firewall creates a set of network rules for each application group that is detected by Kaspersky
Endpoint Security on the computer. You can change the Firewall action that is applied to the application group
network rules that are created by default. You cannot edit, remove, disable, or change the priority of
application group network rules that are created by default.
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You can also create a network rule for an individual application. Such a rule will have a higher priority than the
network rule of the group to which the application belongs.

Creating an application network rule
By default, application activity is controlled by network rules that are de ned for the trust group to which
Kaspersky Endpoint Security assigned the application when it started the rst time. If necessary, you can create
network rules for an entire trust group, for an individual application, or for a group of applications that are within a
trust group.
Manually de ned network rules have a higher priority than network rules that were determined for a trust group. In
other words, if manually de ned application rules di er from the application rules determined for a trust group,
Firewall controls application activity according to the manually de ned rules for applications.
By default, Firewall creates the following network rules for each application:
Any network activity in Trusted networks.
Any network activity in Local networks.
Any network activity in Public networks.
Kaspersky Endpoint Security controls the network activity of applications according to prede ned network rules
as follows:
Trusted and Low Restricted: all network activity is allowed.
High Restricted and Untrusted: all network activity is blocked.
Prede ned application rules cannot be edited or deleted.
You can create an application network rule in the following ways:
Use the Network Monitor tool.

Network Monitor is a tool designed for viewing information about the network activity of a user's computer in
real time. This is convenient because you do not need to con gure all the rule settings. Some Firewall settings
will be inserted automatically from Network Monitor data. Network Monitor is available only in the application
interface.
Con gure the Firewall settings.
This lets you ne-tune the Firewall settings. You can create rules for any network activity, even if there is no
network activity at the current time.
When creating network rules for applications, remember that network packet rules have priority over
application network rules.
How to use the Network Monitor tool to create an application network rule in the application interface
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1. In the main application window, in the Monitoring section, click the Network Monitor tile.
2. Select the Network activity or Open ports tab.
The Network activity tab shows all currently active network connections with the computer. Both
outbound and inbound network connections are displayed.
The Open ports tab lists all open network ports of the computer.
3. In the context menu of a network connection, select Create application rule.
The application rules and properties window opens.
4. Select the Network rules tab.
This opens the list of default network rules that are set by the Firewall.
5. Click the Add button.
This opens the network rule properties.
6. Manually enter the name of the network service in the Name eld.
7. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Network rule template link. Rule templates
describe the most frequently used network connections.
All network rule settings will be lled in automatically.
8. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
9. Click the Save button.
The new network rule will be added to the list.
10. Use the Up / Down buttons to set the priority of the network rule.
11. Save your changes.
How to use Firewall settings to create an application network rule in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Application rules button.
This opens the list of default network rules that are set by the Firewall.
4. In the list of applications, select the application or application group for which you want to create a
network rule.
5. Right-click to open the context menu and select Details and rules.
The application rules and properties window opens.
6. Select the Network rules tab.
7. Click the Add button.
This opens the network rule properties.
8. Manually enter the name of the network service in the Name eld.
9. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Network rule template link. Rule templates
describe the most frequently used network connections.
All network rule settings will be lled in automatically.
10. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
11. Click the Save button.
The new network rule will be added to the list.
12. Use the Up / Down buttons to set the priority of the network rule.
13. Save your changes.
How to create an application network rule in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Essential Threat Protection → Firewall.
6. In the Firewall settings block, click the Settings button.
This opens the list of network packet rules and the list of application network rules.
7. Select the Application network rules tab.
8. Click the Add button.
9. In the opened window, enter criteria to search for the application for which you want to create a network
rule.
You can enter the name of the application or the name of the vendor. Kaspersky Endpoint Security
supports environment variables and the * and ? characters when entering a mask.
10. Click the Refresh button.
Kaspersky Endpoint Security will search for the application in the consolidated list of applications installed
on managed computers. Kaspersky Endpoint Security will show a list of applications that satisfy your
search criteria.
11. Select the necessary application.
12. In the Add selected application to the trust group <trust group> drop-down list, select Default groups
and click OK.
The application will be added to the default group.
13. Select the relevant application and then select Application rights from the context menu of the
application.
The application rules and properties window opens.
14. Select the Network rules tab.
This opens the list of default network rules that are set by the Firewall.
15. Click the Add button.
This opens the network rule properties.
16. Manually enter the name of the network service in the Name eld.
17. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the
frequently used network connections.

button. Rule templates describe the most

All network rule settings will be lled in automatically.
18. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
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19. Click the Save button.
The new network rule will be added to the list.
20. Use the Up / Down buttons to set the priority of the network rule.
21. Save your changes.
How to create an application network rule in the Web Console and Cloud Console

205

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Essential Threat Protection → Firewall.
5. In the Firewall settings block, click the Application network rules link.
This opens the application rights con guration window and the list of protected resources.
6. Select the Application rights tab.
You will see a list of trust groups on the left side of the window and their properties on the right side.
7. Click the Add button.
This starts the Wizard for adding an application to a trust group.
8. Select the relevant trust group for the application.
9. Select the Application type. Click the Next button.
If you want to create a network rule for multiple applications, select the Group type and de ne a name for
the application group.
10. In the opened list of applications, select the applications for which you want to create a network rule.
Use a lter. You can enter the name of the application or the name of the vendor. Kaspersky Endpoint
Security supports environment variables and the * and ? characters when entering a mask.
11. Finish the Wizard by clicking OK.
The application will be added to the trust group.
12. In the left part of the window, select the relevant application.
13. In the right part of the window, select Network rules from the drop-down list.
This opens the list of default network rules that are set by the Firewall.
14. Click the Add button.
This opens the application rule properties.
15. Manually enter the name of the network service in the Name eld.
16. Con gure the network rule settings (see the table below).
You can select a prede ned rule template by clicking the Select template link. Rule templates describe the
most frequently used network connections.
All network rule settings will be lled in automatically.
17. If you want the actions of the network rule to be re ected in the report, select the Log events check box.
18. Click the Save button.
The new network rule will be added to the list.
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19. Use the Up / Down buttons to set the priority of the network rule.
20. Save your changes.
Application network rule settings

Parameter

Action

Description

Allow.
Block.

Protocol

Control network activity over the selected protocol: TCP, UDP, ICMP, ICMPv6, IGMP and GRE.
If ICMP or ICMPv6 is selected as the protocol, you can de ne the ICMP packet type and code.
If TCP or UDP is selected as the protocol type, you can specify the comma-delimited port
numbers of the local and remote computers between which the connection is to be monitored.

Direction

Inbound.
Inbound / Outbound.
Outbound.

Remote
addresses

Network addresses of remote computers that can send and receive network packets. Firewall
applies the network rule to the speci ed range of remote network addresses. You can include
all IP addresses in a network rule, create a separate list of IP addresses, specify a range of IP
addresses, or select a subnet (Trusted networks, Local networks, Public networks). You can
also specify a DNS name of a computer instead of its IP address. You should use DNS names
only for LAN computers or internal services. Interaction with cloud services (such as Microsoft
Azure) and other Internet resources should be handled by the Web Control component.

Local
addresses

Network addresses of computers that can send and receive network packets. Firewall applies
a network rule to the speci ed range of local network addresses. You can include all IP
addresses in a network rule, create a separate list of IP addresses, or specify a range of IP
addresses. You can also specify a DNS name of a computer instead of its IP address. You
should use DNS names only for LAN computers or internal services. Interaction with cloud
services (such as Microsoft Azure) and other Internet resources should be handled by the Web
Control component.
Sometimes the local address cannot be obtained for applications. If this is the case, this
parameter is ignored.

Enabling and disabling an application network rule
To enable or disable an application network rule:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Application rules button.
This opens the list of application rules.
4. In the list of applications, select the application or group of applications for which you want to create or edit a
network rule.
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5. Right-click to open the context menu and select Details and rules.
The application rules and properties window opens.
6. Select the Network rules tab.
7. In the list of network rules for an application group, select the relevant network rule.
The network rule properties window opens.
8. Set the Active or Inactive status for the network rule.
You cannot disable an application group network rule that is created by Firewall by default.
9. Save your changes.

Changing the Firewall action for an application network rule
You can change the Firewall action that is applied to all network rules for an application or application group that
were created by default, and change the Firewall action for a single custom network rule for an application or
application group.

To change the Firewall action for all network rules for an application or group of applications:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Application rules button.
This opens the list of application rules.
4. If you want to change the Firewall action that is applied to all network rules that are created by default, select
an application or group of applications in the list. Manually created network rules are left unchanged.
5. Right-click to open the context menu, select Network rules, then select the action that you want to assign:
Inherit.
Allow.
Block.
6. Save your changes.

To change the Firewall response for one network rule for an application or application group:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Application rules button.
This opens the list of application rules.
4. In the list, select the application or group of applications for which you want to change the action for one
network rule.
208

5. Right-click to open the context menu and select Details and rules.
The application rules and properties window opens.
6. Select the Network rules tab.
7. Select the network rule for which you want to change the Firewall action.
8. In the Permission column, right-click to bring up the context menu and select the action that you want to
assign:
Inherit.
Allow.
Block.
Log events.
9. Save your changes.

Changing the priority of an application network rule
The priority of a network rule is determined by its position in the list of network rules. Firewall executes the rules in
the order in which they appear in the list of network rules, from top to bottom. According to each processed
network rule that applies to a particular network connection, Firewall either allows or blocks network access to the
address and port that are indicated in the settings of this network connection.
Manually created network rules have a higher priority than default network rules.
You cannot change the priority of application group network rules that are created by default.

To change the priority of a network rule:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → Firewall.
3. Click the Application rules button.
This opens the list of application rules.
4. In the list of applications, select the application or group of applications for which you want to change the
priority of a network rule.
5. Right-click to open the context menu and select Details and rules.
The application rules and properties window opens.
6. Select the Network rules tab.
7. Select the network rule whose priority you want to change.
8. Use the Up and Down buttons to move the network rule to the desired spot in the list of network rules.
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9. Save your changes.

Network Monitor
Network Monitor is a tool designed for viewing information about the network activity of a user's computer in real
time.
To start Network Monitor:
In the main application window, in the Monitoring section, click the Network Monitor tile.
The Network Monitor window opens. In this window, information about the network activity of the computer is
shown on four tabs:
The Network activity tab shows all currently active network connections with the computer. Both outbound
and inbound network connections are displayed. On this tab, you can also create network packet rules for
Firewall operation.
The Open ports tab lists all open network ports of the computer. On this tab, you can also create network
packet rules and application rules for Firewall operation.
The Network tra ic tab shows the volume of inbound and outbound network tra ic between the user's
computer and other computers in the network to which the user is currently connected.
The Blocked computers tab lists the IP addresses of remote computers whose network activity has been
blocked by the Network Threat Protection component after detecting network attack attempts from such IP
addresses.

BadUSB Attack Prevention
Some viruses modify the rmware of USB devices to trick the operating system into detecting the USB device as a
keyboard. As a result, the virus may execute commands under your user account to download malware, for
example.
The BadUSB Attack Prevention component prevents infected USB devices emulating a keyboard from connecting
to the computer.
When a USB device is connected to the computer and identi ed as a keyboard by the operating system, the
application prompts the user to enter a numerical code generated by the application from this keyboard or using
On-Screen Keyboard if available (see the gure below). This procedure is known as keyboard authorization.
If the code has been entered correctly, the application saves the identi cation parameters – VID/PID of the
keyboard and the number of the port to which it has been connected – in the list of authorized keyboards.
Keyboard authorization does not need to be repeated when the keyboard is reconnected or after the operating
system is restarted.
When the authorized keyboard is connected to a di erent USB port of the computer, the application shows a
prompt for authorization of this keyboard again.
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If the numerical code has been entered incorrectly, the application generates a new code. You can con gure the
number of attempts for entering the numerical code. If the numerical code is entered incorrectly several times or
the keyboard authorization window is closed (see gure below), the application blocks input from this keyboard.
When the USB device blocking time elapses or the operating system is restarted, the application prompts the user
to perform keyboard authorization again.
The application allows use of an authorized keyboard and blocks a keyboard that has not been authorized.
The BadUSB Attack Prevention component is not installed by default. If you need the BadUSB Attack
Prevention component, you can add the component in the properties of the installation package before
installing the application or change the available application components after installing the application.

Keyboard authorization

Enabling and disabling BadUSB Attack Prevention
USB devices identi ed by the operating system as keyboards and connected to the computer before installation
of the BadUSB Attack Prevention component are considered authorized after installation of the component.

To enable or disable BadUSB Attack Prevention:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → BadUSB Attack Prevention.
3. Use the BadUSB Attack Prevention toggle to enable or disable the component.
4. Under Authorization of USB devices, adjust security settings for entering the authorization code:
Maximum number of USB device authorization attempts. Automatically blocking the USB device if the
authorization code is entered incorrectly the speci ed number of times. Valid values are 1 to 10. For example,
if you allow 5 attempts to enter the authorization code, the USB device is blocked after the fth failed
attempt. Kaspersky Endpoint Security displays the blocking duration for the USB device. After this time
elapses, you can have 5 attempts to enter the authorization code.
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Timeout when reaching the maximum number of attempts (minutes). Blocking duration of the USB device
after the speci ed number of failed attempts to enter the authorization code. Valid values are 1 to 180
(minutes).
5. Save your changes.
As a result, if BadUSB Attack Prevention is enabled, Kaspersky Endpoint Security requires authorization of a
connected USB device identi ed as a keyboard by the operating system. The user cannot use an unauthorized
keyboard until it is authorized.

Using On-Screen Keyboard for authorization of USB devices
On-Screen Keyboard should be used only for authorization of USB devices that do not support the input of
random characters (e.g. bar code scanners). It is not recommended to use On-Screen Keyboard for authorization
of unknown USB devices.

To allow or prohibit the use of On-Screen Keyboard for authorization:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → BadUSB Attack Prevention.
3. Use the Prohibit use of On-Screen Keyboard for authorization of USB devices check box to block or allow
use of the On-Screen Keyboard for authorization.
4. Save your changes.

AMSI Protection
AMSI Protection component is intended to support Antimalware Scan Interface from Microsoft. The Antimalware
Scan Interface (AMSI) allows third-party applications with AMSI support to send objects (for example, PowerShell
scripts) to Kaspersky Endpoint Security for an additional scan and then receive the results from scanning these
objects. Third-party applications may include, for example, Microsoft O ice applications (see the gure below). For
details on AMSI, please refer to the Microsoft documentation .
The AMSI Protection can only detect a threat and notify a third-party application about the detected threat.
Third-party application after receiving a noti cation of a threat does not allow to perform malicious actions (for
example, terminates).

AMSI operation example
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AMSI Protection component may decline a request from a third-party application, for example, if this
application exceeds maximum number of requests within a speci ed interval. Kaspersky Endpoint Security
sends information about a rejected request from a third-party application to the Administration Server. AMSI
Protection component does not reject requests from those third-party applications for which the Do not
block interaction with AMSI Protection component check box is selected.
AMSI Protection is available for the following operating systems for workstations and servers:
Windows 10 Home / Pro / Pro for Workstations / Education / Enterprise;
Windows 11;
Windows Server 2016 Essentials / Standard / Datacenter;
Windows Server 2019 Essentials / Standard / Datacenter;
Windows Server 2022.

Enabling and disabling the AMSI Protection
By default, the AMSI Protection is enabled.

To enable or disable the AMSI Protection:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → AMSI Protection.
3. Use the AMSI Protection toggle to enable or disable the component.
4. Save your changes.

Using AMSI Protection to scan compound les
A common technique for concealing viruses and other malware is to embed them in compound les such as
archives. To detect viruses and other malware that are hidden in this way, the compound le must be unpacked,
which may slow down scanning. You can limit the types of compound les to be scanned, thus speeding up
scanning.

To con gure AMSI Protection scans of compound les:
1. In the main application window, click the button

.

2. In the application settings window, select Essential Threat Protection → AMSI Protection.
3. In the Scan of compound les section, specify the types of compound les that you want to scan: archives,
distribution package, or les in o ice formats.
4. In the Size limit section, do one of the following:
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To block the AMSI Protection component from unpacking large compound les, select the Do not unpack
large compound les check box and specify the required value in the Maximum le size eld. The AMSI
Protection component will not unpack compound les that are larger than the speci ed size.
To allow the AMSI Protection component to unpack large compound les, clear the Do not unpack large
compound les check box.
The AMSI Protection component scans large les that are extracted from archives, regardless of whether
the Do not unpack large compound les check box is selected.
5. Save your changes.

Exploit Prevention
The Exploit Prevention component detects program code that takes advantage of vulnerabilities on the computer
to exploit administrator privileges or to perform malicious activities. For example, exploits can utilize a bu er
over ow attack. To do so, the exploit sends a large amount of data to a vulnerable application. When processing
this data, the vulnerable application executes malicious code. As a result of this attack, the exploit can start an
unauthorized installation of malware. When there is an attempt to run an executable le from a vulnerable
application that was not performed by the user, Kaspersky Endpoint Security blocks this le from running or
noti es the user.

Enabling and disabling Exploit Prevention
By default, Exploit Prevention is enabled and runs in the mode recommended by Kaspersky experts. You can
disable Exploit Prevention if necessary.

To enable or disable Exploit Prevention:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Exploit Prevention.
3. Use the Exploit Prevention toggle to enable or disable the component.
4. Save your changes.
As a result, if Exploit Prevention is enabled, Kaspersky Endpoint Security will monitor executable les that are run
by vulnerable applications. If Kaspersky Endpoint Security detects that an executable le from a vulnerable
application was run by something other than the user, Kaspersky Endpoint Security will perform the selected
action (for example, will block the operation).

Selecting an action to take when an exploit is detected
By default, on detection of an exploit, Kaspersky Endpoint Security blocks operations attempted by the exploit.

To choose an action to be taken when an exploit is detected:
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Exploit Prevention.
3. Select the relevant action in the On detecting exploit block:
Block operation. If this item is selected, on detecting an exploit, Kaspersky Endpoint Security blocks the
operations of this exploit and makes a log entry with information about this exploit.
Inform. If this item is selected, when Kaspersky Endpoint Security detects an exploit it logs an entry
containing information about the exploit and adds information about this exploit to the list of active threats.
4. Save your changes.

System processes memory protection
By default, protection of system process memory is enabled.

To enable or disable system process memory protection:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Exploit Prevention.
3. Use the Enable system process memory protection toggle to enable or disable this feature.
4. Save your changes.
As a result, Kaspersky Endpoint Security will block external processes that attempt to access system processes.

Behavior Detection
The Behavior Detection component receives data on the actions of applications on your computer and provides
this information to other protection components to improve their performance. The Behavior Detection
component utilizes Behavior Stream Signatures (BSS) for applications. If application activity matches a behavior
stream signature, Kaspersky Endpoint Security performs the selected responsive action. Kaspersky Endpoint
Security functionality based on behavior stream signatures provides proactive defense for the computer.

Enabling and disabling Behavior Detection
By default, Behavior Detection is enabled and runs in the mode recommended by Kaspersky experts. You can
disable Behavior Detection if necessary.
It is not recommended to disable Behavior Detection unless absolutely necessary because doing so would
reduce the e ectiveness of the protection components. The protection components may request data
collected by the Behavior Detection component to detect threats.

To enable or disable Behavior Detection:
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Behavior Detection.
3. Use the Behavior Detection toggle to enable or disable the component.
4. Save your changes.
As a result, if Behavior Detection is enabled, Kaspersky Endpoint Security will use behavior stream signatures to
analyze the activity of applications in the operating system.

Selecting the action to take on detecting malware activity
In order to choose what to do if an application engages in malicious activity, perform the following steps:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Behavior Detection.
3. Select the relevant action in the On detecting malware activity block:
Delete le. If this item is selected, on detecting malicious activity Kaspersky Endpoint Security deletes the
executable le of the malicious application and creates a backup copy of the le in Backup.
Terminate the application. If this item is selected, on detecting malicious activity Kaspersky Endpoint
Security terminates this application.
Inform. If this item is selected and malware activity of an application is detected, Kaspersky Endpoint
Security adds information about the malware activity of the application to the list of active threats.
4. Save your changes.

Protection of shared folders against external encryption
The component monitors operations performed only with those les that are stored on mass storage devices
with the NTFS le system and that are not encrypted with EFS.
Protection of shared folders against external encryption provides for analysis of activity in shared folders. If this
activity matches a behavior stream signature that is typical for external encryption, Kaspersky Endpoint Security
performs the selected action.
By default, protection of shared folders against external encryption is disabled.
After Kaspersky Endpoint Security is installed, the protection of shared folders against external encryption will
be limited until the computer is restarted.
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Enabling and disabling protection of shared folders against external
encryption
After Kaspersky Endpoint Security is installed, the protection of shared folders against external encryption will
be limited until the computer is restarted.

To enable or disable protection of shared folders against external encryption:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Behavior Detection.
3. Use the Enable protection of shared folders against external encryption toggle to enable or disable
detection of activity that is typical of external encryption.
4. Save your changes.

Selecting the action to take on detection of external encryption of shared
folders
To select the action to take on detection of external encryption of shared folders:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Behavior Detection.
3. Select the relevant action in the Protection of shared folders against external encryption block:
Block connection for N min. If this option is selected and Kaspersky Endpoint Security detects an attempt
to modify les in shared folders, it takes the following actions:
Blocks network activity of the computer attempting the modi cation.
Creates backup copies of les that are being modi ed.
Adds an entry to local application interface reports.
Sends information about the detected malicious activity to Kaspersky Security Center.
Also, if the Remediation Engine component is enabled, the modi ed les are restored from backup copies.
Inform. If this option is selected and Kaspersky Endpoint Security detects an attempt to modify les in
shared folders, it takes the following actions:
Adds an entry to local application interface reports.
Adds an entry to the list of active threats.
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Sends information about the detected malicious activity to Kaspersky Security Center.
4. Save your changes.

Con guring addresses of exclusions from protection of shared folders
against external encryption
The Audit Logon service must be enabled to enable exclusions of addresses from protection of shared folders
against external encryption. By default, the Audit Logon service is disabled (for detailed information about
enabling the Audit Logon service, please visit the Microsoft website).

The functionality for excluding addresses from shared folder protection does not work on a remote computer
if the remote computer was turned on before Kaspersky Endpoint Security was started. You can restart this
remote computer after Kaspersky Endpoint Security is started to ensure that the functionality for excluding
addresses from shared folder protection works on this remote computer.

To exclude remote computers that perform external encryption of shared folders:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Behavior Detection.
3. In the Exclusions block, click the Con gure addresses of exclusions link.
4. If you want to add an IP address or computer name to the list of exclusions, click the Add button.
5. Enter the IP address or name of the computer from which external encryption attempts must not be handled.
6. Save your changes.

Exporting and importing a list of exclusions from protection of shared
folders against external encryption
You can export the list of exclusions to an XML le. Then you can modify the le to, for example, add a large number
of addresses of the same type. You can also use the export/import function to back up the list of exclusions or to
migrate the list to a di erent server.
How to export and import a list of exclusions in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Behavior Detection.
6. In the Protection of shared folders against external encryption section, click the Exclusions button.
7. To export the list of rules:
a. Select the exclusions that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any exclusion, Kaspersky Endpoint Security will export all exclusions.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
8. To import the list of exclusions:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
9. Save your changes.
How to export and import a list of exclusions in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of exclusions.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Behavior Detection.
5. To export the list of exclusions in the Exclusions block:
a. Select the exclusions that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected exclusions, or export the entire list of exclusions.
d. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
e. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
6. To import the list of exclusions in the Exclusions block:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
7. Save your changes.

Host Intrusion Prevention
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
The Host Intrusion Prevention component prevents applications from performing actions that may be dangerous
for the operating system, and ensures control over access to operating system resources and personal data. The
component provides computer protection with the help of anti-virus databases and the Kaspersky Security
Network cloud service.
The component controls the operation of applications by using application rights. Application rights include the
following access parameters:
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Access to operating system resources (for example, automatic startup options, registry keys)
Access to personal data (such as les and applications)
Network activity of applications is controlled by the Firewall using network rules.
During the rst startup of the application, the Host Intrusion Prevention component performs the following
actions:
1. Checks the security of the application using downloaded anti-virus databases.
2. Checks the security of the application in Kaspersky Security Network.
You are advised to participate in Kaspersky Security Network to help the Host Intrusion Prevention
component work more e ectively.
3. Puts the application in one of the trust groups: Trusted, Low Restricted, High Restricted, Untrusted.
A trust group de nes the rights that Kaspersky Endpoint Security refers to when controlling application
activity. Kaspersky Endpoint Security places an application in a trust group depending on the level of danger
that this application may pose to the computer.
Kaspersky Endpoint Security places an application in a trust group for the Firewall and Host Intrusion
Prevention components. You cannot change the trust group only for the Firewall or Host Intrusion
Prevention.

If you refused to participate in KSN or there is no network, Kaspersky Endpoint Security places the
application in a trust group depending on the settings of the Host Intrusion Prevention component. After
receiving the reputation of the application from KSN, the trust group can be changed automatically.
4. Blocks application actions depending on the trust group. For example, applications from the High Restricted
trust group are denied access to the operating system modules.
The next time the application is started, Kaspersky Endpoint Security checks the integrity of the application. If the
application is unchanged, the component uses the current application rights for it. If the application has been
modi ed, Kaspersky Endpoint Security analyzes the application as if it were being started for the rst time.

Enabling and disabling Host Intrusion Prevention
By default, the Host Intrusion Prevention component is enabled and runs in the mode recommended by Kaspersky
experts.
How to enable or disable the Host Intrusion Prevention component in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. Use the Host Intrusion Prevention check box to enable or disable the component.
7. Save your changes.
How to enable or disable the Host Intrusion Prevention component in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. Use the Host Intrusion Prevention toggle to enable or disable the component.
6. Save your changes.
How to enable or disable the Host Intrusion Prevention component in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Use the Host Intrusion Prevention toggle to enable or disable the component.
4. Save your changes.
If the Host Intrusion Prevention component is enabled, Kaspersky Endpoint Security will place an application in a
trust group depending on the level of danger that this application may pose to the computer. Kaspersky Endpoint
Security will then block the actions of the application depending on the trust group.

Managing application trust groups
222

When each application is started for the rst time, the Host Intrusion Prevention component checks the security
of the application and places the application into one of the trust groups.
At the rst stage of the application scan, Kaspersky Endpoint Security searches the internal database of known
applications for a matching entry and at the same time sends a request to the Kaspersky Security Network
database (if an Internet connection is available). Based on the results of the search in the internal database and the
Kaspersky Security Network database, the application is placed into a trust group. Each time the application is
subsequently started, Kaspersky Endpoint Security sends a new query to the KSN database and places the
application into a di erent trust group if the reputation of the application in the KSN database has changed.
You can select a trust group to which Kaspersky Endpoint Security must automatically assign all unknown
applications. Applications that were started before Kaspersky Endpoint Security are automatically moved to the
trust group de ned in the Host Intrusion Prevention component settings window.
For applications that were started before Kaspersky Endpoint Security, only network activity is controlled.
Control is performed according to the network rules de ned in the Firewall settings.

Changing the trust group of an application
When each application is started for the rst time, the Host Intrusion Prevention component checks the security
of the application and places the application into one of the trust groups.
Kaspersky specialists do not recommend moving applications from the automatically assigned trust group to
a di erent trust group. Instead, you can modify rights for an individual application if necessary.
How to change the trust group of an application in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. Under Application control rules and protected resources, click Settings.
This opens the application rights con guration window and the list of protected resources.
7. Select the Application rights tab.
8. Click the Add button.
9. In the opened window, enter criteria to search for the application whose trust group you want to change.
You can enter the name of the application or the name of the vendor. Kaspersky Endpoint Security
supports environment variables and the * and ? characters when entering a mask.
10. Click the Refresh button.
Kaspersky Endpoint Security will search for the application in the consolidated list of applications installed
on managed computers. Kaspersky Endpoint Security will show a list of applications that satisfy your
search criteria.
11. Select the necessary application.
12. In the Add selected application to the trust group drop-down list, select the necessary trust group for
the application.
13. Save your changes.
How to change the trust group of an application in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application rights and protected resources block, click the Application rights and protected
resources link.
This opens the application rights con guration window and the list of protected resources.
6. Select the Application rights tab.
You will see a list of trust groups on the left side of the window and their properties on the right side.
7. Click the Add button.
This starts the Wizard for adding an application to a trust group.
8. Select the relevant trust group for the application.
9. Select the Application type. Click the Next button.
If you want to change the trust group for multiple applications, select the Group type and de ne a name
for the application group.
10. In the opened list of applications, select the applications whose trust group you want to change.
Use a lter. You can enter the name of the application or the name of the vendor. Kaspersky Endpoint
Security supports environment variables and the * and ? characters when entering a mask.
11. Finish the Wizard by clicking OK.
The application will be added to the trust group.
12. Save your changes.
How to change the trust group of an application in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Click the Manage applications button.
This opens the list of installed applications.
4. Select the necessary application.
5. In the context menu of the application, click Restrictions → <trust group>.
6. Save your changes.
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As a result, the application will be put into the other trust group. Kaspersky Endpoint Security will then block the
actions of the application depending on the trust group. The (user-de ned) status will be assigned to the
application. If the reputation of the application is changed in Kaspersky Security Network, the Host Intrusion
Prevention component will leave this application's trust group unchanged.

Con guring trust group rights
The optimal application rights are created for di erent trust groups by default. The settings of rights for
application groups that are in a trust group inherit values from the settings of the trust group rights.
How to change trust group rights in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. Under Application control rules and protected resources, click Settings.
This opens the application rights con guration window and the list of protected resources.
7. Select the Application rights tab.
8. Select the necessary trust group.
9. Select Group rights from the context menu of the trust group.
This opens the trust group properties.
10. Do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select the Files and system registry tab.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select the Rights tab.
Network activity of applications is controlled by the Firewall using network rules.
11. For the relevant resource, in the column of the corresponding action, right-click to open the context menu
and select the necessary option: Inherit, Allow ( ) or Forbid ( ).
12. If you want to monitor the use of computer resources, select Log events (

/

).

Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
13. Save your changes.
How to change trust group rights in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application rights and protected resources block, click the Application rights and protected
resources link.
This opens the application rights con guration window and the list of protected resources.
6. Select the Application rights tab.
You will see a list of trust groups on the left side of the window and their properties on the right side.
7. In the left part of the window, select the relevant trust group.
8. In the right part of the window, in the drop-down list, do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select Files and system registry.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select Rights.
Network activity of applications is controlled by the Firewall using network rules.
9. For the relevant resource, in the column of the corresponding action, select the necessary option: Inherit,
Allow ( ), or Forbid ( ).
10. If you want to monitor the use of computer resources, select Log events (

/

).

Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
11. Save your changes.
How to change trust group rights in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Click the Manage applications button.
This opens the list of installed applications.
4. Select the necessary trust group.
5. In the context menu of the trust group, select Details and rules.
This opens the trust group properties.
6. Do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select the Files and system registry tab.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select the Rights tab.
Network activity of applications is controlled by the Firewall using network rules.
7. For the relevant resource, in the column of the corresponding action, right-click to open the context menu
and select the necessary option: Inherit, Allow ( ), or Forbid ( ).
8. If you want to monitor the use of computer resources, select Log events ( ).
Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
9. Save your changes.
The trust group rights will be changed. Kaspersky Endpoint Security will then block the actions of the application
depending on the trust group. The status (User settings) will be assigned to the trust group.

Selecting a trust group for applications started before Kaspersky Endpoint
Security
For applications that were started before Kaspersky Endpoint Security, only network activity is controlled.
Control is performed according to the network rules de ned in the Firewall settings. To specify which network
rules must be applied to network activity monitoring for such applications, you must select a trust group.
How to select a trust group for applications started before Kaspersky Endpoint Security in the Administration
Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. In the Application rights block, click the Edit button.
7. For the Trust group for applications launched before Kaspersky Endpoint Security for Windows starts
working setting, select the appropriate trust group.
8. Save your changes.
How to select a trust group for applications started before Kaspersky Endpoint Security in the Web Console and
Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. For the Trust group for applications launched before Kaspersky Endpoint Security for Windows starts
working setting, select the appropriate trust group.
6. Save your changes.
How to select a trust group for applications started before Kaspersky Endpoint Security in the application
interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Under Trust group for applications launched before Kaspersky Endpoint Security for Windows starts
working, select the appropriate trust group.
4. Save your changes.
As a result, an application that is started before Kaspersky Endpoint Security will be put into the other trust group.
Kaspersky Endpoint Security will then block the actions of the application depending on the trust group.
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Selecting a trust group for unknown applications
During the rst startup of an application, the Host Intrusion Prevention component determines the trust group for
the application. If you do not have Internet access or if Kaspersky Security Network has no information about this
application, Kaspersky Endpoint Security will place the application into the Low Restricted group by default. When
information about a previously unknown application is detected in KSN, Kaspersky Endpoint Security will update
the rights of this application. You can then manually edit the application rights.
How to select a trust group for unknown applications in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. In the Application processing rules block, use the Trust group for applications that could not be added
to existing groups drop-down list to select the necessary trust group.
If participation in Kaspersky Security Network is enabled, Kaspersky Endpoint Security sends KSN a
request for the reputation of an application each time the application is started. Based on the received
response, the application may be moved to a trust group that is di erent from the one speci ed in the
Host Intrusion Prevention component settings.
7. Use the Update rights for previously unknown applications from KSN database check box to con gure
automatic update of the rights of unknown applications.
8. Save your changes.
How to select a trust group for unknown applications in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application processing rules block, use the Trust group for applications that could not be added
to existing groups drop-down list to select the necessary trust group.
If participation in Kaspersky Security Network is enabled, Kaspersky Endpoint Security sends KSN a
request for the reputation of an application each time the application is started. Based on the received
response, the application may be moved to a trust group that is di erent from the one speci ed in the
Host Intrusion Prevention component settings.
6. Use the Update rights for previously unknown applications from KSN database check box to con gure
automatic update of the rights of unknown applications.
7. Save your changes.
How to select a trust group for unknown applications in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Under Application processing rules, select the necessary trust group.
If participation in Kaspersky Security Network is enabled, Kaspersky Endpoint Security sends KSN a
request for the reputation of an application each time the application is started. Based on the received
response, the application may be moved to a trust group that is di erent from the one speci ed in the
Host Intrusion Prevention component settings.
4. Use the Update rules for previously unknown applications from KSN check box to con gure automatic
update of the rights of unknown applications.
5. Save your changes.

Selecting a trust group for digitally signed applications
Kaspersky Endpoint Security always places applications signed by Microsoft certi cates or Kaspersky certi cates
into the Trusted group.
How to select a trust group for digitally signed applications in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. In the Application processing rules block, use the Trust digitally signed applications check box to enable
or disable automatic assignment to the Trusted group for applications containing the digital signature of
trusted vendors.

Trusted vendors are those software vendors that are included in the trusted group by Kaspersky. You can
also add vendor certi cate to the trusted system certi cate store manually.
If this check box is cleared, the Host Intrusion Prevention component does not consider digitally signed
applications to be trusted, and uses other parameters to determine their trust group.
7. Save your changes.
How to select a trust group for digitally signed applications in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application processing rules block, use the Trust digitally signed applications check box to enable
or disable automatic assignment to the Trusted group for applications containing the digital signature of
trusted vendors.

Trusted vendors are those software vendors that are included in the trusted group by Kaspersky. You can
also add vendor certi cate to the trusted system certi cate store manually.
If this check box is cleared, the Host Intrusion Prevention component does not consider digitally signed
applications to be trusted, and uses other parameters to determine their trust group.
6. Save your changes.
How to select a trust group for digitally signed applications in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. In the Application processing rules block, use the Trust digitally signed applications check box to enable
or disable automatic assignment to the Trusted group for applications containing the digital signature of
trusted vendors.

Trusted vendors are those software vendors that are included in the trusted group by Kaspersky. You can
also add vendor certi cate to the trusted system certi cate store manually.
If this check box is cleared, the Host Intrusion Prevention component does not consider digitally signed
applications to be trusted, and uses other parameters to determine their trust group.
4. Save your changes.

Managing application rights
By default, application activity is controlled based on the application rights that are de ned for the speci c trust
group that Kaspersky Endpoint Security assigned to the application when it started for the rst time. If necessary,
you can edit the application rights for an entire trust group, for an individual application, or for a group of
applications within a trust group.
Manually de ned application rights have a higher priority than application rights that were de ned for a trust group.
In other words, if manually de ned application rights di er from the application rights de ned for a trust group, the
Host Intrusion Prevention component controls application activity according to the manually de ned application
rights.
The rules that you create for applications are inherited by child applications. For example, if you deny all network
activity for cmd.exe, all network activity will also be denied for notepad.exe if it is started using cmd.exe. If an
application is started indirectly by another application but is not a child of the application it runs from, rules are not
inherited.
How to change application rights in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. Under Application control rules and protected resources, click Settings.
This opens the application rights con guration window and the list of protected resources.
7. Select the Application rights tab.
8. Click the Add button.
9. In the opened window, enter criteria to search for the application whose application rights you want to
change.
You can enter the name of the application or the name of the vendor. Kaspersky Endpoint Security
supports environment variables and the * and ? characters when entering a mask.
10. Click the Refresh button.
Kaspersky Endpoint Security will search for the application in the consolidated list of applications installed
on managed computers. Kaspersky Endpoint Security will show a list of applications that satisfy your
search criteria.
11. Select the necessary application.
12. In the Add selected application to the trust group drop-down list, select Default groups and click OK.
The application will be added to the default group.
13. Select the relevant application and then select Application rights from the context menu of the
application.
This opens the application properties.
14. Do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select the Files and system registry tab.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select the Rights tab.
Network activity of applications is controlled by the Firewall using network rules.
15. For the relevant resource, in the column of the corresponding action, right-click to open the context menu
and select the necessary option: Inherit, Allow ( ) or Forbid ( ).
16. If you want to monitor the use of computer resources, select Log events (
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).

Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
17. Save your changes.
How to change application rights in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application rights and protected resources block, click the Application rights and protected
resources link.
This opens the application rights con guration window and the list of protected resources.
6. Select the Application rights tab.
You will see a list of trust groups on the left side of the window and their properties on the right side.
7. Click the Add button.
This starts the Wizard for adding an application to a trust group.
8. Select the relevant trust group for the application.
9. Select the Application type. Click the Next button.
If you want to change the trust group for multiple applications, select the Group type and de ne a name
for the application group.
10. In the opened list of applications, select the applications whose application rights you want to change.
Use a lter. You can enter the name of the application or the name of the vendor. Kaspersky Endpoint
Security supports environment variables and the * and ? characters when entering a mask.
11. Finish the Wizard by clicking OK.
The application will be added to the trust group.
12. In the left part of the window, select the relevant application.
13. In the right part of the window, in the drop-down list, do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select Files and system registry.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select Rights.
Network activity of applications is controlled by the Firewall using network rules.
14. For the relevant resource, in the column of the corresponding action, select the necessary option: Inherit,
Allow ( ), or Forbid ( ).
15. If you want to monitor the use of computer resources, select Log events (
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Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
16. Save your changes.
How to change application rights in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Click the Manage applications button.
This opens the list of installed applications.
4. Select the necessary application.
5. In the context menu of the application, select Details and rules.
This opens the application properties.
6. Do one of the following:
If you want to edit trust group rights that regulate operations with the operating system registry, user
les, and application settings, select the Files and system registry tab.
If you want to edit trust group rights that regulate access to operating system processes and objects,
select the Rights tab.
7. For the relevant resource, in the column of the corresponding action, right-click to open the context menu
and select the necessary option: Inherit, Allow ( ), or Forbid ( ).
8. If you want to monitor the use of computer resources, select Log events ( ).
Kaspersky Endpoint Security will record information about the operation of the Host Intrusion Prevention
component. Reports contain information about operations with computer resources performed by the
application (allowed or forbidden). Reports also contain information about the applications that utilize each
resource.
9. Select the Exclusions tab and con gure the advanced settings of the application (see the table below).
10. Save your changes.
Advanced Settings of the application

Parameter

Description

Do not scan
opened les

All les that are opened by the application are excluded from scans by Kaspersky
Endpoint Security. For example, if you are using applications to back up les, this
feature helps reduce the consumption of resources by Kaspersky Endpoint
Security.

Do not
monitor
application
activity

Kaspersky Endpoint Security will not monitor the application's le- and network
activity in the operating system. Application activity is monitored by the following
components: Behavior Detection, Exploit Prevention, Host Intrusion Prevention,
Remediation Engine and Firewall.

Do not inherit
restrictions of
the parent
process
(application)

The restrictions con gured for the parent process will not be applied by
Kaspersky Endpoint Security to a child process. The parent process is started by
an application for which application rights (Host Intrusion Prevention) and
application network rules (Firewall) are con gured.

Do not
monitor child
application
activity

Kaspersky Endpoint Security will not monitor the le activity or network activity
of applications that are started by this application.
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Allow
interaction
with the
application
interface

Kaspersky Endpoint Security Self-Defense blocks all attempts to manage
application services from a remote computer. If the check box is selected, the
remote access application is allowed to manage Kaspersky Endpoint Security
settings through the Kaspersky Endpoint Security interface.

Do not scan
encrypted
tra ic / Do
not scan all
tra ic

Network tra ic initiated by the application will be excluded from scans by
Kaspersky Endpoint Security. You can exclude either all tra ic or only encrypted
tra ic from scans. You can also exclude individual IP addresses and port numbers
from scans.

Protecting operating system resources and personal data
The Host Intrusion Prevention component manages the rights of applications to take actions on various categories
of operating system resources and personal data. Kaspersky specialists have established preset categories of
protected resources. For example, the Operating system category has a Startup settings subcategory that lists all
the registry keys associated with autorun of applications. You cannot edit or delete the preset categories of
protected resources or the protected resources that are within these categories.
How to add a protected resource in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. Under Application control rules and protected resources, click Settings.
This opens the application rights con guration window and the list of protected resources.
7. Select the Protected resources tab.
You will see a list of protected resources in the left part of the window and the corresponding rights for
accessing those resources depending on the speci c trust group.
8. Select the category of protected resources to which you want to add a new protected resource.
If you want to add a subcategory, click Add → Category.
9. Click the Add button. In the drop-down list, select the type of resource that you want to add: File or folder
or Registry key.
10. In the opened window, select a le, folder, or registry key.
You can view applications' rights to access the added resources. To do so, select an added resource in the
left part of the window and Kaspersky Endpoint Security will show the access rights for each trust group.
You can also disable control of application activity with resources by using the check box next to a new
resource.
11. Save your changes.
How to add a protected resource in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application rights and protected resources block, click the Application rights and protected
resources link.
This opens the application rights con guration window and the list of protected resources.
6. Select the Protected resources tab.
You will see a list of protected resources in the left part of the window and the corresponding rights for
accessing those resources depending on the speci c trust group.
7. Click the Add button.
The New Resource Wizard starts.
8. Click the Group name link to select the category of protected resources to which you want to add a new
protected resource.
If you want to add a subcategory, select the Category of protected resources option.
9. Select the type of resource that you want to add: File or folder or Registry key.
10. Select a le, folder, or registry key.
11. Finish the Wizard by clicking OK.
You can view applications' rights to access the added resources. To do so, select an added resource in the
left part of the window and Kaspersky Endpoint Security will show the access rights for each trust group.
You can also use the check box in the Status column to disable control of application activity with
resources.
12. Save your changes.
How to add a protected resource in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. Click the Manage resources button.
The list of protected resources opens.
4. Select the category of protected resources to which you want to add a new protected resource.
If you want to add a subcategory, click Add → Category.
5. Click the Add button. In the drop-down list, select the type of resource that you want to add: File or folder
or Registry key.
6. In the opened window, select a le, folder, or registry key.
You can view applications' rights to access the added resources. To do so, select an added resource in the
left part of the window and Kaspersky Endpoint Security will show a list of applications and the access
rights for each application. You can also disable control of application activity with resources by using the
Disable control button in the Status column.
7. Save your changes.
Kaspersky Endpoint Security will control access to the added operating system resources and to personal data.
Kaspersky Endpoint Security controls an application's access to resources based on the trust group assigned to
the application. You can also change the trust group of an application.

Deleting information about unused applications
Kaspersky Endpoint Security uses application rights to control the activities of applications. Application rights are
determined by their trust group. Kaspersky Endpoint Security puts an application into a trust group when the
application is started for the rst time. You can manually change the trust group of an application. You can also
manually con gure the rights of an individual application. Kaspersky Endpoint Security stores the following
information about an application: trust group of the application, and rights of the application.
Kaspersky Endpoint Security automatically deletes information about unused applications to save computer
resources. Kaspersky Endpoint Security deletes application information according to the following rules:
If the trust group and rights of an application were determined automatically, Kaspersky Endpoint Security
deletes information about this application after 30 days. It is not possible to change the storage term for
application information or turn o automatic deletion.
If you manually put an application into a trust group or con gured its access rights, Kaspersky Endpoint
Security deletes information about this application after 60 days (default storage term). You can change the
storage term for application information, or turn o automatic deletion (see the instructions below).
When you start an application whose information has been deleted, Kaspersky Endpoint Security analyzes the
application as if it were starting for the rst time.
How to con gure automatic deletion of information about unused applications in the Administration Console
(MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Host Intrusion Prevention.
6. In the Application processing rules block, do one of the following:
If you want to con gure automatic deletion, select the Delete rules for applications that have not
been started for longer than N days check box and enter the number of days.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be deleted by Kaspersky Endpoint Security after the de ned number of days.
Information about applications whose trust group and application rights were automatically determined
will also be deleted by Kaspersky Endpoint Security after 30 days.
If you want to turn o automatic deletion, clear the Delete rules for applications that have not been
started for longer than N days check box.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be stored by Kaspersky Endpoint Security inde nitely, without any storage
term limits. Kaspersky Endpoint Security will only delete information about applications whose trust
group and application rights were automatically determined after 30 days.
7. Save your changes.
How to con gure automatic deletion of information about unused applications in the Web Console and Cloud
Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Host Intrusion Prevention.
5. In the Application processing rules block, do one of the following:
If you want to con gure automatic deletion, select the Delete rules for applications that have not
been started for longer than N days check box and enter the number of days.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be deleted by Kaspersky Endpoint Security after the de ned number of days.
Information about applications whose trust group and application rights were automatically determined
will also be deleted by Kaspersky Endpoint Security after 30 days.
If you want to turn o automatic deletion, clear the Delete rules for applications that have not been
started for longer than N days check box.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be stored by Kaspersky Endpoint Security inde nitely, without any storage
term limits. Kaspersky Endpoint Security will only delete information about applications whose trust
group and application rights were automatically determined after 30 days.
6. Save your changes.
How to con gure automatic deletion of information about unused applications in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Host Intrusion Prevention.
3. In the Application processing rules block, do one of the following:
If you want to con gure automatic deletion, select the Delete rules for applications that have not
been started for longer than N days check box and enter the number of days.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be deleted by Kaspersky Endpoint Security after the de ned number of days.
Information about applications whose trust group and application rights were automatically determined
will also be deleted by Kaspersky Endpoint Security after 30 days.
If you want to turn o automatic deletion, clear the Delete rules for applications that have not been
started for longer than N days check box.
Information about the applications that you manually put into a trust group or whose access rights you
manually con gured will be stored by Kaspersky Endpoint Security inde nitely, without any storage
term limits. Kaspersky Endpoint Security will only delete information about applications whose trust
group and application rights were automatically determined after 30 days.
4. Save your changes.
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Monitoring Host Intrusion Prevention
You can receive reports on the operation of the Host Intrusion Prevention component. Reports contain
information about operations with computer resources performed by the application (allowed or forbidden).
Reports also contain information about the applications that utilize each resource.
To monitor Host Intrusion Prevention operations, you need to enable report writing. For example, you can enable
forwarding of reports for individual applications in the Host Intrusion Prevention component settings.
When con guring Host Intrusion Prevention monitoring, take into account the potential network load when
forwarding events to Kaspersky Security Center. You can also enable saving of reports only in the local log of
Kaspersky Endpoint Security.

Protecting access to audio and video
Cybercriminals can use special programs to try to gain access to devices that record audio and video (such as
microphones or webcams). Kaspersky Endpoint Security controls when applications receive an audio stream or
video stream and protects data against unauthorized interception.
By default, Kaspersky Endpoint Security controls the access of applications to the audio stream and video stream
as follows:
Trusted and Low Restricted applications are allowed to receive the audio stream and video stream from
devices by default.
High Restricted and Untrusted applications are not allowed to receive the audio stream and video stream from
devices by default.
You can manually allow applications to receive the audio stream and video stream.

Special features of audio stream protection
Audio stream protection has the following special characteristics:
The Host Intrusion Prevention component must be enabled for this functionality to work.
If the application started receiving the audio stream before the Host Intrusion Prevention component was
started, Kaspersky Endpoint Security allows the application to receive the audio stream and does not show any
noti cations.
If you moved the application to the Untrusted group or High Restricted group after the application began
receiving the audio stream, Kaspersky Endpoint Security allows the application to receive the audio stream and
does not show any noti cations.
After the settings for the application's access to sound recording devices have been changed (for example, if
the application has been blocked from receiving the audio stream), this application must be restarted to stop it
from receiving the audio stream.
246

Control of access to the audio stream from sound recording devices does not depend on an application's
webcam access settings.
Kaspersky Endpoint Security protects access to only built-in microphones and external microphones. Other
audio streaming devices are not supported.
Kaspersky Endpoint Security cannot guarantee the protection of an audio stream from such devices as DSLR
cameras, portable video cameras, and action cameras.
When you run audio and video recording or playback applications for the rst time since installation of
Kaspersky Endpoint Security, audio and video playback or recording may be interrupted. This is necessary in
order to enable the functionality that controls access to sound recording devices by applications. The system
service that controls audio hardware will be restarted when Kaspersky Endpoint Security is run for the rst
time.

Special features of application webcam access protection
Webcam access protection functionality has the following special considerations and limitations:
The application controls video and still images derived from the processing of webcam data.
The application controls the audio stream if it is part of the video stream received from the webcam.
The application controls only webcams connected via USB or IEEE1394 that are displayed as Imaging Devices in
the Windows Device Manager.
Kaspersky Endpoint Security supports the following webcams:
Logitech HD Webcam C270
Logitech HD Webcam C310
Logitech Webcam C210
Logitech Webcam Pro 9000
Logitech HD Webcam C525
Microsoft LifeCam VX-1000
Microsoft LifeCam VX-2000
Microsoft LifeCam VX-3000
Microsoft LifeCam VX-800
Microsoft LifeCam Cinema
Kaspersky cannot guarantee support for webcams that are not speci ed in this list.

Remediation Engine
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The Remediation Engine lets Kaspersky Endpoint Security roll back actions that have been performed by malware
in the operating system.
When rolling back malware activity in the operating system, Kaspersky Endpoint Security handles the following
types of malware activity:
File activity
Kaspersky Endpoint Security performs the following actions:
Deletes executable les that were created by malware (on all media except network drives).
Deletes executable les that were created by programs that have been in ltrated by malware.
Restores les that have been modi ed or deleted by malware.
The le recovery feature has a number of limitations.
Registry activity
Kaspersky Endpoint Security performs the following actions:
Deletes registry keys that were created by malware.
Does not restore registry keys that have been modi ed or deleted by malware.
System activity
Kaspersky Endpoint Security performs the following actions:
Terminates processes that have been initiated by malware.
Terminates processes into which a malicious application has penetrated.
Does not resume processes that have been halted by malware.
Network activity
Kaspersky Endpoint Security performs the following actions:
Blocks the network activity of malware.
Blocks the network activity of processes that have been in ltrated by malware.
A rollback of malware actions can be started by the File Threat Protection or Behavior Detection component, or
during a virus scan.
Rolling back malware operations a ects a strictly de ned set of data. Rollback has no adverse e ects on the
operating system or on the integrity of your computer data.
How to enable or disable the Remediation Engine component in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Advanced Threat Protection → Remediation Engine.
6. Use the Remediation Engine check box to enable or disable the component.
7. Save your changes.
How to enable or disable the Remediation Engine component in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Advanced Threat Protection → Remediation Engine.
5. Use the Remediation Engine toggle to enable or disable the component.
6. Save your changes.
How to enable or disable the Remediation Engine component in the application interface

1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Remediation Engine.
3. Use the Remediation Engine toggle to enable or disable the component.
4. Save your changes.
As a result, if Remediation Engine is enabled, Kaspersky Endpoint Security will roll back the actions taken by
malicious applications in the operating system.

Kaspersky Security Network
To protect your computer more e ectively, Kaspersky Endpoint Security uses data that is received from users
around the globe. Kaspersky Security Network is designed for obtaining this data.
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Kaspersky Security Network (KSN) is an infrastructure of cloud services providing access to the online Kaspersky
Knowledge Base that contains information about the reputation of les, web resources, and software. The use of
data from Kaspersky Security Network ensures faster responses by Kaspersky Endpoint Security to new threats,
improves the performance of some protection components, and reduces the likelihood of false positives. If you are
participating in Kaspersky Security Network, KSN services provide Kaspersky Endpoint Security with information
about the category and reputation of scanned les, as well as information about the reputation of scanned web
addresses.
Use of Kaspersky Security Network is voluntary. The application prompts you to use KSN during initial
con guration of the application. Users can begin or discontinue participation in KSN at any time.
For more detailed information about sending Kaspersky statistical information that is generated during
participation in KSN, and about the storage and destruction of such information, please refer to the Kaspersky
Security Network Statement and the Kaspersky website . The ksn_<language ID>.txt le with the text of the
Kaspersky Security Network Statement is included in the application distribution kit.
To reduce the load on KSN servers, Kaspersky experts may release application updates that temporarily disable or
partly restrict requests to Kaspersky Security Network. In this case, the status of the connection to KSN in the
local interface of the application is Enabled with restrictions.

KSN Infrastructure
Kaspersky Endpoint Security supports the following KSN infrastructural solutions:

Global KSN is the solution that is used by most Kaspersky applications. KSN participants receive information
from Kaspersky Security Network and send Kaspersky information about objects detected on the user's
computer to be analyzed additionally by Kaspersky analysts and to be included in the reputation and statistical
databases of Kaspersky Security Network.
Private KSN is a solution that enables users of computers hosting Kaspersky Endpoint Security or other
Kaspersky applications to obtain access to reputation databases of Kaspersky Security Network, and to other
statistical data without sending data to KSN from their own computers. Private KSN is designed for corporate
customers who are unable to participate in Kaspersky Security Network for any of the following reasons:
Local workstations are not connected to the Internet.
Transmission of any data outside the country or outside the corporate LAN is prohibited by law or restricted
by corporate security policies.
By default, Kaspersky Security Center uses Global KSN. You can con gure the use of Private KSN in the
Administration Console (MMC), in the Kaspersky Security Center Web Console, and in the command line. It is
not possible to con gure the use of Private KSN in the Kaspersky Security Center Cloud Console.
For more details about Private KSN, please refer to the documentation on Kaspersky Private Security Network.

KSN Proxy
User computers managed by Kaspersky Security Center Administration Server can interact with KSN via the KSN
Proxy service.
The KSN Proxy service provides the following capabilities:
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The user's computer can query KSN and submit information to KSN even without direct access to the Internet.
The KSN Proxy service caches processed data, thereby reducing the load on the external network
communication channel and speeding up receipt of the information that is requested by the user's computer.
For more details on the KSN Proxy service, please refer to the Kaspersky Security Center Help .

Enabling and disabling the usage of Kaspersky Security Network
To enable or disable the usage of Kaspersky Security Network:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Kaspersky Security Network.
3. Use the Kaspersky Security Network toggle to enable or disable the component.
If you enabled the use of KSN, Kaspersky Endpoint Security will display the Kaspersky Security Network
Statement. Please read and accept the Kaspersky Security Network (KSN) Statement terms of use if you agree
to them.
By default, Kaspersky Endpoint Security uses the Extended KSN mode. Extended KSN mode is a mode in which
Kaspersky Endpoint Security sends additional data to Kaspersky.
4. If required, ip the Enable Extended KSN mode toggle o .
5. Save your changes.
As a result, if use of KSN is enabled, Kaspersky Endpoint Security uses information about the reputation of les,
web resources, and applications received from Kaspersky Security Network.

Limitations of Private KSN
Private KSN (hereinafter also referred to as KPSN) lets you use your own local reputation database to check the
reputation of objects ( les or web addresses). The reputation of an object added to the local reputation database
has a higher priority than one added to KSN/KPSN. For example, imagine that Kaspersky Endpoint Security is
scanning a computer and requests the reputation of a le in KSN/KPSN. If the le has an "untrusted" reputation in
the local reputation database but has a "trusted" reputation in KSN/KPSN, Kaspersky Endpoint Security will detect
the le as "untrusted" and will take the action de ned for detected threats.
However, in some cases Kaspersky Endpoint Security might not request the reputation of an object in KSN/KPSN.
If this is the case, Kaspersky Endpoint Security will not receive data from the local reputation database of KPSN.
Kaspersky Endpoint Security might not request the reputation of an object in KSN/KPSN for the following reasons:
Kaspersky applications are using o line reputation databases. O line reputation databases are designed to
optimize resources during operation of Kaspersky applications and to protect critically important objects on
the computer. O line reputation databases are created by Kaspersky experts based on data from Kaspersky
Security Network. Kaspersky applications update o line reputation databases with anti-virus databases of the
speci c application. If o line reputation databases contain information about an object being scanned, the
application does not request the reputation of this object from KSN/KPSN.
Scan exclusions (trusted zone) are con gured in the application settings. If this is the case, the application does
not take into account the reputation of the object in the local reputation database.
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The application uses scan optimization technologies, such as iSwift or iChecker, or is caching reputation
requests to KSN / KPSN. If this is the case, the application might not request the reputation of previously
scanned objects.
To optimize its workload, the application scans les of a certain format and size. The list of relevant formats and
size limits are determined by Kaspersky experts. This list is updated with the application's anti-virus databases.
You can also con gure scan optimization settings in the application interface, for example, for the File Threat
Protection component.

Enabling and disabling cloud mode for protection components
Cloud mode refers to the application operating mode in which Kaspersky Endpoint Security uses a light version of
anti-virus databases. Kaspersky Security Network supports the operation of the application when light anti-virus
databases are being used. The light version of anti-virus databases lets you use approximately half of the
computer RAM that would otherwise be used with the usual databases. If you do not participate in Kaspersky
Security Network or if cloud mode is disabled, Kaspersky Endpoint Security downloads the full version of anti-virus
databases from Kaspersky servers.
When using Kaspersky Private Security Network, cloud mode functionality is available starting with Kaspersky
Private Security Network version 3.0.

To enable or disable cloud mode for protection components:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced Threat Protection → Kaspersky Security Network.
3. Use the Enable Cloud mode toggle switch to enable or disable the component.
4. Save your changes.
As a result, Kaspersky Endpoint Security downloads a light version or full version of anti-virus databases during
the next update.

If the light version of anti-virus databases is not available for use, Kaspersky Endpoint Security automatically
switches to the premium version of anti-virus databases.

Checking the reputation of a le in Kaspersky Security Network
If you are doubtful of the security of a le, you can check its reputation in Kaspersky Security Network.
You can check the reputation of a le if you have accepted the terms of the Kaspersky Security Network
Statement.

To check the reputation of a le in Kaspersky Security Network:
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Open the le context menu and select the Check reputation in KSN option (see the gure below).

File context menu

Kaspersky Endpoint Security displays the le reputation:
Trusted. Most users of Kaspersky Security Network have con rmed that the le is trusted.
Legitimate software that can be used by intruders to damage your computer or personal data. Although
they do not have any malicious functions, such applications can be exploited by intruders. For details on
legitimate software that could be used by criminals to harm the computer or personal data of a user, please refer
to the Kaspersky IT Encyclopedia website . You can add these applications to the trusted list.
Untrusted. A virus or other application that poses a threat.
Unknown. Kaspersky Security Network does not have any information about the le. You can scan a le using
anti-virus databases (the Scan for viruses option in the context menu).
Kaspersky Endpoint Security displays the KSN solution that was used to determine the reputation of the le:
Global KSN or Private KSN.
Kaspersky Endpoint Security also displays additional information about the le (see the gure below).

Reputation of a le in Kaspersky Security Network
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Encrypted connections scan
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
After installation, Kaspersky Endpoint Security adds a Kaspersky certi cate to the system storage for trusted
certi cates (Windows certi cate store). Kaspersky Endpoint Security also includes the use of system storage of
trusted certi cates in Firefox and Thunderbird to scan the tra ic of these applications.
The Web Control, Mail Threat Protection, Web Threat Protection components can decrypt and scan network
tra ic transmitted over encrypted connections using the following protocols:
SSL 3.0.
TLS 1.0, TLS 1.1, TLS 1.2, TLS 1.3.

Con guring the encrypted connections scan settings
To con gure the encrypted connections scan settings:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. Under Encrypted Connections Scan, select the encrypted connection scanning mode:
Do not scan encrypted connections Kaspersky Endpoint Security will not have access to the contents of
websites whose addresses begin with https://.
Scan encrypted connections upon request from protection components. Kaspersky Endpoint Security
will scan encrypted tra ic only when requested by the File Threat Protection, Mail Threat Protection, and
Web Control components.
Always scan encrypted connections Kaspersky Endpoint Security will scan encrypted network tra ic even
if protection components are disabled.
Kaspersky Endpoint Security does not scan encrypted connections that were established by trusted
applications for which tra ic scanning is disabled. Kaspersky Endpoint Security does not scan encrypted
connections from the prede ned list of trusted websites. The prede ned list of trusted websites is
created by Kaspersky experts. This list is updated with the application's anti-virus databases. You can view
the prede ned list of trusted websites only in the Kaspersky Endpoint Security interface. You cannot view
the list in the Kaspersky Security Center Console.
4. If necessary, add scan exclusions: trusted addresses and applications.
5. Con gure the settings for scanning encrypted connections (see the table below).
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6. Save your changes.
Encrypted connections scan settings

Parameter

When visiting a
domain with an
untrusted
certi cate

Description

Allow. If this option is selected, when visiting a domain with an untrusted
certi cate, Kaspersky Endpoint Security allows the network connection.
When opening a domain with an untrusted certi cate in a browser, Kaspersky
Endpoint Security displays an HTML page showing a warning and the reason why
visiting that domain is not recommended. A user can click the link from the HTML
warning page to obtain access to the requested web resource. After following this
link, during the next hour Kaspersky Endpoint Security will not display warnings about
an untrusted certi cate when visiting other resources on this same domain.
Block connection. If this option is selected, when visiting a domain with an
untrusted certi cate, Kaspersky Endpoint Security blocks the network
connection.
When opening a domain with an untrusted certi cate in a browser, Kaspersky
Endpoint Security displays an HTML page showing the reason why that domain is
blocked.

When
encrypted
connection
scan errors
occur

Block SSL 2.0
connections
(recommended)

Block connection. If this item is selected, when an encrypted connection scan
error occurs, Kaspersky Endpoint Security blocks the network connection.
Add domain to exclusions. If this item is selected, when an encrypted
connection scan error occurs, Kaspersky Endpoint Security adds the domain
that resulted in the error to the list of domains with scan errors and does not
monitor encrypted network tra ic when this domain is visited. You can view a
list of domains with encrypted connections scan errors only in the local
interface of the application. To clear the list contents, you need to select Block
connection.
If the check box is selected, Kaspersky Endpoint Security blocks network
connections established over the SSL 2.0 protocol.
If the check box is cleared, Kaspersky Endpoint Security does not block network
connections established over the SSL 2.0 protocol and does not monitor network
tra ic transmitted over these connections.

Decrypt
encrypted
connections
with websites
that use EV
certi cates

EV certi cates (Extended Validation Certi cates) con rm the authenticity of
websites and enhance the security of the connection. Browsers use a lock icon in
their address bar to indicate that a website has an EV certi cate. Browsers may also
fully or partially color the address bar in green.
If the check box is selected, Kaspersky Endpoint Security decrypts and monitors
encrypted connections with websites that use an EV certi cate.
If the check box is cleared, Kaspersky Endpoint Security does not have access to the
contents of HTTPS tra ic. For this reason, the application monitors HTTPS tra ic
only based on the website address, for example, https://google.com.
If you are opening a website with an EV certi cate for the rst time, the encrypted
connection will be decrypted regardless of whether or not the check box is selected.
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Scanning encrypted connections in Firefox and Thunderbird
After installation, Kaspersky Endpoint Security adds a Kaspersky certi cate to the system storage for trusted
certi cates (Windows certi cate store). By default, Firefox and Thunderbird use their own proprietary Mozilla
certi cate store instead of the Windows certi cate store. If Kaspersky Security Center is deployed in your
organization and a policy is being applied to a computer, Kaspersky Endpoint Security automatically enables use of
the Windows certi cate store in Firefox and Thunderbird to scan the tra ic of these applications. If a policy is not
being applied to the computer, you can choose the certi cate storage that will be used by Mozilla applications. If
you selected the Mozilla certi cate store, manually add a Kaspersky certi cate to it. This will help avoid errors when
working with HTTPS tra ic.
To scan tra ic in the Mozilla Firefox browser and the Thunderbird mail client, you must enable the Encrypted
Connections Scan. If Encrypted Connections Scan is disabled, Kaspersky Endpoint Security does not scan
tra ic in the Mozilla Firefox browser and Thunderbird mail client.
Prior to adding a certi cate to the Mozilla store, export the Kaspersky certi cate from the Windows Control Panel
(browser properties). For details about exporting the Kaspersky certi cate, please refer to the Technical Support
Knowledge Base . For details about adding a certi cate to storage, visit the Mozilla technical support website .
You can choose the certi cate store only in the local interface of the application.

To choose a certi cate store for scanning encrypted connections in Firefox and Thunderbird:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Mozilla Firefox and Thunderbird block, select the Scan secure tra ic in Mozilla applications check box.
4. Select a certi cate store:
Use Windows certi cate store. The Kaspersky root certi cate is added to this store during installation of
Kaspersky Endpoint Security.
Use Mozilla certi cate store. Mozilla Firefox and Thunderbird use their own certi cate stores. If the Mozilla
certi cate store is selected, you need to manually add the Kaspersky root certi cate to this store through
the browser properties.
5. Save your changes.

Excluding encrypted connections from scanning
Most web resources use encrypted connections. Kaspersky experts recommend that you enable Encrypted
connections scan. If encrypted connections scan interferes with work-related activity, you can add a website to
exclusions referred to as trusted addresses. If a trusted application uses an encrypted connection, you can disable
encrypted connections scan for this application. For example, you can disable encrypted connections scan for
cloud storage applications that use two-factor authentication with their own certi cate.

To exclude a web address from encrypted connection scans:
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1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Encrypted connections scan section, click the Trusted addresses button.
4. Click the Add button.
5. Enter a domain name or an IP address if you do not want Kaspersky Endpoint Security to scan encrypted
connections established when visiting that domain.
Kaspersky Endpoint Security supports the * character for entering a mask in the domain name.
Kaspersky Endpoint Security does not support masks for IP addresses. You can enter a range of IP
addresses in the local application interface (for example, 198.51.100.0/24). You cannot enter a range of IP
addresses in the Kaspersky Security Center console.
Examples:
domain.com – the record is inclusive of the following addresses: https://domain.com,
https://www.domain.com, https://domain.com/page123. The record is exclusive of subdomains (for
example, subdomain.domain.com).
subdomain.domain.com – the record is inclusive of the following addresses:
https://subdomain.domain.com, https://subdomain.domain.com/page123. The record is exclusive
of the domain.com domain.
*.domain.com – the record is inclusive of the following addresses: https://movies.domain.com,
https://images.domain.com/page123. The record is exclusive of the domain.com domain.
6. Save your changes.
By default, Kaspersky Endpoint Security does not scan encrypted connections when errors occur and adds the
website to a special list of Domains with scan errors. Kaspersky Endpoint Security compiles a separate list for each
user and does not send data to Kaspersky Security Center. You can enable blocking the connection when a scan
error occurs. You can view a list of domains with encrypted connections scan errors only in the local interface of
the application.

To view the list of domains with scan errors:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Encrypted connections scan section, click the Domains with scan errors button.
A list of domains with scan errors opens. To reset the list, enable blocking connection when scan errors occur in
the policy, apply the policy, then reset the parameter to its initial value and apply the policy again.
Kaspersky specialists make a list of global exceptions — trusted websites that Kaspersky Endpoint Security does
not check regardless of the application settings.

To view the global exclusions from encrypted tra ic scans:
1. In the main application window, click the button

.
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2. In the application settings window, select Advanced settings → Network settings.
3. In the Encrypted connections scan section, click the websites link.
This opens a list of websites compiled by Kaspersky experts. Kaspersky Endpoint Security does not scan
protected connections for websites on the list. The list may be updated when Kaspersky Endpoint Security
databases and modules are updated.
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Computer control

Web Control
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
Web Control manages users' access to web resources. This helps reduce tra ic and inappropriate use of work
time. When a user tries to open a website that is restricted by Web Control, Kaspersky Endpoint Security will block
access or show a warning (see the gure below).
Kaspersky Endpoint Security monitors only HTTP- and HTTPS tra ic.
For HTTPS tra ic monitoring, you need to enable encrypted connections scan.

Methods for managing access to websites
Web Control lets you con gure access to websites by using the following methods:
Website category. Websites are categorized according to the Kaspersky Security Network cloud service,
heuristic analysis, and the database of known websites (included in application databases). For example, you
can restrict user access to the "Social networks" category or to other categories .
Data type. You can restrict users' access to data on a website, and hide graphic images, for example. Kaspersky
Endpoint Security determines the data type based on the le format and not based on its extension.
Kaspersky Endpoint Security does not scan les within archives. For example, if image les were placed in
an archive, Kaspersky Endpoint Security identi es the "Archives" data type and not "Graphic les".
Individual address. You can enter a web address or use masks.
You can simultaneously use multiple methods for regulating access to websites. For example, you can restrict
access to the "O ice les" data type just for the "Web-based mail" website category.

Website access rules
Web Control manages users' access to websites by using access rules. You can con gure the following advanced
settings for a website access rule:
Users to which the rule applies.
For example, you can restrict Internet access through a browser for all users of the company except the IT
department.
Rule schedule.
For example, you can restrict Internet access through a browser during working hours only.
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Access rule priorities
Each rule has a priority. The higher a rule is on the list, the higher its priority. If a website has been added to multiple
rules, Web Control regulates access to the website based on the rule with the highest priority. For example,
Kaspersky Endpoint Security may identify a corporate portal as a social network. To restrict access to social
networks and provide access to the corporate web portal, create two rules: one block rule for the "Social
networks" website category and one allow rule for the corporate web portal. The access rule for the corporate
web portal must have a higher priority than the access rule for social networks.

Web Control messages

Enabling and disabling Web Control
By default, Web Control is enabled.

To enable or disable Web Control:
1. In the main application window, click the button

.
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2. In the application settings window, select Security Controls → Web Control.
3. Use the Web Control toggle to enable or disable the component.
4. Save your changes.

Actions with web resource access rules
It is not recommended to create more than 1000 rules of access to web resources, as this can cause the
system to become unstable.
A web resource access rule is a set of lters and actions that Kaspersky Endpoint Security performs when the
user visits web resources that are described in the rule during the time span that is indicated in the rule schedule.
Filters allow you to precisely specify a pool of web resources to which access is controlled by the Web Control
component.
The following lters are available:
Filter by content. Web Control categorizes web resources by content and data type. You can control user
access to web resources with content and data falling into the types de ned by these categories. When the
users visit web resources that belong to the selected content category and / or data type category, Kaspersky
Endpoint Security performs the action that is speci ed in the rule.
Filter by web resource addresses. You can control user access to all web resource addresses or to individual
web resource addresses and / or groups of web resource addresses.
If ltering by content and ltering by web resource addresses are speci ed, and the speci ed web resource
addresses and / or groups of web resource addresses belong to the selected content categories or data type
categories, Kaspersky Endpoint Security does not control access to all web resources in the selected content
categories and / or data type categories. Instead, the application controls access only to the speci ed web
resource addresses and / or groups of web resource addresses.
Filter by names of users and user groups. You can specify the names of users and / or groups of users for
which access to web resources is controlled according to the rule.
Rule schedule. You can specify the rule schedule. The rule schedule determines the time span during which
Kaspersky Endpoint Security monitors access to web resources covered by the rule.
After Kaspersky Endpoint Security is installed, the list of rules of the Web Control component is not blank. Two
rules are preset:
Scripts and Stylesheets rule, which grants all users access at all times to web resources whose addresses
contain the names of les with the CSS, JS, or VBS extensions. For example: http://www.example.com/style.css,
http://www.example.com/style.css?mode=normal.
Default rule. This rule is applied to any web resources that are not covered by other rules, and allows or blocks
access to these web resources for all users.

Adding a web resource access rule
To add or edit a web resource access rule:
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1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Settings block, click the Rules of access to web resources button.
4. In the window, click the Add button.
The Rule of access to web resources window opens.
5. In the Rule name eld, enter the name of the rule.
6. Select the Active status for the web resource access rule.
You can use the toggle to disable the web resource access rule at any time.
7. In the Action block, select the relevant option:
Allow. If this value is selected, Kaspersky Endpoint Security allows access to web resources that match the
parameters of the rule.
Block. If this value is selected, Kaspersky Endpoint Security blocks access to web resources that match the
parameters of the rule.
Warn. If this value is selected, Kaspersky Endpoint Security displays a warning that a web resource is
unwanted when the user attempts to access web resources that match the rule. By using links from the
warning message, the user can obtain access to the requested web resource.
8. In the Filter content block, select the relevant content lter:
By content categories. You can control user access to web resources by category
Social networks category).

(for example, the

By types of data. You can control user access to web resources based on the speci c data type of its
published data (for example, Graphic images).
To con gure the content lter:
a. Click the Con gure link.
b. Select the check boxes next to the names of the required categories of content and/or data types.
Selecting the check box next to the name of a content category and/or data type means that Kaspersky
Endpoint Security applies the rule to control access to web resources that belong to the selected
categories of content and/or data types.
c. Return to the window for con guring the web resource access rule.
9. In the Addresses block, select the relevant web resource address lter:
To all addresses. Web Control will not lter web resources by address.
To individual addresses. Web Control will lter only web resource addresses from the list. To create a list of
web resource addresses:
a. Click the Add address or Add a group of addresses button.
b. In the opened window, create a list of web resource addresses. You can enter a web address or use
masks. You can also export a list of web resource addresses from a TXT le.
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c. Return to the window for con guring the web resource access rule.
If Encrypted Connections Scan is disabled, for the HTTPS protocol you can only lter by the server
name.
10. In the Users block, select the relevant lter for users:
To all users. Web Control will not lter web resources for speci c users.
To individual users and / or groups. Web Control will lter web resources only for speci c users. To create a
list of users to whom you want to apply the rule:
a. Click the Add button.
b. In the opened window, select the users or group of users to whom you want to apply the web resource
access rule.
c. Return to the window for con guring the web resource access rule.
11. In the Rule schedule drop-down list, select the name of the necessary schedule or generate a new schedule
based on the selected rule schedule. To do so:
a. Click the Edit or add new button.
b. In the window, click the Add button.
c. In the opened window, enter the rule schedule name.
d. Con gure the web resource access schedule for users.
e. Return to the window for con guring the web resource access rule.
12. Save your changes.

Assigning priorities to web resource access rules
You can assign priorities to each rule from the list of rules, by arranging the rules in a certain order.

To assign a priority to a web resource access rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Settings block, click the Rules of access to web resources button.
4. In the opened window, select the rule whose priority you want to change.
5. Use the Up and Down buttons to move the rule to the relevant position in the list of web resource access rules.
6. Save your changes.
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Enabling and disabling a web resource access rule
To enable or disable a web resource access rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Settings block, click the Rules of access to web resources button.
4. In opened window, select the rule that you want to enable or disable.
5. In the State column, do the following:
If you want to enable the use of the rule, select the Active value.
If you want to disable the use of the rule, select the Inactive value.
6. Save your changes.

Exporting and importing the list of trusted web addresses
You can export the list of Web Control rules to an XML le. Then you can modify the le to, for example, add a large
number of addresses of the same type. You can use the export/import function to back up the list of Web Control
rules or to migrate the list to a di erent server.
How to export and import a list of Web Control rules in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Web Control.
6. To export the list of Web Control rules:
a. Select the rules that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any rule, Kaspersky Endpoint Security will export all rules.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of rules,
and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the list of rules to the XML le.
7. To import the list of Web Control rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.
How to export and import a list of Web Control rules in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import the list of rules.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Security Controls → Web Control.
5. To export the list of rules, in the Rule List block:
a. Select the rules that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected rules, or export the entire list.
d. Click the Export button.
Kaspersky Endpoint Security exports the list of rules to an XML le in the default downloads folder.
6. To import the list of rules, in the Rule List block:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
7. Save your changes.

Testing web resource access rules
To check the consistency of Web Control rules, you can test them. For this purpose, the Web Control component
includes a Rules Diagnostics function.

To test the web resource access rules:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Settings block, click the Rules diagnostics link.
The Rules diagnostics window opens.
4. If you want to test the rules that Kaspersky Endpoint Security uses to control access to a speci c web
resource, select the Specify address check box Enter the address of the web resource in the eld below.
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5. If you want to test the rules that Kaspersky Endpoint Security uses to control access to web resources for
speci ed users and / or groups of users, specify a list of users and / or groups of users.
6. If you want to test the rules that Kaspersky Endpoint Security uses to control access to web resources of
certain content categories and/or data type categories, select the Filter content check box and choose the
relevant option from the drop-down list (By content categories, By types of data, or By content categories
and types of data).
7. If you want to test the rules with account of the time and day of the week when an attempt is made to access
the web resources that are speci ed in the rule diagnostics conditions, select the Include time of access
attempt check box. Then specify the day of the week and the time.
8. Click the Scan button.
Test completion is followed by a message with information about the action that is taken by Kaspersky Endpoint
Security, according to the rst rule that is triggered on the attempt to access the speci ed web resource (allow,
block, or warning). The rst rule to be triggered is the one with a rank on the list of Web Control rules which is
higher than that of other rules meeting the diagnostics conditions. The message is displayed on the right of the
Scan button. The following table lists the remaining triggered rules, specifying the action taken by Kaspersky
Endpoint Security. The rules are listed in the order of declining priority.

Exporting and importing the list of web resource addresses
If you have created a list of web resource addresses in a web resource access rule, you can export it to a .txt le.
You can subsequently import the list from this le to avoid creating a new list of web resource addresses manually
when con guring an access rule. The option of exporting and importing the list of web resource addresses may be
useful if, for example, you create access rules with similar parameters.

To import or export a list of web resource addresses to a le:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Settings block, click the Rules of access to web resources button.
4. Select the rule whose list of web resource addresses you want to export or import.
5. To export the list of trusted web addresses, do the following in the Addresses block:
a. Select the addresses that you want to export.
If you did not select any address, Kaspersky Endpoint Security will export all addresses.
b. Click the Export button.
c. In the opened window, enter the name of the TXT le to which you want to export the list of web resource
addresses, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the list of web resource addresses to a TXT le.
6. To import the list of web resources, do the following in the Addresses block:
a. Click the Import button.
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In the window that opens, select the TXT le from which you want to import the list of web resources.
b. Click the Open button.
If the computer already has a list of addresses, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the TXT le.
7. Save your changes.

Monitoring user Internet activity
Kaspersky Endpoint Security lets you log data on user visits to all websites, including allowed websites. This
enables you to obtain the complete history of browser views. Kaspersky Endpoint Security sends user activity
events to Kaspersky Security Center, to the local log of Kaspersky Endpoint Security, and to the Windows Event
log. To receive events in Kaspersky Security Center, you need to con gure the settings of events in a policy in the
Administration Console or Web Console. You can also con gure the transmission of Web Control events by email
and the display of on-screen noti cations on the user's computer.
Kaspersky Endpoint Security creates the following user Internet activity events:
Block the website (Critical events status ).
Visit to a non-recommended website (Warnings status

).

Visit to an allowed website (Informational messages status ).
Prior to enabling user Internet activity monitoring, you must do the following:
Inject a web page interaction script into web tra ic (see the instructions below). The script enables registration
of Web Control events.
For HTTPS tra ic monitoring, you need to enable encrypted connections scan.

To inject a web page interaction script into web tra ic:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. Under Tra ic processing, select the Inject script into web tra ic to interact with web pages check box.
4. Save your changes.
As a result, Kaspersky Endpoint Security will inject a web page interaction script into web tra ic. This script
enables registration of Web Control events for the application event log, OS event log, and reports.

To con gure logging of Web Control events on the user's computer:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. Under Noti cations, click Noti cation settings.
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4. In the opened window, select the Web Control section.
This opens the table of Web Control events and noti cation methods.
5. Con gure the noti cation method for each event: Save in local report or Save in Windows Event Log.
To log allowed website visit events, you need to also con gure Web Control (see the instructions below).
In the events table, you can also enable an on-screen noti cation and an email noti cation. To send
noti cations by email, you need to con gure the SMTP server settings. For more details about sending
noti cations by email, please refer to the Kaspersky Security Center Help .
6. Save your changes.
As a result, Kaspersky Endpoint Security begins logging user Internet activity events.
Web Control sends user activity events to Kaspersky Security Center as follows:
If you are using Kaspersky Security Center, Web Control sends events for all the objects that make up the web
page. For this reason, multiple events may be created when one web page is blocked. For example, when
blocking the web page http://www.example.com, Kaspersky Endpoint Security may relay events for the
following objects: http://www.example.com, http://www.example.com/icon.ico, http://www.example.com/ le.js,
etc.
If you are using the Kaspersky Security Center Cloud Console, Web Control groups events and sends only the
protocol and domain of the website. For instance, if a user visits non-recommended web pages
http://www.example.com/main, http://www.example.com/contact, and http://www.example.com/gallery,
Kaspersky Endpoint Security will send only one event with the http://www.example.com object.
Kaspersky Endpoint Security 11.7.0 does not support sending events to Kaspersky Security Center when
allowed websites are visited. You can turn on the option to save such events in the report. The report is only
available in the local interface of the application.

To enable logging of events for visiting allowed websites:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Additional block, click the Advanced settings button.
4. In the opened window, select the Log the opening of allowed pages check box.
5. Save your changes.
As a result, you will be able to view the full browser history.

Editing templates of Web Control messages
Depending on the type of action that is speci ed in the properties of Web Control rules, Kaspersky Endpoint
Security displays a message of one of the following types when users attempt to access Internet resources (the
application substitutes an HTML page with a message for the HTTP server response):
Warning message. This message warns the user that visiting the web resource is not recommended and/or
violates the corporate security policy. Kaspersky Endpoint Security displays a warning message if the Warn
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option is selected from the Action drop-down list in the settings of the rule that describes this web resource.
If the user believes that the warning is mistaken, the user may click the link from the warning to send a pregenerated message to the local corporate network administrator.
Message informing of blocking of a web resource. Kaspersky Endpoint Security displays a message informing
that a web resource is blocked if the Block option is selected from the Action drop-down list in the settings of
the rule that describes this web resource.
If the user believes that the web resource is blocked by mistake, the user may click the link in the web resource
block noti cation message to send a pre-generated message to the local corporate network administrator.
Special templates are provided for the warning message, the message informing that a web resource is blocked,
and the message sent to the LAN administrator. You can modify their content.

To change the template for Web Control messages:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Web Control.
3. In the Templates block, con gure the templates for Web Control messages:
Warning. The entry eld consists of a template of the message that is displayed if a rule for warning about
attempts to access an unwanted web resource is triggered.
Message about blocking. The entry eld contains the template of the message that appears if a rule which
blocks access to a web resource is triggered.
Message to administrator. The entry eld contains the template of the message to be sent to the LAN
administrator if the user considers the block to be a mistake.
4. Save your changes.

Editing masks for web resource addresses
Using a web resource address mask (also referred to as "address mask") may be useful if you need to enter
numerous similar web resource addresses when creating a web resource access rule. If crafted well, one address
mask can replace a large number of web resource addresses.
When creating an address mask, follow these rules:
1. The * character replaces any sequence that contains zero or more characters.
For example, if you enter the *abc* address mask, the access rule is applied to all web resources that contain
the sequence abc. Example: http://www.example.com/page_0-9abcdef.html.
2. A sequence of *. characters (known as a domain mask) lets you select all domains of an address. The *.
domain mask represents any domain name, subdomain name, or a blank line.
Example: the *.example.com mask represents the following addresses:
http://pictures.example.com. The domain mask *. represents pictures.
http://user.pictures.example.com. The domain mask *. represents pictures. and user.
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http://example.com. The domain mask *. is interpreted as a blank line.
3. The www. character sequence at the start of the address mask is interpreted as a *. sequence.
Example: the address mask www.example.com is interpreted as *.example.com. This mask covers the
addresses www2.example.com and www.pictures.example.com.
4. If an address mask does not start with the * character, the content of the address mask is equivalent to the
same content with the *. pre x.
5. If an address mask ends with a character other than / or *, the content of the address mask is equivalent to
the same content with the /* post x.
Example: the address mask http://www.example.com covers such addresses as
http://www.example.com/abc, where a, b, and c are any characters.
6. If an address mask ends with the / character, the content of the address mask is equivalent to the same
content with the /*. post x.
7. The character sequence /* at the end of an address mask is interpreted as /* or an empty string.
8. Web resource addresses are veri ed against an address mask, taking into account the protocol (http or https):
If the address mask contains no network protocol, this address mask covers addresses with any network
protocol.
Example: the address mask example.com covers the addresses http://example.com and
https://example.com.
If the address mask contains a network protocol, this address mask only covers addresses with the same
network protocol as that of the address mask.
Example: the address mask http://*.example.com covers the address http://www.example.com but
does not cover https://www.example.com.
9. An address mask that is in double quotes is treated without considering any additional replacements, except
the * character if it has been initially included in the address mask. Rules 5 and 7 do not apply to address masks
enclosed in double quotation marks (see examples 14 – 18 in the table below).
10. The user name and password, connection port, and character case are not taken into account during
comparison with the address mask of a web resource.
Examples of how to use rules for creating address masks

No.

Address mask

Address of web resource to
verify

Is the
address
covered by
the
address
mask

Comment

1

*.example.com

http://www.123example.com

No

See rule 1.

2

*.example.com

http://www.123.example.com

Yes

See rule 2.

3

*example.com

http://www.123example.com

Yes

See rule 1.

4

*example.com

http://www.123.example.com

Yes

See rule 1.

5

http://www.*.example.com

http://www.123example.com

No

See rule 1.
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6

www.example.com

http://www.example.com

Yes

See rules 3, 2, 1.

7

www.example.com

https://www.example.com

Yes

See rules 3, 2, 1.

8

http://www.*.example.com

http://123.example.com

Yes

See rules 3, 4, 1.

9

www.example.com

http://www.example.com/abc Yes

See rules 3, 5, 1.

10

example.com

http://www.example.com

Yes

See rules 3, 1.

11

http://example.com/

http://example.com/abc

Yes

See rule 6.

12

http://example.com/*

http://example.com

Yes

See rule 7.

13

http://example.com

https://example.com

No

See rule 8.

14

"example.com"

http://www.example.com

No

See rule 9.

15

"http://www.example.com"

http://www.example.com/abc No

See rule 9.

16

"*.example.com"

http://www.example.com

Yes

See rules 1, 9.

17

"http://www.example.com/*"

http://www.example.com/abc Yes

See rules 1, 9.

18

"www.example.com"

http://www.example.com;
https://www.example.com

See rules 9, 8.

19

www.example.com/abc/123

http://www.example.com/abc No

Yes

An address
mask contains more
information than the
address of a web
resource.

Migrating web resource access rules from previous versions of the
application
When Kaspersky Endpoint Security 10 Service Pack 2 for Windows or an earlier version of the application is
upgraded to Kaspersky Endpoint Security for Windows 11.7.0, the web resource access rules based on web
resource content categories are migrated as follows:
Rules of access to web resources that are based on one or several web resource content categories from the
"Chats and forums", "Web-based mail", and "Social networks" lists migrate to the "Internet communication" web
resource content category.
Rules of access to web resources based on one or several web resource content categories from the "Estores" and "Payment systems" lists migrate to the "Online stores, banks, payment systems" web resource
content category.
Rules of access to web resources based on the "Gambling" web resource content category migrate to the
"Gambling, lotteries, sweepstakes" content category.
Rules of access to web resources based on the "Browser games" web resource content category migrate to
the "Computer games" content category.
Rules of access to web resources based on web resource content categories that are not enumerated in the
list above are migrated without changes.
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Device Control
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
Device Control manages user access to devices that are installed on or connected to the computer (for example,
hard drives, cameras, or Wi-Fi modules). This lets you protect the computer from infection when such devices are
connected, and prevent loss or leaks of data.

Device access levels
Device Control controls access at the following levels:
Device type. For example, printers, removable drives, and CD/DVD drives.
You can con gure device access as follows:
Allow – .
Block – .
Depends on connection bus (except for Wi-Fi) – .
Block with exceptions (Wi-Fi only) – .
Connection bus. A connection bus is an interface used for connecting devices to the computer (for example,
USB or FireWire). Therefore, you can restrict the connection of all devices, for example, over USB.
You can con gure device access as follows:
Allow – .
Block – .
Trusted devices. Trusted devices are devices to which users that are speci ed in the trusted device settings
have full access at all times.
You can add trusted devices based on the following data:
Devices by ID. Each device has a unique identi er (Hardware ID, or HWID). You can view the ID in the device
properties by using operating system tools. Example device ID:
SCSI\CDROM&VEN_NECVMWAR&PROD_VMWARE_SATA_CD00\5&354AE4D7&0&000000. Adding devices by ID is
convenient if you want to add several speci c devices.
Devices by model. Each device has a vendor ID (VID) and a product ID (PID). You can view the IDs in the
device properties by using operating system tools. Template for entering the VID and PID:
VID_1234&PID_5678. Adding devices by model is convenient if you use devices of a certain model in your
organization. This way, you can add all devices of this model.
Devices by ID mask. If you are using multiple devices with similar IDs, you can add devices to the trusted list
by using masks. The * character replaces any set of characters. Kaspersky Endpoint Security does not
support the ? character when entering a mask. For example, WDC_C*.
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Devices by model mask. If you are using multiple devices with similar VIDs or PIDs (for example, devices
from the same manufacturer), you can add devices to the trusted list by using masks. The * character
replaces any set of characters. Kaspersky Endpoint Security does not support the ? character when
entering a mask. For example, VID_05AC & PID_ *.
Device Control regulates user access to devices by using access rules. Device Control also lets you save device
connection/disconnection events. To save events, you need to con gure the registration of events in a policy.
If access to a device depends on the connection bus (the status), Kaspersky Endpoint Security does not
save device connection/disconnection events. To enable Kaspersky Endpoint Security to save device
connection/disconnection events, allow access to the corresponding type of device (the status) or add the
device to the trusted list.
When a device that is blocked by Device Control is connected to the computer, Kaspersky Endpoint Security will
block access and show a noti cation (see the gure below).

Device Control noti cation

Device Control operating algorithm
Kaspersky Endpoint Security makes a decision on whether to allow access to a device after the user connects the
device to the computer (see the gure below).
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Device Control operating algorithm

If a device is connected and access is allowed, you can edit the access rule and block access. In this case, the next
time someone attempts to access the device (such as to view the folder tree, or perform read or write
operations), Kaspersky Endpoint Security blocks access. A device without a le system is blocked only the next
time that the device is connected.
If a user of the computer with Kaspersky Endpoint Security installed must request access to a device that the user
believes was blocked by mistake, send the user the request access instructions.

Enabling and disabling Device Control
By default, Device Control is enabled.

To enable or disable Device Control:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
275

3. Use the Device Control toggle to enable or disable the component.
4. Save your changes.
As a result, if Device Control is enabled, the application relays information about connected devices to
Kaspersky Security Center. You can view the list of connected devices in Kaspersky Security Center in the
Hardware folder.

About access rules
Access rules comprise a group of settings that determine which users can access devices that are installed or
connected to the computer. You cannot add a device that is outside of Device Control classi cation. Access to
such devices is allowed for all users.

Device Access Rules
The group of settings for an access rule di ers depending on the type of device (see the table below).
Access rule settings

Devices

Access
control

Schedule for
access to a device

Assignment of users
and/or a group of users

Priority

Read/write
permission

–

–

–

–

Modems

–

–

–

–

Tape devices

–

–

–

–

Multifunctional
devices

–

–

–

–

Smart card readers

–

–

–

–

Windows CE USB
ActiveSync devices

–

–

–

–

External network
adapters

–

–

–

–

Bluetooth

–

–

–

–

Cameras and
scanners

–

–

–

–

Hard drives
Removable drives
Printers
Floppy disks
CD/DVD drives

Portable devices
(MTP)
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Mobile device access rules
Mobile devices running Android or iOS are categorized as portable devices (MTP). When a mobile device is
connected to the computer, the operating system determines the device type. If Android Debug Bridge (ADB),
iTunes or their equivalent applications are installed on the computer, the operating system identi es mobile
devices as ADB or iTunes devices. In all other cases, the operating system may identify the mobile device type as a
portable device (MTP) for le transfer, a PTP device (camera) for image transfer, or another device. The device
type depends on the model of the mobile device.
Please note the following special considerations regarding access to ADB- or iTunes devices:
You cannot con gure a device access schedule. If access to devices is restricted by rules (they have the
status), ADB- and iTunes devices are always accessible.
You cannot con gure device access for individual users, or con gure access permissions (read/write). If access
to devices is restricted by rules (they have the status), ADB- and iTunes devices are accessible to all users
with all permissions.
You cannot con gure access to trusted ADB- or iTunes devices for individual users. If the device is trusted,
ADB- and iTunes devices are accessible to all users.
If you installed the ADB or iTunes applications after connecting a device to the computer, the unique ID of the
device may be reset. This means that Kaspersky Endpoint Security will identify this device as a new device. If a
device is trusted, add the device to the trusted list again.
By default, access rules grant all users full access to the devices at all times, if access to the connection buses for
the corresponding types of devices is allowed (the status).

Access rules for Wi-Fi networks
A Wi-Fi network access rule determines whether the use of Wi-Fi networks is allowed (the status) or forbidden
(the status). You can add a trusted Wi-Fi network (the status) to a rule. Use of a trusted Wi-Fi network is
allowed without limitations. By default, a Wi-Fi network access rule allows access to any Wi-Fi network.

Connection bus access rules
Connection bus access rules determine whether the connection of devices is allowed (the status) or forbidden
(the status). Rules that allow access to buses are created by default for all connection buses that are present in
the classi cation of the Device Control component.

Editing a device access rule
A device access rule is a group of settings that determine how users can access devices that are installed or
connected to the computer. These settings include access to a speci c device, an access schedule, and read or
write permissions.

To edit a device access rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
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3. In the Access settings block, click the Devices and Wi-Fi networks button.
The opened window shows access rules for all devices that are included in the Device Control component
classi cation.
4. In the Access to storage devices block, select the access rule that you want to edit. The block contains
devices that have a le system for which you can con gure additional access settings. By default, a device
access rule grants all users full access to the speci ed type of devices at any time.
a. In the Access block, select the appropriate device access option:
Allow.
Block.
Depends on connection bus.
To block or allow access to a device, con gure access to the connection bus.
Restrict by rules.
This option lets you con gure user rights, permissions, and a schedule for device access.
b. In the Users' rights block, click the Add button.
This opens a window for adding a new device access rule.
c. Assign a priority to the rule. A rule includes the following attributes: user account, schedule, permissions
(read/write), and priority.
A rule has a speci c priority. If a user has been added to multiple groups, Kaspersky Endpoint Security
regulates device access based on the rule with the highest priority. Kaspersky Endpoint Security allows to
assign priority from 0 to 10,000. The higher the value, the higher the priority. In other words, an entry with the
value of 0 has the lowest priority.
For example, you can grant read-only permissions to the Everyone group and grant read/write permissions
to the administrators group. To do so, assign a priority of 1 for the administrators group and assign a priority
of 0 for the Everyone group.
The priority of a block rule is higher than the priority of an allow rule. In other words, if a user has been added
to multiple groups and the priority of all rules are the same, Kaspersky Endpoint Security regulates device
access based on any existing block rule.
d. Set the Enabled status for the device access rule.
e. Con gure users' device access permissions: read and/or write.
f. Select the users or group of users to whom you want to apply the device access rule.
g. Con gure a device access schedule for users.
h. Click the Add button.
5. In the Access to external devices block, select the rule and con gure access: Allow, Deny, or Depends on
connection bus. If necessary, con gure access to the connection bus.
6. In the Access to Wi-Fi networks block, click the Wi-Fi link and con gure access: Allow, Block, or Block with
exceptions. If necessary, add Wi-Fi networks to the trusted list.
7. Save your changes.
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Editing a connection bus access rule
To edit a connection bus access rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Connection buses.
The opened window shows access rules for all connection buses that are included in the Device Control
component classi cation.
4. Select the access rule that you want to edit.
5. In the Access column, select whether or not to allow access to the connection bus: Allow or Deny.
6. Save your changes.

Adding a Wi-Fi network to the trusted list
You can allow users connect to Wi-Fi networks that you consider to be secure, such as a corporate Wi-Fi network.
To do so, you must add the network to the list of trusted Wi-Fi networks. Device Control will block access to all WiFi networks except those speci ed in the trusted list.

To add a Wi-Fi network to the trusted list:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. In the Access settings block, click the Devices and Wi-Fi networks button.
The opened window shows access rules for all devices that are included in the Device Control component
classi cation.
4. In the Access to Wi-Fi networks block, click the Wi-Fi link.
The opened window shows the Wi-Fi network access rules.
5. In the Access column, select Block with exceptions.
6. Under Trusted Wi-Fi networks, click Add.
7. In the opened window, do the following:
a. In the Network name eld, specify the name of the Wi-Fi network that you want to add to the trusted list.
b. In the Authentication type drop-down list, select the type of authentication used when connecting to the
trusted Wi-Fi network.
c. In the Encryption type drop-down list, select the type of encryption used for securing tra ic of the trusted
Wi-Fi network.
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d. In the Comment eld, you can specify any information about the added Wi-Fi network.
A Wi-Fi network is considered trusted if its settings match all settings speci ed in the rule.
8. Save your changes.

Monitoring usage of removable drives
Monitoring usage of removable drives includes:
Monitoring operations on les on removable drives.
Monitoring connection and disconnection of trusted removable drives.
Kaspersky Endpoint Security allows monitoring connection and disconnection of all trusted devices and not
only removable drives. You can turn on event logging in noti cation settings for the Device Control component.
Events have the Informational message severity level.

To enable monitoring of removable drive usage:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. In the Access settings block, click the Devices and Wi-Fi networks button.
The opened window shows access rules for all devices that are included in the Device Control component
classi cation.
4. In the Access to storage devices block, select Removable drives.
5. Click the Logging link.
6. In the opened window, select the Logging tab.
7. Turn on the Logging toggle.
8. Under File operations, select the operations that you want to monitor: Write, Delete.
9. In the Filter by le formats block, select the formats of les whose associated operations should be logged by
Device Control.
10. Select the users or group of users whose use of removable drives you want to monitor.
11. Save your changes.
As a result, when users write to les located on removable drives or delete les from removable drives,
Kaspersky Endpoint Security will save information about such operations to the event log and send events to
Kaspersky Security Center. You can view events associated with les on removable drives in the Kaspersky
Security Center Administration Console in the workspace of the Administration Server node on the Events tab.
For events to be displayed in the local Kaspersky Endpoint Security event log, you must select the File
operation performed check box in the noti cation settings for the Device Control component.
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Changing the caching duration
The Device Control component registers events related to monitored devices, such as connection and
disconnection of a device, reading a le from a device, writing a le to a device, and other events. Device Control
then either allows or blocks the action according to the Kaspersky Endpoint Security settings.
Device Control saves information about events for a speci c period of time called the caching period. If
information about an event is cached and this event is repeated, there is no need to notify Kaspersky Endpoint
Security about it or to show another prompt for granting access to the corresponding action, such as connecting
a device. This makes it more convenient to work with a device.
An event is considered a duplicate event if all of the following event settings match the record in the cache:
device ID
SID of the user account attempting access
Device category
Action taken with the device
Application permission verdict for this action: allowed or denied
Path to the process used to take the action
File that is being accessed
Prior to changing the caching period, disable Kaspersky Endpoint Security Self-Defense. After changing the
caching period, enable Self-Defense.

To change the caching period:
1. Open the registry editor on the computer.
2. In the registry editor, go to the following section:
For 64-bit operating systems:
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\KasperskyLab\protected\KES\environment]
For 32-bit operating systems:
[HKEY_LOCAL_MACHINE\SOFTWARE\KasperskyLab\protected\KES\environment]
3. Open DeviceControlEventsCachePeriod for editing.
4. De ne the number of minutes that Device Control must save information about an event before this
information is deleted.

Actions with trusted devices
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Trusted devices are devices to which users that are speci ed in the trusted device settings have full access at all
times.
To work with trusted devices, you can grant access to an individual user, to a group of users, or to all users of the
organization.
For example, if your organization does not allow the use of removable drives but administrators use removable
drives in their work, you can allow removable drives only for a group of administrators. To do so, add removable
drives to the trusted list and con gure user access permissions.
Kaspersky Endpoint Security allows you to add a device to the trusted list in the following ways:
If Kaspersky Security Center is not deployed in your organization, you can connect the device to the computer
and add it to the trusted list in the application settings. To distribute the list of trusted devices to all computers
in your organization, you can enable merging the lists of trusted devices in a policy or use the export / import
procedure.
If Kaspersky Security Center is deployed in your organization, you can detect all connected devices remotely
and create a list of trusted devices in the policy. The list of trusted devices will be available on all computers to
which the policy is applied.
Kaspersky Endpoint Security allows controlling the use of trusted devices (connection and disconnection). You can
turn on event logging in noti cation settings for the Device Control component. Events have the Informational
severity level.
Kaspersky Endpoint Security has the following limitations when working with trusted devices:
Kaspersky Endpoint Security administration plug-in versions 11.0.0–11.2.0 cannot work with a list of trusted
devices that was created in Kaspersky Endpoint Security version 11.3.0 and 11.4.0. To work with a list of trusted
devices from these versions, the administration plug-in must be upgraded to version 11.3.0 and 11.4.0,
respectively.
Kaspersky Endpoint Security administration plug-in version 11.3.0 and 11.4.0 cannot work with a list of trusted
devices that was created in Kaspersky Endpoint Security version 11.2.0 or earlier. For these versions to work with
a list of trusted devices, the application must be upgraded to version 11.3.0 and 11.4.0, respectively. You can also
send a request containing a description of your situation to Technical Support through Kaspersky
CompanyAccount .
To migrate a list of trusted devices from Kaspersky Endpoint Security version 11.2.0 to version 11.3.0, send a
request containing a description of your situation to Technical Support through Kaspersky CompanyAccount .

Adding a device to the Trusted list from the application interface
By default, when a device is added to the list of trusted devices, access to the device is granted to all users (the
Everyone group of users).

To add a device to the Trusted list from the application interface:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Trusted devices.
This opens the list of trusted devices.
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4. Click the Select button.
This opens the list of connected devices. The list of devices depends on the value that is selected in the
Display connected devices drop-down list.
5. In the list of devices, select the device that you want to add to the trusted list.
6. In the Comment eld, you can provide any relevant information about the trusted device.
7. Select the users or group of users for whom you want to allow access to trusted devices.
8. Save your changes.

Adding a device to the Trusted list from Kaspersky Security Center
Kaspersky Security Center receives information about devices if Kaspersky Endpoint Security is installed on the
computers and Device Control is enabled. It is not possible to add a device to the trusted list unless information
about that device is available in Kaspersky Security Center.
You can add a device to the trusted list according to the following data:
Devices by ID. Each device has a unique identi er (Hardware ID, or HWID). You can view the ID in the device
properties by using operating system tools. Example device ID:
SCSI\CDROM&VEN_NECVMWAR&PROD_VMWARE_SATA_CD00\5&354AE4D7&0&000000. Adding devices by ID is
convenient if you want to add several speci c devices.
Devices by model. Each device has a vendor ID (VID) and a product ID (PID). You can view the IDs in the device
properties by using operating system tools. Template for entering the VID and PID: VID_1234&PID_5678.
Adding devices by model is convenient if you use devices of a certain model in your organization. This way, you
can add all devices of this model.
Devices by ID mask. If you are using multiple devices with similar IDs, you can add devices to the trusted list by
using masks. The * character replaces any set of characters. Kaspersky Endpoint Security does not support
the ? character when entering a mask. For example, WDC_C*.
Devices by model mask. If you are using multiple devices with similar VIDs or PIDs (for example, devices from
the same manufacturer), you can add devices to the trusted list by using masks. The * character replaces any
set of characters. Kaspersky Endpoint Security does not support the ? character when entering a mask. For
example, VID_05AC & PID_ *.

To add devices to the list of trusted devices:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Device Control.
6. In the right part of the window, select the Trusted devices tab.
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7. Select the Merge values when inheriting check box if you want to create a consolidated list of trusted devices
for all computers in the company.
The lists of trusted devices in the parent and child policies will be merged. The lists will be merged provided that
merging values when inheriting is enabled. Trusted devices from the parent policy are displayed in child policies
in a read-only view. Changing or deleting trusted devices of the parent policy is not possible.
8. Click the Add button and select a method for adding a device to the trusted list.
9. To lter devices, select a device type from the Device type drop-down list (for example, Removable Drives).
10. In the Name / Model eld, enter the device ID, model (VID and PID) or mask, depending on the selected addition
method.
Adding devices by model mask (VID and PID) works as follows: if you enter a model mask that does not
match any model, Kaspersky Endpoint Security checks if the device ID (HWID) matches the mask.
Kaspersky Endpoint Security checks only the part of the device ID that determines the manufacturer and
the type of the device
(SCSI\ CDROM&VEN_NECVMWAR&PROD_VMWARE_SATA_CD00\5&354AE4D7&0&000000). If the model mask
matches this part of the device ID, the devices that match the mask will be added to the list of trusted
devices on the computer. At the same time, the list of devices in Kaspersky Security Center remains empty
when you click the Refresh button. To display the list of devices correctly, you can add devices by device
ID mask.
11. To lter devices, in the Computer eld, enter the computer name or a mask for the name of the computer to
which the device is connected.
The * character replaces any set of characters. The ? character replaces any single character.
12. Click the Refresh button.
The table displays a list of devices that satisfy the de ned ltering criteria.
13. Select the check boxes next to the names of devices that you want to add to the trusted list.
14. In the Comment eld, enter a description of the reason for adding devices to the trusted list.
15. Click the Select button to the right of the Allow to users and / or groups of users eld.
16. Select a user or a group in Active Directory and con rm your selection.
By default, access to trusted devices is allowed for the Everyone group.
17. Save your changes.
When a device is connected, Kaspersky Endpoint Security checks the list of trusted devices for an authorized
user. If the device is trusted, Kaspersky Endpoint Security allows access to the device with all permissions, even
if access to the device type or connection bus is denied. If the device is untrusted and access is denied, you can
request access to the locked device.

Exporting and importing the list of trusted devices
To distribute the list of trusted devices to all computers in your organization, you can use the export/import
procedure.
For example, if you need to distribute a list of trusted removable drives, you need to do the following:
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1. Sequentially connect removable drives to your computer.
2. In the Kaspersky Endpoint Security settings, add the removable drives to the trusted list. If required, con gure
user access permissions. For example, allow only administrators to access removable drives.
3. Export the list of trusted devices in the Kaspersky Endpoint Security settings (see the instructions below).
4. Distribute the trusted device list le to other computers in your organization. For example, place the le in a
shared folder.
5. Import the list of trusted devices in the Kaspersky Endpoint Security settings on other computers in the
organization (see the instructions below).

To import or export the list of trusted devices:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Trusted devices.
This opens the list of trusted devices.
4. To export the list of trusted devices:
a. Select the trusted devices that you want to export.
b. Click the Export button.
c. In the window that opens, specify the name of the XML le to which you want to export the list of trusted
devices, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of trusted devices to the XML le.
5. To import the list of trusted devices:
a. In the Import drop-down list, select the relevant action: Import and add to existing or Import and replace
existing.
b. In the window that opens, select the XML le from which you want to import the list of trusted devices.
c. Click the Open button.
If the computer already has a list of trusted devices, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
6. Save your changes.
When a device is connected, Kaspersky Endpoint Security checks the list of trusted devices for an authorized
user. If the device is trusted, Kaspersky Endpoint Security allows access to the device with all permissions, even
if access to the device type or connection bus is denied.

Obtaining access to a blocked device
When con guring Device Control, you can accidentally block access to a device that is necessary for work.
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If Kaspersky Security Center is not deployed in your organization, you can provide access to a device in the
settings of Kaspersky Endpoint Security. For example, you can add the device to the trusted list or temporarily
disable Device Control.
If Kaspersky Security Center is deployed in your organization and a policy has been applied to computers, you can
provide access to a device in the Administration Console.

Online mode for granting access
You can grant access to a blocked device in online mode only if Kaspersky Security Center is deployed in the
organization and a policy has been applied to the computer. The computer must have the capability to
establish a connection with the Administration Server.
Granting access in online mode consists of the following steps:
1. The user sends the administrator a message containing an access request.
2. The administrator adds the device to the trusted list.
You can add a trusted device in a policy for the administration group or in the local application settings for an
individual computer.
3. The administrator updates the settings of Kaspersky Endpoint Security on the user's computer.

Schematic for granting access to a device in online mode

O line mode for granting access
You can grant access to a blocked device in o line mode only if Kaspersky Security Center is deployed in the
organization and a policy has been applied to the computer. In the policy settings, in the Device Control
section, the Allow requests for temporary access check box must be selected.
If you need to grant temporary access to a blocked device but you cannot add the device to the trusted list, you
can grant access to the device in o line mode. This way, you can grant access to a blocked device even if the
computer does not have network access or if the computer is outside of the corporate network.
Granting access in o line mode consists of the following steps:
1. The user creates a request access le and sends it to the administrator.
2. The administrator creates an access key from the request access le and sends it to the user.
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3. The user activates the access key.

Schematic for granting access to a device in o line mode

Online mode for granting access
You can grant access to a blocked device in online mode only if Kaspersky Security Center is deployed in the
organization and a policy has been applied to the computer. The computer must have the capability to
establish a connection with the Administration Server.

A user requests access to a blocked device as follows:
1. Connect the device to the computer.
Kaspersky Endpoint Security will show a noti cation stating that access to the device is blocked (see the gure
below).
2. Click Access request.
This opens the Message to administrator window. This message contains information about the blocked
device.
3. Click the Send button.
The administrator will receive a message containing a request to provide access, for example, by email. For more
details about processing the requests of users, please refer to the Kaspersky Security Center Help . After
adding the device to the trusted list and updating Kaspersky Endpoint Security settings on the computer, the
user will receive access to the device.

Device Control noti cation
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O line mode for granting access
You can grant access to a blocked device in o line mode only if Kaspersky Security Center is deployed in the
organization and a policy has been applied to the computer. In the policy settings, in the Device Control
section, the Allow requests for temporary access check box must be selected.

A user requests access to a blocked device as follows:
1. Connect the device to the computer.
Kaspersky Endpoint Security will show a noti cation stating that access to the device is blocked (see the gure
below).
2. Click the Request temporary access link.
The Request access to device window opens with a list of connected devices.
3. In the list of connected devices, select the device to which you want to gain access.
4. Click the Generate request access le button.
5. In the Access duration eld, specify the period of time for which you want to have access to the device.
6. Save the le to computer memory.
As a result, a request access le with the *.akey extension will be downloaded to computer memory. Use any
available method to send the device request access le to the corporate LAN administrator.

Device Control noti cation

The administrator creates an access key for a blocked device as follows:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder of the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computer belongs.
3. In the workspace, select the Devices tab.
4. In the list of client computers, select the computer whose user needs to be granted temporary access to a
locked device.
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5. In the context menu of the computer, select Grant access in o line mode.
6. In the opened window, select the Device Control tab.
7. Click the Browse button and download the request access le received from the user.
You will see information about the blocked device to which the user has requested access.
8. If necessary, change the value of the Access duration setting.
By default, the Access duration setting takes the value that was indicated by the user when creating the
access request le.
9. Specify the value of the Activate by setting.
This setting de nes the time period during which the user can activate access to the blocked device by using
the provided access key.
10. Save the access key le to computer memory.
As a result, the blocked device access key will be downloaded to computer memory. An access key le has the
*.acode extension. Use any available method to send the blocked device access key to the user.

The user activates the access key as follows:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. In the Access request block, click the Request access to device button.
4. In the opened window, click the Activate access key button.
5. In the opened window, select the le with the device access key received from the corporate LAN
administrator. Click the Open button.
This opens a window containing information about access provision.
6. Click OK.
As a result, the user receives access to the device for the time period set by the administrator. The user
receives the full set of rights for accessing the device (read and write). When the key expires, access to the
device will be blocked. If the user requires permanent access to the device, add the device to the trusted list.

Editing templates of Device Control messages
When the user attempts to access a blocked device, Kaspersky Endpoint Security displays a message stating that
access to the device is blocked or that an operation with the device contents is forbidden. If the user believes that
access to the device was mistakenly blocked or that an operation with device contents was forbidden by mistake,
the user can send a message to the local corporate network administrator by clicking the link in the displayed
message about the blocked action.
Templates are available for messages about blocked access to devices or forbidden operations with device
contents, and for the message sent to the administrator. You can modify the message templates.

To edit the templates for Device Control messages:
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1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Message templates, con gure templates for Device Control messages:
Message about blocking. Template of the message that appears when a user attempts to access a blocked
device. This message also appears when a user attempts to perform an operation on the device contents
that was blocked for this user.
Message to administrator. A template of the message that is sent to the LAN administrator when the user
believes that access to the device is blocked or an operation with device content is forbidden by mistake.
4. Save your changes.

Anti-Bridging
Anti-Bridging inhibits the creation of network bridges by preventing the simultaneous establishment of multiple
network connections for a computer. This lets you protect a corporate network from attacks over unprotected,
unauthorized networks.
Anti-Bridging regulates the establishment of network connections by using connection rules.
Connection rules are created for the following prede ned types of devices:
Network adapters;
Wi-Fi adapters;
Modems.
If a connection rule is enabled, Kaspersky Endpoint Security:
Blocks the active connection when establishing a new connection, if the device type speci ed in the rule is
used for both connections;
Blocks connections that are established using the types of devices for which lower-priority rules are used.

Enabling Anti-Bridging
Anti-Bridging is disabled by default.

To enable Anti-Bridging:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Anti-Bridging.
4. Use the Enable Anti-Bridging toggle to enable or disable this feature.
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5. Save your changes.
After Anti-Bridging is enabled, Kaspersky Endpoint Security blocks already established connections according
to the connection rules.

Changing the status of a connection rule
To change the status of a connection rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Anti-Bridging.
4. In the Rules for devices block, select the rule whose status you want to change.
5. Use the toggles in the Control column to enable or disable the rule.
6. Save your changes.

Change the priority of a connection rule
To change the priority of a connection rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Device Control.
3. Under Access settings, click Anti-Bridging.
4. In the Rules for devices block, select the rule whose priority you want to change.
5. Use the Up / Down buttons to set the priority of the connection rule.
The higher a rule is positioned in the table of rules, the higher its priority. Anti-Bridging blocks all connections
except one connection established using the type of device for which the highest-priority rule is used.
6. Save your changes.

Adaptive Anomaly Control
This component is available only for Kaspersky Endpoint Security for Business Advanced and Kaspersky Total
Security for Business. For more details about Kaspersky Endpoint Security for Business, please visit the
Kaspersky website .
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This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
The Adaptive Anomaly Control component monitors and blocks actions that are not typical of the computers in a
company's network. Adaptive Anomaly Control uses a set of rules to track uncharacteristic behavior (for example,
the Start of Microsoft PowerShell from o ice application rule). Rules are created by Kaspersky specialists based
on typical scenarios of malicious activity. You can con gure how Adaptive Anomaly Control handles each rule and,
for example, allow the execution of PowerShell scripts that automate certain work ow tasks. Kaspersky Endpoint
Security updates the set of rules along with the application databases. Updates to the sets of rules must be
con rmed manually.

Adaptive Anomaly Control settings
Con guring Adaptive anomaly control consists of the following steps:
1. Training Adaptive Anomaly Control.
After you enable Adaptive Anomaly Control, its rules work in training mode. During the training, Adaptive
Anomaly Control monitors rule triggering and sends triggering events to Kaspersky Security Center. Each rule
has its own duration of the training mode. The duration of the training mode is set by Kaspersky experts.
Normally, the training mode is active for two weeks.
If a rule is not triggered at all during the training, Adaptive Anomaly Control will consider the actions associated
with this rule as non-typical. Kaspersky Endpoint Security will block all actions associated with that rule.
If a rule was triggered during training, Kaspersky Endpoint Security logs events in the rule triggering report and
the Triggering of rules in Smart Training state repository.
2. Analyzing the rule triggering report.
The administrator analyzes the rule triggering report or the contents of the Triggering of rules in Smart
Training state repository. Then the administrator can select the behavior of Adaptive Anomaly Control when
the rule is triggered: either block or allow. The administrator can also continue to monitor how the rule works and
extend the duration of the training mode. If the administrator does not take any action, the application will also
continue to work in training mode. The training mode term is restarted.
Adaptive Anomaly Control is con gured in real time. Adaptive Anomaly Control is con gured via the following
channels:
Adaptive Anomaly Control automatically starts to block the actions associated with the rules that were never
triggered in training mode.
Kaspersky Endpoint Security adds new rules or removes obsolete ones.
The administrator con gures the operation of the Adaptive Anomaly Control after reviewing the rule triggering
report and the contents of the Triggering of rules in Smart Training state repository. It is recommended to
check the rule triggering report and the contents of the Triggering of rules in Smart Training state repository.
When a malicious application attempts to perform an action, Kaspersky Endpoint Security will block the action and
display a noti cation (see gure below).
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Adaptive Anomaly Control noti cation

Adaptive Anomaly Control operating algorithm
Kaspersky Endpoint Security decides whether to allow or block an action that is associated with a rule based on
the following algorithm (see the gure below).

Adaptive Anomaly Control operating algorithm

Enabling and disabling Adaptive Anomaly Control
293

Adaptive Anomaly Control is enabled by default.

To enable or disable Adaptive Anomaly Control:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. Use the Adaptive Anomaly Control toggle to enable or disable the component.
4. Save your changes.

Enabling and disabling an Adaptive Anomaly Control rule
To enable or disable an Adaptive Anomaly Control rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Rules block, click the Edit rules button.
The Adaptive Anomaly Control rule list opens.
4. In the table, select a set of rules (for example, Activity of o ice applications) and expand the set.
5. Select a rule (for example, Start Windows PowerShell from o ice applications).
6. Use the toggle switch in the State column to enable or disable the Adaptive Anomaly Control rule.
7. Save your changes.

Modifying the action taken when an Adaptive Anomaly Control rule is
triggered
To edit the action that is taken when an Adaptive Anomaly Control rule is triggered:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Rules block, click the Edit rules button.
The Adaptive Anomaly Control rule list opens.
4. Select a rule in the table.
5. Click the Edit button.
The Adaptive Anomaly Control rule properties window opens.
6. In the Action block, select one of the following options:
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Smart. If this option is selected, the Adaptive Anomaly Control rule works in Smart training state for a
period of time de ned by Kaspersky experts. In this mode, when an Adaptive Anomaly Control rule is
triggered, Kaspersky Endpoint Security allows the activity covered by the rule and logs an entry in the
Triggering of rules in Smart Training state storage of the Kaspersky Security Center Administration Server.
When the time period set for working in Smart Training state ends, Kaspersky Endpoint Security blocks the
activity covered by an Adaptive Anomaly Control rule and logs an entry containing information about the
activity.
Block. If this action is selected, when an Adaptive Anomaly Control rule is triggered Kaspersky Endpoint
Security blocks the activity covered by the rule and logs an entry containing information about the activity.
Inform. If this action is selected, when an Adaptive Anomaly Control rule is triggered Kaspersky Endpoint
Security allows the activity covered by the rule and logs an entry containing information about the activity.
7. Save your changes.

Creating an exclusion for an Adaptive Anomaly Control rule
You cannot create more than 1,000 exclusions for Adaptive Anomaly Control rules. It is not recommended to
create more than 200 exclusions. To reduce the number of exclusions used, it is recommended to use masks in
the settings of exclusions.
An exclusion for an Adaptive Anomaly Control rule includes a description of the source and target objects. The
source object is the object performing the actions. The target object is the object on which the actions are being
performed. For example, you have opened a le named file.xlsx. As a result, a library le with the DLL extension
is loaded into the computer memory. This library is used by a browser (executable le named browser.exe). In this
example, file.xlsx is the source object, Excel is the source process, browser.exe is the target object, and
Browser is the target process.

To create an exclusion for an Adaptive Anomaly Control rule:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Rules block, click the Edit rules button.
The Adaptive Anomaly Control rule list opens.
4. Select a rule in the table.
5. Click the Edit button.
The Adaptive Anomaly Control rule properties window opens.
6. In the Exclusions block, click the Add button.
The exclusion properties window opens.
7. Select the user for which you want to con gure an exclusion.
Adaptive Anomaly Control does not support exclusions for user groups. If you select a user group,
Kaspersky Endpoint Security does not apply the exclusion.
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8. In the Description eld, enter a description of the exclusion.
9. De ne the settings of the source object or source process started by the object:
Source process. Path or mask of the path to the le or folder containing les (for example,
С:\Dir\File.exe or Dir\*.exe).
Source process hash. File hash code.
Source object. Path or mask of the path to the le or folder containing les (for example,
С:\Dir\File.exe or Dir\*.exe). For example, le path document.docm, which uses a script or macro to
start the target processes.
You can also specify other objects to exclude, such as a web address, macro, command in the command line,
registry path, or others. Specify the object according to the following template: object://<object>,
where <object> refers to the name of the object, for example, object://web.site.example.com,
object://VBA, object://ipconfig, object://HKEY_USERS. You can also use masks, for example,
object://*C:\Windows\temp\*.
Source object hash. File hash code.
The Adaptive Anomaly Control rule is not applied to actions performed by the object, or to processes started
by the object.
10. Specify the settings of the target object or target processes started on the object.
Target process. Path or mask of the path to the le or folder containing les (for example,
С:\Dir\File.exe or Dir\*.exe).
Target process hash. File hash code.
Target object. The command to start the target process. Specify the command using the following pattern
object://<command>, for example, object://cmdline:powershell -Command "$result =
'C:\Windows\temp\result_local_users_pwdage txt'". You can also use masks, for example,
object://*C:\Windows\temp\*.
Target object hash. File hash code.
The Adaptive Anomaly Control rule is not applied to actions taken on the object, or to processes started on the
object.
11. Save your changes.

Exporting and importing exclusions for Adaptive Anomaly Control rules
To export or import the list of exclusions for selected rules:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Rules block, click the Edit rules button.
The Adaptive Anomaly Control rule list opens.
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4. To export the list of rules:
a. Select the rules whose exceptions you want to export.
b. Click the Export button.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
d. Con rm that you want to export only the selected exclusions, or export the entire list of exclusions.
e. Click the Save button.
5. To import the list of rules:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
6. Save your changes.

Applying updates for Adaptive Anomaly Control rules
New Adaptive Anomaly Control rules may be added to the table of rules and existing Adaptive Anomaly Control
rules may be deleted from the table of rules when anti-virus databases are updated. Kaspersky Endpoint Security
distinguishes Adaptive Anomaly Control rules that are to be deleted or added to the table, if an update for these
rules has not been applied.
Until the update is applied, Kaspersky Endpoint Security displays the Adaptive Anomaly Control rules set to be
deleted by the update in the table of rules and assigns the Disabled status to them. It is not possible to
change the settings of these rules.

To apply updates for Adaptive Anomaly Control rules:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Rules block, click the Edit rules button.
The Adaptive Anomaly Control rule list opens.
4. In the opened window, click the Approve updates button.
The Approve updates button is available if an update for Adaptive Anomaly Control rules is available.
5. Save your changes.
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Editing Adaptive Anomaly Control message templates
When a user tries to do an action, blocked by Adaptive Anomaly Control rules, Kaspersky Endpoint Security
displays a message that potentially harmful actions are blocked. If the user believes that an action was mistakenly
blocked, the user can use the link in the message text to send a message to the local corporate network
administrator.
Special templates are available for the message about blocking potentially harmful actions and for the message to
be sent to the administrator. You can modify the message templates.

To edit a message template:
1. In the main application window, click the button

.

2. In the application settings window, select Security Controls → Adaptive Anomaly Control.
3. In the Templates block, con gure the templates for Adaptive Anomaly Control messages:
Message about blocking. Template of the message that is displayed to a user when an Adaptive Anomaly
Control rule that blocks a non-typical action is triggered.
Message to administrator. Template of the message that a user can be sent to the local corporate network
administrator if the user considers the blocking to be a mistake.
4. Save your changes.

Viewing Adaptive Anomaly Control reports
To view Adaptive Anomaly Control reports:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Adaptive Anomaly Control.
The settings of the Adaptive Anomaly Control component are displayed in the right part of the window.
6. Do one of the following:
If you want to view a report on the settings of Adaptive Anomaly Control rules, click Report on Adaptive
Anomaly Control rules state.
If you want to view a report on the triggering of Adaptive Anomaly Control rules, click Report on triggered
Adaptive Anomaly Control rules.
7. The report generation process starts.
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The report is displayed in a new window.

Application Control
Application Control manages the startup of applications on users' computers. This allows you to implement a
corporate security policy when using applications. Application Control also reduces the risk of computer infection
by restricting access to applications.
Con guring Application Control consists of the following steps:
1. Creating application categories.
The administrator creates categories of applications that the administrator wants to manage. Categories of
applications are intended for all computers in the corporate network, regardless of administration groups. To
create a category, you can use the following criteria: KL category (for example, Browsers), le hash, application
vendor, and other criteria.
2. Creating Application Control rules.
The administrator creates Application Control rules in the policy for the administration group. The rule includes
the categories of applications and the startup status of applications from these categories: blocked or allowed.
3. Selecting the Application Control mode.
The administrator chooses the mode for working with applications that are not included in any of the rules
(application denylist and allowlist).
When a user attempts to start a prohibited application, Kaspersky Endpoint Security will block the application from
starting and will display a noti cation (see the gure below).
A test mode is provided to check the con guration of Application Control. In this mode, Kaspersky Endpoint
Security does the following:
Allows the startup of applications, including prohibited ones.
Shows a noti cation about the startup of a prohibited application and adds information to the report on the
user's computer.
Sends data about the startup of prohibited applications to Kaspersky Security Center.

Application Control noti cation

Application Control operating modes
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The Application Control component operates in two modes:
Denylist. In this mode, Application Control allows users to start all applications except for applications that are
prohibited in Application Control rules.
This mode of Application Control is enabled by default.
Allowlist. In this mode, Application Control blocks users from starting any applications except for applications
that are allowed and not prohibited in Application Control rules.
If the allow rules of Application Control are fully con gured, the component blocks the startup of all new
applications that have not been veri ed by the LAN administrator, while allowing the operation of the operating
system and of trusted applications that users rely on in their work.
You can read the recommendations on con guring Application Control rules in allowlist mode.
Application Control can be con gured to operate in these modes both by using the Kaspersky Endpoint Security
local interface and by using Kaspersky Security Center.
However, Kaspersky Security Center o ers tools that are not available in the Kaspersky Endpoint Security local
interface, such as the tools that are needed for the following tasks:
Creating application categories.
Application Control rules created in the Kaspersky Security Center Administration Console are based on your
custom application categories and not on inclusion and exclusion conditions as is the case in the Kaspersky
Endpoint Security local interface.
Receiving information about applications that are installed on corporate LAN computers.
This is why it is recommended to use Kaspersky Security Center to con gure the operation of the Application
Control component.

Application Control operating algorithm
Kaspersky Endpoint Security uses an algorithm to make a decision about starting an application (see the gure
below).
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Application Control operating algorithm

Application Control functionality limitations
Operation of the Application Control component is limited in the following cases:
When the application version is upgraded, importing Application Control component settings is not supported.
When the application version is upgraded, importing Application Control component settings is supported only
if Kaspersky Endpoint Security 10 Service Pack 2 for Windows or later is being upgraded to Kaspersky Endpoint
Security 11.7.0 for Windows.
When application versions other than Kaspersky Endpoint Security 10 Service Pack 2 for Windows are
upgraded, the Application Control settings have to be con gured anew in order to restore this component
to operational state.
If there is no connection with KSN servers, Kaspersky Endpoint Security receives information about the
reputation of applications and their modules only from local databases.
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The list of applications that Kaspersky Endpoint Security designates as KL category Other applications \
Applications, trusted according to reputation in KSN may di er depending on whether or not a
connection to KSN servers is available.
At the Kaspersky Security Center database, information on 150,000 processed les may be stored. Once this
number of records has been achieved, new les will not be processed. To resume inventory operations, you
must delete the les that were previously inventoried in the Kaspersky Security Center database from the
computer on which Kaspersky Endpoint Security is installed.
The component does not control the startup of scripts unless the script is sent to the interpreter via the
command line.
If the startup of an interpreter is allowed by Application Control rules, the component will not block a script
started from this interpreter.

If at least one of the scripts speci ed in the interpreter command line is blocked from start by Application
control rules, the component blocks all the scripts, speci ed in the interpreter command line.
The component does not control the startup of scripts from interpreters that are not supported by Kaspersky
Endpoint Security.
Kaspersky Endpoint Security supports the following interpreters:
Java
PowerShell
The following types of interpreters are supported:
%ComSpec%;
%SystemRoot%\\system32\\regedit.exe;
%SystemRoot%\\regedit.exe;
%SystemRoot%\\system32\\regedt32.exe;
%SystemRoot%\\system32\\cscript.exe;
%SystemRoot%\\system32\\wscript.exe;
%SystemRoot%\\system32\\msiexec.exe;
%SystemRoot%\\system32\\mshta.exe;
%SystemRoot%\\system32\\rundll32.exe;
%SystemRoot%\\system32\\wwahost.exe;
%SystemRoot%\\syswow64\\cmd.exe;
%SystemRoot%\\syswow64\\regedit.exe;
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%SystemRoot%\\syswow64\\regedt32.exe;
%SystemRoot%\\syswow64\\cscript.exe;
%SystemRoot%\\syswow64\\wscript.exe;
%SystemRoot%\\syswow64\\msiexec.exe;
%SystemRoot%\\syswow64\\mshta.exe;
%SystemRoot%\\syswow64\\rundll32.exe;
%SystemRoot%\\syswow64\\wwahost.exe.

Enabling and disabling Application Control
By default, Application Control is disabled.

To enable or disable Application Control:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. Use the Application Control toggle to enable or disable the component.
4. Save your changes.
As a result, if Application Control is enabled, the application forwards information about running executable les
to Kaspersky Security Center. You can view the list of running executable les in Kaspersky Security Center in
the Executable les folder. To receive information about all executable les instead of only running executable
les, run the Inventory task.

Selecting the Application Control mode
To select the Application Control mode:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. In the Application Startup Control mode block, select one of the following options:
Denylist. If this option is selected, Application Control allows all users to start any applications, except in
cases that satisfy the conditions of Application Control block rules.
Allowlist. If this option is selected, Application Control blocks all users from starting any applications, except
in cases that satisfy the conditions of Application Control allow rules.

303

The Golden Image rule and Trusted Updaters rule are initially de ned for Allowlist mode. These
Application Control rules correspond to KL categories. The "Golden Image" KL category includes
programs that ensure normal operation of the operating system. The "Trusted Updaters" KL category
includes updaters for the most reputable software vendors. You cannot delete these rules. The settings
of these rules cannot be edited. By default, the Golden Image rule is enabled and the Trusted
Updaters rule is disabled. All users are allowed to start applications that match the trigger conditions of
these rules.
All rules created during the selected mode are saved after the mode is changed so that the rules can be used
again. To revert back to using these rules, all you have to do is select the necessary mode.
4. In the Action at startup of blocked applications section, select the action to be performed by the component
when a user attempts to start an application that is blocked by Application Control rules.
5. Select the Control DLL modules load (signi cantly increases the load on the system) check box if you want
Kaspersky Endpoint Security to monitor the loading of DLL modules when applications are started by users.
Information about the module and the application that loaded the module will be saved to a report.
Kaspersky Endpoint Security monitors only the DLL modules and drivers that have been loaded since the check
box was selected. Restart the computer after selecting the check box if you want Kaspersky Endpoint Security
to monitor all DLL modules and drivers, including ones that are loaded before Kaspersky Endpoint Security is
started.
When enabling control over the loading of DLL modules and drivers, make sure that one of the following
rules is enabled in the Application Control settings: the default Golden Image rule or another rule that
contains the "Trusted certi cates" KL category and ensures that trusted DLL modules and drivers are
loaded before Kaspersky Endpoint Security is started. Enabling control of the loading of DLL modules and
drivers when the Golden Image rule is disabled may cause instability in the operating system.

We recommend turning on password protection for con guring application settings, so that it is possible
to turn o the rules blocking critical DLL modules and drivers form start, without modifying Kaspersky
Security Center policy settings.
6. Save your changes.

Working with Application Control rules in the application interface
Kaspersky Endpoint Security controls the startup of applications by users by means of rules. An Application
Control rule speci es the triggering conditions and actions performed by the Application Control component
when the rule is triggered (allowing or blocking application startup by users).

Rule-triggering conditions
A rule-triggering condition has the following correlation: "condition type - condition criterion - condition value".
Based on the rule-triggering conditions, Kaspersky Endpoint Security applies (or does not apply) a rule to an
application.
The following types of conditions are used in rules:
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Inclusion conditions. Kaspersky Endpoint Security applies the rule to the application if the application matches
at least one of the inclusion conditions.
Exclusion conditions. Kaspersky Endpoint Security does not apply the rule to the application if the application
matches at least one of the exclusion conditions and does not match any of the inclusion conditions.
Rule-triggering conditions are created using criteria. The following criteria are used to create rules in Kaspersky
Endpoint Security:
Path to the folder containing the executable le of the application or path to the executable le of the
application.
Metadata: application executable le name, application executable le version, application name, application
version, application vendor.
Hash of the executable le of the application.
Certi cate: issuer, subject, thumbprint.
Inclusion of the application in a KL category.
Location of the application executable le on a removable drive.
The criterion value must be speci ed for each criterion used in the condition. If the parameters of the application
being started match the values of criteria speci ed in the inclusion condition, the rule is triggered. In this case,
Application Control performs the action prescribed in the rule. If application parameters match the values of
criteria speci ed in the exclusion condition, Application Control does not control startup of the application.
If you have selected a certi cate as a rule-triggering condition, you need to ensure that this certi cate is
added to the trusted system storage on the computer, and check the trusted system storage usage settings
in the application.

Decisions made by the Application Control component when a rule is triggered
When a rule is triggered, Application Control allows users (or user groups) to start applications or blocks startup
according to the rule. You can select individual users or groups of users that are allowed or not allowed to start
applications that trigger a rule.
If a rule does not specify those users allowed to start applications satisfying the rule, this rule is called a block rule.
If a rule that does not specify any users who are not allowed to start applications that match the rule, this rule is
called an allow rule.
The priority of a block rule is higher than the priority of an allow rule. For example, if an Application Control allow
rule has been assigned for a user group while an Application Control block rule has been assigned for one user in
this user group, this user will be blocked from starting the application.

Operating status of a rule
Application Control rules can have one of the following operating statuses:
On. This status means that the rule is used when Application Control is in operation.
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O . This status means that the rule is ignored when Application Control is in operation.
Test. This status signi es that Kaspersky Endpoint Security allows the startup of applications to which the rules
apply but logs information about the startup of such applications in the report.

Adding an Application Control rule
To add an Application Control rule:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. Click the Blocked applications or Allowed applications button.
This opens the list of Application Control rules.
4. Click the Add button.
The Application Control rule window opens.
5. On the General settings tab, de ne the main settings of the rule:
a. In the Rule name eld, enter the name of the rule.
b. In the Description eld, enter a description of the rule.
c. Compile or edit a list of users and/or groups of users who are allowed or not allowed to start applications
that meet the rule trigger conditions. To do this, click the Add button in the Subjects and their rights table.
By default, the Everyone value is added to the list of users. The rule applies to all users.
If there is no user speci ed in the table, the rule cannot be saved.
d. In the Subjects and their rights table, use the toggle to de ne the right of users to start applications.
e. Select the Deny for other users check box if you want all users that do not appear in the Subject column
and that are not part of the group of users speci ed in the Subject column to be blocked from starting
applications that match the rule trigger conditions.
If the Deny for other users check box is cleared, Kaspersky Endpoint Security does not control the
startup of applications by users that are not speci ed in the Subjects and their rights table and that
do not belong to the groups of users speci ed in the Subjects and their rights table.
f. If you want Kaspersky Endpoint Security to consider applications matching the rule trigger conditions as
trusted updaters allowed to create other executable les that will be allowed to run subsequently, select the
Trusted Updaters check box.
6. On the Conditions tab, create or edit the list of inclusion conditions for triggering the rule.
7. On the Exclusions tab, create or edit the list of exclusion conditions for triggering the rule.
306

When Kaspersky Endpoint Security settings are migrated, the list of executable les created by trusted
updaters is migrated as well.
8. Save your changes.

Adding a trigger condition for an Application Control rule
To add a new trigger condition for an Application Control rule:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. Click the Blocked applications or Allowed applications button.
This opens the list of Application Control rules.
4. Select the rule for which you want to con gure a trigger condition.
The Application Control rule properties open.
5. Select the Conditions tab or Exclusions tab and click the Add button.
6. Select the trigger conditions for the Application Control rule:
Conditions from properties of started applications. In the list of running applications, you can select the
applications to which the Application Control rule will be applied. Kaspersky Endpoint Security also lists
applications that were previously running on the computer. You need to select the criterion that you want to
use to create one or multiple rule trigger conditions: File hash, Certi cate, KL category, Metadata or
Folder path.
Conditions "KL category". A KL category is a list of applications that have shared theme attributes. The list
is maintained by Kaspersky experts. For example, the KL category known as "O ice applications" includes
applications from the Microsoft O ice suite, Adobe® Acrobat®, and others.
Custom condition. You can select the application le and select one of the rule trigger conditions: File hash,
Certi cate, Metadata or Folder path.
Condition by le drive (removable drive). The Application Control rule is applied only to les that are run on
a removable drive.
Conditions from properties of les in the speci ed folder. The Application Control rule is applied only to
les in the speci ed folder. You can also include or exclude les from subfolders. You need to select the
criterion that you want to use to create one or multiple rule trigger conditions: File hash, Certi cate, KL
category, Metadata or Folder path.
7. Save your changes.
When adding conditions, please take into account the following special considerations for Application Control:
Kaspersky Endpoint Security does not support an MD5 le hash and does not control startup of applications
based on an MD5 hash. An SHA256 hash is used as a rule trigger condition.
It is not recommended to use only the Issuer and Subject criteria as rule trigger conditions. Use of these
criteria is unreliable.
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If you are using a symbolic link in the Path to le or folder eld, you are advised to resolve the symbolic link for
correct operation of the Application Control rule. To do so, click the Resolve symbolic link button.

Changing the status of an Application Control rule
To change the status of an Application Control rule:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. Click the Blocked applications or Allowed applications button.
This opens the list of Application Control rules.
4. In the Status column, open the context menu and select one of the following:
On. This status means that the rule is used when the Application Control component is running.
O . This status means that the rule is ignored when the Application Control component is running.
Testing. This status means that Kaspersky Endpoint Security always allows the startup of applications to
which this rule applies but logs information about the startup of such applications in the report.
5. Save your changes.

Managing Application Control rules in Kaspersky Security Center
Kaspersky Endpoint Security controls the startup of applications by users by means of rules. An Application
Control rule speci es the triggering conditions and actions performed by the Application Control component
when the rule is triggered (allowing or blocking application startup by users).

Rule-triggering conditions
A rule-triggering condition has the following correlation: "condition type - condition criterion - condition value".
Based on the rule-triggering conditions, Kaspersky Endpoint Security applies (or does not apply) a rule to an
application.
The following types of conditions are used in rules:

Inclusion conditions. Kaspersky Endpoint Security applies the rule to the application if the application matches
at least one of the inclusion conditions.
Exclusion conditions. Kaspersky Endpoint Security does not apply the rule to the application if the application
matches at least one of the exclusion conditions and does not match any of the inclusion conditions.
Rule-triggering conditions are created using criteria. The following criteria are used to create rules in Kaspersky
Endpoint Security:
Path to the folder containing the executable le of the application or path to the executable le of the
application.
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Metadata: application executable le name, application executable le version, application name, application
version, application vendor.
Hash of the executable le of the application.
Certi cate: issuer, subject, thumbprint.
Inclusion of the application in a KL category.
Location of the application executable le on a removable drive.
The criterion value must be speci ed for each criterion used in the condition. If the parameters of the application
being started match the values of criteria speci ed in the inclusion condition, the rule is triggered. In this case,
Application Control performs the action prescribed in the rule. If application parameters match the values of
criteria speci ed in the exclusion condition, Application Control does not control startup of the application.
If you have selected a certi cate as a rule-triggering condition, you need to ensure that this certi cate is
added to the trusted system storage on the computer, and check the trusted system storage usage settings
in the application.

Decisions made by the Application Control component when a rule is triggered
When a rule is triggered, Application Control allows users (or user groups) to start applications or blocks startup
according to the rule. You can select individual users or groups of users that are allowed or not allowed to start
applications that trigger a rule.
If a rule does not specify those users allowed to start applications satisfying the rule, this rule is called a block rule.
If a rule that does not specify any users who are not allowed to start applications that match the rule, this rule is
called an allow rule.
The priority of a block rule is higher than the priority of an allow rule. For example, if an Application Control allow
rule has been assigned for a user group while an Application Control block rule has been assigned for one user in
this user group, this user will be blocked from starting the application.

Operating status of a rule
Application Control rules can have one of the following operating statuses:
On. This status means that the rule is used when Application Control is in operation.
O . This status means that the rule is ignored when Application Control is in operation.
Test. This status signi es that Kaspersky Endpoint Security allows the startup of applications to which the rules
apply but logs information about the startup of such applications in the report.

Receiving information about the applications that are installed on users'
computers
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To create optimal Application Control rules, it is recommended to rst get a picture of the applications that are
used on computers on the corporate LAN. To do this, you can obtain the following information:
Vendors, versions, and localizations of applications used on the corporate LAN.
Frequency of application updates.
Application usage policies adopted in the company (this may be security policies or administrative policies).
Storage location of application distribution packages.
Information about applications that are used on corporate LAN computers is available in the Applications registry
folder and in the Executable les folder. The Applications registry folder and the Executable les folder are
located in the Application management folder in the Kaspersky Security Center Administration Console tree.
The Applications registry folder contains the list of applications that were detected by Network Agent which is
installed on the client computer.
The Executable les folder contains a list of all executable les that have ever been started on client computers or
that were detected during the inventory task of Kaspersky Endpoint Security.
To view general information about the application and its executable les, and the list of computers on which an
application is installed, open the properties window of an application that is selected in the Applications registry
folder or in the Executable les folder.

To open the application properties window in the Applications registry folder:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select Additional → Application management → Applications registry.
3. Select an application.
4. In the context menu of the application, select Properties.

To open the properties window for an executable le in the Executable les folder:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select the Additional → Application management → Executable les
folder.
3. Select an executable le.
4. In the context menu of the executable le, select Properties.

Creating application categories
For more convenience when creating Application Control rules, you can create application categories.
It is recommended to create a "Work applications" category that covers the standard set of applications that are
used at the company. If di erent user groups use di erent sets of applications in their work, a separate application
category can be created for each user group.
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To create an application category:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select the Additional → Application management → Application
categories folder.
3. Click the New category button in the workspace.
The user category creation wizard starts.
4. Follow the instructions of the user category creation wizard.

Step 1. Selecting the category type
At this step, select one of the following types of application categories:
Category with content added manually. If you selected this type of category, at the "Con guring the
conditions for including applications in a category" step and the "Con guring the conditions for excluding
applications from a category" step, you will be able to de ne the criteria whereby executable les will be
included into the category.
Category that includes executable les from selected devices. If you selected this type of category, at the
"Settings" step you will be able to specify a computer whose executable les will be automatically included in
the category.
Category that includes executable les from a speci c folder. If you selected this type of category, at the
"Repository folder" step you will be able to specify a folder from which executable les will be automatically
included in the category.
When creating a category with content added automatically, Kaspersky Security Center performs inventory
on les with the following formats: EXE, COM, DLL, SYS, BAT, PS1, CMD, JS, VBS, REG, MSI, MSC, CPL, HTML,
HTM, DRV, OCX, and SCR.

Step 2. Entering a user category name
At this step, specify a name for the application category.

Step 3. Con guring the conditions for including applications in a category
This step is available if you selected the Category with content added manually category type.
At this step, in the Add drop-down list, select the conditions for including applications into the category:
From the list of executable les. Add applications from the list of executable les on the client device to the
custom category.
From le properties. Specify detailed data of executable les as a condition for adding applications to the
custom category.
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Metadata from les in folder. Select a folder on the client device that contains executable les. Kaspersky
Security Center will indicate the metadata of these executable les as a condition for adding applications to
the custom category.
Checksums of the les in the folder. Select a folder on the client device that contains executable les.
Kaspersky Security Center will indicate the hashes of these executable les as a condition for adding
applications to the custom category.
Certi cates for the les from the folder. Select a folder on the client device that contains executable les
signed with certi cates. Kaspersky Security Center will indicate the certi cates of these executable les as a
condition for adding applications to the custom category.
It is not recommended to use conditions whose properties do not have the Certi cate thumbprint
parameter speci ed.
MSI installer les metadata. Select the MSI package. Kaspersky Security Center will indicate the metadata of
executable les packed in this MSI package as a condition for adding applications to the custom category.
Checksums of the les from the MSI installer of the application. Select the MSI package. Kaspersky Security
Center will indicate the hashes of executable les packed in this MSI package as a condition for adding
applications to the custom category.
From KL category. Specify a KL category as a condition for adding applications to the custom category. A KL
category is a list of applications that have shared theme attributes. The list is maintained by Kaspersky experts.
For example, the KL category known as "O ice applications" includes applications from the Microsoft O ice
suite, Adobe Acrobat, and others.
You can select all KL categories to generate an extended list of trusted applications.
Specify path to application. Select a folder on the client device. Kaspersky Security Center will add
executable les from this folder to the custom category.
Select certi cate from repository. Select certi cates that were used to sign executable les as a condition
for adding applications to the custom category.
It is not recommended to use conditions whose properties do not have the Certi cate thumbprint
parameter speci ed.
Drive type. Specify the type of storage device (all hard drives and removable drives, or only removable drives)
as a condition for adding applications to the custom category.

Step 4. Con guring the conditions for excluding applications from a category
This step is available if you selected the Category with content added manually category type.

Applications speci ed at this step are excluded from the category even if these applications were speci ed at
the "Con guring the conditions for including applications in a category" step.
At this step, in the Add drop-down list, select conditions for excluding applications from the category:
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From the list of executable les. Add applications from the list of executable les on the client device to the
custom category.
From le properties. Specify detailed data of executable les as a condition for adding applications to the
custom category.
Metadata from les in folder. Select a folder on the client device that contains executable les. Kaspersky
Security Center will indicate the metadata of these executable les as a condition for adding applications to
the custom category.
Checksums of the les in the folder. Select a folder on the client device that contains executable les.
Kaspersky Security Center will indicate the hashes of these executable les as a condition for adding
applications to the custom category.
Certi cates for the les from the folder. Select a folder on the client device that contains executable les
signed with certi cates. Kaspersky Security Center will indicate the certi cates of these executable les as a
condition for adding applications to the custom category.
MSI installer les metadata. Select the MSI package. Kaspersky Security Center will indicate the metadata of
executable les packed in this MSI package as a condition for adding applications to the custom category.
Checksums of the les from the MSI installer of the application. Select the MSI package. Kaspersky Security
Center will indicate the hashes of executable les packed in this MSI package as a condition for adding
applications to the custom category.
From KL category. Specify a KL category as a condition for adding applications to the custom category. A KL
category is a list of applications that have shared theme attributes. The list is maintained by Kaspersky experts.
For example, the KL category known as "O ice applications" includes applications from the Microsoft O ice
suite, Adobe Acrobat, and others.
You can select all KL categories to generate an extended list of trusted applications.
Specify path to application. Select a folder on the client device. Kaspersky Security Center will add
executable les from this folder to the custom category.
Select certi cate from repository. Select certi cates that were used to sign executable les as a condition
for adding applications to the custom category.
Drive type. Specify the type of storage device (all hard drives and removable drives, or only removable drives)
as a condition for adding applications to the custom category.

Step 5. Settings
This step is available if you selected the Category that includes executable les from selected devices
category type.
At this step, click the Add button and specify the computers whose executable les will be added to the
application category by Kaspersky Security Center. All executable les from the speci ed computers presented in
the Executable les folder will be added to the application category by Kaspersky Security Center.
At this step, you can also con gure the following settings:
Algorithm for hash function calculation by Kaspersky Security Center. To select an algorithm, you must select
at least one of the following check boxes:
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Calculate SHA-256 for les in this category (supported by Kaspersky Endpoint Security 10 Service
Pack 2 for Windows and later versions).
Calculate MD5 for les in this category (supported by versions earlier than Kaspersky Endpoint
Security 10 Service Pack 2 for Windows).
Synchronize data with Administration Server repository check box. Select this check box if you want
Kaspersky Security Center to periodically clear the application category and add to it all executable les from
the speci ed computers presented in the Executable les folder.
If the Synchronize data with Administration Server repository check box is cleared, Kaspersky Security
Center will not make any modi cations to an application category after it is created.
Scan period (h) eld. In this eld, you can specify the period of time (in hours) after which Kaspersky Security
Center clears the application category and adds to it all executable les from the speci ed computers
presented in the Executable les folder.
The eld is available if the Synchronize data with Administration Server repository check box is selected.

Step 6. Repository folder
This step is available if you selected the Category that includes executable les from a speci c folder
category type.
At this step, click the Browse button and specify the folder in which Kaspersky Security Center will search for
executable les to automatically add applications to the application category.
At this step, you can also con gure the following settings:
Include dynamic-link libraries (DLL) in this category check box. Select this check box if you want dynamic-link
libraries (DLL les) to be included in the application category.
Including DLL les in the application category may reduce the performance of Kaspersky Security Center.
Include script data in this category check box. Select this check box if you want scripts to be included in the
application category.
Including scripts in the application category may reduce the performance of Kaspersky Security Center.
Algorithm for hash function calculation by Kaspersky Security Center. To select an algorithm, you must select
at least one of the following check boxes:
Calculate SHA-256 for les in this category (supported by Kaspersky Endpoint Security 10 Service
Pack 2 for Windows and later versions).
Calculate MD5 for les in this category (supported by versions earlier than Kaspersky Endpoint
Security 10 Service Pack 2 for Windows).
Force folder scan for changes check box. Select this check box if you want Kaspersky Security Center to
periodically search for executable les in the folder used for automatically adding to the application category.

314

If the Force folder scan for changes check box is cleared, Kaspersky Security Center searches for executable
les in the folder used for automatically adding to the application category only if changes have been made in
the folder, les have been added to it or deleted from it.
Scan period (h) eld. In this eld, you can specify the time interval (in hours) after which Kaspersky Security
Center will search for executable les in the folder used for automatically adding to the application category.
This eld is available if the Force folder scan for changes check box is selected.

Step 7. Creating a custom category
To exit the Application Setup Wizard, click the Finish button.

Adding executable les from the Executable les folder to the application
category
In the Executable les folder the list of executable les detected on computers is displayed. Kaspersky Endpoint
Security generates a list of executable les after executing the Inventory task.

To add executable les from the Executable les folder to the application category:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select Additional → Application management → Executable les folder.
3. In the workspace, select the executable les that you want to add to the application category.
4. Right-click to open the context menu for the selected executable les and select Add to category.
5. In the opened window, do the following:
In the upper part of the window, choose one of the following options:
Add to a new application category. Choose this option if you want to create a new application category
and add executable les to it.
Add to an existing application category. Choose this option if you want to select an existing application
category and add executable les to it.
In the Rule type section, choose one of the following options:
Rules for adding to inclusions. Select this option if you want to create a condition that adds executable
les to the application category.
Rules for adding to exclusions. Select this option if you want to create a condition that excludes
executable les from the application category.
In the Parameter used as a condition block, select one of the following options:
Certi cate details (or SHA-256 hashes for les without a certi cate).
Certi cate details ( les without a certi cate will be skipped).
Only SHA-256 ( les without a hash will be skipped).
315

Only MD5 (discontinued mode, only for Kaspersky Endpoint Security 10 Service Pack 1 version).
6. Click OK.

Adding event-related executable les to the application category
To add executable les related to Application Control events to the application category:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Events tab.
3. Choose a selection of events related to operation of the Application Control component (Viewing events
resulting from operation of the Application Control component, Viewing events resulting from test operation
of the Application Control component) in the Event selections drop-down list.
4. Click the Run selection button.
5. Select the events whose associated executable les you want to add to the application category.
6. Right-click to open the context menu for the selected events and select Add to category.
7. In the opened window, con gure the settings of the application category:
In the upper part of the window, choose one of the following options:
Add to a new application category. Choose this option if you want to create a new application category
and add executable les to it.
Add to an existing application category. Choose this option if you want to select an existing application
category and add executable les to it.
In the Rule type section, choose one of the following options:
Rules for adding to inclusions. Select this option if you want to create a condition that adds executable
les to the application category.
Rules for adding to exclusions. Select this option if you want to create a condition that excludes
executable les from the application category.
In the Parameter used as a condition block, select one of the following options:
Certi cate details (or SHA-256 hashes for les without a certi cate).
Certi cate details ( les without a certi cate will be skipped).
Only SHA-256 ( les without a hash will be skipped).
Only MD5 (discontinued mode, only for Kaspersky Endpoint Security 10 Service Pack 1 version).
8. Click OK.
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Adding and modifying an Application Control rule using Kaspersky Security
Center
To add or modify an Application Control rule using Kaspersky Security Center:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Application Control.
In the right part of the window, the settings of the Application Control component are displayed.
6. Do one of the following:
To add a rule, click the Add button.
If you want to edit an existing rule, select it in the list of rules and click the Edit button.
This opens the Application Control rules window.
7. Do one of the following:
If you want to create a new category:
a. Click the Create a category button.
The user category creation wizard starts.
b. Follow the instructions of the user category creation wizard.
c. In the Category drop-down list, select the created application category.
If you want to edit an existing category:
a. In the Category drop-down list, select the created application category that you want to edit.
b. Click the Properties button.
c. Modify the settings of the selected application category.
d. Click OK.
e. In the Category drop-down list, select the created application category based on which you want to
create a rule.
8. In the Subjects and their rights table, click the Add button.
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9. In the Select Users or Groups window, specify the list of users and/or user groups for which you want to
con gure permission to start applications from the selected category.
10. In the Subjects and their rights table:
If you want to allow users and/or groups of users to start applications that belong to the selected category,
select the Allow check box in the relevant rows.
If you want to block users and/or groups of users from starting applications that belong to the selected
category, select the Deny check box in the relevant rows.
11. Select the Deny for other users check box if you want all users that do not appear in the Subject column and
that are not part of the group of users speci ed in the Subject column to be blocked from starting applications
that belong to the selected category.
12. If you want Kaspersky Endpoint Security to consider applications included in the selected application category
as trusted updaters allowed to create other executable les that will be subsequently allowed to run, select the
Trusted Updaters check box.
When Kaspersky Endpoint Security settings are migrated, the list of executable les created by trusted
updaters is migrated as well.
13. Save your changes.

Changing the status of an Application Control rule via Kaspersky Security
Center
To change the status of an Application Control rule:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Application Control.
In the right part of the window, the settings of the Application Control component are displayed.
6. In the Status column, left-click to display the context menu and select one of the following:
On. This status means that the rule is used when Application Control is in operation.
O . This status means that the rule is ignored when Application Control is in operation.
Test. This status means that Kaspersky Endpoint Security always allows the startup of applications to which
the rule applies but logs information about the startup of such applications in the report.
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You can use the Test status to assign the action equivalent to the Test rules option for a portion of
rules when the Apply rules option is selected in the Action drop-down list.
7. Save your changes.

Exporting and importing Application Control rules
You can export the list of Application Control rules to an XML le. You can use the export/import function to back
up the list of Application Control rules or to migrate the list to a di erent server.
When exporting and importing Application Control rules, please keep in mind the following special considerations:
Kaspersky Endpoint Security exports the list of rules only for the active Application Control mode. In other
words, if Application Control is operating in denylist mode, Kaspersky Endpoint Security exports rules only for
this mode. To export the list of rules for allowlist mode, you need to switch the mode and run the export
operation again.
Kaspersky Endpoint Security uses application categories for Application Control rules to work. When migrating
the list of Application Control rules to a di erent server, you also need to migrate the list of application
categories. For more details on exporting or importing application categories, please refer to Kaspersky
Security Center Help .
How to export and import a list of Application Control rules in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Application Control.
6. To export the list of Application Control rules:
a. Select the rules that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any rule, Kaspersky Endpoint Security will export all rules.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of rules,
and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the list of rules to the XML le.
7. To export a list of Application Control rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.
How to export and import a list of Application Control rules in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import the list of rules.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Security Controls → Application Control.
5. Click the Rules lists settings link.
6. Select a list of rules: application denylist or allowlist.
7. To export the list of Application Control rules:
a. Select the rules that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected rules, or export the entire list.
d. Click the Export button.
Kaspersky Endpoint Security exports the list of rules to an XML le in the default downloads folder.
8. To export a list of Application Control rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
9. Save your changes.

Testing Application Control rules using Kaspersky Security Center
To ensure that Application Control rules do not block applications required for work, it is recommended to enable
testing of Application Control rules and analyze their operation after creating new rules. When testing of
Application Control rules is enabled, Kaspersky Endpoint Security will not block applications whose startup is
forbidden by Application Control, but will instead send noti cations about their startup to the Administration
Server.
An analysis of the operation of Application Control rules requires a review of the resultant Application Control
events that are reported to Kaspersky Security Center. If test mode results in no blocked startup events for all
applications required for the work of the computer user, this means that the correct rules were created.
Otherwise, you are advised to update the settings of the rules you have created, create additional rules, or delete
the existing rules.
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By default, Kaspersky Endpoint Security allows the startup of all applications except for applications prohibited by
the rules.

To enable or disable testing of Application Control rules in Kaspersky Security Center:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Security Controls → Application Control.
In the right part of the window, the settings of the Application Control component are displayed.
6. In the Control mode drop-down list, select one of the following items:
Denylist. If this option is selected, Application Control allows all users to start any applications, except in
cases that satisfy the conditions of Application Control block rules.
Allowlist. If this option is selected, Application Control blocks all users from starting any applications, except
in cases that satisfy the conditions of Application Control allow rules.
7. Do one of the following:
If you want to enable testing of Application Control rules, select the Test rules option in the Action dropdown list.
If you want to enable Application Control to manage the startup of applications on user computers, in the
drop-down list, select Apply rules.
8. Save your changes.

Viewing events resulting from test operation of the Application Control
component
To view Application Control testing events received by Kaspersky Security Center:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Events tab.
3. Click the Create a selection button.
The Properties: <Selection name> window opens.
4. Open the Events section.
5. Click the Clear all button.
6. In the Events table, select the Application startup prohibited in test mode and Application startup allowed
in test mode check boxes.
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7. Click OK.
8. In the Event selections drop-down list, select the created selection.
9. Click the Run selection button.

Viewing a report on blocked applications in test mode
To view the report on blocked applications in test mode:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Reports tab.
3. Click the New report template button.
The New Report Template Wizard starts.
4. Follow the instructions of the Report Template Wizard. At the Selecting the report template type step, select
Other → Report on prohibited applications in test mode.
After you have nished with the New Report Template Wizard, the new report template appears in the table on
the Reports tab.
5. Open the report by double-clicking it.
The report generation process starts. The report is displayed in a new window.

Viewing events resulting from operation of the Application Control
component
To view events resulting from the operation of the Application Control component received by Kaspersky Security
Center:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Events tab.
3. Click the Create a selection button.
The Properties: <Selection name> window opens.
4. Open the Events section.
5. Click the Clear all button.
6. In the Events table, select the Application startup prohibited check box.
7. Click OK.
8. In the Event selections drop-down list, select the created selection.
9. Click the Run selection button.
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Viewing a report on blocked applications
To view the report on blocked applications:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Reports tab.
3. Click the New report template button.
The New Report Template Wizard starts.
4. Follow the instructions of the Report Template Wizard. At the Selecting the report template type step, select
Other → Report on prohibited applications.
After you have nished with the New Report Template Wizard, the new report template appears in the table on
the Reports tab.
5. Open the report by double-clicking it.
The report generation process starts. The report is displayed in a new window.

Testing Application Control rules
To ensure that Application Control rules do not block applications required for work, it is recommended to enable
testing of Application Control rules and analyze their operation after creating new rules.
An analysis of the operation of Application Control rules requires a review of the resultant Application Control
events that are reported to Kaspersky Security Center. If test mode results in no blocked startup events for all
applications required for the work of the computer user, this means that the correct rules were created.
Otherwise, you are advised to update the settings of the rules you have created, create additional rules, or delete
the existing rules.

To enable testing of Application Control rules or to select a blocking action for Application Control:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
This opens the list of Application Control rules.
3. In the Status column, select Testing.
This status means that Kaspersky Endpoint Security always allows the startup of applications to which this rule
applies but logs information about the startup of such applications in the report.
4. Save your changes.
Kaspersky Endpoint Security will not block applications whose startup is forbidden by the Application Control
component, but will send noti cations about their startup to the Administration Server.

Application activity monitor
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Application Activity Monitor is a tool designed for viewing information about the activity of applications on a user's
computer in real time.
Using the Application Activity Monitor requires installing the Application Control and Host Intrusion Prevention
components. If these components are not installed, the Application Activity Monitor section in the main
application window is hidden.

To start Application Activity Monitor:
In the main application window, under Monitoring, click the Application Activity Monitor tile.
The Application Activity window opens. In this window, information about the activity of applications on the
user's computer is presented on three tabs:
The All applications tab displays information about all applications installed on the computer.
The Running tab displays information about the computer resource consumption by each application in real
time. From this tab, you can also proceed to con gure permissions for an individual application.
The Run at startup tab displays the list of applications that are started when the operating system starts.
If you want to hide application activity information on the user's computer, you can restrict user access to the
Application Activity Monitor tool.
How to hide Application Activity Monitor in the application interface using the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General settings → Interface.
6. Use the Hide Application Activity Monitor section check box to grant or revoke access to the tool.
7. Save your changes.
How to hide Application Activity Monitor in the application interface using the Web Console and Cloud Console

325

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Interface.
5. Use the Hide Application Activity Monitor section check box to grant or revoke access to the tool.
6. Save your changes.

Rules for creating name masks for les or folders
A mask of a le or folder name is a representation of the name of a folder or name and extension of a le using
common characters.
You can use the following common characters to create a le or folder name mask:
The * (asterisk) character, which takes the place of any set of characters (including an empty set). For example,
the C:\*.txt mask will include all paths to les with the txt extension located in folders and subfolders on the
(C:) drive.
The ? (question mark) character, which takes the place of any single character, except the \ and / characters
(delimiters of the names of les and folders in paths to les and folders). For example, the mask
C:\Folder\???.txt will include paths to all les residing in the folder named Folder that have the TXT
extension and a name consisting of three characters.

Editing Application Control message templates
When a user attempts to start an application that is blocked by an Application Control rule, Kaspersky Endpoint
Security displays a message stating that the application is blocked from starting. If the user believes that an
application was mistakenly blocked from starting, the user can use the link in the message text to send a message
to the local corporate network administrator.
Special templates are available for the message that is displayed when an application is blocked from starting and
for the message sent to the administrator. You can modify the message templates.

To edit a message template:
1. In the main application window, click the button

.

2. In the application settings window, select the Security Controls → Application Control section.
3. In the Templates block, con gure the templates for Application Control messages:
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Message about blocking. Template of the message that is displayed when an Application Control rule that
blocks an application from starting is triggered.
Message to administrator. Template of the message that a user can send to the corporate LAN
administrator if the user believes that an application was blocked by mistake.
4. Save your changes.

Best practices for implementing a list of allowed applications
When planning implementation of a list of allowed applications, it is recommended to perform the following actions:
1. Form the following types of groups:
User groups. Groups of users for whom you need to allow use of various sets of applications.
Administration groups. One or multiple groups of computers to which Kaspersky Security Center will apply
the list of allowed applications. It is necessary to create multiple groups of computers if di erent allowlist
settings are used for those groups.
2. Create a list of applications that must be allowed to start.
Prior to creating a list, you are advised to do the following:
a. Run the inventory task.
Information about the creation, recon guration, and startup of an inventory task is available in the Task
management section.
b. View the list of executable les.

Con guring allowlist mode for applications
When con guring the allowlist mode, it is recommended to perform the following actions:
1. Create application categories containing the applications that must be allowed to start.
You can select one of the following methods for creating application categories:
Category with content added manually. You can manually add to this category by using the following
conditions:
File metadata. Kaspersky Security Center adds all executable les accompanied by the speci ed
metadata to the application category.
File hash code. Kaspersky Security Center adds all executable les with the speci ed hash to the
application category.
Use of this condition excludes the capability to automatically install updates because di erent
versions of les will have a di erent hash.
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File certi cate. Kaspersky Security Center adds all executable les signed with the speci ed certi cate
to the application category.
KL category. Kaspersky Security Center adds all applications that are in the speci ed KL category to the
application category.
Application folder. Kaspersky Security Center adds all executable les from this folder to the application
category.
Use of the Application folder condition may be unsafe because any application from the speci ed
folder will be allowed to start. It is recommended to apply rules that use the application categories
with the Application folder condition only to those users for whom the automatic installation of
updates must be allowed.
Category that includes executable les from a speci c folder. You can specify a folder from which
executable les will be automatically assigned to the created application category.
Category that includes executable les from selected devices. You can specify a computer for which all
executable les will be automatically assigned to the created application category.
When using this method of creating application categories, Kaspersky Security Center receives
information about applications on the computer from the Executable les folder.
2. Select the allowlist mode for the Application Control component.
3. Create Application Control rules using the created application categories.
The Golden Image rule and Trusted Updaters rule are initially de ned for Allowlist mode. These
Application Control rules correspond to KL categories. The "Golden Image" KL category includes programs
that ensure normal operation of the operating system. The "Trusted Updaters" KL category includes
updaters for the most reputable software vendors. You cannot delete these rules. The settings of these
rules cannot be edited. By default, the Golden Image rule is enabled and the Trusted Updaters rule is
disabled. All users are allowed to start applications that match the trigger conditions of these rules.
4. Determine the applications for which automatic installation of updates must be allowed.
You can allow automatic installation of updates in one of the following ways:
Specify an extended list of allowed applications by allowing the startup of all applications that belong to any
KL category.
Specify an extended list of allowed applications by allowing the startup of all applications that are signed
with certi cates.
To allow the startup of all applications signed with certi cates, you can create a category with a certi catebased condition that uses only the Subject parameter with the value *.
For the Application control rule, select the Trusted Updaters parameter. If this check box is selected,
Kaspersky Endpoint Security considers the applications included in the rule as Trusted Updaters. Kaspersky
Endpoint Security allows the startup of applications that have been installed or updated by applications
included in the rule, provided that no blocking rules are applied to those applications.
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When Kaspersky Endpoint Security settings are migrated, the list of executable les created by trusted
updaters is migrated as well.
Create a folder and place within it the executable les of applications for which you want to allow automatic
installation of updates. Then create an application category with the "Application folder" condition and
specify the path to that folder. Then create an allow rule and select this category.
Use of the Application folder condition may be unsafe because any application from the speci ed
folder will be allowed to start. It is recommended to apply rules that use the application categories with
the Application folder condition only to those users for whom the automatic installation of updates
must be allowed.

Testing the allowlist mode
To ensure that Application Control rules do not block applications required for work, it is recommended to enable
testing of Application Control rules and analyze their operation after creating new rules. When testing is enabled,
Kaspersky Endpoint Security will not block applications whose startup is forbidden by Application Control rules,
but will instead send noti cations about their startup to the Administration Server.
When testing the allowlist mode, it is recommended to perform the following actions:
1. Determine the testing period (ranging from several days to two months).
2. Enable testing of Application Control rules.
3. Examine the events resulting from testing the operation of Application Control and reports on blocked
applications in test mode to analyze the testing results.
4. Based on the analysis results, make changes to the allowlist mode settings.
In particular, based on the test results, you can add executable les related to events to an application
category.

Support for allowlist mode
After selecting a blocking action for Application Control, it is recommended to continue supporting allowlist mode
by performing the following actions:
Examine the events resulting from the operation of Application Control and reports on blocked runs to analyze
the e ectiveness of Application Control.
Analyze users' requests to access applications.
Analyze unfamiliar executable les by checking their reputation in Kaspersky Security Network.
Prior to installing updates for the operating system or for software, install those updates on a test group of
computers to check how they will be processed by Application Control rules.
Add the necessary applications to categories used in Application Control rules.
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Network ports monitoring
During the operation of Kaspersky Endpoint Security, the Web Control, Mail Threat Protection and Web Threat
Protection components monitor data streams that are transmitted via speci c protocols and that pass through
speci c open TCP and UDP ports on user computer. For example, the Mail Threat Protection component analyzes
information transmitted via SMTP, while the Web Threat Protection component analyzes information transmitted
via HTTP and FTP.
Kaspersky Endpoint Security divides TCP and UDP ports of the user's computer into several groups, depending on
the likelihood of their being compromised. Some network ports are reserved for vulnerable services. You are
advised to monitor these ports more thoroughly because they have a greater likelihood of being targeted by a
network attack. If you use non-standard services that rely on non-standard network ports, these network ports
may also be targeted by an attacking computer. You can specify a list of network ports and a list of applications
that request network access. These ports and applications then receive special attention from the Mail Threat
Protection and Web Threat Protection components during network tra ic monitoring.

Enabling monitoring of all network ports
To enable monitoring of all network ports:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Monitored ports section, select the Monitor all network ports option.
4. Save your changes.

Creating a list of monitored network ports
To create a list of monitored network ports:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Monitored ports section, select Monitor selected network ports only.
4. Click the Select button.
This opens a list of network ports that are normally used for transmission of email and network tra ic. This list
of network ports is included in the Kaspersky Endpoint Security package.
5. Use the toggle in the Status column to enable or disable network port monitoring.
6. If a network port is not shown in the list of network ports, add it by doing the following:
a. Click the Add button.
330

b. In the window that opens, enter the network port number and brief description.
c. Set the Active or Inactive status for the network port monitoring.
7. Save your changes.
When the FTP protocol runs in passive mode, the connection can be established via a random network port
that is not added to the list of monitored network ports. To protect such connections, enable monitoring of all
network ports or con gure control of network ports for applications that establish FTP connections.

Creating a list of applications for which all network ports are monitored
You can create a list of applications for which Kaspersky Endpoint Security monitors all network ports.
We recommend including applications that receive or transmit data via the FTP protocol in the list of
applications for which Kaspersky Endpoint Security monitors all network ports.

To create a list of applications for which all network ports are monitored:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Network settings.
3. In the Monitored ports section, select Monitor selected network ports only.
4. Select the Monitor all ports for the applications from the list recommended by Kaspersky check box.
If this check box is selected, Kaspersky Endpoint Security monitors all ports for the following applications:
Adobe Reader.
Apple Application Support.
Google Chrome.
Microsoft Edge.
Mozilla Firefox.
Internet Explorer.
Java.
mIRC.
Opera.
Pidgin.
Safari.
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Mail.ru Agent.
Yandex Browser.
5. Select the Monitor all ports for speci ed applications check box.
6. Click the Select button.
This opens a list of applications for which Kaspersky Endpoint Security monitors network ports.
7. Use the toggle in the Status column to enable or disable network port monitoring.
8. If an application is not included in the list of applications, add it as follows:
a. Click the Add button.
b. In the window that opens, enter the path to the executable le of the application and a brief description.
c. Set the Active or Inactive status for network ports monitoring.
9. Save your changes.

Exporting and importing lists of monitored ports
Kaspersky Endpoint Security uses the following lists to monitor network ports: list of network ports and list of
applications whose ports are monitored by Kaspersky Endpoint Security. You can export lists of monitored ports
to an XML le. Then you can modify the le to, for example, add a large number of ports with the same description.
You can also use the export/import function to back up the lists of monitored ports or to migrate the lists to a
di erent server.
How to export and import lists of monitored ports in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General settings → Network settings.
6. In the Monitored ports section, select Monitor selected network ports only.
7. Click the Settings button.
The Network ports window opens. The Network ports window displays a list of network ports that are
normally used for transmission of email and network tra ic. This list of network ports is included in the
Kaspersky Endpoint Security package.
8. To export the list of network ports:
a. In the list of network ports, select the ports that you want to export. To select multiple ports, use the
CTRL or SHIFT keys.
If you did not select any port, Kaspersky Endpoint Security will export all ports.
b. Click the Export button.
c. In the opened window, enter the name of the XML le to which you want to export the list of network
ports, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of network ports to the XML le.
9. To export the list of applications whose ports are monitored by Kaspersky Endpoint Security:
a. Select the Monitor all ports for speci ed applications check box.
b. In the list of applications, select the applications that you want to export. To select multiple ports, use
the CTRL or SHIFT keys.
If you did not select any application, Kaspersky Endpoint Security will export all applications.
c. Click the Export button.
d. In the window that opens, specify the name of the XML le to which you want to export the list of
applications, and select the folder in which you want to save this le.
e. Click the Save button.
Kaspersky Endpoint Security exports the entire list of applications to the XML le.
10. To import the list of network ports:
a. In the list of network ports, click the Import button.
In the window that opens, select the XML le from which you want to import the list of network ports.
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b. Click the Open button.
If the computer already has a list of network ports, Kaspersky Endpoint Security will prompt you to
delete the existing list or add new entries to it from the XML le.
11. To import a list of applications whose ports are monitored by Kaspersky Endpoint Security:
a. In the list of applications, click the Import button.
In the opened window, select the XML le from which you want to import the list of applications.
b. Click the Open button.
If the computer already has a list of applications, Kaspersky Endpoint Security will prompt you to delete
the existing list or to add new entries to it from the XML le.
12. Save your changes.
How to export / import lists of monitored ports in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import lists of monitored ports.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to the General settings → Network settings section.
5. To export the list of network ports:
a. In the Monitored ports section, select Monitor selected network ports only.
b. Click the N ports selected link.
The Network ports window opens. The Network ports window displays a list of network ports that are
normally used for transmission of email and network tra ic. This list of network ports is included in the
Kaspersky Endpoint Security package.
c. In the list of network ports, select the ports that you want to export.
d. Click the Export button.
e. In the opened window, enter the name of the XML le to which you want to export the list of network
ports, and select the folder in which you want to save this le.
f. Click the Save button.
Kaspersky Endpoint Security exports the entire list of network ports to the XML le.
6. To export the list of applications whose ports are monitored by Kaspersky Endpoint Security:
a. In the Monitored ports block, select the Monitor all ports for speci ed applications check box.
b. Click the N applications selected link.
c. In the list of applications, select the applications that you want to export.
d. Click the Export button.
e. In the window that opens, specify the name of the XML le to which you want to export the list of
applications, and select the folder in which you want to save this le.
f. Click the Save button.
Kaspersky Endpoint Security exports the entire list of applications to the XML le.
7. To import the list of network ports:
a. In the list of network ports, click the Import button.
In the window that opens, select the XML le from which you want to import the list of network ports.
b. Click the Open button.
If the computer already has a list of network ports, Kaspersky Endpoint Security will prompt you to
delete the existing list or add new entries to it from the XML le.
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8. To import a list of applications whose ports are monitored by Kaspersky Endpoint Security:
a. In the list of applications, click the Import button.
In the opened window, select the XML le from which you want to import the list of applications.
b. Click the Open button.
If the computer already has a list of applications, Kaspersky Endpoint Security will prompt you to delete
the existing list or to add new entries to it from the XML le.
9. Save your changes.
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Wipe Data
Kaspersky Endpoint Security lets you use a task to remotely delete data from users' computers.
Kaspersky Endpoint Security deletes data as follows:
In silent mode;
On hard drives and removable drives;
For all user accounts on the computer.
Kaspersky Endpoint Security performs the Wipe data task no matter which licensing type is being used, even
after the license has expired.

Data Wipe modes
This task enables you to delete data in the following modes:
Immediate data deletion.
In this mode, you can, for example, delete outdated data to free up disk space.
Postponed data deletion.
This mode is intended, for example, to protect data on a laptop in case it is lost or stolen. You can con gure
automatic data deletion if the laptop goes outside the boundaries of the corporate network and has not been
synchronized with Kaspersky Security Center in a long time.
It is not possible to set a schedule for deleting data in task properties. You can only delete data immediately
after starting the task manually, or con gure delayed data deletion if there is no connection with Kaspersky
Security Center.

Limitations
Data Wipe has the following limitations:
Only a Kaspersky Security Center administrator can manage the Wipe data task. You cannot con gure or start
a task in the local interface of Kaspersky Endpoint Security.
For the NTFS le system, Kaspersky Endpoint Security deletes only the names of the main data streams.
Alternate data stream names cannot be deleted.
When you delete a symbolic link le, Kaspersky Endpoint Security also deletes the les whose paths are
speci ed in the symbolic link.

Creating a Wipe data task
To delete data on users' computers:
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Wipe data.
c. In the Task name eld, enter a brief description, for example, Wipe data (Anti-Theft).
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
If new computers are added to an administration group within the task scope, the immediate data deletion
task is run on the new computers only if the task is completed within 5 minutes of the addition of the new
computers.
5. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
6. Click the Wipe data task of Kaspersky Endpoint Security.
The task properties window opens.
7. Select the Application settings tab.
8. Select the data deletion method:
Delete by means of the operating system. Kaspersky Endpoint Security uses the operating system
resources to delete les without sending them to the recycle bin.
Delete completely, no recovery possible. Kaspersky Endpoint Security overwrites les with random data. It
is practically impossible to restore data after it is deleted.
9. If you want to postpone data deletion, select the Automatically wipe data when there is no connection to
Kaspersky Security Center for more than N days check box. De ne the number of days.
The postponed data deletion task will be performed each time that a connection with Kaspersky Security
Center is absent for the de ned period of time.
When con guring postponed data deletion, bear in mind that employees may turn o their computer before
going on vacation. In this case, the absent connection term may be exceeded and data will be deleted. Also
consider the work schedule of o line users. For more details about working with o line computers and out-ofo ice users, refer to the Kaspersky Security Center Help .
If the check box is cleared, the task will be performed immediately after synchronization with Kaspersky
Security Center.
10. Create a list of objects to delete:
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Folders. Kaspersky Endpoint Security deletes all les in the folder, and its subfolders. Kaspersky Endpoint
Security does not support masks and environment variables for entering a folder path.
Files by extension. Kaspersky Endpoint Security searches for les with the speci ed extensions on all
computer drives, including removable drives. Use the ";" or "," characters to specify multiple extensions.
Prede ned folders. Kaspersky Endpoint Security will delete les from the following areas:
Documents. Files in the standard Documents folder of the operating system, and its subfolders.
Cookies. Files in which the browser saves data from the websites visited by the user (such as user
authorization data).
Desktop. Files in the standard Desktop folder of the operating system, and its subfolders.
Temporary Internet Explorer les. Temporary les related to the operation of Internet Explorer, such as
copies of web pages, images, and media les.
Temporary les. Temporary les related to the operation of applications installed on the computer. For
example, Microsoft O ice applications create temporary les containing backup copies of documents.
Outlook les. Files related to the operation of the Outlook mail client: data les (PST), o line data les
(OST), o line address book les (OAB), and personal address book les (PAB).
User pro le. Set of les and folders that store operating system settings for the local user account.
You can create a list of objects to delete on each tab. Kaspersky Endpoint Security will create a consolidated
list and delete les from this list when a task is complete.
You cannot delete les that are required for operation of Kaspersky Endpoint Security.
11. Click the Save button.
12. Select the check box next to the task.
13. Click the Run button.
As a result, data on users' computers will be deleted according to the selected mode: immediate or when a
connection is absent. If Kaspersky Endpoint Security cannot delete a le, such as when a user is currently using a
le, the application does not attempt to delete it again. To complete data deletion, run the task again.
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Password protection
Multiple users with di erent levels of computer literacy can share a computer. If users have unrestricted access to
Kaspersky Endpoint Security and its settings, the overall level of computer protection may be reduced. Password
protection lets you restrict users' access to Kaspersky Endpoint Security according to the permissions granted to
them (for example, permission to exit the application).
If the user that started the Windows session (session user) has the permission to perform the action, Kaspersky
Endpoint Security does not request the user name and password or a temporary password. The user receives
access to Kaspersky Endpoint Security in accordance with the granted permissions.
If a session user does not have the permission to perform an action, the user can obtain access to the application
in the following ways:
Enter a user name and password.
This method is suitable for day-to-day operations. To perform a password-protected action, you must enter
the domain account credentials of the user with the required permission. In this case, the computer must be in
that domain. If the computer is not in the domain, you can use the KLAdmin account.
Enter a temporary password.
This method is suitable for granting temporary permissions to perform blocked actions (for example, exiting the
application) to users outside the corporate network. When a temporary password expires or a session ends,
Kaspersky Endpoint Security reverts its settings to their previous state.
When a user attempts to perform a password-protected action, Kaspersky Endpoint Security prompts the user
for the user name and password or temporary password (see the gure below).
In the password entry window, you can switch languages only by pressing ALT+SHIFT. Using other shortcuts,
even if they are con gured in the operating system, do not work for switching languages.

Kaspersky Endpoint Security access password prompt

User name and password
To access Kaspersky Endpoint Security, you must enter your domain account credentials. Password protection
supports the following accounts:
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KLAdmin. An Administrator account with unrestricted access to Kaspersky Endpoint Security. The KLAdmin
account has the right to perform any action that is password-protected. The permissions for the KLAdmin
account cannot be revoked. When you enable password protection, Kaspersky Endpoint Security prompts you
to set a password for the KLAdmin account.
The Everyone group. A built-in Windows group that includes all users within the corporate network. Users in
the Everyone group can access the application according to the permissions that are granted to them.
Individual users or groups. User accounts for which you can con gure individual permissions. For example, if an
action is blocked for the Everyone group, you can allow this action for an individual user or a group.
Session user. Account of the user who started the Windows session. You can switch to another session user
when prompted for a password (the Save password for current session check box). In this case, Kaspersky
Endpoint Security regards the user whose account credentials were entered as the session user instead of the
user who started the Windows session.

Temporary password
A temporary password can be used to grant temporary access to Kaspersky Endpoint Security for an individual
computer outside of the corporate network. The Administrator generates a temporary password for an individual
computer in the computer properties in Kaspersky Security Center. The Administrator selects the actions that will
be protected with the temporary password, and speci es the temporary password's validity period.

Password protection operating algorithm
Kaspersky Endpoint Security decides whether to allow or block a password-protected action based on the
following algorithm (see the gure below).
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Password protection operating algorithm

Enabling Password protection
Password protection lets you restrict users' access to Kaspersky Endpoint Security according to the permissions
granted to them (for example, permission to exit the application).

To enable password protection:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. Use the Password protection toggle to enable or disable the component.
4. Specify the password for the KLAdmin account and con rm it.
The KLAdmin account has the right to perform any action that is password-protected.
If a computer is running under a policy, the Administrator can reset the password for the KLAdmin account
in the policy properties. If the computer is not connected to Kaspersky Security Center and you have
forgotten the password for the KLAdmin account, it is not possible to recover the password.
5. Set permissions for all users within the corporate network:
a. In the Permissions table, click the Edit button to open the list of permissions for the Everyone group.

The Everyone group is a built-in Windows group that includes all users within the corporate network.
b. Select the check boxes next to the actions that users will be allowed to perform without entering the
password.
If a check box is cleared, the users are blocked from performing the action. For example, if the check box
next to the Exit the application permission is cleared, you can exit the application only if you are logged in as
KLAdmin, or as an individual user who has the required permission, or if you enter a temporary password.
Password protection permissions have some important aspects to consider. Make sure that all
conditions for accessing Kaspersky Endpoint Security are ful lled.
c. Click the OK button.
6. Save your changes.
When password protection is enabled, the application will restrict users' access to Kaspersky Endpoint Security
according to the permissions granted to the Everyone group. You can perform the actions that are blocked for
the Everyone group only if you use the KLAdmin account, another account that is granted the required
permissions, or if you enter a temporary password.

You can disable Password protection only if you are logged in as KLAdmin. It is not possible to disable
password protection if you are using any other user account or a temporary password.
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During the password check, you can select the Save password for current session check box. In this case,
Kaspersky Endpoint Security will not prompt for a password when a user attempts to perform another passwordprotected action for the duration of the session.

Granting permissions to individual users or groups
You can grant access to Kaspersky Endpoint Security to individual users or groups. For example, if exiting the
application is blocked for the Everyone group, you can grant the Exit the application permission to an individual
user. As a result, you can exit the application only if you are logged in as that user or as KLAdmin.
You can use account credentials to access the application only if the computer is in the domain. If the
computer is not in the domain, you can use the KLAdmin account or a temporary password.

To grant permissions to individual users or groups:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. In the Password protection table, click the Add button.
4. In the opened window, click the Select user or group button.
The standard Select Users or Groups dialog opens.
5. Select a user or a group in Active Directory and con rm your selection.
6. In the Permissions list, select the check boxes next to the actions that the selected user or group will be
allowed to perform without being prompted for a password.
If a check box is cleared, the users are blocked from performing the action. For example, if the check box next
to the Exit the application permission is cleared, you can exit the application only if you are logged in as
KLAdmin, or as an individual user who has the required permission, or if you enter a temporary password.
Password protection permissions have some important aspects to consider. Make sure that all conditions
for accessing Kaspersky Endpoint Security are ful lled.
7. Save your changes.
As a result, if access to the application is restricted for the Everyone group, users will be granted permissions to
access Kaspersky Endpoint Security according to the users' individual permissions.

Using a temporary password to grant permissions
A temporary password can be used to grant temporary access to Kaspersky Endpoint Security for an individual
computer outside of the corporate network. This is necessary to allow the user to perform a blocked action
without obtaining the KLAdmin account credentials. To use a temporary password, the computer must be added
to Kaspersky Security Center.

To allow a user to perform a blocked action using a temporary password:
1. Open the Kaspersky Security Center Administration Console.
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2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. Double-click to open the computer properties window.
5. In the computer properties window, select the Applications section.
6. In the list of Kaspersky applications installed on the computer, select Kaspersky Endpoint Security for
Windows and double-click to open the application properties.
7. In the application settings window, select General settings → Interface.
8. In the Password protection section, click the Settings button.
The Password protection window opens.
9. In the Temporary password section, click the Settings button.
The Create temporary password window opens.
10. In the Expiration date eld, specify the expiration date when the temporary password will expire.
11. In the Temporary password scope table, select the check boxes next to the actions that will be available to the
user after entering the temporary password.
12. Click the Create button.
A window containing the temporary password opens (see the gure below).
13. Copy the password and provide it to the user.

Temporary password

Special aspects of Password protection permissions
Password protection permissions have some important aspects and limitations to consider.

Application settings
If a user's computer is running under a policy, make sure that all the required settings in the policy are available for
editing (the attributes are open).
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Exit the application
There are no special considerations or limitations.

Disable protection components
It is not possible to grant the permission to disable protection components for the Everyone group. To allow
users other than KLAdmin to disable protection components, add a user or group that has the Disable
protection components permission in the Password Protection settings.
If a user's computer is running under a policy, make sure that all the required settings in the policy are available
for editing (the attributes are open).
To disable protection components in the application settings, a user must have the Con gure application
settings permission.
To disable protection components from the context menu (by using the Pause protection menu item), a user
must have the Disable control components permission in addition to the Disable protection components
permission.

Disable control components
It is not possible to grant the permission to disable control components for the Everyone group. To allow users
other than KLAdmin to disable control components, add a user or group that has the Disable control
components permission in the Password Protection settings.
If a user's computer is running under a policy, make sure that all the required settings in the policy are available
for editing (the attributes are open).
To disable control components in the application settings, a user must have the Con gure application settings
permission.
To disable control components from the context menu (by using the Pause protection menu item), a user must
have the Disable protection components permission in addition to the Disable control components
permission.

Disable Kaspersky Security Center policy
You cannot grant the "Everyone" group the permission to disable the Kaspersky Security Center policy. To allow
users other than KLAdmin to disable the policy, add a user or a group that has the Disable Kaspersky Security
Center policy permission in the Password Protection settings.

Remove key
There are no special considerations or limitations.

Remove / modify / restore the application
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If you have allowed removing, modifying, and restoring the application for the "All" group, Kaspersky Endpoint
Security does not request a password when the user attempts to carry out these operations. Therefore, any user
including users from outside the domain, can install, modify, or restore the application.

Restore access to data on encrypted drives
You can restore access to data on encrypted drives only if you are logged in as KLAdmin. Permission to perform
this action cannot be granted to any other user.

Viewing reports
There are no special considerations or limitations.

Restore from Backup
There are no special considerations or limitations.
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Trusted zone
A trusted zone is a system administrator-con gured list of objects and applications that Kaspersky Endpoint
Security does not monitor when active.
The administrator forms the trusted zone independently, taking into account the features of the objects that are
handled and the applications that are installed on the computer. It may be necessary to include objects and
applications in the trusted zone when Kaspersky Endpoint Security blocks access to a certain object or
application, if you are sure that the object or application is harmless. An administrator can also allow a user to
create their own local trusted zone for a speci c computer. This way, users can create their own local lists of
exclusions and trusted applications in addition to the general trusted zone in a policy.

Creating a scan exclusion
A scan exclusion is a set of conditions that must be ful lled so that Kaspersky Endpoint Security will not scan a
particular object for viruses and other threats.
Scan exclusions make it possible to safely use legitimate software that can be exploited by criminals to damage the
computer or user data. Although they do not have any malicious functions, such applications can be exploited by
intruders. For details on legitimate software that could be used by criminals to harm the computer or personal data
of a user, please refer to the Kaspersky IT Encyclopedia website .
Such applications may be blocked by Kaspersky Endpoint Security. To prevent them from being blocked, you can
con gure scan exclusions for the applications in use. To do so, add the name or name mask that is listed in the
Kaspersky IT Encyclopedia to the trusted zone. For example, you often use the Radmin application for remote
administration of computers. Kaspersky Endpoint Security regards this activity as suspicious and may block it. To
prevent the application from being blocked, create a scan exclusion with the name or name mask that is listed in
the Kaspersky IT Encyclopedia.
If an application that collects information and sends it to be processed is installed on your computer, Kaspersky
Endpoint Security may classify this application as malware. To avoid this, you can exclude the application from
scanning by con guring Kaspersky Endpoint Security as described in this document.
Scan exclusions can be used by the following application components and tasks that are con gured by the system
administrator:
Behavior Detection.
Exploit Prevention.
Host Intrusion Prevention.
File Threat Protection.
Web Threat Protection.
Mail Threat Protection.
Scan tasks.
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Kaspersky Endpoint Security does not scan an object if the drive or folder containing this object is included in
the scan scope at the start of one of the scan tasks. However, the scan exclusion is not applied when a
custom scan task is started for this particular object.
How to create a scan exclusion in the Administration Console (MMC)

348

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General settings → Exclusions.
6. In the Scan exclusions and trusted applications section, click the Settings button.
7. In the Trusted zone window, select the Scan exclusions tab.
This opens a window containing a list of exclusions.
8. Select the Merge values when inheriting check box if you want to create a consolidated list of exclusions
for all computers in the company. The lists of exclusions in the parent and child policies will be merged. The
lists will be merged provided that merging values when inheriting is enabled. Exclusions from the parent
policy are displayed in child policies in a read-only view. Changing or deleting exclusions of the parent policy
is not possible.
9. Select the Allow use of local exclusions check box if you want to enable the user to create a local list of
exclusions. This way, a user can create their own local list of exclusions in addition to the general list of
exclusions generated in the policy. An administrator can use Kaspersky Security Center to view, add, edit,
or delete list items in the computer properties.
If the check box is cleared, the user can access only the general list of exclusions generated in the policy. If
a local list was generated, after this functionality is disabled Kaspersky Endpoint Security continues
excluding the listed les from scans.
10. Click the Add button.
11. To exclude a le or folder from scanning:
a. In the Properties section, select the File or folder check box.
b. Click the select le or folder link in the Scan exclusion description section to open the Name of le or
folder window.
c. Enter the le or folder name or the mask of the le or folder name, or select the le or folder in the
folder tree by clicking Browse.
Use masks:
The * (asterisk) character, which takes the place of any set of characters, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\*\*.txt will include all paths to les with the TXT extension located in folders on the
C: drive, but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the
le or folder name, including the \ and / characters (delimiters of the names of les and folders in
paths to les and folders). For example, the mask C:\Folder\**\*.txt will include all paths to les
with the TXT extension located in the folder named Folder and its subfolders. The mask must
include at least one nesting level. The mask C:\**\*.txt is not a valid mask.
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The ? (question mark) character, which takes the place of any single character, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example,
the mask C:\Folder\???.txt will include paths to all les residing in the folder named Folder that
have the TXT extension and a name consisting of three characters.
d. In the Name of le or folder window, click OK.
A link to the added le or folder appears in the Scan exclusion description section of the Scan
exclusion window.
12. To exclude objects with a speci c name from scanning:
a. In the Properties section, select the Object name check box.
b. Click the enter object name link in the Scan exclusion description section to open the Object name
window.
c. Enter the name of the object type according to the classi cation of the Kaspersky Encyclopedia
example, Email-Worm, Rootkit or RemoteAdmin).

(for

You can use masks with the ? character (replaces any single character) and the * character (replaces
any number of characters). For example, if the Client* mask is speci ed, Kaspersky Endpoint Security
excludes Client-IRC, Client-P2P and Client-SMTP objects from scans.
d. Click OK in the Object name window.
A link to the added object name appears in the Scan exclusion description section of the Scan
exclusion window.
13. If you want to exclude an individual le from scans:
a. In the Properties section, select the Object hash check box.
b. Click the object hash entry link to open the Object hash window.
c. Enter the le hash or select the le by clicking the Browse button.
If the le is modi ed, the le hash will also be modi ed. If this happens, the modi ed le will not be
added to exclusions.
d. Click OK in the Object hash window.
A link to the added object appears in the Scan exclusion description block of the Scan exclusion
window.
14. If necessary, in the Comment eld, enter a brief comment on the scan exclusion that you are creating.
15. Specify the Kaspersky Endpoint Security components that should use the scan exclusion:
a. Click the any link in the Scan exclusion description section to activate the select components link.
b. Click the select components link to open the Protection components window.
c. Select the check boxes opposite the components to which the scan exclusion must be applied.
d. In the Protection components window, click OK.
If the components are speci ed in the settings of the scan exclusion, this exclusion is applied only during
scanning by these components of Kaspersky Endpoint Security.
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If the components are not speci ed in the settings of the scan exclusion, this exclusion is applied during
scanning by all components of Kaspersky Endpoint Security.
16. You can use the check box to stop an exclusion at any time.
17. Save your changes.
How to create a scan exclusion in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for the computers on which you want to add an
exclusion.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Exclusions.
5. In the Scan exclusions and trusted applications block, click the Scan exclusions link.
6. Select the Merge values when inheriting check box if you want to create a consolidated list of exclusions
for all computers in the company. The lists of exclusions in the parent and child policies will be merged. The
lists will be merged provided that merging values when inheriting is enabled. Exclusions from the parent
policy are displayed in child policies in a read-only view. Changing or deleting exclusions of the parent policy
is not possible.
7. Select the Allow use of local exclusions check box if you want to enable the user to create a local list of
exclusions. This way, a user can create their own local list of exclusions in addition to the general list of
exclusions generated in the policy. An administrator can use Kaspersky Security Center to view, add, edit,
or delete list items in the computer properties.
If the check box is cleared, the user can access only the general list of exclusions generated in the policy. If
a local list was generated, after this functionality is disabled Kaspersky Endpoint Security continues
excluding the listed les from scans.
8. Click the Add button.
9. Select how you want to add the exclusion: File or folder, Object name or Object hash.
10. If you want to exclude a le or folder from scans, select the le or folder by clicking the Browse button.
You can also manually enter the path. Kaspersky Endpoint Security supports the * and ? characters when
entering a mask:
The * (asterisk) character, which takes the place of any set of characters, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example, the
mask C:\*\*.txt will include all paths to les with the TXT extension located in folders on the C: drive,
but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the
le or folder name, including the \ and / characters (delimiters of the names of les and folders in
paths to les and folders). For example, the mask C:\Folder\**\*.txt will include all paths to les
with the TXT extension located in the folder named Folder and its subfolders. The mask must include
at least one nesting level. The mask C:\**\*.txt is not a valid mask.
The ? (question mark) character, which takes the place of any single character, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example, the
mask C:\Folder\???.txt will include paths to all les residing in the folder named Folder that have
the TXT extension and a name consisting of three characters.
11. If you want to exclude a speci c type of object from scans, in the Object eld enter the name of the
object type according to the classi cation of the Kaspersky Encyclopedia (for example, Email-Worm,
Rootkit or RemoteAdmin).
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You can use masks with the ? character (replaces any single character) and the * character (replaces any
number of characters). For example, if the Client* mask is speci ed, Kaspersky Endpoint Security
excludes Client-IRC, Client-P2P and Client-SMTP objects from scans.
12. If you want to exclude an individual le from scans, enter the le hash in the File hash eld.
If the le is modi ed, the le hash will also be modi ed. If this happens, the modi ed le will not be added to
exclusions.
13. In the Protection components block, select the components that you want the scan exclusion to apply to.
14. If necessary, in the Comment eld, enter a brief comment on the scan exclusion that you are creating.
15. You can use the toggle to stop an exclusion at any time.
16. Save your changes.
How to create a scan exclusion in the application interface

353

1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Exclusions block, click the Manage exclusions link.
4. Click the Add button.
5. If you want to exclude a le or folder from scans, select the le or folder by clicking the Browse button.
You can also manually enter the path. Kaspersky Endpoint Security supports the * and ? characters when
entering a mask:
The * (asterisk) character, which takes the place of any set of characters, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example, the
mask C:\*\*.txt will include all paths to les with the TXT extension located in folders on the C: drive,
but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the
le or folder name, including the \ and / characters (delimiters of the names of les and folders in
paths to les and folders). For example, the mask C:\Folder\**\*.txt will include all paths to les
with the TXT extension located in the folder named Folder and its subfolders. The mask must include
at least one nesting level. The mask C:\**\*.txt is not a valid mask.
The ? (question mark) character, which takes the place of any single character, except the \ and /
characters (delimiters of the names of les and folders in paths to les and folders). For example, the
mask C:\Folder\???.txt will include paths to all les residing in the folder named Folder that have
the TXT extension and a name consisting of three characters.
6. If you want to exclude a speci c type of object from scans, in the Object eld enter the name of the
object type according to the classi cation of the Kaspersky Encyclopedia (for example, Email-Worm,
Rootkit or RemoteAdmin).
You can use masks with the ? character (replaces any single character) and the * character (replaces any
number of characters). For example, if the Client* mask is speci ed, Kaspersky Endpoint Security
excludes Client-IRC, Client-P2P and Client-SMTP objects from scans.
7. If you want to exclude an individual le from scans, enter the le hash in the File hash eld.
If the le is modi ed, the le hash will also be modi ed. If this happens, the modi ed le will not be added to
exclusions.
8. In the Protection components block, select the components that you want the scan exclusion to apply to.
9. If necessary, in the Comment eld, enter a brief comment on the scan exclusion that you are creating.
10. Select the Active status for the exclusion.
You can use the toggle to stop an exclusion at any time.
11. Save your changes.

Path mask examples:
Paths to les located in any folder:
The mask *.exe will include all paths to les that have the exe extension.
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The mask example* will include all paths to les named EXAMPLE.
Paths to les located in a speci ed folder:
The C:\dir\*.* mask will include all paths to les located in the C:\dir\ folder, but not in the subfolders of
C:\dir\.
The mask C:\dir\* will include all paths to les located in the C:\dir\ folder, but not in the subfolders of
C:\dir\.
The mask C:\dir\ will include all paths to les located in the C:\dir\ folder, but not in the subfolders of
C:\dir\.
The mask C:\dir\*.exe will include all paths to les with the EXE extension located in the C:\dir\ folder,
but not in the subfolders of C:\dir\.
The mask C:\dir\test will include all paths to les named "test" located in the C:\dir\ folder, but not in
the subfolders of C:\dir\.
The mask C:\dir\*\test will include all paths to les named "test" located in the C:\dir\ folder and in the
subfolders of C:\dir\.
Paths to les located in all folders with a speci ed name:
The mask dir\*.* will include all paths to les in folders named "dir", but not in the subfolders of those
folders.
The mask dir\* will include all paths to les in folders named "dir", but not in the subfolders of those
folders.
The mask dir\ will include all paths to les in folders named "dir", but not in the subfolders of those folders.
The mask dir\*.exe will include all paths to les with the EXE extension in folders named "dir", but not in
the subfolders of those folders.
The mask dir\test will include all paths to les named "test" in folders named "dir", but not in the
subfolders of those folders.

Enabling and disabling a scan exclusion
To enable or disable a scan exclusion:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Exclusions block, click the Manage exclusions link.
4. Select the exclusion that you need in the list of scan exclusions.
5. Use the toggle next to an object to include this object in the scan scope or exclude it.
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6. Save your changes.

Editing the list of trusted applications
The list of trusted applications is a list of applications whose le and network activity (including malicious activity)
and access to the system registry are not monitored by Kaspersky Endpoint Security. By default, Kaspersky
Endpoint Security scans objects that are opened, executed, or saved by any application process and controls the
activity of all applications and network tra ic that is generated by them. However, an application that has been
added to the list of trusted applications is excluded from scans by Kaspersky Endpoint Security.
For example, if you consider objects that are used by the standard Microsoft Windows Notepad application to be
safe without scanning, meaning that you trust this application, you can add Microsoft Windows Notepad to the list
of trusted applications. Scanning then skips objects that are used by this application.
In addition, certain actions that are classi ed by Kaspersky Endpoint Security as suspicious may be safe within the
context of the functionality of a number of applications. For example, the interception of text that is typed from
the keyboard is a routine process for automatic keyboard layout switchers (such as Punto Switcher). To take
account of the speci cs of such applications and exclude their activity from monitoring, we recommend that you
add such applications to the trusted applications list.
Excluding trusted applications from scanning allows avoiding compatibility con icts between Kaspersky Endpoint
Security and other programs (for example, the problem of double-scanning of the network tra ic of a third-party
computer by Kaspersky Endpoint Security and by another anti-virus application), and also increases the
computer's performance, which is critical when using server applications.
At the same time, the executable le and process of the trusted application are still scanned for viruses and other
malware. An application can be fully excluded from Kaspersky Endpoint Security scanning by means of scan
exclusions.
How to add an application to the trusted list in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select General settings → Exclusions.
6. In the Scan exclusions and trusted applications section, click the Settings button.
7. In the Trusted zone window, select the Trusted applications tab.
This opens a window containing a list of trusted applications.
8. Select the Merge values when inheriting check box if you want to create a consolidated list of trusted
applications for all computers in the company. The lists of trusted applications in the parent and child
policies will be merged. The lists will be merged provided that merging values when inheriting is enabled.
Trusted applications from the parent policy are displayed in child policies in a read-only view. Changing or
deleting trusted applications of the parent policy is not possible.
9. Select the Allow use of local trusted applications check box if you want to enable the user to create a
local list of trusted applications. This way, a user can create their own local list of trusted applications in
addition to the general list of trusted applications generated in the policy. An administrator can use
Kaspersky Security Center to view, add, edit, or delete list items in the computer properties.
If the check box is cleared, the user can access only the general list of trusted applications generated in
the policy. If a local list was generated, after this functionality is disabled Kaspersky Endpoint Security
continues excluding the listed trusted applications from scans.
10. Click the Add button.
11. In the opened window, enter the path to the executable le of the trusted application.
Kaspersky Endpoint Security supports environment variables and the * and ? characters when entering a
mask.
Kaspersky Endpoint Security does not support the %userprofile% environment variable when
generating a list of trusted applications on the Kaspersky Security Center console. To apply the entry
to all user accounts, you can use the * character (for example, C:\Users\*\Documents\File.exe).

Whenever you add a new environment variable, you need to restart the application.
12. Con gure the advanced settings for the trusted application (see the table below).
13. You can use the check box to exclude an application from the trusted zone at any time.
14. Save your changes.
How to add an application to the trusted list in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to add the
application to the trusted list.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Exclusions.
5. In the Scan exclusions and trusted applications block, click the Trusted applications link.
This opens a window containing a list of trusted applications.
6. Select the Merge values when inheriting check box if you want to create a consolidated list of trusted
applications for all computers in the company. The lists of trusted applications in the parent and child
policies will be merged. The lists will be merged provided that merging values when inheriting is enabled.
Trusted applications from the parent policy are displayed in child policies in a read-only view. Changing or
deleting trusted applications of the parent policy is not possible.
7. Select the Allow use of local trusted applications check box if you want to enable the user to create a
local list of trusted applications. This way, a user can create their own local list of trusted applications in
addition to the general list of trusted applications generated in the policy. An administrator can use
Kaspersky Security Center to view, add, edit, or delete list items in the computer properties.
If the check box is cleared, the user can access only the general list of trusted applications generated in
the policy. If a local list was generated, after this functionality is disabled Kaspersky Endpoint Security
continues excluding the listed trusted applications from scans.
8. Click the Add button.
9. In the opened window, enter the path to the executable le of the trusted application.
Kaspersky Endpoint Security supports environment variables and the * and ? characters when entering a
mask.
Kaspersky Endpoint Security does not support the %userprofile% environment variable when
generating a list of trusted applications on the Kaspersky Security Center console. To apply the entry
to all user accounts, you can use the * character (for example, C:\Users\*\Documents\File.exe).

Whenever you add a new environment variable, you need to restart the application.
10. Con gure the advanced settings for the trusted application (see the table below).
11. You can use the check box to exclude an application from the trusted zone at any time.
12. Save your changes.
How to add an application to the trusted list in the application interface
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1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Exclusions block, click the Specify trusted applications link.
4. In the window, click the Add button.
5. Select the executable le of the trusted application.
You can also manually enter the path. Kaspersky Endpoint Security supports environment variables and the
* and ? characters when entering a mask.
Kaspersky Endpoint Security supports environment variables and converts the path in the local
interface of the application. In other words, if you enter the le path
%userprofile%\Documents\File.exe, a C:\Users\Fred123\Documents\File.exe record is
added in local interface of the application for user Fred123. Accordingly, Kaspersky Endpoint Security
ignores the File.exe trusted program for other users. To apply the entry to all user accounts, you
can use the * character (for example, C:\Users\*\Documents\File.exe).

Whenever you add a new environment variable, you need to restart the application.
6. In the trusted application properties window, con gure the advanced settings (see the table below).
7. You can use the toggle to exclude an application from the trusted zone at any time.
8. Save your changes.
Trusted application settings

Parameter

Description

Do not scan
opened les

All les that are opened by the application are excluded from scans by Kaspersky
Endpoint Security. For example, if you are using applications to back up les, this feature
helps reduce the consumption of resources by Kaspersky Endpoint Security.

Do not monitor
application
activity

Kaspersky Endpoint Security will not monitor the application's le- and network activity
in the operating system. Application activity is monitored by the following components:
Behavior Detection, Exploit Prevention, Host Intrusion Prevention, Remediation Engine
and Firewall.

Do not inherit
restrictions of
the parent
process
(application)

The restrictions con gured for the parent process will not be applied by Kaspersky
Endpoint Security to a child process. The parent process is started by an application for
which application rights (Host Intrusion Prevention) and application network rules
(Firewall) are con gured.

Do not monitor
child application
activity

Kaspersky Endpoint Security will not monitor the le activity or network activity of
applications that are started by this application.

Allow
interaction with
the application
interface

Kaspersky Endpoint Security Self-Defense blocks all attempts to manage application
services from a remote computer. If the check box is selected, the remote access
application is allowed to manage Kaspersky Endpoint Security settings through the
Kaspersky Endpoint Security interface.
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Do not block
interaction with
AMSI
Protection
component

Kaspersky Endpoint Security will not monitor the trusted application's requests for
objects to be scanned by the AMSI Protection component.

(available only in
the Kaspersky
Security Center
Console)
Do not scan
network tra ic

Network tra ic initiated by the application will be excluded from scans by Kaspersky
Endpoint Security. You can exclude either all tra ic or only encrypted tra ic from scans.
You can also exclude individual IP addresses and port numbers from scans.

Comment

If necessary, you can provide a brief comment for the trusted application. Comments
help simplify searches and sorting of trusted applications.

Status

Status of the trusted application:
Active status means that the application is in the trusted zone.
Inactive status means that the application is excluded from the trusted zone.

Enabling and disabling trusted zone rules for an application in the list of
trusted applications
To enable or disable the action of trusted zone rules applied to an application from the list of trusted applications:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Exclusions block, click the Specify trusted applications link.
4. In the list of trusted applications, select the necessary trusted application.
5. Use the toggle in the Status column to include a trusted application in the scan scope or exclude it.
6. Save your changes.

Using trusted system certi cate storage
Use of system certi cate storage lets you exclude applications signed by a trusted digital signature from virus
scans. Kaspersky Endpoint Security automatically assigns such applications to the Trusted group.

To begin using trusted system certi cate storage:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
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3. In the Trusted system certi cate store drop-down list, select which system store must be considered as
trusted by Kaspersky Endpoint Security.
4. Save your changes.
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Managing Backup
Backup stores backup copies of les that were deleted or modi ed during disinfection. A backup copy is a le
copy created before the le was disinfected or deleted. Backup copies of les are stored in a special format and
do not pose a threat.
Backup copies of les are stored in the folder C:\ProgramData\Kaspersky Lab\KES\QB.
Users in the Administrators group are granted full permission to access this folder. Limited access rights to this
folder are granted to the user whose account was used to install Kaspersky Endpoint Security.
Kaspersky Endpoint Security does not provide the capability to con gure user access permissions to backup
copies of les.
Sometimes it is not possible to maintain the integrity of les during disinfection. If you partially or completely lose
access to important information in a disinfected le after disinfection, you can attempt to restore the le from its
backup copy to its original folder.
If Kaspersky Endpoint Security is running under the management of Kaspersky Security Center, backup copies of
les may be transmitted to the Kaspersky Security Center Administration Server. For more details about managing
backup copies of les in Kaspersky Security Center, please refer to the Kaspersky Security Center Help system.

Con guring the maximum storage period for les in Backup
The default maximum storage period for copies of les in Backup is 30 days. After expiration of the maximum
storage term, Kaspersky Endpoint Security deletes the oldest les from Backup.

To con gure the maximum storage period for les in Backup:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Reports and Storage section.
3. If you want to limit the storage period for copies of les in Backup, select the Store objects no longer than N
days check box in the Backup block. In the eld on the right of the Store objects no longer than N days check
box, specify the maximum storage period for copies of les in Backup.
4. Save your changes.

Con guring the maximum size of Backup
You can specify the maximum size of Backup. The size of Backup is unlimited by default. After the maximum size is
reached, Kaspersky Endpoint Security automatically deletes the oldest les from Backup so that the maximum size
is not exceeded.

To con gure the maximum size of Backup:
1. In the main application window, click the button

.
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2. In the application settings window, select the Advanced settings → Reports and Storage section.
3. If you want to limit the size of Backup, select the Limit the size of Backup to N MB check box in
the Backup block. Specify the maximum size of Backup.
4. Save your changes.

Restoring les from Backup
If malicious code is detected in a le, Kaspersky Endpoint Security blocks the le, assigns the Infected status to it,
places a copy of it in Backup, and attempts to disinfect it. If le disinfection succeeds, the status of the backup
copy of the le changes to Disinfected. The le becomes available in its original folder. If a le cannot be
disinfected, Kaspersky Endpoint Security deletes it from its original folder. You can restore the le from its backup
copy to its original folder.
Files with the Will be disinfected on computer restart status cannot be restored. Restart the computer, and the le
status will change to Disinfected or Deleted. You can also restore the le from its backup copy to its original folder.
Upon detecting malicious code in a le that is part of the Windows Store application, Kaspersky Endpoint
Security immediately deletes the le without moving a copy of the le to Backup. You can restore the integrity
of the Windows Store application by using the appropriate tools of the Microsoft Windows 8 operating
system (see the Microsoft Windows 8 help les for details on restoring a Windows Store application).
The set of backup copies of les is presented as a table. For a backup copy of a le, the path to the original folder
of the le is displayed. The path to the original folder of the le may contain personal data.
If several les with identical names and di erent content located in the same folder are moved to Backup, only
the le that was last placed in Backup can be restored.

To restore les from Backup:
1. In the main application window, in the Monitoring section, click the Backup tile.
2. This opens the list of les in Backup; in that list, select the les that you want to restore and click Restore.
Kaspersky Endpoint Security restores les from the selected backup copies to their original folders.

Deleting backup copies of les from Backup
Kaspersky Endpoint Security automatically deletes backup copies of les with any status from Backup after the
storage term con gured in application settings has elapsed. You can also manually delete any copy of a le from
Backup.

To delete backup copies of les from Backup:
1. In the main application window, in the Monitoring section, click the Backup tile.
2. This opens the list of les in Backup; in this list, select les that you want to delete from Backup and click
Delete. You can also delete all les from Backup by clicking the Remove all button.
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Kaspersky Endpoint Security deletes the selected backup copies of les from Backup.
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Noti cation service
All sorts of events occur during the operation of Kaspersky Endpoint Security. Noti cations of these events can
be either be purely informational or contain critical information. For example, noti cations may inform of a
successful database and application modules update or log component errors that need remedying.
Kaspersky Endpoint Security supports the logging of information about events in the operation of the Microsoft
Windows application log and / or the Kaspersky Endpoint Security event log.
Kaspersky Endpoint Security delivers noti cations in the following ways:
using pop-up noti cations in the Microsoft Windows taskbar noti cation area;
by email.
You can con gure the delivery of event noti cations. The method of noti cation delivery is con gured for each
type of event.
When using the table of events to con gure the noti cation service, you can perform the following actions:
Filter noti cation service events by column values or by custom lter conditions.
Use the search function for noti cation service events.
Sort noti cation service events.
Change the order and set of columns that are displayed in the list of noti cation service events.

Con guring event log settings
To con gure event log settings:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. Under Noti cations, click Noti cation settings.
Kaspersky Endpoint Security components and tasks are shown in the left part of the window. The right part of
the window lists the events generated for the selected component or task.
Events may contain the following user data:
Paths to les scanned by Kaspersky Endpoint Security.
Paths to registry keys modi ed during the operation of Kaspersky Endpoint Security.
Microsoft Windows user name.
Addresses of web pages opened by the user.
4. In the left part of the window, select the component or task for which you want to con gure the event log
settings.
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5. Select check boxes opposite the relevant events in the Save in local report and Save in Windows Event Log
columns.
Events whose check boxes are selected in the Save in local report column are displayed in Applications and
Services Logs in the Kaspersky Event Log section. Events whose check boxes are selected in the Save in
Windows Event Log column are displayed in Windows logs in the Application section. To open the event logs,
select Start → Control Panel → Administration → Event Viewer.
6. Save your changes.

Con guring the display and delivery of noti cations
To con gure the display and delivery of noti cations:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. Under Noti cations, click Noti cation settings.
Kaspersky Endpoint Security components and tasks are shown in the left part of the window. The right part of
the window lists events generated for the selected component or the selected task.
Events may contain the following user data:
Paths to les scanned by Kaspersky Endpoint Security.
Paths to registry keys modi ed during the operation of Kaspersky Endpoint Security.
Microsoft Windows user name.
Addresses of web pages opened by the user.
4. In the left part of the window, select the component or task for which you want to con gure the delivery of
noti cations.
5. In the Notify on screen column, select the check boxes next to the required events.
Information about the selected events is displayed on the screen as pop-up messages in the Microsoft
Windows taskbar noti cation area.
6. In the Notify by email column, select the check boxes next to the required events.
Information about the selected events is delivered by email if the mail noti cation delivery settings are
con gured.
7. Click OK.
8. If you enabled email noti cations, con gure the settings for email delivery:
a. Click the Email noti cation settings button.
b. Select the Notify about events check box to enable delivery of information about Kaspersky Endpoint
Security events selected in the Notify by email column.
c. Specify the email noti cation delivery settings.
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d. Click OK.
9. Save your changes.

Con guring the display of warnings about the application status in the
noti cation area
To con gure the display of application status warnings in the noti cation area:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Interface.
3. In the Show application's status in noti cations area section, select the check boxes opposite those
categories of events about which you want to see noti cations in the noti cation area of Microsoft Windows.
4. Save your changes.
When events associated with the selected categories occur, the application icon in the noti cation area will
change to or depending on the severity of the warning.
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Managing reports
Information about the operation of each Kaspersky Endpoint Security component, data encryption events, the
performance of each scan task, the update task and integrity check task, and the overall operation of the
application is recorded in reports.
Reports are stored in the folder C:\ProgramData\Kaspersky Lab\KES\Report.
Reports may contain the following user data:
Paths to les scanned by Kaspersky Endpoint Security.
Paths to registry keys modi ed during the operation of Kaspersky Endpoint Security.
Microsoft Windows user name.
Addresses of web pages opened by the user.
The data in the report is presented in tabular form. Each table row contains information on a separate event. Event
attributes are located in the table columns. Certain columns are compound ones which contain nested columns
with additional attributes. To view additional attributes, click the button next to the name of the column. Events
that are logged during the operation of various components or during the performance of various tasks have
di erent sets of attributes.
The following reports are available:
System Audit report. Contains information about events occurring during the interaction between the user
and the application and in the course of application operation in general, which are unrelated to any particular
Kaspersky Endpoint Security components or tasks.
Reports on the operation of Kaspersky Endpoint Security components.
Kaspersky Endpoint Security task reports.
Data encryption report. Contains information about events occurring during data encryption and decryption.
Reports use the following event importance levels:
Informational messages. Reference events that normally do not contain important information.
Warnings. Events that need attention because they re ect important situations in the operation of Kaspersky
Endpoint Security.
Critical events. Events of critical importance that indicate problems in the operation of Kaspersky Endpoint
Security or vulnerabilities in the protection of the user's computer.
For convenient processing of reports, you can modify the presentation of data on the screen in the following ways:
Filter the event list by various criteria.
Use the search function to nd a speci c event.
View the selected event in a separate section.
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Sort the list of events by each report column.
Display and hide events grouped by the event lter using the

button.

Change the order and arrangement of columns that are shown in the report.
You can save a generated report to a text le, if necessary. You can also delete report information on Kaspersky
Endpoint Security components and tasks that are combined into groups.
If Kaspersky Endpoint Security is running under the management of Kaspersky Security Center, information about
events may be relayed to the Kaspersky Security Center Administration Server (for more details, please refer to
the Kaspersky Security Center Help ).

Viewing reports
If a user can view reports, the user can also view all events re ected in the reports.

To view reports:
1. In the main application window, in the Monitoring section, click the Reports tile.
2. In the left part of the Reports window, in the list of components and tasks, select a component or task.
The right part of the window displays a report containing a list of events resulting from the operation of the
selected component or selected task of Kaspersky Endpoint Security. You can sort events in the report based
on the values in cells of one of the columns. By default, report events are sorted in ascending order of the
values in cells of the Event date column.
3. To view detailed information about an event, select the event in the report.
A section with the event summary is displayed in the lower part of the window.

Con guring the maximum report storage term
The default maximum storage term for reports on events that are logged by Kaspersky Endpoint Security is
30 days. After that period of time, Kaspersky Endpoint Security automatically deletes the oldest entries from the
report le.

To modify the report maximum storage term:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Reports and Storage section.
3. If you want to limit the report storage term, select the Store reports no longer than N days check box in the
Reports block. De ne the maximum report storage term.
4. Save your changes.

369

Con guring the maximum size of the report le
You can specify the maximum size of the le that contains the report. By default, the maximum report le size is
1024 MB. To avoid exceeding the maximum report le size, Kaspersky Endpoint Security automatically deletes the
oldest entries from the report le when the maximum report le size is reached.

To con gure the maximum report le size:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Reports and Storage section.
3. In the Reports block, select the Limit the size of report le to N MB check box if you want to limit the size of a
report le. De ne the maximum size of the report le.
4. Save your changes.

Saving a report to le
The user is personally responsible for ensuring the security of information from a report saved to le, and
particularly for controlling and restricting access to this information.
You can save the report that you generate to a le in text format (TXT) or a CSV le.
Kaspersky Endpoint Security logs events in the report in the same way as they are displayed on the screen: in
other words, with the same set and sequence of event attributes.

To save a report to le:
1. In the main application window, in the Monitoring section, click the Reports tile.
2. This opens a window; in this window, select the component or task.
A report is displayed in the right part of the window, which contains a list of events in the operation of the
selected Kaspersky Endpoint Security component or task.
3. If necessary, you can modify data presentation in the report by:
Filtering events
Running an event search
Rearranging columns
Sorting events
4. Click the Save report button in the upper right part of the window.
5. In the window that opens, specify the destination folder for the report le.
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6. In the File name eld, type the report le name.
7. In the File type eld, select the necessary report le format: TXT or CSV.
8. Save your changes.

Clearing reports
To remove information from reports:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Reports and Storage section.
3. In the Reports block, click the Clear button.
4. If Password Protection is enabled, Kaspersky Endpoint Security may prompt you for user account credentials.
The application prompts for account credentials if the user does not have the required permission.
Kaspersky Endpoint Security will delete all reports for all application components and tasks.
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Kaspersky Endpoint Security Self-Defense
Self-Defense prevents other applications from performing actions that can interfere with the operation of
Kaspersky Endpoint Security and, for example, remove Kaspersky Endpoint Security from the computer. The set of
available Self-Defense technologies for Kaspersky Endpoint Security depends on whether the operating system is
32-bit or 64-bit (refer to the table below).
Kaspersky Endpoint Security Self-Defense technologies

Technology

Self-Defense
mechanism

Description

х86
computer

x64
computer

The technology blocks access to the following application
components:
les in the Kaspersky Endpoint Security installation folder
and other les of the application;
registry keys with records belonging to the application;
processes that the application runs.

AM-PPL
(Antimalware
Protected
Process Light)

The technology protects Kaspersky Endpoint Security
processes against malicious actions. For more details about
AM-PPL technology, please visit the Microsoft website .
AM-PPL technology is available for Windows 10 version
1703 (RS2) or later, and Windows Server 2019 operating
systems.

External
management
defense
mechanism

This technology prevents remote administration applications
(for example, TeamViewer or RemotelyAnywhere) from gaining
access to Kaspersky Endpoint Security.

Enabling and disabling Self-Defense
The Self-Defense mechanism of Kaspersky Endpoint Security is enabled by default.

To enable or disable Self-Defense:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. Use the Enable Self-Defense check box to enable or disable the Self-Defense mechanism.
4. Save your changes.
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–
(except
for
Windows
7)

Enabling and disabling AM-PPL support
Kaspersky Endpoint Security supports Antimalware Protected Process Light technology (hereinafter referred to
as "AM-PPL") from Microsoft. AM-PPL protects Kaspersky Endpoint Security processes against malicious actions
(for example, terminating the application). AM-PPL allows only trusted processes to run. Kaspersky Endpoint
Security processes are signed in accordance with Windows security requirements, and therefore they are trusted.
For more details about AM-PPL technology, please visit the Microsoft website . AM-PPL technology is enabled
by default.
Kaspersky Endpoint Security also has built-in mechanisms for protecting application processes. AM-PPL support
lets you delegate process security functions to the operating system. You can thereby increase the speed of the
application and reduce the consumption of computer resources.
AM-PPL technology is available for Windows 10 version 1703 (RS2) or later, and Windows Server 2019
operating systems.

To enable or disable AM-PPL technology:
1. Turn o the application's Self-Defense mechanism.
The Self-Defense mechanism prevents modi cation and deletion of application processes in the computer
memory, including changing the AM-PPL status.
2. Run the command line interpreter (cmd.exe) as an administrator.
3. Go to the folder where the Kaspersky Endpoint Security executable le is located.
4. Type the following in the command line:
klpsm.exe enable – enable support for AM-PPL technology (see the gure below).
klpsm.exe disable – disable support for AM-PPL technology.
5. Restart Kaspersky Endpoint Security.
6. Resume the application's Self-Defense mechanism.

Enabling support for AM-PPL technology
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Enabling and disabling external management defense
External management defense prevents remote administration applications (for example, TeamViewer or
RemotelyAnywhere) from gaining access to Kaspersky Endpoint Security. This technology includes the following
external management defense features:
Protection against modi cation of Kaspersky Endpoint Security settings.
Protection of Kaspersky Endpoint Security services (such as the avp service).
Protection of application processes.
Protection against external management is available only for computers running 32-bit operating systems,
except for Windows 7. For Windows 7, the technology is available for 32-bit and 64-bit operating systems.

To enable or disable protection against external management:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. Use the Allow managing Kaspersky Endpoint Security settings via remote control applications check box to
enable or disable external management defense.
If the check box is selected, you can use remote administration applications to con gure Kaspersky Endpoint
Security and manage its services and processes.
If the check box is cleared, external management defense prevents remote administration applications from
gaining access to Kaspersky Endpoint Security. You can allow con guring Kaspersky Endpoint Security using
speci c remote administration applications. To do so, you must add the remote administration application to
the trusted list. In this case, the remote administration defense will still prevent the remote administration
application from gaining access to services and processes of Kaspersky Endpoint Security.
4. Use the Enable external service control check box to enable or disable the protection of Kaspersky Endpoint
Security services against external management.
To quit the application from the command line, disable the protection of Kaspersky Endpoint Security
services against external management.
5. Save your changes.
As a result, when external management defense is enabled, Kaspersky Endpoint Security prevents the mouse
pointer from entering the application window. When a remote user attempts to shut down an application service,
a system window with an error message appears.

Supporting remote administration applications
You may occasionally need to use a remote administration application while external management defense is
enabled.

To enable the operation of remote administration applications:
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1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Exclusions block, click the Specify trusted applications link.
4. In the window, click the Add button.
5. Select the executable le of the remote administration application.
You can also manually enter the path. Kaspersky Endpoint Security supports environment variables and the *
and ? characters when entering a mask.
6. Select the Do not monitor application activity check box.
7. Save your changes.
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Kaspersky Endpoint Security performance and compatibility with other
applications
Performance of Kaspersky Endpoint Security
The performance of Kaspersky Endpoint Security refers to the number of types of objects that can harm the
computer that are detectable, as well as energy consumption and use of computer resources.

Selecting types of detectable objects
Kaspersky Endpoint Security lets you ne-tune the protection of your computer and select the types of
objects that the application detects during operation. Kaspersky Endpoint Security always scans the operating
system for viruses, worms, and Trojans. You cannot disable scanning of these types of objects. Such malware can
cause signi cant harm to the computer. For greater security on your computer, you can expand the range of
detectable object types by enabling monitoring of legal software that can be used by criminals to damage your
computer or personal data.

Using energy-saving mode
Energy consumption by applications is a key consideration for portable computers. Kaspersky Endpoint Security
scheduled tasks usually use up considerable resources. When the computer is running on battery power, you can
use energy-saving mode to consume power more sparingly.
In energy-saving mode, the following scheduled tasks are postponed automatically:
Update task;
Full Scan task;
Critical Areas Scan task;
Custom Scan task;
Integrity Check task.
Whether or not energy saving mode is enabled, Kaspersky Endpoint Security pauses encryption tasks when a
portable computer switches to battery power. The application resumes encryption tasks when the portable
computer switches from battery power to mains power.

Conceding computer resources to other applications
Use of computer resources by Kaspersky Endpoint Security may impact the performance of other applications. To
resolve the problem of simultaneous operation during increased load on the CPU and hard drive subsystems,
Kaspersky Endpoint Security can pause scheduled tasks and concede resources to other applications.
However, a number of applications start immediately when CPU resources become available, proceeding to work in
background mode. To prevent scanning from depending on the performance of other applications, it is better to
not concede operating system resources to them.
You can start such tasks manually, if necessary.
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Using advanced disinfection technology
Today's malicious applications can penetrate the lowest levels of an operating system, which makes them virtually
impossible to eliminate. After detecting malicious activity in the operating system, Kaspersky Endpoint Security
performs an extensive disinfection procedure that uses special advanced disinfection technology. Advanced
disinfection technology is aimed at purging the operating system of malicious applications that have already
started their processes in RAM and that prevent Kaspersky Endpoint Security from removing them by using other
methods. The threat is neutralized as a result. While Advanced Disinfection is in progress, you are advised to refrain
from starting new processes or editing the operating system registry. The advanced disinfection technology uses
considerable operating system resources, which may slow down other applications.
After the Advanced Disinfection process has been completed on a computer running Microsoft Windows for
workstations, Kaspersky Endpoint Security requests the user's permission to reboot the computer. After system
reboot, Kaspersky Endpoint Security deletes malware les and starts a "lite" full scan of the computer.
A reboot prompt is impossible on a computer running Microsoft Windows for servers due to the speci cs of
Kaspersky Endpoint Security. An unplanned reboot of a le server can lead to problems involving temporary
unavailability of le server data or loss of unsaved data. It is recommended to reboot a le server strictly according
to schedule. This is why Advanced Disinfection technology is disabled by default for le servers.
If active infection is detected on a le server, an event is relayed to Kaspersky Security Center with information
that Active Disinfection is required. To disinfect an active infection of a server, enable Active Disinfection
technology for servers and start a Virus scan group task at a time convenient for server users.

Selecting types of detectable objects
To select types of detectable objects:
1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Types of detected objects section, select check boxes opposite the types of objects that you want
Kaspersky Endpoint Security to detect:
Viruses and worms
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Subcategory: viruses and worms (Viruses_and_Worms)
Threat level: high
Classic viruses and worms perform actions that are not authorized by the user. They can create copies
of themselves which are able to self-replicate.
Classic virus
When a classic virus in ltrates a computer, it infects a le, activates, performs malicious actions, and
adds copies of itself to other les.
A classic virus multiplies only on local resources of the computer; it cannot penetrate other computers
on its own. It can be passed to another computer only if it adds a copy of itself to a le that is stored in
a shared folder or on an inserted CD, or if the user forwards an email message with an attached
infected le.
Classic virus code can penetrate various areas of computers, operating systems, and applications.
Depending on the environment, viruses are divided into le viruses, boot viruses, script viruses, and
macro viruses.
Viruses can infect les by using a variety of techniques. Overwriting viruses write their code over the
code of the le that is infected, thus erasing the le's content. The infected le stops functioning and
cannot be restored. Parasitic viruses modify les, leaving them fully or partially functional. Companion
viruses do not modify les, but instead create duplicates. When an infected le is opened, a duplicate
of it (what is actually a virus) is started. The following types of viruses are also encountered: link viruses,
OBJ viruses, LIB viruses, source code viruses, and many others.
Worm
As with a classic virus, the code of a worm is activated and performs malicious actions after it in ltrates
a computer. Worms are so named because of their ability to "crawl" from one computer to another and
to spread copies via numerous data channels without the user's permission.
The main feature that allows di erentiating between various types of worms is the way they spread.
The following table provides an overview of various types of worms, which are classi ed by the way in
which they spread.
Ways in which worms spread

Type

Name

Description

EmailWorm

EmailWorm

They spread via email.

IMWorm

IM client
worms

They spread through IM clients.

IRCWorm

Internet
chat

They spread via Internet Relay Chats, service systems which allow
communicating with other people over the Internet in real time.

An infected email message contains an attached le with a copy of a worm,
or a link to a le that is uploaded to a website which may have been hacked or
created exclusively for that purpose. When you open the attached le, the
worm is activated. When you click the link, download, and then open the le,
the worm also starts performing its malicious actions. After that, it goes on
spreading copies of itself, searching for other email addresses and sending
infected messages to them.

Usually, such worms send messages that contain a link to a le with a copy of
the worm on a website, making use of the user's contact lists. When the user
downloads and opens the le, the worm activates.
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worms

These worms publish a le with a copy of themselves or a link to the le in an
Internet chat. When the user downloads and opens the le, the worm
activates.

NetWorm

Network
worms

These worms spread over computer networks.

P2PWorm

File
sharing
network
worms

They spread over peer-to-peer le sharing networks.

Unlike other types of worms, a typical network worm spreads without the
user's participation. It scans the local network for computers that contain
programs with vulnerabilities. To do this, it sends a specially formed network
packet (exploit) which contains the worm code or a part of it. If a "vulnerable"
computer is on the network, it receives such a network packet. When the
worm completely penetrates the computer, it activates.

To in ltrate a P2P network, the worm copies itself into a le sharing folder
which is usually located on the user's computer. The P2P network displays
information about this le so that the user may " nd" the infected le on the
network like any other le, and then download and open it.
More sophisticated worms emulate the network protocol of a speci c P2P
network: they return positive responses to search queries and o er copies
of themselves for download.

Worm

Other
types of
worms

Other types of worms include:
Worms that spread copies of themselves over network resources. By
using the functions of the operating system, they scan available network
folders, connect to computers on the Internet, and attempt to obtain full
access to their disk drives. Unlike the previously described types of
worms, other types of worms activate not on their own, but when the
user opens a le that contains a copy of the worm.
Worms that do not use any of the methods described in the previous
table to spread (for example, those that spread over cell phones).

Trojans
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Subcategory: Trojans
Threat level: high
Unlike worms and viruses, Trojans do not self-replicate. For example, they penetrate a computer via
email or a browser when the user visits an infected web page. Trojans are started with the user's
participation. They begin performing their malicious actions right after they are started.
Di erent Trojans behave di erently on infected computers. The main functions of Trojans consist in
blocking, modifying, or destroying information, and disabling computers or networks. Trojans can also
receive or send les, run them, display messages on the screen, request web pages, download and
install programs, and restart the computer.
Hackers often use "sets" of various Trojans.
Types of Trojan behavior are described in the following table.
Types of Trojan behavior on an infected computer

Type

TrojanArcBomb

Backdoor

Name

Description

Trojans –
"archive
bombs"

When unpacked, these archives grow in size to such an extent
that the computer's operation is impacted.

Trojans for
remote
administration

They are considered the most dangerous type of Trojan. In their
functions, they are similar to remote administration applications
that are installed on computers.

When the user attempts to unpack such an archive, the
computer may slow down or freeze; the hard disk may become
lled with "empty" data. "Archive bombs" are especially dangerous
to le and mail servers. If the server uses an automatic system to
process incoming information, an "archive bomb" may halt the
server.

These programs install themselves on the computer without
being noticed by the user, allowing the intruder to manage the
computer remotely.
Trojan

Trojans

They include the following malicious applications:
Classic Trojans. These programs perform only the main
functions of Trojans: blocking, modifying or destroying
information, and disabling computers or networks. They do
not have any advanced features, unlike the other types of
Trojans that are described in the table.
Versatile Trojans. These programs have advanced features
typical of several types of Trojans.

TrojanRansom

Ransom
Trojans

They take the user's information "hostage", modifying or blocking
it, or impact the computer's operation so that the user loses the
ability to use information. The intruder demands a ransom from
the user, promising to send an application to restore the
computer's performance and the data that had been stored on it.

TrojanClicker

Trojan clickers

They access web pages from the user's computer, either by
sending commands to a browser on their own or by changing the
web addresses that are speci ed in operating system les.
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By using these programs, intruders perpetrate network attacks
and increase website visits, increasing the number of displays of
banner ads.
TrojanDownloader

Trojan
downloaders

They access the intruder's web page, download other malicious
applications from it, and install them on the user's computer.
They can contain the le name of the malicious application to
download, or receive it from the web page that is accessed.

TrojanDropper

Trojan
droppers

They contain other Trojans which they install on the hard drive
and then install.
Intruders may use Trojan Dropper–type programs for the
following goals:
Install a malicious application without being noticed by the
user: Trojan Dropper–type programs display no messages, or
display fake messages which inform, for example, of an error in
an archive or an incompatible version of the operating system.
Protect another known malicious application from detection:
not all anti-virus software can detect a malicious application
within a Trojan Dropper–type application.

TrojanNoti er

Trojan
noti ers

They inform an intruder that the infected computer is accessible,
sending the intruder information about the computer: IP address,
number of opened port, or email address. They connect with the
intruder via email, FTP, accessing the intruder's web page, or in
another way.
Trojan Noti er–type programs are often used in sets that are
made of several Trojans. They notify the intruder that other
Trojans have been successfully installed on the user's computer.

TrojanProxy

Trojan proxies

They allow the intruder to anonymously access web pages by
using the user's computer; they are often used for sending spam.

TrojanPSW

Passwordstealing-ware

Password-stealing-ware is a kind of Trojan that steals user
accounts, such as software registration data. These Trojans nd
con dential data in system les and in the registry and send it to
the “attacker" by email, via FTP, by accessing the intruder's web
page, or in another way.
Some of these Trojans are categorized into separate types that
are described in this table. These are Trojans that steal bank
accounts (Trojan-Banker), steal data from users of IM clients
(Trojan-IM), and steal information from users of online games
(Trojan-GameThief).

Trojan-Spy

Trojan spies

They spy on the user, collecting information about the actions
that the user makes while working at the computer. They may
intercept the data that the user enters at the keyboard, take
screenshots, or collect lists of active applications. After they
receive the information, they transfer it to the intruder by email,
via FTP, by accessing the intruder's web page, or in another way.

TrojanDDoS

Trojan
network
attackers

They send numerous requests from the user's computer to a
remote server. The server lacks resources to process all
requests, so it stops functioning (Denial of Service, or simply
DoS). Hackers often infect many computers with these programs
so that they can use the computers to attack a single server
simultaneously.
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DoS programs perpetrate an attack from a single computer with
the user's knowledge. DDoS (Distributed DoS) programs
perpetrate distributed attacks from several computers without
being noticed by the user of the infected computer.
Trojan-IM

Trojans that
steal
information
from users of
IM clients

They steal account numbers and passwords of IM client users.
They transfer the data to the intruder by email, via FTP, by
accessing the intruder's web page, or in another way.

Rootkit

Rootkits

They mask other malicious applications and their activity, thus
prolonging the applications' persistence in the operating system.
They can also conceal les, processes in an infected computer's
memory, or registry keys which run malicious applications. The
rootkits can mask data exchange between applications on the
user's computer and other computers on the network.

Trojan-SMS

Trojans in the
form of SMS
messages

They infect cell phones, sending SMS messages to premium-rate
phone numbers.

TrojanGameThief

Trojans that
steal
information
from users of
online games

They steal account credentials from users of online games, after
which they send the data to the intruder by email, via FTP, by
accessing the intruder's web page, or in another way.

TrojanBanker

Trojans that
steal bank
accounts

They steal bank account data or e-money system data; send the
data to the hacker by email, via FTP, by accessing the hacker's
web page, or by using another method.

TrojanMail nder

Trojans that
collect email
addresses

They collect email addresses that stored on a computer and
send them to the intruder by email, via FTP, by accessing the
intruder's web page, or in another way. Intruders may send spam
to the addresses they have collected.

Malicious tools
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Subcategory: Malicious tools
Danger level: medium
Unlike other types of malware, malicious tools do not perform their actions right after they are started.
They can be safely stored and started on the user's computer. Intruders often use the features of
these programs to create viruses, worms, and Trojans, perpetrate network attacks on remote servers,
hack computers, or perform other malicious actions.
Various features of malicious tools are grouped by the types that are described in the following table.
Features of malicious tools

Type

Name

Description

Constructor

Constructors

They allow creating new viruses, worms, and Trojans. Some
constructors boast a standard window-based interface in
which the user can select the type of malicious application to
create, the way of counteracting debuggers, and other
features.

Dos

Network
attacks

They send numerous requests from the user's computer to a
remote server. The server lacks resources to process all
requests, so it stops functioning (Denial of Service, or simply
DoS).

Exploit

Exploits

An exploit is a set of data or a program code that uses
vulnerabilities of the application in which it is processed,
performing a malicious action on a computer. For example, an
exploit can write or read les, or request "infected" web pages.
Di erent exploits use vulnerabilities in di erent applications or
network services. Disguised as a network packet, an exploit is
transmitted over the network to numerous computers,
searching for computers with vulnerable network services. An
exploit in a DOC le uses the vulnerabilities of a text editor. It
may start performing the actions that are preprogrammed by
the hacker when the user opens the infected le. An exploit
that is embedded in an email message searches for
vulnerabilities in any email client. It may start performing a
malicious action as soon as the user opens the infected
message in this email client.
Net-Worms spread over networks by using exploits. Nuker
exploits are network packets that disable computers.

FileCryptor

Encryptors

They encrypt other malicious applications to conceal them
from the anti-virus application.

Flooder

Programs for
"contaminating"
networks

They send numerous messages over network channels. This
type of tools includes, for example, programs that contaminate
Internet Relay Chats.
Flooder-type tools do not include programs that "contaminate"
channels that are used by email, IM clients, and mobile
communication systems. These programs are distinguished as
separate types that are described in the table (Email-Flooder,
IM-Flooder, and SMS-Flooder).

HackTool

Hacking tools

They make it possible to hack the computer on which they are
installed or attack another computer (for example, by adding
new system accounts without the user's permission or by
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erasing system logs to conceal traces of their presence in the
operating system). This type of tools includes some sni ers
which feature malicious functions, such as password
interception. Sni ers are programs that allow viewing network
tra ic.
Hoax

Hoaxes

They alarm the user with virus-like messages: they may "detect
a virus" in an uninfected le or notify the user that the disk has
been formatted, although this has not happened in reality.

Spoofer

Spoo ng tools

They send messages and network requests with a fake address
of the sender. Intruders use Spoofer-type tools to pass
themselves o as the true senders of messages, for example.

VirTool

Tools that
modify
malicious
applications

They allow modifying other malware programs, concealing them
from anti-virus applications.

EmailFlooder

Programs that
"contaminate"
email
addresses

They send numerous messages to various email addresses,
thus "contaminating" them. A large volume of incoming
messages prevents users from viewing useful messages in their
inboxes.

IM-Flooder

Programs that
"contaminate"
tra ic of IM
clients

They ood users of IM clients with messages. A large volume of
messages prevents users from viewing useful incoming
messages.

SMSFlooder

Programs that
"contaminate"
tra ic with
SMS messages

They send numerous SMS messages to cell phones.

Adware

Subcategory: advertising software (Adware);
Threat level: medium
Adware displays advertising information to the user. Adware programs display banner ads in the
interfaces of other programs and redirect search queries to advertising web pages. Some of them
collect marketing information about the user and send it to the developer: this information may include
the names of the websites that are visited by the user or the content of the user's search queries.
Unlike Trojan-Spy–type programs, adware sends this information to the developer with the user's
permission.
Auto-dialers
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Subcategory: legal software that may be used by criminals to damage your computer or personal data.
Danger level: medium
Most of these applications are useful, so many users run them. These applications include IRC clients,
auto-dialers, le download programs, computer system activity monitors, password utilities, and
Internet servers for FTP, HTTP, and Telnet.
However, if intruders gain access to these programs, or if they plant them on the user's computer, some
of the application's features may be used to violate security.
These applications di er by function; their types are described in the following table.

Type

Name

Description

Client-IRC

Internet chat
clients

Users install these programs to talk to people in Internet Relay
Chats. Intruders use them to spread malware.

Dialer

Auto-dialers

They can establish phone connections over a modem in hidden
mode.

Downloader

Programs for
downloading

They can download les from web pages in hidden mode.

Monitor

Programs for
monitoring

They allow monitoring activity on the computer on which they
are installed (seeing which applications are active and how they
exchange data with applications that are installed on other
computers).

PSWTool

Password
restorers

They allow viewing and restoring forgotten passwords.
Intruders secretly implant them on users' computers with the
same purpose.

RemoteAdmin

Remote
administration
programs

They are widely used by system administrators. These
programs allow obtaining access to the interface of a remote
computer to monitor and manage it. Intruders secretly implant
them on users' computers with the same purpose: to monitor
and manage remote computers.
Legal remote administration programs di er from Backdoortype Trojans for remote administration. Trojans have the ability
to penetrate the operating system independently and install
themselves; legal programs are unable to do so.

Server-FTP

FTP servers

They function as FTP servers. Intruders implant them on the
user's computer to open remote access to it via FTP.

Server-Proxy

Proxy servers

They function as proxy servers. Intruders implant them on the
user's computer to send spam under the user's name.

Server-Telnet

Telnet servers

They function as Telnet servers. Intruders implant them on the
user's computer to open remote access to it via Telnet.

Server-Web

Web servers

They function as web servers. Intruders implant them on the
user's computer to open remote access to it via HTTP.

RiskTool

Tools for
working at a
local
computer

They provide the user with additional options when working at
the user's own computer. The tools allow the user to hide les
or windows of active applications and terminate active
processes.

NetTool

Network tools

They provide the user with additional options when working
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with other computers on the network. These tools allow
restarting them, detecting open ports, and starting
applications that are installed on the computers.
Client-P2P

P2P network
clients

They allow working on peer-to-peer networks. They can be
used by intruders for spreading malware.

Client-SMTP

SMTP clients

They send email messages without the user's knowledge.
Intruders implant them on the user's computer to send spam
under the user's name.

WebToolbar

Web toolbars

They add toolbars to the interfaces of other applications to
use search engines.

FraudTool

Pseudoprograms

They pass themselves o as other programs. For example,
there are pseudo-anti-virus programs which display messages
about malware detection. However, in reality, they do not nd
or disinfect anything.

Detect other software that can be used by criminals to damage your computer or personal data
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Subcategory: legal software that may be used by criminals to damage your computer or personal data.
Danger level: medium
Most of these applications are useful, so many users run them. These applications include IRC clients,
auto-dialers, le download programs, computer system activity monitors, password utilities, and
Internet servers for FTP, HTTP, and Telnet.
However, if intruders gain access to these programs, or if they plant them on the user's computer, some
of the application's features may be used to violate security.
These applications di er by function; their types are described in the following table.

Type

Name

Description

Client-IRC

Internet chat
clients

Users install these programs to talk to people in Internet Relay
Chats. Intruders use them to spread malware.

Dialer

Auto-dialers

They can establish phone connections over a modem in hidden
mode.

Downloader

Programs for
downloading

They can download les from web pages in hidden mode.

Monitor

Programs for
monitoring

They allow monitoring activity on the computer on which they
are installed (seeing which applications are active and how they
exchange data with applications that are installed on other
computers).

PSWTool

Password
restorers

They allow viewing and restoring forgotten passwords.
Intruders secretly implant them on users' computers with the
same purpose.

RemoteAdmin

Remote
administration
programs

They are widely used by system administrators. These
programs allow obtaining access to the interface of a remote
computer to monitor and manage it. Intruders secretly implant
them on users' computers with the same purpose: to monitor
and manage remote computers.
Legal remote administration programs di er from Backdoortype Trojans for remote administration. Trojans have the ability
to penetrate the operating system independently and install
themselves; legal programs are unable to do so.

Server-FTP

FTP servers

They function as FTP servers. Intruders implant them on the
user's computer to open remote access to it via FTP.

Server-Proxy

Proxy servers

They function as proxy servers. Intruders implant them on the
user's computer to send spam under the user's name.

Server-Telnet

Telnet servers

They function as Telnet servers. Intruders implant them on the
user's computer to open remote access to it via Telnet.

Server-Web

Web servers

They function as web servers. Intruders implant them on the
user's computer to open remote access to it via HTTP.

RiskTool

Tools for
working at a
local
computer

They provide the user with additional options when working at
the user's own computer. The tools allow the user to hide les
or windows of active applications and terminate active
processes.

NetTool

Network tools

They provide the user with additional options when working
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with other computers on the network. These tools allow
restarting them, detecting open ports, and starting
applications that are installed on the computers.
Client-P2P

P2P network
clients

They allow working on peer-to-peer networks. They can be
used by intruders for spreading malware.

Client-SMTP

SMTP clients

They send email messages without the user's knowledge.
Intruders implant them on the user's computer to send spam
under the user's name.

WebToolbar

Web toolbars

They add toolbars to the interfaces of other applications to
use search engines.

FraudTool

Pseudoprograms

They pass themselves o as other programs. For example,
there are pseudo-anti-virus programs which display messages
about malware detection. However, in reality, they do not nd
or disinfect anything.

Packed objects whose packing may be used to protect malicious code

Kaspersky Endpoint Security scans compressed objects and the unpacker module within SFX (selfextracting) archives.
To hide dangerous programs from anti-virus applications, intruders archive them by using special
packers or create multi-packed les.
Kaspersky virus analysts have identi ed packers that are the most popular amongst hackers.
If Kaspersky Endpoint Security detects such a packer in a le, the le most likely contains a malicious
application or an application that can be used by criminals to cause harm to your computer or personal
data.
Kaspersky Endpoint Security singles out the following types of programs:

Packed les that may cause harm – used for packing malware, such as viruses, worms, and Trojans.
Multi-packed les (medium threat level) – the object has been packed three times by one or more
packers.
Multi-packed objects
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Kaspersky Endpoint Security scans compressed objects and the unpacker module within SFX (selfextracting) archives.
To hide dangerous programs from anti-virus applications, intruders archive them by using special
packers or create multi-packed les.
Kaspersky virus analysts have identi ed packers that are the most popular amongst hackers.
If Kaspersky Endpoint Security detects such a packer in a le, the le most likely contains a malicious
application or an application that can be used by criminals to cause harm to your computer or personal
data.
Kaspersky Endpoint Security singles out the following types of programs:

Packed les that may cause harm – used for packing malware, such as viruses, worms, and Trojans.
Multi-packed les (medium threat level) – the object has been packed three times by one or more
packers.
4. Save your changes.

Enabling or disabling Advanced Disinfection technology
If Kaspersky Endpoint Security cannot halt the execution of a piece of malware, you can use the Advanced
Disinfection technology. By default, Advanced Disinfection is disabled because this technology uses a signi cant
amount of computing resources. Therefore, you can enable Advanced Disinfection only when working with active
threats.
Advanced Disinfection works di erently for workstations and servers. To use the technology on servers, you
must enable immediate advanced disinfection in the properties of the Anti-Virus Scan task. This prerequisite
is not necessary to use the technology on workstations.

To enable or disable the Advanced Disinfection technology:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. In the Operating mode section, select or clear the Enable Advanced Disinfection technology check box to
enable or disable Advanced Disinfection technology.
4. Save your changes.
As a result, the user cannot use most operating system features while Active Disinfection is in progress. When
the disinfection is complete, the computer is rebooted.

Enabling or disabling energy-saving mode
To enable or disable energy conservation mode:
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1. In the main application window, click the button

.

2. In the application settings window, select the Advanced settings → Threats and Exclusions section.
3. In the Performance section, use the Postpone scheduled tasks while running on battery power check box to
enable or disable power saving mode.
When energy conservation mode is enabled and the computer is running on battery power, the following tasks
are not run even if scheduled:
Update task;
Full Scan task;
Critical Areas Scan task;
Custom Scan task;
Integrity Check task.
4. Save your changes.

Enabling or disabling conceding of resources to other applications
To enable or disable conceding of resources to other applications:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. In the Performance section, use the Concede resources to other applications check box to enable or disable
conceding of resources to other applications.
When con gured to concede resources to other applications, Kaspersky Endpoint Security postpones
scheduled tasks that slow down other applications:
Update task;
Full Scan task;
Critical Areas Scan task;
Custom Scan task;
Integrity Check task.
By default, the application is con gured to concede resources to other applications.
4. Save your changes.
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Creating and using a con guration le
A con guration le with Kaspersky Endpoint Security settings lets you accomplish the following tasks:
Perform local installation of Kaspersky Endpoint Security via the command line with prede ned settings.
To do so, you must save the con guration le in the same folder where the distribution package is located.
Perform remote installation of Kaspersky Endpoint Security via Kaspersky Security Center with prede ned
settings.
Migrate Kaspersky Endpoint Security settings from one computer to another.

To create a con guration le:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Manage Settings.
3. Click the Export button.
4. In the window that opens, specify the path to where you want to save the con guration le, and enter its name.
To use the con guration le for local or remote installation of Kaspersky Endpoint Security, you must name
it install.cfg.
5. Click the Save button.

To import Kaspersky Endpoint Security settings from a con guration le:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Manage Settings.
3. Click the Import button.
4. In the window that opens, enter the path to the con guration le.
5. Click the Open button.
All values of Kaspersky Endpoint Security settings will be set according to the selected con guration le.
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Restoring the default application settings
You can restore the settings recommended by Kaspersky for Endpoint Security at any time. When the settings are
restored, the Recommended security level is set for all protection components.

To restore the default application settings:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → Manage Settings.
3. Click the Restore button.
4. Save your changes.
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Messaging between users and the administrator
The Application Control, Device Control, Web Control and Adaptive Anomaly Control components enable LAN
users whose computers have Kaspersky Endpoint Security installed to send messages to the administrator.
A user may need to send a message to the local corporate network administrator in the following cases:
Device Control blocked access to the device.
The message template for a request to access a blocked device is available in the Kaspersky Endpoint Security
interface in the Device Control section.
Application Control blocked the startup of an application.
The message template for a request to allow the startup of a blocked application is available in the Kaspersky
Endpoint Security interface in the Application Control section.
Web Control blocked access to a web resource.
The message template for a request to access a blocked web resource is available in the Kaspersky Endpoint
Security interface in the Web Control section.
The method used to send messages and the utilized template depends on whether or not there is an active
Kaspersky Security Center policy running on the computer that has Kaspersky Endpoint Security installed, and
whether or not there is a connection with the Kaspersky Security Center Administration Server. The following
scenarios are possible:
If a Kaspersky Security Center policy is not running on the computer that has Kaspersky Endpoint Security
installed, a user's message is sent to the local area network administrator by email.
The message elds are populated with the values of elds from the template de ned in the local interface of
Kaspersky Endpoint Security.
If a Kaspersky Security Center policy is running on the computer that has Kaspersky Endpoint Security
installed, the standard message is sent to the Kaspersky Security Center Administration Server.
In this case, user messages are available for viewing in the Kaspersky Security Center event storage (see
instruction below). The message elds are populated with the values of elds from the template de ned in the
Kaspersky Security Center policy.
If a Kaspersky Security Center out-of-o ice policy is running on the computer with Kaspersky Endpoint
Security installed, the method used to send messages depends on whether or not there is a connection with
Kaspersky Security Center.
If a connection with Kaspersky Security Center is established, Kaspersky Endpoint Security sends the
standard message to the Kaspersky Security Center Administration Server.
If a connection with Kaspersky Security Center is absent, a user's message is sent to the local area network
administrator by email.
In both cases, the message elds are populated with the values of elds from the template de ned in the
Kaspersky Security Center policy.

To view a user message in the Kaspersky Security Center event storage:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Events tab.
The Kaspersky Security Center workspace displays all events occurring during the operation of Kaspersky
Endpoint Security, including messages to the administrator that are received from LAN users.
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3. To con gure the event lter, in the Event selections drop-down list, select User requests.
4. Select the message sent to the administrator.
5. Click the Open event properties window button in the right part of the Administration Console workspace.
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Data Encryption
Kaspersky Endpoint Security lets you encrypt les and folders that are stored on local and removable drives, or
entire removable drives and hard drives. Data encryption minimizes the risk of information leaks that may occur
when a portable computer, removable drive or hard drive is lost or stolen, or when data is accessed by
unauthorized users or applications. Kaspersky Endpoint Security uses the Advanced Encryption Standard (AES)
encryption algorithm.
If the license has expired, the application does not encrypt new data, and old encrypted data remains encrypted
and available for use. In this event, encrypting new data requires the application be activated with a new license
that permits the use of encryption.
If your license has expired, or the End User License Agreement has been violated, the license key, Kaspersky
Endpoint Security, or encryption components has been removed, the encrypted status of previously
encrypted les is not guaranteed. This is because some applications, such as Microsoft O ice Word, create a
temporary copy of les during editing. When the original le is saved, the temporary copy replaces the original
le. As a result, on a computer that has no or inaccessible encryption functionality, the le remains
unencrypted.
Kaspersky Endpoint Security o ers the following aspects of data protection:
File Level Encryption on local computer drives. You can compile lists of les by extension or group of
extensions and lists of folders stored on local computer drives, and create rules for encrypting les that are
created by speci c applications. After a policy is applied, Kaspersky Endpoint Security encrypts and decrypts
the following les:
les individually added to lists for encryption and decryption;
les stored in folders added to lists for encryption and decryption;
les created by separate applications.
Encryption of removable drives. You can specify a default encryption rule, according to which the application
applies the same action to all removable drives, or specify encryption rules for individual removable drives.
The default encryption rule has a lower priority than encryption rules created for individual removable drives.
Encryption rules created for removable drives of the speci ed device model have a lower priority than
encryption rules created for removable drives with the speci ed device ID.
To select an encryption rule for les on a removable drive, Kaspersky Endpoint Security checks whether or not
the device model and ID are known. The application then performs one of the following operations:
If only the device model is known, the application uses the encryption rule (if any) created for removable
drives of the speci c device model.
If only the device ID is known, the application uses the encryption rule (if any) created for removable drives
with the speci c device ID.
If the device model and ID are known, the application applies the encryption rule (if any) created for
removable drives with the speci c device ID. If no such rule exists, but there is an encryption rule created for
removable drives with the speci c device model, the application applies this rule. If no encryption rule is
speci ed for the speci c device ID nor for the speci c device model, the application applies the default
encryption rule.
If neither the device model nor device ID is known, the application uses the default encryption rule.
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The application lets you prepare a removable drive for using encrypted data stored on it in portable mode.
After enabling portable mode, you can access encrypted les on removable drives connected to a computer
without encryption functionality.
Managing rules of application access to encrypted les. For any application, you can create an encrypted le
access rule that blocks access to encrypted les or allows access to encrypted les only as ciphertext, which is
a sequence of characters obtained when encryption is applied.
Creating encrypted packages. You can create encrypted archives and protect access to such archives with a
password. The contents of encrypted archives can be accessed only by entering the passwords with which you
protected access to those archives. Such archives can be securely transmitted over networks or on removable
drives.
Full Disk Encryption. You can select an encryption technology: Kaspersky Disk Encryption or BitLocker Drive
Encryption (hereinafter also referred to as simply "BitLocker").

BitLocker is a technology that is part of the Windows operating system. If a computer is equipped with a
Trusted Platform Module (TPM), BitLocker uses it to store recovery keys that provide access to an encrypted
hard drive. When the computer starts, BitLocker requests the hard drive recovery keys from the Trusted
Platform Module and unlocks the drive. You can con gure the use of a password and/or PIN code for accessing
recovery keys.
You can specify the default full disk encryption rule and create a list of hard drives to be excluded from
encryption. Kaspersky Endpoint Security performs full disk encryption by sector after the Kaspersky Security
Center policy is applied. The application encrypts all logical partitions of hard drives simultaneously.
After the system hard drives have been encrypted, at the next computer startup the user must complete
authentication using the Authentication Agent before the hard drives can be accessed and the operating
system is loaded. This requires entering the password of the token or smart card connected to the computer,
or the user name and password of the Authentication Agent account created by the local area network
administrator using the Manage Authentication Agent accounts task. These accounts are based on Microsoft
Windows accounts under which users log into the operating system. You can also use Single Sign-On (SSO)
technology, which lets you automatically log in to the operating system using the user name and password of
the Authentication Agent account.
If you back up a computer and then encrypt the computer data, after which you restore the backup copy
of the computer and encrypt the computer data again, Kaspersky Endpoint Security creates duplicates of
Authentication Agent accounts. To remove the duplicate accounts, you must use the klmover utility with
the dupfix key. The klmover utility is included in the Kaspersky Security Center build. You can read more
about its operation in the Kaspersky Security Center Help.
Access to encrypted hard drives is possible only from computers on which Kaspersky Endpoint Security with
full disk encryption functionality is installed. This precaution minimizes the risk of data leaks from an encrypted
hard drive when an attempt to access it is made outside of the local area network of the company.
To encrypt hard drives and removable drives, you can use the Encrypt used disk space only function. It is
recommended you only use this function for new devices that have not been previously used. If you are applying
encryption to a device that is already in use, it is recommended you encrypt the entire device. This ensures that all
data is protected – even deleted data that might still contain retrievable information.
Before beginning encryption, Kaspersky Endpoint Security obtains the map of le system sectors. The rst wave
of encryption includes sectors that are occupied by les at the moment when encryption is started. The second
wave of encryption includes sectors that were written to after encryption began. After encryption is complete, all
sectors containing data are encrypted.
After encryption is complete and a user deletes a le, the sectors that stored the deleted le become available for
storing new information at the le system level but remain encrypted. Thus, as les are written to a new device and
the device is regularly encrypted with the Encrypt used disk space only function enabled, all sectors will be
encrypted after some time.
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The data needed to decrypt les is provided by the Kaspersky Security Center Administration Server that
controlled the computer at the time of encryption. If the computer with encrypted objects was managed by a
di erent Administration Server for some reason, you can obtain access to the encrypted data in one of the
following ways:
Administration Servers in the same hierarchy:
You do not need to take any additional actions. The user will retain access to the encrypted objects.
Encryption keys are distributed to all Administration Servers.
Separated Administration Servers:
Request access to encrypted objects from the LAN administrator.
Restore data on encrypted devices using the Restore Utility.
Restore the con guration of the Kaspersky Security Center Administration Server that controlled the
computer at the time of encryption from a backup copy and use this con guration on the Administration
Server that now controls the computer with encrypted objects.
If there is no access to encrypted data, follow the special instructions for working with encrypted data (Restoring
access to encrypted les, Working with encrypted devices when there is no access to them).

Encryption functionality limitations
Data Encryption has the following limitations:
The application creates service les during encryption. Around 0.5% of non-fragmented free space on the hard
drive is required to store them. If there is not enough non-fragmented free space on the hard drive, encryption
will not start until enough space is freed up.
You can manage all data encryption components in the Kaspersky Security Center Administration Console and
in the Kaspersky Security Center Web Console. In the Kaspersky Security Center Cloud Console, you can only
manage Bitlocker.
Data encryption is available only when using Kaspersky Endpoint Security with the Kaspersky Security Center
administration system or the Kaspersky Security Center Cloud Console (BitLocker only). Data Encryption when
using Kaspersky Endpoint Security in o line mode is not possible because Kaspersky Endpoint Security stores
encryption keys in Kaspersky Security Center.
If Kaspersky Endpoint Security is installed on a computer running Microsoft Windows for Servers, only full disk
encryption using BitLocker Drive Encryption technology is available. If Kaspersky Endpoint Security is installed
on a computer running Windows for Workstations, data encryption functionality is fully available.
Full disk encryption using Kaspersky Disk Encryption technology is unavailable for hard drives that do not meet the
hardware and software requirements.
Compatibility between the full disk encryption functionality of Kaspersky Endpoint Security and Kaspersky AntiVirus for UEFI is not supported. Kaspersky Anti-Virus for UEFI starts before the operating system loads. When
using full disk encryption, the application will detect the absence of an installed operating system on the computer.
As a result, the operation of Kaspersky Anti-Virus for UEFI will end with an error. File Level Encryption (FLE) does
not a ect the operation of Kaspersky Anti-Virus for UEFI.
Kaspersky Endpoint Security supports the following con gurations:
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HDD, SSD, and USB drives.
Kaspersky Disk Encryption (FDE) technology supports working with SSD while preserving the performance
and service life of SSD drives.
Drives connected via bus: SCSI, ATA, IEEE1934, USB, RAID, SAS, SATA, NVME.
Non-removable drives connected via SD or MMC bus.
Drives with 512-byte sectors.
Drives with 4096-byte sectors that emulate 512 bytes.
Drives with the following type of partitions: GPT, MBR, and VBR (removable drives).
Embedded software of the UEFI 64 and Legacy BIOS standard.
Embedded software of the UEFI standard with Secure Boot support.

Secure Boot is a technology designed to verify digital signatures for UEFI loader applications and drivers.
Secure Boot blocks the startup of UEFI applications and drivers that are unsigned or signed by unknown
publishers. Kaspersky Disk Encryption (FDE) fully supports Secure Boot. Authentication Agent is signed by a
Microsoft Windows UEFI Driver Publisher certi cate.
On some devices (for example, Microsoft Surface Pro and Microsoft Surface Pro 2), an out-of-date list of
digital signature veri cation certi cates may be installed by default. Prior to encrypting the drive, you need to
update the list of certi cates.
Embedded software of the UEFI standard with Fast Boot support.

Fast Boot is a technology that helps the computer start up faster. When Fast Boot technology is enabled,
normally the computer loads only the minimum set of UEFI drivers required for starting the operating system.
When Fast Boot technology is enabled, USB keyboards, mice, USB tokens, touchpads and touchscreens may
not work while Authentication Agent is running.
To use Kaspersky Disk Encryption (FDE), it is recommended to disable Fast Boot technology. You can use
the FDE Test Utility to test the operation of Kaspersky Disk Encryption (FDE).
Kaspersky Endpoint Security does not support the following con gurations:
The boot loader is located on one drive while the operating system is on a di erent drive.
The system contains embedded software of the UEFI 32 standard.
The system has Intel® Rapid Start Technology and drives that have a hibernation partition even when Intel®
Rapid Start Technology is disabled.
Drives in MBR format with more than 10 extended partitions.
The system has a swap le located on a non-system drive.
Multiboot system with multiple simultaneously installed operating systems.
Dynamic partitions (only primary partitions are supported).
Drives with less than 0.5% free unfragmented disk space.
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Drives with a sector size di erent from 512 bytes or 4096 bytes that emulate 512 bytes.
Hybrid drives.
The system has third-party loaders.
Drives with compressed NTFS directories.
Kaspersky Disk Encryption (FDE) technology is incompatible with other full disk encryption technologies (such
as BitLocker, McAfee Drive Encryption, and WinMagic SecureDoc).
Kaspersky Disk Encryption (FDE) technology is incompatible with Express Cache technology.
Creating, deleting, and modifying partitions on an encrypted drive is not supported. You could lose data.
File system formatting is not supported. You could lose data.
If you need to format a drive that was encrypted with Kaspersky Disk Encryption (FDE) technology, format the
drive on a computer that does not have Kaspersky Endpoint Security for Windows and use only full disk
encryption.
An encrypted drive that is formatted with the quick format option may be mistakenly identi ed as encrypted
the next time it is connected to a computer that has Kaspersky Endpoint Security for Windows installed. User
data will be unavailable.
Authentication Agent supports no more than 100 accounts.
Single Sign-On technology is incompatible with other technologies of third-party developers.
Kaspersky Disk Encryption (FDE) technology is not supported on the following models of devices:
Dell Latitude E6410 (UEFI mode)
HP Compaq nc8430 (Legacy BIOS mode)
Lenovo Think Center 8811 (Legacy BIOS mode)
Authentication Agent does not support working with USB tokens when Legacy USB Support is enabled. Only
password-based authentication will be possible on the computer.
When encrypting a drive in Legacy BIOS mode, you are advised to enable Legacy USB Support on the following
models of devices:
Acer Aspire 5560G
Acer Aspire 6930
Acer TravelMate 8572T
Dell Inspiron 1420
Dell Inspiron 1545
Dell Inspiron 1750
Dell Inspiron N4110
Dell Latitude E4300
399

Dell Studio 1537
Dell Studio 1569
Dell Vostro 1310
Dell Vostro 1320
Dell Vostro 1510
Dell Vostro 1720
Dell Vostro V13
Dell XPS L502x
Fujitsu Celsius W370
Fujitsu LifeBook A555
HP Compaq dx2450 Microtower PC
Lenovo G550
Lenovo ThinkPad L530
Lenovo ThinkPad T510
Lenovo ThinkPad W540
Lenovo ThinkPad X121e
Lenovo ThinkPad X200s (74665YG)
Samsung R530
Toshiba Satellite A350
Toshiba Satellite U400 10O
MSI 760GM-E51 (motherboard)

Changing the length of the encryption key (AES56 / AES256)
Kaspersky Endpoint Security uses the Advanced Encryption Standard (AES) encryption algorithm. Kaspersky
Endpoint Security supports the AES encryption algorithm with an e ective key length of 256 or 56 bits. The data
encryption algorithm depends on the AES encryption library that is included in the distribution package: Strong
encryption (AES256) or Lite encryption (AES56). The AES encryption library is installed together with the
application.
Changing the length of the encryption key is available only for Kaspersky Endpoint Security 11.2.0 or later.
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Changing the encryption key length consists of the following steps:
1. Decrypt objects that Kaspersky Endpoint Security encrypted before you begin changing the encryption key
length:
a. Decrypt hard drives.
b. Decrypt les on local drives.
c. Decrypt removable drives.
After the encryption key length is changed, objects that were previously encrypted become unavailable.
2. Remove Kaspersky Endpoint Security.
3. Install Kaspersky Endpoint Security from the Kaspersky Endpoint Security distribution package containing a
di erent encryption library.
You can also change the encryption key length by upgrading the application. The key length can be changed
through an application upgrade only if the following conditions are met:
Kaspersky Endpoint Security version 10 Service Pack 2 or later is installed on the computer.
Data encryption components (File Level Encryption, Full Disk Encryption) are not installed on the computer.
By default, data encryption components are not included in Kaspersky Endpoint Security. The BitLocker
Management component does not a ect the change in the length of the encryption key.
To change the encryption key length, run the kes_win.msi or setup_kes.exe le from the distribution package
containing the necessary encryption library. You can also remotely upgrade the application by using the installation
package.
It is impossible to change the length of the encryption key using the distribution package of the same version
of the application that is installed on your computer without rst uninstalling the application.

Kaspersky Disk Encryption
Kaspersky Disk Encryption is available only for computers running a Windows operating system for
workstations. For computers running a Windows operating system for servers, use BitLocker Drive Encryption
technology.

Kaspersky Endpoint Security supports full disk encryption in FAT32, NTFS and exFat le systems.
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Before starting full disk encryption, the application runs a series of checks to determine if the device can be
encrypted, which includes checking the system hard drive for compatibility with Authentication Agent or with
BitLocker encryption components. To check for compatibility, the computer must be restarted. After the
computer has been rebooted, the application performs all the necessary checks automatically. If the compatibility
check is successful, full disk encryption starts after the operating system has loaded and the application has
started. If the system hard drive is found to be incompatible with Authentication Agent or with BitLocker
encryption components, the computer must be restarted by pressing the Reset hardware button. Kaspersky
Endpoint Security logs information about the incompatibility. Based on this information, the application does not
start full disk encryption at operating system startup. Information about this event is logged in Kaspersky Security
Center reports.
If the hardware con guration of the computer has changed, the incompatibility information logged by the
application during the previous check should be deleted in order to check the system hard drive for compatibility
with Authentication Agent and BitLocker encryption components. To do so, prior to full disk encryption, type
avp pbatestreset in the command line. If the operating system fails to load after the system hard drive has
been checked for compatibility with Authentication Agent, you must remove the objects and data remaining after
test operation of Authentication Agent by using the Restore Utility and then start Kaspersky Endpoint Security
and execute the avp pbatestreset command again.
After full disk encryption has started, Kaspersky Endpoint Security encrypts all data that is written to hard drives.
If the user shuts down or restarts the computer during full disk encryption, Authentication Agent is loaded before
the next startup of the operating system. Kaspersky Endpoint Security resumes full disk encryption after
successful authentication in Authentication Agent and operating system startup.
If the operating system switches to hibernation mode during full disk encryption, Authentication Agent is loaded
when the operating system switches back from hibernation mode. Kaspersky Endpoint Security resumes full disk
encryption after successful authentication in Authentication Agent and operating system startup.
If the operating system goes into sleep mode during full disk encryption, Kaspersky Endpoint Security resumes full
disk encryption when the operating system comes out of sleep mode without loading Authentication Agent.
User authentication in the Authentication Agent can be performed in two ways:
Enter the name and password of the Authentication Agent account created by the LAN administrator using
Kaspersky Security Center tools.
Enter the password of a token or smart card connected to the computer.
Use of a token or smart card is available only if the computer hard drives were encrypted using the AES256
encryption algorithm. If the computer hard drives were encrypted using the AES56 encryption algorithm,
addition of the electronic certi cate le to the command will be denied.
The authentication agent supports keyboard layouts for the following languages:
English (UK)
English (USA)
Arabic (Algeria, Morocco, Tunis; AZERTY layout)
Spanish (Latin America)
Italian
German (Germany and Austria)
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German (Switzerland)
Portuguese (Brazil, ABNT2 layout)
Russian (for 105-key IBM / Windows keyboards with the QWERTY layout)
Turkish (QWERTY layout)
French (France)
French (Switzerland)
French (Belgium, AZERTY layout)
Japanese (for 106-key keyboards with the QWERTY layout)
A keyboard layout becomes available in the Authentication Agent if this layout has been added in the language
and regional standards settings of the operating system and has become available on the welcome screen of
Microsoft Windows.
If the Authentication Agent account name contains symbols that cannot be entered using keyboard layouts
available in the Authentication Agent, encrypted hard drives can be accessed only after they are restored using
the Restore Utility or after the Authentication Agent account name and password are restored.

Special features of SSD drive encryption
The application supports encryption of SSD drives, hybrid SSHD drives, and drives with the Intel Smart Response
feature. The application does not support encryption of drives with the Intel Rapid Start feature. Disable the Intel
Rapid Start feature prior to encrypting such a drive.
Encryption of SSD drives has the following special features:
If an SSD drive is new and contains no con dential data, enable encryption of only occupied space. This lets
you overwrite the relevant drive sectors.
If an SSD drive is in use and it has con dential data, select one of the following options:
Fully wipe the SSD drive (Secure Erase), install the operating system and run encryption of the SSD drive
with the option to encrypt only occupied space enabled.
Run encryption of the SSD drive with the option to encrypt only occupied space disabled.
Encryption of an SSD drive requires 5-10 GB of free space. The free space requirements for storing encryption
administration data are provided in the table below.
Free space requirements for storing encryption administration data

SSD drive size
(GB)

Free space on primary partition of SSD
drive (MB)

Free space on secondary partition of SSD
drive (MB)

128

250

64

256

250

640

512

300

128
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Full disk encryption using Kaspersky Disk Encryption technology
Prior to starting full disk encryption, you are advised to make sure that the computer is not infected. To do so,
start the Full Scan or Critical Areas Scan task. Performing full disk encryption on a computer that is infected
by a rootkit may cause the computer to become inoperable.

To perform full disk encryption using Kaspersky Disk Encryption technology:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select Kaspersky Disk Encryption.
Kaspersky Disk Encryption technology cannot be used if the computer has hard drives that were
encrypted by BitLocker.
7. In the Encryption mode drop-down list, select Encrypt all hard drives.
If the computer has several operating systems installed, after encrypting all hard drives you will be able to
load only the operating system that has the application installed.

If you need to exclude some of the hard drives from encryption, create a list of such hard drives.
8. Con gure rules for adding Authentication Agent accounts during disk encryption. The Agent allows a user to
complete authentication for access to encrypted drives and to load the operating system. To automatically add
Authentication Agent accounts, con gure the following settings:
During encryption, automatically create Authentication Agent accounts for Windows users. If this check
box is selected, the application creates Authentication Agent accounts based on the list of Windows user
accounts on the computer. By default, Kaspersky Endpoint Security uses all local and domain accounts with
which the user logged in to the operating system over the past 30 days.
Automatically create Authentication Agent accounts for all users of this computer upon sign-in. If this
check box is selected, the application checks information about Windows user accounts on the computer
before starting Authentication Agent. If Kaspersky Endpoint Security detects a Windows user account that
has no Authentication Agent account, the application will create a new account for accessing encrypted
drives. The new Authentication Agent account will have the following default settings: password-protected
sign-on only, and password change on rst authentication. Therefore, you do not need to manually add
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Authentication Agent accounts using the Manage Authentication Agent accounts task for computers with
already encrypted drives.
If you disabled automatic creation of Authentication Agent accounts, you can manually add Authentication
Agent accounts by using the Manage accounts task. You can also use this task to change the settings of
Authentication Agent accounts that were created automatically.
9. For user convenience, you can save the user name to Authentication Agent memory so that the user only has
to enter a password the next time they sign in to the system. To do so, select the Save user name entered in
Authentication Agent check box.
10. Select one of the following encryption methods:
If you want to apply encryption only to those hard drive sectors that are occupied by les, select the
Encrypt used disk space only check box.
If you are applying encryption on a drive that is already in use, it is recommended to encrypt the entire drive.
This ensures that all data is protected – even deleted data that might still contain retrievable information.
The Encrypt used disk space only function is recommended for new drives that have not been previously
used.
If you want to apply encryption to the entire hard drive, clear the Encrypt used disk space only check box.
If a device was previously encrypted using the Encrypt used disk space only (reduces encryption
time) option, after applying a policy in Encrypt all hard drives mode, sectors that are not occupied by
les remain unencrypted.
11. If a hardware incompatibility problem occurs during computer encryption, you can select the Use Legacy USB
Support (not recommended) check box.

Legacy USB Support is a BIOS/UEFI function that allows you to use USB devices (such as a security token)
during the computer's boot phase before starting the operating system (BIOS mode). Legacy USB Support
does not a ect support for USB devices after the operating system is started.
When the Legacy USB Support function is enabled, the Authentication Agent in BIOS mode does not
support working with tokens via USB. It is recommended to use this option only when there is a hardware
compatibility issue and only for those computers on which the problem occurred.
12. Save your changes.
You can use the Encryption Monitor tool to control the disk encryption or decryption process on a user's
computer. You can run the Encryption Monitor tool from the main application window.
If system hard drives are encrypted, the Authentication Agent loads before startup of the operating system. Use
the Authentication Agent to complete authentication for obtaining access to encrypted system hard drives and
load the operating system. After successful completion of the authentication procedure, the operating system
loads. The authentication process is repeated every time the operating system restarts.

Creating a list of hard drives excluded from encryption
You can create a list of exclusions from encryption only for Kaspersky Disk Encryption technology.
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To form a list of hard drives excluded from encryption:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select the Kaspersky Disk Encryption option.
Entries corresponding to hard drives excluded from encryption appear in the Do not encrypt the following
hard drives table. This table is empty if you have not previously formed a list of hard drives excluded from
encryption.
7. To add hard drives to the list of hard drives excluded from encryption:
a. Click the Add button.
b. In the Add devices from Kaspersky Security Center list window, specify the values of the following
parameters: Name, Computer, Disk type, and Kaspersky Disk Encryption.
c. Click the Refresh button.
d. In the Name column, select the check boxes in the table rows corresponding to those hard drives that you
want to add to the list of hard drives excluded from encryption.
e. Click OK.
The selected hard drives appear in the Do not encrypt the following hard drives table.
8. If you want to remove hard drives from the table of exclusions, select one or several rows in the Do not encrypt
the following hard drives table and click the Delete button.
To select multiple rows in the table, select them while holding down the CTRL key.
9. Save your changes.

Exporting and importing a list of hard drives excluded from encryption
You can export the list of hard drive encryption exclusions to an XML le. Then you can modify the le to, for
example, add a large number of exclusions of the same type. You can also use the export/import function to back
up the list of exclusions or to migrate the exclusions to a di erent server.
How to export and import a list of hard drive encryption exclusions in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select the Kaspersky Disk Encryption option.
Entries corresponding to hard drives excluded from encryption appear in the Do not encrypt the following
hard drives table.
7. To export the list of exclusions:
a. Select the exclusions that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any exclusion, Kaspersky Endpoint Security will export all exclusions.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
8. To import the list of rules:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
9. Save your changes.
How to export and import a list of hard drive encryption exclusions in the Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of exclusions.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Full Disk Encryption.
5. Select the Kaspersky Disk Encryption technology and follow the link to con gure the settings.
The encryption settings open.
6. Click the Exclusions link.
7. To export the list of rules:
a. Select the exclusions that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected exclusions, or export the entire list of exclusions.
d. In the window that opens, specify the name of the XML le to which you want to export the list of
exclusions, and select the folder in which you want to save this le.
e. Click the Save button.
Kaspersky Endpoint Security exports the entire list of exclusions to the XML le.
8. To import the list of rules:
a. Click the Import button.
b. In the window that opens, select the XML le from which you want to import the list of exclusions.
c. Click the Open button.
If the computer already has a list of exclusions, Kaspersky Endpoint Security will prompt you to delete
the existing list or add new entries to it from the XML le.
9. Save your changes.

Enabling Single Sign-On (SSO) technology
Single Sign-On (SSO) technology allows you to automatically log into the operating system using the credentials of
the Authentication Agent.
When using Single Sign-on technology, the Authentication Agent ignores the password strength requirements
speci ed in Kaspersky Security Center. You can set the password strength requirements in the operating system
settings.
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Single Sign-On technology is incompatible with third-party providers of account credentials.
How to enable the use of Single Sign-On technology in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Common Encryption Settings.
6. In the Password settings block, click the Settings button.
7. In the window that opens, on the Authentication Agent tab, select the Use Single Sign-On (SSO)
technology check box.
8. Save your changes.
As a result, the user needs to complete the authentication procedure only once with the Agent. The
authentication procedure is not required for loading the operating system. The operating system loads
automatically.
How to enable use of Single Sign-On in the Web Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to enable use
of Single Sign-On.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Full Disk Encryption.
5. Select the Kaspersky Disk Encryption technology and follow the link to con gure the settings.
The encryption settings open.
6. In the Password settings section, select the Use Single Sign-On (SSO) technology check box.
7. Click OK.
As a result, the user needs to complete the authentication procedure only once with the Agent. The
authentication procedure is not required for loading the operating system. The operating system loads
automatically.
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For Single Sign-On to work, the Windows account password and the password for the Authentication Agent
account must match. If the passwords do not match, the user needs to perform the authentication procedure
twice: in the interface of the Authentication Agent and before loading the operating system. After that, Kaspersky
Endpoint Security replaces the password of the Authentication Agent account with the password of the Windows
account.

Managing Authentication Agent accounts
Authentication Agent is needed for working with drives that are protected using Kaspersky Disk Encryption (FDE)
technology. Before the operating system is loaded, the user needs to complete authentication with the Agent. The
Manage Authentication Agent accounts task is designed for con guring user authentication settings. You can use
local tasks for individual computers as well as group tasks for computers from separate administration groups or a
selection of computers.
You cannot con gure a schedule for starting the Manage Authentication Agent accounts task. It is also
impossible to forcibly stop a task.
How to create the Manage Authentication Agent accounts task in the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → Manage Authentication Agent accounts.

Step 2. Selecting an Authentication Agent account management command
Generate a list of Authentication Agent account management commands. Management commands allow you
to add, modify, and delete Authentication Agent accounts (see instructions below). Only users who have an
Authentication Agent account can complete the authentication procedure, load the operating system, and
gain access to the encrypted drive.

Step 3. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 4. De ning the task name
Enter a name for the task, for example, Administrator Accounts.

Step 5. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.
As a result, after the task is completed at the next computer startup, the new user can complete the
authentication procedure, load the operating system, and gain access to the encrypted drive.
How to create the Manage Authentication Agent accounts task in the Web Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
2. In the Task type drop-down list, select Manage Authentication Agent accounts.
3. In the Task name eld, enter a brief description, such as Administrator accounts.
4. In the Select devices to which the task will be assigned section, select the task scope.

Step 2. Managing Authentication Agent accounts
Generate a list of Authentication Agent account management commands. Management commands allow you
to add, modify, and delete Authentication Agent accounts (see instructions below). Only users who have an
Authentication Agent account can complete the authentication procedure, load the operating system, and
gain access to the encrypted drive.

Step 3. Completing task creation
Finish the wizard by clicking the Finish button. A new task will be displayed in the list of tasks.
To run a task, select the check box opposite the task and click the Start button.
As a result, after the task is completed at the next computer startup, the new user can complete the
authentication procedure, load the operating system, and gain access to the encrypted drive.
To add an Authentication Agent account, you need to add a special command to the Manage Authentication
Agent accounts task. It is convenient to use a group task, for example, to add an administrator account to all
computers.
Kaspersky Endpoint Security allows you to automatically create Authentication Agent accounts before encrypting
a drive. You can enable automatic creation of Authentication Agent accounts in the Full Disk Encryption policy
settings. You can also use Single Sign-On (SSO) technology.
How to add an Authentication Agent account through the Administration Console (MMC)
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1. Open the properties of the Manage Authentication Agent accounts task.
2. In the task properties, select the Options section.
3. Click Add → Account adding command.
4. In the window that opens, in the Windows account eld, specify the name of the Microsoft Windows
account that will be used to create the Authentication Agent account.
5. If you manually entered the Windows account name, click the Allow button to de ne the account security
identi er (SID).
If you choose not to determine the security identi er (SID) by clicking the Allow button, it will be
determined when the task is performed on the computer.
De ning a Windows account security identi er is necessary to verify that the Windows account name
was entered correctly. If the Windows account does not exist on the computer or in the trusted
domain, the Manage Authentication Agent accounts task will end with an error.
6. Select the Replace existing account check box if you want the existing account previously created for the
Authentication Agent to be replaced with the account being created.
This step is available when you are adding an Authentication Agent account creation command in the
properties of a group task for managing Authentication Agent accounts. This step is not available
when you are adding an Authentication Agent account creation command in the properties of the
Manage Authentication Agent accounts local task.
7. In the User name eld, type the name of the Authentication Agent account that must be entered during
authentication for access to encrypted hard drives.
8. Select the Allow password-based authentication check box if you want the application to prompt the
user to enter the Authentication Agent account password during authentication for accessing encrypted
hard drives. Set a password for the Authentication Agent account. If necessary, you can request a new
password from the user after the rst authentication.
9. Select the Allow certi cate-based authentication check box if you want the application to prompt the
user to connect a token or smart card to the computer during authentication for accessing encrypted
hard drives. Select a certi cate le for authentication with a smart card or token.
10. If required, in the Command description eld, enter the Authentication Agent account details that you
need for managing the command.
11. Do one of the following:
Select the Allow authentication option if you want the application to allow the user working under the
account speci ed in the command to access the authentication dialog in Authentication Agent.
Select the Block authentication option if you want the application to block the user working under the
account speci ed in the command from accessing the authentication dialog in Authentication Agent.
12. Save your changes.
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How to add an Authentication Agent account through the Web Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Manage Authentication Agent accounts task of Kaspersky Endpoint Security.
The task properties window opens.
3. Select the Application settings tab.
4. In the list of Authentication Agent accounts, click the Add button.
This starts the Authentication Agent Account Management Wizard.
5. Select the Add account command type.
6. Select a user account. You can select an account from the list of domain accounts or manually enter the
account name. Click the Next button.
Kaspersky Endpoint Security determines the account security identi er (SID). This is necessary to verify
the account. If you entered the user name incorrectly, Kaspersky Endpoint Security will end the task with
an error.
7. Con gure the Authentication Agent account settings.
Create a new Authentication Agent account to replace the existing account. Kaspersky Endpoint
Security scans existing accounts on the computer. If the user security ID on the computer and in the
task match, Kaspersky Endpoint Security will change the user account settings in accordance with the
task.
User name. The default user name of the Authentication Agent account corresponds to the domain
name of the user.
Allow password-based authentication. Set a password for the Authentication Agent account. If
necessary, you can request a new password from the user after the rst authentication. This way, each
user will have their own unique password. You can also set password strength requirements for the
Authentication Agent account in the policy.
Allow certi cate-based authentication. Select a certi cate le for authentication with a smart card
or token. This way, the user will need to enter the password for the smart card or token.
Account access to encrypted data. Con gure user access to the encrypted drive. You can, for
example, temporarily disable user authentication instead of deleting the Authentication Agent account.
Comment. Enter an account description, if necessary.
8. Save your changes.
9. Select the check box next to the task and click the Start button.
As a result, after the task is completed at the next computer startup, the new user can complete the
authentication procedure, load the operating system, and gain access to the encrypted drive.
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To change the password and other settings of the Authentication Agent account, you need to add a special
command to the Manage Authentication Agent accounts task. It is convenient to use a group task, for example, to
replace the administrator token certi cate on all computers.
How to change the Authentication Agent account through the Administration Console (MMC)
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1. Open the properties of the Manage Authentication Agent accounts task.
2. In the task properties, select the Options section.
3. Click Add → Account editing command.
4. In the window that opens, in the Windows account eld, specify the name of the Microsoft Windows user
account that you want to change.
5. If you manually entered the Windows account name, click the Allow button to de ne the account security
identi er (SID).
If you choose not to determine the security identi er (SID) by clicking the Allow button, it will be
determined when the task is performed on the computer.
De ning a Windows account security identi er is necessary to verify that the Windows account name
was entered correctly. If the Windows account does not exist on the computer or in the trusted
domain, the Manage Authentication Agent accounts task will end with an error.
6. Select the Change user name check box and enter a new name for the Authentication Agent account if
you want Kaspersky Endpoint Security to change the user name for all Authentication Agent accounts
created using the Microsoft Windows account with the name indicated in the Windows account eld to
the name typed in the eld below.
7. Select the Modify password-based authentication settings check box to make password-based
authentication settings editable.
8. Select the Allow password-based authentication check box if you want the application to prompt the
user to enter the Authentication Agent account password during authentication for accessing encrypted
hard drives. Set a password for the Authentication Agent account.
9. Select the Edit the password change rule upon authentication in Authentication Agent check box if you
want Kaspersky Endpoint Security to change the value of the password change setting for all
Authentication Agent accounts created using the Microsoft Windows account with the name indicated in
the Windows account eld to the setting value speci ed below.
10. Specify the value of the password change setting upon authentication in Authentication Agent.
11. Select the Modify certi cate-based authentication settings check box to make settings of
authentication based on the electronic certi cate of a token or smart card editable.
12. Select the Allow certi cate-based authentication check box if you want the application to prompt the
user to enter the password to the token or smart card connected to the computer during the
authentication process in order to access encrypted hard drives. Select a certi cate le for authentication
with a smart card or token.
13. Select the Edit command description check box and edit the command description if you want Kaspersky
Endpoint Security to change the command description for all Authentication Agent accounts created
using the Microsoft Windows account with the name indicated in the Windows account eld.
14. Select the Edit the authentication access rule in Authentication Agent check box if you want Kaspersky
Endpoint Security to change the rule for user access to the authentication dialog in Authentication Agent
to the value speci ed below for all Authentication Agent accounts created using the Microsoft Windows
account with the name indicated in the Windows account eld.
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15. Specify the rule for accessing the authentication dialog in Authentication Agent.
16. Save your changes.
How to change the Authentication Agent account through the Web Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Manage Authentication Agent accounts task of Kaspersky Endpoint Security.
The task properties window opens.
3. Select the Application settings tab.
4. In the list of Authentication Agent accounts, click the Add button.
This starts the Authentication Agent Account Management Wizard.
5. Select the Edit account command type.
6. Select a user account. You can select an account from the list of domain accounts or manually enter the
account name. Click the Next button.
Kaspersky Endpoint Security determines the account security identi er (SID). This is necessary to verify
the account. If you entered the user name incorrectly, Kaspersky Endpoint Security will end the task with
an error.
7. Select the check boxes next to the settings that you want to edit.
8. Con gure the Authentication Agent account settings.
Create a new Authentication Agent account to replace the existing account. Kaspersky Endpoint
Security scans existing accounts on the computer. If the user security ID on the computer and in the
task match, Kaspersky Endpoint Security will change the user account settings in accordance with the
task.
User name. The default user name of the Authentication Agent account corresponds to the domain
name of the user.
Allow password-based authentication. Set a password for the Authentication Agent account. If
necessary, you can request a new password from the user after the rst authentication. This way, each
user will have their own unique password. You can also set password strength requirements for the
Authentication Agent account in the policy.
Allow certi cate-based authentication. Select a certi cate le for authentication with a smart card
or token. This way, the user will need to enter the password for the smart card or token.
Account access to encrypted data. Con gure user access to the encrypted drive. You can, for
example, temporarily disable user authentication instead of deleting the Authentication Agent account.
Comment. Enter an account description, if necessary.
9. Save your changes.
10. Select the check box next to the task and click the Start button.
To delete an Authentication Agent account, you need to add a special command to the Manage Authentication
Agent accounts task. It is convenient to use a group task, for example, to delete the account of a dismissed
employee.
How to delete an Authentication Agent account through the Administration Console (MMC)
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1. Open the properties of the Manage Authentication Agent accounts task.
2. In the task properties, select the Options section.
3. Click Add → Account deletion command.
4. In the window that opens, in the Windows account eld, specify the name of the Windows user account
that was used to create the Authentication Agent account that you want to delete.
5. If you manually entered the Windows account name, click the Allow button to de ne the account security
identi er (SID).
If you choose not to determine the security identi er (SID) by clicking the Allow button, it will be
determined when the task is performed on the computer.
De ning a Windows account security identi er is necessary to verify that the Windows account name
was entered correctly. If the Windows account does not exist on the computer or in the trusted
domain, the Manage Authentication Agent accounts task will end with an error.
6. Save your changes.
How to delete an Authentication Agent account through the Web Console

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Manage Authentication Agent accounts task of Kaspersky Endpoint Security.
The task properties window opens.
3. Select the Application settings tab.
4. In the list of Authentication Agent accounts, click the Add button.
This starts the Authentication Agent Account Management Wizard.
5. Select the Remove account command type.
6. Select a user account. You can select an account from the list of domain accounts or manually enter the
account name.
7. Save your changes.
8. Select the check box next to the task and click the Start button.
As a result, after the task is completed at the next computer startup, the user will not be able to complete
the authentication procedure and load the operating system. Kaspersky Endpoint Security will deny access
to encrypted data.
To view the list of users who can complete authentication with the Agent and load the operating system, you need
to go to the properties of the managed computer.
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How to view the list of Authentication Agent accounts through the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. Double-click to open the computer properties window.
5. In the computer properties window, select the Tasks section.
The list of local tasks opens.
6. Select the Manage Authentication Agent accounts task.
7. In the task properties, select the Options section.
As a result, you will be able to access a list of Authentication Agent accounts on this computer. Only users
from the list can complete authentication with the Agent and load the operating system.
How to view a list of Authentication Agent accounts through the Web Console

1. In the main window of Web Console, select Devices → Managed devices.
2. Click the name of the computer on which you want to view the list of Authentication Agent accounts.
This opens the computer properties.
3. In the computer properties window, select the Tasks section.
The list of local tasks opens.
4. Select the Manage Authentication Agent accounts task.
5. In the task properties, select the Application Settings tab.
As a result, you will be able to access a list of Authentication Agent accounts on this computer. Only users
from the list can complete authentication with the Agent and load the operating system.

Using a token and smart card with Authentication Agent
A token or smart card can be used for authentication when accessing encrypted hard drives. To do so, you must
add the electronic certi cate le of a token or smart card to the Manage Authentication Agent accounts task.
Use of a token or smart card is available only if the computer hard drives were encrypted using the AES256
encryption algorithm. If the computer hard drives were encrypted using the AES56 encryption algorithm,
addition of the electronic certi cate le to the command will be denied.
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Kaspersky Endpoint Security supports the following tokens, smart card readers, and smart cards:
SafeNet eToken PRO 64K (4.2b);
SafeNet eToken PRO 72K Java;
SafeNet eToken 4100-72K Java;
SafeNet eToken 5100;
SafeNet eToken 5105;
SafeNet eToken 7300;
EMC RSA SID 800;
Gemalto IDPrime.NET 510;
Gemalto IDPrime.NET 511;
Rutoken ECP;
Rutoken ECP Flash;
Athena IDProtect Laser;
SafeNet eToken PRO 72K Java;
Aladdin-RD JaCarta PKI.
To add the le of a token or smart card electronic certi cate to the command for creating an Authentication
Agent account, you must rst save the le using third-party software for managing certi cates.
The token or smart-card certi cate must have the following properties:
The certi cate must be compliant with the X.509 standard, and the certi cate le must have DER encoding.
The certi cate contains an RSA key with a length of at least 1024 bits.
If the electronic certi cate of the token or smart card does not meet these requirements, you cannot load the
certi cate le into the command for creating an Authentication Agent account.
The KeyUsage parameter of the certi cate must have the value keyEncipherment or dataEncipherment. The
KeyUsage parameter determines the purpose of the certi cate. If the parameter has a di erent value, Kaspersky
Security Center will download the certi cate le but will display a warning.
If a user has lost a token or smart card, the administrator must add the le of a token or smart card electronic
certi cate to the command for creating an Authentication Agent account. Then the user must complete the
procedure for receiving access to encrypted devices or restoring data on encrypted devices.

Hard drive decryption
You can decrypt hard drives even if there is no active license permitting data encryption.
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To decrypt hard drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select the technology with which the hard drives were encrypted.
7. Do one of the following:
In the Encryption mode drop-down list, select the Decrypt all hard drives option if you want to decrypt all
encrypted hard drives.
Add the encrypted hard drives that you want to decrypt to the Do not encrypt the following hard drives
table.
This option is available only for Kaspersky Disk Encryption technology.
8. Save your changes.
You can use the Encryption Monitor tool to control the disk encryption or decryption process on a user's
computer. You can run the Encryption Monitor tool from the main application window.
If the user shuts down or restarts the computer during decryption of hard drives that were encrypted using
Kaspersky Disk Encryption technology, the Authentication Agent loads before the next startup of the operating
system. Kaspersky Endpoint Security resumes hard drive decryption after successful authentication in the
authentication agent and operating system startup.
If the operating system switches to hibernation mode during decryption of hard drives that were encrypted
using Kaspersky Disk Encryption technology, Authentication Agent loads when the operating system comes out
of hibernation mode. Kaspersky Endpoint Security resumes hard drive decryption after successful
authentication in the authentication agent and operating system startup. After hard drive decryption,
hibernation mode is unavailable until the rst reboot of the operating system.
If the operating system goes into sleep mode during hard drive decryption, Kaspersky Endpoint Security
resumes hard drive decryption when the operating system comes out of sleep mode without loading the
Authentication Agent.

Restoring access to a drive protected by Kaspersky Disk Encryption
technology
If a user has forgotten the password for accessing a hard drive protected by Kaspersky Disk Encryption
technology, you need to start the recovery procedure (Request-Response).
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Restoring access to the system hard drive
Restoring access to a system hard drive protected by Kaspersky Disk Encryption technology consists of the
following steps:
1. The user reports the request blocks to the administrator (see the gure below).
2. The administrator enters the request blocks into Kaspersky Security Center, receives the response blocks and
reports the response blocks to the user.
3. The user enters the response blocks in the Authentication Agent interface and obtains access to the hard
drive.

Restoring access to a system hard drive protected by Kaspersky Disk Encryption technology

To start the recovery procedure, the user needs to click the Forgot your password button in the Authentication
Agent interface.
How to obtain response blocks for a system hard drive protected by Kaspersky Disk Encryption technology in the
Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the computer of the user requesting access to encrypted data and right-click
to open the context menu.
5. In the context menu, select Grant access in o line mode.
6. In the window that opens, select the Authentication Agent tab.
7. In the Encryption algorithm in use section, select an encryption algorithm: AES56 or AES256.
The data encryption algorithm depends on the AES encryption library that is included in the distribution
package: Strong encryption (AES256) or Lite encryption (AES56). The AES encryption library is installed
together with the application.
8. In the Account drop-down list, select the name of the Authentication Agent account of the user who
requested recovery of access to the drive.
9. In the Hard drive drop-down list, select the encrypted hard drive for which you need to recover access.
10. In the User request section enter the blocks of request dictated by the user.
As a result, the contents of the blocks of the response to the user's request for recovery of the user name
and password of an Authentication Agent account will be displayed in the Access key eld. Convey the
contents of the response blocks to the user.
How to obtain response blocks for a system hard drive protected by Kaspersky Disk Encryption technology in the
Web Console

1. In the main window of Web Console, select Devices → Managed devices.
2. Select the check box next to the name of the computer whose drive you want to restore access to.
3. Click the Grant access to the device in o line mode button.
4. In the window that opens, select the Authentication Agent section.
5. In the Account drop-down list, select the name of the Authentication Agent account created for the user
who is requesting recovery of the Authentication Agent account name and password.
6. Enter the request blocks conveyed by the user.
The contents of the blocks of the response to the user's request for recovery of the user name and
password of the Authentication Agent account will be displayed at the bottom of the window. Convey the
contents of the response blocks to the user.
After completing the recovery procedure, the Authentication Agent will prompt the user to change the password.
424

Restoring access to a non-system hard drive
Restoring access to a non-system hard drive protected by Kaspersky Disk Encryption technology consists of the
following steps:
1. The user sends a request access le to the administrator.
2. The administrator adds the request access le to Kaspersky Security Center, creates an access key le and
sends the le to the user.
3. The user adds the access key le to Kaspersky Endpoint Security and obtains access to the hard drive.
To start the recovery procedure, the user needs to attempt to access a hard drive. As a result, Kaspersky Endpoint
Security will create a request access le (a le with the KESDC extension), which the user needs to send to the
administrator, for example, by email.
How to obtain an access key le for an encrypted non-system hard drive in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the computer of the user requesting access to encrypted data and right-click
to open the context menu.
5. In the context menu, select Grant access in o line mode.
6. In the window that opens, select the Data Encryption tab.
7. On the Data Encryption tab, click the Browse button.
8. In the window for selecting a request access le, specify the path to the le received from the user.
You will see information about the user's request. Kaspersky Security Center generates a key le. Email the
generated encrypted data access key le to the user. Or save the access le and use any available method
to transfer the le.
How to obtain an encrypted non-system hard drive access key le in the Web Console
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1. In the main window of Web Console, select Devices → Managed devices.
2. Select the check box next to the name of the computer whose data you want to restore access to.
3. Click the Grant access to the device in o line mode button.
4. Select the Data Encryption section.
5. Click the Select le button and select the request access le that you received from the user (a le with
the KESDC extension).
The Web Console will display information about the request. This will include the name of the computer on
which the user is requesting access to the le.
6. Click the Save key button and select a folder to save the encrypted data access key le (a le with the
KESDR extension).
As a result, you will be able to obtain the encrypted data access key, which you will need to transfer to the
user.

Updating the operating system
There are a number of special considerations for updating the operating system of a computer that is protected
by Full Disk Encryption (FDE). Update the operating system as follows: rst update the OS on one computer, then
update the OS on a small portion of the computers, then update the OS on all computers of the network.
If you are using Kaspersky Disk Encryption technology, Authentication Agent is loaded before the operating
system is started. Using Authentication Agent, the user can sign in to the system and receive access to encrypted
drives. Then the operating system begins loading.
If you start an update of the operating system on a computer that is protected using Kaspersky Disk Encryption
technology, the OS Update Wizard will remove Authentication Agent. As a result, the computer can be locked
because the OS loader will not be able to access the encrypted drive.
For details about safely updating the operating system, please refer to the Technical Support Knowledge Base .
Automatic updating of the operating system is available under the following conditions:
1. The operating system is updated through WSUS (Windows Server Update Services).
2. Windows 10 version 1607 (RS1) or later is installed on the computer.
3. Kaspersky Endpoint Security version 11.2.0 or later is installed on the computer.
If all the conditions are met, you can update the operating system in the usual way.
If you are using Kaspersky Disk Encryption (FDE) technology and Kaspersky Endpoint Security for Windows version
11.1.0 or 11.1.1 is installed on the computer, you do not need to decrypt the hard drives to update Windows 10.
To update the operating system, you need to do the following:
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1. Prior to updating the system, copy the drivers named cm_km.inf, cm_km.sys, klfde.cat, klfde.inf, klfde.sys,
klfdefsf.cat, klfdefsf.inf, and klfdefsf.sys to a local folder. For example, C:\fde_drivers.
2. Run the system update installation with the /ReflectDrivers switch and specify the folder containing the
saved drivers:
setup.exe /ReflectDrivers C:\fde_drivers
If you are using BitLocker Drive Encryption technology, you do not need to decrypt the hard drives to update
Windows 10. For more details on BitLocker, please visit the Microsoft website .

Eliminating errors of encryption functionality update
Full Disk Encryption is updated when a previous version of the application is upgraded to Kaspersky Endpoint
Security for Windows 11.7.0.
When starting update of the Full Disk Encryption functionality the following errors may occur:
Unable to initialize update.
Device is incompatible with Authentication Agent.

To eliminate errors that occurred when you start update process of the Full Disk Encryption functionality in the
new application version:
1. Decrypt hard drives.
2. Encrypt hard drives once again.
During update of the Full Disk Encryption functionality the following errors may occur:
Unable to complete the update.
Full Disk Encryption upgrade rollback completed with an error.

To eliminate errors that occurred during update process of the Full Disk Encryption functionality,
restore access to encrypted devices using Restore Utility.

Selecting the Authentication Agent tracing level
The application logs service information about the operation of the Authentication Agent and information about
the user's operations with the Authentication Agent in the trace le.

To select the Authentication Agent tracing level:
1. As soon as a computer with encrypted hard drives starts, press the F3 button to call up a window for
con guring Authentication Agent settings.
2. Select the tracing level in the Authentication Agent settings window:
Disable debug logging (default). If this option is selected, the application does not log information about
Authentication Agent events in the trace le.
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Enable debug logging. If this option is selected, the application logs information about the operation of the
Authentication Agent and the user operations performed with the Authentication Agent in the trace le.
Enable verbose logging. If this option is selected, the application logs detailed information about the
operation of the Authentication Agent and the user operations performed with the Authentication Agent in
the trace le.
The level of detail of entries under this option is higher compared to the level of the Enable debug
logging option. A high level of detail of entries can slow down the startup of the Authentication Agent
and the operating system.
Enable debug logging and select serial port. If this option is selected, the application logs information
about the operation of the Authentication Agent and the user operations performed with the
Authentication Agent in the trace le, and relays it via the COM port.
If a computer with encrypted hard drives is connected to another computer via the COM port,
Authentication Agent events can be examined from this other computer.
Enable verbose debug logging and select serial port. If this option is selected, the application logs detailed
information about the operation of the Authentication Agent and the user operations performed with the
Authentication Agent in the trace le, and relays it via the COM port.
The level of detail of entries under this option is higher compared to the level of the Enable debug
logging and select serial port option. A high level of detail of entries can slow down the startup of the
Authentication Agent and the operating system.
Data is recorded in the Authentication Agent trace le if there are encrypted hard drives on the computer or
during full disk encryption.
The Authentication Agent trace le is not sent to Kaspersky, unlike other trace les of the application. If necessary,
you can manually send the Authentication Agent trace le to Kaspersky for analysis.

Editing Authentication Agent help texts
Before editing help messages of the Authentication Agent, please review the list of supported characters in a
preboot environment (see below).

To edit Authentication Agent help messages:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Common Encryption Settings.
6. In the Templates section, click the Help button.
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This opens the Authentication Agent help messages window.
7. Do the following:
Select the Authentication tab to edit the help text shown in the Authentication Agent window when
account credentials are being entered.
Select the Change password tab to edit the help text shown in the Authentication Agent window when the
password for the Authentication Agent account is being changed.
Select the Recover password tab to edit the help text shown in the Authentication Agent window when the
password for the Authentication Agent account is being recovered.
8. Edit help messages.
If you want to restore the original text, click the By default button.
You can enter help text containing 16 lines or less. The maximum length of a line is 64 characters.
9. Save your changes.

Limited support for characters in Authentication Agent help messages
In a preboot environment, the following Unicode characters are supported:
Basic Latin alphabet (0000 - 007F)
Additional Latin-1 characters (0080 - 00FF)
Extended Latin-A (0100 - 017F)
Extended Latin-B (0180 - 024F)
Uncombined extended ID characters (02B0 - 02FF)
Combined diacritical marks (0300 - 036F)
Greek and Coptic alphabets (0370 - 03FF)
Cyrillic (0400 - 04FF)
Hebrew (0590 - 05FF)
Arabic script (0600 - 06FF)
Additional extended Latin (1E00 - 1EFF)
Punctuation marks (2000 - 206F)
Currency symbols (20A0 - 20CF)
Letter-like symbols (2100 - 214F)
Geometric gures (25A0 - 25FF)
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Presentation forms of Arabic script-B (FE70 - FEFF)
Characters that are not speci ed in this list are not supported in a preboot environment. It is not recommended to
use such characters in Authentication Agent help messages.

Removing leftover objects and data after testing the operation of
Authentication Agent
During application uninstallation, if Kaspersky Endpoint Security detects objects and data that remained on the
system hard drive after test operation of Authentication Agent, application uninstallation is interrupted and
becomes impossible until such objects and data are removed.
Objects and data may remain on the system hard drive after test operation of Authentication Agent only in
exceptional cases. For example, this can happen if the computer has not been restarted after a Kaspersky Security
Center policy with encryption settings was applied, or if the application fails to start after test operation of
Authentication Agent.
You can remove objects and data that remained on the system hard drive after test operation of Authentication
Agent in the following ways:
Using the Kaspersky Security Center policy.
using Restore Utility.

To use a Kaspersky Security Center policy to remove objects and data that remained after test operation of
Authentication Agent:
1. Apply to the computer a Kaspersky Security Center policy with settings con gured to decrypt all computer
hard drives.
2. Start Kaspersky Endpoint Security.

To remove information about application incompatibility with Authentication Agent,
type the avp pbatestreset command in the command line.

BitLocker Management
BitLocker is an encryption technology built into Windows operating systems. Kaspersky Endpoint Security allows
you to control and manage Bitlocker using Kaspersky Security Center. BitLocker encrypts logical volumes.
BitLocker cannot be used for encryption of removable drives. For more details on BitLocker, refer to the Microsoft
documentation .
BitLocker provides secure storage of access keys using a trusted platform module. A Trusted Platform Module
(TPM) is a microchip developed to provide basic functions related to security (for example, to store encryption
keys). A Trusted Platform Module is usually installed on the computer motherboard and interacts with all other
system components via the hardware bus. Using TPM is the safest way to store BitLocker access keys, since TPM
provides pre-startup system integrity veri cation. You can still encrypt drives on a computer without a TPM. In this
case, the access key will be encrypted with a password. BitLocker uses the following authentication methods:
TPM.
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TPM and PIN.
Password.
After encrypting a drive, BitLocker creates a master key. Kaspersky Endpoint Security sends the master key to
Kaspersky Security Center so that you can restore access to the disk, for example, if a user has forgotten the
password.
If a user encrypts a disk using BitLocker, Kaspersky Endpoint Security will send information about disk encryption
to Kaspersky Security Center. However, Kaspersky Endpoint Security will not send the master key to Kaspersky
Security Center, so it will be impossible to restore access to the disk using Kaspersky Security Center. For
BitLocker to work correctly with Kaspersky Security Center, decrypt the drive and re-encrypt the drive using a
policy. You can decrypt a drive locally or using a policy.
After encrypting the system hard drive, the user needs to go through BitLocker authentication to boot the
operating system. After the authentication procedure, BitLocker will allow for users to log in. BitLocker does not
support single sign-on technology (SSO).
If you are using Windows group policies, turn o BitLocker management in the policy settings. Windows policy
settings may con ict with Kaspersky Endpoint Security policy settings. When encrypting a drive, errors may
occur.

Starting BitLocker Drive Encryption
Prior to starting full disk encryption, you are advised to make sure that the computer is not infected. To do so,
start the Full Scan or Critical Areas Scan task. Performing full disk encryption on a computer that is infected
by a rootkit may cause the computer to become inoperable.

To use BitLocker Drive Encryption on computers running Windows operating systems for servers, installing the
BitLocker Drive Encryption component may be required. Install the component using the operating system
tools (Add Roles and Components Wizard). For more information about installing BitLocker Drive Encryption,
refer to the Microsoft documentation .
How to run BitLocker Drive Encryption through the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select BitLocker Drive Encryption.
7. In the Encryption mode drop-down list, select Encrypt all hard drives.
If the computer has several operating systems installed, after encryption you will be able to load only
the operating system in which the encryption was performed.
8. Con gure advanced BitLocker Drive Encryption options (see table below).
9. Save your changes.
How to run BitLocker Drive Encryption through the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of Kaspersky Endpoint Security policy for the computers for which you want to start
BitLocker Drive Encryption.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Full Disk Encryption.
5. In the Manage encryption section, select BitLocker Drive Encryption.
6. Click the BitLocker Drive Encryption link.
This opens the Bitlocker Drive Encryption settings window.
7. In the Encryption mode drop-down list, select Encrypt all hard drives.
If the computer has several operating systems installed, after encryption you will be able to load only
the operating system in which the encryption was performed.
8. Con gure advanced BitLocker Drive Encryption options (see table below).
9. Click OK.
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You can use the Encryption Monitor tool to control the disk encryption or decryption process on a user's
computer. You can run the Encryption Monitor tool from the main application window.
After the policy is applied, the application will display the following queries, depending on the authentication
settings:
TPM only. No user input required. The disk will be encrypted when the computer restarts.
TPM + PIN / Password. If a TPM module is available, a PIN code prompt window appears. If a TPM module is not
available, you will see a password prompt window for preboot authentication.
Password only. You will see a password prompt window for preboot authentication.
If the Federal Information Processing standard compatibility mode is enabled for computer operating system,
then in Windows 8 and earlier versions of operating system, a request for connecting a storage device is
displayed to save the recovery key le. You can save multiple recovery key les on a single storage device.
After setting a password or a PIN, BitLocker will ask you to restart your computer to complete the encryption.
Next, the user needs to go through the BitLocker authentication procedure. After the authentication procedure,
the user must log on to the system. After the operating system has loaded, BitLocker will complete the encryption.
If there is no access to encryption keys, the user may request the local network administrator to provide a
recovery key (if the recovery key was not saved earlier on the storage device or was lost).
BitLocker Drive Encryption component settings

Parameter

Enable use of
BitLocker
authentication
requiring preboot keyboard
input on tablets

Description

This check box enables / disables the use of authentication requiring data input in a
preboot environment, even if the platform does not have the capability for preboot
input (for example, with touchscreen keyboards on tablets).
The touchscreen of tablet computers is not available in the preboot environment.
To complete BitLocker authentication on tablet computers, the user must
connect a USB keyboard, for example.
If the check box is selected, use of authentication requiring preboot input is allowed. It
is recommended to use this setting only for devices that have alternative data input
tools in a preboot environment, such as a USB keyboard in addition to touchscreen
keyboards.
If the check box is cleared, BitLocker Drive Encryption is not possible on tablets.

Use hardware
encryption
(Windows 8 and
later versions)
Encrypt used
disk space only
(Windows 8 and
later versions)

If the check box is selected, the application applies hardware encryption. This lets you
increase the speed of encryption and use less computer resources.

This check box enables / disables the option that limits the encryption area to only
occupied hard drive sectors. This limit lets you reduce encryption time.
Enabling or disabling the Encrypt used disk space only (reduces encryption
time) feature after starting encryption does not modify this setting until the hard
drives are decrypted. You must select or clear the check box before starting
encryption.
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If the check box is selected, only portions of the hard drive that are occupied by les
are encrypted. Kaspersky Endpoint Security automatically encrypts new data as it is
added.
If the check box is cleared, the entire hard drive is encrypted, including residual
fragments of previously deleted and modi ed les.
This option is recommended for new hard drives whose data has not been
modi ed or deleted. If you are applying encryption on a hard drive that is already in
use, it is recommended to encrypt the entire hard drive. This ensures protection of
all data, even deleted data that is potentially recoverable.
This check box is cleared by default.
Authentication
settings

Use password (Windows 8 and later versions)
If this option is selected, Kaspersky Endpoint Security prompts the user for a
password when the user attempts to access an encrypted drive.
This option can be selected when a Trusted Platform Module (TPM) is not being used.
Use Trusted Platform Module (TPM)
If this option is selected, BitLocker uses a Trusted Platform Module (TPM).
A Trusted Platform Module (TPM) is a microchip developed to provide basic functions
related to security (for example, to store encryption keys). A Trusted Platform Module
is usually installed on the computer motherboard and interacts with all other system
components via the hardware bus.
For computers running Windows 7 or Windows Server 2008 R2, only encryption
using a TPM module is available. If a TPM module is not installed, BitLocker
encryption is not possible. Use of a password on these computers is not
supported.
A device equipped with a Trusted Platform Module can create encryption keys that
can be decrypted only with the device. A Trusted Platform Module encrypts
encryption keys with its own root storage key. The root storage key is stored within the
Trusted Platform Module. This provides an additional level of protection against
attempts to hack encryption keys.
This action is selected by default.
You can set an additional layer of protection for access to the encryption key, and
encrypt the key with a password or a PIN:
Use PIN for TPM. If this check box is selected, a user can use of a PIN code to
obtain access to an encryption key that is stored in a Trusted Platform Module
(TPM).
If this check box is cleared, users are prohibited from using PIN codes. To access
the encryption key, a user must enter the password.
You can allow the user to use enhanced PIN. Enhanced PIN allows using other
characters in addition to numerical characters: uppercase and lowercase Latin
letters, special characters, and spaces.
Use Trusted Platform Module (TPM); if it is unavailable - use password. If the
check box is selected, the user can use a password to obtain access to encryption
keys when a Trusted Platform Module (TPM) is not available.
If the check box is cleared and the TPM is not available, full disk encryption will not
start.

434

Decrypting a hard drive protected by BitLocker
Users can decrypt a disk using the operating system (the Turn O BitLocker function). After that, Kaspersky
Endpoint Security will prompt the user to encrypt the disk again. Kaspersky Endpoint Security will be prompting to
encrypt the disk unless you enable disk decryption in the policy.
How to decrypt a hard drive protected by BitLocker through the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Full Disk Encryption.
6. In the Encryption technology drop-down list, select BitLocker Drive Encryption.
7. In the Encryption mode drop-down list, select Decrypt all hard drives.
8. Save your changes.
How to decrypt a BitLocker-encrypted hard drive through the Web Console and Cloud Console

1. In the main window of Web Console, select the Devices → Policies & pro les tab.
2. Click the name of Kaspersky Endpoint Security policy for the computers for which you want to decrypt
hard drives.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Full Disk Encryption.
5. Select the BitLocker Drive Encryption technology and follow the link to con gure the settings.
The encryption settings open.
6. In the Encryption mode drop-down list, select Decrypt all hard drives.
7. Click OK.
You can use the Encryption Monitor tool to control the disk encryption or decryption process on a user's
computer. You can run the Encryption Monitor tool from the main application window.
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Restoring access to a drive protected by BitLocker
If a user has forgotten the password for accessing a hard drive encrypted by BitLocker, you need to start the
recovery procedure (Request-Response).
If the computer's operating system has Federal Information Processing standard (FIPS) compatibility mode
enabled, then in Windows 8 and older the recovery key le is saved to the removable drive before encryption.
To restore access to the drive, insert the removable drive and follow the on-screen instructions.
Restoring access to a hard drive encrypted by BitLocker consists of the following steps:
1. The user tells the administrator the recovery key ID (see the gure below).
2. The administrator veri es the ID of the recovery key in the computer properties in Kaspersky Security Center.
The ID that the user provided must match the ID that is displayed in the computer properties.
3. If the recovery key IDs match, the administrator provides the user with the recovery key or sends a recovery key
le.
A recovery key le is used for computers running the following operating systems:
Windows 7;
Windows 8;
Windows Server 2008;
Windows Server 2011;
Windows Server 2012.
For all other operating systems, a recovery key is used.
4. The user enters the recovery key and gains access to the hard drive.
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Restoring access to a hard drive encrypted by BitLocker

Restoring access to a system drive
To start the recovery procedure, the user needs to press the Esc key at the pre-boot authentication stage.
How to view the recovery key for a system drive encrypted by BitLocker in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the computer of the user requesting access to encrypted data and right-click
to open the context menu.
5. In the context menu, select Grant access in o line mode.
6. In the window that opens, select the Access to a BitLocker-protected system drive tab.
7. Prompt the user for the recovery key ID indicated in the BitLocker password input window, and compare it
with the ID in the Recovery key ID eld.
If the IDs do not match, this key is not valid for restoring access to the speci ed system drive. Make
sure that the name of the selected computer matches the name of the user's computer.
As a result, you will have access to the recovery key or le of the recovery key, which will need to be
transferred to the user.
How to view the recovery key for a BitLocker-encrypted system drive in the Web Console and Cloud Console
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1. In the main window of Web Console, select Devices → Managed devices.
2. Select the check box next to the name of the computer whose drive you want to restore access to.
3. Click the Grant access to the device in o line mode button.
4. In the window that opens, select the BitLocker section.
5. Verify the recovery key ID. The ID provided by the user must match the ID that is displayed in the computer
settings.
If the IDs do not match, this key is not valid for restoring access to the speci ed system drive. Make
sure that the name of the selected computer matches the name of the user's computer.
6. Click the Receive key button.
As a result, you will have access to the recovery key or le of the recovery key, which will need to be
transferred to the user.
After the operating system is loaded, Kaspersky Endpoint Security prompts the user to change the password or
PIN code. After you set a new password or PIN code, BitLocker will create a new master key and send the key to
Kaspersky Security Center. As a result, the recovery key and recovery key le will be updated. If the user has not
changed the password, you can use the old recovery key the next time the operating system loads.
Windows 7 computers don't allow changing the password or PIN code. After the recovery key is entered and
the operating system is loaded, Kaspersky Endpoint Security won't prompt the user to change the password
or PIN code. Thus, it is impossible to set a new password or a PIN code. This issue stems from the peculiarities
of the operating system. To continue, you need to re-encrypt the hard drive.

Restoring access to a non-system drive
To start the recovery procedure, the user needs to click the Forgot your password link in the window providing
access to the drive. After gaining access to the encrypted drive, the user can enable automatic unlocking of the
drive during Windows authentication in the BitLocker settings.
How to view the recovery key for a non-system drive encrypted by BitLocker in the Administration Console
(MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select the Additional → Data encryption and protection →
Encrypted drives folder.
3. In the workspace, select the encrypted device for which you want to create an access key le, then in the
context menu of the device, click Get access to the device in Kaspersky Endpoint Security for
Windows.
4. Prompt the user for the recovery key ID indicated in the BitLocker password input window, and compare it
with the ID in the Recovery key ID eld.
If the IDs do not match, this key is not valid for restoring access to the speci ed drive. Make sure that
the name of the selected computer matches the name of the user's computer.
5. Send the user the key that is indicated in the Recovery key eld.
How to view the recovery key for a BitLocker-encrypted non-system drive in the Web Console and Cloud Console

1. In the main window of the Web Console, select Operations → Data encryption and protection →
Encrypted Drives.
2. Select the check box next to the name of the computer whose drive you want to restore access to.
3. Click the Grant access to the device in o line mode button.
This starts the Wizard for granting access to a device.
4. Follow the instructions of the Wizard for granting access to a device:
a. Select the Kaspersky Endpoint Security for Windows plug-in.
b. Verify the recovery key ID. The ID provided by the user must match the ID that is displayed in the
computer settings.
If the IDs do not match, this key is not valid for restoring access to the speci ed system drive. Make
sure that the name of the selected computer matches the name of the user's computer.
c. Click the Receive key button.
As a result, you will have access to the recovery key or le of the recovery key, which will need to be
transferred to the user.

Pausing BitLocker protection to update software
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There are a number of special considerations for updating the operating system, installing update packages for the
operating system, or updating other software with BitLocker protection turned on. Installing updates may require
restarting the computer multiple times. After each restart, the user must complete BitLocker authentication. To
make sure updates install correctly, you can temporarily turn o BitLocker authentication. In this case the disk
stays encrypted and the user has access to data after signing in to the system. To manage BitLocker
authentication, you can use the BitLocker Protection Management task. You can use this task to specify the
number of computer restarts that do not require BitLocker authentication. In this way, after updates are installed
and the BitLocker Protection Management task is complete, BitLocker authentication is automatically enabled.
You can enable BitLocker authentication at any time.
How to pause BitLocker protection using the Administration Console (MMC)
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1. In the Administration Console, go to the folder Administration Server → Tasks.
The list of tasks opens.
2. Click the New task button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Selecting task type
Select Kaspersky Endpoint Security for Windows (11.7.0) → BitLocker Protection Management.

Step 2. BitLocker Protection Management
Con gure BitLocker authentication. To pause BitLocker protection, select Temporarily allow skipping
BitLocker authentication and enter the number of restarts without BitLocker authentication (1 to 15 times). If
necessary, enter an expiration date and time for the task. At the speci ed time, the task is automatically
turned o , and the user must complete BitLocker authentication when the computer is restarted.

Step 3. Selecting the devices to which the task will be assigned
Select the computers on which the task will be performed. The following options are available:
Assign the task to an administration group. In this case, the task is assigned to computers included in a
previously created administration group.
Select computers detected by the Administration Server in the network: unassigned devices. The speci c
devices can include devices in administration groups as well as unassigned devices.
Specify device addresses manually, or import addresses from a list. You can specify NetBIOS names, IP
addresses, and IP subnets of devices to which you want to assign the task.

Step 4. De ning the task name
Enter the name of the task, for example Updating to Windows 10.

Step 5. Completing task creation
Exit the Wizard. If necessary, select the Run the task after the Wizard nishes check box. You can monitor
the progress of the task in the task properties.
How to pause BitLocker protection using Web Console
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1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts. Follow the instructions of the Wizard.

Step 1. Con guring general task settings
Con gure the general task settings:
1. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
2. In the Task type drop-down list, select BitLocker Protection Management.
3. In the Task name eld, enter a brief description, for example, Updating to Windows 10.
4. In the Select devices to which the task will be assigned section, select the task scope.

Step 2. BitLocker Protection Management
Con gure BitLocker authentication. To pause BitLocker protection, select Temporarily allow skipping
BitLocker authentication and enter the number of restarts without BitLocker authentication (1 to 15 times). If
necessary, enter an expiration date and time for the task. At the speci ed time, the task is automatically
turned o , and the user must complete BitLocker authentication when the computer is restarted.

Step 3. Completing task creation
Finish the wizard by clicking the Finish button. A new task will be displayed in the list of tasks.
To run a task, select the check box opposite the task and click the Start button.
As a result, when the task is running, after the next restart of the computer, BitLocker does not prompt the user
for authentication. After each restart of the computer without BitLocker authentication, Kaspersky Endpoint
Security generates a corresponding event and records the number of remaining restarts. Kaspersky Endpoint
Security then sends the event to Kaspersky Security Center to be monitored by the administrator. You can also
nd out the number of remaining restarts in computer properties in the Kaspersky Security Center console.
When the speci ed number of restarts or the expiration time of the task is reached, BitLocker authentication is
automatically turned on. To gain access to data, the user must complete BitLocker authentication.
On computers running Windows 7, BitLocker cannot count computer restarts. Counting restarts on Windows
7 computers is handled by Kaspersky Endpoint Security. Thus to automatically turn on BitLocker
authentication after each restart, Kaspersky Endpoint Security must be started.
To turn on BitLocker authentication ahead of time, open BitLocker Protection Management task properties and
select the Request authentication each time in preboot option.

442

File Level Encryption on local computer drives
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
File encryption has the following special features:
Kaspersky Endpoint Security encrypts / decrypts les in prede ned folders only for local user pro les of the
operating system. Kaspersky Endpoint Security does not encrypt or decrypt les in prede ned folders of
roaming user pro les, mandatory user pro les, temporary user pro les, or redirected folders.
Kaspersky Endpoint Security does not encrypt les whose modi cation could harm the operating system and
installed applications. For example, the following les and folders with all nested folders are on the list of
encryption exclusions:
%WINDIR%;
%PROGRAMFILES% and %PROGRAMFILES(X86)%;
Windows registry les.
The list of encryption exclusions cannot be viewed or edited. While les and folders on the list of encryption
exclusions can be added to the encryption list, they will not be encrypted during le encryption.

Encrypting les on local computer drives
Kaspersky Endpoint Security does not encrypt les whose contents are located in OneDrive cloud storage,
and blocks the encrypted les from copying to OneDrive cloud storage, if these les are not added to
decryption rule.

To encrypt les on local drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → File Level Encryption.
6. In the right part of the window, select the Encryption tab.
7. In the Encryption mode drop-down list, select the According to rules item.
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8. On the Encryption tab, click the Add button, and in the drop-down list select one of the following items:
a. Select the Prede ned folders item to add les from folders of local user pro les suggested by Kaspersky
experts to an encryption rule.
Documents. Files in the standard Documents folder of the operating system, and its subfolders.
Favorites. Files in the standard Favorites folder of the operating system, and its subfolders.
Desktop. Files in the standard Desktop folder of the operating system, and its subfolders.
Temporary les. Temporary les related to the operation of applications installed on the computer. For
example, Microsoft O ice applications create temporary les containing backup copies of documents.
Outlook les. Files related to the operation of the Outlook mail client: data les (PST), o line data les
(OST), o line address book les (OAB), and personal address book les (PAB).
b. Select the Custom folder item to add a manually entered folder path to an encryption rule.
When adding a folder path, adhere to the following rules:
Use an environment variable (for example, %FOLDER%\UserFolder\). You can use an environment
variable only once and only at the beginning of the path.
Do not use relative paths. You can use the set \..\ (e.g. C:\Users\..\UserFolder\). The set \..\
denotes the transition to the parent folder.
Do not use the * and ? characters.
Do not use UNC paths.
Use ; or , as a separator character.
c. Select the Files by extension item to add individual le extensions to an encryption rule. Kaspersky Endpoint
Security encrypts les with the speci ed extensions on all local drives of the computer.
d. Select the Files by groups of extensions item to add groups of le extensions to an encryption rule (for
example, Microsoft O ice Documents). Kaspersky Endpoint Security encrypts les that have the extensions
listed in the groups of extensions on all local drives of the computer.
9. Save your changes.
As soon as the policy is applied, Kaspersky Endpoint Security encrypts the les that are included in the
encryption rule and not included in the decryption rule.
File encryption has the following special features:
If the same le is added to both an encryption rule and a decryption rule, then Kaspersky Endpoint Security
performs the following actions:
If the le is not encrypted, Kaspersky Endpoint Security does not encrypt this le.
If the le is encrypted, Kaspersky Endpoint Security decrypts this le.
Kaspersky Endpoint Security continues to encrypt new les if these les meet the criteria of the encryption
rule. For example, when you change the properties of an unencrypted le (path or extension), the le then
meets the criteria of the encryption rule. Kaspersky Endpoint Security encrypts this le.
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When the user creates a new le whose properties meet the encryption rule criteria, Kaspersky Endpoint
Security encrypts the le as soon as it is opened.
Kaspersky Endpoint Security postpones the encryption of open les until they are closed.
If you move an encrypted le to another folder on the local drive, the le remains encrypted regardless of
whether or not this folder is included in the encryption rule.
If you decrypt a le and copy it to another local folder that is not included in the decryption rule, a copy of the
le may be encrypted. To prevent the copied le from being encrypted, create a decryption rule for the target
folder.

Forming encrypted le access rules for applications
To form encrypted le access rules for applications:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → File Level Encryption.
6. In the right part of the window, select the Encryption tab.
7. In the Encryption mode drop-down list, select the According to rules item.
Access rules are applied only when in the According to rules mode. After applying access rules in
According to rules mode, if you switch to Leave unchanged, mode, Kaspersky Endpoint Security will
ignore all access rules. All applications will have access to all encrypted les.
8. In the right part of the window, select the Rules for applications tab.
9. If you want to select applications exclusively from the Kaspersky Security Center list, click the Add button and
in the drop-down list select the Applications from Kaspersky Security Center list item.
a. Specify the lters to narrow down the list of applications in the table. To do so, specify the values of the
Application, Vendor, and Period added parameters, and all check boxes from the Group section.
b. Click the Refresh button.
c. The table lists applications that match the applied lters.
d. In the Applications column, select check boxes opposite the applications for which you want to form
encrypted le access rules.
e. In the Rule for applications drop-down list, select the rule that will determine the access of applications to
encrypted les.
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f. In the Actions for applications that were selected earlier drop-down list, select the action to be taken by
Kaspersky Endpoint Security on encrypted le access rules that were previously formed for such
applications.
The details of an encrypted le access rule for applications appear in the table on the Rules for applications
tab.
10. If you want to manually select applications, click the Add button and in the drop-down list select the Custom
applications item.
a. In the entry eld, type the name or list of names of executable application les, including their extensions.
You can also add the names of executable les of applications from the Kaspersky Security Center list by
clicking the Add from Kaspersky Security Center list button.
b. If required, in the Description eld, enter a description of the list of applications.
c. In the Rule for applications drop-down list, select the rule that will determine the access of applications to
encrypted les.
The details of an encrypted le access rule for applications appear in the table on the Rule for applications
tab.
11. Save your changes.

Encrypting les that are created or modi ed by speci c applications
You can create a rule by which Kaspersky Endpoint Security will encrypt all les created or modi ed by the
applications speci ed in the rule.
Files that were created or modi ed by the speci ed applications before the encryption rule was applied will
not be encrypted.

To con gure encryption of les that are created or modi ed by speci c applications:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → File Level Encryption.
6. In the right part of the window, select the Encryption tab.
7. In the Encryption mode drop-down list, select the According to rules item.
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Encryption rules are applied only in According to rules mode. After applying encryption rules in According
to rules mode, if you switch to Leave unchanged, mode, Kaspersky Endpoint Security will ignore all
encryption rules. Files that were previously encrypted will remain encrypted.
8. In the right part of the window, select the Rules for applications tab.
9. If you want to select applications exclusively from the Kaspersky Security Center list, click the Add button and
in the drop-down list select the Applications from Kaspersky Security Center list item.
a. Specify the lters to narrow down the list of applications in the table. To do so, specify the values of the
Application, Vendor, and Period added parameters, and all check boxes from the Group section.
b. Click the Refresh button.
The table lists applications that match the applied lters.
c. In the Applications column, select the check boxes next to the applications whose created les you want to
encrypt.
d. In the Rule for applications drop-down list, select Encrypt all created les.
e. In the Actions for applications that were selected earlier drop-down list, select the action to be taken by
Kaspersky Endpoint Security on le encryption rules that were previously formed for such applications.
Information about the encryption rule for les created or modi ed by the selected applications appears in the
table on the Rules for applications tab.
10. If you want to manually select applications, click the Add button and in the drop-down list select the Custom
applications item.
a. In the entry eld, type the name or list of names of executable application les, including their extensions.
You can also add the names of executable les of applications from the Kaspersky Security Center list by
clicking the Add from Kaspersky Security Center list button.
b. If required, in the Description eld, enter a description of the list of applications.
c. In the Rule for applications drop-down list, select Encrypt all created les.
Information about the encryption rule for les created or modi ed by selected applications is displayed in the
table on the Rule for applications tab.
11. Save your changes.

Generating a decryption rule
To generate a decryption rule:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
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4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → File Level Encryption.
6. In the right part of the window, select the Decryption tab.
7. In the Encryption mode drop-down list, select the According to rules item.
8. On the Decryption tab, click the Add button, and in the drop-down list select one of the following items:
a. Select the Prede ned folders item to add les from folders of local user pro les suggested by Kaspersky
experts to a decryption rule.
b. Select the Custom folder item to add a manually entered folder path to a decryption rule.
c. Select the Files by extension item to add individual le extensions to a decryption rule. Kaspersky Endpoint
Security does not encrypt les with the speci ed extensions on all local drives of the computer.
d. Select the Files by groups of extensions item to add groups of le extensions to a decryption rule (for
example, Microsoft O ice Documents). Kaspersky Endpoint Security does not encrypt les that have the
extensions listed in the groups of extensions on all local drives of the computer.
9. Save your changes.
If the same le has been added to the encryption rule and the decryption rule, Kaspersky Endpoint Security
does not encrypt this le if it is not encrypted, and decrypts the le if it is encrypted.

Decrypting les on local computer drives
To decrypt les on local drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → File Level Encryption.
6. In the right part of the window, select the Encryption tab.
7. Remove les and folders that you want to decrypt from the encryption list. To do so, select les and select the
Delete rule and decrypt les item in the context menu of the Remove button.
You can delete several items from the encryption list at once. To do so, while holding down the CTRL key, select
the les you need by left-clicking them and select the Delete rule and decrypt les item in the context menu
of the Remove button.
Files and folders removed from the encryption list are automatically added to the decryption list.
8. Form a le decryption list.
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9. Save your changes.
As soon as the policy is applied, Kaspersky Endpoint Security decrypts encrypted les that are added to the
decryption list.
Kaspersky Endpoint Security decrypts encrypted les if their parameters ( le path / le name / le extension)
change to match the parameters of objects added to the decryption list.
Kaspersky Endpoint Security postpones the decryption of open les until they are closed.

Creating encrypted packages
To protect your data when sending les to users outside the corporate network, you can use encrypted packages.
Encrypted packages can be convenient for transferring large les on removable drives, as email clients have le
size restrictions.
Before creating encrypted packages, Kaspersky Endpoint Security will prompt the user for a password. To reliably
protect the data, you can enable password strength check and specify password strength requirements. This will
prevent users from using short and simple passwords, for example, 1234.
How to enable password strength check when creating encrypted archives in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Common Encryption Settings.
6. In the Password settings block, click the Settings button.
7. In the window that opens, select the Encrypted packages tab.
8. Con gure password complexity settings when creating encrypted packages.
How to enable password strength check when creating encrypted archives in the Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for the computers on which you want to enable
password strength check.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → File Level Encryption.
5. In the Encrypted package password settings block, con gure the password strength criteria required
when creating encrypted packages.
You can create encrypted packages on computers with Kaspersky Endpoint Security installed with File Level
Encryption available.
When adding a le to the encrypted package whose contents reside in OneDrive cloud storage, Kaspersky
Endpoint Security downloads the contents of the le and performs encryption.

To create an encrypted package:
1. In any le manager, select the les or folders that you want to add to the encrypted package. Right-click to
open their context menu.
2. In the context menu, select New encrypted package (see gure below).
3. In the window that opens, select a location on a removable drive to save the encrypted package → specify the
package name and click the Save button.
4. In the window that opens, specify the password and con rm it.
The password must meet the complexity criteria speci ed in the policy.
5. Click the Create button.
The encrypted package creation process starts. Kaspersky Endpoint Security does not perform le
compression when it creates an encrypted package. When the process nishes, a self-extracting passwordprotected encrypted package (an executable le with .exe extension –
) is created in the selected destination
folder.

Creating an encrypted package
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To access les in an encrypted package, double-click it to start the Unpacking Wizard, then enter the password. If
you forgot or lost your password, it is not possible to recover it and access the les in the encrypted package. You
can recreate the encrypted package.

Restoring access to encrypted les
When les are encrypted, Kaspersky Endpoint Security receives an encryption key required for directly accessing
the encrypted les. Using this encryption key, a user working under any Windows user account that was active
during le encryption can directly access the encrypted les. Users working under Windows accounts that were
inactive during le encryption must connect to Kaspersky Security Center in order to access the encrypted les.
Encrypted les may be inaccessible under the following circumstances:
The user's computer stores encryption keys, but there is no connection with Kaspersky Security Center for
managing them. In this case, the user must request access to encrypted les from the LAN administrator.
If access to Kaspersky Security Center does not exist, you must:
request an access key for access to encrypted les on computer hard drives;
to access encrypted les that are stored on removable drives, request separate access keys for encrypted
les on each removable drive.
Encryption components are deleted from the user's computer. In this event, the user may open encrypted les
on local and removable disks but the contents of those les will appear encrypted.
The user may work with encrypted les under the following circumstances:
Files are placed inside encrypted packages created on a computer with Kaspersky Endpoint Security
installed.
Files are stored on removable drives on which portable mode has been allowed.
To gain access to encrypted les, the user needs to start the recovery procedure (Request-Response).
Recovering access to encrypted les consists of the following steps:
1. The user sends a request access le to the administrator (see the gure below).
2. The administrator adds the request access le to Kaspersky Security Center, creates an access key le and
sends the le to the user.
3. The user adds the access key le to Kaspersky Endpoint Security and gains access to the les.

451

Restoring access to encrypted les

To start the recovery procedure, the user needs to attempt to access a le. As a result, Kaspersky Endpoint
Security will create a request access le (a le with the KESDC extension), which the user needs to send to the
administrator, for example, by email.
Kaspersky Endpoint Security generates a request access le for access to all encrypted les stored on the
computer's drive (local drive or removable drive).
How to obtain an encrypted data access key le in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the computer of the user requesting access to encrypted data and right-click
to open the context menu.
5. In the context menu, select Grant access in o line mode.
6. In the window that opens, select the Data Encryption tab.
7. On the Data Encryption tab, click the Browse button.
8. In the window for selecting a request access le, specify the path to the le received from the user.
You will see information about the user's request. Kaspersky Security Center generates a key le. Email the
generated encrypted data access key le to the user. Or save the access le and use any available method
to transfer the le.
How to obtain an encrypted data access key le in the Web Console
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1. In the main window of Web Console, select Devices → Managed devices.
2. Select the check box next to the name of the computer whose data you want to restore access to.
3. Click the Grant access to the device in o line mode button.
4. Select the Data Encryption section.
5. Click the Select le button and select the request access le that you received from the user (a le with
the KESDC extension).
The Web Console will display information about the request. This will include the name of the computer on
which the user is requesting access to the le.
6. Click the Save key button and select a folder to save the encrypted data access key le (a le with the
KESDR extension).
As a result, you will be able to obtain the encrypted data access key, which you will need to transfer to the
user.
After receiving the encrypted data access key le, the user needs to run the le by double-clicking it. As a result,
Kaspersky Endpoint Security will grant access to all encrypted les stored on the drive. To access encrypted les
that are stored on other drives, you must obtain a separate access key le for each drive.

Restoring access to encrypted data after operating system failure
You can restore access to data after operating system failure only for le level encryption (FLE). You cannot
restore access to data if full disk encryption (FDE) is used.

To restore access to encrypted data after operating system failure:
1. Reinstall the operating system without formatting the hard drive.
2. Install Kaspersky Endpoint Security.
3. Establish a connection between the computer and the Kaspersky Security Center Administration Server that
controlled the computer when the data was encrypted.
Access to encrypted data will be granted under the same conditions that applied before operating system
failure.

Editing templates of encrypted le access messages
To edit templates of encrypted le access messages:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
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3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Common Encryption Settings.
6. In the Templates section, click the Templates button.
The Templates window opens.
7. Do the following:
If you want to edit the user message template, select the User's message tab. The Access to data is
blocked window opens when the user attempts to access an encrypted le while there is no key available on
the computer for access to encrypted les. Clicking the Send by email button in the Access to data is
blocked window automatically creates a user message. This message is sent to the corporate LAN
administrator along with the le requesting access to encrypted les.
If you want to edit the administrator message template, select the Administrator's message tab. This
message is created automatically when you click the Send by email button in the Request access to
encrypted les window and is sent to the user after the user is granted access to encrypted les.
8. Edit the message templates.
You can use the By default button and the Variable drop-down list.
9. Save your changes.

Encryption of removable drives
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.

Kaspersky Endpoint Security supports encryption of les in FAT32 and NTFS le systems. If a removable drive
with an unsupported le system is connected to the computer, the encryption task for this removable drive
ends with an error and Kaspersky Endpoint Security assigns the read-only status to the removable drive.
To protect data on removable drives, you can use the following types of encryption:
Full Disk Encryption (FDE).
Encryption of the entire removable drive, including the le system.
It is not possible to access encrypted data outside the corporate network. It is also impossible to access
encrypted data inside the corporate network if the computer is not connected to Kaspersky Security
Center (e.g. on a guest computer).
File Level Encryption (FLE).
Encryption of only les on a removable drive. The le system remains unchanged.
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Encryption of les on removable drives provides the capability to access data outside the corporate
network using a special mode called portable mode.
During encryption, Kaspersky Endpoint Security creates a master key. Kaspersky Endpoint Security saves the
master key in the following repositories:
Kaspersky Security Center.
User's computer.
The master key is encrypted with the user's secret key.
Removable drive.
The master key is encrypted with the public key of Kaspersky Security Center.
After encryption is complete, the data on the removable drive can be accessed within the corporate network as if
was on an ordinary unencrypted removable drive.

Accessing encrypted data
When a removable drive with encrypted data is connected, Kaspersky Endpoint Security performs the following
actions:
1. Checks for a master key in the local storage on the user's computer.
If the master key is found, the user gains access to the data on the removable drive.
If the master key is not found, Kaspersky Endpoint Security performs the following actions:
a. Sends a request to Kaspersky Security Center.
After receiving the request, Kaspersky Security Center sends a response that contains the master key.
b. Kaspersky Endpoint Security saves the master key in the local storage on the user's computer for
subsequent operations with the encrypted removable drive.
2. Decrypts the data.

Special features of removable drive encryption
Encryption of removable drives has the following special features:
The policy with preset settings for removable drive encryption is formed for a speci c group of managed
computers. Therefore, the result of applying the Kaspersky Security Center policy con gured for
encryption / decryption of removable drives depends on the computer to which the removable drive is
connected.
Kaspersky Endpoint Security does not encrypt / decrypt read-only les that are stored on removable drives.
The following device types are supported as removable drives:
Data media connected via the USB bus
hard drives connected via USB and FireWire buses
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SSD drives connected via USB and FireWire buses

Starting encryption of removable drives
You can use a policy to decrypt a removable drive. A policy with de ned settings for removable drive encryption is
generated for a speci c administration group. Therefore, the result of data decryption on removable drives
depends on the computer to which the removable drive is connected.
Kaspersky Endpoint Security supports encryption in FAT32 and NTFS le systems. If a removable drive with an
unsupported le system is connected to the computer, removable drive encryption ends with an error and
Kaspersky Endpoint Security assigns read-only access for the removable drive.

To encrypt removable drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Encryption of removable drives.
6. In the Encryption mode drop-down list, select the default action that you want Kaspersky Endpoint Security to
perform on removable drives:
Encrypt entire removable drive (FDE). Kaspersky Endpoint Security encrypts the contents of a removable
drive sector by sector. As a result, the application encrypts not only the les stored on the removable drive
but also its le systems, including the le names and folder structures on the removable drive.
Encrypt all les (FLE). Kaspersky Endpoint Security encrypts all les that are stored on removable drives.
The application does not encrypt the le systems of removable drives, including the names of les and
folder structures.
Encrypt new les only (FLE). Kaspersky Endpoint Security encrypts only those les that have been added
to removable drives or that were stored on removable drives and have been modi ed after the Kaspersky
Security Center policy was last applied.
Kaspersky Endpoint Security does not encrypt a removable drive that is already encrypted.
7. If you want to use portable mode for encryption of removable drives, select the Portable mode check box.

Portable mode is a mode of le encryption (FLE) on removable drives that provides the ability to access data
outside of a corporate network. Portable mode also lets you work with encrypted data on computers that do
not have Kaspersky Endpoint Security installed.
8. If you want to encrypt a new removable drive, it is recommended to select the Encrypt used disk space only
check box. If the check box is cleared, Kaspersky Endpoint Security will encrypt all les, including the residual
fragments of deleted or modi ed les.
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9. If you want to con gure encryption for individual removable drives, de ne encryption rules.
10. If you want to use full disk encryption of removable drives in o line mode, select the Allow encryption of
removable drives in o line mode check box.

O line encryption mode refers to encryption of removable drives (FDE) when there is no connection to
Kaspersky Security Center. During encryption, Kaspersky Endpoint Security saves the master key only on the
user's computer. Kaspersky Endpoint Security will send the master key to Kaspersky Security Center during the
next synchronization.
If the computer on which the master key is saved is corrupted and data is not sent to Kaspersky Security
Center, it is not possible to obtain access to the removable drive.
If the Allow encryption of removable drives in o line mode check box is cleared and there is no connection to
Kaspersky Security Center, removable drive encryption is not possible.
11. Save your changes.
After the policy is applied, when the user connects a removable drive or if a removable drive is already
connected, Kaspersky Endpoint Security prompts the user for con rmation to perform the encryption
operation (see the gure below).
The application lets you perform the following actions:
If the user con rms the encryption request, Kaspersky Endpoint Security encrypts the data.
If the user declines the encryption request, Kaspersky Endpoint Security leaves the data unchanged and
assigns read-only access for this removable drive.
If the user does not respond to the encryption request, Kaspersky Endpoint Security leaves the data
unchanged and assigns read-only access for this removable drive. The application prompts for con rmation
again when subsequently applying a policy or the next time this removable drive is connected.
If the user initiates safe removal of a removable drive during data encryption, Kaspersky Endpoint Security
interrupts the data encryption process and allows removal of the removable drive before the encryption process
has nished. Data encryption will be continued the next time the removable drive is connected to this computer.
If encryption of a removable drive failed, view the Data encryption report in the Kaspersky Endpoint Security
interface. Access to les may be blocked by another application. In this case, try unplugging the removable
drive from the computer and connecting it again.
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Removable drive encryption request

Adding an encryption rule for removable drives
To add an encryption rule for removable drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Encryption of removable drives.
6. Click the Add button, and in the drop-down list select one of the following items:
If you want to add encryption rules for removable drives that are in the list of trusted devices of the Device
Control component, select From list of trusted devices of this policy.
If you want to add encryption rules for removable drives that are in the Kaspersky Security Center list,
select From Kaspersky Security Center list of devices.
7. In the Encryption mode for selected devices drop-down list, select the action to be performed by Kaspersky
Endpoint Security on les stored on the selected removable drives.
8. Select the Portable mode check box if you want Kaspersky Endpoint Security to prepare removable drives
before encryption, making it possible to use encrypted les stored on them in portable mode.
Portable mode lets you use encrypted les stored on removable drives that are connected to computers
without encryption functionality.
9. Select the Encrypt used disk space only check box if you want Kaspersky Endpoint Security to encrypt only
those disk sectors that are occupied by les.
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If you are applying encryption on a drive that is already in use, it is recommended to encrypt the entire drive.
This ensures that all data is protected - even deleted data that might still contain retrievable information. The
Encrypt used disk space only function is recommended for new drives that have not been previously used.
If a device was previously encrypted using the Encrypt used disk space only function, after applying a
policy in Encrypt entire removable drive mode, sectors that are not occupied by les will still not be
encrypted.
10. In the Actions for devices that were selected earlier drop-down list, select the action to be performed by
Kaspersky Endpoint Security according to encryption rules that had been previously de ned for removable
drives:
If you want the previously created encryption rule for the removable drive to remain unchanged, select Skip.
If you want the previously created encryption rule for the removable drive to be replaced by the new rule,
select Update.
11. Save your changes.
The added encryption rules for removable drives will be applied to removable drives connected to any
computers in the organization.

Exporting and importing a list of encryption rules for removable drives
You can export the list of removable drive encryption rules to an XML le. Then you can modify the le to, for
example, add a large number of rules for the same type of removable drives. You can also use the export/import
function to back up the list of rules or to migrate the rules to a di erent server.
How to export and import a list of removable drive encryption rules in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Encryption of removable drives.
6. To export the list of encryption rules for removable drives:
a. Select the rules that you want to export. To select multiple ports, use the CTRL or SHIFT keys.
If you did not select any rule, Kaspersky Endpoint Security will export all rules.
b. Click the Export link.
c. In the window that opens, specify the name of the XML le to which you want to export the list of rules,
and select the folder in which you want to save this le.
d. Click the Save button.
Kaspersky Endpoint Security exports the list of rules to the XML le.
7. To import a list of encryption rules for removable drives:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.
How to export and import a list of removable drive encryption rules in the Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to export or
import a list of removable drive encryption rules.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Encryption of Removable Drives.
5. In the Encryption rules for selected devices block, click the Encryption rules link.
This opens a list of encryption rules for removable drives.
6. To export the list of encryption rules for removable drives:
a. Select the rules that you want to export.
b. Click the Export button.
c. Con rm that you want to export only the selected rules, or export the entire list.
d. Click the Export button.
Kaspersky Endpoint Security exports the list of rules to an XML le in the default downloads folder.
7. To import the list of rules:
a. Click the Import link.
In the window that opens, select the XML le from which you want to import the list of rules.
b. Click the Open button.
If the computer already has a list of rules, Kaspersky Endpoint Security will prompt you to delete the
existing list or add new entries to it from the XML le.
8. Save your changes.

Portable mode for accessing encrypted les on removable drives
Portable mode is a mode of le encryption (FLE) on removable drives that provides the ability to access data
outside of a corporate network. Portable mode also lets you work with encrypted data on computers that do not
have Kaspersky Endpoint Security installed.
Portable mode is convenient to use in the following cases:
There is no connection between the computer and the Kaspersky Security Center Administration Server.
The infrastructure has changed with the change of the Kaspersky Security Center Administration Server.
Kaspersky Endpoint Security is not installed on the computer.
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Portable File Manager
To work in portable mode, Kaspersky Endpoint Security installs a special encryption module named Portable File
Manager on a removable drive. The Portable File Manager provides an interface for working with encrypted data if
Kaspersky Endpoint Security is not installed on the computer (see the gure below). If Kaspersky Endpoint
Security is installed on your computer, you can work with encrypted removable drives using your usual le manager
(for example, Explorer).
The Portable File Manager stores a key to encrypt les on a removable drive. The key is encrypted with the user
password. The user sets a password before encrypting les on a removable drive.
The Portable File Manager starts automatically when a removable drive is connected to a computer on which
Kaspersky Endpoint Security is not installed. If automatic startup of applications is disabled on the computer,
manually start the Portable File Manager. To do so, run the le named pmv.exe that is stored on the removable
drive.

Portable File Manager

Support for portable mode for working with encrypted les
How to enable portable mode support for working with encrypted les on removable drives in the Administration
Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Encryption of removable drives.
6. In the Encryption mode for selected devices drop-down list, select Encrypt all les or Encrypt new les
only.
Portable mode is available only with File Level Encryption (FLE). It is not possible to enable portable
mode support for Full Disk Encryption (FDE).
7. Select the Portable mode check box.
8. If necessary, add encryption rules for individual removable drives.
9. Save your changes.
10. After applying the policy, connect the removable drive to the computer.
11. Con rm the removable drive encryption operation.
This opens a window in which you can create a password for Portable File Manager.
12. Specify a password that meets the strength requirements and con rm it.
13. Save your changes.
Kaspersky Endpoint Security will encrypt les on the removable drive. The Portable File Manager used for
working with encrypted les will also be added to the removable drive. If there are already encrypted les on
the removable drive, Kaspersky Endpoint Security will encrypt them again using its own key. This allows the
user to access all les on the removable drive in portable mode.
How to enable portable mode support for working with encrypted les on removable drives in the Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy for computers on which you want to enable
support for portable mode.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Data Encryption → Encryption of Removable Drives.
5. Under Manage encryption, select Encrypt all les or Encrypt new les only.
Portable mode is available only with File Level Encryption (FLE). It is not possible to enable portable
mode support for Full Disk Encryption (FDE).
6. Select the Portable mode check box.
7. If necessary, add encryption rules for individual removable drives.
8. Save your changes.
9. After applying the policy, connect the removable drive to the computer.
10. Con rm the removable drive encryption operation.
This opens a window in which you can create a password for Portable File Manager.
11. Specify a password that meets the strength requirements and con rm it.
12. Save your changes.
Kaspersky Endpoint Security will encrypt les on the removable drive. The Portable File Manager used for
working with encrypted les will also be added to the removable drive. If there are already encrypted les on
the removable drive, Kaspersky Endpoint Security will encrypt them again using its own key. This allows the
user to access all les on the removable drive in portable mode.

Accessing encrypted les on a removable drive
After encrypting les on a removable drive with portable mode support, the following le access methods are
available:
If Kaspersky Endpoint Security is not installed on the computer, the Portable File Manager will prompt you to
enter a password. You will need to enter the password each time you restart the computer or reconnect the
removable drive.
If the computer is located outside the corporate network and Kaspersky Endpoint Security is installed on the
computer, the application will prompt you to enter the password or send the administrator a request to access
the les. After gaining access to les on a removable drive, Kaspersky Endpoint Security will save the secret key
in the computer's key storage. This will allow access to les in the future without entering a password or asking
the administrator.
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If the computer is located inside the corporate network and Kaspersky Endpoint Security is installed on the
computer, you will get access to the device without entering a password. Kaspersky Endpoint Security will
receive the secret key from the Kaspersky Security Center Administration Server to which the computer is
connected.

Recovering the password for working in portable mode
If you have forgotten the password for working in portable mode, you need to connect the removable drive to a
computer with Kaspersky Endpoint Security installed inside the corporate network. You will get access to the les
because the secret key is stored in the computer's key storage or on the Administration Server. Decrypt and reencrypt les with a new password.

Features of portable mode when connecting a removable drive to a computer from another
network
If the computer is located outside the corporate network and Kaspersky Endpoint Security is installed on the
computer, you can access the les in the following ways:
Password-based access
After entering the password, you will be able to view, modify, and save les on the removable drive (transparent
access). Kaspersky Endpoint Security can set a read-only access right for a removable drive if the following
parameters are con gured in the policy settings for encryption of removable drives:
Portable mode support is disabled.
The Encrypt all les or Encrypt new les only mode is selected.
In all other cases, you will get full access to the removable drive (read/write permission). You will be able to add
and delete les.
You can change the removable drive access permissions even while the removable drive is connected to the
computer. If the removable drive access permissions are changed, Kaspersky Endpoint Security will block
access to the les and prompt you for the password again.
After entering the password, you cannot apply encryption policy settings for the removable drive. In this case, it
is impossible to decrypt or re-encrypt les on the removable drive.
Ask the administrator for access to les
If you have forgotten the password for working in portable mode, ask the administrator for access to les. To
access the les, the user needs to send the administrator a request access le (a le with the KESDC
extension). The user can send the request access le by email, for example. The administrator will send an
encrypted data access le (a le with the KESDR extension).
After you complete the Request-Response password recovery procedure, you will receive transparent access
to les on the removable drive, and full access to the removable drive (read/write permission).
You can apply a removable drive encryption policy, and decrypt les, for example. After recovering the password
or when the policy is updated, Kaspersky Endpoint Security will prompt you to con rm the changes.
How to obtain an encrypted data access le in the Administration Console (MMC)
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1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the computer of the user requesting access to encrypted data and rightclick to open the context menu.
5. In the context menu, select Grant access in o line mode.
6. In the window that opens, select the Data Encryption tab.
7. On the Data Encryption tab, click the Browse button.
8. In the window for selecting a request access le, specify the path to the le received from the user.
You will see information about the user's request. Kaspersky Security Center generates a key le. Email
the generated encrypted data access key le to the user. Or save the access le and use any available
method to transfer the le.
How to obtain an encrypted data access le in the Web Console

1. In the main window of Web Console, select Devices → Managed devices.
2. Select the check box next to the name of the computer whose data you want to restore access to.
3. Click the Grant access to the device in o line mode button.
4. Select the Data Encryption section.
5. Click the Select le button and select the request access le that you received from the user (a le
with the KESDC extension).
The Web Console will display information about the request. This will include the name of the computer
on which the user is requesting access to the le.
6. Click the Save key button and select a folder to save the encrypted data access key le (a le with the
KESDR extension).
As a result, you will be able to obtain the encrypted data access key, which you will need to transfer to
the user.

Decryption of removable drives
You can use a policy to decrypt a removable drive. A policy with de ned settings for removable drive encryption is
generated for a speci c administration group. Therefore, the result of data decryption on removable drives
depends on the computer to which the removable drive is connected.
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To decrypt removable drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Data Encryption → Encryption of removable drives.
6. If you want to decrypt all encrypted les that are stored on removable drives, in the Encryption mode dropdown list select Decrypt entire removable drive.
7. To decrypt data that is stored on individual removable drives, edit the encryption rules for removable drives
whose data you want to decrypt. To do so:
a. In the list of removable drives for which encryption rules have been con gured, select an entry
corresponding to the removable drive you need.
b. Click the Set a rule button to edit the encryption rule for the selected removable drive.
c. In the context menu of the Set a rule button, click Decrypt entire removable drive.
8. Save your changes.
As a result, if a user connects a removable drive or if it is already connected, Kaspersky Endpoint Security
decrypts the removable drive. The application warns the user that the decryption process may take some time.
If the user initiates safe removal of a removable drive during data decryption, Kaspersky Endpoint Security
interrupts the data decryption process and allows removal of the removable drive before the decryption
operation has nished. Data decryption will be continued the next time the removable drive is connected to the
computer.

If decryption of a removable drive failed, view the Data encryption report in the Kaspersky Endpoint Security
interface. Access to les may be blocked by another application. In this case, try unplugging the removable
drive from the computer and connecting it again.

Viewing data encryption details
While encryption or decryption in progress, Kaspersky Endpoint Security relays information about the status of
encryption parameters applied to client computers to Kaspersky Security Center.
The following encryption status values are possible:

Encryption policy not de ned. A Kaspersky Security Center encryption policy has not been de ned for the
computer.
Applying policy. Data encryption and / or decryption is in progress on the computer.
Error. An error occurred during data encryption and / or decryption on the computer.
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Reboot required. The operating system has to be rebooted in order to start or nish data encryption or
decryption on the computer.
Compliant with policy. Data encryption on the computer has been completed using the encryption settings
speci ed in the Kaspersky Security Center policy applied to the computer.
Cancelled by user. The user has declined to con rm the le encryption operation on the removable drive.

Viewing the encryption status
To view the encryption status of computer data:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of the
administration group to which the relevant client computers belong.
3. In the workspace, select the Devices tab.
The Devices tab in the workspace shows the properties of computers in the selected administration group.
4. On the Devices tab in the workspace, slide the scroll bar all the way to the right.
5. If the Encryption status column is not displayed:
a. Right-click to open the context menu for the table header.
b. In the context menu, in the View drop-down list, select Add/Remove columns.
c. In the window that opens, check the Encryption status box.
6. Click OK.
The Encryption status column shows the encryption status of data on computers in the selected administration
group. This status is formed based on information about le encryption on local drives of the computer, and
about full disk encryption.

Viewing encryption statistics on Kaspersky Security Center dashboards
To view the encryption status on Kaspersky Security Center dashboards:
1. Open the Kaspersky Security Center Administration Console.
2. In the console tree, select the Administration Server – <Computer name> node.
3. In the workspace to the right of the Administration Console tree, select the Statistics tab.
4. Create a new page with details panes containing data encryption statistics. To do so:
a. On the Statistics tab, click the Customize view button.
The Properties: Statistics window opens.
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b. In the Properties: Statistics window, click Add.
The Properties: New page window opens.
c. In the General section of the Properties: New page window, type the page name.
d. In the Information panels section, click the Add button.
The New information panel window opens.
e. In the New information panel window in the Protection status group, select the Encryption of devices
item.
f. Click OK.
The Properties: Encryption Control window opens.
g. If necessary, edit the details pane settings. To do so, use the View and Devices sections of the Properties:
Encryption of devices window.
h. Click OK.
i. Repeat steps d – h of the instructions, selecting the Encryption of removable drives item in the Protection
status section of the New information panel window.
The details panes added appear in the Information panels list in the Properties: New page window.
j. In the Properties: New page window, click OK.
The name of the page with details panes created at the previous steps appears in the Pages list of the
Properties: Statistics window.
k. In the Properties: Statistics window, click Close.
5. On the Statistics tab, open the page that was created during the previous steps of the instructions.
The details panes appear, showing the encryption status of computers and removable drives.

Viewing le encryption errors on local computer drives
To view the le encryption errors on local computer drives:
1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder of the Administration Console tree, open the folder with the name of the
administration group that includes the client computer whose list of le encryption errors you want to view.
3. In the workspace, select the Devices tab.
4. On the Devices tab, select the name of the computer in the list and right-click it to open the context menu.
5. In the context menu of the computer, select the Properties item. In the Properties: <computer name> window,
select the Protection section.
6. In the Protection section of the Properties: <computer name> window, click the View data encryption errors
link to open the Data encryption errors window.
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This window shows the details of le encryption errors on local computer drives. When an error is corrected,
Kaspersky Security Center removes the error details from the Data encryption errors window.

Viewing the data encryption report
To view the data encryption report:
1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Server node of the Administration Console tree, select the Reports tab.
3. Click the New report template button.
The New Report Template Wizard starts.
4. Follow the instructions of the Report Template Wizard. In the Selecting the report template type window in
the Other section, select one of the following items:
Report on encryption status of managed devices.
Report on encryption status of mass storage devices.
Report on le encryption errors.
Report on blockage of access to encrypted les.
After you have nished with the New Report Template Wizard, the new report template appears in the table on
the Reports tab.
5. Select the report template that was created at the previous steps of the instructions.
6. In the context menu of the template, select Show report.
The report generation process starts. The report is displayed in a new window.

Working with encrypted devices when there is no access to them
Obtaining access to encrypted devices
A user may be required to request access to encrypted devices in the following cases:
The hard drive was encrypted on a di erent computer.
The encryption key for a device is not on the computer (for example, upon the rst attempt to access the
encrypted removable drive on the computer), and the computer is not connected to Kaspersky Security
Center.
After the user has applied the access key to the encrypted device, Kaspersky Endpoint Security saves the
encryption key on the user's computer and allows access to this device upon subsequent access attempts
even if there is no connection to Kaspersky Security Center.
Access to encrypted devices can be obtained as follows:
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1. The user uses the Kaspersky Endpoint Security application interface to create a request access le with the
kesdc extension and sends it to the corporate LAN administrator.
2. The administrator uses the Kaspersky Security Center Administration Console to create an access key le with
the kesdr extension and sends it to the user.
3. The user applies the access key.

Restoring data on encrypted devices
A user can use the Encrypted Device Restore Utility (hereinafter referred to as the Restore Utility) to work with
encrypted devices. This may be required in the following cases:
The procedure for using an access key to obtain access was unsuccessful.
Encryption components have not been installed on the computer with the encrypted device.
The data needed to restore access to encrypted devices using the Restore Utility resides in the memory of
the user's computer in unencrypted form for some time. To reduce the risk of unauthorized access to such
data, you are advised to restore access to encrypted devices on trusted computers.
Data on encrypted devices can be restored as follows:
1. The user uses the Restore Utility to create a request access le with the fdertc extension and sends it to the
corporate LAN administrator.
2. The administrator uses the Kaspersky Security Center Administration Console to create an access key le with
the fdertr extension and sends it to the user.
3. The user applies the access key.
To restore data on encrypted system hard drives, the user can also specify the Authentication Agent account
credentials in the Restore Utility. If the metadata of the Authentication Agent account has been corrupted,
the user must complete the restoration procedure using a request access le.
Before restoring data on encrypted devices, it is recommended to cancel the Kaspersky Security Center policy or
disable encryption in the Kaspersky Security Center policy settings on the computer where the procedure will be
performed. This prevents the device from being encrypted again.

Recovering data by using the FDERT Restore Utility
If the hard drive fails, the le system may be corrupt. If this is the case, data protected by Kaspersky Disk
Encryption technology will be unavailable. You can decrypt the data and copy the data to a new drive.
Data recovery on a drive protected by Kaspersky Disk Encryption technology consists of the following steps:
1. Create a stand-alone Restore Utility (see the gure below).
2. Connect a drive to a computer that does not have Kaspersky Endpoint Security encryption components
installed.
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3. Run the Restore Utility and diagnose the hard drive.
4. Access data on the drive. To do so, enter the credentials of the Authentication Agent or start the recovery
procedure (Request-Response).

FDERT Restore Utility

Creating a standalone restore utility
To create the executable le of Restore Utility:
1. In the main application window, click the Support button.
2. In the window that opens, click the Restore encrypted device button.
Encrypted device Restore Utility starts.
3. Click the Create Stand-alone Restore Utility button in the window of Restore Utility.
4. Save the stand-alone Restore Utility to computer memory.
As a result, the executable le of the Restore Utility (fdert.exe) will be saved in the speci ed folder. Copy the
Restore Utility to a computer that does not have Kaspersky Endpoint Security encryption components. This
prevents the drive from being encrypted again.

The data needed to restore access to encrypted devices using the Restore Utility resides in the memory of
the user's computer in unencrypted form for some time. To reduce the risk of unauthorized access to such
data, you are advised to restore access to encrypted devices on trusted computers.

Recovering data on a hard drive
To restore access to an encrypted device using the Restore Utility:
1. Run the le named fdert.exe, which is the executable le of the Restore Utility. This le is created by Kaspersky
Endpoint Security.
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2. In the Restore Utility window, select the encrypted device to which you want to restore access.
3. Click the Scan button to allow the utility to de ne which of the actions should be taken on the device: whether
it should be unlocked or decrypted.
If the computer has access to Kaspersky Endpoint Security encryption functionality, the Restore Utility
prompts you to unlock the device. While unlocking the device does not decrypt it, the device becomes directly
accessible as a result of being unlocked. If the computer does not have access to Kaspersky Endpoint Security
encryption functionality, the Restore Utility prompts you to decrypt the device.
4. If you want to import diagnostic information, click the Save diagnostics button.
The utility will save an archive with les containing diagnostic information.
5. Click the Fix MBR button if diagnostics of the encrypted system hard drive has returned a message about
problems involving the master boot record (MBR) of the device.
Fixing the master boot record of the device can speed up the process of obtaining information that is needed
for unlocking or decrypting the device.
6. Click the Unlock or Decrypt button depending on the results of diagnostics.
7. If you want to restore data using an Authentication Agent account, select the Use Authentication Agent
account settings option and enter the credentials of the Authentication Agent.
This method is possible only when restoring data on a system hard drive. If the system hard drive was corrupted
and Authentication Agent account data has been lost, you must obtain an access key from the corporate LAN
administrator to restore data on an encrypted device.
8. If you want to start the recovery procedure, do the following:
a. Select the Specify device access key manually option.
b. Click the Receive access key button and save the request access le to computer memory (a le with the
FDERTC extension).
c. Send the request access le to the corporate LAN administrator.
Do not close the Receive device access key window until you have received the access key. When this
window is opened again, you will not be able to apply the access key that was previously created by the
administrator.
d. Receive and save the access le (a le with the FDERTR extension) created and sent to you by the
corporate LAN administrator (see the instructions below).
e. Download the access le in the Receive device access key window.
9. If you are decrypting a device, you must con gure additional decryption settings:
Specify area to decrypt:
If you want to decrypt the entire device, select the Decrypt entire device option.
If you want to decrypt a portion of the data on a device, select the Decrypt individual device areas
option and specify the decryption area boundaries.
Select the location for writing the decrypted data:
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If you want the data on the original device to be rewritten with the decrypted data, clear the Decrypt to
a disk image le check box.
If you want to save decrypted data separately from the original encrypted data, select the Decrypt to a
disk image le check box and use the Browse button to specify the path where to save the VHD le.
10. Click OK.
The device unlocking / decryption process starts.
How to create an encrypted data access le in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Administration Console tree, select the Additional → Data encryption and protection →
Encrypted drives folder.
3. In the workspace, select the encrypted device for which you want to create an access key le, then in the
context menu of the device, click Get access to the device in Kaspersky Endpoint Security for
Windows.
If you are not sure for which computer the access request le was generated, in the Administration
Console tree select the Additional → Data encryption and protection folder and in the workspace,
click Get device encryption key in Kaspersky Endpoint Security for Windows.
4. In the window that opens, select the encryption algorithm to use: AES256 or AES56.
The data encryption algorithm depends on the AES encryption library that is included in the distribution
package: Strong encryption (AES256) or Lite encryption (AES56). The AES encryption library is installed
together with the application.
5. Click Browse to open a window; in this window, specify the path to the request le with the fdertc
extension that was received from the user.
6. Click the Open button.
You will see information about the user's request. Kaspersky Security Center generates a key le. Email the
generated encrypted data access key le to the user. Or save the access le and use any available method
to transfer the le.
How to create an encrypted data access le in the Web Console
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1. In the main window of the Web Console, select Operations → Data encryption and protection →
Encrypted Drives.
2. Select the check box next to the name of the computer on which you want to recover data.
3. Click the Grant access to the device in o line mode button.
This starts the Wizard for granting access to a device.
4. Follow the instructions of the Wizard for granting access to a device:
a. Select the Kaspersky Endpoint Security for Windows plug-in.
b. Select the encryption algorithm to use: AES256 or AES56.
The data encryption algorithm depends on the AES encryption library that is included in the distribution
package: Strong encryption (AES256) or Lite encryption (AES56). The AES encryption library is installed
together with the application.
c. Click the Select le button and select the request access le received from the user (a le with the
FDERTC extension).
d. Click the Save key button and select a folder to save the key le for accessing encrypted data (a le
with the FDERTR extension).
As a result, you will be able to obtain the encrypted data access key, which you will need to transfer to the
user.

Creating an operating system rescue disk
The operating system rescue disk can be useful when an encrypted hard drive cannot be accessed for some
reason and the operating system cannot load.
You can load an image of the Windows operating system using the rescue disk and restore access to the
encrypted hard drive using Restore Utility included in the operating system image.

To create an operating system rescue disk:
1. Create an executable le for the Encrypted Device Restore Utility.
2. Create a custom image of the Windows pre-boot environment. While creating the custom image of the
Windows pre-boot environment, add the executable le of Restore Utility to the image.
3. Save the custom image of the Windows pre-installation environment to bootable media such as a CD or
removable drive.
Refer to Microsoft help les for instructions on creating a custom image of the Windows pre-boot environment
(for example, in the Microsoft TechNet resource ).
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Detection and Response

Kaspersky Endpoint Agent
Kaspersky Endpoint Agent supports interaction between the application and other Kaspersky solutions for
detecting advanced threats (e.g. Kaspersky Sandbox). Kaspersky solutions are compatible with speci c versions of
Kaspersky Endpoint Agent.
For complete information about the Kaspersky Endpoint Agent for Windows included in the software solution you
are using, and for complete information about the standalone solution, please refer to the Help Guide of the
relevant product:

Kaspersky Anti Targeted Attack Platform Help
Kaspersky Sandbox Help
Kaspersky Endpoint Detection and Response Optimum Help
Kaspersky Managed Detection and Response Help
Kaspersky Endpoint Agent is included in the Kaspersky Endpoint Security distribution kit. You can install Kaspersky
Endpoint Agent during installation of Kaspersky Endpoint Security. To do so, you must select the Endpoint Agent
component during installation of the application (for example, in the installation package). After installing the
application with Endpoint Agent, Kaspersky Endpoint Security and Kaspersky Endpoint Agent will be added to the
list of installed applications. After uninstalling Kaspersky Endpoint Security, Kaspersky Endpoint Agent will also be
uninstalled automatically.
Kaspersky Endpoint Security 11.7.0 now has a wizard for migration from Kaspersky Endpoint Agent to Kaspersky
Endpoint Security. You can migrate policy and task settings for the following solutions:
Kaspersky Sandbox;
Kaspersky Endpoint Detection and Response (EDR);
Kaspersky Managed Detection and Response (MDR).
It is recommended to begin with migrating Kaspersky Endpoint Agent to Kaspersky Endpoint Security on a
single computer, then do it on a group of computers, and then complete the migration on all computers of the
organization.

To migrate policy and task settings from Kaspersky Endpoint Agent to Kaspersky Endpoint Security:
In the main window of Web Console, select Operations → Migration from Kaspersky Endpoint Agent.
This runs the Policy and Task Migration Wizard. Follow the instructions of the Wizard.

Step 1. Policy migration
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The Migration Wizard creates a new policy which merges the settings of Kaspersky Endpoint Security and
Kaspersky Endpoint Agent policies. In the policy list, select Kaspersky Endpoint Agent policies whose settings you
want to merge with the Kaspersky Endpoint Security policy. Click a Kaspersky Endpoint Agent policy to select the
Kaspersky Endpoint Security with which you want to merge settings. Make sure you selected the correct policies
and go to the next step.

Step 2. Task migration
The Migration Wizard creates new tasks for Kaspersky Endpoint Security. In the task list, select Kaspersky
Endpoint Agent tasks which you want to create for Kaspersky Endpoint Security policy. The Wizard supports tasks
for Kaspersky Endpoint Detection and Response and Kaspersky Sandbox. Go to the next step.

Step 3. Wizard completion
Exit the Wizard. As a result, the wizard:
Creates a new Kaspersky Endpoint Security policy.
The policy merges settings from Kaspersky Endpoint Security and Kaspersky Endpoint Agent. The policy is
called <Kaspersky Endpoint Security policy name> & <Kaspersky Endpoint Agent policy name>. The new policy
has the Inactive status. To continue, change the statuses of Kaspersky Endpoint Agent and Kaspersky Endpoint
Security policies to Inactive and activate the new merged policy.
After migrating from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows, please make
sure that the new policy has the functionality for data transfer to the Administration Server (quarantine le
data and threat development chain data) set up. Data transfer parameter values are not migrated from a
Kaspersky Endpoint Agent policy.
Creates new Kaspersky Endpoint Security tasks.
New tasks are copies of Kaspersky Endpoint Agent tasks for Kaspersky Endpoint Detection and Response and
Kaspersky Sandbox. At the same time, the Wizard leaves Kaspersky Endpoint Agent tasks unchanged.

Migrating the [KES+KEA] con guration to [KES11.7.0]
Kaspersky Endpoint Security 11.7.0 now has built-in agents for the Kaspersky Endpoint Detection and Response
Optimum 2.0 (EDR Optimum) and Kaspersky Sandbox 2.0 solutions. You no longer need a separate Kaspersky
Endpoint Agent application to work with these solutions. When you upgrade Kaspersky Endpoint Security to
version 11.7.0, the EDR Optimum and Kaspersky Sandbox solutions keep working with Kaspersky Endpoint Security.
In addition, the Kaspersky Endpoint Agent is removed from the computer.
Migrating the [KES+KEA] con guration to [KES11.7.0] involves the following steps:
1

Upgrading Kaspersky Security Center
Upgrade all Kaspersky Security Center components to version 13.2, including the Administration Agent on user
computers and Web Console.

2

Upgrading the Kaspersky Endpoint Security web plug-in
In Kaspersky Security Center Web Console, upgrade the Kaspersky Endpoint Security web plug-in to version
11.7.0. To manage EDR Optimum and Kaspersky Sandbox components, you must use Web Console.
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3

Migrating the policy and tasks
Use the Kaspersky Endpoint Agent Policy and Task Migration Wizard to migrate Kaspersky Endpoint Agent
settings to Kaspersky Endpoint Security for Windows.
This creates a new Kaspersky Endpoint Security policy. The new policy has the Inactive status. To apply the
policy, open policy properties, accept the Kaspersky Security Network Statement and set the status to Active.

4

Licensing functionality
If you use a common Kaspersky Endpoint Detection and Response Optimum or Kaspersky Optimum Security
license to activate Kaspersky Endpoint Security for Windows and Kaspersky Endpoint Agent, EDR Optimum
functionality will be activated automatically after upgrading the application to version 11.7.0. You do not need to
do anything else.
If you use a stand-alone Kaspersky Endpoint Detection and Response Optimum Add-on license to activate EDR
Optimum functionality, you must make sure that the EDR Optimum key is added to the Kaspersky Security
Center repository and the automatic license key distribution functionality is enabled. After you upgrade the
application to version 11.7.0, EDR Optimum functionality is activated automatically.
If you use a Kaspersky Endpoint Detection and Response Optimum or Kaspersky Optimum Security license to
activate Kaspersky Endpoint Agent, and a di erent license to activate Kaspersky Endpoint Security for
Windows, you must replace the Kaspersky Endpoint Security for Windows key with the common Kaspersky
Endpoint Detection and Response Optimum or Kaspersky Optimum Security key. You can replace the key using
the Add key task.
You do not need to activate Kaspersky Sandbox functionality. Kaspersky Sandbox functionality will be available
immediately after upgrading and activating Kaspersky Endpoint Security for Windows.

5

Upgrading the Kaspersky Endpoint Security application
To upgrade the application and migrate EDR Optimum and Kaspersky Sandbox functionality, a remote
installation task is recommended.
To upgrade the application using a remote installation task, you must edit the following settings:
Select the Endpoint Detection and Response Optimum or Kaspersky Sandbox components in the settings of
the installation package.
Exclude the Kaspersky Endpoint Agent component in the settings of the installation package.
You can also upgrade the application using the following methods:
Using Kaspersky update service (Seamless Update – SMU).
Locally, by using the Setup Wizard.
In this case, you must check the con guration of Kaspersky Endpoint Agent that is installed on the computer. If
the installed Kaspersky Endpoint Agent includes the Endpoint Detection and Response Expert (KATA EDR)
component, remove the component before you upgrade the application. If you cannot remove the Endpoint
Detection and Response Expert (KATA EDR) component, Kaspersky Endpoint Security will skip the EDR Optimum
and Kaspersky Sandbox components when upgrading the application. You can install components using the
Change application components task after upgrading the application.

6

Computer restart
Restart your computer to nish upgrading the application with the built-in agent. When upgrading the
application, the installer removes Kaspersky Endpoint Agent before the computer is restarted. After the
computer is restarted, the installer adds the built-in agent. This means that Kaspersky Endpoint Security does
not perform the functions of EDR and Kaspersky Sandbox until the computer is restarted.
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7

Checking the health of Kaspersky Endpoint Detection and Response Optimum and Kaspersky Sandbox
If after the upgrade, the computer has the Critical status in the Kaspersky Security Center console:
Make sure that the computer has Administration Agent 13.2 installed.
Check the operating status of the EDR Optimum and Kaspersky Sandbox components by viewing the
Application components status report. If a component has the Not installed status, install the components
using the Change application components task.
Make sure you accept the Kaspersky Security Network Statement in the new policy of Kaspersky Endpoint
Security for Windows.
Make sure EDR Optimum functionality is activated using the Application components status report. If a
component has the Not covered by license status, make sure that the automatic license key distribution
functionality of EDR Optimum is turned on.

Upgrading the application as part of KATA EDR
If you have Kaspersky Endpoint Agent installed for integration with Kaspersky Anti Targeted Attack Platform (the
Endpoint Detection and Response Expert (KATA EDR) component), you can upgrade Kaspersky Endpoint Security
for Windows in any of the following ways:
Using a remote installation task.
To do so, you need to edit the following settings:
Exclude the Endpoint Detection and Response Optimum and Kaspersky Sandbox components in the
settings of the installation package.
Select the Kaspersky Endpoint Agent component in the settings of the installation package. If the computer
already has Kaspersky Endpoint Agent installed, the application is upgraded to version 3.11.
Using the Kaspersky update service (SMU).
To do so, you must con rm the application upgrade. Kaspersky Endpoint Security excludes Endpoint Detection
and Response Optimum and Kaspersky Sandbox from the installation. Upgrading Kaspersky Endpoint Agent is
not supported. You can upgrade Kaspersky Endpoint Agent manually.
Locally, by using the Setup Wizard.
Kaspersky Endpoint Security excludes Endpoint Detection and Response Optimum and Kaspersky Sandbox
from the installation. If the computer already has Kaspersky Endpoint Agent installed, the application is
upgraded to version 3.11.

Managed Detection and Response
Kaspersky Endpoint Security 11.6.0 introduces the built-in agent for the Managed Detection and
Response solution. The Kaspersky Managed Detection and Response (MDR) solution automatically
detects and analyzes security incidents in your infrastructure. To do so, MDR uses telemetry data
received from endpoints and machine learning. MDR sends incident data to Kaspersky experts. The
experts can then process the incident and, for example, add a new entry to Anti-Virus databases.
Alternatively, the experts can issue recommendations on processing the incident and, for example,
suggest isolating computer from the network. For detailed information about how the solution
works, please refer to the Kaspersky Managed Detection and Response Help .
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When interacting with Kaspersky Managed Detection and Response, the application lets you perform the following
functions:
Activate Managed Detection and Response using a BLOB con guration le.
Execute commands from Kaspersky Managed Detection and Response.
Send telemetry data to Kaspersky Managed Detection and Response for threat detection.

Integration with Kaspersky Managed Detection and Response
Integration with Kaspersky Managed Detection and Response consists of the following steps:
1

Con guring Private Kaspersky Security Network
Skip this step if you are using Kaspersky Security Center Cloud Console. Kaspersky Security Center Cloud
Console automatically con gures Local Kaspersky Security Network when installing the MDR plug-in.
Private KSN supports data exchange between computers and Kaspersky Security Network dedicated servers,
but not Global KSN.
Upload the Kaspersky Security Network con guration le in the Administration Server properties. The Kaspersky
Security Network con guration le is located within the ZIP archive of the MDR con guration le. You can obtain
the ZIP archive in the Kaspersky Managed Detection and Response Console. For details on con guring Private
Kaspersky Security Network, see Kaspersky Security Center Help . You can also upload a Kaspersky Security
Network con guration le to the computer from the command line (see the instructions below).
How to con gure Private Kaspersky Security Network from the command line

1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security distribution package is located.
3. Run the following command:
avp.com KSN /private <file name>
where <file name> is the name of the con guration le containing the Private KSN settings
(PKCS7 or PEM le format).
Example:
avp.com KSN /private C:\kpsn_config.pkcs7

As a result, Kaspersky Endpoint Security will use Private KSN to determine the reputation of les, applications,
and websites. The policy settings in the Kaspersky Security Network section will show the following operating
status: KSN network: Private KSN.
You must enable extended KSN mode for Managed Detection and Response to work.

2

Activate Managed Detection and Response
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Load the BLOB con guration le in the Kaspersky Endpoint Security policy (see the instructions below). The
BLOB le contains the client ID and information about the license for Kaspersky Managed Detection and
Response. The BLOB le is located inside the ZIP archive of the MDR con guration le. You can obtain the ZIP
archive in the Kaspersky Managed Detection and Response Console. For detailed information about a BLOB le,
please refer to the Kaspersky Managed Detection and Response Help .
How to activate Managed Detection and Response in the Administration Console (MMC)

1. Open the Kaspersky Security Center Administration Console.
2. In the Managed devices folder in the Administration Console tree, open the folder with the name of
the administration group to which the relevant client computers belong.
3. In the workspace, select the Policies tab.
4. Select the necessary policy and double-click to open the policy properties.
5. In the policy window, select Detection and Response → Managed Detection and Response.
6. Select the Managed Detection and Response check box.
7. In the Settings block, click Import and select the BLOB le received in the Kaspersky Managed
Detection and Response Console. The le has the P7 extension.
8. Save your changes.
How to activate Managed Detection and Response in the Web Console and Cloud Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Detection and Response → Managed Detection and Response.
5. Turn on the Managed Detection and Response toggle.
6. Click Import and select the BLOB le that was obtained in the Kaspersky Managed Detection and
Response Console. The le has the P7 extension.
7. Save your changes.
How to activate Managed Detection and Response from the command line
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1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security distribution package is located.
3. Run the following command:
If the application settings are not password protected:
avp.com MDRLICENSE /ADD <file name>
<file name> is the name of the BLOB con guration le for activating Managed Detection and
Response (P7 le format).
If the application settings are password protected:
avp.com MDRLICENSE /ADD <file name> /login=<user name> /password=<password>

As a result, Kaspersky Endpoint Security will verify the BLOB le. BLOB le veri cation includes checking the
digital signature and the license term. If the BLOB le is successfully veri ed, Kaspersky Endpoint Security will
upload the le and send the le to the computer during the next synchronization with Kaspersky Security
Center. Check the operating status of the component by viewing the Application components status report.
You can also view the operating status of a component in reports in the local interface of Kaspersky Endpoint
Security. The Managed Detection and Response component will be added to the list of Kaspersky Endpoint
Security components.
3

Supporting Managed Detection and Response
You must enable the following components for Managed Detection and Response to work:
Kaspersky Security Network (extended mode).
Behavior Detection.
Enabling these components is non-optional. Otherwise Kaspersky Managed Detection and Response cannot
function because it does not receive required telemetry data.
In addition, Kaspersky Managed Detection and Response uses data received from other application
components. Enabling those components is optional. Components that provide additional data include:
Web Threat Protection.
Mail Threat Protection.
Firewall.
For Kaspersky Managed Detection and Response to work with Administration Server via Kaspersky Security
Center Web Console, you must also establish a new secure connection, a background connection. Kaspersky
Managed Detection and Response prompts you to establish a background connection when you deploy the
solution. Make sure the background connection is established. For details about the integration of Kaspersky
Security Center with other Kaspersky solutions, refer to the Kaspersky Security Center Help .

Migration from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows
Kaspersky Endpoint Security version 11 and later supports the MDR solution. Kaspersky Endpoint Security versions
11 – 11.5.0 only sends telemetry data to Kaspersky Managed Detection and Response to enable threat detection.
Kaspersky Endpoint Security version 11.6.0 has all the functionality of the built-in agent (Kaspersky Endpoint
Agent).
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If you are using Kaspersky Endpoint Security 11 – 11.5.0, you must update databases to the latest version to work
with the MDR solution. You must also install Kaspersky Endpoint Agent.
If you are using Kaspersky Endpoint Security 11.6.0 or later, to work with the MDR solution, you must select the
Managed Detection and Response component when installing the application. In this case, you do not need to
install Kaspersky Endpoint Agent.
To migrate from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows:
1. Con gure integration with Kaspersky Managed Detection and Response in the Kaspersky Endpoint Security
policy.
2. Disable the Managed Detection and Response component in the Kaspersky Endpoint Agent policy.
If the Kaspersky Endpoint Security policy also applies to computers that do not have Kaspersky Endpoint
Security 11 – 11.5.0 installed, you must rst create a separate Kaspersky Endpoint Agent policy for those
computers. In the new policy, con gure integration with Kaspersky Managed Detection and Response.

Endpoint Detection and Response
Kaspersky Endpoint Security 11.7.0 now has a built-in agent for the Kaspersky Endpoint Detection
and Response Optimum solution (hereinafter also "EDR Optimum"). Kaspersky Endpoint Detection
and Response Optimum is a solution for protecting the organization's IT infrastructure from
advanced cyber threats. The functionality of the solution combines automatic detection of threats
with the ability to react to these threats to counteract advanced attacks including new exploits,
ransomware, leless attacks, as well as methods using legitimate system tools. For more information
about the solution, refer to the Kaspersky Endpoint Detection and Response Optimum Help .
Kaspersky Endpoint Detection and Response Optimum reviews and analyses threat development
and provides security personnel or the Administrator with information about the potential attack
that is necessary for a timely response. Kaspersky Endpoint Detection and Response displays alert
details in a separate window. Alert Details is a tool for viewing the entirety of collected information
about a detected threat and managing response actions. Alert details include, for example, the
history of les appearing on the computer. For details about managing alert details, refer to the
Kaspersky Endpoint Detection and Response Optimum Help.
The solution uses the following Threat Intelligence tools:
The Kaspersky Security Network (hereinafter also referred to as "KSN") cloud service infrastructure, which
provides access to real-time le, website, and software reputation information from the Kaspersky knowledge
base. Using data from Kaspersky Security Network ensures faster responses by Kaspersky applications to
threats, improves the performance of some protection components, and reduces the likelihood of false
positives.
Integration with Kaspersky Private Security Network (hereinafter also referred to as "KPSN"), which allows the
user to gain access to KSN reputation database as well as other statistical data without sending data from their
computers to the KSN.
Integration with the Kaspersky Threat Intelligence Portal information system, which contains and displays
information about the reputation of les and URLs.
Kaspersky Threats database.
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Kaspersky Endpoint Detection and Response Optimum requires Kaspersky Security Center version 13.2. In
earlier versions of Kaspersky Security Center, it is impossible to activate the EDR Optimum feature.

The component can be managed only using the Web Console. You cannot manage this component using the
Administration Console (MMC).

Integration with Kaspersky Endpoint Detection and Response Optimum
Integration with Kaspersky Endpoint Detection and Response Optimum involves the following steps:
1

Installing the Kaspersky Endpoint Detection and Response Optimum component
You can select the Endpoint Detection and Response Optimum component during installation or upgrade, as well
as using the Change application components task.
Following the Change application components task execution, the status of the task is displayed incorrectly.
Instead of Completed successfully, the task has the Scheduled status. However, the task can still be
completed successfully. Make sure that the new component is installed in the computer properties of the
Kaspersky Security Center console (Applications → Kaspersky Endpoint Security for Windows →
Components) or in the local application interface.

2

Activating Kaspersky Endpoint Detection and Response Optimum
You can acquire a license to use Kaspersky Endpoint Detection and Response Optimum in the following ways:
The EDR Optimum feature is included in the license for use of Kaspersky Endpoint Security for Windows.
The feature will be available immediately after activation of Kaspersky Endpoint Security for Windows.
License extension for use of EDR Optimum.
The feature will be available after you add a separate key for Kaspersky Endpoint Detection and Response. As
a result, two keys will be installed on the computer: a key for Kaspersky Endpoint Security and a key for
Kaspersky Endpoint Detection and Response Optimum.
Licensing for the individual EDR Optimum feature does not di er from licensing for Kaspersky Endpoint
Security.
Make sure that the EDR Optimum feature is included in the license and is running in the local interface of the
application.

3

Enabling the Endpoint Detection and Response Optimum component
You can enable or disable the component in Kaspersky Endpoint Security for Windows policy settings.
To use the component, the following conditions must be met:
The application is activated and Kaspersky Endpoint Detection and Response Optimum functionality is
covered by the license.
The Endpoint Detection and Response Optimum component is turned on.
Application components that Endpoint Detection and Response Optimum depends on are enabled and
operational. The component depends on the following components:
File Threat Protection.
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Web Threat Protection.
Mail Threat Protection.
Exploit Prevention.
Behavior Detection.
Host Intrusion Prevention.
Remediation Engine.
Adaptive Anomaly Control.
How to enable or disable Endpoint Detection and Response Optimum component in the Web Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Detection and Response → Endpoint Detection and Response Optimum.
5. Turn on the Endpoint Detection and Response Optimum toggle switch.
6. Save your changes.
The Kaspersky Endpoint Detection and Response Optimum component is enabled. Check the operating status
of the component by viewing the Application components status report. You can also view the operating status
of a component in reports in the local interface of Kaspersky Endpoint Security. The Endpoint Detection and
Response Optimum component is added to the list of Kaspersky Endpoint Security components.
4

Enabling data transfer to Administration Server
To enable all the EDR Optimum features, transfer should be enabled for the following types of data:
Quarantine le data.
The data are required to obtain information about les quarantined on a computer through Web Console. For
example, you can download a le from quarantine for analysis in Web Console.
Threat development chain data.
The data are required to obtain information about threats detected on a computer in Web Console. You can
view alert details and take response actions in Web Console.
How to enable data transfer to the Administration Server in Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Reports and Storage.
5. Please check the following boxes under Data transfer to Administration Server:
About quarantine les.
About a threat development chain.
6. Save your changes.

Migration from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows
If you are using Kaspersky Endpoint Security 11.7.0 or newer with the EDR Optimum component (built-in agent)
installed, you do not need to do anything for the Kaspersky Endpoint Detection and Response Optimum solution
to work. The EDR Optimum component is not compatible with Kaspersky Endpoint Agent. If Kaspersky Endpoint
Agent is installed on the computer, when Kaspersky Endpoint Security is updated to version 11.7.0, Kaspersky
Endpoint Detection and Response Optimum continues working with Kaspersky Endpoint Security. In addition,
Kaspersky Endpoint Agent will be removed from the computer. To complete migration from Kaspersky Endpoint
Agent to Kaspersky Endpoint Security for Windows, you need to transfer policy and task settings using the
Migration Wizard.
If you are using Kaspersky Endpoint Security 11.4.0–11.6.0 for interoperability with Kaspersky Endpoint Detection
and Response Optimum, the application includes Kaspersky Endpoint Agent. You can install Kaspersky Endpoint
Agent side-by-side with Kaspersky Endpoint Security.
The EDR Optimum component as part of Kaspersky Endpoint Security supports interaction with the
Kaspersky Endpoint Detection and Response Optimum 2.0 solution. Interaction with Kaspersky Endpoint
Detection and Response Optimum version 1.0 is not supported.

Scan for indicators of compromise (IOC)
An Indicator of Compromise (IOC) is a set of data about an object or activity that indicates unauthorized access
to the computer (compromise of data). For example, many unsuccessful attempts to sign in to the system can
constitute an Indicator of Compromise. The IOC Scan tasks allows nding Indicators of Compromise on the
computer and take threat response measures.
Kaspersky Endpoint Security searches for indicators of compromise using IOC les IOC les are les containing
the sets of indicators that the application tries to match to count a detection. IOC les must conform to the
OpenIOC standard. Kaspersky Endpoint Security creates IOC les automatically and allows to load IOC les
prepared by the user. If you want to add an indicator of compromise manually, please read the requirements for
IOC les.
486

The le that you can download by clicking the link below, contains a table with the full list of IOC terms of the
OpenIOC standard that are supported by the Kaspersky Endpoint Detection and Response solution.
DOWNLOAD THE IOC_TERMS.XLSX FILE

IOC Scan task run modes
Kaspersky Endpoint Security allows running the IOC Scan in the following modes:

Standard IOC scan task is a group or local task that is created and con gured manually in the Web Console.
Tasks are run using IOC les prepared by the user.
Stand-alone IOC scan task is a group task that is automatically created when reacting to a threat detected by
Kaspersky Sandbox. Kaspersky Endpoint Security automatically generates the IOC le. Custom IOC les are
not supported. Tasks are automatically deleted seven days after the last start time or creation time if the task
was never run. For more details about stand-alone IOC scan tasks, refer to the Kaspersky Sandbox Help.

Running the IOC Scan task
Kaspersky Sandbox may create IOC Scan tasks automatically when reacting to threats. In Kaspersky Endpoint
Detection and Response Optimum, you can only create IOC Scan tasks manually.
You can create IOC Scan tasks manually:
In alert details.

Alert Details is a tool for viewing the entirety of collected information about a detected threat and managing
response actions. Alert details include, for example, the history of les appearing on the computer. For details
about managing alert details, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
Using the Task Wizard.
You can con gure the settings only in the Web Console.

To create standalone IOC Scan tasks for threat response, Kaspersky Security Center version 13.2 is required.

To create an IOC Scan task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select IOC Scan.
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c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
The system account (SYSTEM) does not have permission to perform the IOC Scan task on network drives. If
you want to run the task for a network drive, select the account of a user that has access to that drive.
For standalone IOC Scan tasks on network drives, in the task properties you need to manually select the
user account that has access to this drive.
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
The task properties window opens.
8. Select the Application settings tab.
9. Go to the IOC scan settings section.
10. Load the IOC les to search for indicators of compromise.
After loading the IOC les, you can view the list of indicators from IOC les. If necessary, you can temporarily
exclude IOC les from the scope of the task.
Adding or removing IOC les after running the task is not recommended. This can cause the IOC scan
results to display incorrectly for prior runs of the task. To search indicators of compromise by new IOC
les, it is recommended to add new tasks.
11. Con gure actions on IOC detection:
Isolate computer from the network. If this option is selected, Kaspersky Endpoint Security isolates the
computer from the network to prevent the threat from spreading. You can con gure the duration of the
isolation in Endpoint Detection and Response component settings.
Move copy to Quarantine, delete object. If this option is selected, Kaspersky Endpoint Security deletes the
malicious object found on the computer. Before deleting the object, Kaspersky Endpoint Security creates a
backup copy in case the object needs to be restored later. Kaspersky Endpoint Security moves the backup
copy to Quarantine.
Run scan of critical areas. If this option is selected, Kaspersky Endpoint Security runs the Critical Areas
Scan task. By default, Kaspersky Endpoint Security scans the kernel memory, running processes, and disk
boot sectors.
12. Go to the Advanced section.
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13. Select data types (IOC documents) that must be analyzed as part of the task.
Kaspersky Endpoint Security automatically selects data types (IOC documents) for the IOC Scan task in
accordance with the content of loaded IOC les. It is not recommended to deselect data types.
You can additionally con gure scan scopes for the following data types:
Files - FileItem. Set an IOC scan scope on the computer using preset scopes.
By default, Kaspersky Endpoint Security scans for IOCs only in important areas of the computer, such as
the Downloads folder, the desktop, the folder with temporary operating system les, etc. You can also
manually add the scan scope.
Windows event log - EventLogItem. Enter the time period when the events were logged. You can also
select Windows event logs for IOC scanning: the application event log, the system event log, and the
security event log.
For the data type Windows registry - RegistryItem Kaspersky Endpoint Security scans a set of registry keys.
14. Click the Save button.
15. Select the check box next to the task.
16. Click the Run button.
As a result, Kaspersky Endpoint Security runs the search for indicators of compromise on the computer. You can
view the results of the task in task properties in the Results section. You can view the information about
detected indicators of compromise in the task properties: Application settings → IOC Scan Results.

IOC scan results are kept for 30 days. After this period, Kaspersky Endpoint Security automatically deletes
the oldest entries.

Move le to Quarantine
When reacting to threats, Kaspersky Endpoint Detection and Response Optimum can create Move le to
Quarantine tasks. The Quarantine is a special local storage on the computer where les that are infected by
viruses or non-disinfectable les are moved to. Quarantined les are stored in an encrypted state and do not
threaten the security of the device. Kaspersky Endpoint Security uses Quarantine only when working with
Kaspersky Sandbox and Kaspersky Endpoint Detection and Response Optimum solutions. In other cases
Kaspersky Endpoint Security places the relevant le in Backup. For details on managing Quarantine as part of
solutions, see Kaspersky Sandbox and Kaspersky Endpoint Detection and Response Optimum Help Guides.
You can create Move le to Quarantine tasks in the following ways:
In alert details.

Alert Details is a tool for viewing the entirety of collected information about a detected threat and managing
response actions. Alert details include, for example, the history of les appearing on the computer. For details
about managing alert details, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
Using the Task Wizard.
You must enter the le path or hash (SHA256 or MD5), or both the le path and the le hash.
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The le size must not exceed 100 MB.

You can con gure the settings only in the Web Console.

To create a Move le to Quarantine task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Move le to Quarantine.
c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
The task properties window opens.
8. Select the Application settings tab.
9. In the list of les, click Add.
The le adding wizard starts.
10. To add the le, you must enter the hash of the le (SHA256 or MD5), the full path to the le, or both the hash
and the path.
If the le is located on a network drive, enter the le path starting with \\, and not the drive letter. For
example, \\server\shared_folder\file.exe. If the le path contains a network drive letter, you can
get a File not found error.
11. Click the Save button.

490

12. Select the check box next to the task.
13. Click the Run button.
As a result, Kaspersky Endpoint Security moves the le to Quarantine. If the le is locked by a di erent process,
the task is displayed as Completed, but the le itself is quarantined only after the computer is restarted. After
restarting the computer, con rm that the le is deleted.
The Move le to Quarantine task can nish with the Access denied error if you are trying to quarantine an
executable le that is currently running. Create a terminate process task for the le and try again.
The Move le to Quarantine task can fail with the Not enough space in Quarantine storage error if you are trying to
quarantine a le that is too large. Empty the Quarantine or make Quarantine larger. Then try again.
You can restore a le from Quarantine or empty the Quarantine using Web Console. You can restore objects locally
on the computer using the command line.

Get le
You can get les from user computers. For example, you can con gure getting an event log le created by a thirdparty application. To get the le, you must create a dedicated task. As a result of the execution of the task, the le
is saved in Quarantine. You can download this le from Quarantine to your computer using Web Console. On the
user's computer, the le remains in its original folder.
The le size must not exceed 100 MB.

You can con gure the settings only in the Web Console.

To create a Get le task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Get le.
c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
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By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
The task properties window opens.
8. Select the Application settings tab.
9. In the list of les, click Add.
The le adding wizard starts.
10. To add the le, you must enter the hash of the le (SHA256 or MD5), the full path to the le, or both the hash
and the path.
If the le is located on a network drive, enter the le path starting with \\, and not the drive letter. For
example, \\server\shared_folder\file.exe. If the le path contains a network drive letter, you can
get a File not found error.
11. Click the Save button.
12. Select the check box next to the task.
13. Click the Run button.
As a result, Kaspersky Endpoint Security creates a copy of the le and moves that copy to Quarantine. You can
download the le from Quarantine in Web Console.

Delete le
You can remotely delete les using the Delete le task. For example, you can remotely delete a le when
responding to threats.
You can con gure the settings only in the Web Console.

To create a Delete le task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
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b. In the Task type drop-down list, select Delete le.
c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
The task properties window opens.
8. Select the Application settings tab.
9. In the list of les, click Add.
The le adding wizard starts.
10. To add the le, you must enter the hash of the le (SHA256 or MD5), the full path to the le, or both the hash
and the path.
If the le is located on a network drive, enter the le path starting with \\, and not the drive letter. For
example, \\server\shared_folder\file.exe. If the le path contains a network drive letter, you can
get a File not found error.
11. Click the Save button.
12. Select the check box next to the task.
13. Click the Run button.
As a result, Kaspersky Endpoint Security deletes the le from the computer. If the le is locked by a di erent
process, the task is displayed as Completed, but the le itself is deleted only after the computer is restarted.
After restarting the computer, con rm that the le is deleted.
The Delete le task can nish with the Access denied error if you are trying to delete an executable le that is
currently running. Create a terminate process task for the le and try again.

Process start
You can remotely run les using the Process start task. For example, you can remotely run an utility that creates
the computer con guration le. Next you can use the Get le task to receive the created le in Kaspersky Security
Center Web Console.
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You can con gure the settings only in the Web Console.

To create a Process start task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Process start.
c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
8. The task properties window opens.
9. Select the Application settings tab.
10. Enter the process start command.
For example, if you want to run an utility (utility.exe) that saves the information about the computer's
con guration to a le named conf.txt, you must enter the following values:
Executable command – utility.exe
Command-line arguments – /R conf.txt
Path to the working folder – C:\Users\admin\Diagnostic\
Alternatively, in the Executable command eld, you can enter C:\Users\admin\Diagnostic\utility.exe
/R conf.txt. In this case you do not need to enter the rest of the settings.
11. Click the Save button.
12. Select the check box next to the task.
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13. Click the Run button.
As a result, Kaspersky Endpoint Security runs the command in silent mode and starts the process. You can view
the results of the task in task properties in the Results section.

Terminate process
You can remotely terminate processes using the Terminate process task. For example, you can remotely terminate
an Internet speed testing utility that was started using the Process start task.
If you want to prohibit running a le, you can con gure the Execution prevention component. You can prohibit the
execution of executable les, scripts, o ice format les.
You can con gure the settings only in the Web Console.

To create a Terminate process task:
1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the Add button.
The Task Wizard starts.
3. Con gure the task settings:
a. In the Application drop-down list, select Kaspersky Endpoint Security for Windows (11.7.0).
b. In the Task type drop-down list, select Process termination.
c. In the Task name eld, enter a brief description.
d. In the Select devices to which the task will be assigned section, select the task scope.
4. Select devices according to the selected task scope option. Click the Next button.
5. Enter the account credentials of the user whose rights you want to use to run the task. Click the Next button.
By default, Kaspersky Endpoint Security starts the task as the system user account (SYSTEM).
6. Finish the wizard by clicking the Finish button.
A new task will be displayed in the list of tasks.
7. Click the new task.
The task properties window opens.
8. Select the Application settings tab.
9. In the list of les, click Add.
The le adding wizard starts.
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10. To add the le, you must enter the hash of the le (SHA256 or MD5), the full path to the le, or both the hash
and the path.
If the le is located on a network drive, enter the le path starting with \\, and not the drive letter. For
example, \\server\shared_folder\file.exe. If the le path contains a network drive letter, you can
get a File not found error.
11. Click the Save button.
12. Select the check box next to the task.
13. Click the Run button.
As a result, Kaspersky Endpoint Security terminates the process on the computer. For example, if a 'GAME'
application is running and you terminate the game.exe process, the application is closed without saving data. You
can view the results of the task in task properties in the Results section.

Execution prevention
Execution prevention allows managing the running of executable les and scripts, as well as opening o ice format
les. In this way, you can, for example, prevent the execution of applications that you consider insecure. Execution
prevention supports a set of o ice le extensions and a set of script interpreters.

Execution prevention rule
Execution prevention manages user access to les with execution prevention rules. An execution prevention rules
is a set of criteria that are considered when blocking. The application identi es les by their paths or checksums
calculated using MD5 and SHA256 hashing algorithms.
You can create Execution prevention rules:
In alert details.

Alert Details is a tool for viewing the entirety of collected information about a detected threat and managing
response actions. Alert details include, for example, the history of les appearing on the computer. For details
about managing alert details, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
Using a group policy or local application settings.
You must enter the le path or hash (SHA256 or MD5), or both the le path and the le hash.
You can also manage Execution prevention locally using the command line.
It is not recommended to create more than 5000 run prevention rules, as this can cause system instability.

Prevention rules do not cover les on CDs or in ISO images. The application does not block execution or
opening of these les.

Execution prevention rule modes
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The Execution prevention component can work in two modes:
Statistics only.
In this mode, Kaspersky Endpoint Security publishes an event about attempts to run executable objects or
open documents that match prevention rule criteria to the Windows event log and Kaspersky Security Center,
but does not block the attempt to run or open the object or document. This mode is selected by default.
Active.
In this mode, the application blocks the execution of objects or opening of documents that match prevention
rule criteria. The application also publishes an event about attempts to execute objects or open documents to
the Windows event log and Kaspersky Security Center event log.

Managing Execution prevention
You can con gure the component settings only in the Web Console.

To prevent execution:
1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Detection and Response → Endpoint Detection and Response.
5. Use the Execution prevention toggle to enable or disable the component.
6. Under Action on execution or opening of forbidden object, select the component operating mode:
Block and write to report. In this mode, the application blocks the execution of objects or opening of
documents that match prevention rule criteria. The application also publishes an event about attempts to
execute objects or open documents to the Windows event log and Kaspersky Security Center event log.
Log events only. In this mode, Kaspersky Endpoint Security publishes an event about attempts to run
executable objects or open documents that match prevention rule criteria to the Windows event log and
Kaspersky Security Center, but does not block the attempt to run or open the object or document. This
mode is selected by default.
7. Create a list of execution prevention rules:
a. Click the Add button.
b. This opens a window; in this window, enter the name of the execution prevention rule (for example,
Application A).
c. In the Type drop-down list, select the object that you want to block: Executable le, Script, Microsoft
O ice document.
If you select a wrong object type, Kaspersky Endpoint Security does not block the le or script.
d. To add the le, you must enter the hash of the le (SHA256 or MD5), the full path to the le, or both the hash
and the path.
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If the le is located on a network drive, enter the le path starting with \\, and not the drive letter. For
example, \\server\shared_folder\file.exe. If the le path contains a network drive letter,
Kaspersky Endpoint Security does not block the le or script.
Execution prevention supports a set of o ice le extensions and a set of script interpreters.
e. Click OK.
8. Save your changes.
As a result, Kaspersky Endpoint Security blocks the execution of objects: running executable les and scripts,
opening o ice format les. You can, however, for example, open a script le in a text editor even if running the
script is prevented. When blocking the execution of an object, Kaspersky Endpoint Security displays a standard
noti cation (see gure below) if noti cations are enabled in application settings.

Execution prevention noti cation

Computer network isolation
Computer network isolation allows automatically isolating a computer from the network in response to the
detection of an indicator of compromise (IOC).
When Network isolation is turned on, the application severs all active connections and blocks all new TCP/IP
network connections on the computer except the following connections:
Connections listed in Network isolation exclusions.
Connections initiated by Kaspersky Endpoint Security services.
Connections initiated by the Kaspersky Security Center Administration agent.

Managing Network isolation
You can con gure the component settings only in the Web Console.
You can con gure Network isolation to be turned on automatically in response to an IOC detection. You can also
manually turn Network isolation on and o .
You can turn on Network isolation:
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In alert details.

Alert Details is a tool for viewing the entirety of collected information about a detected threat and managing
response actions. Alert details include, for example, the history of les appearing on the computer. For details
about managing alert details, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
Using local application settings.
How to con gure Network isolation to be turned on automatically in response to an IOC detection

1. In the main window of Web Console, select Devices → Tasks.
The list of tasks opens.
2. Click the IOC Scan task of Kaspersky Endpoint Security.
The task properties window opens.
If necessary, create the IOC Scan task.
3. Select the Application settings tab.
4. Under Action on IOC detection, select Take response actions after an IOC is found and Isolate
computer from the network check boxes.
5. Save your changes.
As a result, when an IOC is detected, the application isolates the computer from the network to prevent the
threat from spreading.
How to turn on Network isolation of a computer manually

1. In the main window of Web Console, select Devices → Managed devices.
2. Select the computer for which you want to con gure local application settings.
This opens the computer properties.
3. Select the Applications tab.
4. Click Kaspersky Endpoint Security for Windows.
This opens the local application settings.
5. Select the Application settings tab.
6. Select Detection and Response → Endpoint Detection and Response.
7. Under Network isolation, click Isolate computer from the network.
8. Save your changes.
You can con gure Network isolation to be turned o automatically after a speci ed time elapses. By default, the
application turns o Network isolation after 5 hours have passed from the time when it was turned on. You can
also manually turn o Network isolation. After turning o network isolation, the computer can use the Network
without restrictions.
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How to con gure the delay for automatically turning o Network isolation of a computer

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Detection and Response → Endpoint Detection and Response.
5. Under Network isolation, click Con gure computer unlock settings.
6. This opens a window; in this window, select the Automatically unlock isolated computer in N hours check
box and enter the delay for automatically turning o Network isolation.
7. Save your changes.
How to turn o Network isolation of a computer manually

1. In the main window of Web Console, select Devices → Managed devices.
2. Select the computer for which you want to con gure local application settings.
This opens the computer properties.
3. Select the Applications tab.
4. Click Kaspersky Endpoint Security for Windows.
This opens the local application settings.
5. Select the Application settings tab.
6. Select Detection and Response → Endpoint Detection and Response.
7. Under Network isolation, click Unblock computer isolated from the network.
8. Save your changes.
You can also disable Network isolation locally using the command line.

Network isolation exclusions
You can con gure Network isolation exclusions. Network connections that match the rules are not blocked on the
computer when Network isolation is turned on.
To con gure Network isolation exclusions, you can use a list of standard network pro les. By default, exclusions
include network pro les containing rules that ensure uninterrupted operation of devices with the DNS/DHCP
server and DNS/DHCP client roles. You can also modify the settings of standard network pro les or de ne
exclusions manually (see instructions below).
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Exclusions speci ed in policy properties are applied only if Network isolation is turned on automatically in
response to a detected threat. Exclusions speci ed in computer properties are applied only if Network
isolation is turned on manually in computer properties in the Kaspersky Security Center console.

An active policy does not prevent applying exclusions from Network isolation con gured in computer
properties because these parameters have di erent usage scenarios.
How to add a Network isolation exclusion

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select Detection and Response → Endpoint Detection and Response.
5. Under Network isolation exclusions, click Exclusions.
6. This opens a window; in this window, click Add from pro le and select standard network pro les for
con guring exclusions.
Network isolation exclusions from the pro le are added to the list of Network isolation exclusions. You can
view the properties of network connections. If necessary, you can modify network connection settings.
7. If necessary, add a Network isolation exclusion manually. To do so, in the window with the list of exclusions,
click Add and manually edit network connection settings.
8. Save your changes.
You can also view the Network isolation exclusion list locally using the command line.

Kaspersky Sandbox
Kaspersky Endpoint Security 11.7.0 now includes the Kaspersky Sandbox component. The
component enables interoperability with the Kaspersky Sandbox solution. The Kaspersky Sandbox
solution detects and automatically blocks advanced threats on computers. Kaspersky Sandbox
analyzes object behavior to detect malicious activity and activity characteristic of targeted attacks
on the IT infrastructure of the organization. Kaspersky Sandbox analyzes and scans objects on
special servers with deployed virtual images of Microsoft Windows operating systems (Kaspersky
Sandbox servers). For details about the solution, refer to the Kaspersky Sandbox Help.
When interacting with Kaspersky Sandbox, the application lets you:
Add a TLS certi cate for securely connecting to Kaspersky Sandbox servers.
Add Kaspersky Sandbox servers.
Select a threat response action.
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Scan for indicators of compromise (IOC).
Kaspersky Sandbox requires Kaspersky Security Center version 13.2. Earlier versions of Kaspersky Security
Center do not allow the creation of standalone IOC Scan tasks for threat response.

The component can be managed only using the Web Console. You cannot manage this component using the
Administration Console (MMC).

Integration with Kaspersky Sandbox
Integration with Kaspersky Sandbox involves the following steps:
1

Installing the Kaspersky Sandbox component
You can select the Kaspersky Sandbox component during installation or upgrade, as well as using the Change
application components task.
Following the Change application components task execution, the status of the task is displayed incorrectly.
Instead of Completed successfully, the task has the Scheduled status. However, the task can still be
completed successfully. Make sure that the new component is installed in the computer properties of the
Kaspersky Security Center console (Applications → Kaspersky Endpoint Security for Windows →
Components) or in the local application interface.

2

Adding a TLS certi cate
To con gure a trusted connection with Kaspersky Sandbox servers, you must prepare a TLS certi cate. Next
you must add the certi cate to Kaspersky Sandbox servers and the Kaspersky Endpoint Security policy. For
details on preparing the certi cate and adding the certi cate to servers, refer to the Kaspersky Sandbox Help.
How to add a TLS certi cate using Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Detection and Response → Kaspersky Sandbox.
5. Click Server connection settings.
This opens the Kaspersky Sandbox server connection settings window.
6. Under Server TLS certi cate, click Add and select the TLS certi cate le.
Kaspersky Endpoint Security can only have one TLS certi cate for a Kaspersky Sandbox server. If
you have added a TLS certi cate before, that certi cate is revoked. Only the last added certi cate
is used.
7. Con gure advanced connections settings for Kaspersky Sandbox servers:
Request timeout. Connection timeout for Kaspersky Sandbox server. After the con gured
timeout elapses, Kaspersky Endpoint Security sends a request to the next server. You can
increase the connection timeout for Kaspersky Sandbox if your connection speed is low or if the
connection is unstable. The default value is 5 seconds.
Kaspersky Sandbox request queue. Size of the request queue folder. When an object is
accessed on the computer (executable launched or document opened, for example in DOCX or
PDF format), Kaspersky Endpoint Security can also send the object to be scanned by Kaspersky
Sandbox. If there are multiple requests, Kaspersky Endpoint Security creates a request queue. By
default, the size of the request queue folder is limited to 100 MB. After the maximum size is
reached, Kaspersky Sandbox stops adding new requests to the queue and sends the
corresponding event to Kaspersky Security Center. You can con gure the size of the request
queue folder depending on your server con guration.
8. Save your changes.
As a result, Kaspersky Endpoint Security veri es the TLS certi cate. If the certi cate is successfully
veri ed, Kaspersky Endpoint Security uploads the certi cate le to the computer during the next
synchronization with Kaspersky Security Center. If you have added two TLS certi cates, Kaspersky
Sandbox will use the latest certi cate to establish a trusted connection.
You can also add a TLS certi cate to the computer locally using the command line.
3

Enabling the Kaspersky Sandbox component
You can enable or disable the component in Kaspersky Endpoint Security for Windows policy settings.
To use the component, the following conditions must be met:
The application is activated and the functionality is covered by the license.
The Kaspersky Sandbox component is enabled.
How to enable or disable Kaspersky Sandbox using Web Console
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1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Detection and Response → Kaspersky Sandbox.
5. Use the Integration with Kaspersky Sandbox toggle switch to enable or disable the component.
6. Save your changes.
You can also enable or disable Kaspersky Sandbox locally using the command line.
As a result, the Kaspersky Sandbox component is enabled. Check the operating status of the component by
viewing the Application components status report. You can also view the operating status of a component in
reports in the local interface of Kaspersky Endpoint Security. The Kaspersky Sandbox component is added to
the list of Kaspersky Endpoint Security components.
4

Connecting computers to Kaspersky Sandbox servers
To connect computers to Kaspersky Sandbox servers with virtual images of operating systems, you must enter a
server address and a port. For details about deploying virtual images and con guring Kaspersky Sandbox
servers, refer to the Kaspersky Sandbox Help.
How to connect computers to Kaspersky Sandbox servers using Web Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Go to Detection and Response → Kaspersky Sandbox.
5. Under Kaspersky Sandbox servers, click Add.
6. This opens a window; in the window, enter Kaspersky Sandbox server address (IPv4, IPv6, DNS) and
port.
7. Save your changes.

5

Establishing a background connection between Kaspersky Security Center Web Console and
Administration Server
For Kaspersky Sandbox to work with Administration Server via Kaspersky Security Center Web Console, you
must establish a new secure connection, a background connection. For details about the integration of
Kaspersky Security Center with other Kaspersky solutions, refer to the Kaspersky Security Center Help.
Establishing a background connection in Web Console
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1. In the main window of Web Console, select Console settings → Integration.
2. Go to the Cross-service integration section.
3. Turn on the Establish a background connection for cross-service integration toggle switch.
4. Save your changes.
If a background connection between Kaspersky Security Center Web Console and Administration Server is not
established, stand-alone IOC scan tasks cannot be created as part of Threat Response.
6

Enabling data transfer to Administration Server
To use all the features of Kaspersky Sandbox, make sure quarantine le data transfer is enabled. The data are
required to obtain information about les quarantined on a computer through Web Console. For example, you
can download a le from quarantine for analysis in Web Console.
How to enable data transfer to the Administration Server in Web Console

1. In the main window of Web Console, select Devices → Policies & pro les.
2. Click the name of the Kaspersky Endpoint Security policy.
The policy properties window opens.
3. Select the Application settings tab.
4. Select General settings → Reports and Storage.
5. Under Data transfer to Administration Server, check the About quarantine les box.
6. Save your changes.

Migration from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows
If you are using Kaspersky Endpoint Security 11.7.0 or newer with the Kaspersky Sandbox component installed,
interoperability with the Kaspersky Sandbox solution is available immediately after installation. The Kaspersky
Sandbox component is not compatible with Kaspersky Endpoint Agent. If Kaspersky Endpoint Agent is installed on
the computer, when Kaspersky Endpoint Security is updated to version 11.7.0, Kaspersky Sandbox continues
working with Kaspersky Endpoint Security. In addition, Kaspersky Endpoint Agent will be removed from the
computer. To complete migration from Kaspersky Endpoint Agent to Kaspersky Endpoint Security for Windows,
you need to transfer policy and task settings using the Migration Wizard.
If you are using Kaspersky Endpoint Security 11.4.0–11.6.0 for interoperability with Kaspersky Sandbox, the
application includes Kaspersky Endpoint Agent. You can install Kaspersky Endpoint Agent side-by-side with
Kaspersky Endpoint Security.
The Kaspersky Sandbox component that is part of Kaspersky Endpoint Security supports interoperability with
Kaspersky Sandbox solution 2.0. Kaspersky Sandbox solution 1.0 is not supported.
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Managing the application from the command line
You can manage Kaspersky Endpoint Security from the command line. You can view the list of commands for
managing the application by executing the HELP command. To read about the syntax of a speci c command, enter
HELP <command>.
Special characters in the command must be escaped. To escape the characters &, |, (, ), <, >, ^, use the ^
character (for example, to use the & character, enter ^&). To escape the % character, enter %%.

Installing the application
Kaspersky Endpoint Security can be installed from the command line in one of the following modes:
In interactive mode by using the Application Setup Wizard.
In silent mode. After installation is started in silent mode, your involvement in the installation process is not
required. To install the application in silent mode, use the /s and /qn keys.
Prior to installing the application in silent mode, please open and read the End User License Agreement and
the text of the Privacy Policy. The End User License Agreement and the text of the Privacy Policy are
included in the Kaspersky Endpoint Security distribution kit. You may proceed to install the application only
if you have fully read, understand, and accept the provisions and terms of the End User License
Agreement, you understand and agree that your data will be processed and transmitted (including to thirdparty countries) in accordance with the Privacy Policy, and you have fully read and understand the Privacy
Policy. If you do not accept the provisions and terms of the End User License Agreement and the Privacy
Policy, please do not install or use Kaspersky Endpoint Security.

To install the application or upgrade a previous version of the application:
1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security distribution package is located.
3. Run the following command:
setup_kes.exe /pEULA=1 /pPRIVACYPOLICY=1 [/pKSN=1|0] [/pALLOWREBOOT=1]
[/pSKIPPRODUCTCHECK=1] [/pSKIPPRODUCTUNINSTALL=1] [/pKLLOGIN=<user name> /pKLPASSWD=
<password> /pKLPASSWDAREA=<password scope>] [/pENABLETRACES=1|0 /pTRACESLEVEL=<tracing
level>] [/s]
or
msiexec /i <distribution kit name> EULA=1 PRIVACYPOLICY=1 [KSN=1|0]
[ALLOWREBOOT=1] [SKIPPRODUCTCHECK=1] [KLLOGIN=<user name> KLPASSWD=<password>
KLPASSWDAREA=<password scope>] [ENABLETRACES=1|0 TRACESLEVEL=<tracing level>] [/qn]
EULA=1

Acceptance of the terms of the End User License Agreement. The text
of the License Agreement is included in the distribution kit of Kaspersky
Endpoint Security.
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Accepting the terms of the End User License Agreement is
necessary for installing the application or upgrading the application
version.

PRIVACYPOLICY=1

Acceptance of the Privacy Policy. The text of the Privacy Policy is
included in the Kaspersky Endpoint Security distribution kit.
To install the application or upgrade the application version, you must
accept the Privacy Policy.

KSN

Agreement or refusal to participate in Kaspersky Security Network (KSN).
If no value is set for this parameter, Kaspersky Endpoint Security will
prompt to con rm your consent or refusal to participate in KSN when
Kaspersky Endpoint Security is rst started. Available values:
1 – agreement to participate in KSN.
0 – refusal to participate in KSN (default value).
The Kaspersky Endpoint Security distribution package is optimized for
use with Kaspersky Security Network. If you opted not to participate
in Kaspersky Security Network, you should update Kaspersky Endpoint
Security immediately after the installation is complete.

ALLOWREBOOT=1

Automatic restart of the computer, if required after installation or
upgrade of the application. If no value is set for this parameter, automatic
computer restart is blocked.
Restart is not required when installing Kaspersky Endpoint Security.
Restart is required only if you have to remove incompatible applications
prior to installation. Restart may also be required when updating the
application version.

SKIPPRODUCTCHECK=1

Disabling checking for incompatible software. The list of incompatible
software is available in the incompatible.txt le that is included in the
distribution kit. If no value is set for this parameter and incompatible
software is detected, the installation of Kaspersky Endpoint Security will
be terminated.

SKIPPRODUCTUNINSTALL=1

Disable automatic removal of detected incompatible software. If no value
is set for this parameter, Kaspersky Endpoint Security attempts to
remove incompatible software.
Automatic removal of incompatible software cannot be enabled
when installing Kaspersky Endpoint Security using the msiexec
installer. Use setup_kes.exe to enable the automatic removal of
incompatible software.

KLLOGIN

Set the user name for accessing the features and settings of Kaspersky
Endpoint Security (the Password protection component). The user name
is set together with the KLPASSWD and KLPASSWDAREA parameters. The
user name KLAdmin is used by default.

KLPASSWD

Specify a password for accessing Kaspersky Endpoint Security features
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and settings (the password is speci ed together with the KLLOGIN and
KLPASSWDAREA parameters).
If you speci ed a password but did not specify a user name with the
KLLOGIN parameter, the KLAdmin user name is used by default.
KLPASSWDAREA

Specify the scope of the password for accessing Kaspersky Endpoint
Security. When a user attempts to perform an action that is included in
this scope, Kaspersky Endpoint Security prompts for the user's account
credentials (KLLOGIN and KLPASSWD parameters). Use the ";" character
to specify multiple values. Available values:
SET – modifying application settings.
EXIT – exiting the application.
DISPROTECT – disabling protection components and stopping scan
tasks.
DISPOLICY – disabling the Kaspersky Security Center policy.
UNINST – removing the application from the computer.
DISCTRL – disabling control components.
REMOVELIC – removing the key.
REPORTS – viewing reports.

ENABLETRACES

Enabling or disabling application tracing. After Kaspersky Endpoint
Security starts, it saves trace les in the folder
%ProgramData%\Kaspersky Lab\KES\Traces. Available values:
1 – tracing is enabled.
0 – tracing is disabled (default value).

TRACESLEVEL

Level of detail of traces. Available values:
100 (critical). Only messages about fatal errors.
200 (high). Messages about all errors, including fatal errors.
300 (diagnostic). Messages about all errors, as well as warnings.
400 (important). All error messages, warnings, and additional
information.
500 (normal). Messages about all errors and warnings, as well as
detailed information about the operation of the application in normal
mode (default).
600 (low). All messages.

AMPPL

Enables or disables protection of the Kaspersky Endpoint Security
processes using AM-PPL technology (Antimalware Protected Process
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Light). For more details about AM-PPL technology, please visit the
Microsoft website .
AM-PPL technology is available for Windows 10 version 1703 (RS2) or
later, and Windows Server 2019 operating systems.
Available values:
1 – protection of the Kaspersky Endpoint Security processes using
AM-PPL technology is enabled.
0 – protection of the Kaspersky Endpoint Security processes using
AM-PPL technology is disabled.
RESTAPI

Managing the application through the REST API. To manage the
application through the REST API, you must specify the user name
(RESTAPI_User parameter).
Available values:
1 – management via REST API is allowed.
0 – management via REST API is blocked (default value).
To manage the application through the REST API, management using
administrative systems must be allowed. To do so, set the
AdminKitConnector=1 parameter. If you manage the application
through the REST API, it is impossible to manage the application using
the administration systems of Kaspersky.

RESTAPI_User

User name of the Windows domain account used for managing the
application through the REST API. Management of the application
through the REST API is available only to this user. Enter the user name in
the format <DOMAIN>\<UserName> (for example,
RESTAPI_User=COMPANY\Administrator). You can select only one
user to work with the REST API.
Adding a user name is a prerequisite for managing the application through
the REST API.

RESTAPI_Port

Port used for managing the application through the REST API. Port 6782
is used by default.

RESTAPI_Certificate

Certi cate for identifying requests (for example,
RESTAPI_Certificate=C:\cert.pem). Secure interaction of
Kaspersky Endpoint Security with the REST client requires con guring
request identi cation. To do so, you must install a certi cate and
subsequently sign the payload of each request.

ADMINKITCONNECTOR

Application management using administration systems. Administration
systems include, for example, Kaspersky Security Center. In addition to
Kaspersky administration systems, you can use third-party solutions.
Kaspersky Endpoint Security provides an API for this purpose.
Available values:
1 – application management with the help of administration systems
is allowed (default value).
0 – application management is allowed only through the local
interface.

Example:
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setup_kes.exe /pEULA=1 /pPRIVACYPOLICY=1 /pKSN=1
/pALLOWREBOOT=1
msiexec /i kes_win.msi EULA=1 PRIVACYPOLICY=1
KSN=1 KLLOGIN=Admin KLPASSWD=Password
KLPASSWDAREA=EXIT;DISPOLICY;UNINST /qn
setup_kes.exe /pEULA=1 /pPRIVACYPOLICY=1 /pKSN=1
/pENABLETRACES=1 /pTRACESLEVEL=600 /s

After Kaspersky Endpoint Security is installed, the trial license is activated unless you provided an activation
code in the setup.ini le. A trial license usually has a short term. When the trial license expires, all Kaspersky
Endpoint Security features become disabled. To continue using the application, you need to activate the
application with a commercial license by using the Application Activation Wizard or a special command.
When installing the application or upgrading the application version in silent mode, use of the following les is
supported:
setup.ini – general settings for application installation
install.cfg – settings of Kaspersky Endpoint Security operation
setup.reg – registry keys
Registry keys from the setup.reg le are written to the registry only if the setup.reg value is set for the
SetupReg parameter in the setup.ini le. The setup.reg le is generated by Kaspersky experts. It is not
recommended to modify the contents of this le.
To apply settings from the setup.ini, install.cfg, and setup.reg les, place these les into the folder containing
the Kaspersky Endpoint Security distribution package. You can also put the setup.reg le in a di erent folder.
If you do so, you need to specify the path to the le in the following application installation command:
SETUPREG=<path to the setup.reg file>.

Activating the application
To activate the application from the command line,
type the following string in the command line:
avp.com license /add <activation code or key file> [/login=<user name> /password=
<password>]
You need to enter the user account credentials (/login=<user name> /password=<password>) if Password
Protection is enabled.

Remove the application
Kaspersky Endpoint Security can be uninstalled from the command line in one of the following ways:
In interactive mode by using the Application Setup Wizard.
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In silent mode. After uninstallation is started in silent mode, your involvement in the removal process is not
required. To uninstall the application in silent mode, use the /s and /qn switches.

To uninstall the application in silent mode:
1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security distribution package is located.
3. Run the following command:
If the removal process is not password protected:
setup_kes.exe /s /x
or
msiexec.exe /x <GUID> /qn
<GUID> is the unique ID of the application. You can nd out the GUID of the application by using the
following command:
wmic product where "Name like '%Kaspersky Endpoint Security%'" get Name,
IdentifyingNumber.
If the removal process is password protected:
setup_kes.exe /pKLLOGIN=<user name> /pKLPASSWD=<password> /s /x
or
msiexec.exe /x <GUID> KLLOGIN=<user name> KLPASSWD=<password> /qn
Example:
msiexec.exe /x {9A017278-F7F4-4DF9-A482-0B97B70DD7ED} KLLOGIN=KLAdmin
KLPASSWD=!Password1 /qn

AVP commands
To manage Kaspersky Endpoint Security from the command line:
1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security executable le is located.
3. To execute a command, enter:
avp.com <command> [options]
As a result, Kaspersky Endpoint Security will execute the command (see gure below.)
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Managing the application from the command line

SCAN. Virus Scan
Run the virus scan task.
Command syntax
SCAN [<scan scope>] [<action on threat detection>] [<file types>] [<scan exclusions>]
[/R[A]:<report file>] [<scan technologies>] [/C:<file with virus scan settings>]

Scan scope
<files to
scan>

A space-separated list of les and folders. Long paths must be enclosed in quotation
marks. Short paths (MS-DOS format) do not need to be enclosed in quotation marks. For
example:
"C:\Program Files (x86)\Example Folder" – long path.
C:\PROGRA~2\EXAMPL~1 – short path.

/ALL

Run the Full Scan task. Kaspersky Endpoint Security scans the following objects:
Kernel memory
Objects that are loaded at startup of the operating system
Boot sectors
Operating system backup
All hard and removable drives

/MEMORY

Scan the Kernel memory

/STARTUP

Scan the Objects that are loaded at startup of the operating system

/MAIL

Scan Outlook mailbox

/REMDRIVES

Scan removable drives.

/FIXDRIVES

Scan hard drives.

/NETDRIVES

Scan network drives.

/QUARANTINE

Scan the les in the Kaspersky Endpoint Security Backup.

/@:<file

Scan the les and folders from a list. Each le in the list must be on a new row. Long paths
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list.lst>

must be enclosed in quotation marks. Short paths (MS-DOS format) do not need to be
enclosed in quotation marks. For example:
"C:\Program Files (x86)\Example Folder" – long path.
C:\PROGRA~2\EXAMPL~1 – short path.

Action on
threat
detection
/i0

Inform. If this option is selected, Kaspersky Endpoint Security adds the information about
infected les to the list of active threats on detection of these les.

/i1

Disinfect; block if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection is not
possible, Kaspersky Endpoint Security adds the information about the infected les that are
detected to the list of active threats.

/i2

Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection fails,
Kaspersky Endpoint Security deletes the les.
This action is selected by default.

/i3

Disinfect the infected les that are detected. If disinfection fails, delete the infected les. Also
delete compound les (for example, archives) if the infected le cannot be disinfected or
deleted.

/i4

Delete infected les. Also delete compound les (for example, archives) if the infected le
cannot be deleted.

/i8

Prompt the user for action as soon as a threat is detected.

/i9

Prompt the user for action after the scan is completed.

File
types
/fe

Files scanned by extension. If this setting is enabled, Kaspersky Endpoint Security scans infectable
les only . The le format is then determined based on the le's extension.

/fi

Files scanned by format. If this setting is enabled, Kaspersky Endpoint Security scans infectable
les only . Before scanning a le for malicious code, the internal header of the le is analyzed to
determine the format of the le (for example, .txt, .doc, or .exe). The scan also looks for les with
particular le extensions.

/fa

All les. If this setting is enabled, Kaspersky Endpoint Security checks all les without exception (all
formats and extensions).
This is the default setting.

Scan
exclusions
-e:a

RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE archives are excluded from the scan scope.

-e:b

Mail databases, incoming and outgoing e-mails are excluded from the scan scope.

-e:<file
mask>

Files that match the le mask are excluded from the scan scope. For example:
The mask *.exe will include all paths to les that have the exe extension.
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The mask example* will include all paths to les named EXAMPLE.
-e:<seconds>

Files that take longer to scan than the speci ed time limit (in seconds) are excluded from
the scan scope.

-es:
<megabytes>

Files that are larger than the speci ed size limit (in megabytes) are excluded from the
scan scope.

Saving events to a report le mode
/R:<report file>

Save only critical events to the report le.

/RA:<report file>

Save all events to a report le.

Scan technologies
/iChecker=on|off

This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scans by using a special algorithm that takes into
account the release date of Kaspersky Endpoint Security databases, the date when
the le was last scanned, and any modi cations to the scan settings. There are
limitations to iChecker Technology: it does not work with large les and applies only
to les with a structure that the application recognizes (for example, EXE, DLL, LNK,
TTF, INF, SYS, COM, CHM, ZIP, and RAR).

/iSwift=on|off

This technology allows increasing scan speed by excluding certain les from
scanning. Files are excluded from scanning by using a special algorithm that takes
into account the release date of Kaspersky Endpoint Security databases, the date
that the le was last scanned on, and any modi cations to the scanning settings.
The iSwift technology is an advancement of the iChecker technology for the NTFS
le system.

Advanced
settings
/C:<file
with
virus
scan
settings>

File with Virus scan task settings. The le must be created manually and saved in TXT format.
The le can have the following contents: [<scan scope>] [<action on threat
detection>] [<file types>] [<scan exclusions>] [/R[A]:<report file>]
[<scan technologies>].

Example:
avp.com SCAN /R:log.txt /MEMORY /STARTUP /MAIL "C:\Documents and Settings\All
Users\My Documents" "C:\Program Files"

UPDATE. Updating databases and application software modules
Run the Update task.
Command syntax
UPDATE [local] ["<update source>"] [/R[A]:<report file>] [/C:<file with update
settings >]

514

Update
task
settings
local

Start of the Update task that was created automatically after the application was installed. You
can change the settings of the Update task in the local application interface or in the console of
Kaspersky Security Center. If this setting is not con gured, Kaspersky Endpoint Security starts
the Update task with the default settings or with the settings speci ed in the command. You can
con gure Update task settings as follows:
UPDATE starts the Update task with the default settings: the update source is Kaspersky
update servers, the account is System, and other default settings.
UPDATE local starts the Update task that was created automatically after installation
(prede ned task).
UPDATE <update settings> starts the Update task with manually de ned settings (see
below).

Update
source
"<update
source>"

Address of a HTTP or FTP server, or of a shared folder with the update package. You can
specify only one update source. If the update source is not speci ed, Kaspersky Endpoint
Security uses the default source: Kaspersky update servers.

Saving events to a report le mode
/R:<report file>

Save only critical events to the report le.

/RA:<report file>

Save all events to a report le.

Advanced
settings
/C:<file
with update
settings>

File with the Update task settings. The le must be created manually and saved in TXT
format. The le can have the following contents: ["<update source>"] [/R[A]:
<report file>].

Example:
avp.com UPDATE local
avp.com UPDATE "ftp://my_server/kav updates" /RA:avbases_upd.txt

ROLLBACK. Last update rollback
Roll back the last anti-virus database update. This lets you roll back the databases and application modules to their
previous version when necessary, for example, when the new database version contains an invalid signature that
causes Kaspersky Endpoint Security to block a safe application.
Command syntax
ROLLBACK [/R[A]:<report file>]
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Saving events to a report le mode
/R:<report file>

Save only critical events to the report le.

/RA:<report file>

Save all events to a report le.

Example:
avp.com ROLLBACK /RA:rollback.txt

TRACES. Tracing
Enable / disable tracing. Trace les are stored on the computer as long as the application is in use, and are deleted
permanently when the application is removed. Trace les, except trace les of Authentication Agent, are stored in
the folder %ProgramData%\Kaspersky Lab\KES\Traces. By default, tracing is disabled.
Command syntax
TRACES on|off [<tracing level>] [<advanced settings>]

Tracing
level
<tracing
level>

Level of detail of traces. Available values:
100 (critical). Only messages about fatal errors.
200 (high). Messages about all errors, including fatal errors.
300 (diagnostic). Messages about all errors, as well as warnings.
400 (important). All error messages, warnings, and additional information.
500 (normal). Messages about all errors and warnings, as well as detailed information about
the operation of the application in normal mode (default).
600 (low). All messages.

Advanced
settings
all

Run a command with the dbg, file and mem parameters.

dbg

Use the OutputDebugString function and save the trace le. The OutputDebugString function
sends a character string to the application debugger to display on screen. For details, visit the
MSDN website .

file

Save one trace le (no size limit).

rot

Save traces to a limited number of les of limited size and overwrite the older les when the
maximum size is reached.

mem

Save traces to dump les.
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Examples:
avp.com TRACES on 500
avp.com TRACES on 500 dbg
avp.com TRACES off
avp.com TRACES on 500 dbg mem
avp.com TRACES off file

START. Start the pro le
Start the pro le (for example, to update databases or to enable a protection component).
Command syntax
START <profile> [/R[A]:<report file>]

Pro le
<profile>

Pro le name. A Pro le is a Kaspersky Endpoint Security component, task or feature. You can
view the list of available pro les by executing the HELP START command.

Saving events to a report le mode
/R:<report file>

Save only critical events to the report le.

/RA:<report file>

Save all events to a report le.

Example:
avp.com START Scan_Objects

STOP. Stopping a pro le
Stop the running pro le (for example, stop scanning, stop removable drives scan, or disable a protection
component).
To execute this command, Password protection must be enabled. The user must have the Disable protection
components and Disable control components permissions.

Command syntax
STOP <profile> /login=<user name> /password=<password>
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Pro le
<profile>

Pro le name. A Pro le is a Kaspersky Endpoint Security component, task or feature. You can
view the list of available pro les by executing the HELP STOP command.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

STATUS. Pro le status
Show status information for application pro les (for example, running or completed). You can view the list of
available pro les by executing the HELP STATUS command.
Kaspersky Endpoint Security also displays information about the status of service pro les. Information about
the status of service pro les may be required when you are contacting Kaspersky Technical Support.

Command syntax
STATUS [<profile>]

STATISTICS. Pro le operation statistics
View statistical information about an application pro le (for example, scan duration or the number of threats
detected.) You can view the list of available pro les by running the HELP STATISTICS command.
Command syntax
STATISTICS <profile>

RESTORE. Restoring les from Backup
You can restore a le from Backup to its original folder. If a le with the same name already exists at the speci ed
path, the su ix "-copy"is appended to the le name. The le that is being restored is copied keeping its original
name.
To execute this command, Password protection must be enabled. The user must have the Restore from
Backup permission.

Backup stores backup copies of les that were deleted or modi ed during disinfection. A backup copy is a le
copy created before the le was disinfected or deleted. Backup copies of les are stored in a special format and
do not pose a threat.
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Backup copies of les are stored in the folder C:\ProgramData\Kaspersky Lab\KES\QB.
Users in the Administrators group are granted full permission to access this folder. Limited access rights to this
folder are granted to the user whose account was used to install Kaspersky Endpoint Security.
Kaspersky Endpoint Security does not provide the capability to con gure user access permissions to backup
copies of les.

Command syntax
RESTORE [/REPLACE] <file name> /login=<user name> /password=<password>

Advanced settings
/REPLACE

Overwrite an existing le.

<file name>

The name of the le to be restored.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com RESTORE /REPLACE true_file.txt /login=KLAdmin /password=!Password1

EXPORT. Exporting application settings
Export Kaspersky Endpoint Security settings to a le. The le will be located in the C:\Windows\SysWOW64 folder.
Command syntax
EXPORT <profile> <file name>

Pro le
<profile>

Pro le name. A Pro le is a Kaspersky Endpoint Security component, task or feature. You can
view the list of available pro les by executing the HELP EXPORT command.

File to
export
<file
name>

The name of the le to which the application settings will be exported. You can export Kaspersky
Endpoint Security settings to a DAT or CFG con guration le, to a TXT text le, or to an XML
document.

Examples:
avp.com EXPORT ids ids_config.dat
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avp.com EXPORT fm fm_config.txt

IMPORT. Importing application settings
Imports settings for Kaspersky Endpoint Security from a le that was created with the EXPORT command.
To execute this command, Password protection must be enabled. The user must have the Con gure
application settings permission.

Command syntax
IMPORT <file name> /login=<username> /password=<password>

File to
import
<file
name>

The name of the le from which the application settings will be imported. You can import
Kaspersky Endpoint Security settings from a DAT or CFG con guration le, a TXT text le, or an
XML document.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com IMPORT config.dat /login=KLAdmin /password=!Password1

ADDKEY. Applying a key le
Apply the key le to activate Kaspersky Endpoint Security. If the application is already activated, the key will be
added as a reserve one.
Command syntax
ADDKEY <file name> /login=<user name> /password=<password>

Key le
<file name>

Key le name.

Authentication
/login=<user name>
/password=<password>

User account credentials. These credentials need to be entered only if
Password protection is enabled.
520

Example:
avp.com ADDKEY file.key

LICENSE. Licensing
Perform actions with Kaspersky Endpoint Security license keys.
To execute this command and remove a license key, Password protection must be enabled. The user must have
the Remove key permission.

Command syntax
LICENSE <operation> [/login=<user name> /password=<password>]

Operation
/ADD <file name>

Apply the key le to activate Kaspersky Endpoint Security. If the application is
already activated, the key will be added as a reserve one.

/ADD <activation
code>

Activate Kaspersky Endpoint Security using an activation code. If the application
is already activated, the key will be added as a reserve one.

/REFRESH <file
name>

Renew your license with a key le. A reserve key is added as a result. It becomes
active upon license expiration. It is not possible to add an active key by executing
this command.

/REFRESH
<activation code>

Renew your license with an activation code. A reserve key is added as a result. It
becomes active upon license expiration. It is not possible to add an active key by
executing this command.

/DEL /login=<user
name> /password=
<password>

Remove a license key. Reserve key will also be removed.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com LICENSE /ADD file.key
avp.com LICENSE /ADD AAAAA-BBBBB-CCCCC-DDDDD
avp.com LICENSE /DEL /login=KLAdmin /password=!Password1

RENEW. Purchasing a license
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Open the Kaspersky website to purchase or renew your license.

PBATESTRESET. Reset the disk check results before encrypting the disk
Reset the compatibility check results for Full Disk Encryption(FDE), including both the Kaspersky Disk Encryption
and BitLocker Drive Encryption technologies.
Before running Full Disk Encryption, the application performs a number of checks to verify that the computer can
be encrypted. If the computer does not support Full Disk Encryption, Kaspersky Endpoint Security logs
information about the incompatibility. The next time you try to encrypt, the application does not perform this
check and warns you that encryption is not possible. If the hardware con guration of the computer has changed,
the compatibility check results previously logged by the application must be reset to re-check the system hard
drive for compatibility with Kaspersky Disk Encryption or BitLocker drive encryption technologies.

EXIT. Exit the application
Exits Kaspersky Endpoint Security. The application will be unloaded from the computer's RAM.
To execute this command, Password protection must be enabled. The user must have the Exit the application
permission.

Command syntax
EXIT /login=<user name> /password=<password>

EXITPOLICY. Disabling policy
Disables a Kaspersky Security Center policy on the computer. All Kaspersky Endpoint Security settings are
available for con guration, including settings that have a closed lock in the policy ( ).
To execute this command, Password protection must be enabled. The user must have the Disable Kaspersky
Security Center policy permission.

Command syntax
EXITPOLICY /login=<user name> /password=<password>

STARTPOLICY. Enabling policy
Enables a Kaspersky Security Center policy on the computer. The application settings will be con gured according
to the policy.
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DISABLE. Disabling protection
Disables File Threat Protection on a computer with an expired Kaspersky Endpoint Security license. It is not
possible to run this command on a computer that has the application that is not activated or has a valid license.

SPYWARE. Spyware detection
Enable / disable spyware detection. By default, spyware detection is enabled.
Command syntax
SPYWARE on|off

KSN. Global/Private KSN transition
Selecting a Kaspersky Security Network solution for determining the reputation of les or websites. Kaspersky
Endpoint Security supports the following KSN infrastructural solutions:

Global KSN is the solution that is used by most Kaspersky applications. KSN participants receive information
from Kaspersky Security Network and send Kaspersky information about objects detected on the user's
computer to be analyzed additionally by Kaspersky analysts and to be included in the reputation and statistical
databases of Kaspersky Security Network.
Private KSN is a solution that enables users of computers hosting Kaspersky Endpoint Security or other
Kaspersky applications to obtain access to reputation databases of Kaspersky Security Network, and to other
statistical data without sending data to KSN from their own computers. Private KSN is designed for corporate
customers who are unable to participate in Kaspersky Security Network for any of the following reasons:
Local workstations are not connected to the Internet.
Transmission of any data outside the country or outside the corporate LAN is prohibited by law or restricted
by corporate security policies.
Command syntax
KSN /global | /private <file name>

Private KSN
con guration le
<file name>

Name of the con guration le containing the KSN proxy server settings This le has
the PKCS7 or PEM extension.

Example:
avp.com KSN /global
avp.com KSN /private C:\ksn_config.pkcs7
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KESCLI commands
KESCLI commands let you receive information about the state of computer protection using the OPSWAT
component, and let you perform standard tasks such as virus scans and database updates.
You can view the list of KESCLI commands by using the --help command or by using the abbreviated command h.

To manage Kaspersky Endpoint Security from the command line:
1. Run the command line interpreter (cmd.exe) as an administrator.
2. Go to the folder where the Kaspersky Endpoint Security executable le is located.
3. To execute a command, enter:
kescli <command> [options]
As a result, Kaspersky Endpoint Security will execute the command (see gure below.)

Managing the application from the command line

Scan. Virus Scan
Run the virus scan task.
Command syntax
--opswat Scan <scan scope> <action on threat detection>
You can check the completion status of a Full Scan task by using the GetScanState command and view the date
and time when the scan was last completed by using the GetLastScanTime command.
Scan scope
<files to
scan>

;-separated list of les and folders. E.g.: C:\Program Files (x86)\Example
Folder.

Action on
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threat
detection
0

Inform. If this option is selected, Kaspersky Endpoint Security adds the information about
infected les to the list of active threats on detection of these les.

1

Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection fails,
Kaspersky Endpoint Security deletes the les.
This action is selected by default.

Example:
kescli --opswat Scan C:\Documents and Settings\All Users\My Documents;C:\Program
Files 1

GetScanState. Scan completion status
Receive information about the status of Full Scan task completion:
1 – the scan is in progress.
0 – the scan is not running.
Command syntax
--opswat GetScanState

Example:
kescli --opswat GetScanState

GetLastScanTime. Determining the scan completion time
Receive information about the date and time of the last Full Scan task completion.
Command syntax
--opswat GetLastScanTime

Example:
kescli --opswat GetLastScanTime

GetThreats. Obtaining data on detected threats
Receive a list of detected threats (Threats report). This report contains information about threats and virus
activity during the last 30 days prior to creating the report.
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Command syntax
--opswat GetThreats
When this command is executed, Kaspersky Endpoint Security will send a response in the following format:
<name of detected object> <type of object> <detection date and time> <path to file> <action
on threat detection> <threat danger level>

Managing the application from the command line

Object
type
0

Not known (Unknown).

1

Viruses (Virware).

2

Trojan programs (Trojware).

3

Malicious programs (Malware).

4

Advertisement programs (Adware).

5

Auto-dialer programs (Pornware).

6

Applications that could be used by a cybercriminal to harm the user's computer or data
(Riskware).

7

Packed objects whose packing method may be used to protect malicious code (Packed).

20

Unknown objects (Xfiles).

21

Known applications (Software).

22

Concealed les (Hidden).

23

Application requiring attention (Pupware).

24

Anomalous behavior (Anomaly).

30

Not determined (Undetect).

40

Ad banners (Banner).

50

Network attack (Attack).

51

Registry access (Registry).

52

Suspicious activity (Suspicion).

60

Vulnerabilities (Vulnerability).

70

Phishing.

80

Unwanted email attachment (Attachment).

90

Malware detected by Kaspersky Security Network (Urgent).
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100

Unknown link (Suspic URL).

110

Other malware (Behavioral).

Action on threat
detection
0

Not known (unknown).

1

Threat was remediated (ok).

2

Object was infected and has not been disinfected (infected).

5

Object is in an archive and has not been disinfected (archive).

9

Object has been disinfected (disinfected).

10

Object has not been disinfected (not disinfected).

11

Object was deleted (deleted).

13

A backup copy of the object was created (backupped).

15

Object was moved to Backup (quarantined).

23

Object was deleted on computer restart (delete on reboot).

25

Object was disinfected on computer restart (disinfect on reboot).

29

Object was moved to Backup by a user (added by user).

30

Object was added to exclusions (added to exclude).

31

Object was moved to Backup on computer restart (quarantine on
reboot).

36

False positive (false alarm).

38

Process was terminated (terminated).

40

Object was not detected (not found).

41

Cannot resolve the threat (untreatable).

42

Object was restored (rolled back).

43

Object was created as a result of threat activity (produced by threat).

44

Object was restored on computer restart (roll back on reboot).

0xffffffff

Object was not processed (discarded).

Threat danger level
0

Unknown

1

High

2

Medium scan

4

Low

8

Info (less than Low)
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UpdateDe nitions. Updating databases and application software modules
Run the Update task. Kaspersky Endpoint Security uses the default source: Kaspersky update servers.
Command syntax
--opswat UpdateDefinitions
You can view the date and time of the last completed Update task by using the GetDefinitionsetState
command.
Example:
kescli --opswat UpdateDefinitions

GetDe nitionState. Determining the update completion time
Receive information about the date and time of the last Update task completion.
Command syntax
--opswat GetDefinitionState

Example:
kescli --opswat GetDefinitionState

EnableRTP. Enabling protection
Enable Kaspersky Endpoint Security protection components on the computer: File Threat Protection, Web Threat
Protection, Mail Threat Protection, Network Threat Protection, Host Intrusion Prevention.
Command syntax
--opswat EnableRTP
You can check the operating status of File Threat Protection by using the GetRealTimeProtectionState
command.
Example:
kescli --opswat EnableRTP

GetRealTimeProtectionState. File Threat Protection status
Receive information about the operating status of the File Threat Protection component:
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1 – the component is enabled.
0 – the component is disabled.
Command syntax
--opswat GetRealTimeProtectionState

Example:
kescli --opswat GetRealTimeProtectionState

Version. Identifying the application version
Identify the version of Kaspersky Endpoint Security for Windows.
Command syntax
--Version
You can also use the abbreviated command -v.
Example:
kescli -v

Detection and Response management commands
You can use the command line to manage built-in functionality of Detection and Response solutions (for example,
Kaspersky Sandbox or Kaspersky Endpoint Detection and Response Optimum). You can manage Detection and
Response solutions if management using the Kaspersky Security Center console is not possible. You can view the
list of commands for managing the application by executing the HELP command. To read about the syntax of a
speci c command, enter HELP <command>.

SANDBOX. Managing Kaspersky Sandbox
Commands for managing the Kaspersky Sandbox component:
Enable or disable the Kaspersky Sandbox component.
The Kaspersky Sandbox component enables interoperability with the Kaspersky Sandbox solution.
Con gure the Kaspersky Sandbox component:
Connect the computer to Kaspersky Sandbox servers.
The servers use deployed virtual images of Microsoft Windows operating systems to run objects that need
to be scanned. You can enter an IP address (IPv4 or IPv6) or a fully quali ed domain name. For details about
deploying virtual images and con guring Kaspersky Sandbox servers, refer to the Kaspersky Sandbox Help.
529

Con gure connection timeout for Kaspersky Sandbox server.
Timeout for receiving a response to an object scanning request from the Kaspersky Sandbox server. After
the timeout elapses, Kaspersky Sandbox redirects the request to the next server. The timeout value
depends on the speed and stability of the connection. The default value is 5 seconds.
Con gure a trusted connection between the computer and Kaspersky Sandbox servers.
To con gure a trusted connection with Kaspersky Sandbox servers, you must prepare a TLS certi cate.
Next you must add the certi cate to Kaspersky Sandbox servers and the Kaspersky Endpoint Security
policy. For details on preparing the certi cate and adding the certi cate to servers, refer to the Kaspersky
Sandbox Help.
Display the current settings of the component.
Command syntax
stop sandbox [/login=<user name> /password=<password>]
start sandbox
sandbox /set [--tls=yes|no] [--servers=<server address>:<port>] [--timeout=<Kaspersky
Sandbox server connection timeout (ms)>] [--pinned-certificate=<path to the TLS
certificate>][/login=<user name> /password=<password>]
sandbox /show

Operation
stop

Disable the Kaspersky Sandbox component.

start

Enable the Kaspersky Sandbox component.

set

Con gure the Kaspersky Sandbox component. You can modify the following settings:
Use a trusted connection (--tls).
Add a TLS certi cate (--pinned-certificate).
Set the Kaspersky Sandbox server connection timeout (--timeout).
Add Kaspersky Sandbox servers (--servers).

show

Display the current settings of the component. You get the following response:
sandbox.timeout=<Kaspersky Sandbox server connection timeout (ms)>
sandbox.tls=<trusted connection status>
sandbox.servers=<list of Kaspersky Sandbox servers>

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com start sandbox
avp.com sandbox /set --tls=yes --pinned-certificate="С:\Users\Admin\certificate.pem"
avp.com sandbox /set --servers=10.10.111.0:147
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PREVENTION. Managing Execution prevention
Disable Execution Prevention or show the current component settings, including the list of execution prevention
rules.
Command syntax
prevention disable
prevention /show
Upon executing the prevention /show command, you will get the following response:
prevention.enable=true|false
prevention.mode=audit|prevent
prevention.rules
id: <rule ID>
target: script|process|document
md5: <MD5 hash of the file>
sha256: <SHA256 hash of the file>
pattern: <path to the object>
case-sensitive: true|false
Command return values:
-1 means the command is not supported by the version of Kaspersky Endpoint Agent that is installed on the
device.
0 means the command was executed successfully.
1 means a mandatory argument was not passed to the command.
2 means a general error occurred.
4 means there was a syntax error.
9 – wrong operation (for example, an attempt to disable the component when it is already disabled).

ISOLATION. Managing Network isolation
Disable Network isolation of the computer or display current component settings including the list of con gured
network exclusion pro les as well as the list of rules con gured in network pro les.
Command syntax:
isolation /OFF /login=<user name> /password=<password>
isolation /STAT
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As a result of running the show command, you receive the following response: isolation.enable=true|false.
Command return values:
-1 means the command is not supported by the version of Kaspersky Endpoint Agent that is installed on the
device.
0 means the command was executed successfully.
1 means a mandatory argument was not passed to the command.
2 means a general error occurred.
4 means there was a syntax error.
9 – wrong operation (for example, an attempt to disable the component when it is already disabled).

RESTORE. Restoring les from Quarantine
Restore a le from Quarantine to a special folder on the computer. Then you must manually move the le to the
destination folder. The Quarantine is a special local storage on the computer where les that are infected by
viruses or non-disinfectable les are moved to. Quarantined les are stored in an encrypted state and do not
threaten the security of the device. Kaspersky Endpoint Security uses Quarantine only when working with
Kaspersky Sandbox and Kaspersky Endpoint Detection and Response Optimum solutions. In other cases
Kaspersky Endpoint Security places the relevant le in Backup. For details on managing Quarantine as part of
solutions, see Kaspersky Sandbox and Kaspersky Endpoint Detection and Response Optimum Help Guides.
To execute this command, Password protection must be enabled. The user must have the Restore from
Backup permission.
The object is quarantined under the system account (SYSTEM).
Command syntax
RESTORE [/REPLACE] <file name> /login=<user name> /password=<password>

Advanced settings
/REPLACE

Overwrite an existing le.

<file name>

The name of the le to be restored.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com RESTORE /REPLACE true_file.txt /login=KLAdmin /password=!Password1
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Command return values:
-1 means the command is not supported by the version of Kaspersky Endpoint Agent that is installed on the
device.
0 means the command was executed successfully.
1 means a mandatory argument was not passed to the command.
2 means a general error occurred.
4 means there was a syntax error.

IOCSCAN. Scan for indicators of compromise (IOC)
Run the Scan for indicators of compromise (IOC) task. An Indicator of Compromise (IOC) is a set of data about an
object or activity that indicates unauthorized access to the computer (compromise of data). For example, many
unsuccessful attempts to sign in to the system can constitute an Indicator of Compromise. The IOC Scan tasks
allows nding Indicators of Compromise on the computer and take threat response measures.
Command syntax
IOCSCAN <full path to the IOC file>|/path=<path to the IOC files folder>
[/process=on|off] [/hint=<full path to executable file of a process|full file path>]
[/registry=on|off] [/dnsentry=on|off] [/arpentry=on|off] [/ports=on|off]
[/services=on|off] [/system=on|off] [/users=on|off] [/volumes=on|off]
[/eventlog=on|off] [/datetime=<event publication date>] [/channels=<list of channels>]
[/files=on|off] [/drives=<all|system|critical|custom>] [/excludes=<list of
exclusions>][/scope=<list of folders to scan>]

IOC les
<full path to
the IOC file>

Full path to the IOC le that you want to use for scanning. You can specify multiple IOC
les separated by spaces. The full path to the IOC le must be entered without the
/path argument.
For example, C:\Users\Admin\Desktop\IOC\file1.ioc

/path=<path to
the folder
with IOC
files>

Path to the folder with IOC les that you want to use for scanning. IOC les are les
containing the sets of indicators that the application tries to match to count a
detection. IOC les must conform to the OpenIOC standard.
For example, C:\Users\Admin\Desktop\IOC

Data type for IOC scanning
/process=on|off

Analyze process data when performing the IOC scan (ProcessItem
term).
If the value of the argument is off, Kaspersky Endpoint Security
does not analyze processes running on the computer when
performing the scan. If the IOC le contains IOC terms of the
ProcessItem IOC document, they are ignored (detected as no
match).
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If the argument is not speci ed, Kaspersky Endpoint Security
analyzes process data only if the ProcessItem IOC document is
described in the IOC le that is provided for the scan.
/hint=<full path to the
executable file of the
process|full path to the
file>

Analyze le data when performing the IOC scan (ProcessItem and
FileItem terms).
You can select a le in one of the following ways:
<full path to the executable file of the process> –
ProcessItem;
<full path to the file> – FileItem.

/registry=on|off

Analyze Windows registry data when performing an IOC scan
(RegistryItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the Windows registry. If the IOC le contains
RegistryItem IOC document terms, they are ignored (detected as no
match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes the Windows registry only if the RegistryItem IOC document
is described in the IOC le that is provided for the scan.
For the RegistryItem data type, Kaspersky Endpoint Security scans a
set of registry keys.

/dnsentry=on|off

Analyze the data about records in the local DNS cache when
performing the IOC scan (DnsEntryItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the local DNS cache. If the IOC le contains
DnsEntryItem IOC document terms, they are ignored (detected as no
match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes the local DNS cache only if the DnsEntryItem IOC document
is described in the IOC le that is provided for the scan.

/arpentry=on|off

Analyze the data about records in the ARP table when performing
the IOC scan (ArpEntryItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the ARP table. If the IOC le contains ArpEntryItem
IOC document terms, they are ignored (detected as no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes the ARP table only if the ArpEntryItem IOC document is
described in the IOC le that is provided for the scan.

/ports=on|off

Analyze data about ports open for listening when performing the IOC
scan (PortItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the table of active connections on the device. If the
IOC le contains PortItem IOC document terms, they are ignored
(detected as no match).
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If the argument is not speci ed, Kaspersky Endpoint Security
analyzes the table of active connections only if the PortItem IOC
document is described in the IOC le that is provided for the scan.
/services=on|off

Analyze data about services installed on the device when performing
the IOC scan (ServiceItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the data about services installed on the device. If the
IOC le contains ServiceItem IOC document terms, they are ignored
(detected as no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes service data only if the ServiceItem IOC document is
described in the IOC le that is provided for the scan.

/system=on|off

Analyze environment data when performing the IOC scan
(SystemInfoItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not analyze environment data. If the IOC le contains
SystemInfoItem IOC document terms, they are ignored (detected as
no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes environment data only if the SystemInfoItem IOC document
is described in the IOC le that is provided for the scan.

/users=on|off

Analyze data about users when performing the IOC scan (UserItem
term).
If the value of the argument is off, Kaspersky Endpoint Security
does not analyze data about users created in the system. If the IOC
le contains UserItem IOC document terms, they are ignored
(detected as no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes data about users created in the system only if the UserItem
IOC document is described in the IOC le that is provided for the
scan.

/volumes=on|off

Analyze data about volumes when performing the IOC scan
(VolumeItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the data about volumes on the device. If the IOC le
contains VolumeItem IOC document terms, they are ignored
(detected as no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes volume data only if the VolumeItem IOC document is
described in the IOC le that is provided for the scan.

/eventlog=on|off

Analyze the data about records in the Windows event log when
performing the IOC scan (EventLogItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not scan the records in the Windows event log. If the IOC le
contains EventLogItem IOC document terms, they are ignored
(detected as no match).
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If the argument is not speci ed, Kaspersky Endpoint Security
analyzes the Windows event log if the EventLogItem IOC document
is described in the IOC le that is provided for the scan.
/datetime=<event publication
date>

Take into consideration the date when the event was published in the
Windows event log when determining the IOC scan scope for the
corresponding IOC document.
When performing an IOC scan, Kaspersky Endpoint Security scans
Windows event log entries published during the period from the
speci ed time and date to the moment when the task is run.
Kaspersky Endpoint Security allows specifying the event publication
date as the value of the argument. The scan is performed only for
events published in the Windows event log after the speci ed date
and before the scan is run.
If the argument is not speci ed, Kaspersky Endpoint Security scans
events with any publication date. The
TaskSettings::BaseSettings::EventLogItem::datetime setting cannot
be edited.
The setting is used only if the EventLogItem IOC document is
described in the IOC le provided for the scan.

/channel=<list of channels>

List of channel (log) names for which you want to perform an IOC
scan.
If the argument is speci ed, Kaspersky Endpoint Security scans
records published in the speci ed logs. The IOC document must have
the EventLogItem term described.
The name of the log is speci ed as a string in accordance with the
name of the log (channel) speci ed in the properties of the log (the
Full Name parameter) or in the event properties (the <Channel>
</Channel> parameter in the xml schema of the event). You can
specify multiple channels separated by spaces.
If the argument is not speci ed, Kaspersky Endpoint Security scans
records for channels Application, System, Security.

/files=on|off

Analyze le data when performing the IOC scan (FileItem term).
If the value of the argument is off, Kaspersky Endpoint Security
does not analyze le data. If the IOC le contains FileItem IOC
document terms, they are ignored (detected as no match).
If the argument is not speci ed, Kaspersky Endpoint Security
analyzes le data only if the FileItem IOC document is described in
the IOC le that is provided for the scan.

/drives=
<all|system|critical|custom>

Set IOC scan scope when analyzing data for the FileItem IOC
document.
You can set the following values for the scan scope:
<all> for all available le scopes.
<system> for les in folders where the operating system is
installed.
<critical> for temporary les in user and system folders.
<custom> for les in user-de ned scopes (/scope=<list of
folders to scan>).
If the argument is not speci ed, the scan is performed for critical
areas.
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/excludes=<list of
exclusions>

Set exclusion scope when analyzing data for the FileItem IOC
document. You can specify multiple paths separated by spaces.

/scope=<list of folders to
scan>

User-de ned IOC scan scope when analyzing data for the FileItem
IOC document (/drives=custom). You can specify multiple paths
separated by spaces.

Command return values:
-1 means the command is not supported by the version of Kaspersky Endpoint Agent that is installed on the
device.
0 means the command was executed successfully.
1 means a mandatory argument was not passed to the command.
2 means a general error occurred.
4 means there was a syntax error.
If the command was executed successfully (return value 0) and indicators of compromise were detected along the
way, Kaspersky Endpoint Security outputs the following task result information to the command line:
Uuid

ID of the IOC le from the header of the IOC le structure (the <ioc id=""> tag)

Name

Description of the IOC le from the header of the IOC le structure (the
<description></description> tag)

Matched
Indicator Items

List of IDs of all matched indicators.

Matched objects

Data for each IOC document for which there was a match.

MDRLICENSE. MDR activation
Perform operations with the BLOB con guration le to activate Managed Detection and Response. The BLOB le
contains the client ID and information about the license for Kaspersky Managed Detection and Response. The
BLOB le is located inside the ZIP archive of the MDR con guration le. You can obtain the ZIP archive in the
Kaspersky Managed Detection and Response Console. For detailed information about a BLOB le, please refer to
the Kaspersky Managed Detection and Response Help .
Administrator privileges are required for performing operations with a BLOB le. Managed Detection and
Response settings in the policy must also be available for editing ( ).

Command syntax
MDRLICENSE <operation> [/login=<user name> /password=<password>]

Operation
/ADD
<file

Apply the BLOB con guration le for integration with Kaspersky Managed Detection and
Response (P7 le format). You can apply only one BLOB le. If a BLOB le was already added to
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name>

the computer, the le will be replaced.

/DEL

Delete the BLOB con guration le.

Authentication
/login=<user name> /password=
<password>

User account credentials with the required Password protection
permissions.

Example:
avp.com MDRLICENSE /ADD file.key
avp.com MDRLICENSE /DEL /login=KLAdmin /password=!Password1

Error codes
Errors may occur when working with the application through the command line. When errors occur, Kaspersky
Endpoint Security shows an error message, for example, Error: Cannot start task 'EntAppControl'.
Kaspersky Endpoint Security can also show additional information in the form of a code, for example,
error=8947906D (see the table below).
Error codes

Error code

Description

09479001

License key for Kaspersky Endpoint Security is already in use on this computer.

0947901D

License expired. Database update is not available.

89479002

Key not found.

89479003

Digital signature missing or corrupted.

89479004

Data corrupted.

89479005

Key le corrupted.

89479006

License expired or license key expired.

89479007

Key le not speci ed.

89479008

Cannot apply key le.

89479009

Failed to save data.

8947900A

Failed to read data.

8947900B

I/O error.

8947900C

Databases not found.

8947900E

Licensing library not loaded.

8947900F

Databases corrupted or updated manually.

89479010

Databases are corrupted.

89479011

Cannot use invalid key le to add a reserve key.

89479012

System error.
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89479013

Denylist of keys corrupted.

89479014

Digital signature of le does not match the digital signature of Kaspersky.

89479015

Cannot use a key for non-commercial license as a key for commercial license.

89479016

The beta license is required to use the beta version of the application.

89479017

Key le not compatible with this application.

89479018

Key blocked by Kaspersky.

89479019

Application has already been used under a trial license. Cannot add trial key again.

8947901A

Key le corrupted.

8947901B

Digital signature missing, corrupted, or does not match the digital signature of Kaspersky.

8947901C

Cannot add a key if the corresponding non-commercial license has expired.

8947901E

The date the key le was created or used is invalid. Check the system date.

8947901F

Cannot add a key for trial license: another key for trial license is already active.

89479020

Denylist of keys corrupted or missing.

89479021

Update description missing or corrupted.

89479022

Error in license key service data.

89479023

Cannot use invalid key le to add a reserve key.

89479025

Error sending request to activation server. Possible reasons: Internet connection error or
temporary problems on the activation server. Try to activate the application with the activation
code later. If this error persists, contact your Internet provider.

89479026

Error in response from activation server.

89479027

Cannot obtain response status.

89479028

Error occurred when saving temporary le.

89479029

Activation code has been entered incorrectly or system date is incorrect. Check the system
date on the computer.

8947902A

Key le not compatible with this application, or license expired. You cannot activate Kaspersky
Endpoint Security by using a key le for a di erent application.

8947902B

Failed to receive key le. Incorrect activation code was entered.

8947902C

Activation server has returned error 400.

8947902D

Activation server has returned error 401.

8947902E

Activation server has returned error 403.

8947902F

Activation server has returned error 404.

89479030

Activation server has returned error 405.

89479031

Activation server has returned error 406.

89479032

Authentication on proxy server required. Check the network options.

89479033

Request timeout expired.

89479034

Activation server has returned error 409.

89479035

Activation server has returned error 410.
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89479036

Activation server has returned error 411.

89479037

Activation server has returned error 412.

89479038

Activation server has returned error 413.

89479039

Activation server has returned error 414.

8947903A

Activation server has returned error 415.

8947903C

Internal server error.

8947903D

Functionality not supported.

8947903E

Invalid response from gateway. Check the network options.

8947903F

Service unavailable (HTTP Error 503).

89479040

Gateway response timeout has expired. Check the network options.

89479041

The protocol is not supported by the server.

89479043

Unknown HTTP error.

89479044

Invalid resource ID.

89479046

Invalid URL.

89479047

Invalid destination folder.

89479048

Memory allocation error.

89479049

Error converting parameters to ANSI string (URL, folder, agent).

8947904A

Error creating worker thread.

8947904B

Worker thread already running.

8947904C

Worker thread not running.

8947904D

Key le not found on activation server.

8947904E

Key is blocked.

8947904F

Internal error of activation server.

89479050

Not enough data in activation request.

89479053

License key expired.

89479054

Incorrect system date is set on the computer.

89479055

Trial license has expired.

89479056

License expired.

89479057

The limit of application activations has been exceeded for the speci ed code.

89479058

Activation procedure ended with a system error.

89479059

Cannot use a key for non-commercial license as a key for commercial license.

8947905C

Activation code is required.

89479062

Cannot connect to activation server.

89479064

Activation server is unavailable. Please check your Internet connection settings and retry
activation.

89479065

Application database release date exceeds the license expiration date.
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89479066

Cannot replace the active key with an expired key.

89479067

Cannot add a reserve key if it expires before the current license.

89479068

Updated subscription key missing.

8947906A

Incorrect activation code (checksum does not match).

8947906B

Key already active.

8947906C

License types that correspond to active and reserve keys do not match.

8947906D

Component not supported by license.

8947906E

Unable to add subscription key as a reserve key.

89479213

Transport layer general error.

89479214

Failed to connect to activation server.

89479215

Invalid URL format.

89479216

Failed to convert proxy server address.

89479217

Failed to convert server address. Check the Internet connection settings.

89479218

Failed to connect to activation server or proxy server.

89479219

Remote access denied.

8947921A

Response timeout has expired.

8947921B

Error sending HTTP request.

8947921C

SSL connection error.

8947921D

Operation interrupted by callback.

8947921E

Too many forward attempts.

8947921F

Recipient check failed.

89479220

Empty response from activation server.

89479221

Error sending data.

89479222

Error receiving data.

89479223

Local SSL certi cate error.

89479224

SSL encryption error.

89479225

Server SSL certi cate error.

89479226

Invalid contents of network packet.

89479227

User access denied.

89479228

Invalid SSL certi cate le.

89479229

Failed to establish SSL connection.

8947922A

Failed to send or receive network packet. Please try again later.

8947922B

Invalid le with revoked certi cates.

8947922C

SSL certi cate request error.

89479401

Unknown server error.

89479402

Internal server error.
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89479403

No license key available for the activation code entered.

89479404

Active key blocked.

89479405

Required parameters of application activation request are missing.

89479406

Incorrect user name or password.

89479407

Incorrect activation code sent to server.

89479408

Activation code is invalid for Kaspersky Endpoint Security. You cannot activate Kaspersky
Endpoint Security by using a key le for an unknown application.

89479409

Request is missing an activation code.

8947940B

License expired (according to data from the activation server).

8947940C

Number of activations with this code has been exceeded.

8947940D

Invalid format of request ID.

8947940E

Activation code is invalid for Kaspersky Endpoint Security. Activation code is intended for a
di erent Kaspersky application.

8947940F

Cannot update license key.

89479410

Activation code is invalid for this region.

89479411

Activation code is invalid for the Kaspersky Endpoint Security language version.

89479412

Additional access to the activation server is required.

89479413

Activation server has returned error 643.

89479414

Activation server has returned error 644.

89479415

Activation server has returned error 645.

89479416

Activation server has returned error 646.

89479417

Activation code format not supported by activation server.

89479418

Invalid activation code format.

89479419

Incorrect system time is set on the computer.

8947941A

Activation code is invalid for the Kaspersky Endpoint Security version.

8947941B

Subscription expired.

8947941C

Number of activations exceeded for this license key.

8947941D

Invalid digital signature of license key.

8947941E

Additional data is needed.

8947941F

User data veri cation failed.

89479420

Subscription inactive.

89479421

Activation server is under maintenance.

89479501

Unknown error of Kaspersky Endpoint Security.

89479502

Invalid parameter transferred (for example, an empty list of activation server addresses).

89479503

Incorrect activation code.

89479504

Invalid user name.
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89479505

Invalid user password.

89479506

Invalid response from activation server.

89479507

Activation request interrupted.

89479509

Activation server returned an empty forwarding list.

Appendix. Application pro les
A Pro le is a Kaspersky Endpoint Security component, task or feature. Pro les are used to manage the application
from the command line. You can use pro les to execute START, STOP, STATUS, STATISTICS, EXPORT, and IMPORT
commands. Using pro les, you can con gure application settings (for example, STOP DeviceControl) or run tasks
(for example, START Scan_My_Computer).
The following pro les are available:
AdaptiveAnomaliesControl – Adaptive Anomaly Control.
AMSI – AMSI Protection.
BehaviorDetection – Behavior Detection.
DeviceControl – Device control.
EntAppControl – Application Control.
File_Monitoring or FM – File Threat Protection.
Firewall or FW – Firewall.
HIPS – Host Intrusion prevention.
IDS – Network Threat Protection.
IntegrityCheck – Integrity check.
Mail_Monitoring or EM – Mail Threat Protection.
Rollback – update rollback.
Scan_ContextScan – Scan from context menu.
Scan_IdleScan – Background scan.
Scan_Memory – Kernel memory scan.
Scan_My_Computer – Full scan.
Scan_Objects – Custom scan.
Scan_Qscan – Scan objects that are loaded at operation system startup.
Scan_Removable_Drive – Removable drives scan.
543

Scan_Startup or STARTUP – Critical Areas Scan.
Updater – Update.
Web_Monitoring or WM – Web Threat Protection.
WebControl – Web Control.
Kaspersky Endpoint Security also supports service pro les. Service pro les may be required when you are
contacting Kaspersky Technical Support.
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Managing the application through the REST API
Kaspersky Endpoint Security lets you con gure application settings, run a scan, update the anti-virus databases,
and perform other tasks using third-party solutions. Kaspersky Endpoint Security provides an API for this purpose.
The Kaspersky Endpoint Security REST API operates over HTTP and consists of a set of request/response
methods. In other words, you can manage Kaspersky Endpoint Security through a third-party solution, and not the
local application interface or the Kaspersky Security Center Administration Console.
To start using REST API, you need to install Kaspersky Endpoint Security with support for the REST API. The REST
client and Kaspersky Endpoint Security must be installed on the same computer.
To ensure safe interaction between Kaspersky Endpoint Security and the REST client:
Con gure REST client's protection from unauthorized access according the recommendations of the REST
client developer. Con gure REST client folder protection from writing with the help of Discretionary Access
Control List – DACL.
To run REST client, use a separate account with administrator rights. Deny interactive sign-in into the system
for this account.
The application is managed through the REST API at http://127.0.0.1 or http://localhost. It is not possible to remotely
manage Kaspersky Endpoint Security through the REST API.
OPEN THE REST API DOCUMENTATION

Installing the application with the REST API
To manage the application through the REST API, you need to install Kaspersky Endpoint Security with support for
the REST API. If you manage Kaspersky Endpoint Security through the REST API, you cannot manage the
application using Kaspersky Security Center.

Preparing for installing the application with REST API support
Secure interaction of Kaspersky Endpoint Security with the REST client requires con guring request identi cation.
To do so, you must install a certi cate and subsequently sign the payload of each request.
To create a certi cate, you can use e.g. OpenSSL.
Example:
$ openssl req -x509 -newkey rsa:4096 -keyout key.pem -out cert.pem -days 1825 -nodes
Use the RSA encryption algorithm with a key length of 2048 bits or more.
As a result, you will get a cert.pem certi cate and a key.pem private key.

Installing the application with REST API support
To install Kaspersky Endpoint Security with REST API support:
1. Run the command line interpreter (cmd.exe) as an administrator.
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2. Go to the folder that contains the distribution package for Kaspersky Endpoint Security version 11.2.0 or later.
3. Install Kaspersky Endpoint Security with the following settings:
RESTAPI=1
RESTAPI_User=<User name>
User name for managing the application through the REST API. Enter the user name in the format
<DOMAIN>\<UserName> (for example, RESTAPI_User=COMPANY\Administrator). You can manage the
application through the REST API only under this account. You can select only one user to work with the
REST API.
RESTAPI_Port=<Port>
Port used for data exchange. Optional parameter. Port 6782 is selected by default.
RESTAPI_Certificate=<Path to certificate>
Certi cate for identifying requests (for example, RESTAPI_Certificate=C:\cert.pem).
You can install the certi cate after installing the application or update the certi cate after the certi cate
expires.
How to install a certi cate for REST API request identi cation

1. Disable Kaspersky Endpoint Security Self-Defense
The Self-Defense mechanism prevents alteration or deletion of application les on the hard drive,
processes in memory, and entries in the system registry.
2. Go to the registry key that contains REST API settings:
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\KasperskyLab\protected\KES\settings\Rest
3. Enter the path to the certi cate, for example, Certificate = C:\Folder\cert.pem.
4. Enable Kaspersky Endpoint Security Self-Defense.
5. Restart the application.
AdminKitConnector=1
Application management using administration systems. Management is allowed by default.
You can also use the setup.ini le to de ne the settings for working with the REST API.
Example:
setup_kes.exe /pEULA=1 /pPRIVACYPOLICY=1 /pKSN=1 /pALLOWREBOOT=1
/pAdminKitConnector=1 /pRESTAPI=1 /pRESTAPI_User=COMPANY\Administrator
/pRESTAPI_Certificate=C:\cert.pem /s
As a result, you will be able to manage the application through the REST API. To verify its operation, open the REST
API documentation using a GET request.
Example:
GET http://localhost:6782/kes/v1/api-docs
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If you installed the application with REST API support, Kaspersky Endpoint Security automatically creates an
allow rule in the Web Control settings for accessing web resources (Service Rule for REST API). This rule is
needed to allow the REST client to access Kaspersky Endpoint Security at all times. For example, if you have
restricted user access to web resources, this will not a ect managing the application through the REST API.
We recommend that you do not delete the rule or change the Service Rule for REST API settings. If you
deleted the rule, Kaspersky Endpoint Security will restore it after restarting the application.

Working with the API
It is not possible to restrict access to the application through the REST API using Password Protection. For
example, it is not possible to block a user from disabling protection through the REST API. You can con gure
Password Protection through the REST API and restrict user access to the application through the local
interface.
To manage the application through the REST API, you need to run the REST client under the account that you
speci ed when installing the application with REST API support. You can select only one user to work with the
REST API.
OPEN THE REST API DOCUMENTATION
Managing the application through the REST API consists of the following steps:
1. Get the current values of the application settings. To do so, send a GET request.
Example:
GET http://localhost:6782/kes/v1/settings/ExploitPrevention
2. The application will send a response with the structure and values of settings. Kaspersky Endpoint Security
supports XML- and JSON formats.
Example:
{
"action": 0,
"enableSystemProcessesMemoryProtection": true,
"enabled": true
}
3. Edit the application settings. Use the settings structure received in response to the GET request.
Example:
{
"action": 0,
"enableSystemProcessesMemoryProtection": false,
"enabled": true
}
4. Save application settings (the payload) in a JSON (payload.json).
5. Sign the JSON in the PKCS7 format.
Example:
$ openssl smime -sign -in payload.json -signer cert.pem -inkey key.pem -nodetach binary -outform pem -out signed_payload.pem
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As a result, you get a signed le with the payload of the request (signed_payload.pem).
6. Edit the application settings. To do so, send a POST request and attach the signed le with the request payload
(signed_payload.pem).
The application applies the new settings and sends a response containing the application con guration results
(the response can be empty). You can verify that the settings are updated using a GET request.

548

Sources of information about the application
Kaspersky Endpoint Security page on the Kaspersky website
On the Kaspersky Endpoint Security page , you can view general information about the application and its
functions and features.
The Kaspersky Endpoint Security page contains a link to the online store. There you can purchase or renew the
application.

Kaspersky Endpoint Security page in the Knowledge Base
Knowledge Base is a section on the Technical Support website.
On the Kaspersky Endpoint Security page in the Knowledge Base , you can read articles that provide useful
information, recommendations, and answers to frequently asked questions on how to purchase, install, and use the
application.
Knowledge Base articles can answer questions relating to not only Kaspersky Endpoint Security but also to other
Kaspersky applications. Articles in the Knowledge Base may also contain news from Technical Support.

Discussion of Kaspersky applications in user community
If your question does not require an urgent answer, you can discuss it with Kaspersky experts and other users in
our Community .
In the Community, you can view existing topics, post your own comments, and create new discussion topics.
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Contacting Technical Support
If you cannot nd a solution to your problem in the documentation or in other sources of information about
Kaspersky Endpoint Security, we recommend that you contact Technical Support. Technical Support will answer
your questions about installing and using Kaspersky Endpoint Security.
Kaspersky provides support for Kaspersky Endpoint Security during the application's life cycle (refer to the
application life cycle page ). Before contacting Technical Support, please read the support rules .
You can contact Technical Support in one of the following ways:
By visiting the Technical Support website
By sending a request to Kaspersky Technical Support through the Kaspersky CompanyAccount portal
After you inform Kaspersky Technical Support specialists about your issue, they may ask you to create a trace le.
The trace le allows you to trace the process of performing application commands step by step and determine the
stage of application operation at which an error occurs.
Technical Support specialists may also require additional information about the operating system, processes that
are running on the computer, detailed reports on the operation of application components.
While running diagnostics, Technical Support experts may ask you to change application settings by:
Activating the functionality for receiving extended diagnostic information.
Fine-tuning the settings of individual application components, which are not available via standard user
interface elements.
Changing the settings for storage of diagnostic information.
Con guring the interception and logging of network tra ic.
Technical Support experts will provide all the information needed to perform these operations (description of the
sequence of steps, settings to be modi ed, con guration les, scripts, additional command line functionality,
debugging modules, special-purpose utilities, etc.) and inform you about the scope of data used for purposes of
debugging. The extended diagnostic information is saved on the user's computer. The data is not automatically
transmitted to Kaspersky.
The operations listed above should be performed only under the supervision of Technical Support specialists
by following their instructions. Unsupervised changes to application settings performed in ways other than
those described in the Administrator's Guide or instructions of Technical Support specialists can slow down or
crash the operating system, a ect computer security, or compromise the availability and integrity of data
being processed.

Contents and storage of trace les
You are personally responsible for the security of the data that is stored on your computer, particularly for
monitoring and restricting access to the data until it is submitted to Kaspersky.
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Trace les are stored on the computer as long as the application is in use, and are deleted permanently when the
application is removed.
Trace les, except trace les of Authentication Agent, are stored in the folder %ProgramData%\Kaspersky
Lab\KES\Traces.
Trace les are named as follows: KES<service version number_dateXX.XX_timeXX.XX_pidXXX.><trace
file type>.log.
You can view data saved in trace les.
All trace les contain the following common data:
Event time.
Number of the thread of execution.
The Authentication Agent trace le does not contain this information.
Application component that caused the event.
Degree of event severity (informational event, warning, critical event, error).
A description of the event involving command execution by a component of the application and the result of
execution of this command.
Kaspersky Endpoint Security saves user passwords to a trace le only in encrypted form.

Contents of SRV.log, GUI.log, and ALL.log trace les
SRV.log, GUI.log, and ALL.log trace les may store the following information in addition to general data:
Personal data, including the last name, rst name, and middle name, if such data is included in the path to les
on the local computer.
Data on the hardware installed on the computer (such as BIOS/UEFI rmware data). This data is written to trace
les when performing Kaspersky Disk Encryption.
The user name and password if they were transmitted openly. This data can be recorded in trace les during
Internet tra ic scanning.
The user name and password if they are contained in HTTP headers.
The name of the Microsoft Windows account if the account name is included in a le name.
Your email address or a web address containing the name of your account and password if they are contained
in the name of the object detected.
Websites that you visit and redirects from these websites. This data is written to trace les when the
application scans websites.
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Proxy server address, computer name, port, IP address, and user name used to sign in to the proxy server. This
data is written to trace les if the application uses a proxy server.
Remote IP addresses to which your computer established connections.
Message subject, ID, sender's name and address of the message sender's web page on a social network. This
data is written to trace les if the Web Control component is enabled.
Network tra ic data. This data is written to trace les if tra ic monitoring components are enabled (such as
Web Control).
Data received from Kaspersky servers (such as the version of anti-virus databases).
Statuses of Kaspersky Endpoint Security components and their operating data.
Data on user activity in the application.
Operating system events.

Contents of HST.log, BL.log, Dumpwriter.log, WD.log, AVPCon.dll.log trace les
In addition to general data, the HST.log trace le contains information about the execution of a database and
application module update task.
In addition to general data, the BL.log trace le contains information about events occurring during operation of
the application, as well as data required to troubleshoot application errors. This le is created if the application is
started with the avp.exe –bl parameter.
In addition to general data, the Dumpwriter.log trace le contains service information required for
troubleshooting errors that occur when the application dump le is written.
In addition to general data, the WD.log trace le contains information about events occurring during operation of
the avpsus service, including application module update events.
In addition to general data, the AVPCon.dll.log trace le contains information about events occurring during the
operation of the Kaspersky Security Center connectivity module.

Contents of performance trace les
Performance trace les are named as follows: KES<version
number_dateXX.XX_timeXX.XX_pidXXX.>PERF.HAND.etl.
In addition to general data, performance trace les contain information about the load on the processor,
information about the loading time of the operating system and applications, and information about running
processes.

Contents of the AMSI Protection component trace le
In addition to general data, the AMSI.log trace le contains information about the results of scans performed on
requests from third-party applications.

Contents of trace les of the Mail Threat Protection component
552

The trace le mcou.OUTLOOK.EXE.log may contain parts of email messages, including email addresses, in
addition to general data.

Contents of trace les of the Scan from Context Menu component
The shellex.dll.log trace le contains information about completion of the scan task and data required to
debug the application, in addition to general information.

Contents of trace les of the application web plug-in
Trace les of the application web plug-in are stored on the computer on which Kaspersky Security Center Web
Console is deployed, in the folder Program Files\Kaspersky Lab\Kaspersky Security Center Web Console\logs.
Trace les of the application web plug-in are named as follows: logs-kes_windows-<type of trace
file>.DESKTOP-<date of file update>.log. Web Console begins writing data after installation and deletes
the trace les after Web Console is removed.
Trace les of the application web plug-in contain the following information in addition to general data:
KLAdmin user password for unlocking the Kaspersky Endpoint Security interface (Password protection).
Temporary password for unlocking the Kaspersky Endpoint Security interface (Password protection).
User name and password for the SMTP mail server (Email noti cations).
User name and password for the Internet proxy server (Proxy server).
User name and password for the Change application components task.
Account credentials and paths speci ed in Kaspersky Endpoint Security tasks and policy properties.

Contents of the Authentication Agent trace le
The Authentication Agent trace le is stored in the System Volume Information folder and is named as follows:
KLFDE.{EB2A5993-DFC8-41a1-B050-F0824113A33A}.PBELOG.bin.
In addition to general data, the Authentication Agent trace le contains information about the operation of
Authentication Agent and the actions performed by the user with Authentication Agent.

Application operation tracing
Application tracing is a detailed record of actions that performed by the application, and of messages about
events that occurred during operation of the application.
Application tracing should be performed under the supervision of Kaspersky Technical Support.

To create an application trace le:
1. In the main application window, click the button

.
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The Support window opens.
2. In the Support window, click the Support Tools button.
3. Use the Enable application tracing toggle to enable or disable tracing of application operation.
4. In the Tracing drop-down list, select an application tracing mode:
With rotation. Save traces to a limited number of les of limited size and overwrite the older les when the
maximum size is reached. If this mode is selected, you can de ne the maximum number of les for rotation
and the maximum size for each le.
Write to a single le. Save one trace le (no size limit).
5. In the Level drop-down list, select the tracing level.
You are advised to clarify the required tracing level with a Technical Support specialist. In the absence of
guidance from Technical Support, set the tracing level to Normal (500).
6. Restart Kaspersky Endpoint Security.
7. To stop the tracing process, return to the Support window and disable tracing.
You can also create trace les when installing the application from the command line, including by using the
setup.ini le.
As a result, a performance trace le is created in the %ProgramData%\Kaspersky Lab\KES\Traces folder. After
the trace le is created, send the le to Kaspersky Technical Support.
Kaspersky Endpoint Security automatically deletes trace les when the application is removed. You can also delete
the les manually. To do so, you must disable tracing and stop the application.

Application performance tracing
Kaspersky Endpoint Security lets you receive information about computer operating issues during use of the
application. For example, you can receive information about delays in operating system loading after the
application is installed. To do so, Kaspersky Endpoint Security creates performance trace les. Performance
tracing refer to the logging of actions performed by the application for the purpose of diagnosing performance
issues of Kaspersky Endpoint Security. To receive information, Kaspersky Endpoint Security uses the Event Tracing
for Windows service (ETW). Kaspersky Technical Support is responsible for diagnosing issues of Kaspersky
Endpoint Security and establishing the reasons for those issues.
Application tracing should be performed under the supervision of Kaspersky Technical Support.

To create a performance trace le:
1. In the main application window, click the button

.

The Support window opens.
2. In the Support window, click the Support Tools button.
3. Use the Enable performance tracing toggle to enable or disable tracing of application performance.
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4. In the Tracing drop-down list, select an application tracing mode:
With rotation. Save traces to a limited number of les of limited size and overwrite the older les when the
maximum size is reached. If this mode is selected, you can de ne the maximum size for each le.
Write to a single le. Save one trace le (no size limit).
5. In the Level drop-down list, select the tracing level:
Light scan. Kaspersky Endpoint Security analyzes the most important operating system processes related
to performance.
Detailed. Kaspersky Endpoint Security analyzes all operating system processes related to performance.
6. In the Tracing type drop-down list, select the tracing type:
Basic information. Kaspersky Endpoint Security analyzes processes while the operating system is running.
Use this tracing type if a problem persists after the operating system is loaded, such as a problem accessing
the Internet in the browser.
On restart. Kaspersky Endpoint Security analyzes processes only while the operating system is loading.
After the operating system is loaded, Kaspersky Endpoint Security stops tracing. Use this tracing type if the
problem is related to delayed loading of the operating system.
7. Restart the computer and try to reproduce the problem.
8. To stop the tracing process, return to the Support window and disable tracing.
As a result, a performance trace le is created in the %ProgramData%\Kaspersky Lab\KES\Traces folder.
After the trace le is created, send the le to Kaspersky Technical Support.

Dump writing
A dump le contains all information about the working memory of Kaspersky Endpoint Security processes at the
moment when the dump le was created.
Saved dump les may contain con dential data. To control access to data, you must independently ensure the
security of dump les.
Dump les are stored on the computer as long as the application is in use, and are deleted permanently when the
application is removed. Dump les are stored in the folder %ProgramData%\Kaspersky Lab\KES\Traces.

To enable or disable dump writing:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. In the Debug information block, use the Enable dump writing check box to enable or disable application dump
writing.
4. Save your changes.
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Protecting dump les and trace les
Dump les and trace les contain information about the operating system, and may also contain user data. To
prevent unauthorized access to such data, you can enable protection of dump les and trace les.
If protection of dump les and trace les is enabled, the les can be accessed by the following users:
Dump les can be accessed by the system administrator and local administrator, and by the user that enabled
the writing of dump les and trace les.
Trace les can be accessed only by the system administrator and local administrator.

To enable or disable protection of dump les and trace les:
1. In the main application window, click the button

.

2. In the application settings window, select Advanced settings → General.
3. In the Debug information block, use the Enable dump and trace les protection check box to enable or
disable le protection.
4. Save your changes.
Dump les and trace les that were written while protection was active remain protected even after this
function is disabled.
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Limitations and warnings
Kaspersky Endpoint Security has a number of limitations that are not critical to operation of the application.
Installing the application
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For details about support for the Microsoft Windows 10, Microsoft Windows Server 2016 and Microsoft
Windows Server 2019 operating systems, please refer to the Technical Support Knowledge Base .
For details about support for the Microsoft Windows 11 and Microsoft Windows Server 2022 operating
systems, please refer to the Technical Support Knowledge Base .
After being installed to an infected computer, the application does not inform the user about the need to
run a computer scan. You may experience problems activating the application. To resolve these problems,
start a Critical Areas Scan.
If non-ASCII characters (for example, Russian letters) are used in the setup.ini and setup.reg les, you are
advised to edit the le using notepad.exe and to save the le in UTF-16LE encoding. Other encodings are
not supported.
The application does not support the use of non-ASCII characters when specifying the application
installation path in the installation package settings.
When application settings are imported from a CFG le, the value of the setting that de nes participation
in Kaspersky Security Network is not applied. After importing the settings, please read the text of the
Kaspersky Security Network Statement and con rm your consent to participate in Kaspersky Security
Network. You can read the text of the Statement in the application interface or in the ksn_*.txt le located
in the folder containing the application distribution kit.
If you want to remove and then re-install encryption (FLE or FDE) or the Device Control component, you
must restart the system before reinstallation.
When using the Microsoft Windows 10 operating system, you must restart the system after removing the
File Level Encryption (FLE) component.
When attempting to install any version of the AES Encryption Module on a computer that has Kaspersky
Endpoint Security for Windows 11.7.0 but no encryption components installed, installation of the Encryption
Module will end with an error message stating that a newer version of the application is installed. Starting
with Kaspersky Endpoint Security 10 for Windows Service Pack 2 (version 10.3.0.6294), there is no separate
installation le for the Encryption Module. Encryption libraries are included in the application distribution
package. Kaspersky Endpoint Security 11.7.0 is incompatible with AES encryption modules. The libraries
required for encryption are installed automatically when the Full Disk Encryption (FDE) or File Level
Encryption (FLE) component is selected.
Installation of the application may end with an error stating An application whose name is missing or
unreadable is installed on your computer. This means that incompatible applications or fragments of them
remain on your computer. To remove artifacts of incompatible applications, send a request with a detailed
description of the situation to Kaspersky Technical Support via Kaspersky CompanyAccount .
If you canceled removal of the application, start its recovery after the computer restarts.
On computers running Windows 10 version 1903 and 1909, upgrades from Kaspersky Endpoint Security 10
for Windows Service Pack 2 Maintenance Release 3 (build 10.3.3.275), Service Pack 2 Maintenance Release
4 (build 10.3.3.304), 11.0.0 and 11.0.1 with the File Level Encryption (FLE) component installed may end with an
error. This is because le encryption is not supported for these versions of Kaspersky Endpoint Security
for Windows in Windows 10 version 1903 and 1909. Prior to installing this upgrade, you are advised to
remove the le encryption component.
The application requires Microsoft .NET Framework 4.0 or later. Microsoft .NET Framework 4.6.1 has
vulnerabilities. If you are using Microsoft .NET Framework 4.6.1, you must install security updates. For details
about Microsoft .NET Framework security updates, refer to the Microsoft Technical Support website .
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If you are upgrading a previous version of the application to version 11.7.0, to install Kaspersky Endpoint
Agent, restart the computer and sign in to the system using an account with local administrator rights.
Otherwise, Kaspersky Endpoint Agent will not be installed during the upgrade procedure.
If the application is unsuccessfully installed with the Kaspersky Endpoint Agent component selected in a
server operating system and the Windows Installer Coordinator Error window appears, refer to the
instructions on the Microsoft support website.
If the application was installed locally in non-interactive mode, use the provided setup.ini le to replace the
installed components.
After Kaspersky Endpoint Security for Windows is installed in some con gurations of Windows 7, Windows
Defender continues to operate. You are advised to manually disable Windows Defender to prevent
degraded system performance.
Upgrading the application
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When upgrading from Kaspersky Endpoint Security 10 Service Pack 2 for Windows (build 10.3.0.6294), the
Host Intrusion Prevention component is turned on.
When updating Kaspersky Endpoint Security 10 for Windows Service Pack 2 (build 10.3.0.6294), the les
that were placed in Backup or Quarantine in the previous version of the application will be transferred to
Backup in the new version of the application. These les are not transferred for versions earlier than
Kaspersky Endpoint Security 10 for Windows Service Pack 2 (build 10.3.0.6294). To save them, you must
restore the les from Quarantine and Backup before upgrading the application. After the upgrade is
complete, re-scan the restored les.
Starting from 11.0.0 application version, you can install Kaspersky Endpoint Security for Windows MMC
plugin on top of the previous plugin version. To return to a previous plugin version, delete the current plugin
and install a previous version of the plugin.
When upgrading Kaspersky Endpoint Security 11.0.0 or 11.0.1 for Windows, the local task schedule settings
for the Update, Critical Areas Scan, Custom Scan, and Integrity Check tasks are not saved.
On computers running Windows 10 version 1903 and 1909, upgrades from Kaspersky Endpoint Security 10
for Windows Service Pack 2 Maintenance Release 3 (build 10.3.3.275), Service Pack 2 Maintenance Release
4 (build 10.3.3.304), 11.0.0 and 11.0.1 with the File Level Encryption (FLE) component installed may end with an
error. This is because le encryption is not supported for these versions of Kaspersky Endpoint Security
for Windows in Windows 10 version 1903 and 1909. Prior to installing this upgrade, you are advised to
remove the le encryption component.
The application requires Microsoft .NET Framework 4.0 or later. Microsoft .NET Framework 4.6.1 has
vulnerabilities. If you are using Microsoft .NET Framework 4.6.1, you must install security updates. For details
about Microsoft .NET Framework security updates, refer to the Microsoft Technical Support website .
If you are upgrading a previous version of the application to version 11.7.0, to install Kaspersky Endpoint
Agent, restart the computer and sign in to the system using an account with local administrator rights.
Otherwise, Kaspersky Endpoint Agent will not be installed during the upgrade procedure.
If you are upgrading Kaspersky Endpoint Security 10 for Windows Service Pack 2 Maintenance Release 4
with the File Level Encryption (FLE) component installed on computers running Windows 10 version 1809,
1903 and 1909, FDE drivers will not be installed to the WinRE image.
When upgrading Kaspersky Endpoint Security, the application disables the use of KSN until the Kaspersky
Security Network Statement is accepted. In addition, the computer status can be changed to Critical in
Kaspersky Security Center; the event KSN servers are unavailable is received. If you use Kaspersky
Managed Detection and Response, you will receive events about violations in the operation of the solution.
The use of KSN is required for the operation of Kaspersky Managed Detection and Response. Kaspersky
Endpoint Security enables the use of KSN after applying the policy in which the administrator accepts the
KSN terms of use. Once the Kaspersky Security Network Statement is accepted, Kaspersky Endpoint
Security resumes its operation.
After the application is upgraded from versions earlier than Kaspersky Endpoint Security 11 for Windows,
the computer must be restarted.
Support for server platforms
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The ReFS le system is supported with limitations:
Kaspersky Endpoint Security may process threat disinfection events incorrectly. For example, if the
application has deleted a malicious le, the report might have an Object not processed entry. At the
same time, Kaspersky Endpoint Security disinfects threats in accordance with application settings.
Kaspersky Endpoint Security can also create a duplicate of the Object will be disinfected on restart
event for the same object.
File Threat Protection may skip some threats. At the same time, Virus Scan works correctly.
After server anti-virus check is started, scan exclusions added with iChecker are reset when the server
is rebooted.
The iSwift technology is not supported. Kaspersky Endpoint Security does not consider scan
exclusions added using the iSwift technology.
Kaspersky Endpoint Security does not detect eicar.com and susp-eicar.com les if meicar.exe le
existed on the computer before Kaspersky Endpoint Security was installed.
Kaspersky Endpoint Security may incorrectly display threat disinfection noti cations. For example, the
application may display a threat noti cation for a previously disinfected threat.
The Server Core and Cluster Mode con gurations are not supported.
File Level Encryption (FLE) and Kaspersky Disk Encryption (FDE) technologies are not supported on server
platforms. At the same time, Kaspersky Endpoint Security may incorrectly process data encryption events.
Device Control is not supported on server platforms.
In server operating systems, no warning is displayed regarding the need for advanced disinfection.
Microsoft Windows Server 2008 was excluded from support. - Installing the application on a computer
running the Microsoft Windows Server 2008 operating system is not supported.
Support for virtual platforms
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Full disk encryption (FDE) on Hyper-V virtual machines is not supported.
Full disk encryption (FDE) on Citrix virtual platforms is not supported.
Windows 10 Enterprise multi-session is supported with limitations:
Kaspersky Endpoint Security considers Windows 10 Enterprise multi-session as a server operating
system. Therefore, Windows 10 Enterprise multi-session is supported with server platform-speci c
limitations. For example, servers cannot use some Kaspersky Endpoint Security components. The
application also uses a server license key instead of a workstation license key.
Full disk encryption (FDE) is not supported.
Managing BitLocker is not supported.
Using Kaspersky Endpoint Security with removable drives is not supported. The Microsoft Azure
infrastructure de nes removable drives as network drives.
Installation and use of le level encryption (FLE) on Citrix virtual platforms is not supported.
To support compatibility of Kaspersky Endpoint Security for Windows with Citrix PVS, perform installation
with the Ensure compatibility with Citrix PVS option enabled. This option can be enabled in the Setup
Wizard or by using the command line parameter /pCITRIXCOMPATIBILITY=1. In case of remote
installation, the KUD le must be edited by adding the following parameter to it:
/pCITRIXCOMPATIBILITY=1.
Citrix XenDesktop. Before starting cloning, you must disable Self-Defense to clone virtual machines that
use vDisk.
When preparing a template machine for the Citrix XenDesktop master image with pre-installed Kaspersky
Endpoint Security for Windows and Kaspersky Security Center Network Agent, add the following types of
exclusions to the con guration le:
[Rule-Begin]
Type=File-Catalog-Construction
Action=Catalog-Location-Guest-Modifiable
name="%ALLUSERSPROFILE%\Kaspersky\**\*"
name="%ALLUSERSPROFILE%\KasperskyLab\**\*"
[Rule-End]
For details about Citrix XenDesktop, visit the Citrix Support website .
In some cases, an attempt to safely disconnect a removable drive may be unsuccessful on a virtual
machine that is deployed on a VMware ESXi hypervisor. Attempt to safely disconnect the device once
again.
Compatibility with Kaspersky Security Center
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You can manage the Adaptive Anomaly Control component only in Kaspersky Security Center version 11 or
later.
The Kaspersky Security Center 11 threat report might not display information about the action taken on
threats that were detected by the AMSI Protection.
The operating status of the AMSI Protection and Adaptive Anomaly Control components is available only
in Kaspersky Security Center version 11 or later. You can view the operating status in the Kaspersky
Security Center Console within the computer properties in the Tasks section. Reports for these
components are also available only in Kaspersky Security Center version 11 or later.
Licensing

If the Error receiving data system message is displayed, verify that the computer on which you are
performing activation has network access, or con gure the activation settings via Kaspersky Security
Center Activation Proxy.
The application cannot be activated by subscription via the Kaspersky Security Center if the license has
expired or if a trial license is active on the computer. To replace a trial license or a soon-to-be expired
license with a subscription license, use the license distribution task.
In the application interface, the license expiration date is displayed in the local time of the computer.
Installation of the application with an embedded key le on a computer that has unstable Internet access
may result in the temporary display of events stating that the application is not activated or that the
license does not permit component operation. This is because the application rst installs and attempts to
activate the embedded trial license, which requires Internet access for activation during the installation
procedure.
During the trial period, installation of any application upgrade or patch on a computer that has unstable
Internet access may result in the temporary display of events stating that the application is not activated.
This is because the application once again installs and attempts to activate the embedded trial license,
which requires Internet access for activation when installing an upgrade.
If the trial license was automatically activated during application installation and then the application was
removed without saving the license information, the application will not be automatically activated with the
trial license when re-installed. In this case, manually activate the application.
If you are using Kaspersky Security Center version 11 and Kaspersky Endpoint Security version 11.7.0,
component performance reports may work incorrectly. If you installed Kaspersky Endpoint Security
components that are not included in your license, Network Agent may send component status errors to
the Windows Event Log. To avoid errors, remove the components that are not included in your license.
Remediation Engine
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The application restores les only on devices that have the NTFS or FAT32 le system.
The application can restore les with the following extensions: odt, ods, odp, odm, odc, odb, doc, docx,
docm, wps, xls, xlsx, xlsm, xlsb, xlk, ppt, pptx, pptm, mdb, accdb, pst, dwg, dxf, dxg, wpd, rtf, wb2, pdf, mdf,
dbf, psd, pdd, eps, ai, indd, cdr, jpg, jpe, dng, 3fr, arw, srf, sr2, bay, crw, cr2, dcr, kdc, erf, mef, mrw, nef, nrw, orf,
raf, raw, rwl, rw2, r3d, ptx, pef, srw, x3f, der, cer, crt, pem, pfx, p12, p7b, p7c, 1cd.
It is not possible to restore les residing on network drives or on rewritable CD/DVD discs.
It is not possible to restore les that were encrypted with the Encryption File System (EFS). For more
details on EFS operation, please visit the Microsoft website .
The application does not monitor modi cations to les performed by processes at the level of the
operating system kernel.
The application does not monitor modi cations made to les over a network interface (for example, if a le
is stored in a shared folder and a process is started remotely from another computer).
Firewall
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Filtration of packets or connections by local address, physical interface, and packet time to live (TTL) is
supported in the following cases:
By local address for outbound packets or connections in application rules for TCP and UDP and packet
rules.
By local address for inbound packets or connections (except UDP) in block application rules and packet
rules.
By packet time to live (TTL) in block packet rules for inbound or outbound packets.
By network interface for inbound and outbound packets or connections in packet rules.
In application versions 11.0.0 and 11.0.1, de ned MAC addresses are incorrectly applied. The MAC address
settings for versions 11.0.0, 11.0.1 and 11.1.0 or later are not compatible. After upgrading the application or
plug-in from these versions to version 11.1.0 or later, you must verify and recon gure the de ned MAC
addresses in Firewall rules.
When upgrading the application from versions 11.1.1 and 11.2.0 to version 11.7.0, the statuses of permissions
for the following Firewall rules are not migrated:
Requests to DNS server over TCP.
Requests to DNS server over UDP.
Any network activity.
ICMP Destination Unreachable incoming responses.
Incoming ICMP stream.
If you con gured a network adapter or packet time to live (TTL) for an allowing packet rule, the priority of
this rule is lower than a blocking application rule. In other words, if network activity is blocked for an
application (for example, the application is in the High Restricted trust group), you cannot allow network
activity of the application by using a packet rule with these settings. In all other cases, the priority of a
packet rule is higher than an application network rule.
When importing Firewall packet rules, Kaspersky Endpoint Security may modify rule names. The application
determines rules with identical sets of general parameters: protocol, direction, remote and local ports,
packet time-to-live (TTL). If this set of general parameters is identical for multiple rules, the application
assigns the same name to those rules or appends a parameter tag to the name. In this way, Kaspersky
Endpoint Security imports all packet rules, but the name of rules that have identical general settings can
be modi ed.
If you have enabled application event reporting in a network rule, on moving the application to a di erent
trust group, the restrictions of this trust group will not be applied. Thus, if the application is in the Trusted
trust group, it will have no network restrictions. Then you enabled event reporting for this application and
moved it to the Untrusted trust group. Firewall will not enforce network restrictions for this application. We
recommend that you rst move the application to the appropriate trust group and then enable event
reporting. If this method is not suitable, you can manually con gure restrictions for the application in the
network rule settings. The restriction applies only to the local interface of the application. Moving the
application between trust groups in the policy works correctly.
The Firewall and Intrusion Prevention components have common settings: application rights and protected
resources. If you change these settings for Firewall, Kaspersky Endpoint Security automatically applies the
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new settings to Intrusion Prevention. If, for example, you have allowed changes to the general settings of
the Firewall policy (the padlock is open), the Intrusion Prevention settings will also become editable.
When a network packet rule is triggered in Kaspersky Endpoint Security 11.6.0 or earlier, the Application
Name column in the Firewall report will always display the Kaspersky Endpoint Security value. In addition,
the Firewall will block the connection at packet level for all applications. This behavior has been modi ed for
Kaspersky Endpoint Security 11.7.0 or later. The Rule Type column has been added to the Firewall report.
When a network packet rule is triggered, the value in the Application Name column remains empty.
BadUSB Attack Prevention

Kaspersky Endpoint Security resets the timeout of USB device lock when the computer is locked (for
example, screen lock timeout elapsed). That is, if you enter a wrong USB device authorization code multiple
times and the application locks the USB device, Kaspersky Endpoint Security allows you to repeat the
authorization attempt after unlocking the computer. In this case, Kaspersky Endpoint Security does not
lock the USB device for a time speci ed in BadUSB Attack Prevention component settings.
Kaspersky Endpoint Security resets the USB device lock timeout when computer protection is paused.
That is, if you enter a wrong USB device authorization code multiple times and the application locks the
USB device, Kaspersky Endpoint Security allows you to repeat the authorization attempt after resuming
computer protection. In this case, Kaspersky Endpoint Security does not lock the USB device for a time
speci ed in BadUSB Attack Prevention component settings.
Application Control

When working in Microsoft Windows 10 in application denylist mode, block rules may be incorrectly applied,
which could cause blocking of applications that are not speci ed in rules.
When progressive web apps (PWA) are blocked by the Application Control component, appManifest.xml is
indicated as the blocked app in the report.
When adding the standard Notepad application to an Application Control rule for Windows 11, it is not
recommended to specify the path to the application. On computers running Windows 11, the operating
system uses Metro Notepad located in the folder C:\Program
Files\WindowsApps\Microsoft.WindowsNotepad*\Notepad\Notepad.exe. In previous versions of the
operating system, Notepad is located in the following folders:
C:\Windows\notepad.exe
C:\Windows\System32\notepad.exe
C:\Windows\SysWOW64\notepad.exe
When adding Notepad to an Application Control rule, you can specify the application name and the le
hash from the properties of the running application, for example.

Device Control
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Access to Printer devices that were added to the trusted list is blocked by device and bus blocking rules.
For MTP devices, control of Read, Write, and Connect operations is supported if you are using the built-in
Microsoft drivers of the operating system. If a user installs a custom driver for working with a device (for
example, as part of iTunes or Android Debug Bridge), control of Read and Write operations may not work.
When working with MTP devices, access rules are changed after reconnecting the device.
If you are adding a device to the trusted list based on a model mask and use characters that are included in
the ID but not in the model name, these devices are not added. On a workstation, these devices will be
added to the trusted list based on an ID mask.
Web Control

The OGV and WEBM formats are not supported.
The RTMP protocol is not supported.
Adaptive Anomaly Control

It is recommended to create exclusions automatically based on the event. When manually adding an
exclusion, add the * character to the beginning of the path when specifying the target object.
An Adaptive Anomaly Control Rules report cannot be generated if the sample includes even one event
whose name contains more than 260 characters.
Adding exclusions from Adaptive Anomaly Control Triggering of Rules repository is not supported if the
properties of an object or a process have a value consisting of more than 256 characters (for example,
path to target object). You can add an exclusion manually in the Policy settings. You can also add an
exclusion in the Report on triggered Adaptive Anomaly Control rules.
Drive Encryption (FDE)
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After installing the application, you must restart the operating system for hard drive encryption to work
properly.
The Authentication Agent does not support hieroglyphics or the special characters | and \.
For optimal computer performance after encryption, it is required that the processor supports AES-NI
instruction set (Intel Advanced Encryption Standard New Instructions). If the processor does not support
AES-NI, computer performance might decrease.
When there are processes that attempt to access encrypted devices before the application has granted
access to such devices, the application shows a warning stating that such processes must be terminated.
If the processes cannot be terminated, re-connect the encrypted devices.
The unique IDs of hard drives are displayed in the device encryption statistics in inverted format.
It is not recommended to format devices while they are being encrypted.
When multiple removable drives are simultaneously connected to a computer, the encryption policy can be
applied to only one removable drive. When the removable devices are reconnected, the encryption policy is
applied correctly.
Encryption may fail to start on a heavily fragmented hard drive. Defragment the hard drive.
When hard drives are encrypted, hibernation is blocked from the time when the encryption task starts until
the rst restart of a computer running Microsoft Windows 7/8/8.1/10, and after installation of hard drive
encryption until the rst restart of Microsoft Windows 8/8.1/10 operating systems. When hard drives are
decrypted, hibernation is blocked from the time when the boot drive is fully decrypted until the rst restart
of the operating system. When the Quick Start option is enabled in Microsoft Windows 8/8.1/10, blocking
of hibernation prevents you from shutting down the operating system.
Windows 7 computers don't allow to change password during recovery when the disk is encrypted with
BitLocker technology. After the recovery key is entered and the operating system is loaded, Kaspersky
Endpoint Security won't prompt the user to change the password or PIN code. Thus, it is impossible to set
a new password or a PIN code. This issue stems from the peculiarities of the operating system. To continue,
you need to re-encrypt the hard drive.
It is not recommended to use the xbootmgr.exe tool with additional providers enabled. For example,
Dispatcher, Network, or Drivers.
Formatting an encrypted removable drive is not supported on a computer that has Kaspersky Endpoint
Security for Windows installed.
Formatting an encrypted removable drive with the FAT32 le system is not supported (the drive is
displayed as encrypted). To format a drive, reformat it to the NTFS le system.
For details on restoring an operating system from a backup copy to an encrypted GPT device, visit the
Technical Support Knowledge Base .
Multiple download agents cannot co-exist on one encrypted computer.
It is impossible to access a removable drive that was previously encrypted on a di erent computer when all
of the following conditions are simultaneously met:
There is no connection to the Kaspersky Security Center server.
The user is attempting authorization with a new token or password.
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If a similar situation occurs, restart the computer. After the computer has been restarted, access to the
encrypted removable drive will be granted.
Discovery of USB devices by the Authentication Agent may not be supported when xHCI mode for USB is
enabled in BIOS settings.
Kaspersky Disk Encryption (FDE) for the SSD part of a device that is used for caching the most frequently
used data is not supported for SSHD devices.
Encryption of hard drives in 32-bit Microsoft Windows 8/8.1/10 operating systems running in UEFI mode is
not supported.
Restart the computer before encrypting a decrypted hard drive again.
Hard drive encryption is not compatible with Kaspersky Anti-Virus for UEFI. It is not recommended to use
hard drive encryption on computers that have Kaspersky Anti-Virus for UEFI installed.
Creating Authentication Agent accounts based on Microsoft accounts is supported with the following
limitations:
Single Sign-On technology is not supported.
Automatic creation of Authentication Agent accounts is not supported if the option to create
accounts for users who log in to the system in the last N days is selected.
If the name of an Authentication Agent account has the format <domain>/<Windows account name>,
after changing the computer name you need to also change the names of accounts that were created for
local users of this computer. For example, imagine that there is a local user Ivanov on the Ivanov
computer, and an Authentication Agent account with the name Ivanov/Ivanov has been created for this
user. If the computer name Ivanov has been changed to Ivanov-PC, you need to change the name of the
Authentication Agent account for the user Ivanov from Ivanov/Ivanov to Ivanov-PC/Ivanov. You
can change the account name using the local account management task of the Authentication Agent.
Before the name of the account has been changed, authentication in the preboot environment is possible
using the old name (for example, Ivanov/Ivanov).
If a user is allowed to access a computer that was encrypted using Kaspersky Disk Encryption technology
only by using a token and this user needs to complete the access recovery procedure, make sure that this
user is granted password-based access to this computer after access to the encrypted computer has
been restored. The password that the user set when restoring access might not be saved. In this case, the
user will have to complete the procedure for restoring access to the encrypted computer again the next
time the computer is restarted.
When decrypting a hard drive using the FDE Recovery Tool, the decryption process may end with an error
if data on the source device is overwritten with the decrypted data. Part of the data on the hard drive will
remain encrypted. It is recommended to choose the option to save decrypted data to a le in the device
decryption settings when using the FDE Recovery Tool.
If the Authentication Agent password has been changed, a message containing the text Your password has
been changed successfully. Click OK appears and the user restarts the computer, the new password is not
saved. The old password must be used for subsequent authentication in the preboot environment.
Disk encryption is incompatible with Intel Rapid Start technology.
Disk encryption is incompatible with ExpressCache technology.
In some cases, when attempting to decrypt an encrypted drive using the FDE Recovery Tool, the tool
mistakenly detects the device status as "unencrypted" after the "Request-Response" procedure is
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completed. The tool's log shows an event stating that the device was successfully decrypted. In this case,
you must restart the data recovery procedure to decrypt the device.
After the Kaspersky Endpoint Security for Windows plug-in is updated in the Web Console, the client
computer properties do not show the BitLocker recovery key until the Web Console service is restarted.
To see the other limitations of full disk encryption support and a list of devices for which encryption of
hard drives is supported with restrictions, please refer to the Technical Support Knowledge Base .
File Level Encryption (FLE)
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File and folder encryption is not supported in operating systems of the Microsoft Windows Embedded
family.
Once you have installed the application, you must restart the operating system for le and folder
encryption to work properly.
If an encrypted le is stored on a computer that has available encryption functionality and you access the
le from a computer where encryption is not available, direct access to this le will be provided. An
encrypted le that is stored in a network folder on a computer that has available encryption functionality is
copied in decrypted form to a computer that does not have available encryption functionality.
You are advised to decrypt les that were encrypted with Encrypting File System before encrypting les
with Kaspersky Endpoint Security for Windows.
After a le is encrypted, its size increases by 4 kB.
After a le is encrypted, the Archive attribute is set in the le properties.
If an unpacked le from an encrypted archive has the same name as an already existing le on your
computer, the latter will be overwritten by the new le that is unpacked from an encrypted archive. The
user is not noti ed about the overwrite operation.
The Portable File Manager interface does not display messages about errors that occur during its
operation.
Kaspersky Endpoint Security for Windows does not start the Portable File Manager on a computer that
has the File Level Encryption component installed.
You cannot use the Portable File Manager to access a removable drive if the following conditions are true
simultaneously:
There is no connection to Kaspersky Security Center;
Kaspersky Endpoint Security for Windows is installed on the computer;
Data encryption (FDE or FLE) was not performed on the computer.
Access is impossible even if you know the password of the Portable File Manager.
When le encryption is used, the application is incompatible with the Sylpheed mail client.
Kaspersky Endpoint Security for Windows does not support the rules of restriction of access to
encrypted les for some applications. This is due to the fact that some le operations are performed by a
third-party application. For example, le copying is performed by the le manager, not by the application
itself. In this way, if access to encrypted les is denied to the Outlook mail client, Kaspersky Endpoint
Security will allow the mail client to access the encrypted le, if the user has copied les to the email
message via the clipboard or using the drag-and-drop function. The copy operation was performed by a
le manager, for which the rules of restriction of access to encrypted les are not speci ed, i.e. the access
is allowed.
When removable drives are encrypted with portable mode support, password age control cannot be
disabled.
Changing the page le settings is not supported. The operating system uses the default values instead of
the speci ed parameter values.
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Use safe removal when working with encrypted removable drives. We cannot guarantee data integrity if the
removable drive is not safely removed.
After les are encrypted, their non-encrypted originals are securely deleted.
Synchronization of o line les using Client-Side Caching (CSC) is not supported. It is recommended to
prohibit o line management of shared resources at the group policy level. Files that are in o line mode can
be edited. After synchronization, changes made to an o line le may be lost. For details regarding support
for Client-Side Caching (CSC) when using encryption, please refer to the Technical Support Knowledge
Base .
Creation of an encrypted archive in the root of the system hard drive is not supported.
You may experience problems when accessing encrypted les over the network. You are advised to move
the les to a di erent source or make sure that the computer being used as a le server is managed by the
same Kaspersky Security Center Administration Server.
Changing the keyboard layout may cause the password entry window for an encrypted self-extracting
archive to hang. To solve this problem, close the password entry window, switch the keyboard layout in your
operating system, and re-enter the password for the encrypted archive.
When le encryption is used on systems that have multiple partitions on one disk, you are advised to use
the option that automatically determines the size of the page le.sys le. After the computer restarts, the
page le.sys le may move between disk partitions.
After applying le encryption rules, including les in the My Documents folder, make sure that users for
whom encryption has been applied can successfully access encrypted les. To do so, have each user sign
in to the system when a connection to Kaspersky Security Center is available. If a user attempts to access
encrypted les without a connection to Kaspersky Security Center, the system may hang.
If system les are somehow included in the scope of le level encryption, events regarding errors when
encrypting these les may appear in reports. The les speci ed in these events are not actually encrypted.
Pico processes are not supported.
Case-sensitive paths are not supported. When encryption rules or decryption rules are applied, the paths
in product events are displayed in lowercase.
It is not recommended to encrypt les that are used by the system on startup. If these les are encrypted,
an attempt to access encrypted les without a connection to Kaspersky Security Center may cause the
system to hang or result in prompts for access to unencrypted les.
If users jointly work with a le over the network under FLE rules via applications that use the le-tomemory mapping method (such as WordPad or FAR) and applications designed for working with large les
(such as Notepad ++ ), the le in unencrypted form may be blocked inde nitely without the capability to
access it from the computer on which it resides.
File encryption in OneDrive sync folders is not supported. Adding folders with already encrypted les to
the OneDrive sync list may result in loss of data in the encrypted les.
When the le level encryption component is installed, management of users and groups does not work in
WSL mode (Windows Subsystem for Linux).
When the le level encryption component is installed, POSIX (Portable Operating System Interface) for
renaming and deleting les is not supported.
It is not recommended to encrypt temporary les, as this can cause data loss. For example, Microsoft
Word creates temporary les when processing a document. If temporary les are encrypted, but the
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original le is not, the user may receive an Access Denied error when trying to save the document.
Additionally, Microsoft Word might save the le, but it will not be possible to open the document the next
time, i.e. the data will be lost. To prevent data loss, you need to exclude the temporary les folder from
encryption rules.
After updating Kaspersky Endpoint Security for Windows version 11.0.1 or earlier, to access encrypted les
after restarting the computer, make sure that the Network Agent is running. Network Agent has a delayed
startup, so you cannot access the encrypted les immediately after the operating system loads. There is
no need to wait for the Network Agent to start after the next computer startup.
Other limitations
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Web addresses that are added to the trusted list may be incorrectly processed.
System Watcher. Complete information about processes is not displayed.
When Kaspersky Endpoint Security for Windows is started for the rst time, a digitally signed application
may be temporarily placed into the wrong group. The digitally signed application will later be put into the
correct group.
When scanning mail with the Mail Threat Protection extension for Microsoft Outlook, you are advised to
use Cached Exchange Mode (the Use Cached Exchange Mode option).

Virus Scan task does not support 64-bit Microsoft Outlook version. This means that Kaspersky Endpoint
Security does not check Outlook x64 les (PST and OST les) even if mail is included in scan scope.
In Kaspersky Security Center 10, when switching from using the global Kaspersky Security Network to using
a private Kaspersky Security Network, or vice versa, the option to participate in Kaspersky Security
Network is disabled in the policy of the speci c product. After switching, carefully read the text of the
Kaspersky Security Network Statement and con rm your consent to participate in KSN. You can read the
text of the Statement in the application interface or when editing the product policy.
During a rescan of a malicious object that was blocked by third-party software, the user is not noti ed
when the threat is detected again. The threat re-detection event is displayed in the product report and in
the Kaspersky Security Center 10 report.
The Endpoint Sensor component cannot be installed in Microsoft Windows Server 2008.
The Kaspersky Security Center 10 report on device encryption will not include information about devices
that were encrypted using Microsoft BitLocker on server platforms or on workstations on which the
Device Control component is not installed.
It is not possible to enable the display of all report entries in the Kaspersky Security Center Web Console.
In the Web Console, you can only change the number of entries displayed in reports. By default, Kaspersky
Security Center Web Console shows 1000 report entries. You can enable the display of all report entries in
the Administration Console (MMC).
It is not possible to set the display of more than 1000 report entries in the Kaspersky Security Center
Console. If you set a higher value than 1000, the Kaspersky Security Center Console will display only 1000
report entries.
When using a policy hierarchy, the settings of the Encryption of Removable Drives section in a child policy
are accessible for editing if the parent policy prohibits modi cation of those settings.
You must enable Audit Logon in the operating system settings to ensure proper functioning of exclusions
for the protection of shared folders against external encryption.
If shared folder protection is enabled, Kaspersky Endpoint Security for Windows monitors attempts to
encrypt shared folders for each remote access session that was started before the startup of Kaspersky
Endpoint Security for Windows, including if the computer from which the remote access session was
started has been added to exclusions. If you do not want Kaspersky Endpoint Security for Windows to
monitor attempts to encrypt shared folders for remote access sessions that were started from a
computer that was added to exclusions and that were started before the startup of Kaspersky Endpoint
Security for Windows, terminate and re-establish the remote access session or restart the computer on
which Kaspersky Endpoint Security for Windows is installed.
If the update task is run with the permissions of a speci c user account, product patches will not be
downloaded when updating from a source that requires authorization.
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The application may fail to start due to insu icient system performance. To resolve this problem, use the
Ready Boot option or increase the operating system timeout for starting services.
The application cannot work in Safe Mode.
To ensure that Kaspersky Endpoint Security for Windows versions 11.5.0 and 11.6.0 can work correctly with
Cisco AnyConnect software, you must install Compliance Module version 4.3.183.2048 or later. Learn more
about compatibility with Cisco Identity Services Engine in Cisco documentation .
We cannot guarantee that Audio Control will work until after the rst restart after installing the application.
In the Administration Console (MMC), in the Intrusion Prevention settings in the window for con guring
application permissions, the Remove button is unavailable. You can remove an application from a trust
group via the context menu of the application.
In the local interface of the application, in the Intrusion Prevention settings, application permissions and
protected resources are not available for viewing if the computer is managed by a policy. Scroll, search,
lter and other window controls are unavailable. You can view application permissions in the policy
properties in the Kaspersky Security Center Console.
When rotated trace les are enabled, no traces are created for the AMSI component and the Outlook
plug-in.
Performance traces cannot be manually collected in Windows Server 2008.
Performance traces for the "Restart" trace type are not supported.
Dump logging is not supported for pico processes.
The KSN availability check task is no longer supported.
Turning o the "Disable external management of the system services" option will not allow you to stop the
service of the application that was installed with the AMPPL=1 parameter (by default, the parameter value
is set to 1 starting with the Windows 10RS2 operating system version). The AMPPL parameter with a value
of 1 enables the use of Protection Processes technology for the product service.
To run a custom scan of a folder, the user that starts the custom scan must have the permissions to read
the attributes of this folder. Otherwise the custom folder scan will be impossible and will end with an error.
When a scan rule de ned in a policy includes a path without the \ character at the end, for example,
С:\folder1\folder2, the scan will be run for the path С:\folder1\.
When upgrading the application from version 11.1.0 to 11.7.0, the AMSI Protection settings are reset to their
default values.
If you are using software restriction policies (SRP), the computer may fail to load (black screen). You are
advised to change the SRP settings as follows: set the All software les except libraries (such as DLL)
value for the Apply software restriction policies to the following objects parameter, and add rules with
the Unrestricted security level for paths to les of the application (C:\Program Files\Common
Files\Kaspersky Lab and C:\Program Files\Kaspersky Lab). For details on using SRP, refer to the
Microsoft documentation .
Management of Outlook plug-in settings via Rest API is not supported.
Task run settings for a speci c user cannot be transferred between devices via a con guration le. After
settings are applied from a con guration le, manually specify the user name and password.
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After installing an update, the integrity check task does not work until the system is restarted to apply the
update.
When the rotated tracing level is changed through the remote diagnostics utility, Kaspersky Endpoint
Security for Windows incorrectly displays a blank value for the trace level. However, trace les are written
according to the correct trace level. When the rotated tracing level is changed through the local interface
of the application, the tracing level is correctly modi ed but the remote diagnostics utility incorrectly
displays the trace level that was last de ned by the utility. This may cause the administrator to not have
up-to-date information about the current tracing level, and relevant information may be absent from
traces if a user manually changes the tracing level in the local interface of the application.
In the local interface, Password protection settings don't allow changing the name of the administrator
account (KLAdmin by default). To change the name of the administrator account, you need to disable
Password protection, then enable Password protection and specify a new name of the administrator
account.
Kaspersky Endpoint Security monitors HTTP tra ic that complies with the RFC 2616, RFC 7540, RFC 7541,
RFC 7301 standards. If Kaspersky Endpoint Security detects another data exchange format in HTTP
tra ic, the application blocks this connection to prevent downloading malicious les from the Internet.
When scanning an encrypted connection, Kaspersky Endpoint Security forces HTTP/1.
You cannot scan an object quarantined as a result of the Move le to Quarantine task.
Kaspersky Endpoint Security does not run IOC Scan tasks on network drives if the folder path in the task
properties begins with a drive letter. Kaspersky Endpoint Security supports only the UNC path format for
IOC Scan tasks on network drives. For example, \\server\shared_folder.
An import of an application con guration le ends with an error if the integration with Kaspersky Sandbox
setting is enabled in the con guration le. Prior to exporting application settings, disable Kaspersky
Sandbox. Then perform the export/import procedure. After importing the con guration le, enable
Kaspersky Sandbox.
When an indicator of compromise is detected while running the IOC Scan task, the application quarantines
a le only for the FileItem term. Quarantining a le for other terms is not supported.
It is not possible to quarantine an Alternate Data Stream (ADS) that is larger than 4 MB. Kaspersky
Endpoint Security skips such ADS without notifying the user.
To manage alert details, you will need the web plug-in for Kaspersky Endpoint Security for Windows 11.7.0 or
later. Alert details are needed by Endpoint Detection and Response solution (EDR Optimum and EDR
Expert). Alert details are available only in Kaspersky Security Center Web Console and Kaspersky Security
Center Cloud Console.
The Kaspersky Endpoint Security application when installed on a Windows Server 2019 server is
incompatible with Docker. Deploying Docker containers on a computer with Kaspersky Endpoint Security
causes a crash (BSOD).
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Glossary

Active key
A key that is currently used by the application.

Additional key
A key that certi es the right to use the application but is not currently being used.

Administration group
A set of devices that share common functions and a set of Kaspersky applications installed on them. Devices are
grouped so that they can be managed conveniently as a single unit. A group may include other groups. It is possible
to create group policies and group tasks for each installed application in the group.

Anti-virus databases
Databases that contain information about computer security threats known to Kaspersky as of the anti-virus
database release date. Anti-virus database signatures help to detect malicious code in scanned objects. Anti-virus
databases are created by Kaspersky specialists and updated hourly.

Archive
One or several les packed into a single compressed le. A specialized application called an archiver is required for
packing and unpacking data.

Authentication Agent
Interface that lets you complete authentication to access encrypted hard drives and load the operating system
after the bootable hard drive has been encrypted.

Certi cate issuer
Certi cation center that issued the certi cate.

Database of malicious web addresses
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A list of web addresses whose content may be considered to be dangerous. The list is created by Kaspersky
specialists. It is regularly updated and is included in the Kaspersky application distribution kit.

Database of phishing web addresses
A list of web addresses which Kaspersky specialists have determined to be phishing-related. The database is
regularly updated and is part of the Kaspersky application distribution kit.

Disinfection
A method of processing infected objects that results in complete or partial recovery of data. Not all infected
objects can be disinfected.

False alarm
A false alarm occurs when the Kaspersky application reports an uninfected le as infected because the signature
of the le is similar to that of a virus.

Infectable le
A le which, due to its structure or format, can be used by intruders as a "container" to store and spread malicious
code. As a rule, these are executable les, with such le extensions as .com, .exe, and .dll. There is a fairly high risk of
intrusion of malicious code in such les.

Infected le
A le which contains malicious code (code of known malware has been detected when scanning the le).
Kaspersky does not recommend using such les, because they may infect your computer.

IOC
Indicator of Compromise A set of data about a malicious object or activity.

IOC le
A le containing a set of indicators of compromise (IOCs) that the application tries to match to count a detection.
The likelihood of detection can be higher if exact matches with multiple IOC les are found for the object as a
result of the scan.

License certi cate
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A document that Kaspersky transfers to the user together with the key le or activation code. It contains
information about the license granted to the user.

Mask
Representation of a le name and extension by using wildcards.
File masks can contain any characters that are allowed in le names, including wildcards:
The * (asterisk) character, which takes the place of any set of characters, except the \ and / characters
(delimiters of the names of les and folders in paths to les and folders). For example, the mask C:\*\*.txt
will include all paths to les with the TXT extension located in folders on the C: drive, but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an empty set) in the le or
folder name, including the \ and / characters (delimiters of the names of les and folders in paths to les and
folders). For example, the mask C:\Folder\**\*.txt will include all paths to les with the TXT extension
located in the folder named Folder and its subfolders. The mask must include at least one nesting level. The
mask C:\**\*.txt is not a valid mask. The ** mask is available only for creating scan exclusions.
The ? (question mark) character, which takes the place of any single character, except the \ and / characters
(delimiters of the names of les and folders in paths to les and folders). For example, the mask
C:\Folder\???.txt will include paths to all les residing in the folder named Folder that have the TXT
extension and a name consisting of three characters.

Network Agent
A Kaspersky Security Center component that enables interaction between the Administration Server and
Kaspersky applications that are installed on a speci c network node (workstation or server). This component is
common for all Kaspersky applications running under Windows. Dedicated versions of Network Agent are intended
for applications running under other operating systems.

Normalized form of the address of a web resource
The normalized form of the address of a web resource is a textual representation of a web resource address that is
obtained through normalization. Normalization is a process whereby the textual representation of a web resource
address changes according to speci c rules (for example, exclusion of the user login, password, and connection
port from the text representation of the web resource address; additionally, the web resource address is changed
from uppercase to lowercase characters).
Regarding the operation of protection components, the purpose of normalization of web resource addresses is to
avoid scanning website addresses, which may di er in syntax while being physically equivalent, more than once.
Example:
Non-normalized form of an address: www.Example.com\.
Normalized form of an address: www.example.com.
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OLE object
An attached le or a le that is embedded in another le. Kaspersky applications allow scanning OLE objects for
viruses. For example, if you insert a Microsoft O ice Excel® table into a Microsoft O ice Word document, the
table is scanned as an OLE object.

OpenIOC
Open standard of Indicator of Compromise (IOC) descriptions based on XML and including over 500 di erent
Indicators of Compromise.

Portable File Manager
This is an application that provides an interface for working with encrypted les on removable drives when
encryption functionality is not available on the computer.

Protection scope
Objects that are constantly being scanned by the Essential Threat Protection component when it is running. The
protection scopes of di erent components have di erent properties.

Scan scope
Objects that Kaspersky Endpoint Security scans while performing a scan task.

Task
Functions performed by the Kaspersky application as tasks, for example: Real-time File Protection, Full Device
Scan, Database Update.

Trusted Platform Module
A microchip developed to provide basic functions related to security (for example, for storing encryption keys). A
Trusted Platform Module is usually installed on the computer motherboard and interacts with all other system
components via the hardware bus.
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Appendices
This section contains information that supplements the body of the document.

Appendix 1. Application settings
You can use a policy, tasks, or the application interface to con gure Kaspersky Endpoint Security. Detailed
information about application components is provided in the corresponding sections.

File Threat Protection
The File Threat Protection component lets you prevent infection of the le system of the computer. By default,
the File Threat Protection component permanently resides in the computer's RAM. The component scans les on
all drives of the computer, as well as on connected drives. The component provides computer protection with the
help of anti-virus databases, the Kaspersky Security Network cloud service, and heuristic analysis.
The component scans the les accessed by the user or application. If a malicious le is detected, Kaspersky
Endpoint Security blocks the le operation. The application then disinfects or deletes the malicious le, depending
on the settings of the File Threat Protection component.
When attempting to access a le whose contents are stored in the OneDrive cloud, Kaspersky Endpoint
Security downloads and scans the le contents.
File Threat Protection component settings

Parameter

Security level

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

Description

For File Threat Protection, Kaspersky Endpoint Security can apply di erent groups of
settings. These groups of settings that are stored in the application are called security
levels:
High. When this le security level is selected, the File Threat Protection component
takes the strictest control of all les that are opened, saved, and started. The File
Threat Protection component scans all le types on all hard drives, removable drives,
and network drives of the computer. It also scans archives, installation packages, and
embedded OLE objects.
Recommended. This le security level is recommended by Kaspersky Lab experts. The
File Threat Protection component scans only the speci ed le formats on all hard
drives, removable drives, and network drives of the computer, and embedded OLE
objects. The File Threat Protection component does not scan archives or installation
packages.
Low. The settings of this le security level ensure maximum scanning speed. The File
Threat Protection component scans only les with speci ed extensions on all hard
drives, removable drives, and network drives of the computer. The File Threat
Protection component does not scan compound les.

File types

All les. If this setting is enabled, Kaspersky Endpoint Security checks all les without
exception (all formats and extensions).
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(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

Files scanned by format. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . Before scanning a le for malicious code, the internal header of the
le is analyzed to determine the format of the le (for example, .txt, .doc, or .exe). The scan
also looks for les with particular le extensions.

File Threat
Protection
scope

Contains objects that are scanned by the File Threat Protection component. A scan object
may be a hard drive, removable drive, network drive, folder, le, or multiple les de ned by a
mask.

Files scanned by extension. If this setting is enabled, Kaspersky Endpoint Security scans
infectable les only . The le format is then determined based on the le's extension.

By default, the File Threat Protection component scans les that are started on any hard
drives, removable drives, or network drives. The protection scope for these objects cannot
be changed or deleted. You can also exclude an object (such as removable drives) from
scans.
Machine
learning and
signature
analysis

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)
Heuristic
Analysis

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)
Action on
threat
detection

The machine learning and signature analysis method uses the Kaspersky Endpoint Security
databases that contain descriptions of known threats and ways to neutralize them.
Protection that uses this method provides the minimum acceptable security level.
Based on the recommendations of Kaspersky experts, machine learning and signature
analysis is always enabled.

The technology was developed for detecting threats that cannot be detected by using the
current version of Kaspersky application databases. It detects les that may be infected
with an unknown virus or a new variety of a known virus.
When scanning les for malicious code, the heuristic analyzer executes instructions in the
executable les. The number of instructions that are executed by the heuristic analyzer
depends on the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.

Disinfect; delete if disinfection fails. If this option is selected, Kaspersky Endpoint
Security automatically attempts to disinfect all infected les that are detected. If
disinfection fails, Kaspersky Endpoint Security deletes the les.
Disinfect; block if disinfection fails. If this option is selected, Kaspersky Endpoint Security
automatically attempts to disinfect all infected les that are detected. If disinfection is not
possible, Kaspersky Endpoint Security adds the information about the infected les that
are detected to the list of active threats.
Block. If this option is selected, the File Threat Protection component automatically blocks
all infected les without attempting to disinfect them.
Before attempting to disinfect or delete an infected le, Kaspersky Endpoint Security
creates a backup copy of the le in case you need to restore the le or if it can be
disinfected in the future.
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Scan only
new and
changed les

Scans only new les and those les that have been modi ed since the last time they were
scanned. This helps reduce the duration of a scan. This mode applies both to simple and to
compound les.

Scan archives

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE. Kaspersky
Endpoint Security scans archives not only by le extension, but also by format.

Scan
distribution
packages

This check box enables/disables scanning of third-party distribution packages.

Scan les in
Microsoft
O ice
formats

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft extensions).
O ice format les include OLE objects as well.

Do not
unpack large
compound
les

If this check box is selected, Kaspersky Endpoint Security does not scan compound les if
their size exceeds the speci ed value.
If this check box is cleared, Kaspersky Endpoint Security scans compound les of all sizes.
Kaspersky Endpoint Security scans large les that are extracted from archives
regardless of whether the check box is ticked or not.

Unpack
compound
les in the
background

If the check box is selected, Kaspersky Endpoint Security provides access to compound
les that are larger than the speci ed value before these les are scanned. In this case,
Kaspersky Endpoint Security unpacks and scans compound les in the background.
Kaspersky Endpoint Security provides access to compound les that are smaller than this
value only after unpacking and scanning these les.
If the check box is not selected, Kaspersky Endpoint Security provides access to
compound les only after unpacking and scanning les of any size.

Scan mode

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

Kaspersky Endpoint Security scans les accessed by the user, operating system, or an
application running under the user's account.
Smart mode. In this mode, File Threat Protection scans an object based on an analysis of
actions taken on the object. For example, when working with a Microsoft O ice document,
Kaspersky Endpoint Security scans the le when it is rst opened and last closed.
Intermediate operations that overwrite the le do not cause it to be scanned.
On access and modi cation. In this mode, File Threat Protection scans objects whenever
there is an attempt to open or modify them.
On access. In this mode, File Threat Protection scans objects only upon an attempt to
open them.
On execution. In this mode, File Threat Protection only scans objects upon an attempt to
run them.

iSwift
Technology

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scanning by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date that the le was last scanned on,
and any modi cations to the scanning settings. The iSwift technology is an advancement
of the iChecker technology for the NTFS le system.
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(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)
iChecker
Technology

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)
Pause File
Threat
Protection

This technology allows increasing scan speed by excluding certain les from scanning. Files
are excluded from scans by using a special algorithm that takes into account the release
date of Kaspersky Endpoint Security databases, the date when the le was last scanned,
and any modi cations to the scan settings. There are limitations to iChecker Technology: it
does not work with large les and applies only to les with a structure that the application
recognizes (for example, EXE, DLL, LNK, TTF, INF, SYS, COM, CHM, ZIP, and RAR).

This temporarily and automatically pauses operation of File Threat Protection at the
speci ed time or when working with the speci ed applications.

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

Web Threat Protection
The Web Threat Protection component prevents downloads of malicious les from the Internet, and also blocks
malicious and phishing websites. The component provides computer protection with the help of anti-virus
databases, the Kaspersky Security Network cloud service, and heuristic analysis.
Kaspersky Endpoint Security scans HTTP-, HTTPS- and FTP-tra ic. Kaspersky Endpoint Security scans URLs and
IP addresses. You can specify the ports that Kaspersky Endpoint Security will monitor, or select all ports.
For HTTPS tra ic monitoring, you need to enable encrypted connections scan.
When a user tries to open a malicious or phishing website, Kaspersky Endpoint Security will block access and show
a warning (see the gure below).
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Website access denied message
Web Threat Protection component settings

Parameter

Security level

(available only in
the
Administration
Console (MMC)
and in the
Kaspersky
Endpoint
Security
interface)

Description

For Web Threat Protection, Kaspersky Endpoint Security can apply di erent groups of
settings. These groups of settings that are stored in the application are called security
levels:
High. The security level under which the Web Threat Protection component performs
maximum scanning of web tra ic that the computer receives over the HTTP and FTP
protocols. Web Threat Protection performs detailed scanning of all web tra ic
objects by using the full set of application databases, and performs the deepest
possible heuristic analysis .
Recommended. The security level that provides the optimal balance between the
performance of Kaspersky Endpoint Security and the security of web tra ic. The
Web Threat Protection component performs heuristic analysis at the medium scan
level. This web tra ic security level is recommended by Kaspersky specialists.
Low. The settings of this web tra ic security level ensure the maximum web tra ic
scanning speed. The Web Threat Protection component performs heuristic analysis at
the light scan level.

Action on
threat
detection

Block download. If this option is selected and an infected object is detected in web
tra ic, the Web Threat Protection component blocks access to the object and displays a
message in the browser.
Inform. If this option is selected and an infected object is detected in web tra ic,
Kaspersky Endpoint Security allows this object to be downloaded to the computer but
adds information about the infected object to the list of active threats.

Check the web
address
against the
database of

Scanning the links to determine whether they are included in the database of malicious
web addresses allows you to track websites that have been added to denylist. The
database of malicious web addresses is maintained by Kaspersky, included in the
585

malicious web
addresses

application installation package, and updated during Kaspersky Endpoint Security
database updates.

(available only in
the
Administration
Console (MMC)
and in the
Kaspersky
Endpoint
Security
interface)
Use Heuristic
Analysis

(available only in
the
Administration
Console (MMC)
and in the
Kaspersky
Endpoint
Security
interface)
Check the web
address
against the
database of
phishing web
addresses

The technology was developed for detecting threats that cannot be detected by using
the current version of Kaspersky application databases. It detects les that may be
infected with an unknown virus or a new variety of a known virus.
When web tra ic is scanned for viruses and other applications that present a threat, the
heuristic analyzer performs instructions in the executable les. The number of
instructions that are executed by the heuristic analyzer depends on the level that is
speci ed for the heuristic analyzer. The heuristic analysis level ensures a balance between
the thoroughness of searching for new threats, the load on the resources of the
operating system, and the duration of heuristic analysis.

The database of phishing web addresses includes the web addresses of currently known
websites that are used to launch phishing attacks. Kaspersky supplements this database
of phishing links with addresses obtained from the international organization known as
the Anti-Phishing Working Group. The database of phishing addresses is included in the
application installation package and supplemented with Kaspersky Endpoint Security
database updates.

(available only in
the
Administration
Console (MMC)
and in the
Kaspersky
Endpoint
Security
interface)
Do not scan
web tra ic
from trusted
web addresses

If the check box is selected, the Web Threat Protection component does not scan the
content of web pages or websites whose addresses are included in the list of trusted
web addresses. You can add both the speci c address and the address mask of a web
page/website to the list of trusted web addresses.

Mail Threat Protection
The Mail Threat Protection component scans the attachments of incoming and outgoing email messages for
viruses and other threats. The component also scans messages for malicious and phishing links. By default, the Mail
Threat Protection component permanently resides in the computer's RAM and scans all messages received or
sent using the POP3, SMTP, IMAP, or NNTP protocols, or the Microsoft O ice Outlook mail client (MAPI). The
component provides computer protection with the help of anti-virus databases, the Kaspersky Security Network
cloud service, and heuristic analysis.
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The Mail Threat Protection component does not scan messages if the mail client is open in a browser.
When a malicious le is detected in an attachment, Kaspersky Endpoint Security renames the message subject as
follows: [Message is infected] <message subject> or [Infected object deleted] <message
subject>.
This component interacts with mail clients installed on the computer. For the Microsoft O ice Outlook mail client,
an extension with additional parameters is provided. The Mail Threat Protection extension is embedded in the
Microsoft O ice Outlook mail client during installation of Kaspersky Endpoint Security.
Mail Threat Protection component settings

Parameter

Security level

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

Description

For Mail Threat Protection, Kaspersky Endpoint Security applies di erent groups of
settings. These groups of settings that are stored in the application are called security
levels:
High. When this email security level is selected, the Mail Threat Protection component
scans email messages most thoroughly. The Mail Threat Protection component scans
incoming and outgoing email messages, and performs deep heuristic analysis. The High
mail security level is recommended for high-risk environments. An example of such an
environment is a connection to a free email service from a home network that is not
guarded by centralized email protection.
Recommended. The email security level that provides the optimal balance between the
performance of Kaspersky Endpoint Security and email security. The Mail Threat
Protection component scans incoming and outgoing email messages, and performs
medium-level heuristic analysis. This mail tra ic security level is recommended by
Kaspersky specialists.
Low. When this email security level is selected, the Mail Threat Protection component
only scans incoming email messages, performs light heuristic analysis, and does not
scan archives that are attached to email messages. At this mail security level, the Mail
Threat Protection component scans email messages at maximum speed and uses a
minimum of operating system resources. The Low mail security level is recommended
for use in a well-protected environment. An example of such an environment might be
an enterprise LAN with centralized email security.

Action on
threat
detection

Disinfect; delete if disinfection fails. When an infected object is detected in an inbound
or outbound message, Kaspersky Endpoint Security attempts to disinfect the detected
object. The user will be able to access the message with a safe attachment. If the object
cannot be disinfected, Kaspersky Endpoint Security deletes the infected object. Kaspersky
Endpoint Security adds information about the performed action to the message subject:
[Infected object was deleted] <message subject>.
Disinfect; block if disinfection fails. When an infected object is detected in an inbound
message, Kaspersky Endpoint Security attempts to disinfect the detected object. The
user will be able to access the message with a safe attachment. If the object cannot be
disinfected, Kaspersky Endpoint Security adds a warning to the message subject:
[Message infected] <message subject>. The user will be able to access the
message with the original attachment. When an infected object is detected in an outbound
message, Kaspersky Endpoint Security attempts to disinfect the detected object. If the
object cannot be disinfected, Kaspersky Endpoint Security blocks transmission of the
message, and the mail client shows an error.
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Block. If an infected object is detected in an inbound message, Kaspersky Endpoint
Security adds a warning to the message subject: [Message infected] <message
subject>. The user will be able to access the message with the original attachment. If an
infected object is detected in an outbound message, Kaspersky Endpoint Security blocks
transmission of the message, and the mail client shows an error.
Protection
scope

The Protection scope includes objects that the component checks when it is run:
Incoming and outgoing messages or Incoming messages only.

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

In order to protect your computers, you need only scan incoming messages. You can turn
on scanning for outgoing messages to prevent infected les from being sent in archives.
You can also turn on the scanning of outgoing messages if you want to prevent les in
particular formats from being sent, such as audio and video les, for example.

Scan POP3,
SMTP, NNTP,
and IMAP
tra ic

The check box enables / disables scanning by the Mail Threat Protection component of
tra ic that is transferred via the POP3, SMTP, NNTP, and IMAP protocols.

Connect
Microsoft
Outlook
extension

If the check box is selected, scanning of email messages transmitted via the POP3, SMTP,
NNTP, IMAP protocols is enabled on the side of the extension integrated into Microsoft
Outlook.

Heuristic
Analysis

The technology was developed for detecting threats that cannot be detected by using the
current version of Kaspersky application databases. It detects les that may be infected
with an unknown virus or a new variety of a known virus.

(available only
in the
Administration
Console
(MMC) and in
the Kaspersky
Endpoint
Security
interface)

If mail is scanned using the extension for Microsoft Outlook, it is recommended to use
Cached Exchange Mode. For more detailed information about Cached Exchange Mode and
recommendations on its use, refer to the Microsoft Knowledge Base.

When scanning les for malicious code, the heuristic analyzer executes instructions in the
executable les. The number of instructions that are executed by the heuristic analyzer
depends on the level that is speci ed for the heuristic analyzer. The heuristic analysis level
ensures a balance between the thoroughness of searching for new threats, the load on the
resources of the operating system, and the duration of heuristic analysis.

Scan
attached
archives

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE.

Scan
attached les
of O ice
formats

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft extensions).
O ice format les include OLE objects as well.

Do not scan
archives

If this check box is selected, the Mail Threat Protection component excludes archives
attached to email messages from scanning if their size exceeds the speci ed value. If the

If during the scan, Kaspersky Endpoint Security detects a password for an archive in
the text of the message, this password will be used to scan the content of the archive
for malicious applications. In this case, the password is not saved. An archive is
unpacked during scan. If an application error occurs during the unpacking process, you
can manually delete the unpacked les that are saved to the following path:
%systemroot%\temp. The les have the PR pre x.
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larger than N
MB

check box is cleared, the Mail Threat Protection component scans email attachment
archives of any size.

Limit the time
for checking
archives to N
sec

If the check box is selected, the time that is allocated for scanning archives attached to
email messages is limited to the speci ed period.

Attachment
lter

The attachment lter is not applied to outgoing email messages.
Disable ltering. If this option is selected, the Mail Threat Protection component does not
lter les that are attached to email messages.
Rename attachments of selected types. If this option is selected, the Mail Threat
Protection component will replace the last extension character found in the attached les
of the speci ed types with the underscore character (for example, attachment.doc_).
Thus, in order to open the le, the user must rename the le.
Delete attachments of selected types. If this option is selected, the Mail Threat
Protection component deletes attached les of the speci ed types from email messages.
In the list of le masks, you can specify the types of attached les to rename or delete
from email messages.

Network Threat Protection
The Network Threat Protection component scans inbound network tra ic for activity that is typical of network
attacks. When Kaspersky Endpoint Security detects an attempted network attack on the user's computer, it
blocks the network connection with the attacking computer. Descriptions of currently known types of network
attacks and ways to counteract them are provided in Kaspersky Endpoint Security databases. The list of network
attacks that the Network Threat Protection component detects is updated during database and application
module updates.
Network Threat Protection component settings

Parameter

Description

Treat port
scanning
and
network
ooding as
attacks

Network Flooding is an attack on network resources of an organization (such as web servers).
This attack consists of sending a large number of requests to overload the bandwidth of
network resources. When this happens, users are unable to access the network resources of
the organization.
A Port Scanning attack consists of scanning UDP ports, TCP ports, and network services on
the computer. This attack allows the attacker to identify the degree of vulnerability of the
computer before conducting more dangerous types of network attacks. Port Scanning also
enables the attacker to identify the operating system on the computer and select the
appropriate network attacks for this operating system.
If this check box is selected, Kaspersky Endpoint Security monitors network tra ic to detect
these attacks. When an attack is detected, the application lters and blocks the tra ic
associated with the attack. This way, if a Network Flooding attack is launched against the
computer, the application reduces the load on the resource being attacked. If a Port
Scanning attack is launched against the computer, Kaspersky Endpoint Security prevents
data leaks on the computer.
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You can disable detection of these types of attacks in case some of your allowed
applications perform operations that are typical for these types of attacks. This will help
avoid false alarms.
Add an
attacking
computer
to the list
of blocked
computers
for N
minutes

If the check box is selected, the Network Threat Protection component adds the attacking
computer to the blocked list. This means that the Network Threat Protection component
blocks the network connection with the attacking computer after the rst network attack
attempt for the speci ed amount of time. This block automatically protects the user's
computer against possible future network attacks from the same address.
You can view the block list in the Network Monitor tool window.
Kaspersky Endpoint Security clears the block list when the application is restarted and
when the Network Threat Protection settings are changed.

Exclusions

The list contains IP addresses from which Network Threat Protection does not block network
attacks.
Kaspersky Endpoint Security does not log information on network attacks from the IP
addresses that are in the list of exclusions.

MAC
Spoo ng
Protection

A MAC spoo ng attack consists of changing the MAC address of a network device (network
card). As a result, an attacker can redirect data sent to a device to another device and gain
access to this data. Kaspersky Endpoint Security lets you block MAC Spoo ng attacks and
receive noti cations about the attacks.

Firewall
The Firewall blocks unauthorized connections to the computer while working on the Internet or local network. The
Firewall also controls the network activity of applications on the computer. This allows you to protect your
corporate LAN from identity theft and other attacks. The component provides computer protection with the help
of anti-virus databases, the Kaspersky Security Network cloud service, and prede ned network rules.
Network Agent is used for interaction with Kaspersky Security Center. Firewall automatically creates network
rules required for the application and the Network Agent to work. As a result, the Firewall opens several ports
on the computer. Which ports are opened depends on computer's role (for example, distribution point). To
learn more about the ports that will be opened on the computer, refer to the Kaspersky Security Center
Help .

Network rules
You can con gure network rules at the following levels:

Network packet rules. Network packet rules impose restrictions on network packets, regardless of the
application. Such rules restrict inbound and outbound network tra ic through speci c ports of the selected
data protocol. Kaspersky Endpoint Security has prede ned network packet rules with permissions
recommended by Kaspersky experts.
Application network rules. Application network rules impose restrictions on the network activity of a speci c
application. They factor in not only the characteristics of the network packet, but also the speci c application
to which this network packet is addressed or which issued this network packet.
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Controlled access of applications to operating system resources, processes and personal data is provided by
the Host Intrusion Prevention component by using application rights.
During the rst startup of the application, the Firewall performs the following actions:
1. Checks the security of the application using downloaded anti-virus databases.
2. Checks the security of the application in Kaspersky Security Network.
You are advised to participate in Kaspersky Security Network to help the Firewall work more e ectively.
3. Puts the application in one of the trust groups: Trusted, Low Restricted, High Restricted, Untrusted.
A trust group de nes the rights that Kaspersky Endpoint Security refers to when controlling application
activity. Kaspersky Endpoint Security places an application in a trust group depending on the level of danger
that this application may pose to the computer.
Kaspersky Endpoint Security places an application in a trust group for the Firewall and Host Intrusion
Prevention components. You cannot change the trust group only for the Firewall or Host Intrusion
Prevention.

If you refused to participate in KSN or there is no network, Kaspersky Endpoint Security places the
application in a trust group depending on the settings of the Host Intrusion Prevention component. After
receiving the reputation of the application from KSN, the trust group can be changed automatically.
4. It blocks network activity of the application depending on the trust group. For example, applications in the High
Restricted trust group are not allowed to use any network connections.
The next time the application is started, Kaspersky Endpoint Security checks the integrity of the application. If the
application is unchanged, the component uses the current network rules for it. If the application has been
modi ed, Kaspersky Endpoint Security analyzes the application as if it were being started for the rst time.

Network Rule Priorities
Each rule has a priority. The higher a rule is on the list, the higher its priority. If network activity is added to several
rules, the Firewall regulates network activity according to the rule with the highest priority.
Network packet rules have a higher priority than network rules for applications. If both network packet rules and
network rules for applications are speci ed for the same type of network activity, the network activity is handled
according to the network packet rules.
Network rules for applications work as follows: a network rule for applications includes access rules based on the
network status: public, local, or trusted. For example, applications in the High Restricted trust group are not allowed
any network activity in networks of all statuses by default. If a network rule is speci ed for an individual application
(parent application), then the child processes of other applications will run according to the network rule of the
parent application. If there is no network rule for the application, the child processes will run according to network
access rule of the application's trust group.
For example, you have prohibited any network activity in networks of all statuses for all applications, except
browser X. If you start browser Y installation (child process) from browser X (parent application), then browser Y
installer will access the network and download the necessary les. After installation, browser Y will be denied any
network connections according to the Firewall settings. To prohibit network activity of browser Y installer as a child
process, you must add a network rule for the installer of browser Y.
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Network connection statuses
The Firewall allows you to control network activity depending on the status of the network connection. Kaspersky
Endpoint Security receives the network connection status from the computer's operating system. The status of
the network connection in the operating system is set by the user when setting up the connection. You can change
the status of the network connection in the Kaspersky Endpoint Security settings. The Firewall will monitor
network activity depending on the network status in the Kaspersky Endpoint Security settings, and not in the
operating system.
The network connection can have one of the following status types:
Public network. The network is not protected by antivirus applications, rewalls, or lters (such as Wi-Fi in a
cafe). When the user operates a computer that is connected to such a network, Firewall blocks access to les
and printers of this computer. External users are also unable to access data through shared folders and remote
access to the desktop of this computer. Firewall lters the network activity of each application according to
the network rules that are set for it.
Firewall assigns Public network status to the Internet by default. You cannot change the status of the Internet.
Local network. Network for users with restricted access to les and printers on this computer (such as for a
corporate LAN or home network).
Trusted network. Safe network in which the computer is not exposed to attacks or unauthorized data access
attempts. Firewall permits any network activity within networks with this status.
Firewall component settings

Parameter

Network
packet rules

Description

Table with a list of network packet rules. Network packet rules serve to impose
restrictions on network packets, regardless of the application. Such rules restrict inbound
and outbound network tra ic through speci c ports of the selected data protocol.
The table lists pre-con gured network packet rules that are recommended by Kaspersky
for optimum protection of the network tra ic of computers that run on Microsoft
Windows operating systems.
Firewall sets the execution priority of each network packet rule. Firewall processes
network packet rules in the order in which they appear in the list of network packet
rules, from top to bottom. Firewall locates the topmost network packet rule that is
suitable for the network connection and applies it by either allowing or blocking network
activity. Firewall then ignores all subsequent network packet rules for the speci c
network connection.
Network packet rules have higher priority than network rules for applications.

Network
connections

This table contains information about network connections that Firewall detects on the
computer.
The Public network status is assigned to the Internet by default. You cannot change
the status of the Internet.

Network
rules

Applications
Table of applications that are controlled by the Firewall component. Applications are
assigned to trust groups. A trust group de nes the rights used by Kaspersky Endpoint
Security when controlling network activity of applications.
You can select an application from a single list of all applications installed on computers
under the in uence of a policy and add the application to a trust group.
592

Network rules
Table of network rules for applications that are part of a trust group. In accordance with
these rules, Firewall regulates the network activity of applications.
The table displays the prede ned network rules that are recommended by Kaspersky
experts. These network rules have been added to optimally protect the network tra ic of
computers running Windows operating systems. It is not possible to delete the
prede ned network rules.

BadUSB Attack Prevention
Some viruses modify the rmware of USB devices to trick the operating system into detecting the USB device as a
keyboard. As a result, the virus may execute commands under your user account to download malware, for
example.
The BadUSB Attack Prevention component prevents infected USB devices emulating a keyboard from connecting
to the computer.
When a USB device is connected to the computer and identi ed as a keyboard by the operating system, the
application prompts the user to enter a numerical code generated by the application from this keyboard or using
On-Screen Keyboard if available (see the gure below). This procedure is known as keyboard authorization.
If the code has been entered correctly, the application saves the identi cation parameters – VID/PID of the
keyboard and the number of the port to which it has been connected – in the list of authorized keyboards.
Keyboard authorization does not need to be repeated when the keyboard is reconnected or after the operating
system is restarted.
When the authorized keyboard is connected to a di erent USB port of the computer, the application shows a
prompt for authorization of this keyboard again.
If the numerical code has been entered incorrectly, the application generates a new code. You can con gure the
number of attempts for entering the numerical code. If the numerical code is entered incorrectly several times or
the keyboard authorization window is closed (see gure below), the application blocks input from this keyboard.
When the USB device blocking time elapses or the operating system is restarted, the application prompts the user
to perform keyboard authorization again.
The application allows use of an authorized keyboard and blocks a keyboard that has not been authorized.
The BadUSB Attack Prevention component is not installed by default. If you need the BadUSB Attack
Prevention component, you can add the component in the properties of the installation package before
installing the application or change the available application components after installing the application.
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Keyboard authorization
BadUSB Attack Prevention component settings

Parameter

Description

Prohibit use
of OnScreen
Keyboard for
authorization
of USB
devices

If the check box is selected, the application blocks use of On-Screen Keyboard for
authorization of a USB device from which an authorization code cannot be entered.

Maximum
number of
device
authorization
attempts

Automatically blocking the USB device if the authorization code is entered incorrectly the
speci ed number of times. Valid values are 1 to 10. For example, if you allow 5 attempts to
enter the authorization code, the USB device is blocked after the fth failed attempt.
Kaspersky Endpoint Security displays the blocking duration for the USB device. After this
time elapses, you can have 5 attempts to enter the authorization code.

Timeout
when
reaching the
maximum
number of
attempts
(minutes)

Blocking duration of the USB device after the speci ed number of failed attempts to enter
the authorization code. Valid values are 1 to 180 (minutes).

AMSI Protection
AMSI Protection component is intended to support Antimalware Scan Interface from Microsoft. The Antimalware
Scan Interface (AMSI) allows third-party applications with AMSI support to send objects (for example, PowerShell
scripts) to Kaspersky Endpoint Security for an additional scan and then receive the results from scanning these
objects. Third-party applications may include, for example, Microsoft O ice applications (see the gure below). For
details on AMSI, please refer to the Microsoft documentation .
The AMSI Protection can only detect a threat and notify a third-party application about the detected threat.
Third-party application after receiving a noti cation of a threat does not allow to perform malicious actions (for
example, terminates).
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AMSI operation example

AMSI Protection component may decline a request from a third-party application, for example, if this
application exceeds maximum number of requests within a speci ed interval. Kaspersky Endpoint Security
sends information about a rejected request from a third-party application to the Administration Server. AMSI
Protection component does not reject requests from those third-party applications for which the Do not
block interaction with AMSI Protection component check box is selected.
AMSI Protection is available for the following operating systems for workstations and servers:
Windows 10 Home / Pro / Pro for Workstations / Education / Enterprise;
Windows 11;
Windows Server 2016 Essentials / Standard / Datacenter;
Windows Server 2019 Essentials / Standard / Datacenter;
Windows Server 2022.
AMSI Protection settings

Parameter

Description

Scan archives

Scans archives in the following formats: RAR, ARJ, ZIP, CAB, LHA, JAR, and ICE.

Scan distribution
packages

This check box enables/disables scanning of third-party distribution packages.

Scan les in
Microsoft O ice
formats

Scans Microsoft O ice les (DOC, DOCX, XLS, PPT and other Microsoft
extensions). O ice format les include OLE objects as well.

Do not unpack large
compound les

If this check box is selected, Kaspersky Endpoint Security does not scan
compound les if their size exceeds the speci ed value.
If this check box is cleared, Kaspersky Endpoint Security scans compound les
of all sizes.
Kaspersky Endpoint Security scans large les that are extracted from archives
regardless of whether the check box is ticked or not.

Exploit Prevention
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The Exploit Prevention component detects program code that takes advantage of vulnerabilities on the computer
to exploit administrator privileges or to perform malicious activities. For example, exploits can utilize a bu er
over ow attack. To do so, the exploit sends a large amount of data to a vulnerable application. When processing
this data, the vulnerable application executes malicious code. As a result of this attack, the exploit can start an
unauthorized installation of malware. When there is an attempt to run an executable le from a vulnerable
application that was not performed by the user, Kaspersky Endpoint Security blocks this le from running or
noti es the user.
Exploit Prevention component settings

Parameter

On detecting
exploit

Description

Block operation. If this option is selected, on detection of an exploit Kaspersky
Endpoint Security blocks the actions attempted by the exploit.
Inform. If this option is selected and an exploit is detected, Kaspersky Endpoint
Security does not block the actions of the exploit but adds information about this
exploit to the list of active threats.

Enable system
process memory
protection

If this toggle button is switched on, Kaspersky Endpoint Security blocks external
processes that attempt to access system process memory.

Behavior Detection
The Behavior Detection component receives data on the actions of applications on your computer and provides
this information to other protection components to improve their performance. The Behavior Detection
component utilizes Behavior Stream Signatures (BSS) for applications. If application activity matches a behavior
stream signature, Kaspersky Endpoint Security performs the selected responsive action. Kaspersky Endpoint
Security functionality based on behavior stream signatures provides proactive defense for the computer.
Behavior Detection component settings

Parameter

On detecting
malware
activity

Description

Delete le. If this option is selected, on detecting malicious activity Kaspersky
Endpoint Security deletes the executable le of the malicious application and
creates a backup copy of the le in Backup.
Terminate the application. If this option is selected, on detecting malicious activity
Kaspersky Endpoint Security terminates this application.
Inform. If this option is selected and malicious activity of an application is
detected, Kaspersky Endpoint Security does not terminate this application but
adds information about the malicious activity of this application to the list of active
threats.

Enable
protection of
shared folders
against external
encryption

If the toggle button is switched on, Kaspersky Endpoint Security analyzes activity in
shared folders. If this activity matches a behavior stream signature that is typical for
external encryption, Kaspersky Endpoint Security performs the selected action.
Kaspersky Endpoint Security prevents external encryption of only those les that
are located on media that have the NTFS le system and are not encrypted by the
EFS system.
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Inform. If this option is selected, on detecting an attempt to modify les in shared
folders, Kaspersky Endpoint Security adds information about this attempt to
modify les in shared folders to the list of active threats.
Block connection for N min. If this option is selected, when Kaspersky Endpoint
Security detects an attempt to modify les in shared folders, it blocks the network
activity of the computer that is attempting to modify the les and creates backup
copies of modi ed les.
If the Remediation Engine component is enabled and the Block connection for N
min option is selected, modi ed les are restored from backup copies.

Exclusions

List of computers from which attempts to encrypt shared folders will not be monitored.
To apply the list of exclusions of computers from protection of shared folders
against external encryption, you must enable Audit Logon in the Windows security
audit policy. Audit Logon is disabled by default. For more details about a Windows
security audit policy, please visit the Microsoft website .

Host Intrusion Prevention
The Host Intrusion Prevention component prevents applications from performing actions that may be dangerous
for the operating system, and ensures control over access to operating system resources and personal data. The
component provides computer protection with the help of anti-virus databases and the Kaspersky Security
Network cloud service.
The component controls the operation of applications by using application rights. Application rights include the
following access parameters:
Access to operating system resources (for example, automatic startup options, registry keys)
Access to personal data (such as les and applications)
Network activity of applications is controlled by the Firewall using network rules.
During the rst startup of the application, the Host Intrusion Prevention component performs the following
actions:
1. Checks the security of the application using downloaded anti-virus databases.
2. Checks the security of the application in Kaspersky Security Network.
You are advised to participate in Kaspersky Security Network to help the Host Intrusion Prevention
component work more e ectively.
3. Puts the application in one of the trust groups: Trusted, Low Restricted, High Restricted, Untrusted.
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A trust group de nes the rights that Kaspersky Endpoint Security refers to when controlling application
activity. Kaspersky Endpoint Security places an application in a trust group depending on the level of danger
that this application may pose to the computer.
Kaspersky Endpoint Security places an application in a trust group for the Firewall and Host Intrusion
Prevention components. You cannot change the trust group only for the Firewall or Host Intrusion
Prevention.

If you refused to participate in KSN or there is no network, Kaspersky Endpoint Security places the
application in a trust group depending on the settings of the Host Intrusion Prevention component. After
receiving the reputation of the application from KSN, the trust group can be changed automatically.
4. Blocks application actions depending on the trust group. For example, applications from the High Restricted
trust group are denied access to the operating system modules.
The next time the application is started, Kaspersky Endpoint Security checks the integrity of the application. If the
application is unchanged, the component uses the current application rights for it. If the application has been
modi ed, Kaspersky Endpoint Security analyzes the application as if it were being started for the rst time.
Host Intrusion Prevention component settings

Parameter

Application
rights

Description

Applications
Table of applications that are monitored by the Host Intrusion Prevention component.
Applications are assigned to trust groups. A trust group de nes the rights that
Kaspersky Endpoint Security refers to when controlling application activity.
You can select an application from a single list of all applications installed on computers
under the in uence of a policy and add the application to a trust group.
Application access rights are presented in the following tables:
Files and system registry. This table contains the rights of applications within a
trust group to access operating system resources and personal data.
Rights. This table contains the rights of applications in a trust group to access
processes and resources of the operating system.
Network rules. Table of network rules for applications that are part of a trust
group. In accordance with these rules, Firewall regulates the network activity of
applications. The table displays the prede ned network rules that are recommended
by Kaspersky experts. These network rules have been added to optimally protect
the network tra ic of computers running Windows operating systems. It is not
possible to delete the prede ned network rules.

Protected
resources

Name
The table contains categorized computer resources. The Host Intrusion Prevention
component monitors attempts by other applications to access resources in the table.
A resource can be a registry category, le or folder, or registry key.
Applications
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Table of applications monitored by the Host Intrusion Prevention component for the
selected resource. Applications are assigned to trust groups. A trust group de nes the
rights that Kaspersky Endpoint Security refers to when controlling application activity.
Trust group for
applications
launched before
Kaspersky
Endpoint
Security for
Windows starts
working
Update rights for
previously
unknown
applications
from KSN
database
Trust digitally
signed
applications

A trust group in which Kaspersky Endpoint Security will place applications that are
started before Kaspersky Endpoint Security.

If the check box is selected, the Host Intrusion Prevention component updates rights
for previously unknown applications by using the Kaspersky Security Network database.

If this check box is selected, the Host Intrusion Prevention component places the
applications with the digital signature of trusted vendors in the Trusted group.

Trusted vendors are those software vendors that are trusted by Kaspersky. You can
also add vendor certi cate to the trusted certi cate store manually.
If this check box is cleared, the Host Intrusion Prevention component does not consider
such applications to be trusted, and uses other parameters to determine their trust
group.

Delete rules for
applications that
have not been
started for
longer than N
days

If the check box is selected, Kaspersky Endpoint Security automatically deletes
information about the application (trust group and access rights) if the following
conditions are met:
You manually put the application into a trust group or con gured its access rights.
The application has not started within the de ned period of time.
If the trust group and rights of an application were determined automatically, Kaspersky
Endpoint Security deletes information about this application after 30 days. It is not
possible to change the storage term for application information or turn o automatic
deletion.
The next time you start this application, Kaspersky Endpoint Security analyzes the
application as if it were starting for the rst time.

Trust group for
applications that
could not be
added to existing
groups

Items in this drop-down list determine to which trust group Kaspersky Endpoint
Security will assign an unknown application.
You can choose one of the following items:
Low Restricted.
High Restricted.
Untrusted.

Remediation Engine
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The Remediation Engine lets Kaspersky Endpoint Security roll back actions that have been performed by malware
in the operating system.
When rolling back malware activity in the operating system, Kaspersky Endpoint Security handles the following
types of malware activity:
File activity
Kaspersky Endpoint Security performs the following actions:
Deletes executable les that were created by malware (on all media except network drives).
Deletes executable les that were created by programs that have been in ltrated by malware.
Restores les that have been modi ed or deleted by malware.
The le recovery feature has a number of limitations.
Registry activity
Kaspersky Endpoint Security performs the following actions:
Deletes registry keys that were created by malware.
Does not restore registry keys that have been modi ed or deleted by malware.
System activity
Kaspersky Endpoint Security performs the following actions:
Terminates processes that have been initiated by malware.
Terminates processes into which a malicious application has penetrated.
Does not resume processes that have been halted by malware.
Network activity
Kaspersky Endpoint Security performs the following actions:
Blocks the network activity of malware.
Blocks the network activity of processes that have been in ltrated by malware.
A rollback of malware actions can be started by the File Threat Protection or Behavior Detection component, or
during a virus scan.
Rolling back malware operations a ects a strictly de ned set of data. Rollback has no adverse e ects on the
operating system or on the integrity of your computer data.

Kaspersky Security Network
To protect your computer more e ectively, Kaspersky Endpoint Security uses data that is received from users
around the globe. Kaspersky Security Network is designed for obtaining this data.
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Kaspersky Security Network (KSN) is an infrastructure of cloud services providing access to the online Kaspersky
Knowledge Base that contains information about the reputation of les, web resources, and software. The use of
data from Kaspersky Security Network ensures faster responses by Kaspersky Endpoint Security to new threats,
improves the performance of some protection components, and reduces the likelihood of false positives. If you are
participating in Kaspersky Security Network, KSN services provide Kaspersky Endpoint Security with information
about the category and reputation of scanned les, as well as information about the reputation of scanned web
addresses.
Use of Kaspersky Security Network is voluntary. The application prompts you to use KSN during initial
con guration of the application. Users can begin or discontinue participation in KSN at any time.
For more detailed information about sending Kaspersky statistical information that is generated during
participation in KSN, and about the storage and destruction of such information, please refer to the Kaspersky
Security Network Statement and the Kaspersky website . The ksn_<language ID>.txt le with the text of the
Kaspersky Security Network Statement is included in the application distribution kit.
To reduce the load on KSN servers, Kaspersky experts may release application updates that temporarily disable or
partly restrict requests to Kaspersky Security Network. In this case, the status of the connection to KSN in the
local interface of the application is Enabled with restrictions.

KSN Infrastructure
Kaspersky Endpoint Security supports the following KSN infrastructural solutions:

Global KSN is the solution that is used by most Kaspersky applications. KSN participants receive information
from Kaspersky Security Network and send Kaspersky information about objects detected on the user's
computer to be analyzed additionally by Kaspersky analysts and to be included in the reputation and statistical
databases of Kaspersky Security Network.
Private KSN is a solution that enables users of computers hosting Kaspersky Endpoint Security or other
Kaspersky applications to obtain access to reputation databases of Kaspersky Security Network, and to other
statistical data without sending data to KSN from their own computers. Private KSN is designed for corporate
customers who are unable to participate in Kaspersky Security Network for any of the following reasons:
Local workstations are not connected to the Internet.
Transmission of any data outside the country or outside the corporate LAN is prohibited by law or restricted
by corporate security policies.
By default, Kaspersky Security Center uses Global KSN. You can con gure the use of Private KSN in the
Administration Console (MMC), in the Kaspersky Security Center Web Console, and in the command line. It is
not possible to con gure the use of Private KSN in the Kaspersky Security Center Cloud Console.
For more details about Private KSN, please refer to the documentation on Kaspersky Private Security Network.

KSN Proxy
User computers managed by Kaspersky Security Center Administration Server can interact with KSN via the KSN
Proxy service.
The KSN Proxy service provides the following capabilities:
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The user's computer can query KSN and submit information to KSN even without direct access to the Internet.
The KSN Proxy service caches processed data, thereby reducing the load on the external network
communication channel and speeding up receipt of the information that is requested by the user's computer.
For more details on the KSN Proxy service, please refer to the Kaspersky Security Center Help .
Kaspersky Security Network settings

Parameter

Description

Enable
extended
KSN mode

Extended KSN mode is a mode in which Kaspersky Endpoint Security sends additional data to
Kaspersky. Kaspersky Endpoint Security uses KSN to detect threats regardless of the toggle
position.

Enable
Cloud
mode

Cloud mode refers to the application operating mode in which Kaspersky Endpoint Security
uses a light version of anti-virus databases. Kaspersky Security Network supports the
operation of the application when light anti-virus databases are being used. The light version
of anti-virus databases lets you use approximately half of the computer RAM that would
otherwise be used with the usual databases. If you do not participate in Kaspersky Security
Network or if cloud mode is disabled, Kaspersky Endpoint Security downloads the full version
of anti-virus databases from Kaspersky servers.
If the toggle button is switched on, Kaspersky Endpoint Security uses the light version of antivirus databases, which reduces the load on operating system resources.
Kaspersky Endpoint Security downloads the light version of anti-virus databases during
the next update after the check box was selected.
If the toggle button is switched o , Kaspersky Endpoint Security uses the full version of antivirus databases.
Kaspersky Endpoint Security downloads the full version of anti-virus databases during
the next update after the check box was cleared.

Computer
status
when KSN
servers
are
unavailable

The items in this drop-down list determine the status of a computer in Kaspersky Security
Center when KSN servers are unavailable.

(available
only in the
Kaspersky
Security
Center
Console)
Use KSN
Proxy

If the check box is selected, Kaspersky Endpoint Security uses the KSN Proxy service. You can
con gure the KSN Proxy service settings in the Administration Server properties.

(available
only in the
Kaspersky
Security
Center
Console)
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Use KSN
servers
when KSN
Proxy is
not
available

If the check box is selected, Kaspersky Endpoint Security uses KSN servers when the KSN
Proxy service is unavailable. KSN servers may be located both on the side of Kaspersky (when
Global KSN is used) and on the side of third parties (when Private KSN is used).

(available
only in the
Kaspersky
Security
Center
Console)

Web Control
Web Control manages users' access to web resources. This helps reduce tra ic and inappropriate use of work
time. When a user tries to open a website that is restricted by Web Control, Kaspersky Endpoint Security will block
access or show a warning (see the gure below).
Kaspersky Endpoint Security monitors only HTTP- and HTTPS tra ic.
For HTTPS tra ic monitoring, you need to enable encrypted connections scan.

Methods for managing access to websites
Web Control lets you con gure access to websites by using the following methods:
Website category. Websites are categorized according to the Kaspersky Security Network cloud service,
heuristic analysis, and the database of known websites (included in application databases). For example, you
can restrict user access to the "Social networks" category or to other categories .
Data type. You can restrict users' access to data on a website, and hide graphic images, for example. Kaspersky
Endpoint Security determines the data type based on the le format and not based on its extension.
Kaspersky Endpoint Security does not scan les within archives. For example, if image les were placed in
an archive, Kaspersky Endpoint Security identi es the "Archives" data type and not "Graphic les".
Individual address. You can enter a web address or use masks.
You can simultaneously use multiple methods for regulating access to websites. For example, you can restrict
access to the "O ice les" data type just for the "Web-based mail" website category.

Website access rules
Web Control manages users' access to websites by using access rules. You can con gure the following advanced
settings for a website access rule:
Users to which the rule applies.
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For example, you can restrict Internet access through a browser for all users of the company except the IT
department.
Rule schedule.
For example, you can restrict Internet access through a browser during working hours only.

Access rule priorities
Each rule has a priority. The higher a rule is on the list, the higher its priority. If a website has been added to multiple
rules, Web Control regulates access to the website based on the rule with the highest priority. For example,
Kaspersky Endpoint Security may identify a corporate portal as a social network. To restrict access to social
networks and provide access to the corporate web portal, create two rules: one block rule for the "Social
networks" website category and one allow rule for the corporate web portal. The access rule for the corporate
web portal must have a higher priority than the access rule for social networks.

Web Control messages
Web Control component settings

Parameter

Description
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Rules of
access to
web
resources

List containing web resource access rules. Each rule has a priority. The higher a rule is on the
list, the higher its priority. If a website has been added to multiple rules, Web Control regulates
access to the website based on the rule with the highest priority.

Default
rule

The Default rule is a rule for accessing web resources that are not covered by any other rule.
The following options are available:
Allow all except the rules list, also known as denylist mode for prohibited websites.
Deny everything except the rules list, also known as allowlist mode for allowed websites.

Message
templates

Warning. The entry eld consists of a template of the message that is displayed if a rule
for warning about attempts to access an unwanted web resource is triggered.
Message about blocking. The entry eld contains the template of the message that
appears if a rule which blocks access to a web resource is triggered.
Message to administrator. The entry eld contains the template of the message to be
sent to the LAN administrator if the user considers the block to be a mistake.

Log the
opening
of allowed
pages

Kaspersky Endpoint Security logs data on visits to all websites, including allowed websites.
Kaspersky Endpoint Security sends events to Kaspersky Security Center, to the local log of
Kaspersky Endpoint Security, and to the Windows Event log. To monitor user Internet activity,
you need to con gure the settings for saving events.
Monitoring user Internet activity may require more computer resources when decrypting
HTTPS tra ic.

Device Control
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
Device Control manages user access to devices that are installed on or connected to the computer (for example,
hard drives, cameras, or Wi-Fi modules). This lets you protect the computer from infection when such devices are
connected, and prevent loss or leaks of data.

Device access levels
Device Control controls access at the following levels:
Device type. For example, printers, removable drives, and CD/DVD drives.
You can con gure device access as follows:
Allow – .
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Block – .
Depends on connection bus (except for Wi-Fi) – .
Block with exceptions (Wi-Fi only) – .
Connection bus. A connection bus is an interface used for connecting devices to the computer (for example,
USB or FireWire). Therefore, you can restrict the connection of all devices, for example, over USB.
You can con gure device access as follows:
Allow – .
Block – .
Trusted devices. Trusted devices are devices to which users that are speci ed in the trusted device settings
have full access at all times.
You can add trusted devices based on the following data:
Devices by ID. Each device has a unique identi er (Hardware ID, or HWID). You can view the ID in the device
properties by using operating system tools. Example device ID:
SCSI\CDROM&VEN_NECVMWAR&PROD_VMWARE_SATA_CD00\5&354AE4D7&0&000000. Adding devices by ID is
convenient if you want to add several speci c devices.
Devices by model. Each device has a vendor ID (VID) and a product ID (PID). You can view the IDs in the
device properties by using operating system tools. Template for entering the VID and PID:
VID_1234&PID_5678. Adding devices by model is convenient if you use devices of a certain model in your
organization. This way, you can add all devices of this model.
Devices by ID mask. If you are using multiple devices with similar IDs, you can add devices to the trusted list
by using masks. The * character replaces any set of characters. Kaspersky Endpoint Security does not
support the ? character when entering a mask. For example, WDC_C*.
Devices by model mask. If you are using multiple devices with similar VIDs or PIDs (for example, devices
from the same manufacturer), you can add devices to the trusted list by using masks. The * character
replaces any set of characters. Kaspersky Endpoint Security does not support the ? character when
entering a mask. For example, VID_05AC & PID_ *.
Device Control regulates user access to devices by using access rules. Device Control also lets you save device
connection/disconnection events. To save events, you need to con gure the registration of events in a policy.
If access to a device depends on the connection bus (the status), Kaspersky Endpoint Security does not
save device connection/disconnection events. To enable Kaspersky Endpoint Security to save device
connection/disconnection events, allow access to the corresponding type of device (the status) or add the
device to the trusted list.
When a device that is blocked by Device Control is connected to the computer, Kaspersky Endpoint Security will
block access and show a noti cation (see the gure below).
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Device Control noti cation

Device Control operating algorithm
Kaspersky Endpoint Security makes a decision on whether to allow access to a device after the user connects the
device to the computer (see the gure below).

Device Control operating algorithm
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If a device is connected and access is allowed, you can edit the access rule and block access. In this case, the next
time someone attempts to access the device (such as to view the folder tree, or perform read or write
operations), Kaspersky Endpoint Security blocks access. A device without a le system is blocked only the next
time that the device is connected.
If a user of the computer with Kaspersky Endpoint Security installed must request access to a device that the user
believes was blocked by mistake, send the user the request access instructions.
Device Control component settings

Parameter

Allow requests
for temporary
access

(available only in
the Kaspersky
Security Center
Console)

Description

If the check box is selected, the Request access button is available through the local
interface of Kaspersky Endpoint Security. Clicking this button opens the Request
access to device window. In this window, the user can request temporary access to a
blocked device.

Devices and
Wi-Fi networks

This table contains all possible types of devices according to the classi cation of the
Device Control component, including their respective access statuses.

Connection
buses

A list of all available connection buses according to the Device Control component's
classi cation, including their respective access statuses.

Trusted
devices

List of trusted devices and users who are granted access to these devices.

Anti-Bridging

Anti-Bridging inhibits the creation of network bridges by preventing the simultaneous
establishment of multiple network connections for a computer. This lets you protect a
corporate network from attacks over unprotected, unauthorized networks.
Anti-Bridging blocks the establishment of multiple connections according to the
priorities of devices. The higher a device is on the list, the higher its priority.
If an active connection and a new connection are both of the same type (for example,
Wi-Fi), Kaspersky Endpoint Security blocks the active connection and allows
establishment of the new connection.
If an active connection and a new connection are of di erent types (for example, a
network adapter and Wi-Fi), Kaspersky Endpoint Security blocks the connection with the
lower priority and allows the connection with the higher priority.
Anti-Bridging supports operation with the following types of devices: network adapter,
Wi-Fi, and modem.

Message
templates

Message about blocking. Template of the message that appears when a user
attempts to access a blocked device. This message also appears when a user
attempts to perform an operation on the device contents that was blocked for this
user.
Message to administrator. A template of the message that is sent to the LAN
administrator when the user believes that access to the device is blocked or an
operation with device content is forbidden by mistake.
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Application Control
Application Control manages the startup of applications on users' computers. This allows you to implement a
corporate security policy when using applications. Application Control also reduces the risk of computer infection
by restricting access to applications.
Con guring Application Control consists of the following steps:
1. Creating application categories.
The administrator creates categories of applications that the administrator wants to manage. Categories of
applications are intended for all computers in the corporate network, regardless of administration groups. To
create a category, you can use the following criteria: KL category (for example, Browsers), le hash, application
vendor, and other criteria.
2. Creating Application Control rules.
The administrator creates Application Control rules in the policy for the administration group. The rule includes
the categories of applications and the startup status of applications from these categories: blocked or allowed.
3. Selecting the Application Control mode.
The administrator chooses the mode for working with applications that are not included in any of the rules
(application denylist and allowlist).
When a user attempts to start a prohibited application, Kaspersky Endpoint Security will block the application from
starting and will display a noti cation (see the gure below).
A test mode is provided to check the con guration of Application Control. In this mode, Kaspersky Endpoint
Security does the following:
Allows the startup of applications, including prohibited ones.
Shows a noti cation about the startup of a prohibited application and adds information to the report on the
user's computer.
Sends data about the startup of prohibited applications to Kaspersky Security Center.

Application Control noti cation

Application Control operating modes
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The Application Control component operates in two modes:
Denylist. In this mode, Application Control allows users to start all applications except for applications that are
prohibited in Application Control rules.
This mode of Application Control is enabled by default.
Allowlist. In this mode, Application Control blocks users from starting any applications except for applications
that are allowed and not prohibited in Application Control rules.
If the allow rules of Application Control are fully con gured, the component blocks the startup of all new
applications that have not been veri ed by the LAN administrator, while allowing the operation of the operating
system and of trusted applications that users rely on in their work.
You can read the recommendations on con guring Application Control rules in allowlist mode.
Application Control can be con gured to operate in these modes both by using the Kaspersky Endpoint Security
local interface and by using Kaspersky Security Center.
However, Kaspersky Security Center o ers tools that are not available in the Kaspersky Endpoint Security local
interface, such as the tools that are needed for the following tasks:
Creating application categories.
Application Control rules created in the Kaspersky Security Center Administration Console are based on your
custom application categories and not on inclusion and exclusion conditions as is the case in the Kaspersky
Endpoint Security local interface.
Receiving information about applications that are installed on corporate LAN computers.
This is why it is recommended to use Kaspersky Security Center to con gure the operation of the Application
Control component.

Application Control operating algorithm
Kaspersky Endpoint Security uses an algorithm to make a decision about starting an application (see the gure
below).
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Application Control operating algorithm
Application Control component settings

Parameter

Test mode

Application
Startup
Control
mode

Description

If the toggle button is switched on, Kaspersky Endpoint Security allows the startup of an
application that is blocked in the current Application Control mode, but logs information
about its startup in the report.
You can choose one of the following options:
Denylist. If this option is selected, Application Control allows all users to start any
applications, except in cases that satisfy the conditions of Application Control block
rules.
Allowlist. If this option is selected, Application Control blocks all users from starting any
applications, except in cases that satisfy the conditions of Application Control allow
rules.
When Allowlist mode is selected, two Application Control rules are automatically created:
Golden Image.
Trusted Updaters.
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You cannot edit the settings of or delete automatically created rules. You can enable or
disable these rules.

Control
DLL
modules
load

If the check box is selected, Kaspersky Endpoint Security controls the loading of DLL
modules when users attempt to start applications. Information about the DLL module and
the application that loaded this DLL module is logged in the report.
When enabling control over the loading of DLL modules and drivers, make sure that one
of the following rules is enabled in the Application Control settings: the default Golden
Image rule or another rule that contains the "Trusted certi cates" KL category and
ensures that trusted DLL modules and drivers are loaded before Kaspersky Endpoint
Security is started. Enabling control of the loading of DLL modules and drivers when the
Golden Image rule is disabled may cause instability in the operating system.
Kaspersky Endpoint Security monitors only the DLL modules and drivers that have been
loaded since the check box was selected. After selecting the check box, it is recommended
to restart the computer to ensure that the application monitors all DLL modules and drivers,
including those loaded before Kaspersky Endpoint Security starts.

Message
templates

Message about blocking. Template of the message that is displayed when an Application
Control rule that blocks an application from starting is triggered.
Message to administrator. Template of the message that a user can send to the corporate
LAN administrator if the user believes that an application was blocked by mistake.

Adaptive Anomaly Control
This component is available only for Kaspersky Endpoint Security for Business Advanced and Kaspersky Total
Security for Business. For more details about Kaspersky Endpoint Security for Business, please visit the
Kaspersky website .

This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
The Adaptive Anomaly Control component monitors and blocks actions that are not typical of the computers in a
company's network. Adaptive Anomaly Control uses a set of rules to track uncharacteristic behavior (for example,
the Start of Microsoft PowerShell from o ice application rule). Rules are created by Kaspersky specialists based
on typical scenarios of malicious activity. You can con gure how Adaptive Anomaly Control handles each rule and,
for example, allow the execution of PowerShell scripts that automate certain work ow tasks. Kaspersky Endpoint
Security updates the set of rules along with the application databases. Updates to the sets of rules must be
con rmed manually.

Adaptive Anomaly Control settings
Con guring Adaptive anomaly control consists of the following steps:
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1. Training Adaptive Anomaly Control.
After you enable Adaptive Anomaly Control, its rules work in training mode. During the training, Adaptive
Anomaly Control monitors rule triggering and sends triggering events to Kaspersky Security Center. Each rule
has its own duration of the training mode. The duration of the training mode is set by Kaspersky experts.
Normally, the training mode is active for two weeks.
If a rule is not triggered at all during the training, Adaptive Anomaly Control will consider the actions associated
with this rule as non-typical. Kaspersky Endpoint Security will block all actions associated with that rule.
If a rule was triggered during training, Kaspersky Endpoint Security logs events in the rule triggering report and
the Triggering of rules in Smart Training state repository.
2. Analyzing the rule triggering report.
The administrator analyzes the rule triggering report or the contents of the Triggering of rules in Smart
Training state repository. Then the administrator can select the behavior of Adaptive Anomaly Control when
the rule is triggered: either block or allow. The administrator can also continue to monitor how the rule works and
extend the duration of the training mode. If the administrator does not take any action, the application will also
continue to work in training mode. The training mode term is restarted.
Adaptive Anomaly Control is con gured in real time. Adaptive Anomaly Control is con gured via the following
channels:
Adaptive Anomaly Control automatically starts to block the actions associated with the rules that were never
triggered in training mode.
Kaspersky Endpoint Security adds new rules or removes obsolete ones.
The administrator con gures the operation of the Adaptive Anomaly Control after reviewing the rule triggering
report and the contents of the Triggering of rules in Smart Training state repository. It is recommended to
check the rule triggering report and the contents of the Triggering of rules in Smart Training state repository.
When a malicious application attempts to perform an action, Kaspersky Endpoint Security will block the action and
display a noti cation (see gure below).

Adaptive Anomaly Control noti cation

Adaptive Anomaly Control operating algorithm
Kaspersky Endpoint Security decides whether to allow or block an action that is associated with a rule based on
the following algorithm (see the gure below).
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Adaptive Anomaly Control operating algorithm
Adaptive Anomaly Control component settings

Parameter

Report on Adaptive
Anomaly Control rules
state

Description

This report contains information about the status of Adaptive Anomaly Control
detection rules (for example, the O or Block). The report is generated for all
administration groups.

(available only in the
Kaspersky Security
Center Console)
Report on triggered
rules of Adaptive
Anomaly Control

This report contains information about non-typical actions detected using
Adaptive Anomaly Control. The report is generated for all administration groups.

(available only in the
Kaspersky Security
Center Console)
Rules
Templates

Adaptive Anomaly Control table of rules. Rules are created by Kaspersky
specialists based on typical scenarios of potentially malicious activity.
Message about blocking. Template of the message that is displayed to a
user when an Adaptive Anomaly Control rule that blocks a non-typical
action is triggered.
Message to administrator. Template of the message that a user can be
sent to the local corporate network administrator if the user considers the
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blocking to be a mistake.

Endpoint Sensor
Endpoint Sensor is not included in Kaspersky Endpoint Security 11.4.0.

You can manage the Endpoint Sensor in the Kaspersky Security Center Web Console and in the Kaspersky
Security Center Administration Console. It is not possible to manage Endpoint Sensor in the Kaspersky
Security Center Cloud Console.

Endpoint Sensor is designed to interact with Kaspersky Anti Targeted Attack Platform. Kaspersky Anti Targeted
Attack Platform is a solution designed for timely detection of sophisticated threats such as targeted attacks,
advanced persistent threats (APT), zero-day attacks, and others. Kaspersky Anti Targeted Attack Platform
includes two functional blocks: Kaspersky Anti Targeted Attack (hereinafter also referred to as "KATA") and
Kaspersky Endpoint Detection and Response (hereinafter also referred to as "KEDR"). You can purchase KEDR
separately. For details about the solution, please refer to the Kaspersky Anti Targeted Attack Platform Help .
Managing Endpoint Sensor has the following limitations:
You can con gure Endpoint Sensor settings in a policy provided that Kaspersky Endpoint Security version 11.0.0
to 11.3.0 is installed on the computer. For more information about con guring Endpoint Sensor settings using
the policy, refer to the help articles for the previous versions of Kaspersky Endpoint Security .
If Kaspersky Endpoint Security version 11.4.0 and later is installed on the computer, you cannot con gure
Endpoint Sensor settings in the policy.
Endpoint Sensor is installed on client computers. On these computers, the component constantly monitors
processes, active network connections, and les that are modi ed. Endpoint Sensor relays information to the
KATA server.
The component functionality is available under the following operating systems:
Windows 7 Service Pack 1 Home / Professional / Enterprise;
Windows 8.1.1 Professional / Enterprise;
Windows 10 RS3 Home / Professional / Education / Enterprise;
Windows 10 RS4 Home / Professional / Education / Enterprise;
Windows 10 RS5 Home / Professional / Education / Enterprise;
Windows 10 RS6 Home / Professional / Education / Enterprise;
Windows Server 2008 R2 Foundation / Standard / Enterprise (64-bit);
Windows Server 2012 Foundation / Standard / Enterprise (64-bit);
Windows Server 2012 R2 Foundation / Standard / Enterprise (64-bit);
615

Windows Server 2016 Essentials / Standard (64-bit).
For detailed information on KATA operation, refer to the Kaspersky Anti Targeted Attack Platform Help .

Kaspersky Sandbox
Kaspersky Endpoint Security 11.7.0 now includes the Kaspersky Sandbox component. The component enables
interoperability with the Kaspersky Sandbox solution. The Kaspersky Sandbox solution detects and automatically
blocks advanced threats on computers. Kaspersky Sandbox analyzes object behavior to detect malicious activity
and activity characteristic of targeted attacks on the IT infrastructure of the organization. Kaspersky Sandbox
analyzes and scans objects on special servers with deployed virtual images of Microsoft Windows operating
systems (Kaspersky Sandbox servers). For details about the solution, refer to the Kaspersky Sandbox Help.
The component can be managed only using the Kaspersky Security Center Web Console. You cannot manage
this component using the Administration Console (MMC).
Kaspersky Sandbox component settings

Parameter

Description

Server TLS
certi cate

To con gure a trusted connection with Kaspersky Sandbox servers, you must prepare a TLS
certi cate. Next you must add the certi cate to Kaspersky Sandbox servers and the
Kaspersky Endpoint Security policy. For details on preparing the certi cate and adding the
certi cate to servers, refer to the Kaspersky Sandbox Help.

Connection
timeout for
Kaspersky
Sandbox

Connection timeout for Kaspersky Sandbox server. After the con gured timeout elapses,
Kaspersky Endpoint Security sends a request to the next server. You can increase the
connection timeout for Kaspersky Sandbox if your connection speed is low or if the
connection is unstable. The default value is 5 seconds.

Kaspersky
Sandbox
request
queue

Size of the request queue folder. When an object is accessed on the computer (executable
launched or document opened, for example in DOCX or PDF format), Kaspersky Endpoint
Security can also send the object to be scanned by Kaspersky Sandbox. If there are multiple
requests, Kaspersky Endpoint Security creates a request queue. By default, the size of the
request queue folder is limited to 100 MB. After the maximum size is reached, Kaspersky
Sandbox stops adding new requests to the queue and sends the corresponding event to
Kaspersky Security Center. You can con gure the size of the request queue folder
depending on your server con guration.

Kaspersky
Sandbox
servers

Kaspersky Sandbox server connection settings. The servers use deployed virtual images of
Microsoft Windows operating systems to run objects that need to be scanned. You can enter
an IP address (IPv4 or IPv6) or a fully quali ed domain name.

Action on
threat
detection

Move copy to Quarantine, delete object. If this option is selected, Kaspersky Endpoint
Security deletes the malicious object found on the computer. Before deleting the object,
Kaspersky Endpoint Security creates a backup copy in case the object needs to be restored
later. Kaspersky Endpoint Security moves the backup copy to Quarantine.
Run scan of critical areas. If this option is selected, Kaspersky Endpoint Security runs the
Critical Areas Scan task. By default, Kaspersky Endpoint Security scans the kernel memory,
running processes, and disk boot sectors.
Run IOC scan. If this option is selected, Kaspersky Endpoint Security automatically creates
the IOC Scan task (autonomous IOC scan task). For this task, you can con gure the run
mode, scan scope, and action on IOC detection: delete object, run the Critical Areas Scan
task. To modify other settings of the IOC Scan task, go to the task settings.
616

IOC scan
scope

Critical le areas. If this option is selected, Kaspersky Endpoint Security does an IOC scan
only in critical le areas of the computer: kernel memory and boot sectors.
File areas on system drives of the device. IF this option is selected, Kaspersky Endpoint
Security does an IOC scan on the system drive of the computer.

Run IOC
scan

Manually. Run mode in which you can start the IOC scan task manually at a time of your
choosing.
After threat is detected. Run mode in which Kaspersky Endpoint Security runs the IOC Scan
task automatically whenever a threat is detected.
Run only when the computer is idle. Run mode in which Kaspersky Endpoint Security runs
the IOC Scan task if the screensaver is active or the screen is locked. If the user unlocks the
computer, Kaspersky Endpoint Security pauses the task. This means that the task can take
several days to complete.

Endpoint Detection and Response
Kaspersky Endpoint Security 11.7.0 now has a built-in agent for the Kaspersky Endpoint Detection and Response
Optimum solution (hereinafter also "EDR Optimum"). Kaspersky Endpoint Detection and Response Optimum is a
solution for protecting the organization's IT infrastructure from advanced cyber threats. The functionality of the
solution combines automatic detection of threats with the ability to react to these threats to counteract
advanced attacks including new exploits, ransomware, leless attacks, as well as methods using legitimate system
tools. For more information about the solution, refer to the Kaspersky Endpoint Detection and Response Optimum
Help .
Kaspersky Endpoint Detection and Response Optimum reviews and analyses threat development and provides
security personnel or the Administrator with information about the potential attack that is necessary for a timely
response. Kaspersky Endpoint Detection and Response displays alert details in a separate window. Alert Details is a
tool for viewing the entirety of collected information about a detected threat and managing response actions.
Alert details include, for example, the history of les appearing on the computer. For details about managing alert
details, refer to the Kaspersky Endpoint Detection and Response Optimum Help.
The component can be managed only using the Kaspersky Security Center Web Console. You cannot manage
this component using the Administration Console (MMC).
Endpoint Detection and Response Optimum settings

Parameter

Network
isolation

Description

Automatic isolation of the computer from the network in response to detected threats.
When network isolation is turned on, the application severs all active connections and
blocks all new TCP/IP connections on the computer. The application leaves only the
following connections active:
Connections listed in Network isolation exclusions.
Connections initiated by Kaspersky Endpoint Security services.
Connections initiated by the Kaspersky Security Center Administration agent.

Automatically
unlock
isolated
computer in
N hours

Network isolation can be turned o automatically after a speci ed time or manually. By
default, Kaspersky Endpoint Security turns o Network isolation 5 hours after the start of
the isolation.
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Network
isolation
exclusions

List of rules for exclusions from network isolation. Network connections that match the
rules are not blocked on computers when Network isolation is turned on.
To con gure Network isolation exclusions, you can use a list of standard network pro les.
By default, exclusions include network pro les containing rules that ensure uninterrupted
operation of devices with the DNS/DHCP server and DNS/DHCP client roles. You can also
modify the settings of standard network pro les or de ne exclusions manually.
Exclusions speci ed in policy properties are applied only if Network isolation is turned
on automatically in response to a detected threat. Exclusions speci ed in computer
properties are applied only if Network isolation is turned on manually in computer
properties in the Kaspersky Security Center console.

Execution
prevention

Control the execution of executable les and scripts and opening of o ice format les. For
example, you can prevent the execution of applications that are considered insecure on the
selected computer. Execution prevention supports a set of o ice le extensions and a set
of script interpreters.

Action on
execution or
opening of
forbidden
object

Block and write to report. In this mode, the application blocks the execution of objects or
opening of documents that match prevention rule criteria. The application also publishes
an event about attempts to execute objects or open documents to the Windows event log
and Kaspersky Security Center event log.

Execution
prevention
rules

List of object execution prevention rules. An execution prevention rules is a set of criteria
that are considered when blocking. The application identi es les by their paths or
checksums calculated using MD5 and SHA256 hashing algorithms.

Log events only. In this mode, Kaspersky Endpoint Security publishes an event about
attempts to run executable objects or open documents that match prevention rule criteria
to the Windows event log and Kaspersky Security Center, but does not block the attempt
to run or open the object or document. This mode is selected by default.

Full Disk Encryption
You can select an encryption technology: Kaspersky Disk Encryption or BitLocker Drive Encryption (hereinafter
also referred to as simply "BitLocker").

Kaspersky Disk Encryption
After the system hard drives have been encrypted, at the next computer startup the user must complete
authentication using the Authentication Agent before the hard drives can be accessed and the operating system
is loaded. This requires entering the password of the token or smart card connected to the computer, or the user
name and password of the Authentication Agent account created by the local area network administrator using
the Manage Authentication Agent accounts task. These accounts are based on Microsoft Windows accounts
under which users log into the operating system. You can also use Single Sign-On (SSO) technology, which lets you
automatically log in to the operating system using the user name and password of the Authentication Agent
account.
User authentication in the Authentication Agent can be performed in two ways:
Enter the name and password of the Authentication Agent account created by the LAN administrator using
Kaspersky Security Center tools.
Enter the password of a token or smart card connected to the computer.
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Use of a token or smart card is available only if the computer hard drives were encrypted using the AES256
encryption algorithm. If the computer hard drives were encrypted using the AES56 encryption algorithm,
addition of the electronic certi cate le to the command will be denied.

BitLocker Drive Encryption
BitLocker is an encryption technology built into Windows operating systems. Kaspersky Endpoint Security allows
you to control and manage Bitlocker using Kaspersky Security Center. BitLocker encrypts logical volumes.
BitLocker cannot be used for encryption of removable drives. For more details on BitLocker, refer to the Microsoft
documentation .
BitLocker provides secure storage of access keys using a trusted platform module. A Trusted Platform Module
(TPM) is a microchip developed to provide basic functions related to security (for example, to store encryption
keys). A Trusted Platform Module is usually installed on the computer motherboard and interacts with all other
system components via the hardware bus. Using TPM is the safest way to store BitLocker access keys, since TPM
provides pre-startup system integrity veri cation. You can still encrypt drives on a computer without a TPM. In this
case, the access key will be encrypted with a password. BitLocker uses the following authentication methods:
TPM.
TPM and PIN.
Password.
After encrypting a drive, BitLocker creates a master key. Kaspersky Endpoint Security sends the master key to
Kaspersky Security Center so that you can restore access to the disk, for example, if a user has forgotten the
password.
If a user encrypts a disk using BitLocker, Kaspersky Endpoint Security will send information about disk encryption
to Kaspersky Security Center. However, Kaspersky Endpoint Security will not send the master key to Kaspersky
Security Center, so it will be impossible to restore access to the disk using Kaspersky Security Center. For
BitLocker to work correctly with Kaspersky Security Center, decrypt the drive and re-encrypt the drive using a
policy. You can decrypt a drive locally or using a policy.
After encrypting the system hard drive, the user needs to go through BitLocker authentication to boot the
operating system. After the authentication procedure, BitLocker will allow for users to log in. BitLocker does not
support single sign-on technology (SSO).
If you are using Windows group policies, turn o BitLocker management in the policy settings. Windows policy
settings may con ict with Kaspersky Endpoint Security policy settings. When encrypting a drive, errors may
occur.
Kaspersky Disk Encryption component settings

Parameter

Encryption
mode

Description

Encrypt all hard drives. If this item is selected, the application encrypts all hard drives
when the policy is applied.
If the computer has several operating systems installed, after encryption you will be
able to load only the operating system that has the application installed.
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Decrypt all hard drives. If this item is selected, the application decrypts all previously
encrypted hard drives when the policy is applied.
Leave unchanged. If this item is selected, the application leaves drives in their previous
state when the policy is applied. If the drive was encrypted, it remains encrypted. If the
drive was decrypted, it remains decrypted. This item is selected by default.
During
encryption,
automatically
create
Authentication
Agent
accounts for
Windows users

If this check box is selected, the application creates Authentication Agent accounts
based on the list of Windows user accounts on the computer. By default, Kaspersky
Endpoint Security uses all local and domain accounts with which the user logged in to the
operating system over the past 30 days.

Authentication
Agent account
creation
settings

All accounts on the computer. If this check box is selected, when running the full disk
encryption task Kaspersky Endpoint Security creates Authentication Agent accounts for
all computer accounts that have ever been active.
All domain accounts on the computer. If this check box is selected, when running the full
disk encryption task Kaspersky Endpoint Security creates Authentication Agent
accounts for all computer accounts belonging to a certain domain that have ever been
active.
All local accounts on the computer. If this check box is selected, when running the full
disk encryption task Kaspersky Endpoint Security creates Authentication Agent
accounts for all local computer accounts that have ever been active.
Local administrator. If this check box is selected, when running the full disk encryption
task Kaspersky Endpoint Security creates a local administrator account.
Computer manager. If this check box is selected, when running the full disk encryption
task Kaspersky Endpoint Security creates an Authentication Agent account for the
account whose properties in Active Directory show that it is a management account.
Active account. If this check box is selected, when running the full disk encryption task
Kaspersky Endpoint Security automatically creates an Authentication Agent account for
the computer account that is active during the task.

Automatically
create
Authentication
Agent
accounts for
all users of this
computer
upon sign-in

If this check box is selected, the application checks information about Windows user
accounts on the computer before starting Authentication Agent. If Kaspersky Endpoint
Security detects a Windows user account that has no Authentication Agent account, the
application will create a new account for accessing encrypted drives. The new
Authentication Agent account will have the following default settings: passwordprotected sign-on only, and password change on rst authentication. Therefore, you do
not need to manually add Authentication Agent accounts using the Manage
Authentication Agent accounts task for computers with already encrypted drives.

Save user
name entered
in
Authentication
Agent

If the check box is selected, the application saves the name of the Authentication Agent
account. You will not be required to enter the account name the next time you attempt to
complete authorization in the Authentication Agent under the same account.

Encrypt used
disk space
only

This check box enables / disables the option that limits the encryption area to only
occupied hard drive sectors. This limit lets you reduce encryption time.
Enabling or disabling the Encrypt used disk space only (reduces encryption time)
feature after starting encryption does not modify this setting until the hard drives
are decrypted. You must select or clear the check box before starting encryption.
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If the check box is selected, only portions of the hard drive that are occupied by les are
encrypted. Kaspersky Endpoint Security automatically encrypts new data as it is added.
If the check box is cleared, the entire hard drive is encrypted, including residual fragments
of previously deleted and modi ed les.
This option is recommended for new hard drives whose data has not been modi ed
or deleted. If you are applying encryption on a hard drive that is already in use, it is
recommended to encrypt the entire hard drive. This ensures protection of all data,
even deleted data that is potentially recoverable.
This check box is cleared by default.
Use Legacy
USB Support

This check box enables/disables the Legacy USB Support function. Legacy USB Support
is a BIOS/UEFI function that allows you to use USB devices (such as a security token)
during the computer's boot phase before starting the operating system (BIOS mode).
Legacy USB Support does not a ect support for USB devices after the operating
system is started.
If the check box is selected, support for USB devices during initial startup of the
computer will be enabled.
When the Legacy USB Support function is enabled, the Authentication Agent in
BIOS mode does not support working with tokens via USB. It is recommended to use
this option only when there is a hardware compatibility issue and only for those
computers on which the problem occurred.

Password
settings

Authentication Agent account password strength settings. You can also enable the use
of Single Sign-On (SSO) technology.
SSO technology makes it possible to use the same account credentials to access
encrypted hard drives and to sign in to the operating system.
If the check box is selected, you must enter the account credentials for accessing
encrypted hard drives and then automatically logging in to the operating system.
If the check box is cleared, to access encrypted hard drives and subsequently log into the
operating system you must separately enter the credentials for accessing encrypted hard
drives and the operating system user account credentials.

Help texts

Authentication. Help text that appears in the Authentication Agent window when
entering account credentials.
Change password. Help text that appears in the Authentication Agent window when
changing the password for the Authentication Agent account.
Recover password. Help text that appears in the Authentication Agent window when
recovering the password for the Authentication Agent account.

BitLocker Drive Encryption component settings

Parameter

Encryption mode

Description

Encrypt all hard drives. If this item is selected, the application encrypts all hard drives
when the policy is applied.
If the computer has several operating systems installed, after encryption you will
be able to load only the operating system that has the application installed.
621

Decrypt all hard drives. If this item is selected, the application decrypts all previously
encrypted hard drives when the policy is applied.
Leave unchanged. If this item is selected, the application leaves drives in their previous
state when the policy is applied. If the drive was encrypted, it remains encrypted. If the
drive was decrypted, it remains decrypted. This item is selected by default.
Enable use of
BitLocker
authentication
requiring preboot keyboard
input on tablets

This check box enables / disables the use of authentication requiring data input in a
preboot environment, even if the platform does not have the capability for preboot
input (for example, with touchscreen keyboards on tablets).
The touchscreen of tablet computers is not available in the preboot environment.
To complete BitLocker authentication on tablet computers, the user must
connect a USB keyboard, for example.
If the check box is selected, use of authentication requiring preboot input is allowed. It
is recommended to use this setting only for devices that have alternative data input
tools in a preboot environment, such as a USB keyboard in addition to touchscreen
keyboards.
If the check box is cleared, BitLocker Drive Encryption is not possible on tablets.

Use hardware
encryption
Encrypt used
disk space only
(Windows 8 and
later versions)

If the check box is selected, the application applies hardware encryption. This lets you
increase the speed of encryption and use less computer resources.
This check box enables / disables the option that limits the encryption area to only
occupied hard drive sectors. This limit lets you reduce encryption time.
Enabling or disabling the Encrypt used disk space only (reduces encryption
time) feature after starting encryption does not modify this setting until the hard
drives are decrypted. You must select or clear the check box before starting
encryption.
If the check box is selected, only portions of the hard drive that are occupied by les
are encrypted. Kaspersky Endpoint Security automatically encrypts new data as it is
added.
If the check box is cleared, the entire hard drive is encrypted, including residual
fragments of previously deleted and modi ed les.
This option is recommended for new hard drives whose data has not been
modi ed or deleted. If you are applying encryption on a hard drive that is already in
use, it is recommended to encrypt the entire hard drive. This ensures protection of
all data, even deleted data that is potentially recoverable.
This check box is cleared by default.

Authentication
settings

Use password (Windows 8 and later versions)
If this option is selected, Kaspersky Endpoint Security prompts the user for a
password when the user attempts to access an encrypted drive.
This option can be selected when a Trusted Platform Module (TPM) is not being used.
Use Trusted Platform Module (TPM)
If this option is selected, BitLocker uses a Trusted Platform Module (TPM).
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A Trusted Platform Module (TPM) is a microchip developed to provide basic functions
related to security (for example, to store encryption keys). A Trusted Platform Module
is usually installed on the computer motherboard and interacts with all other system
components via the hardware bus.
For computers running Windows 7 or Windows Server 2008 R2, only encryption
using a TPM module is available. If a TPM module is not installed, BitLocker
encryption is not possible. Use of a password on these computers is not
supported.
A device equipped with a Trusted Platform Module can create encryption keys that
can be decrypted only with the device. A Trusted Platform Module encrypts
encryption keys with its own root storage key. The root storage key is stored within the
Trusted Platform Module. This provides an additional level of protection against
attempts to hack encryption keys.
This action is selected by default.
You can set an additional layer of protection for access to the encryption key, and
encrypt the key with a password or a PIN:
Use PIN for TPM. If this check box is selected, a user can use of a PIN code to
obtain access to an encryption key that is stored in a Trusted Platform Module
(TPM).
If this check box is cleared, users are prohibited from using PIN codes. To access
the encryption key, a user must enter the password.
You can allow the user to use enhanced PIN. Enhanced PIN allows using other
characters in addition to numerical characters: uppercase and lowercase Latin
letters, special characters, and spaces.
Use Trusted Platform Module (TPM); if it is unavailable - use password. If the
check box is selected, the user can use a password to obtain access to encryption
keys when a Trusted Platform Module (TPM) is not available.
If the check box is cleared and the TPM is not available, full disk encryption will not
start.

File Level Encryption
You can compile lists of les by extension or group of extensions and lists of folders stored on local computer
drives, and create rules for encrypting les that are created by speci c applications. After a policy is applied,
Kaspersky Endpoint Security encrypts and decrypts the following les:
les individually added to lists for encryption and decryption;
les stored in folders added to lists for encryption and decryption;
les created by separate applications.
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.
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File encryption has the following special features:
Kaspersky Endpoint Security encrypts / decrypts les in prede ned folders only for local user pro les of the
operating system. Kaspersky Endpoint Security does not encrypt or decrypt les in prede ned folders of
roaming user pro les, mandatory user pro les, temporary user pro les, or redirected folders.
Kaspersky Endpoint Security does not encrypt les whose modi cation could harm the operating system and
installed applications. For example, the following les and folders with all nested folders are on the list of
encryption exclusions:
%WINDIR%;
%PROGRAMFILES% and %PROGRAMFILES(X86)%;
Windows registry les.
The list of encryption exclusions cannot be viewed or edited. While les and folders on the list of encryption
exclusions can be added to the encryption list, they will not be encrypted during le encryption.
File Level Encryption component settings

Parameter

Manage
encryption

Description

Leave unchanged. If this item is selected, Kaspersky Endpoint Security leaves the les
and folders unchanged without encrypting or decrypting them.
Encrypt according to rules. If this item is selected, Kaspersky Endpoint Security
encrypts the les and folders according to encryption rules, decrypts the les and
folders according to decryption rules, and regulates the access of applications to
encrypted les according to application rules.
Decrypt entire device. If this item is selected, Kaspersky Endpoint Security decrypts all
encrypted les and folders.

Encryption
rules

This tab shows encryption rules for les stored on local drives. You can add les as
follows:
Prede ned folders. Kaspersky Endpoint Security allows you to add the following
areas:
Documents. Files in the standard Documents folder of the operating system, and its
subfolders.
Favorites. Files in the standard Favorites folder of the operating system, and its
subfolders.
Desktop. Files in the standard Desktop folder of the operating system, and its
subfolders.
Temporary les. Temporary les related to the operation of applications installed on
the computer. For example, Microsoft O ice applications create temporary les
containing backup copies of documents.
Outlook les. Files related to the operation of the Outlook mail client: data les (PST),
o line data les (OST), o line address book les (OAB), and personal address book
les (PAB).
Folders. You can type the path to the folder. When adding a folder path, adhere to the
following rules:
Use an environment variable (for example, %FOLDER%\UserFolder\). You can use an
environment variable only once and only at the beginning of the path.
Do not use relative paths. You can use the set \..\ (e.g.
C:\Users\..\UserFolder\). The set \..\ denotes the transition to the parent
folder.
Do not use the * and ? characters.
Do not use UNC paths.
Use ; or , as a separator character.
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Files by extension. You can select extension groups from the list, such as the
extension group Archives. You can also manually add the le extension.
Decryption
rules

This tab shows decryption rules for les stored on local drives.

Rules for
applications

The tab displays a table containing encrypted le access rules for applications and
encryption rules for les that are created or modi ed by individual applications.

Encrypted
package
password
settings

Password strength requirements to meet when creating encrypted packages.

Encryption of removable drives
This component is available if Kaspersky Endpoint Security is installed on a computer that runs on Windows
for workstations. This component is unavailable if Kaspersky Endpoint Security is installed on a computer that
runs on Windows for servers.

Kaspersky Endpoint Security supports encryption of les in FAT32 and NTFS le systems. If a removable drive
with an unsupported le system is connected to the computer, the encryption task for this removable drive
ends with an error and Kaspersky Endpoint Security assigns the read-only status to the removable drive.
To protect data on removable drives, you can use the following types of encryption:
Full Disk Encryption (FDE).
Encryption of the entire removable drive, including the le system.
It is not possible to access encrypted data outside the corporate network. It is also impossible to access
encrypted data inside the corporate network if the computer is not connected to Kaspersky Security
Center (e.g. on a guest computer).
File Level Encryption (FLE).
Encryption of only les on a removable drive. The le system remains unchanged.
Encryption of les on removable drives provides the capability to access data outside the corporate
network using a special mode called portable mode.
During encryption, Kaspersky Endpoint Security creates a master key. Kaspersky Endpoint Security saves the
master key in the following repositories:
Kaspersky Security Center.
User's computer.
The master key is encrypted with the user's secret key.
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Removable drive.
The master key is encrypted with the public key of Kaspersky Security Center.
After encryption is complete, the data on the removable drive can be accessed within the corporate network as if
was on an ordinary unencrypted removable drive.

Accessing encrypted data
When a removable drive with encrypted data is connected, Kaspersky Endpoint Security performs the following
actions:
1. Checks for a master key in the local storage on the user's computer.
If the master key is found, the user gains access to the data on the removable drive.
If the master key is not found, Kaspersky Endpoint Security performs the following actions:
a. Sends a request to Kaspersky Security Center.
After receiving the request, Kaspersky Security Center sends a response that contains the master key.
b. Kaspersky Endpoint Security saves the master key in the local storage on the user's computer for
subsequent operations with the encrypted removable drive.
2. Decrypts the data.

Special features of removable drive encryption
Encryption of removable drives has the following special features:
The policy with preset settings for removable drive encryption is formed for a speci c group of managed
computers. Therefore, the result of applying the Kaspersky Security Center policy con gured for
encryption / decryption of removable drives depends on the computer to which the removable drive is
connected.
Kaspersky Endpoint Security does not encrypt / decrypt read-only les that are stored on removable drives.
The following device types are supported as removable drives:
Data media connected via the USB bus
hard drives connected via USB and FireWire buses
SSD drives connected via USB and FireWire buses
Encryption of removable drives component settings

Parameter

Description

Manage
encryption

Encrypt entire removable drive. If this item is selected, when applying the policy with the
speci ed encryption settings for removable drives, Kaspersky Endpoint Security encrypts
removable drives sector by sector, including their le systems.
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Encrypt all les. If this item is selected, when applying the policy with the speci ed
encryption settings for removable drives, Kaspersky Endpoint Security encrypts all les
that are stored on removable drives. Kaspersky Endpoint Security does not re-encrypt
les that are already encrypted. The contents of the le system of a removable drive,
including the folder structure and names of encrypted les, are not encrypted and remain
accessible.
Encrypt new les only. If this item is selected, when applying the policy with the speci ed
encryption settings for removable drives, Kaspersky Endpoint Security encrypts only
those les that were added or modi ed on removable drives after the Kaspersky Security
Center policy was last applied. This encryption mode is convenient when a removable drive
is used for both personal and work purposes. This encryption mode lets you leave all old
les unchanged and encrypt only those les that the user creates on a work computer
that has Kaspersky Endpoint Security installed and encryption functionality enabled. As a
result, access to personal les is always available, regardless of whether or not Kaspersky
Endpoint Security is installed on the computer with encryption functionality enabled.
Decrypt entire removable drive. If this item is selected, when applying the policy with the
speci ed encryption settings for removable drives, Kaspersky Endpoint Security decrypts
all encrypted les stored on removable drives as well as the le systems of the removable
drives if they were previously encrypted.
Leave unchanged. If this item is selected, the application leaves drives in their previous
state when the policy is applied. If the drive was encrypted, it remains encrypted. If the
drive was decrypted, it remains decrypted. This item is selected by default.
Portable
mode

This check box enables / disables the preparation of a removable drive that makes it
possible to access les stored on this removable drive on computers outside of the
corporate network.
If this check box is selected, Kaspersky Endpoint Security prompts the user to specify a
password before encrypting les on a removable drive upon the application of the policy.
The password is needed to access les encrypted on a removable drive on computers
outside of the corporate network. You can con gure the password strength.
Portable mode is available for the Encrypt all les or Encrypt new les only modes.

Encrypt
used disk
space only

This check box enables / disables the encryption mode in which only occupied disk sectors
are encrypted. This mode is recommended for new drives whose data has not been
modi ed or deleted.
If the check box is selected, only portions of the drive that are occupied by les are
encrypted. Kaspersky Endpoint Security automatically encrypts new data as it is added.
If the check box is cleared, the entire drive is encrypted, including residual fragments of
previously deleted and modi ed les.
The ability to encrypt only occupied space is available only for the Encrypt entire
removable drive mode.
After encryption started, enabling / disabling the Encrypt used disk space only
function will not change this setting. You must select or clear the check box before
starting encryption.

Encryption
rules for
selected
devices

This table contains devices for which custom encryption rules are de ned. You can create
encryption rules for individual removable drives in the following ways:
Add a removable drive from the list of trusted devices for Device Control.
Manually add a removable drive:
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By device ID (Hardware ID, or HWID)
By device model: vendor ID (VID) and product ID (PID)
Allow
encryption
of
removable
drives in
o line
mode
Portable
mode
password
settings

If this check box is selected, Kaspersky Endpoint Security encrypts removable drives even
when there is no connection to Kaspersky Security Center. In this case, the data required
for decrypting removable drives is stored on the hard drive of the computer to which the
removable drive is connected, and is not transmitted to Kaspersky Security Center.
If the check box is cleared, Kaspersky Endpoint Security does not encrypt removable
drives without a connection to Kaspersky Security Center.
Password strength settings for the Portable File Manager.

Templates (data encryption)
After data encryption, Kaspersky Endpoint Security may restrict access to data, for example, due to a change in
the organization's infrastructure and a change in the Kaspersky Security Center Administration Server. If a user
does not have access to encrypted data, the user can ask the administrator for access to the data. In other words,
the user needs to send a request access le to the administrator. The user then needs to upload the response le
received from the administrator to Kaspersky Endpoint Security. Kaspersky Endpoint Security allows you to
request access to data from the administrator via email (see the gure below).

Requesting access to encrypted data

A template is provided for reporting a lack of access to encrypted data. For user convenience, you can ll out the
following elds:
To. Enter the email address of the administrator group with rights to the data encryption features.
Subject. Enter the subject of the email with your request for access to encrypted les. You can, for example,
add tags to lter messages.
Message. If necessary, change the contents of the message. You can use variables to get the necessary data
(for example, %USER_NAME% variable).
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Exclusions
A trusted zone is a system administrator-con gured list of objects and applications that Kaspersky Endpoint
Security does not monitor when active.
The administrator forms the trusted zone independently, taking into account the features of the objects that are
handled and the applications that are installed on the computer. It may be necessary to include objects and
applications in the trusted zone when Kaspersky Endpoint Security blocks access to a certain object or
application, if you are sure that the object or application is harmless. An administrator can also allow a user to
create their own local trusted zone for a speci c computer. This way, users can create their own local lists of
exclusions and trusted applications in addition to the general trusted zone in a policy.

Scan exclusions
A scan exclusion is a set of conditions that must be ful lled so that Kaspersky Endpoint Security will not scan a
particular object for viruses and other threats.
Scan exclusions make it possible to safely use legitimate software that can be exploited by criminals to damage the
computer or user data. Although they do not have any malicious functions, such applications can be exploited by
intruders. For details on legitimate software that could be used by criminals to harm the computer or personal data
of a user, please refer to the Kaspersky IT Encyclopedia website .
Such applications may be blocked by Kaspersky Endpoint Security. To prevent them from being blocked, you can
con gure scan exclusions for the applications in use. To do so, add the name or name mask that is listed in the
Kaspersky IT Encyclopedia to the trusted zone. For example, you often use the Radmin application for remote
administration of computers. Kaspersky Endpoint Security regards this activity as suspicious and may block it. To
prevent the application from being blocked, create a scan exclusion with the name or name mask that is listed in
the Kaspersky IT Encyclopedia.
If an application that collects information and sends it to be processed is installed on your computer, Kaspersky
Endpoint Security may classify this application as malware. To avoid this, you can exclude the application from
scanning by con guring Kaspersky Endpoint Security as described in this document.
Scan exclusions can be used by the following application components and tasks that are con gured by the system
administrator:
Behavior Detection.
Exploit Prevention.
Host Intrusion Prevention.
File Threat Protection.
Web Threat Protection.
Mail Threat Protection.
Scan tasks.

List of trusted applications
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The list of trusted applications is a list of applications whose le and network activity (including malicious activity)
and access to the system registry are not monitored by Kaspersky Endpoint Security. By default, Kaspersky
Endpoint Security scans objects that are opened, executed, or saved by any application process and controls the
activity of all applications and network tra ic that is generated by them. However, an application that has been
added to the list of trusted applications is excluded from scans by Kaspersky Endpoint Security.
For example, if you consider objects that are used by the standard Microsoft Windows Notepad application to be
safe without scanning, meaning that you trust this application, you can add Microsoft Windows Notepad to the list
of trusted applications. Scanning then skips objects that are used by this application.
In addition, certain actions that are classi ed by Kaspersky Endpoint Security as suspicious may be safe within the
context of the functionality of a number of applications. For example, the interception of text that is typed from
the keyboard is a routine process for automatic keyboard layout switchers (such as Punto Switcher). To take
account of the speci cs of such applications and exclude their activity from monitoring, we recommend that you
add such applications to the trusted applications list.
Excluding trusted applications from scanning allows avoiding compatibility con icts between Kaspersky Endpoint
Security and other programs (for example, the problem of double-scanning of the network tra ic of a third-party
computer by Kaspersky Endpoint Security and by another anti-virus application), and also increases the
computer's performance, which is critical when using server applications.
At the same time, the executable le and process of the trusted application are still scanned for viruses and other
malware. An application can be fully excluded from Kaspersky Endpoint Security scanning by means of scan
exclusions.
Settings of exclusions

Parameter

Types of
detected
objects

Description

Regardless of the con gured application settings, Kaspersky Endpoint Security always
detects and blocks viruses, worms, and Trojans. They can cause signi cant harm to the
computer.
Viruses and worms
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Subcategory: viruses and worms (Viruses_and_Worms)
Threat level: high
Classic viruses and worms perform actions that are not authorized by the user. They
can create copies of themselves which are able to self-replicate.
Classic virus
When a classic virus in ltrates a computer, it infects a le, activates, performs
malicious actions, and adds copies of itself to other les.
A classic virus multiplies only on local resources of the computer; it cannot penetrate
other computers on its own. It can be passed to another computer only if it adds a
copy of itself to a le that is stored in a shared folder or on an inserted CD, or if the
user forwards an email message with an attached infected le.
Classic virus code can penetrate various areas of computers, operating systems, and
applications. Depending on the environment, viruses are divided into le viruses, boot
viruses, script viruses, and macro viruses.
Viruses can infect les by using a variety of techniques. Overwriting viruses write
their code over the code of the le that is infected, thus erasing the le's content.
The infected le stops functioning and cannot be restored. Parasitic viruses modify
les, leaving them fully or partially functional. Companion viruses do not modify les,
but instead create duplicates. When an infected le is opened, a duplicate of it (what
is actually a virus) is started. The following types of viruses are also encountered: link
viruses, OBJ viruses, LIB viruses, source code viruses, and many others.
Worm
As with a classic virus, the code of a worm is activated and performs malicious
actions after it in ltrates a computer. Worms are so named because of their ability
to "crawl" from one computer to another and to spread copies via numerous data
channels without the user's permission.
The main feature that allows di erentiating between various types of worms is the
way they spread. The following table provides an overview of various types of worms,
which are classi ed by the way in which they spread.
Ways in which worms spread

Type

Name

Description

EmailWorm

EmailWorm

They spread via email.

IMWorm

IM client
worms

They spread through IM clients.

An infected email message contains an attached le with
a copy of a worm, or a link to a le that is uploaded to a
website which may have been hacked or created
exclusively for that purpose. When you open the attached
le, the worm is activated. When you click the link,
download, and then open the le, the worm also starts
performing its malicious actions. After that, it goes on
spreading copies of itself, searching for other email
addresses and sending infected messages to them.
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Usually, such worms send messages that contain a link to a
le with a copy of the worm on a website, making use of
the user's contact lists. When the user downloads and
opens the le, the worm activates.
IRCWorm

Internet
chat
worms

They spread via Internet Relay Chats, service systems
which allow communicating with other people over the
Internet in real time.
These worms publish a le with a copy of themselves or a
link to the le in an Internet chat. When the user
downloads and opens the le, the worm activates.

NetWorm

Network
worms

These worms spread over computer networks.

P2PWorm

File
sharing
network
worms

They spread over peer-to-peer le sharing networks.

Unlike other types of worms, a typical network worm
spreads without the user's participation. It scans the local
network for computers that contain programs with
vulnerabilities. To do this, it sends a specially formed
network packet (exploit) which contains the worm code or
a part of it. If a "vulnerable" computer is on the network, it
receives such a network packet. When the worm
completely penetrates the computer, it activates.

To in ltrate a P2P network, the worm copies itself into a
le sharing folder which is usually located on the user's
computer. The P2P network displays information about
this le so that the user may " nd" the infected le on the
network like any other le, and then download and open it.
More sophisticated worms emulate the network protocol
of a speci c P2P network: they return positive responses
to search queries and o er copies of themselves for
download.

Worm

Other
types of
worms

Other types of worms include:
Worms that spread copies of themselves over network
resources. By using the functions of the operating
system, they scan available network folders, connect
to computers on the Internet, and attempt to obtain
full access to their disk drives. Unlike the previously
described types of worms, other types of worms
activate not on their own, but when the user opens a
le that contains a copy of the worm.
Worms that do not use any of the methods described
in the previous table to spread (for example, those that
spread over cell phones).

Trojans (including ransomware)
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Subcategory: Trojans
Threat level: high
Unlike worms and viruses, Trojans do not self-replicate. For example, they penetrate a
computer via email or a browser when the user visits an infected web page. Trojans
are started with the user's participation. They begin performing their malicious
actions right after they are started.
Di erent Trojans behave di erently on infected computers. The main functions of
Trojans consist in blocking, modifying, or destroying information, and disabling
computers or networks. Trojans can also receive or send les, run them, display
messages on the screen, request web pages, download and install programs, and
restart the computer.
Hackers often use "sets" of various Trojans.
Types of Trojan behavior are described in the following table.
Types of Trojan behavior on an infected computer

Type

TrojanArcBomb

Name

Description

Trojans –
"archive
bombs"

When unpacked, these archives grow in size to
such an extent that the computer's operation
is impacted.
When the user attempts to unpack such an
archive, the computer may slow down or
freeze; the hard disk may become lled with
"empty" data. "Archive bombs" are especially
dangerous to le and mail servers. If the server
uses an automatic system to process
incoming information, an "archive bomb" may
halt the server.

Backdoor

Trojans for
remote
administration

They are considered the most dangerous type
of Trojan. In their functions, they are similar to
remote administration applications that are
installed on computers.
These programs install themselves on the
computer without being noticed by the user,
allowing the intruder to manage the computer
remotely.

Trojan

Trojans

They include the following malicious
applications:
Classic Trojans. These programs perform
only the main functions of Trojans: blocking,
modifying or destroying information, and
disabling computers or networks. They do
not have any advanced features, unlike the
other types of Trojans that are described in
the table.
Versatile Trojans. These programs have
advanced features typical of several types
of Trojans.
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TrojanRansom

Ransom
Trojans

They take the user's information "hostage",
modifying or blocking it, or impact the
computer's operation so that the user loses
the ability to use information. The intruder
demands a ransom from the user, promising to
send an application to restore the computer's
performance and the data that had been
stored on it.

TrojanClicker

Trojan clickers

They access web pages from the user's
computer, either by sending commands to a
browser on their own or by changing the web
addresses that are speci ed in operating
system les.
By using these programs, intruders perpetrate
network attacks and increase website visits,
increasing the number of displays of banner
ads.

TrojanDownloader

Trojan
downloaders

They access the intruder's web page,
download other malicious applications from it,
and install them on the user's computer. They
can contain the le name of the malicious
application to download, or receive it from the
web page that is accessed.

TrojanDropper

Trojan
droppers

They contain other Trojans which they install
on the hard drive and then install.
Intruders may use Trojan Dropper–type
programs for the following goals:
Install a malicious application without being
noticed by the user: Trojan Dropper–type
programs display no messages, or display
fake messages which inform, for example,
of an error in an archive or an incompatible
version of the operating system.
Protect another known malicious
application from detection: not all antivirus software can detect a malicious
application within a Trojan Dropper–type
application.

TrojanNoti er

Trojan
noti ers

They inform an intruder that the infected
computer is accessible, sending the intruder
information about the computer: IP address,
number of opened port, or email address. They
connect with the intruder via email, FTP,
accessing the intruder's web page, or in
another way.
Trojan Noti er–type programs are often used
in sets that are made of several Trojans. They
notify the intruder that other Trojans have
been successfully installed on the user's
computer.

TrojanProxy

Trojan proxies
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They allow the intruder to anonymously
access web pages by using the user's

computer; they are often used for sending
spam.
TrojanPSW

Passwordstealing-ware

Password-stealing-ware is a kind of Trojan that
steals user accounts, such as software
registration data. These Trojans nd
con dential data in system les and in the
registry and send it to the “attacker" by email,
via FTP, by accessing the intruder's web page,
or in another way.
Some of these Trojans are categorized into
separate types that are described in this table.
These are Trojans that steal bank accounts
(Trojan-Banker), steal data from users of IM
clients (Trojan-IM), and steal information from
users of online games (Trojan-GameThief).

Trojan-Spy

Trojan spies

They spy on the user, collecting information
about the actions that the user makes while
working at the computer. They may intercept
the data that the user enters at the keyboard,
take screenshots, or collect lists of active
applications. After they receive the
information, they transfer it to the intruder by
email, via FTP, by accessing the intruder's web
page, or in another way.

TrojanDDoS

Trojan
network
attackers

They send numerous requests from the user's
computer to a remote server. The server lacks
resources to process all requests, so it stops
functioning (Denial of Service, or simply DoS).
Hackers often infect many computers with
these programs so that they can use the
computers to attack a single server
simultaneously.
DoS programs perpetrate an attack from a
single computer with the user's knowledge.
DDoS (Distributed DoS) programs perpetrate
distributed attacks from several computers
without being noticed by the user of the
infected computer.

Trojan-IM

Trojans that
steal
information
from users of
IM clients

They steal account numbers and passwords of
IM client users. They transfer the data to the
intruder by email, via FTP, by accessing the
intruder's web page, or in another way.

Rootkit

Rootkits

They mask other malicious applications and
their activity, thus prolonging the applications'
persistence in the operating system. They can
also conceal les, processes in an infected
computer's memory, or registry keys which run
malicious applications. The rootkits can mask
data exchange between applications on the
user's computer and other computers on the
network.

Trojan-SMS

Trojans in the
form of SMS
messages

They infect cell phones, sending SMS
messages to premium-rate phone numbers.
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TrojanGameThief

Trojans that
steal
information
from users of
online games

They steal account credentials from users of
online games, after which they send the data
to the intruder by email, via FTP, by accessing
the intruder's web page, or in another way.

TrojanBanker

Trojans that
steal bank
accounts

They steal bank account data or e-money
system data; send the data to the hacker by
email, via FTP, by accessing the hacker's web
page, or by using another method.

TrojanMail nder

Trojans that
collect email
addresses

They collect email addresses that stored on a
computer and send them to the intruder by
email, via FTP, by accessing the intruder's web
page, or in another way. Intruders may send
spam to the addresses they have collected.

Malicious tools
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Subcategory: Malicious tools
Danger level: medium
Unlike other types of malware, malicious tools do not perform their actions right after
they are started. They can be safely stored and started on the user's computer.
Intruders often use the features of these programs to create viruses, worms, and
Trojans, perpetrate network attacks on remote servers, hack computers, or perform
other malicious actions.
Various features of malicious tools are grouped by the types that are described in
the following table.
Features of malicious tools

Type

Name

Description

Constructor

Constructors

They allow creating new viruses, worms, and
Trojans. Some constructors boast a
standard window-based interface in which
the user can select the type of malicious
application to create, the way of
counteracting debuggers, and other
features.

Dos

Network
attacks

They send numerous requests from the
user's computer to a remote server. The
server lacks resources to process all
requests, so it stops functioning (Denial of
Service, or simply DoS).

Exploit

Exploits

An exploit is a set of data or a program code
that uses vulnerabilities of the application in
which it is processed, performing a malicious
action on a computer. For example, an
exploit can write or read les, or request
"infected" web pages.
Di erent exploits use vulnerabilities in
di erent applications or network services.
Disguised as a network packet, an exploit is
transmitted over the network to numerous
computers, searching for computers with
vulnerable network services. An exploit in a
DOC le uses the vulnerabilities of a text
editor. It may start performing the actions
that are preprogrammed by the hacker when
the user opens the infected le. An exploit
that is embedded in an email message
searches for vulnerabilities in any email
client. It may start performing a malicious
action as soon as the user opens the
infected message in this email client.
Net-Worms spread over networks by using
exploits. Nuker exploits are network packets
that disable computers.

FileCryptor

Encryptors
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They encrypt other malicious applications to
conceal them from the anti-virus
application.

Flooder

Programs for
"contaminating"
networks

They send numerous messages over
network channels. This type of tools
includes, for example, programs that
contaminate Internet Relay Chats.
Flooder-type tools do not include programs
that "contaminate" channels that are used by
email, IM clients, and mobile communication
systems. These programs are distinguished
as separate types that are described in the
table (Email-Flooder, IM-Flooder, and SMSFlooder).

HackTool

Hacking tools

They make it possible to hack the computer
on which they are installed or attack another
computer (for example, by adding new
system accounts without the user's
permission or by erasing system logs to
conceal traces of their presence in the
operating system). This type of tools
includes some sni ers which feature
malicious functions, such as password
interception. Sni ers are programs that
allow viewing network tra ic.

Hoax

Hoaxes

They alarm the user with virus-like messages:
they may "detect a virus" in an uninfected le
or notify the user that the disk has been
formatted, although this has not happened
in reality.

Spoofer

Spoo ng tools

They send messages and network requests
with a fake address of the sender. Intruders
use Spoofer-type tools to pass themselves
o as the true senders of messages, for
example.

VirTool

Tools that
modify
malicious
applications

They allow modifying other malware
programs, concealing them from anti-virus
applications.

EmailFlooder

Programs that
"contaminate"
email
addresses

They send numerous messages to various
email addresses, thus "contaminating" them.
A large volume of incoming messages
prevents users from viewing useful
messages in their inboxes.

IM-Flooder

Programs that
"contaminate"
tra ic of IM
clients

They ood users of IM clients with
messages. A large volume of messages
prevents users from viewing useful incoming
messages.

SMSFlooder

Programs that
"contaminate"
tra ic with
SMS messages

They send numerous SMS messages to cell
phones.

Adware
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Subcategory: advertising software (Adware);
Threat level: medium
Adware displays advertising information to the user. Adware programs display banner
ads in the interfaces of other programs and redirect search queries to advertising
web pages. Some of them collect marketing information about the user and send it
to the developer: this information may include the names of the websites that are
visited by the user or the content of the user's search queries. Unlike Trojan-Spy–
type programs, adware sends this information to the developer with the user's
permission.
Auto-dialers
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Subcategory: legal software that may be used by criminals to damage your
computer or personal data.
Danger level: medium
Most of these applications are useful, so many users run them. These applications
include IRC clients, auto-dialers, le download programs, computer system activity
monitors, password utilities, and Internet servers for FTP, HTTP, and Telnet.
However, if intruders gain access to these programs, or if they plant them on the
user's computer, some of the application's features may be used to violate security.
These applications di er by function; their types are described in the following table.

Type

Name

Description

Client-IRC

Internet chat
clients

Users install these programs to talk to
people in Internet Relay Chats. Intruders use
them to spread malware.

Dialer

Auto-dialers

They can establish phone connections over
a modem in hidden mode.

Downloader

Programs for
downloading

They can download les from web pages in
hidden mode.

Monitor

Programs for
monitoring

They allow monitoring activity on the
computer on which they are installed (seeing
which applications are active and how they
exchange data with applications that are
installed on other computers).

PSWTool

Password
restorers

They allow viewing and restoring forgotten
passwords. Intruders secretly implant them
on users' computers with the same purpose.

RemoteAdmin

Remote
administration
programs

They are widely used by system
administrators. These programs allow
obtaining access to the interface of a
remote computer to monitor and manage it.
Intruders secretly implant them on users'
computers with the same purpose: to
monitor and manage remote computers.
Legal remote administration programs di er
from Backdoor-type Trojans for remote
administration. Trojans have the ability to
penetrate the operating system
independently and install themselves; legal
programs are unable to do so.

Server-FTP

FTP servers

They function as FTP servers. Intruders
implant them on the user's computer to
open remote access to it via FTP.

Server-Proxy

Proxy servers

They function as proxy servers. Intruders
implant them on the user's computer to
send spam under the user's name.

Server-Telnet

Telnet servers

They function as Telnet servers. Intruders
implant them on the user's computer to
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open remote access to it via Telnet.
Server-Web

Web servers

They function as web servers. Intruders
implant them on the user's computer to
open remote access to it via HTTP.

RiskTool

Tools for
working at a
local
computer

They provide the user with additional
options when working at the user's own
computer. The tools allow the user to hide
les or windows of active applications and
terminate active processes.

NetTool

Network tools

They provide the user with additional
options when working with other computers
on the network. These tools allow restarting
them, detecting open ports, and starting
applications that are installed on the
computers.

Client-P2P

P2P network
clients

They allow working on peer-to-peer
networks. They can be used by intruders for
spreading malware.

Client-SMTP

SMTP clients

They send email messages without the
user's knowledge. Intruders implant them on
the user's computer to send spam under the
user's name.

WebToolbar

Web toolbars

They add toolbars to the interfaces of other
applications to use search engines.

FraudTool

Pseudoprograms

They pass themselves o as other
programs. For example, there are pseudoanti-virus programs which display messages
about malware detection. However, in reality,
they do not nd or disinfect anything.

Detect other software that can be used by criminals to damage your computer or
personal data
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Subcategory: legal software that may be used by criminals to damage your
computer or personal data.
Danger level: medium
Most of these applications are useful, so many users run them. These applications
include IRC clients, auto-dialers, le download programs, computer system activity
monitors, password utilities, and Internet servers for FTP, HTTP, and Telnet.
However, if intruders gain access to these programs, or if they plant them on the
user's computer, some of the application's features may be used to violate security.
These applications di er by function; their types are described in the following table.

Type

Name

Description

Client-IRC

Internet chat
clients

Users install these programs to talk to
people in Internet Relay Chats. Intruders use
them to spread malware.

Dialer

Auto-dialers

They can establish phone connections over
a modem in hidden mode.

Downloader

Programs for
downloading

They can download les from web pages in
hidden mode.

Monitor

Programs for
monitoring

They allow monitoring activity on the
computer on which they are installed (seeing
which applications are active and how they
exchange data with applications that are
installed on other computers).

PSWTool

Password
restorers

They allow viewing and restoring forgotten
passwords. Intruders secretly implant them
on users' computers with the same purpose.

RemoteAdmin

Remote
administration
programs

They are widely used by system
administrators. These programs allow
obtaining access to the interface of a
remote computer to monitor and manage it.
Intruders secretly implant them on users'
computers with the same purpose: to
monitor and manage remote computers.
Legal remote administration programs di er
from Backdoor-type Trojans for remote
administration. Trojans have the ability to
penetrate the operating system
independently and install themselves; legal
programs are unable to do so.

Server-FTP

FTP servers

They function as FTP servers. Intruders
implant them on the user's computer to
open remote access to it via FTP.

Server-Proxy

Proxy servers

They function as proxy servers. Intruders
implant them on the user's computer to
send spam under the user's name.

Server-Telnet

Telnet servers

They function as Telnet servers. Intruders
implant them on the user's computer to
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open remote access to it via Telnet.
Server-Web

Web servers

They function as web servers. Intruders
implant them on the user's computer to
open remote access to it via HTTP.

RiskTool

Tools for
working at a
local
computer

They provide the user with additional
options when working at the user's own
computer. The tools allow the user to hide
les or windows of active applications and
terminate active processes.

NetTool

Network tools

They provide the user with additional
options when working with other computers
on the network. These tools allow restarting
them, detecting open ports, and starting
applications that are installed on the
computers.

Client-P2P

P2P network
clients

They allow working on peer-to-peer
networks. They can be used by intruders for
spreading malware.

Client-SMTP

SMTP clients

They send email messages without the
user's knowledge. Intruders implant them on
the user's computer to send spam under the
user's name.

WebToolbar

Web toolbars

They add toolbars to the interfaces of other
applications to use search engines.

FraudTool

Pseudoprograms

They pass themselves o as other
programs. For example, there are pseudoanti-virus programs which display messages
about malware detection. However, in reality,
they do not nd or disinfect anything.

Packed objects whose packing may be used to protect malicious code
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Kaspersky Endpoint Security scans compressed objects and the unpacker module
within SFX (self-extracting) archives.
To hide dangerous programs from anti-virus applications, intruders archive them by
using special packers or create multi-packed les.
Kaspersky virus analysts have identi ed packers that are the most popular amongst
hackers.
If Kaspersky Endpoint Security detects such a packer in a le, the le most likely
contains a malicious application or an application that can be used by criminals to
cause harm to your computer or personal data.
Kaspersky Endpoint Security singles out the following types of programs:

Packed les that may cause harm – used for packing malware, such as viruses,
worms, and Trojans.
Multi-packed les (medium threat level) – the object has been packed three times
by one or more packers.
Multi-packed objects

Kaspersky Endpoint Security scans compressed objects and the unpacker module
within SFX (self-extracting) archives.
To hide dangerous programs from anti-virus applications, intruders archive them by
using special packers or create multi-packed les.
Kaspersky virus analysts have identi ed packers that are the most popular amongst
hackers.
If Kaspersky Endpoint Security detects such a packer in a le, the le most likely
contains a malicious application or an application that can be used by criminals to
cause harm to your computer or personal data.
Kaspersky Endpoint Security singles out the following types of programs:

Packed les that may cause harm – used for packing malware, such as viruses,
worms, and Trojans.
Multi-packed les (medium threat level) – the object has been packed three times
by one or more packers.

Exclusions

This table contains information about scan exclusions.
You can exclude objects from scans by using the following methods:
Specify the path to the le or folder.
Enter the object hash.
Use masks:
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The * (asterisk) character, which takes the place of any set of characters, except the
\ and / characters (delimiters of the names of les and folders in paths to les and
folders). For example, the mask C:\*\*.txt will include all paths to les with the TXT
extension located in folders on the C: drive, but not in subfolders.
Two consecutive * characters take the place of any set of characters (including an
empty set) in the le or folder name, including the \ and / characters (delimiters of
the names of les and folders in paths to les and folders). For example, the mask
C:\Folder\**\*.txt will include all paths to les with the TXT extension located in
the folder named Folder and its subfolders. The mask must include at least one
nesting level. The mask C:\**\*.txt is not a valid mask.
The ? (question mark) character, which takes the place of any single character, except
the \ and / characters (delimiters of the names of les and folders in paths to les
and folders). For example, the mask C:\Folder\???.txt will include paths to all les
residing in the folder named Folder that have the TXT extension and a name
consisting of three characters.
Enter the name of the object type according to the classi cation of the Kaspersky
Encyclopedia (for example, Email-Worm, Rootkit or RemoteAdmin). You can use
masks with the ? character (replaces any single character) and the * character (replaces
any number of characters). For example, if the Client* mask is speci ed, Kaspersky
Endpoint Security excludes Client-IRC, Client-P2P and Client-SMTP objects from
scans.
Trusted
applications

This table lists trusted applications whose activity is not monitored by Kaspersky Endpoint
Security during its operation.
The Application Control component regulates the startup of each of the applications
regardless of whether or not the application is included in the table of trusted applications.

Merge
values when
inheriting

(available
only in the
Kaspersky
Security
Center
Console)

This merges the list of scan exclusions and trusted applications in the parent and child
policies of Kaspersky Security Center. To merge lists, the child policy must be con gured to
inherit the settings of the parent policy of Kaspersky Security Center.
If the check box is selected, list items from the Kaspersky Security Center parent policy are
displayed in child policies. This way you can, for example, create a consolidated list of trusted
applications for the entire organization.
Inherited list items in a child policy cannot be deleted or edited. Items on the list of scan
exclusions and the list of trusted applications that are merged during inheritance can be
deleted and edited only in the parent policy. You can add, edit or delete list items in lowerlevel policies.
If items on lists of the child and parent policy match, these items are displayed as the same
item of the parent policy.
If the check box is not selected, list items are not merged when inheriting the settings of
Kaspersky Security Center policies.

Allow use of
local
exclusions /
Allow use of
local
trusted
applications

Local exclusions and local trusted applications (local trusted zone) – user-de ned list of
objects and applications in Kaspersky Endpoint Security for a speci c computer. Kaspersky
Endpoint Security does not monitor objects and applications from the local trusted zone.
This way, users can create their own local lists of exclusions and trusted applications in
addition to the general trusted zone in a policy.
If the check box is selected, a user can create a local list of scan exclusions and a local list of
trusted applications. An administrator can use Kaspersky Security Center to view, add, edit,
or delete list items in the computer properties.
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(available
only in the
Kaspersky
Security
Center
Console)

If the check box is cleared, a user can access only the general lists of scan exclusions and
trusted applications generated in the policy. If local lists were generated, after this
functionality is disabled Kaspersky Endpoint Security continues excluding the listed objects
from scans.

Trusted
system
certi cate
store

If one of the trusted system certi cate stores is selected, Kaspersky Endpoint Security
excludes applications signed with a trusted digital signature from scans. Kaspersky Endpoint
Security automatically assigns such applications to the Trusted group.
If Do not use is selected, Kaspersky Endpoint Security scans applications regardless of
whether or not they have a digital signature. Kaspersky Endpoint Security places an
application in a trust group depending on the level of danger that this application may pose
to the computer.

Application settings
You can con gure the following general settings of the application:
Operating mode
Self-Defense
Performance
Debug information
Computer status when settings are applied
Application settings

Parameter

Description

Start
Kaspersky
Endpoint
Security for
Windows on
computer
startup

When the check box is selected, Kaspersky Endpoint Security is started after the
operating system loads, protecting the computer during the entire session.

Use
Advanced
Disinfection
technology
(requires
considerable
computer
resources)

If the check box is selected, a pop-up noti cation appears on the screen when malicious
activity is detected in the operating system. In its noti cation, Kaspersky Endpoint
Security o ers the user to perform Advanced Disinfection of the computer. After the
user approves this procedure, Kaspersky Endpoint Security neutralizes the threat. After
completing the advanced disinfection procedure, Kaspersky Endpoint Security restarts
the computer. The advanced disinfection technology uses considerable computing
resources, which may slow down other applications.

When the check box is cleared, Kaspersky Endpoint Security is not started after the
operating system loads, until the user starts it manually. Computer protection is
disabled and user data may be exposed to threats.

When the application is in process of detecting an active infection, some operating
system functionality can be unavailable. The availability of the operating system is
restored when Advanced Disinfection is complete and the computer is restarted.
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If Kaspersky Endpoint Security is installed on a computer running Windows for
Servers, Kaspersky Endpoint Security does not show the noti cation. Therefore, the
user cannot select an action to disinfect an active threat. To disinfect a threat, you
need to enable Advanced Disinfection technology in application settings and enable
immediate Advanced Disinfection in Virus Scan task settings. Then you need to
start Virus Scan task.

Use
Kaspersky
Security
Center as
proxy server
for
activation

If this check box is selected, the Kaspersky Security Center Administration Server is
used as a proxy server when activating the application.

(available
only in the
Kaspersky
Security
Center
Console)
Enable SelfDefense

When this check box is selected, Kaspersky Endpoint Security prevents alteration or
deletion of application les on the hard drive, memory processes, and entries in the
system registry.

Allow
managing
Kaspersky
Endpoint
Security
settings via
remote
control
applications

If the check box is selected, trusted remote administration applications (such as
TeamViewer, LogMeIn Pro, and Remotely Anywhere) can modify Kaspersky Endpoint
Security settings.

Enable
external
service
control

If the check box is selected, Kaspersky Endpoint Security allows management of
application services from a remote computer. When an attempt is made to manage
application services remotely, a noti cation is displayed in the Microsoft Windows
taskbar, above the application icon (unless the noti cation service has been disabled by
the user).

Postpone
scheduled
tasks while
running on
battery
power

If the check box is selected, energy conservation mode is enabled. Kaspersky Endpoint
Security postpones scheduled tasks. You can start scan and update tasks manually, if
necessary.

Concede
resources to
other
applications

When Kaspersky Endpoint Security runs scheduled tasks, this may result in increased
workload on the CPU and disk subsystems, which slows down the performance of other
applications.

Enable dump
writing

If the check box is selected, Kaspersky Endpoint Security writes dumps when it crashes.

Untrusted remote administration applications are prohibited from modifying Kaspersky
Endpoint Security settings even when the check box is selected.

When the check box is selected, Kaspersky Endpoint Security suspends scheduled tasks
when it detects an increased load and frees up operating system resources for user
applications.

If the check box is cleared, Kaspersky Endpoint Security does not write dumps. The
application also deletes existing dump les from the computer hard drive.
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Enable dump
and trace
les
protection

If the check box is selected, access to dump les is granted to the system administrator
and local administrator as well as to the user who enabled dump writing. Only system and
local administrators can access trace les.
If the check box is cleared, any user can access dump les and trace les.

Computer
status when
settings are
applied

Settings for displaying the statuses of client computers with Kaspersky Endpoint
Security installed in the Web Console when errors occur while applying a policy or
executing a task. The OK, Warning, and Critical statuses are available.

(available
only in the
Kaspersky
Security
Center
Console)

Reports and storage
Reports
Information about the operation of each Kaspersky Endpoint Security component, data encryption events, the
performance of each scan task, the update task and integrity check task, and the overall operation of the
application is recorded in reports.
Reports are stored in the folder C:\ProgramData\Kaspersky Lab\KES\Report.

Backup
Backup stores backup copies of les that were deleted or modi ed during disinfection. A backup copy is a le
copy created before the le was disinfected or deleted. Backup copies of les are stored in a special format and
do not pose a threat.
Backup copies of les are stored in the folder C:\ProgramData\Kaspersky Lab\KES\QB.
Users in the Administrators group are granted full permission to access this folder. Limited access rights to this
folder are granted to the user whose account was used to install Kaspersky Endpoint Security.
Kaspersky Endpoint Security does not provide the capability to con gure user access permissions to backup
copies of les.

Quarantine
The Quarantine is a special local storage on the computer where les that are infected by viruses or nondisinfectable les are moved to. Quarantined les are stored in an encrypted state and do not threaten the
security of the device. Kaspersky Endpoint Security uses Quarantine only when working with Kaspersky Sandbox
and Kaspersky Endpoint Detection and Response Optimum solutions. In other cases Kaspersky Endpoint Security
places the relevant le in Backup. For details on managing Quarantine as part of solutions, see Kaspersky
Sandbox and Kaspersky Endpoint Detection and Response Optimum Help Guides.
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Quarantine can only be con gured using Web Console. You can also use Web Console to manage quarantined
objects (restore, delete, add, etc). You can restore objects locally on the computer using the command line.
Kaspersky Endpoint Security uses the system account (SYSTEM) to quarantine les.
Settings of reports and storage

Parameter

Description

Store reports
no longer than
N days

If the check box is selected, the maximum report storage term is limited to the de ned
time interval. The default maximum storage term for reports is 30 days. After that period
of time, Kaspersky Endpoint Security automatically deletes the oldest entries from the
report le.

Limit the size
of report le
to N MB

If the check box is selected, the maximum report le size is limited to the de ned value. By
default, the maximum le size is 1024 MB. To avoid exceeding the maximum report le size,
Kaspersky Endpoint Security automatically deletes the oldest entries from the report le
when the maximum report le size is reached.

Store objects
no longer than
N days

If the check box is selected, the maximum le storage term is limited to the de ned time
interval. The default maximum storage term for les is 30 days. After expiration of the
maximum storage term, Kaspersky Endpoint Security deletes the oldest les from Backup.

Limit the size
of Backup to
N MB

If the check box is selected, the maximum storage size is limited to the de ned value. By
default, the maximum size is 100 MB. To avoid exceeding the maximum storage size,
Kaspersky Endpoint Security automatically deletes the oldest les from storage when the
maximum storage size is reached.

Limit the size
of Quarantine
to N MB

Maximum Quarantine size in MB. For example, you can set the maximum Quarantine size to
200 MB. When Quarantine reaches maximum size, Kaspersky Endpoint Security sends the
corresponding event to Kaspersky Security Center and publishes the event in Windows
Event Log. Meanwhile the application continues quarantining new objects.

(available only
in Web
Console)
Notify when
the
Quarantine
storage
reaches N
percent

Threshold value of the Quarantine. For example, you can set the Quarantine threshold to
50%.
When Quarantine reaches the threshold, Kaspersky Endpoint Security sends the
corresponding event to Kaspersky Security Center and publishes the event in Windows
Event Log. Meanwhile the application continues quarantining new objects.

(available only
in Web
Console)
Data transfer
to
Administration
Server

Categories of events on client computers whose information must be relayed to the
Administration Server.

(available only
in Kaspersky
Security
Center)

Network settings
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You can con gure the proxy server used for connecting to the Internet and updating anti-virus databases, select
the network port monitoring mode, and con gure encrypted connections scan.
Network options

Parameter

Limit tra ic on
a metered
connection

Description

If this check box is selected, the application limits its own network tra ic when the
Internet connection is limited. Kaspersky Endpoint Security identi es a high-speed
mobile Internet connection as a limited connection and identi es a Wi-Fi connection as
an unlimited connection.
Cost-Aware Networking works on computers running Windows 8 or later.

Inject script
into web tra ic
to interact with
web pages

If the check box is selected, Kaspersky Endpoint Security injects a web page interaction
script into web tra ic. This script ensures that the Web Control component can work
correctly. The script enables registration of Web Control events. Without this script, you
cannot enable user Internet activity monitoring.
Kaspersky experts recommend injecting this web page interaction script into tra ic
to ensure correct operation of Web Control.

Proxy server

Settings of the proxy server used for Internet access of users of client computers.
Kaspersky Endpoint Security uses these settings for certain protection components,
including for updating databases and application modules.
For automatic con guration of a proxy server, Kaspersky Endpoint Security uses the
WPAD protocol (Web Proxy Auto-Discovery Protocol). If the IP address of the proxy
server cannot be determined by using this protocol, Kaspersky Endpoint Security uses
the proxy server address that is speci ed in the Microsoft Internet Explorer browser
settings.

Bypass proxy
server for local
addresses

If the check box is selected, Kaspersky Endpoint Security does not use a proxy server
when performing an update from a shared folder.

Monitored
ports

Monitor all network ports. In this network port monitoring mode, the protection
components (File Threat Protection, Web Threat Protection, Mail Threat Protection)
monitor data streams that are transmitted via any open network ports of the computer.
Monitor selected network ports only. In this network port monitoring mode, the
protection components monitor the selected ports of the computer and the network
activity of the selected applications. The list of network ports that are normally used for
transmission of email and network tra ic is con gured according to the
recommendations of Kaspersky experts.
Monitor all ports for the applications from the list recommended by Kaspersky. This
uses a prede ned list of applications whose network ports are monitored by Kaspersky
Endpoint Security. For example, this list includes Google Chrome, Adobe Reader, Java,
and other applications.
Monitor all ports for speci ed applications. This uses a list of applications whose
network ports are monitored by Kaspersky Endpoint Security.

Encrypted
connections
scan

Kaspersky Endpoint Security scans encrypted network tra ic transmitted over the
following protocols:
SSL 3.0.
TLS 1.0, TLS 1.1, TLS 1.2, TLS 1.3.
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Kaspersky Endpoint Security supports the following encrypted connection scanning
modes:
Do not scan encrypted connections Kaspersky Endpoint Security will not have
access to the contents of websites whose addresses begin with https://.
Scan encrypted connections upon request from protection components.
Kaspersky Endpoint Security will scan encrypted tra ic only when requested by the
File Threat Protection, Mail Threat Protection, and Web Control components.
Always scan encrypted connections Kaspersky Endpoint Security will scan
encrypted network tra ic even if protection components are disabled.
Kaspersky Endpoint Security does not scan encrypted connections that were
established by trusted applications for which tra ic scanning is disabled. Kaspersky
Endpoint Security does not scan encrypted connections from the prede ned list of
trusted websites. The prede ned list of trusted websites is created by Kaspersky
experts. This list is updated with the application's anti-virus databases. You can view
the prede ned list of trusted websites only in the Kaspersky Endpoint Security
interface. You cannot view the list in the Kaspersky Security Center Console.

When visiting a
domain with an
untrusted
certi cate

Allow. If this option is selected, when visiting a domain with an untrusted
certi cate, Kaspersky Endpoint Security allows the network connection.
When opening a domain with an untrusted certi cate in a browser, Kaspersky Endpoint
Security displays an HTML page showing a warning and the reason why visiting that
domain is not recommended. A user can click the link from the HTML warning page to
obtain access to the requested web resource. After following this link, during the next
hour Kaspersky Endpoint Security will not display warnings about an untrusted
certi cate when visiting other resources on this same domain.
Block connection. If this option is selected, when visiting a domain with an
untrusted certi cate, Kaspersky Endpoint Security blocks the network connection.
When opening a domain with an untrusted certi cate in a browser, Kaspersky Endpoint
Security displays an HTML page showing the reason why that domain is blocked.

When
encrypted
connection
scan errors
occur

Block SSL 2.0
connections
(recommended)

Block connection. If this item is selected, when an encrypted connection scan
error occurs, Kaspersky Endpoint Security blocks the network connection.
Add domain to exclusions. If this item is selected, when an encrypted connection
scan error occurs, Kaspersky Endpoint Security adds the domain that resulted in
the error to the list of domains with scan errors and does not monitor encrypted
network tra ic when this domain is visited. You can view a list of domains with
encrypted connections scan errors only in the local interface of the application. To
clear the list contents, you need to select Block connection.
If the check box is selected, Kaspersky Endpoint Security blocks network connections
established over the SSL 2.0 protocol.
If the check box is cleared, Kaspersky Endpoint Security does not block network
connections established over the SSL 2.0 protocol and does not monitor network tra ic
transmitted over these connections.

Decrypt
encrypted

EV certi cates (Extended Validation Certi cates) con rm the authenticity of websites
and enhance the security of the connection. Browsers use a lock icon in their address
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connections
with websites
that use EV
certi cates

bar to indicate that a website has an EV certi cate. Browsers may also fully or partially
color the address bar in green.
If the check box is selected, Kaspersky Endpoint Security decrypts and monitors
encrypted connections with websites that use an EV certi cate.
If the check box is cleared, Kaspersky Endpoint Security does not have access to the
contents of HTTPS tra ic. For this reason, the application monitors HTTPS tra ic only
based on the website address, for example, https://google.com.
If you are opening a website with an EV certi cate for the rst time, the encrypted
connection will be decrypted regardless of whether or not the check box is selected.

Trusted
addresses

This uses a list of web addresses for which Kaspersky Endpoint Security does not scan
network connections. You can enter a domain name or an IP address. Kaspersky Endpoint
Security supports the * character for entering a mask in the domain name.
Kaspersky Endpoint Security does not support masks for IP addresses. You can
enter a range of IP addresses in the local application interface (for example,
198.51.100.0/24). You cannot enter a range of IP addresses in the Kaspersky Security
Center console.
Examples:
domain.com – the record is inclusive of the following addresses:
https://domain.com, https://www.domain.com,
https://domain.com/page123. The record is exclusive of subdomains (for
example, subdomain.domain.com).
subdomain.domain.com – the record is inclusive of the following addresses:
https://subdomain.domain.com, https://subdomain.domain.com/page123.
The record is exclusive of the domain.com domain.
*.domain.com – the record is inclusive of the following addresses:
https://movies.domain.com, https://images.domain.com/page123. The
record is exclusive of the domain.com domain.

Trusted
applications

List of applications whose activity is not monitored by Kaspersky Endpoint Security
during its operation. You can select the types of application activity that Kaspersky
Endpoint Security will not monitor (for example, do not scan network tra ic). Kaspersky
Endpoint Security supports environment variables and the * and ? characters when
entering a mask.

Scan secure
tra ic in Mozilla
applications

If this check box is selected, Kaspersky Endpoint Security scans encrypted tra ic in the
Mozilla Firefox browser and Thunderbird mail client. Access to some websites via the
HTTPS protocol may be blocked.

(available only in
the Kaspersky
Endpoint
Security
interface)

To scan tra ic in the Mozilla Firefox browser and the Thunderbird mail client, you
must enable the Encrypted Connections Scan. If Encrypted Connections Scan is
disabled, Kaspersky Endpoint Security does not scan tra ic in the Mozilla Firefox
browser and Thunderbird mail client.
Kaspersky Endpoint Security uses the Kaspersky root certi cate to decrypt and analyze
encrypted tra ic. You can select the certi cate store that will contain the Kaspersky
root certi cate.
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Use Windows certi cate store. The Kaspersky root certi cate is added to this store
during installation of Kaspersky Endpoint Security.
Use Mozilla certi cate store. Mozilla Firefox and Thunderbird use their own
certi cate stores. If the Mozilla certi cate store is selected, you need to manually add
the Kaspersky root certi cate to this store through the browser properties.

Interface
You can con gure the settings of the application interface.
Interface settings

Parameter

Interaction
with user

(available
only in the
Kaspersky
Security
Center
Console)

Description

With simpli ed interface. On a client computer, the main application window is inaccessible,
and only the icon in the Windows noti cation area is available. In the context menu of the
icon, the user can perform a limited number of operations with Kaspersky Endpoint Security.
Kaspersky Endpoint Security also displays noti cations above the application icon.
With full interface. On a client computer, the main window of Kaspersky Endpoint Security
and the icon in the Windows noti cation area are available. In the context menu of the icon,
the user can perform operations with Kaspersky Endpoint Security. Kaspersky Endpoint
Security also displays noti cations above the application icon.
Hide Application Activity Monitor section. On the client computer, in the main window of
Kaspersky Endpoint Security, the Application Activity Monitor button is not available.
Application Activity Monitor is a tool designed for viewing information about the activity of
applications on a user's computer in real time.
No interface. On a client computer, no signs of Kaspersky Endpoint Security operation are
displayed. The icon in the Windows noti cation area and noti cations are not available.

Noti cation
settings

A table with the settings of noti cations about events of di erent importance levels that
may occur during the operation of a component, task, or the entire application. Kaspersky
Endpoint Security shows noti cations about these events on the screen, sends them by
email, or logs them.

Email
noti cation
settings

SMTP server settings for delivery of noti cations about events registered during operation
of the application.

Show
application's
status in
noti cations
area

Categories of application events that cause the Kaspersky Endpoint Security icon to
change in the Microsoft Windows taskbar noti cation area ( or ) and result in a pop-up
noti cation.

Local antivirus
database
status
noti cations

Settings of noti cations about outdated anti-virus databases used by the application.

Password
protection

If the toggle button is switched on, Kaspersky Endpoint Security prompts the user for a
password when the user attempts to perform an operation that is within the scope of
Password Protection. The Password Protection scope includes forbidden operations (such
as disabling protection components) and the user accounts to which the Password
Protection scope is applied.
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After Password Protection is enabled, Kaspersky Endpoint Security prompts you to set a
password for performing operations.
Technical
Support
web
resources

List of links to web resources containing information about technical support for Kaspersky
Endpoint Security. Added links are displayed in the Support window of the Kaspersky
Endpoint Security local interface instead of standard links.

(available
only in the
Kaspersky
Security
Center
Console)
Message to
user

Message that is displayed in the Support window of the local interface of Kaspersky
Endpoint Security.

(available
only in the
Kaspersky
Security
Center
Console)

Manage Settings
You can save the current Kaspersky Endpoint Security settings to a le and use them to quickly con gure the
application on a di erent computer. You can also use a con guration le when deploying the application through
Kaspersky Security Center 12 with an installation package. You can restore the default settings at any time.
Application con guration management settings are available only in the Kaspersky Endpoint Security interface.
Application con guration management settings

Settings

Description

Import

Extract application settings from a le in CFG format and apply them.

Export

Save the current application settings to a le in CFG format.

Restore

You can restore the settings recommended by Kaspersky for Endpoint Security at any time.
When the settings are restored, the Recommended security level is set for all protection
components.

Updating databases and application software modules
Updating the databases and application modules of Kaspersky Endpoint Security ensures up-to-date protection
on your computer. New viruses and other types of malware appear worldwide on a daily basis. Kaspersky Endpoint
Security databases contain information about threats and ways of neutralizing them. To detect threats quickly, you
are urged to regularly update the databases and application modules.
Regular updates require a license in e ect. If there is no current license, you will be able to perform an update
only once.
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The main update source for Kaspersky Endpoint Security is Kaspersky update servers.
Your computer must be connected to the Internet to successfully download the update package from Kaspersky
update servers. By default, the Internet connection settings are determined automatically. If you are using a proxy
server, you need to con gure the proxy server settings.
Updates are downloaded over the HTTPS protocol. They may also be downloaded over the HTTP protocol
when it is impossible to download updates over the HTTPS protocol.
While performing an update, the following objects are downloaded and installed on your computer:
Kaspersky Endpoint Security databases. Computer protection is provided using databases that contain
signatures of viruses and other threats and information on ways to neutralize them. Protection components
use this information when searching for and neutralizing infected les on your computer. The databases are
constantly updated with records of new threats and methods for counteracting them. Therefore, we
recommend that you update the databases regularly.
In addition to the Kaspersky Endpoint Security databases, the network drivers that enable the application's
components to intercept network tra ic are updated.
Application modules. In addition to the databases of Kaspersky Endpoint Security, you can also update the
application modules. Updating the application modules xes vulnerabilities in Kaspersky Endpoint Security, adds
new functions, or enhances existing functions.
While updating, the application modules and databases on your computer are compared against the up-to-date
version at the update source. If your current databases and application modules di er from their respective upto-date versions, the missing portion of the updates is installed on your computer.
Context help les can be updated together with application module updates.
If the databases are obsolete, the update package may be large, which may cause additional Internet tra ic
(up to several dozen MB).
Information about the current state of the Kaspersky Endpoint Security databases is displayed in the main
application window or the tooltip that you see when you hover the cursor over the icon of the application in the
noti cation area.
Information on update results and on all events that occur during the performance of the update task is logged in
the Kaspersky Endpoint Security report.
Application module and database update settings

Parameter

Run mode

Description

Automatically. In this mode, Kaspersky Endpoint Security checks the update source for
availability of new update packages with a certain frequency. The frequency of checking for
the update package increases during virus outbreaks and decreases when there are none.
After detecting a fresh update package, Kaspersky Endpoint Security downloads it and
installs updates on your computer.
Manually. This update task run mode allows you to manually start the update task.
By schedule. In this update task run mode, Kaspersky Endpoint Security runs the update task
in accordance with the schedule that you have speci ed. If this update task run mode is
selected, you can also start the Kaspersky Endpoint Security update task manually.

Run
missed

If the check box is selected, Kaspersky Endpoint Security starts the skipped update task as
soon as this becomes possible. The update task can be skipped, for example, if the computer
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tasks

was turned o at the update task start time.
If the check box is cleared, Kaspersky Endpoint Security does not start missed update tasks.
Instead, it runs the next update task in accordance with the current schedule.

Update
source

An update source is a resource that contains updates for databases and application modules
of Kaspersky Endpoint Security.
Update sources include the Kaspersky Security Center server, Kaspersky update servers, and
network or local folders.
The default list of update sources includes Kaspersky Security Center and Kaspersky update
servers. You can add other update sources to the list. You can specify HTTP/FTP servers and
shared folders as update sources.
Kaspersky Endpoint Security does not support updates from HTTPS servers unless they
are Kaspersky's update servers.
If several resources are selected as update sources, Kaspersky Endpoint Security tries to
connect to them one after another, starting from the top of the list, and performs the update
task by retrieving the update package from the rst available source.

Run task
as

Download
updates of
application
modules

By default, the Kaspersky Endpoint Security update task is started on behalf of the user
whose account you have used to log in to the operating system. However, Kaspersky Endpoint
Security may be updated from an update source that the user cannot access due to a lack of
required rights (for example, from a shared folder that contains an update package) or an
update source for which proxy server authentication is not con gured. In the Kaspersky
Endpoint Security settings, you can specify a user that has such rights and start the
Kaspersky Endpoint Security update task under that user account.
This check box enables / disables downloads of application module updates along with antivirus database updates.
If the check box is selected, Kaspersky Endpoint Security noti es the user about available
application module updates and includes application module updates in the update package
while running the update task. The way application module updates are applied is determined
by the following settings:
Install critical and approved updates. If this option is selected, when application
module updates are available Kaspersky Endpoint Security installs critical updates
automatically and all other application module updates only after their installation is
approved locally via the application interface or on the side of Kaspersky Security
Center.
Install only approved updates. If this option is selected, when application module
updates are available Kaspersky Endpoint Security installs them only after their
installation is approved locally via the application interface or on the side of Kaspersky
Security Center. This option is selected by default.
If the check box is cleared, Kaspersky Endpoint Security does not notify the user about
available application module updates and does not include application module updates in the
update package while running the update task.
If application module updates require reviewing and accepting the terms of the End User
License Agreement, the application installs updates after the terms of the End User
License Agreement have been accepted.
This check box is selected by default.
656

Copy
updates to
folder

If this check box is selected, Kaspersky Endpoint Security copies the update package to the
shared folder speci ed under the check box. After that, other computers on your LAN are
able to receive the update package from this shared folder. This reduces Internet tra ic
because the update package is downloaded only once. The following folder is speci ed by
default: C:\ProgramData\Kaspersky Lab\KES\Update distribution\.

Proxy
server for
updates

Proxy server settings for Internet access of users of client computers to update application
modules and databases.

(available
only in the
Kaspersky
Endpoint
Security
interface)

For automatic con guration of a proxy server, Kaspersky Endpoint Security uses the WPAD
protocol (Web Proxy Auto-Discovery Protocol). If the IP address of the proxy server cannot
be determined by using this protocol, Kaspersky Endpoint Security uses the proxy server
address that is speci ed in the Microsoft Internet Explorer browser settings.

Bypass
proxy
server for
local
addresses

If the check box is selected, Kaspersky Endpoint Security does not use a proxy server when
performing an update from a shared folder.

(available
only in the
Kaspersky
Endpoint
Security
interface)

Appendix 2. Application trust groups
Kaspersky Endpoint Security categorizes all applications that are started on the computer into trust groups.
Applications are categorized into trust groups depending on the level of threat that the applications pose to the
operating system.
The trust groups are as follows:
Trusted. This group includes applications for which one or more of the following conditions are met:
Applications are digitally signed by trusted vendors.
Applications are recorded in the trusted applications database of Kaspersky Security Network.
The user has placed applications in the Trusted group.
No operations are prohibited for these applications.
Low Restricted. This group includes applications for which the following conditions are met:
Applications are not digitally signed by trusted vendors.
Applications are not recorded in the trusted applications database of Kaspersky Security Network.
The user has placed applications in the "Low Restricted" group.
Such applications are subject to minimal restrictions on access to operating system resources.
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High Restricted. This group includes applications for which the following conditions are met:
Applications are not digitally signed by trusted vendors.
Applications are not recorded in the trusted applications database of Kaspersky Security Network.
The user has placed applications in the High Restricted group.
Such applications are subject to high restrictions on access to operating system resources.
Untrusted. This group includes applications for which the following conditions are met:
Applications are not digitally signed by trusted vendors.
Applications are not recorded in the trusted applications database of Kaspersky Security Network.
The user has placed applications in the Untrusted group.
For these applications, all operations are blocked.

Appendix 3. File extensions for quick removable drives scan
com – executable le of an application no larger than 64 KB
exe – executable le or self-extracting archive
sys – Microsoft Windows system le
prg – program text for dBase™, Clipper or Microsoft Visual FoxPro®, or a WAVmaker program
bin – binary le
bat – batch le
cmd – command le for Microsoft Windows NT (similar to a bat le for DOS), OS/2
dpl – compressed Borland Delphi library
dll – dynamic link library
scr – Microsoft Windows splash screen
cpl – Microsoft Windows control panel module
ocx – Microsoft OLE (Object Linking and Embedding) object
tsp – program running in split-time mode
drv – device driver
vxd – Microsoft Windows virtual device driver
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pif – program information le
lnk – Microsoft Windows link le
reg – Microsoft Windows system registry key le
ini – con guration le which contains con guration data for Microsoft Windows, Windows NT, and some
applications
cla – Java class
vbs – Visual Basic® script
vbe – BIOS video extension
js, jse – JavaScript source text
htm – hypertext document
htt – Microsoft Windows hypertext header
hta – hypertext program for Microsoft Internet Explorer®
asp – Active Server Pages script
chm – compiled HTML le
pht – HTML le with integrated PHP scripts
php – script that is integrated into HTML les
wsh – Microsoft Windows Script Host le
wsf – Microsoft Windows script
the – Microsoft Windows 95 desktop wallpaper le
hlp – Win Help le
eml – Microsoft Outlook Express email message
nws – new Microsoft Outlook Express email message
msg – Microsoft Mail email message
plg – email message
mbx – saved Microsoft O ice Outlook email message
doc* – Microsoft O ice Word documents, such as: doc for Microsoft O ice Word documents, docx for Microsoft
O ice Word 2007 documents with XML support, and docm for Microsoft O ice Word 2007 documents with
macro support
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dot* – Microsoft O ice Word document templates, such as: dot for Microsoft O ice Word document templates,
dotx for Microsoft O ice Word 2007 document templates, dotm for Microsoft O ice Word 2007 document
templates with macro support
fpm – database program, Microsoft Visual FoxPro start le
rtf – Rich Text Format document
shs – Windows Shell Scrap Object Handler fragment
dwg – AutoCAD® drawing database
msi – Microsoft Windows Installer package
otm – VBA project for Microsoft O ice Outlook
pdf – Adobe Acrobat document
swf – Shockwave® Flash package object
jpg, jpeg – compressed image graphics format
emf – Enhanced Meta le format le;
ico – object icon le
ov? – Microsoft O ice Word executable les
xl* – Microsoft O ice Excel documents and les, such as: xla, the extension for Microsoft O ice Excel, xlc for
diagrams, xlt for document templates, xlsx for Microsoft O ice Excel 2007 workbooks, xltm for Microsoft O ice
Excel 2007 workbooks with macro support, xlsb for Microsoft O ice Excel 2007 workbooks in binary (non-XML)
format, xltx for Microsoft O ice Excel 2007 templates, xlsm for Microsoft O ice Excel 2007 templates with
macro support, and xlam for Microsoft O ice Excel 2007 plug-ins with macro support
pp* – Microsoft O ice PowerPoint® documents and les, such as: pps for Microsoft O ice PowerPoint slides,
ppt for presentations, pptx for Microsoft O ice PowerPoint 2007 presentations, pptm for Microsoft O ice
PowerPoint 2007 presentations with macros support, potx for Microsoft O ice PowerPoint 2007 presentation
templates, potm for Microsoft O ice PowerPoint 2007 presentation templates with macro support, ppsx for
Microsoft O ice PowerPoint 2007 slide shows, ppsm for Microsoft O ice PowerPoint 2007 slide shows with
macro support, and ppam for Microsoft O ice PowerPoint 2007 plug-ins with macro support
md* – Microsoft O ice Access® documents and les, such as: mda for Microsoft O ice Access workgroups and
mdb for databases
sldx – a Microsoft PowerPoint 2007 slide
sldm – a Microsoft PowerPoint 2007 slide with macro support
thmx – a Microsoft O ice 2007 theme

Appendix 4. File Types for the Mail Threat Protection attachment lter
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Note that the actual format of a le may not match its le name extension.
If you enabled ltering of email attachments, the Mail Threat Protection component may rename or delete les
with the following extensions:
com – executable le of an application no larger than 64 KB
exe – executable le or self-extracting archive
sys – Microsoft Windows system le
prg – program text for dBase™, Clipper or Microsoft Visual FoxPro®, or a WAVmaker program
bin – binary le
bat – batch le
cmd – command le for Microsoft Windows NT (similar to a bat le for DOS), OS/2
dpl – compressed Borland Delphi library
dll – dynamic link library
scr – Microsoft Windows splash screen
cpl – Microsoft Windows control panel module
ocx – Microsoft OLE (Object Linking and Embedding) object
tsp – program running in split-time mode
drv – device driver
vxd – Microsoft Windows virtual device driver
pif – program information le
lnk – Microsoft Windows link le
reg – Microsoft Windows system registry key le
ini – con guration le which contains con guration data for Microsoft Windows, Windows NT, and some
applications
cla – Java class
vbs – Visual Basic® script
vbe – BIOS video extension
js, jse – JavaScript source text
htm – hypertext document
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htt – Microsoft Windows hypertext header
hta – hypertext program for Microsoft Internet Explorer®
asp – Active Server Pages script
chm – compiled HTML le
pht – HTML le with integrated PHP scripts
php – script that is integrated into HTML les
wsh – Microsoft Windows Script Host le
wsf – Microsoft Windows script
the – Microsoft Windows 95 desktop wallpaper le
hlp – Win Help le
eml – Microsoft Outlook Express email message
nws – new Microsoft Outlook Express email message
msg – Microsoft Mail email message
plg – email message
mbx – saved Microsoft O ice Outlook email message
doc* – Microsoft O ice Word documents, such as: doc for Microsoft O ice Word documents, docx for Microsoft
O ice Word 2007 documents with XML support, and docm for Microsoft O ice Word 2007 documents with
macro support
dot* – Microsoft O ice Word document templates, such as: dot for Microsoft O ice Word document templates,
dotx for Microsoft O ice Word 2007 document templates, dotm for Microsoft O ice Word 2007 document
templates with macro support
fpm – database program, Microsoft Visual FoxPro start le
rtf – Rich Text Format document
shs – Windows Shell Scrap Object Handler fragment
dwg – AutoCAD® drawing database
msi – Microsoft Windows Installer package
otm – VBA project for Microsoft O ice Outlook
pdf – Adobe Acrobat document
swf – Shockwave® Flash package object
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jpg, jpeg – compressed image graphics format
emf – Enhanced Meta le format le;
ico – object icon le
ov? – Microsoft O ice Word executable les
xl* – Microsoft O ice Excel documents and les, such as: xla, the extension for Microsoft O ice Excel, xlc for
diagrams, xlt for document templates, xlsx for Microsoft O ice Excel 2007 workbooks, xltm for Microsoft O ice
Excel 2007 workbooks with macro support, xlsb for Microsoft O ice Excel 2007 workbooks in binary (non-XML)
format, xltx for Microsoft O ice Excel 2007 templates, xlsm for Microsoft O ice Excel 2007 templates with
macro support, and xlam for Microsoft O ice Excel 2007 plug-ins with macro support
pp* – Microsoft O ice PowerPoint® documents and les, such as: pps for Microsoft O ice PowerPoint slides,
ppt for presentations, pptx for Microsoft O ice PowerPoint 2007 presentations, pptm for Microsoft O ice
PowerPoint 2007 presentations with macros support, potx for Microsoft O ice PowerPoint 2007 presentation
templates, potm for Microsoft O ice PowerPoint 2007 presentation templates with macro support, ppsx for
Microsoft O ice PowerPoint 2007 slide shows, ppsm for Microsoft O ice PowerPoint 2007 slide shows with
macro support, and ppam for Microsoft O ice PowerPoint 2007 plug-ins with macro support
md* – Microsoft O ice Access® documents and les, such as: mda for Microsoft O ice Access workgroups and
mdb for databases
sldx – a Microsoft PowerPoint 2007 slide
sldm – a Microsoft PowerPoint 2007 slide with macro support
thmx – a Microsoft O ice 2007 theme

Appendix 5. Network settings for interaction with external services
Kaspersky Endpoint Security uses the following network settings for interacting with external services.
Network settings

Address

Description

activationv2.kaspersky.com/activationservice/activationservice.svc

Activating the application

Protocol: HTTPS
Port: 443
Updating databases and
application modules

s00.upd.kaspersky.com
s01.upd.kaspersky.com
s02.upd.kaspersky.com
s03.upd.kaspersky.com
s04.upd.kaspersky.com
s05.upd.kaspersky.com
s06.upd.kaspersky.com
s07.upd.kaspersky.com
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s08.upd.kaspersky.com
s09.upd.kaspersky.com
s10.upd.kaspersky.com
s11.upd.kaspersky.com
s12.upd.kaspersky.com
s13.upd.kaspersky.com
s14.upd.kaspersky.com
s15.upd.kaspersky.com
s16.upd.kaspersky.com
s17.upd.kaspersky.com
s18.upd.kaspersky.com
s19.upd.kaspersky.com
cm.k.kaspersky-labs.com
Protocol: HTTPS
Port: 443
downloads.upd.kaspersky.com

Updating databases and
application modules

Protocol: HTTPS
Port: 443

Checking if Kaspersky servers
are accessible. If access to
the servers using system DNS
is not possible, the application
uses public DNS. This is
necessary to make sure antivirus databases are updated
and the level of security is
maintained for the computer.
Kaspersky Endpoint Security
uses the following list of
public DNS servers in the
following order:
1. Google Public DNS
(8.8.8.8).
2. Cloud are DNS (1.1.1.1).
3. Alibaba Cloud DNS
(223.6.6.6).
4. Quad9 DNS (9.9.9.9).
5. CleanBrowsing
(185.228.168.168).
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Requests emitted by the
application may contain
addresses of domains and
the public IP address of
the user because the
application establishes a
TCP/UDP connection with
the DNS server. This
information is needed, for
example, to validate the
certi cate of a web
resource when using
HTTPS. If Kaspersky
Endpoint Security is using
a public DNS server, data
processing is governed by
the privacy policy of the
relevant service. If you
want to prevent Kaspersky
Endpoint Security from
using a public DNS server,
contact Technical Support
for a private patch.

touch.kaspersky.com

Receiving the trusted time for
checking the validity period of
the certi cate (TLS
connection).

Protocol: HTTP

Warning about access denial
to a web resource in the
browser (Web Threat
Protection and Web Control)
Updating databases and
application modules

p00.upd.kaspersky.com
p01.upd.kaspersky.com
p02.upd.kaspersky.com
p03.upd.kaspersky.com
p04.upd.kaspersky.com
p05.upd.kaspersky.com
p06.upd.kaspersky.com
p07.upd.kaspersky.com
p08.upd.kaspersky.com
p09.upd.kaspersky.com
p10.upd.kaspersky.com
p11.upd.kaspersky.com
p12.upd.kaspersky.com
p13.upd.kaspersky.com
p14.upd.kaspersky.com
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p15.upd.kaspersky.com
p16.upd.kaspersky.com
p17.upd.kaspersky.com
p18.upd.kaspersky.com
p19.upd.kaspersky.com
downloads.kaspersky-labs.com
cm.k.kaspersky-labs.com
Protocol: HTTP
Port: 80
Using Kaspersky Security
Network.

ds.kaspersky.com
Protocol: HTTPS
Port: 443

Using Kaspersky Security
Network.

ksn-a-stat-geo.kaspersky-labs.com
ksn-file-geo.kaspersky-labs.com
ksn-verdict-geo.kaspersky-labs.com
ksn-url-geo.kaspersky-labs.com
ksn-a-p2p-geo.kaspersky-labs.com
ksn-info-geo.kaspersky-labs.com
ksn-cinfo-geo.kaspersky-labs.com
Protocol: Any
Port: 443, 1443

Follow links from the interface

click.kaspersky.com
redirect.kaspersky.com
Protocol: HTTPS

Public Key Infrastructure (PKI)

crl.kaspersky.com
ocsp.kaspersky.com
Protocol: HTTP
Port: 80

Appendix 6. Application events in the Windows Event Log
Information about the operation of each Kaspersky Endpoint Security component, data encryption events, the
performance of each scan task, the update task and integrity check task, and the overall operation of the
application is recorded in the Windows Event Log.
System audit

666

Codes of events

Event
ID

Description

Enabled by
default

201

End User License Agreement violated.

203

License has almost expired.

–

206

Databases are missing or corrupted.

–

207

Databases are extremely out of date.

–

209

Application autorun is disabled.

–

229

Activation error.

231

Active threat detected. Advanced Disinfection must be started.

–

2023

KSN servers unavailable.

–

237

Application crashed during previous session.

204

License expires soon.

–

208

Databases are out of date.

–

210

Automatic updates are disabled.

–

211

Self-Defense is disabled.

–

214

Protection components are disabled.

–

215

Computer is running in safe mode.

–

216

There are unprocessed les.

–

219

Group policy applied.

224

Restart the application to complete the update.

225

Computer restart required.

226

The license allows the use of components that have not been installed.

–

232

Advanced Disinfection started.

–

233

Advanced Disinfection completed.

–

230

Incorrect reserve activation code.

–

336

Cannot restore object from Backup.

2001

Suspicious network activity detected.

250

Encrypted connection terminated.

2021

Participation in KSN is disabled.

245

Processing of some OS functions is disabled.

235

Application started.

236

Application stopped.

213

The operation with application resources is blocked by Self-Defense.

217

Report cleared.

220

Group policy disabled.

–

–

–

–

–
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218

Application settings changed.

227

All application components that are de ned by the license have been
installed and run in normal mode.

238

Subscription settings have changed.

239

Subscription has been renewed.

335

Object restored from Backup.

2000

Enter a user name and password.

–

2020

Participation in KSN is enabled.

–

2022

KSN servers available.

–

2024

The application works and processes data under relevant laws and uses
the appropriate infrastructure.

212

Task cannot run.

–

221

Task started.

–

222

Task stopped.

–

223

Task completed.

–

227

Installed components match the license.

–

240

License expires soon.

708

Task settings applied successfully.

Behavior Detection
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–

–

Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

–

313

Cannot be deleted.

–

452

Process terminated.

–

453

Cannot terminate the process.

–

455

Rollback completed.

–

331

Blocked.

–

307

Object deleted.

–

323

Object will be deleted on restart.

–

311

Cannot create a backup copy.

–

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

457

File restored.

–

308

A backup copy of the object was created.

–

458

Registry value restored.

–

459

Registry value deleted.

–

329

Object renamed.

–

Exploit Prevention
Codes of events

Event ID

Description

Enabled by default

302

Malicious object detected.

–

331

Blocked.

–

455

Rollback completed.

–

307

Object deleted.

–

323

Object will be deleted on restart.

–

457

File restored.

–

458

Registry value restored.

–

459

Registry value deleted.

–

329

Object renamed.

–

Host Intrusion Prevention
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Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

–

312

Disinfection not possible.

–

313

Cannot be deleted.

–

317

Processing error.

452

Process terminated.

–

453

Cannot terminate the process.

–

310

Cannot create a backup copy.

–

314

Object not processed.

–

320

Object encrypted.

–

321

Object corrupted.

–

323

Object will be deleted on restart.

–

324

Object will be disinfected on restart.

–

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

336

Cannot restore object from Backup.

307

Object deleted.

–

306

Object disinfected.

–

301

Object processed.

–

308

A backup copy of the object was created.

–

315

Object skipped.

–

318

Archive detected.

–

319

Packed object detected.

–

327

Overwritten by a copy that was disinfected earlier.

–

332

Information about detected object.

–

322

Password-protected archive detected.

–

335

Object restored from Backup.

–

401

Application placed in the trusted group.

–

402

Application placed in restricted group.

–

403

Host Intrusion Prevention was triggered.

–

340

Object is on the Private KSN allowlist.

File Threat Protection

670

Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

312

Disinfection not possible.

–

313

Cannot be deleted.

–

317

Processing error.

452

Process terminated.

–

453

Cannot terminate the process.

–

310

Cannot create a backup copy.

–

314

Object not processed.

–

320

Object encrypted.

–

321

Object corrupted.

–

323

Object will be deleted on restart.

–

324

Object will be disinfected on restart.

–

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

336

Cannot restore object from Backup.

307

Object deleted.

–

306

Object disinfected.

–

455

Rollback completed.

–

301

Object processed.

–

308

A backup copy of the object was created.

–

315

Object skipped.

–

318

Archive detected.

–

319

Packed object detected.

–

325

Overwritten by a copy that was disinfected earlier.

–

322

Password-protected archive detected.

–

332

Information about detected object.

–

335

Object restored from Backup.

–

329

Object renamed.

–

340

Object is on the Private KSN allowlist.

Web Threat Protection
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Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

362

Dangerous link blocked.

363

Dangerous link opened.

1201

Previously opened dangerous link detected.

317

Processing error.

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

331

Blocked

–

341

Object download was blocked.

–

321

Object corrupted.

–

301

Object processed.

–

301

Link processed.

–

332

Information about detected object.

–

319

Packed object detected.

–

318

Archive detected.

–

322

Password-protected archive detected.

–

329

Object renamed.

–

1211

Previously opened malicious link detected.

370

Link is on the Private KSN allowlist.

370

Object is on the Private KSN allowlist.

Mail Threat Protection
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Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

312

Disinfection not possible.

317

Processing error.

314

Object not processed.

–

303

Detected legitimate software that can be used by intruders to
damage your computer.

–

321

Object corrupted.

–

336

Cannot restore object from Backup.

–

307

Object deleted.

–

306

Object disinfected.

–

301

Object processed.

–

308

A backup copy of the object was created.

–

318

Archive detected.

–

319

Packed object detected.

–

329

Object renamed.

–

332

Information about detected object.

–

322

Password-protected archive detected.

–

335

Object restored from Backup.

–

340

Object is on the Private KSN allowlist.

–

Firewall
Codes of events

Event ID

Description

Enabled by default

602

Network activity blocked.

–

601

Network activity allowed.

–

Network Threat Protection
Codes of events

Event ID

Description

Enabled by default

651

Network attack detected.

–

BadUSB Attack Prevention
673

Codes of events

Event ID

Description

Enabled by default

2051

Keyboard not authorized.

2052

Keyboard authorization error.

2050

Keyboard authorized.

–

AMSI Protection
Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

2200

AMSI request blocked.

317

Processing error.

314

Object not processed.

–

320

Object encrypted.

–

321

Object corrupted.

–

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

1512

The object scan result has been sent to a third-party application.

–

301

Object processed.

–

315

Object skipped.

–

318

Archive detected.

–

319

Packed object detected.

–

322

Password-protected archive detected.

–

332

Information about detected object.

–

340

Object is on the Private KSN allowlist.

329

Object renamed.

–

Application Control

674

Codes of events

Event
ID

Description

Enabled by
default

702

Application startup prohibited.

–

710

Prohibited process was started before Kaspersky Endpoint Security for
Windows was started.

–

707

Error in task settings. Task settings not applied.

–

708

Task settings applied successfully.

–

701

Application startup allowed.

–

703

Application startup prohibited in test mode.

–

704

Application startup allowed in test mode.

–

Device Control
Codes of events

Event ID

Description

Enabled by default

802

Operation with the device prohibited.

–

809

Network connection blocked.

–

803

Temporary access to device activated.

801

Operation with the device allowed.

–

808

File operation performed.

–

Web Control
Codes of events

Event ID

Description

Enabled by default

752

Access denied.

–

753

Warning about undesirable content.

–

754

Undesirable content was accessed after a warning.

–

751

Access allowed.

–

751

Allowed page opened.

–

Adaptive Anomaly Control

675

Codes of events

Event ID

Description

2200

Process action blocked.

2201

Process action skipped.

Enabled by default

–

Data Encryption

676

Codes of events

Event
ID

Description

Enabled by
default

904

Error applying le encryption/decryption rules.

912

File encryption/decryption error.

940

File access blocked.

951

Error enabling portable mode.

953

Error disabling portable mode.

931

Error creating encrypted package.

1305

Error encrypting/decrypting device.

1311

Failed to load encryption module.

1340

The task for managing Authentication Agent accounts ended with an
error.

1312

Policy cannot be applied.

1342

FDE upgrade failed.

1344

Full Disk Encryption upgrade rollback completed with an error.

903

Interrupted applying le encryption/decryption rules.

–

914

File encryption/decryption interrupted.

–

1303

Device encryption/decryption interrupted.

–

1306

User has opted out of the encryption policy.

–

1345

Failed to install or upgrade Kaspersky Disk Encryption drivers in the
WinRE image.

901

Started applying le encryption/decryption rules.

–

902

Finished applying le encryption/decryption rules.

–

905

Resumed applying le encryption/decryption rules.

–

910

File encryption/decryption started.

–

911

File encryption/decryption completed.

–

913

File has not been encrypted because it is an exclusion.

–

950

Portable mode enabled.

–

952

Portable mode disabled.

–

1301

Device encryption/decryption started.

–

1302

Device encryption/decryption completed.

–

1304

Device encryption/decryption resumed.

–

1310

Encryption module loaded.

–

1307

Device is not encrypted.

–

1308

Device encryption/decryption process has been switched to active
mode.

–
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1309

Drive encryption/decryption process has been switched to passive
mode.

–

1330

New Authentication Agent account created.

–

1331

Authentication Agent account deleted.

–

1332

Authentication Agent account password changed.

–

1333

Successful Authentication Agent login.

–

1334

Failed Authentication Agent login attempt.

–

1335

Hard drive accessed using the procedure of requesting access to
encrypted devices.

–

1336

Failed attempt to access the hard drive using the procedure of
requesting access to encrypted devices.

–

1337

Account not added. This account already exists.

–

1338

Account not modi ed. This account does not exist.

–

1339

Account not deleted. This account does not exist.

–

1341

FDE upgrade successful.

1343

FDE upgrade rollback successful.

1346

Failed to uninstall Kaspersky Disk Encryption drivers from the WinRE
image.

1370

BitLocker recovery key was changed.

Endpoint Sensor

678

Codes of events

Event
ID

Description

Enabled by
default

2100

Kaspersky Anti Targeted Attack Platform server unavailable.

2105

Application startup was blocked.

2106

Document opening was blocked.

2112

All processes started from a le image or stream were terminated.

2113

Application startup.

2111

File or stream was deleted by the Kaspersky Anti Targeted Attack
Platform server administrator.

2110

File was restored from quarantine on the Kaspersky Anti Targeted Attack
Platform server by the administrator.

2109

File is quarantined on the Kaspersky Anti Targeted Attack Platform server
by administrator.

2107

Network activity of all third-party applications is blocked.

2108

Network activity of all third-party applications is unblocked.

2104

Tasks from the Kaspersky Anti Targeted Attack Platform server are being
processed.

–

2103

Processing of tasks from the Kaspersky Anti Targeted Attack Platform
server is inactive.

–

2101

Endpoint Sensors connected to server.

–

2102

Connection to the Kaspersky Anti Targeted Attack Platform server
restored.

–

Scanning the computer

679

–

Codes of events

Event
ID

Description

Enabled by
default

302

Malicious object detected.

312

Disinfection not possible.

–

313

Cannot be deleted.

–

317

Processing error.

–

452

Process terminated.

–

453

Cannot terminate the process.

–

310

Cannot create a backup copy.

–

314

Object not processed.

–

320

Object encrypted.

–

321

Object corrupted.

–

323

Object will be deleted on restart.

–

324

Object will be disinfected on restart.

–

303

Detected legitimate software that can be used by intruders to damage
your computer or personal data.

–

336

Cannot restore object from Backup.

307

Object deleted.

–

306

Object disinfected.

–

455

Rollback completed.

–

301

Object processed.

–

308

A backup copy of the object was created.

–

315

Object skipped.

–

318

Archive detected.

–

319

Packed object detected.

–

327

Overwritten by a copy that was disinfected earlier.

–

332

Information about detected object.

–

322

Password-protected archive detected.

–

335

Object restored from Backup.

329

Object renamed.

340

Object is on the Private KSN allowlist.

–

Integrity check
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Codes of events

Event ID

Description

Enabled by default

2002

System module signature check failed

–

Database update
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Codes of events

Event ID

Description

Enabled by default

1011

Error updating component.

–

1012

Error distributing component updates.

–

1014

Local update error.

–

1015

Network update error.

–

1017

Cannot start two tasks at the same time.

–

1018

Error verifying application databases and modules.

–

1019

Error in interaction with Kaspersky Security Center.

–

1021

Not all components were updated.

–

1023

Update completed successfully, update distribution failed.

–

101

An internal error has occurred.

2153

Patch installation failed.

–

2156

Patch rollback failed.

–

1016

Operation canceled by the user.

–

1001

Update source selected.

–

1002

Proxy server selected.

–

1003

File download.

–

1004

File downloaded.

–

1005

File installed.

–

1006

File updated.

–

1007

File rolled back due to update error.

–

1008

Updating les.

–

1009

Distributing updates.

–

1010

Rolling back les.

–

1013

Creating the list of les to download.

–

1020

No available updates.

–

1022

Update distribution completed successfully.

–

2150

Downloading patches.

–

2151

Installing patches.

–

2152

Patch installed.

–

2154

Rolling back patch.

–

2155

Patch rolled back.

–

Wipe Data
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Codes of events

Event ID

Description

Enabled by default

2252

Cannot be deleted.

–

2253

Wipe task statistics.

–

2251

Object deleted.

–

Appendix 7. Application events in the Kaspersky Security Center event log
Information about the operation of each Kaspersky Endpoint Security component, data encryption events, the
completion of each scan task, update task and integrity check task, and the overall operation of the application is
recorded in the Kaspersky Security Center event log.
Events of Kaspersky Endpoint Security for Windows

Event ID

GNRL_EV_VIRUS_FOUND

Description

Malicious
object
detected.

Settings

GNRL_EA_PARAM_1 is the hash of the
object (SHA256).
GNRL_EA_PARAM_2 is the name of the
object.
GNRL_EA_PARAM_5 is the name of the
object according to Kaspersky
classi cation.
GNRL_EA_PARAM_7 is the name of the
session user.
GNRL_EA_PARAM_8 is the type of the
threat, for example, Trojware.
GNRL_EA_PARAM_9 is additional
information about the detected object:
Application component (engine ).
Threat detection technology (method
Threat detected by Private KSN
(denylist): true or false.
EDR version.
Threat identi er in EDR.
MD5 hash of the object.

GNRL_EV_SUSPICIOUS_OBJECT_FOUND

Detected
legitimate
software
that can be
used by
criminals to
harm your
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GNRL_EA_PARAM_1 is the hash of the
object (SHA256).
GNRL_EA_PARAM_2 is the name of the
object.

computer or
personal
data

GNRL_EA_PARAM_5 is the name of the
threat, for example, EICAR-Test-File
GNRL_EA_PARAM_7 is the name of the
session user.
GNRL_EA_PARAM_8 is the type of the
threat, for example, Trojware.

GNRL_EV_OBJECT_CURED

Object
disinfected.

GNRL_EA_PARAM_1 is the hash of the
object (SHA256).
GNRL_EA_PARAM_2 is the name of the
object.
GNRL_EA_PARAM_3 is the creation date
of the object (optional).
GNRL_EA_PARAM_5 is the name of the
object according to Kaspersky
classi cation.
GNRL_EA_PARAM_7 is the name of the
session user.
GNRL_EA_PARAM_8 is the type of the
threat, for example, Trojware.
GNRL_EA_PARAM_9 is additional
information about the detected object:
Application component (engine ).
Threat detection technology (method
Threat detected by Private KSN
(denylist): true or false.
EDR version.
Threat identi er in EDR.
MD5 hash of the object.

GNRL_EV_OBJECT_DELETED

Object
deleted.

GNRL_EA_PARAM_1 is the hash of the
object (SHA256).
GNRL_EA_PARAM_2 is the name of the
object.
GNRL_EA_PARAM_3 is the creation date
of the object (optional).
GNRL_EA_PARAM_5 is the name of the
object according to Kaspersky
classi cation.
GNRL_EA_PARAM_7 is the name of the
session user.
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GNRL_EA_PARAM_8 is the type of the
threat, for example, Trojware.
GNRL_EA_PARAM_9 is additional
information about the detected object:
Application component (engine ).
Threat detection technology (method
Threat detected by Private KSN
(denylist): true or false.
EDR version.
Threat identi er in EDR.
MD5 hash of the object.
GNRL_EV_OBJECT_NOTCURED

Disinfection
not possible.

GNRL_EA_PARAM_1 is the hash of the
object (SHA256).
GNRL_EA_PARAM_2 is the name of the
object.
GNRL_EA_PARAM_3 is the creation date
of the object (optional).
GNRL_EA_PARAM_5 is the name of the
object according to Kaspersky
classi cation.
GNRL_EA_PARAM_7 is the name of the
session user.
GNRL_EA_PARAM_9 is additional
information about the detected object:
Application component (engine ).
Threat detection technology (method
Threat detected by Private KSN
(denylist): true or false.
EDR version.
Threat identi er in EDR.
MD5 hash of the object.

GNRL_EV_PASSWD_ARCHIVE_FOUND

Passwordprotected
archive
detected.

GNRL_EA_PARAM_2 is the name of the
object.
GNRL_EA_PARAM_3 is the creation date
of the object (optional).
GNRL_EA_PARAM_7 is the name of the
session user.
GNRL_EA_PARAM_9 is additional
information about the detected object:
Application component (engine ).
Threat detection technology (method
Threat detected by Private KSN
(denylist): true or false.
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GNRL_EV_ATTACK_DETECTED

Network
attack
detected
(Network
Threat
Protection).

GNRL_EA_PARAM_1 is the name of the
attack.
GNRL_EA_PARAM_2 is the protocol.
GNRL_EA_PARAM_3 is the IP address of
the computer acting as the source of th
network attack. The IP address is
indicated in the byte order of the host.
For example, 2886729929 for
172.16.0.201.
GNRL_EA_PARAM_4 is the port number.
GNRL_EA_PARAM_5 is an IPv6 address, f
example,
12B012B012B012B012B012B012B012B
GNRL_EA_PARAM_6 is the IP address of
the computer targeted by the network
attack. The IP address is indicated in the
byte order of the host. For example,
2886729929 for 172.16.0.201.

GNRL_EV_APPLICATION_LAUNCHED

Application
startup
allowed
(Application
Control).

GNRL_EA_PARAM_2 is the time of the las
start of the application in the special
format for Kaspersky Security Center.
GNRL_EA_PARAM_3 is the total number
times the application was started.
GNRL_EA_PARAM_4 is the account
security identi er (SID).
GNRL_EA_PARAM_5 is the application
category ID (optional).
GNRL_EA_PARAM_6 is the name of the
session user.

GNRL_EV_APPLICATION_LAUNCH_DENIED

Application
startup
prohibited
(Application
Control).

GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_3 is the manually
created category identi er.
GNRL_EA_PARAM_4 is the application
category ID (optional).
GNRL_EA_PARAM_5 is information about
the digital signature of the application.
GNRL_EA_PARAM_6 is the name of the
executable le of the application (for
example, chrome.exe).
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GNRL_EA_PARAM_7 is the path to the
executable le.
GNRL_EA_PARAM_8 is the hash of the
object (SHA256).
GNRL_EA_PARAM_9 is the version of the
application that the user is trying to run
GNRL_EV_APP_LAUNCH_TESTED_DENIED

Application
startup
prohibited in
test mode
(Application
Control).

GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_3 is the manually
created category identi er.
GNRL_EA_PARAM_4 is the account
security identi er (SID).
GNRL_EA_PARAM_5 is information about
the digital signature of the application.
GNRL_EA_PARAM_6 is the name of the
executable le of the application (for
example, chrome.exe).
GNRL_EA_PARAM_7 is the path to the
executable le.
GNRL_EA_PARAM_8 is the hash of the
object (SHA256).
GNRL_EA_PARAM_9 is the version of the
application that the user is trying to run

GNRL_EV_APP_LAUNCH_TESTED_ALLOW

Application
startup
allowed in
test mode
(Application
Control).

GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_3 is the manually
created category identi er.
GNRL_EA_PARAM_4 is the account
security identi er (SID).
GNRL_EA_PARAM_5 is the application
category ID (optional).

GNRL_EV_AC_USER_REQUEST

Application
startup
blockage
message to
administrator
(Application
Control).
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c_er_descr is the message to user.
GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_6 is the name of the
executable le of the application (for

example, chrome.exe).
GNRL_EA_PARAM_7 is the path to the
executable le.
GNRL_EA_PARAM_8 is the hash of the
object (SHA256).
GNRL_EA_PARAM_9 is the version of the
application that the user is trying to run
GNRL_EV_WEB_URL_BLOCKED

Access
denied (Web
Control).

GNRL_EA_PARAM_1 is the URL.
GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_3 is the name of the
Web Control rule.

GNRL_EV_WEB_URL_WARNING

GNRL_EV_WC_USER_REQUEST

GNRL_EV_DC_USER_REQUEST

GNRL_EV_DEVCTRL_DEV_PLUGGED

GNRL_EV_DEVCTRL_DEV_UNPLUGGED

Warning
about
undesirable
content
(Web
Control).

Web page
access
blockage
message to
administrator
(Web
Control).
Device
access
blockage
message to
administrator
(Device
Control).

GNRL_EA_PARAM_1 is the URL.
GNRL_EA_PARAM_2 is the name of the
session user.
GNRL_EA_PARAM_3 is the name of the
Web Control rule.

c_er_descr is the message to user.
GNRL_EA_PARAM_1 is the URL.
GNRL_EA_PARAM_2 is the name of the
session user.

c_er_descr is the message to user.
GNRL_EA_PARAM_1 is the Hardware ID
(HWID).
GNRL_EA_PARAM_2 is the name of the
session user.

Device
plugged
(Device
Control).

GNRL_EA_PARAM_1 is the Hardware ID
(HWID).

Device
unplugged

GNRL_EA_PARAM_1 is the Hardware ID
(HWID).
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GNRL_EA_PARAM_2 is the name of the
session user.

GNRL_EV_DEVCTRL_DEV_PLUG_DENIED

(Device
Control).

GNRL_EA_PARAM_2 is the name of the
session user.

Plugged
device
blocked
(Device
Control).

GNRL_EA_PARAM_1 is the Hardware ID
(HWID).
GNRL_EA_PARAM_2 is the name of the
session user.

Appendix 8. Supported le extensions for Execution prevention
Kaspersky Endpoint Security supports preventing the opening of o ice format les in certain applications. The
information about supported le extensions and applications is listed in the following table.
Supported le extensions for Execution prevention

Application name

Microsoft Word

Executable le

winword.exe

File extension

rtf
doc
dot
docm
docx
dotx
dotm
docb

WordPad

wordpad.exe

docx
rtf

Microsoft Excel

excel.exe

xls
xlt
xlm
xlsx
xlsm
xltx
xltm
xlsb
xla
xlam
xll
xlw

Microsoft PowerPoint

powerpnt.exe

ppt
pot
pps
pptx
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pptm
potx
potm
ppam
ppsx
ppsm
sldx
sldm
Adobe Acrobat

acrord32.exe

Foxit

FoxitReader.exe

STDU Viewer

STDUViewerApp.exe

Microsoft Edge

MicrosoftEdge.exe

Google Chrome

chrome.exe

Mozilla Firefox

pdf

refox.exe

Yandex Browser

browser.exe

Tor Browser

tor.exe

Appendix 9. Supported script interpreters
Execution prevention supports the following script interpreters:
AutoHotkey.exe
AutoHotkeyA32.exe
AutoHotkeyA64.exe
AutoHotkeyU32.exe
AutoHotkeyU64.exe
InstallUtil.exe
RegAsm.exe
RegSvcs.exe
autoit.exe
cmd.exe
control.exe
cscript.exe
hh.exe
mmc.exe
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msbuild.exe
mshta.exe
msiexec.exe
perl.exe
powershell.exe
python.exe
reg.exe
regedit.exe
regedt32.exe
regsvr32.exe
ruby.exe
rubyw.exe
rundll32.exe
runlegacycplelevated.exe
wscript.exe
wwahost.exe
Execution prevention supports working with Java applications in the Java runtime environment (java.exe and
javaw.exe processes).

Appendix 10. IOC scan scope in the registry (RegistryItem)
When you add the RegistryItem data type to the IOC scan scope, Kaspersky Endpoint Security scans the following
registry keys:
HKEY_CLASSES_ROOT\htafile
HKEY_CLASSES_ROOT\batfile
HKEY_CLASSES_ROOT\exefile
HKEY_CLASSES_ROOT\comfile
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Lsa
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Print\Monitors
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HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\NetworkProvider
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Class
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\SecurityProviders
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Terminal Server
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Session Manager
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services
HKEY_LOCAL_MACHINE\Software\Classes\piffile
HKEY_LOCAL_MACHINE\Software\Classes\htafile
HKEY_LOCAL_MACHINE\Software\Classes\exefile
HKEY_LOCAL_MACHINE\Software\Classes\comfile
HKEY_LOCAL_MACHINE\Software\Classes\CLSID
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\ShellServiceObjectDelayLoad
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer
HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\Windows\CurrentVersion\Run
HKEY_LOCAL_MACHINE\Software\Microsoft\Active Setup\Installed Components
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\Windows
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\Image File Execution
Options
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\Aedebug
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\Winlogon

Appendix 11. IOC le requirements
When creating IOC Scan tasks, consider the following IOC le requirements and limitations:
Kaspersky Endpoint Detection and Response Optimum supports IOC les with the IOC and XML extensions in
the open standard OpenIOC versions 1.0 and 1.1 for describing indicators of compromise.
If during IOC Scan task creation you upload IOC les, some of which are not supported, when the task is run,
the application uses only the supported IOC les.
If during IOC Scan task creation you upload only unsupported IOC les, the task can still be run, but no
indicators of compromise will be detected.
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Semantic errors and unsupported IOC terms and tags in IOC les do not cause task execution to fail. In such
sections of IOC les, the application detects no match.
The identi ers of all IOC les used in a single IOC Scan task must be unique. If there are IOC les with the
same identi er, it might a ect the task execution results.
A single IOC le must not exceed 3 MB in size. Using larger les will cause IOC Scan tasks to terminate with an
error. That said, the total size of all les added to the IOC collection may exceed 3 MB.
It is recommended to create one IOC le per threat. This makes it easier to analyze the results of the IOC Scan
task.
The le that you can download by clicking the link below, contains a table with the full list of IOC terms of the
OpenIOC standard that are supported by the Kaspersky Endpoint Detection and Response solution.
DOWNLOAD THE IOC_TERMS.XLSX FILE
Features and limitations of the application’s support for the OpenIOC standard are shown in the following table.
Features and limitations of support for OpenIOC version 1.0 and 1.1.

Supported
conditions

OpenIOC 1.0:
is
isnot (as an exception from the set)
contains
containsnot (as an exception from the set)
OpenIOC 1.1:
is
contains
starts-with
ends-with
matches
greater-than
less-than

Supported
condition
attributes

OpenIOC 1.1:

Supported
operators

AND
OR

Supported data
types

"date": date (applicable conditions: is, greater-than, less-than)

preserve-case
negate

"int": integer (applicable conditions: is, greater-than, less-than)
"string": string (applicable conditions: is, contains, matches, starts-with,
ends-with)
"duration": duration in seconds (applicable conditions: is, greater-than,
less-than)
Features of data
type interpretation

The "boolean string", "restricted string", "md5", "IP", "sha256" and
"base64Binary" data types are interpreted as string.
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The application supports interpretation of the Content setting for the int and date
data types when it is set in the form of intervals:
OpenIOC 1.0:
Using the TO operator in the Content eld:
<Content type="int">49600 TO 50700</Content>
<Content type="date">2009-04-28T10:00:00Z TO 2009-0428T16:00:00Z</Content>
<Content type="int">[154192 TO 154192]</Content>
OpenIOC 1.1:
Using the greater-than and less-than conditions
Using the TO operator in the Content eld
The application supports interpretation of the date and duration data types if the
indicators are set in ISO 8601, Zulu Time Zone, UTC format.
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Information about third-party code
Information about third-party code is contained in the le legal_notices.txt, in the application installation folder.

695

Trademark notices
Registered trademarks and service marks are the property of their respective owners.
Adobe, Acrobat, Flash, Reader, and Shockwave are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.
Apple, FireWire, iTunes and Safari are trademarks of Apple Inc., registered in the U.S. and other countries.
AutoCAD is a trademark or registered trademark of Autodesk, Inc., and/or its subsidiaries and/or a iliates in the
USA and/or other countries.
The Bluetooth word, mark and logos are owned by Bluetooth SIG, Inc.
Borland is trademark or registered trademark of Borland Software Corporation.
Android and Google Chrome are trademarks of Google, Inc.
Citrix and Citrix Provisioning Services, and XenDesktop are trademarks of Citrix Systems, Inc. and/or one or more
of its subsidiaries, and may be registered in the United States Patent and Trademark O ice and in other countries.
Dell is a trademark of Dell, Inc. or its subsidiaries.
dBase is a trademark of dataBased Intelligence, Inc.
EMC is a trademark or registered trademark of EMC Corporation in the United States and/or elsewhere.
Radmin is a registered trademark of Famatech.
IBM is a trademark of International Business Machines Corporation, registered in many jurisdictions worldwide.
ICQ is a trademark and/or service mark of ICQ LLC.
Intel is a trademark of Intel Corporation in the U.S. and/or other countries.
IOS is a registered trademark of Cisco Systems, Inc. and/or its a iliates in the United States and other countries.
Lenovo and ThinkPad are trademarks of Lenovo in the United States and/or elsewhere.
Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.
Logitech is either a registered trademark or trademark of Logitech in the United States and/or other countries.
LogMeIn Pro and Remotely Anywhere are trademarks of LogMeIn, Inc.
Mail.ru is a registered trademark of Mail.Ru, LLC.
McAfee is a trademark or registered trademark of McAfee, Inc. in the United States and other countries.
Microsoft, Access, Active Directory, ActiveSync, BitLocker, Excel, Internet Explorer, LifeCam Cinema, MSDN,
MultiPoint, Outlook, PowerPoint, PowerShell, Visual Basic, Visual FoxPro, Windows, Windows PowerShell, Windows
Server, Windows Store, MS-DOS, Surface and Hyper-V are trademarks of Microsoft Corporation in the United
States and other countries.
Mozilla, Firefox, and Thunderbird are the trademarks of the Mozilla Foundation.
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Java and JavaScript are registered trademarks of Oracle and/or its a iliates.
VERISIGN is a registered trademark in the United States and elsewhere or an unregistered trademark of VeriSign,
Inc. and its subsidiaries.
VMware and VMware ESXi are registered trademarks or trademarks of VMware, Inc. in the United States and/or
other jurisdictions.
Thawte is a trademark or registered trademark of Symantec Corporation or its a iliates in the U.S. and other
countries.
SAMSUNG is a trademark of SAMSUNG in the United States and other countries.
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